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Except as provided in writing signed by an officer to Beckman Coulter, Inc., this system and any related 
documentation are provided “as is” without warranty of any kind, expressed or implied, including that the system is 
“error free.” This information is presented in good faith, but Beckman Coulter, Inc. does not warrant, guarantee, or 
make any representations regarding the use or the results of the use of this system and related documentation in terms 
of correctness, accuracy, reliability, currentness, omissions, or otherwise. The entire risk as to the use, results, and 
performance of this system and related documentation is assumed by the user.

Except as expressly provided herein, Beckman Coulter, Inc. makes no other warranty, whether oral or written, 
expressed or implied, as to any matter whatsoever, including but not limited to those concerning merchantability and 
fitness for a particular purpose, nor is freedom from any patent owned by Beckman Coulter, Inc. or by others to be 
inferred.

LIMITATIONS OF LIABILITY
Beckman Coulter, Inc. shall not be liable, to any extent whatsoever, for any damages resulting from or arising out of 
the use or performance of this system and related documentation or the procedures specified in this manual, 
regardless of foreseeability or the form of action, whether in contract, tort (including negligence), breach of warranty, 
strict liability or otherwise, and including but not limited to damages resulting from loss of data, loss of anticipated 
profits, or any special, indirect, incidental or consequential damages. In no event shall Beckman Coulter, Inc.’s 
liability to the user exceed the amount paid by the user to Beckman Coulter, Inc. hereunder. The user assumes full 
responsibility for the results obtained from the use of this system and related documentation and for application of 
such results.

Beckman Coulter, SAGIAN Operations
Indianapolis, Indiana
www.beckmancoulter.com

Biomek, SAMI, Orca, and the Beckman Coulter logo are registered trademarks and Beckman Coulter and SAGIAN 
are trademarks of Beckman Coulter, Inc.
Microsoft and MS-DOS are registered trademarks and Windows is a trademark of Microsoft Corporation. All other 
trademarks appearing in this manual are owned by their respective companies.

Copyright 2004 by Beckman Coulter, Inc. All rights reserved. No part of this publication may be reproduced, 
distributed, or transmitted in any form or by any means, electronic, mechanical, photocopying, recording, or 
otherwise, or stored in a database or retrieval system, without the prior written permission of Beckman Coulter, Inc.



iii

Biomek Software User’s Manual

Warranty and Returned Goods Requirements
All standard Beckman Coulter, Inc. policies governing returned goods apply to this 
product. Subject to the exceptions and upon the conditions stated below, the Company 
warrants that the products sold under this sales agreement shall be free from defects in 
workmanship and materials for one year after delivery of the products to the original 
Purchaser by the Company, and if any such product should prove to be defective 
within such one year period, the Company agrees, at its option, either (1) to correct by 
repair or at the Company’s election by replacement, any such defective product 
provided that investigation and factory inspection discloses that such defect 
developed under normal and proper use, or (2) to refund the purchase price. The 
exceptions and conditions mentioned above are as follows:

a. Components or accessories manufactured by the Company which by their 
nature are not intended to and will not function for one year are warranted 
only to reasonable service for a reasonable time. What constitutes a 
reasonable time and a reasonable service shall be determined solely by the 
Company. A complete list of such components and accessories is maintained 
at the factory.

b. The Company makes no warranty with respect to components or accessories 
not manufactured by it. In the event of defect in any such component or 
accessory, the Company will give reasonable assistance to Purchaser in 
obtaining from the manufacturer’s own warranty.

c. Any product claimed to be defective must, if required by the Company, be 
returned to the factory, transportation charges prepaid, and will be returned 
to Purchaser with transportation charges collect unless the product is found 
to be defective, in which case the product must be properly decontaminated 
of any chemical, biological, or radioactive hazardous material.

d. The Company shall be released from all obligations under all warranties, 
either expressed or implied, if any product covered hereby is repaired or 
modified by persons other than its own authorized service personnel, unless 
such repair by others is made with the written consent of the Company.

e. If the product is a reagent or the like, it is warranted only to conform to the 
quantity and content and for the period (but not in excess of one year) stated 
on the label at the time of delivery.

It is expressly agreed that the above warranty shall be in lieu of all warranties of 
fitness and of the warranty of merchantability, and that the company shall have no 
liability for special or consequential damages of any kind or from any cause 
whatsoever arising out of the manufacture, use, sale, handling, repair, maintenance, or 
replacement of any of the products sold under the sales agreement.

Representatives and warranties made by any person, including dealers and 
representatives of the Company, which are consistent or in conflict with the terms of 
this warranty, shall not be binding upon the Company unless reduced in writing and 
approved by an expressly authorized officer of the Company.

Parts replaced during the warranty period are warranted to the end of the instrument 
warranty.

Note:  Performance characteristics and specifications are only warranted when 
Beckman Coulter replacement parts are used.
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Safety Information

All Warnings and Cautions in this document include an exclamation point, a lightning 
bolt, or a light burst symbol framed within a triangle. Please pay special attention to 
the specific safety information associated with these symbols. 

WARNING: If the equipment is used in a manner not specified by 
Beckman Coulter, Inc., the protection provided by the equipment may be 
impaired.

Warning and Caution Definitions
The exclamation point symbol is an international symbol which serves as a reminder 
that all safety instructions should be read and understood before installation, use, 
maintenance, and servicing is attempted.

When this symbol is displayed in this manual, pay special attention to the specific 
safety information associated with the symbol.

WARNING
A WARNING calls attention to a condition or possible situation that 
could cause injury to the operator.

CAUTION
A CAUTION calls attention to a condition or possible situation that could 
damage or destroy the product or the operator’s work.
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Electrical Safety
To prevent electrically related injuries and property damage, properly inspect all 
electrical equipment prior to use and immediately report any electrical deficiencies. 
Contact a Beckman Coulter Service Representative for any servicing of equipment 
requiring the removal of covers or panels.

High Voltage
This symbol indicates the potential of an electrical shock hazard existing from a high 
voltage source and that all safety instructions should be read and understood before 
proceeding with the installation, maintenance, and servicing of all modules.

Do not remove system covers. To avoid electrical shock, use supplied power cords 
only and connect to properly grounded (three-holed) wall outlets. Do not use 
multiplug power strips.

Laser Light
This symbol indicates that a potential hazard to personal safety exists from a laser 
source. When this symbol is displayed in this manual, pay special attention to the 
specific safety information associated with the symbol.

Laser Specifications
Laser Type: Class II Laser Diode

Maximum Output: 1mW

Wavelength: 670 nm
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Chemical and Biological Safety
Normal operation of laboratory equipment may involve the use of materials that are 
toxic, flammable, or otherwise biologically harmful. When using such materials, 
observe the following precautions:

• Handle infectious samples according to good laboratory procedures and 
methods to prevent the spread of disease.

• Observe all cautionary information printed on the original solutions 
containers prior to their use.

• Dispose of all waste solutions according to your facility’s waste disposal 
procedures.

• Operate the Biomek instrument in accordance with the instructions outlined 
in this manual, and take all the necessary precautions when using 
pathological, toxic, or radioactive materials.

• Objects dropped onto plates, accidental tool release, or other accidental 
collisions may result in splashing of liquids; therefore, take appropriate 
safety precautions, such as using safety glasses and wearing protective 
clothing, when working with potentially hazardous liquids.

• Use an appropriately contained environment when using hazardous 
materials.

• Observe the appropriate cautionary procedures as defined by your safety 
officer when using flammable solvents in or near a powered-up instrument.

• Observe the appropriate cautionary procedures as defined by your safety 
officer when using toxic, pathological, or radioactive materials.

Note:  Observe all warnings and cautions listed for the Biomek instrument and any 
external devices attached or used during operation of the instrument. Refer to the 
applicable instrument and external device user’s manuals for operating procedures of 
that device.

Moving Parts
To avoid injury due to moving parts, observe the following:

• Never attempt to exchange labware, reagents, or tools while the instrument 
is operating.

• Never attempt to physically restrict any of the moving components of the 
Biomek instrument.

• Keep the Biomek instrument work area clear to prevent obstruction of the 
movement.



viii Safety Information

Beckman Coulter, Inc.

Cleaning
Observe the cleaning procedures outlined in the user’s manual for the Biomek 
instrument, automated labware positioner (ALP), or external device. Prior to cleaning 
equipment that has been exposed to hazardous material:

• Appropriate Chemical and Biological Safety personnel should be contacted.

• The Chemical and Biological Safety information contained in this user’s 
manual should be reviewed.

Maintenance
Perform only the maintenance described in this manual or the user’s manual for the 
Biomek instrument. Maintenance other than that specified in these manuals should be 
performed only by Beckman Coulter Service Representatives.

It is your responsibility to decontaminate the Biomek instrument or any of its 
accessories before requesting service by a Beckman Coulter Service Representative 
or returning parts to Beckman Coulter for repair. Beckman Coulter will NOT accept 
any items which have not been decontaminated where it is appropriate to do so. If any 
parts are returned, they must be enclosed in a sealed plastic bag stating that the 
contents are safe to handle and are not contaminated.

Important
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Warnings and Cautions Found in this Manual
Please read and observe all cautions and instructions. Remember, the most important 
key to safety is to operate the Biomek instrument and accessories with care.

The WARNINGs and CAUTIONs found within this document are listed below.

Note:  Also refer to the warnings and cautions in the applicable Biomek instrument 
user’s manual for additional safety information.

WARNING: If the equipment is used in a manner not specified by 
Beckman Coulter, Inc., the protection provided by the equipment may be 
impaired.

CAUTION: Make sure the correct ALP is chosen when configuring the 
deck setup in the Deck Editor. ALPs vary in height and failure to choose 
the correct ALP in the Deck Editor may result in collisions between 
pod(s) and ALPs during operation.

CAUTION: After new tips are added, the correct properties must be 
defined in the Tip Type Editor according to the manufacturer’s 
specifications. Inaccurate specifications may lead to hardware crashes.

CAUTION: The correct well properties must be defined in Labware Types 
according to the manufacturer’s specifications. Inaccurate 
specifications may lead to inaccurate pipetting.

CAUTION: Make sure the correct ALP is chosen when configuring the 
deck setup in the Deck Editor. ALPs vary in height and failure to choose 
each ALP correctly in the software may result in collisions between 
pod(s) and ALPs during operation.

CAUTION: No changes to the Biomek state are permitted while a method 
is paused. Changes can be made to the labware contents, but not the 
deck or the devices.

WARNING: The light curtain is a safety device. Use it to stop a method 
only in an emergency.

CAUTION: An inaccurate Instrument Setup may result in pod and labware 
collisions, or in inappropriate pipetting.

CAUTION: To make sure the Biomek pod avoids all obstacles during its 
travel, always specify the labware, ALPs, and devices that are on the 
deck, and the deck position each occupies.

CAUTION: Do not place labware other than a tip box on a tip loader 
position (TL#).

CAUTION: Do not purge the system without mandrels installed and 
tubing attached to disposable or fixed tips. Purging the system without 
the mandrels installed and the tubing attached to tips may cause 
corrosion in the tip interface.

CAUTION: Do not attempt to access a 96-Channel or 384-Channel Tip 
Wash ALP with a Multichannel Pod equipped with an HDR Tool Body. The 
gripper may crash and damage the pod, HDR Tool Body, or Tip Wash 
ALP.
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CAUTION: Do not access labware positioned on a 1 x 5 Passive ALP with 
the HDR Tool Body. The gripper may crash into the ALP.

CAUTION: Do not access labware on a Stirring ALP with the HDR Tool 
Body. The magnetic stirrer may bend the pins or interfere with the liquid 
transfer performance of the pins.

CAUTION: When setting the height for pipetting operations on the 
Stirring ALP, the presence of the stir bar must be taken into 
consideration. Pipetting operations that do not account for the height of 
the stir bar could damage the tips.

WARNING: The Ignore error recovery option is potentially dangerous 
since almost every action depends upon the successful completion of 
previous actions. Choose Ignore at your own risk.

CAUTION: Resuming a method assumes that the Biomek instrument is in 
the same state as when the error occurred. The pod may be moved to 
deal with a problem, but no changes can be made to the Biomek 
instrument deck.

CAUTION: The partially completed steps assume the pods are in the 
same position they were in when the method was halted. Removing the 
Recovery step without also removing these partially completed steps 
could result in a crash.

WARNING: To eliminate the possibility of replacing a Continuation 
method before corrections are made, it is recommended that a 
Continuation method be edited and run as soon as it is created.

CAUTION: A Continuation method assumes that the instrument is in the 
same state as when the Continuation was snapped. If this is not true, the 
Continuation method must be edited to account for the changes.



Biomek Software User’s Manual

xi

Table of Contents

Warranty and Returned Goods Requirements . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . iii

Safety Information  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . v
Warning and Caution Definitions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . v
Electrical Safety . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . vi

High Voltage. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . vi
Laser Light . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . vi

Laser Specifications  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . vi
Chemical and Biological Safety  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . vii
Moving Parts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . vii
Cleaning . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . viii
Maintenance. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . viii
Warnings and Cautions Found in this Manual. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . ix

Table of Contents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xi

List of Figures . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xxiii

List of Tables. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xxxv

1 Biomek Software Introduction
1.1 About Biomek Software  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-1

1.1.1 Instrument Files  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-1
1.1.2 Project Files  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-2
1.1.3 Methods  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-2

1.2 About this Manual . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-3
1.2.1 Related Manuals . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 1-3



xii Table of Contents

Beckman Coulter, Inc.

2 Using Accounts & Permissions
2.1 Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-1
2.2 Installing and Setting the Level of Support For Accounts & Permissions  . . . . . . 2-2

2.2.1 Installing Accounts & Permissions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-2
2.2.2 Setting the Level of Support For Accounts & Permissions  . . . . . . . . . . 2-3

2.3 Administering User Accounts and Permissions. . . . . . . . . . . . . . . . . . . . . . . . . . . 2-5
2.3.1 Assigning Biomek Software Permissions. . . . . . . . . . . . . . . . . . . . . . . . 2-6

2.4 Restoring the Administrator Password  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-7
2.5 Viewing the Audit Log  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-8
2.6 Using the Biomek Software With Accounts & Permissions Enabled . . . . . . . . . . 2-9

2.6.1 Logging Onto the Biomek Software . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-9
2.6.2 Logging Off the Biomek Software . . . . . . . . . . . . . . . . . . . . . . . . . . . . 2-11

3 Using Instrument Files and Settings
3.1 Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-1

3.1.1 Instrument Display in Method Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-2
3.1.2 Contents of an Instrument File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-2

3.2 Saving and Opening Instrument Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-3
3.2.1 Saving an Instrument File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-3
3.2.2 Creating a New Instrument File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-3
3.2.3 Opening an Existing Instrument File  . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-4

3.3 Restoring Instrument Settings from Backup Files . . . . . . . . . . . . . . . . . . . . . . . . . 3-5
3.4 Sharing Instrument Settings Using the Import/Export Utility . . . . . . . . . . . . . . . . 3-6

3.4.1 Exporting Settings to an Import File. . . . . . . . . . . . . . . . . . . . . . . . . . . . 3-7
3.4.2 Importing Settings from an Import File  . . . . . . . . . . . . . . . . . . . . . . . . . 3-9
3.4.3 Restoring Instrument Settings from Backup Files  . . . . . . . . . . . . . . . . 3-10

4 Configuring Hardware Setup
4.1 Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-1
4.2 Accessing Hardware Setup  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-2
4.3 Understanding the Options in Hardware Setup . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-3
4.4 Configuring the Biomek Simulator . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-4

4.4.1 Configuring Simulator Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-4
4.4.2 Configuring Camera Controls. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-9
4.4.3 Configuring Materials. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 4-11

5 Preparing and Managing the Deck
5.1 Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-1

5.1.1 Framing the Deck . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-3
5.2 Understanding the Deck Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-4

5.2.1 Viewing the ALP Types List  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-6
5.2.2 Biomek FX Deck  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-6
5.2.3 Biomek 3000 Deck . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-7
5.2.4 Biomek NX-MC Deck  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-8
5.2.5 Biomek NX-S8 Deck  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-9



Table of Contents xiii

Biomek Software User’s Manual

5.3 Opening, Selecting, Creating, Deleting, or Renaming a Deck  . . . . . . . . . . . . . . 5-10
5.3.1 Opening and Selecting a Deck . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-10
5.3.2 Creating a New Deck . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-11
5.3.3 Deleting a Deck  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-12
5.3.4 Renaming a Deck . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-13

5.4 Modifying a Deck  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-14
5.4.1 Deleting ALPs and Deck Positions from a Deck . . . . . . . . . . . . . . . . . 5-14
5.4.2 Adding ALPs and Deck Positions  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 5-15
5.4.3 Setting ALP Properties and Deck Positions . . . . . . . . . . . . . . . . . . . . . 5-16

6 Understanding and Using Project Files
6.1 Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-1

6.1.1 Contents of a Project File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-3
6.2 Creating a New Project File. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-4
6.3 Opening a Project File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-5
6.4 Deleting and Restoring Project Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-6

6.4.1 Deleting Projects. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-6
6.4.2 Restoring Projects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-7

6.5 Renaming a Project File. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-8
6.5.1 Renaming the Active Project File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-8
6.5.2 Renaming a Saved Project File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-9

6.6 Creating a Copy of a Project File. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-10
6.7 Checking In a Project File . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-11
6.8 Viewing Project Contents  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-13

6.8.1 Restoring Deleted Project Items . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-14
6.9 Reverting Projects . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-15

6.9.1 Reverting Project Contents to a Certain Date and Time. . . . . . . . . . . . 6-15
6.9.2 Discarding All Changes Since Last Check In. . . . . . . . . . . . . . . . . . . . 6-17
6.9.3 Reverting Individual Project Items to a Specific Revision. . . . . . . . . . 6-19

6.10 Importing and Exporting Project Files. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 6-20
6.10.1 Exporting a Project File to a Biomek Import File  . . . . . . . . . . . . . . . . 6-20
6.10.2 Importing a Project File from a Biomek Import File . . . . . . . . . . . . . . 6-22

7 Creating and Modifying Tip and Labware Types
7.1 Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-1
7.2 Defining Tips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-3

7.2.1 Accessing the Tip Type Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-4
7.2.2 Adding New Tips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-5
7.2.3 Changing Tip Properties . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-6
7.2.4 Removing Tips . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-8

7.3 Defining Labware Types . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-9
7.3.1 Accessing the Labware Type Editor . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-9
7.3.2 Adding a New Labware Type. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-10
7.3.3 Copying a Labware Type . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-11
7.3.4 Deleting a Labware Type . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-12
7.3.5 Renaming a Labware Type . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-13
7.3.6 Editing Labware Type Properties . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 7-14



xiv Table of Contents

Beckman Coulter, Inc.

8 Understanding and Creating Liquid Types
8.1 Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-1

8.1.1 Understanding Liquid Types  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-3
8.2 Creating New Liquid Types. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-4

8.2.1 Changing the Aspirate and Dispense Speeds in the Liquid Type Editor . . 8-7
8.2.2 Changing the Cutoff Velocity for Span-8 Pods in Liquid Type Editor 

(FX, NX-S8 only) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-8
8.3 Removing Liquid Types  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-10
8.4 Copying and Pasting Liquid Types Within a Project File . . . . . . . . . . . . . . . . . . 8-10
8.5 Specifying the Default Liquid Type  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 8-11

9 Understanding and Creating Techniques
9.1 Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-1

9.1.1 How Techniques Work . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-1
9.1.2 Why Techniques are Valuable  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-2

9.2 Accessing the Technique Browser. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-3
9.2.1 Identifying Techniques . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-4

9.3 Creating New Techniques . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-5
9.4 Setting Technique Values . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-9

9.4.1 Viewing Technique Description . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-10
9.4.2 Setting Aspirate Values  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-12
9.4.3 Setting Dispense Values . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-14
9.4.4 Setting Mix Values . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-17
9.4.5 Setting Liquid Level Sensing Values (FX, 3000, and NX-S8 only). . . 9-19
9.4.6 Setting Clot Detection Values (NX-S8 only) . . . . . . . . . . . . . . . . . . . . 9-25
9.4.7 Setting Piercing Values (NX-S8 only) . . . . . . . . . . . . . . . . . . . . . . . . . 9-29
9.4.8 Overriding Liquid Type Values  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-30

9.5 Calibrating Techniques  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-34
9.6 Conditioning Techniques for Multiple Dispense (FX, NX-S8 only). . . . . . . . . . 9-36
9.7 Creating Technique Groups . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-39

9.7.1 Renaming Groups . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-40
9.7.2 Adding and Removing Techniques from Groups . . . . . . . . . . . . . . . . . 9-41
9.7.3 Removing Groups . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-42

9.8 Removing Techniques . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-43
9.9 Modifying Saved Techniques  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-44
9.10 Selecting and Modifying Techniques Manually in a Method . . . . . . . . . . . . . . . 9-45

9.10.1 Modifying a Technique Through a Method Step . . . . . . . . . . . . . . . . . 9-46
9.10.2 Saving Custom Techniques  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 9-48

10 Using the Pipetting Template Editor
10.1 Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10-1
10.2 Creating and Modifying Pipetting Templates . . . . . . . . . . . . . . . . . . . . . . . . . . . 10-2

10.2.1 Viewing Existing Pipetting Templates . . . . . . . . . . . . . . . . . . . . . . . . . 10-3
10.2.2 Creating a New Pipetting Template . . . . . . . . . . . . . . . . . . . . . . . . . . . 10-4
10.2.3 Modifying Existing Pipetting Templates  . . . . . . . . . . . . . . . . . . . . . . . 10-7



Table of Contents xv

Biomek Software User’s Manual

10.3 Understanding Context Variables  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10-8
10.3.1 Inserting Variables and Expressions. . . . . . . . . . . . . . . . . . . . . . . . . . . 10-8
10.3.2 Defining Context Variables  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10-10

10.4 Using Volume Conditioning in Pipetting Templates (FX, NX-S8 only)  . . . . . 10-15
10.4.1 About ListMath. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10-15

10.5 Configuring Pipetting Template Steps. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10-17
10.5.1 If, Comment, and Loop. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10-17
10.5.2 Clot Detection (NX-S8 only)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10-18
10.5.3 Aspirate Air Gap. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10-20
10.5.4 Aspirate . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10-21
10.5.5 Moving Aspirate . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10-22
10.5.6 Dispense Air Gap . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10-24
10.5.7 Dispense . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10-25
10.5.8 Moving Dispense  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10-26
10.5.9 Mix . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10-28
10.5.10 Prewet . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10-30
10.5.11 Tip Touch . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10-31
10.5.12 Axes Move . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10-33
10.5.13 Pause . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 10-34
10.5.14 Bulk Dispense (FX and NX-S8 only) . . . . . . . . . . . . . . . . . . . . . . . . . 10-35

11 Creating Well Patterns
11.1 Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11-1
11.2 Creating a New Well Pattern . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11-3
11.3 Copying a Well Pattern . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11-5
11.4 Deleting a Well Pattern . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11-6
11.5 Renaming a Well Pattern . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 11-7

12 Creating and Using Methods
12.1 Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-1
12.2 Creating a New Method. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-3

12.2.1 Configuring the Start Step  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-4
12.2.2 Configuring the Finish Step . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-7

12.3 Inserting Steps in a Method . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-13
12.3.1 Understanding Techniques . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-14

12.4 Using Additional Step Palettes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-15
12.5 Copying, Cutting, and Pasting Steps in a Method . . . . . . . . . . . . . . . . . . . . . . . 12-16
12.6 Deleting Steps in a Method . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-17
12.7 Using Undo and Redo in Method Building . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-18

12.7.1 Using Undo . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-18
12.7.2 Using Redo . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-18

12.8 Entering and Viewing Method Properties . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-19
12.9 Saving a Method  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-20
12.10 Checking In a Method . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-22
12.11 Validating a Method  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-24
12.12 Signing a Method. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-26



xvi Table of Contents

Beckman Coulter, Inc.

12.13 Viewing Method History . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-27
12.13.1 Viewing Revision History  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-27
12.13.2 Viewing Validated Run History . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-28

12.14 Opening a Saved Method. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-30
12.15 Checking Out a Method. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-32
12.16 Importing and Exporting Methods. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-34

12.16.1 Exporting a Method  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-35
12.16.2 Exporting All Methods Associated With a Project File . . . . . . . . . . . 12-36
12.16.3 Importing Methods . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-37

12.17 Deleting and Restoring Methods . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-40
12.17.1 Deleting Methods . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-40
12.17.2 Restoring Methods . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-41

12.18 Running, Pausing, and Stopping a Method . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-44
12.18.1 Running a Method  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-44
12.18.2 Pausing a Method in Progress. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-51
12.18.3 Stopping a Method in Progress . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-52
12.18.4 Snapping a Continuation (FX, NX only)  . . . . . . . . . . . . . . . . . . . . . . 12-52
12.18.5 Disabling Steps Within a Method. . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-53
12.18.6 Purging Air From Span-8 Pod Before a Method Run 

(FX and NX-S8 Only)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-54
12.19 Printing a Method  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-55
12.20 Improving a Method  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-56

12.20.1 Running the Method at Slow Speed . . . . . . . . . . . . . . . . . . . . . . . . . . 12-56
12.20.2 Snapping a Continuation (FX and NX Only) . . . . . . . . . . . . . . . . . . . 12-57
12.20.3 Using Logging  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 12-58

13 Using Variables and Expressions in a Method
13.1 Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13-1
13.2 Using Variables . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13-2

13.2.1 Creating Variables  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13-3
13.2.2 Using Variables in a Method  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13-4

13.3 Using Expressions . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 13-6

14 Using Sample Tracking and Data Sets in a Method
14.1 Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14-1

14.1.1 Sample Tracking . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14-1
14.1.2 Data Set Definition . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14-1
14.1.3 Data Set Steps in the Biomek Software  . . . . . . . . . . . . . . . . . . . . . . . . 14-2
14.1.4 Example of Sample Tracking Using Data Sets. . . . . . . . . . . . . . . . . . . 14-2

14.2 Understanding How Data Sets Are Created  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 14-3
14.2.1 Understanding the Volume Data Set  . . . . . . . . . . . . . . . . . . . . . . . . . . 14-3

14.3 Using Data Sets in a Transfer or Combine Step  . . . . . . . . . . . . . . . . . . . . . . . . . 14-4
14.3.1 Defining Well Patterns Using Data Sets. . . . . . . . . . . . . . . . . . . . . . . . 14-5
14.3.2 Specifying Volumes Using Data Sets . . . . . . . . . . . . . . . . . . . . . . . . . . 14-8



Table of Contents xvii

Biomek Software User’s Manual

15 Using the Basic Step Palette
15.1 Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15-1
15.2 Instrument Setup Step . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15-3

15.2.1 Selecting a Deck Layout . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15-5
15.2.2 Verifying Deck Layout . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15-6
15.2.3 Configuring Pod Setup Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15-7
15.2.4 Populating the Deck with Labware. . . . . . . . . . . . . . . . . . . . . . . . . . . . 15-9
15.2.5 Configuring Tip and Labware Properties . . . . . . . . . . . . . . . . . . . . . . 15-15
15.2.6 Creating the SampleID Data Set Using the Instrument Setup Step . . 15-23
15.2.7 Creating Custom Labware  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15-26

15.3 Configuring Transfer and Combine Steps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15-29
15.3.1 Configuring Tip Handling  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15-30
15.3.2 Configuring Source Labware . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15-35
15.3.3 Configuring Destination Labware  . . . . . . . . . . . . . . . . . . . . . . . . . . . 15-44
15.3.4 Configuring Transfer Details  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15-53

15.4 Move Labware Step . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15-56
15.4.1 Inserting a Move Labware Step  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15-56
15.4.2 Configuring the Move Labware Step . . . . . . . . . . . . . . . . . . . . . . . . . 15-57

15.5 Pause Step  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15-58
15.5.1 Configuring a Pause for a Specific Deck Position or Pod  . . . . . . . . . 15-60
15.5.2 Pausing the Whole System and Displaying a Message  . . . . . . . . . . . 15-61

15.6 Comment Step . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 15-62

16 Using the Intermediate Step Palette
16.1 Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16-1
16.2 Displaying the Intermediate Step Palette. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16-3
16.3 Aspirate Step . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16-4

16.3.1 Configuring the Aspirate Step  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16-6
16.4 Dispense Step. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16-9

16.4.1 Configuring the Dispense Step . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16-10
16.5 Mix Step. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16-14

16.5.1 Configuring the Mix Step . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16-15
16.6 Wash Step  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16-17

16.6.1 Configuring the Wash Step. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16-18
16.7 New Tips Step . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16-19
16.8 Unload Tips Step . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16-21
16.9 Loop Step. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16-23

16.9.1 Configuring a Loop Step and Creating a New Variable . . . . . . . . . . . 16-24
16.9.2 Configuring a Loop Step Using an Existing Variable  . . . . . . . . . . . . 16-27

16.10 Cleanup Step  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16-30
16.11 Move Pod Step. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16-33
16.12 Group Step . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 16-35



xviii Table of Contents

Beckman Coulter, Inc.

17 Using the Advanced Step Palette
17.1 Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17-1
17.2 Displaying the Advanced Step Palette. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17-3
17.3 Run Method Step . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17-4

17.3.1 Configuring the Run Method Step . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17-5
17.4 Worklist Step . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17-6

17.4.1 Configuring the Worklist Step  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17-8
17.5 Just in Time Step . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17-9
17.6 Let Step  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17-11

17.6.1 Configuring the Let Step. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17-12
17.7 If Step. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17-13

17.7.1 Configuring the If Step . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17-14
17.8 Script Step . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17-15

17.8.1 Configuring the Script Step  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17-17
17.9 Scripted Let Step . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 17-18

17.9.1 Configuring the Scripted Let Step  . . . . . . . . . . . . . . . . . . . . . . . . . . . 17-20

18 Using the Span-8 Step Palette
18.1 Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18-1
18.2 Displaying the Span-8 Step Palette . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18-3
18.3 Serial Dilution Step (including 3000)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18-4

18.3.1 Configuring the Serial Dilution Step  . . . . . . . . . . . . . . . . . . . . . . . . . . 18-6
18.3.2 Configuring Diluent Properties. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18-12

18.4 Span-8 Aspirate Step . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18-16
18.4.1 Configuring the Span-8 Aspirate Step  . . . . . . . . . . . . . . . . . . . . . . . . 18-18

18.5 Span-8 Dispense Step  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18-23
18.5.1 Configuring the Span-8 Dispense Step. . . . . . . . . . . . . . . . . . . . . . . . 18-25

18.6 Span-8 New Tips Step . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18-31
18.6.1 Configuring the Span-8 New Tips Step . . . . . . . . . . . . . . . . . . . . . . . 18-32

18.7 Span-8 Tip Discard Step  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18-33
18.7.1 Configuring the Span-8 Tip Discard Step. . . . . . . . . . . . . . . . . . . . . . 18-34

18.8 Span-8 Wash Tips Step . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18-35
18.8.1 Configuring the Span-8 Wash Tips Step for a Passive Wash. . . . . . . 18-36
18.8.2 Configuring the Span-8 Wash Tips Step for an Active Wash  . . . . . . 18-39

18.9 Transfer From File Step (including 3000) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18-41
18.9.1 Configuring Tip Handling  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18-43
18.9.2 Configuring File Properties  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18-47
18.9.3 Configuring Source Labware . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18-51
18.9.4 Configuring Destination Labware  . . . . . . . . . . . . . . . . . . . . . . . . . . . 18-55
18.9.5 Configuring Transfer Details  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18-62

18.10 Define Pattern Step (including 3000)  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18-64
18.10.1 Configuring the Define Pattern Step by Specifying the 

Wells Manually. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 18-65
18.10.2 Configuring the Define Pattern Step Reading from a File . . . . . . . . . 18-66
18.10.3 Using a Defined Pattern in a Transfer or Combine Step  . . . . . . . . . . 18-69



Table of Contents xix

Biomek Software User’s Manual

19 Using the HDR Step Palette (FX, 3000 only)
19.1 Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19-1
19.2 Displaying the HDR Step Palette. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19-2
19.3 Using the HDR Transfer and Combine Steps  . . . . . . . . . . . . . . . . . . . . . . . . . . . 19-3

19.3.1 Washing Pins Between Transfers . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19-6
19.3.2 Configuring Source Labware . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19-7
19.3.3 Configuring Destination Labware  . . . . . . . . . . . . . . . . . . . . . . . . . . . 19-13

19.4 Using the HDR Tool Cleaning Step  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19-20
19.4.1 Configuring Cleaning Operations . . . . . . . . . . . . . . . . . . . . . . . . . . . . 19-21

19.5 Using the HDR Move Labware Step (FX only)  . . . . . . . . . . . . . . . . . . . . . . . . 19-30
19.5.1 Configuring the HDR Move Labware Step  . . . . . . . . . . . . . . . . . . . . 19-31

20 Using the Biomek 3000 Step Palette
20.1 Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20-1
20.2 Displaying the Biomek 3000 Step Palette . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20-3
20.3 Change Tool Step. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20-4
20.4 Load Tool Step. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20-5
20.5 Unload Tool Step . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20-7
20.6 Remove to Waste Step. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20-8
20.7 Bulk Dispense Step . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20-10
20.8 Purge Wash Tool Step . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20-13
20.9 Wash Plate Step . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 20-15

21 Using the Specialty Step Palette
21.1 Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21-1
21.2 Displaying the Speciality Step Palette . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21-3
21.3 Create Group Step . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21-4

21.3.1 Configuring the Create Group Step  . . . . . . . . . . . . . . . . . . . . . . . . . . . 21-4
21.4 Next Labware Step. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21-7

21.4.1 Configuring the Next Labware Step . . . . . . . . . . . . . . . . . . . . . . . . . . . 21-7
21.4.2 Using Group Variables in a Method . . . . . . . . . . . . . . . . . . . . . . . . . . . 21-9

21.5 Run Program Step . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21-10
21.5.1 Configuring the Run Program Step  . . . . . . . . . . . . . . . . . . . . . . . . . . 21-10

21.6 Next Item Step . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21-13
21.6.1 Configuring the Next Item Step . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21-14

21.7 Set Global Step  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21-16
21.7.1 Configuring the Set Global Step . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21-16

21.8 Defining and Running Procedures . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21-18
21.8.1 Define Procedure Step  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21-18
21.8.2 Run Procedure Step  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21-20

21.9 Break Step . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21-21
21.9.1 Configuring the Break Step  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 21-21



xx Table of Contents

Beckman Coulter, Inc.

22 Using the Devices Step Palette
22.1 Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-1
22.2 Displaying the Devices Step Palette  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-3
22.3 SPE Step  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-4

22.3.1 Configuring the SPE Step . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-5
22.4 Using External Devices with Biomek Laboratory Automation Workstations  . . 22-7

22.4.1 Configuring Devices Using the Device Editor . . . . . . . . . . . . . . . . . . . 22-7
22.5 Device Setup Step . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-9

22.5.1 Configuring the Device Setup Step  . . . . . . . . . . . . . . . . . . . . . . . . . . 22-10
22.6 Device Action Step  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-16

22.6.1 Configuring the Device Action Step. . . . . . . . . . . . . . . . . . . . . . . . . . 22-17
22.7 Tip Loader Step (FX, NX-MC only) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-37

22.7.1 Configuring the Tip Loader Step  . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-38
22.8 SILAS Module Step. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-39

22.8.1 Configuring the SILAS Module . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-39
22.8.2 Configuring Runtime Data . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 22-41
22.8.3 Creating Data Sets from SILAS Messages . . . . . . . . . . . . . . . . . . . . . 22-42

23 Using the Stacker Carousel Step Palette
23.1 Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23-1
23.2 Displaying the Stacker Carousel Step Palette . . . . . . . . . . . . . . . . . . . . . . . . . . . 23-2
23.3 Using the Stacker Setup Step. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23-3

23.3.1 Configuring the Placement of Labware in the Hotels. . . . . . . . . . . . . . 23-3
23.3.2 Configuring the Properties of the Labware in the Hotels . . . . . . . . . . . 23-6

23.4 Using the Present Step . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23-12
23.4.1 Configuring from which Hotel Labware is Presented  . . . . . . . . . . . . 23-12
23.4.2 Configuring Bar Code Reading Options. . . . . . . . . . . . . . . . . . . . . . . 23-13

23.5 Using the Store Step  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 23-14

24 Using the Data Sets Step Palette
24.1 Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24-1
24.2 Displaying the Data Sets Step Palette . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24-2
24.3 Configuring the Create Data Set Step . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24-3

24.3.1 Configuring File Options  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24-4
24.3.2 Configuring Input Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24-9
24.3.3 Configuring Output Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24-13

24.4 Configuring the Data Set Management Step . . . . . . . . . . . . . . . . . . . . . . . . . . . 24-16
24.4.1 Copying a Data Set . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24-16
24.4.2 Renaming a Data Set. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24-17
24.4.3 Removing a Data Set  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24-19
24.4.4 Changing the Properties of a Data Set  . . . . . . . . . . . . . . . . . . . . . . . . 24-20

24.5 Configuring the Data Set Processing Step. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24-22
24.5.1 Understanding Expressions. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24-24

24.6 Configuring the Reporting Step. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24-25
24.6.1 Report Styles. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 24-26
24.6.2 Configuring a SQL Server Report Style . . . . . . . . . . . . . . . . . . . . . . . 24-29



Table of Contents xxi

Biomek Software User’s Manual

25 Handling and Preventing Errors
25.1 Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25-1

25.1.1 Error Message Overview  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25-1
25.1.2 Error Recovery Overview. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25-2
25.1.3 Error Prevention Overview. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25-2

25.2 Configuration Errors  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25-3
25.2.1 Configuration Error Messages  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25-3
25.2.2 Recovering from Configuration Errors. . . . . . . . . . . . . . . . . . . . . . . . . 25-5

25.3 Validation Errors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25-6
25.3.1 Validation Error Messages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25-6
25.3.2 Validating a Method Before Run . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25-6
25.3.3 Recovering from Validation Errors  . . . . . . . . . . . . . . . . . . . . . . . . . . 25-10

25.4 Manual Control Errors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25-11
25.4.1 Manual Control Error Messages and Recovery . . . . . . . . . . . . . . . . . 25-11

25.5 Run-Time Errors  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25-12
25.5.1 Run-Time Error Messages  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25-12
25.5.2 Recovering from Run-Time Errors. . . . . . . . . . . . . . . . . . . . . . . . . . . 25-13

25.6 Light Curtain Errors. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25-15
25.6.1 Light Curtain Error Messages. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25-15
25.6.2 Recovery Options for Light Curtain Errors  . . . . . . . . . . . . . . . . . . . . 25-15
25.6.3 Using the Stop Button on the Biomek 3000 . . . . . . . . . . . . . . . . . . . . 25-17

25.7 Liquid Level Sensing Errors  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25-18
25.7.1 Liquid Level Sensing on the FX and NX-S8 . . . . . . . . . . . . . . . . . . . 25-18
25.7.2 Liquid Level Sensing on the Biomek 3000  . . . . . . . . . . . . . . . . . . . . 25-18
25.7.3 Recovering from Liquid Level Sensing Errors. . . . . . . . . . . . . . . . . . 25-18

25.8 Clot Detection Error Message (NX-S8 only)  . . . . . . . . . . . . . . . . . . . . . . . . . . 25-21
25.8.1 Retrying Has Not Resolved the Clot. . . . . . . . . . . . . . . . . . . . . . . . . . 25-21

25.9 Multiple Error Messages . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25-22
25.9.1 Recovering from Multiple Errors . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25-22

25.10 Observed Errors . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25-23
25.10.1 Recovering from Observed Errors  . . . . . . . . . . . . . . . . . . . . . . . . . . . 25-23

25.11 Using Continuations (not available on a 3000) . . . . . . . . . . . . . . . . . . . . . . . . . 25-25
25.11.1 Characteristics of Continuations . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25-25
25.11.2 Snapping a Continuation. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25-26
25.11.3 Loading and Running a Continuation. . . . . . . . . . . . . . . . . . . . . . . . . 25-29

25.12 Performing Single Operations Within Steps . . . . . . . . . . . . . . . . . . . . . . . . . . . 25-30

26 Generating and Using Log Data
26.1 Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26-1
26.2 Types of Logs  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26-3

26.2.1 Details Log . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26-3
26.2.2 Errors Log . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26-4
26.2.3 Pipetting Log. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26-4
26.2.4 Span8Pipetting Log (FX, NX-S8 only)  . . . . . . . . . . . . . . . . . . . . . . . . 26-4
26.2.5 Span8Transfer Log (FX, NX-S8 only) . . . . . . . . . . . . . . . . . . . . . . . . . 26-5
26.2.6 UnifiedPipetting Log  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26-5
26.2.7 UnifiedTransfer Log . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26-5



xxii Table of Contents

Beckman Coulter, Inc.

26.3 Log Contents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26-6
26.3.1 Details Log Contents  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26-6
26.3.2 Errors Log Contents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26-6
26.3.3 Pipetting Log Contents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26-7
26.3.4 Span-8Pipetting Log Contents (FX, NX-S8 only) . . . . . . . . . . . . . . . . 26-7
26.3.5 Span-8Transfer Log Contents (FX, NX-S8 only). . . . . . . . . . . . . . . . . 26-8
26.3.6 UnifiedPipetting Log Contents . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26-9
26.3.7 UnifiedTransfer Log Contents  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26-11

26.4 Selecting Log Types  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26-13
26.5 Viewing Log Files . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26-14

27 Using Manual Control
27.1 Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27-1
27.2 Accessing Manual Control. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27-2
27.3 Understanding the Options in Manual Control . . . . . . . . . . . . . . . . . . . . . . . . . . 27-3

28 Scripting
28.1 Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28-1
28.2 Using the Script Steps . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28-2
28.3 Scripting Data Sets. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28-2

28.3.1 Procedure to Script Data Sets . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 28-3

29 Changing Window Appearance
29.1 Overview . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29-1
29.2 Changing Display Preferences. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29-4

29.2.1 Configuring General Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29-5
29.2.2 Configuring View Options . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29-7
29.2.3 Configuring Errors Options  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29-9

29.3 Toggling Toolbars and Step Palettes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29-11
29.4 Customizing Step Palettes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29-14

29.4.1 Displaying Large Step Palette and Toolbar Views. . . . . . . . . . . . . . . 29-14
29.4.2 Changing Step Properties . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29-16
29.4.3 Modifying a Step Caption in Method View . . . . . . . . . . . . . . . . . . . . 29-17

29.5 Using the Step Palette Builder . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29-18
29.5.1 Accessing the Step Palette Builder . . . . . . . . . . . . . . . . . . . . . . . . . . . 29-19
29.5.2 Displaying and Hiding Step Palettes  . . . . . . . . . . . . . . . . . . . . . . . . . 29-20
29.5.3 Customizing Step Palettes  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29-20
29.5.4 Creating a New Step Palette . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29-23
29.5.5 Modifying Step Palette Properties  . . . . . . . . . . . . . . . . . . . . . . . . . . . 29-23
29.5.6 Deleting a Step Palette  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 29-24

Index. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . xxxix



Biomek Software User’s Manual

xxiii

List of Figures

Figure 2-1. Support Options ........................................................................................................ 2-3
Figure 2-2. Account Management ............................................................................................... 2-5
Figure 2-3. Password Restore ...................................................................................................... 2-7
Figure 2-4. Accounts & Permissions Audit Log.......................................................................... 2-8
Figure 2-5. Log on/off button — no user logged on.................................................................... 2-9
Figure 2-6. Logon ........................................................................................................................ 2-9
Figure 2-7. Administrator Notification ...................................................................................... 2-10
Figure 2-8. Log on/off button — user logged on....................................................................... 2-11
Figure 2-9. Current Permissions ................................................................................................ 2-11
Figure 2-10. Log on/off button — user logged on..................................................................... 2-11
Figure 3-1. Biomek method editor............................................................................................... 3-2
Figure 3-2. Save Instrument......................................................................................................... 3-3
Figure 3-3. Open Instrument........................................................................................................ 3-4
Figure 3-4. Import/Export Utility ................................................................................................ 3-6
Figure 3-5. Exporting deck layout Deck1 to an import file......................................................... 3-7
Figure 3-6. Save Import File........................................................................................................ 3-8
Figure 3-7. Confirmation to address to overwrite an imported setting........................................ 3-9
Figure 3-8. Open Instrument file ............................................................................................... 3-10
Figure 3-9. Open Instrument showing backup files................................................................... 3-10
Figure 4-1. Hardware Setup for a Biomek FX instrument 

with a Multichannel Pod and Span-8 Pod............................................................ 4-2
Figure 4-2. Hardware Setup — configuring the simulator settings ............................................. 4-4
Figure 4-3. Selecting a background color .................................................................................... 4-5
Figure 4-4. Simulator Preview with camera navigation buttons enabled .................................... 4-7
Figure 4-5. Camera Navigation buttons....................................................................................... 4-8
Figure 4-6. Hardware Setup — configuring camera controls...................................................... 4-9
Figure 4-7. Hardware Setup — configuring materials............................................................... 4-11
Figure 5-1. Deck relationship in Biomek 3000............................................................................ 5-2
Figure 5-2. Deck Editor showing Deck1 for a Biomek FX ......................................................... 5-4
Figure 5-3. Deck Editor for a Biomek FX ................................................................................... 5-6
Figure 5-4. Deck Editor for a Biomek 3000 ................................................................................ 5-7



xxiv List of Figures

Beckman Coulter, Inc.

Figure 5-5. Deck Editor for a Biomek NX-MC........................................................................... 5-8
Figure 5-6. Deck Editor for a Biomek NX-S8............................................................................. 5-9
Figure 5-7. Previews deck selected............................................................................................ 5-10
Figure 5-8. Enter a new name for the deck................................................................................ 5-11
Figure 5-9. Confirmation to cancel changes .............................................................................. 5-11
Figure 5-10. Delete Deck confirmation ..................................................................................... 5-12
Figure 5-11. Change deck name ................................................................................................ 5-13
Figure 5-12. Error in renaming .................................................................................................. 5-13
Figure 5-13. Confirmation to delete ALP.................................................................................. 5-14
Figure 5-14. Possible OneByThree deck positions highlighted on a Biomek FX deck ............ 5-15
Figure 5-15. Warning appears because an ALP is about to be placed 

where it will overlap another ALP..................................................................... 5-15
Figure 5-16. Position and Labware Offset locations on the OnebyOne ALP............................ 5-17
Figure 5-17. ALP Properties of a OneByThree ALP................................................................. 5-18
Figure 5-18. Position Properties for Deck Positions.................................................................. 5-19
Figure 5-19. Per-Labware Offsets.............................................................................................. 5-21
Figure 6-1. Biomek method editor............................................................................................... 6-2
Figure 6-2. Create new project .................................................................................................... 6-4
Figure 6-3. Opening a project file................................................................................................ 6-5
Figure 6-4. Open Project.............................................................................................................. 6-6
Figure 6-5. Confirm deletion of selected project ......................................................................... 6-6
Figure 6-6. Recycled projects ...................................................................................................... 6-7
Figure 6-7. Renaming the open project ....................................................................................... 6-8
Figure 6-8. Open Project.............................................................................................................. 6-9
Figure 6-9. Saving project as to create a copy........................................................................... 6-10
Figure 6-10. Checking in project items as official records........................................................ 6-11
Figure 6-11. Check-In (Accounts & Permissions enabled) ....................................................... 6-12
Figure 6-12. Viewing project contents (Accounts & Permissions enabled).............................. 6-13
Figure 6-13. History of a project record .................................................................................... 6-14
Figure 6-14. Viewing project contents ...................................................................................... 6-15
Figure 6-15. Reverting a project file to a specific date and time............................................... 6-16
Figure 6-16. Viewing project contents ...................................................................................... 6-17
Figure 6-17. Discarding changes to a project file after a specific date and time....................... 6-18
Figure 6-18. Viewing project contents ...................................................................................... 6-19
Figure 6-19. History of a project item ....................................................................................... 6-19
Figure 6-20. Selecting project contents to export ...................................................................... 6-20
Figure 6-21. Save Import File.................................................................................................... 6-21
Figure 6-22. Open Import File ................................................................................................... 6-22
Figure 6-23. Checking in project items as official records........................................................ 6-23
Figure 6-24. Information that appears when no project items are imported.............................. 6-23
Figure 6-25. Check-In (Accounts & Permissions enabled) ....................................................... 6-24
Figure 7-1. Relationships for labware and tips in Biomek Software........................................... 7-2
Figure 7-2. Tip Types .................................................................................................................. 7-4
Figure 7-3. Adding a new tip type ............................................................................................... 7-5
Figure 7-4. Warning to confirm cancellation of changes ............................................................ 7-5
Figure 7-7. Remove tips warning ................................................................................................ 7-8



List of Figures xxv

Biomek Software User’s Manual

Figure 7-8. Labware Types .......................................................................................................... 7-9
Figure 7-9. New Labware .......................................................................................................... 7-10
Figure 7-10. Copy Labware Type.............................................................................................. 7-11
Figure 7-11. Information............................................................................................................ 7-12
Figure 7-12. Rename Labware Type ......................................................................................... 7-13
Figure 7-13. Basic Information chosen...................................................................................... 7-16
Figure 7-14. Labware Colors ..................................................................................................... 7-17
Figure 7-15. Color...................................................................................................................... 7-17
Figure 7-16. Warning to confirm cancellation of changes made............................................... 7-18
Figure 7-17. Sections chosen ..................................................................................................... 7-19
Figure 7-18. Error reminder that sections are deleted................................................................ 7-19
Figure 7-19. Edit Section Profile ............................................................................................... 7-20
Figure 7-20. Edit Section Top.................................................................................................... 7-20
Figure 7-21. Error for an improperly configured reservoir........................................................ 7-21
Figure 7-22. Stacking chosen..................................................................................................... 7-22
Figure 7-23. Stackable Items ..................................................................................................... 7-23
Figure 7-24. Secure Stacking..................................................................................................... 7-25
Figure 7-25. Wells_1 chosen ..................................................................................................... 7-26
Figure 7-26. Well Configuration Dialog.................................................................................... 7-27
Figure 7-27. Well Configuration Dialog with Bottom Section checked ................................... 7-28
Figure 8-1. Liquid Type Editor.................................................................................................... 8-2
Figure 8-2. Liquid Type Editor with a new liquid ....................................................................... 8-4
Figure 8-3. Liquid Type Editor.................................................................................................... 8-9
Figure 9-1. Technique Browser ................................................................................................... 9-3
Figure 9-2. Technique Browser where technique parameters are displayed ............................... 9-4
Figure 9-3. Setting Technique Properties for a Biomek FX technique ....................................... 9-7
Figure 9-4. Technique Editor — General tab ............................................................................ 9-10
Figure 9-5. Technique Editor — Aspirate tab ........................................................................... 9-12
Figure 9-6. Technique Editor — Dispense tab .......................................................................... 9-15
Figure 9-7. Technique Editor — Mix tab .................................................................................. 9-17
Figure 9-8. Technique Editor — General Settings on Liquid Level Sensing tab ...................... 9-20
Figure 9-9. Technique Editor — Repetition Settings on Liquid Level Sensing tab .................. 9-21
Figure 9-10. Technique Editor — Sensitivity Settings on Liquid Level Sensing tab ............... 9-22
Figure 9-11. Technique Editor — Error Handling Settings on Liquid Level Sensing tab ........ 9-23
Figure 9-12. Liquid Level Sensing Error Handling prompt for Biomek 3000 .......................... 9-24
Figure 9-13. Technique Editor — General Settings on Clot Detection tab ............................... 9-26
Figure 9-14. Technique Editor - Sensitivity Settings on Clot Detection tab ............................. 9-27
Figure 9-15. Technique Editor - Error Handling Settings on Clot Detection tab ...................... 9-28
Figure 9-16. Technique Editor - Piercing tab ............................................................................ 9-29
Figure 9-17. Technique Editor — Liquid Type tab ................................................................... 9-31
Figure 9-18. Technique Editor — Volume Calibration on Calibration Tab.............................. 9-35
Figure 9-20. Technique Editor — Volume Conditioning on Calibration Tab........................... 9-38
Figure 9-21. Creating a new group in the Technique Browser.................................................. 9-39
Figure 9-22. New group created in the Technique Browser...................................................... 9-40
Figure 9-23. Creating a new group in the Technique Browser.................................................. 9-41
Figure 9-24. Remove technique confirmation prompt............................................................... 9-43



xxvi List of Figures

Beckman Coulter, Inc.

Figure 9-25. Customize techniques or manually select techniques from a list in source or 
destination configurations of a pipetting step .................................................... 9-45

Figure 9-26. Technique selection within a method.................................................................... 9-46
Figure 9-27. Dispense Tab appears when Customize is selected from destination ................... 9-47
Figure 9-28. Save a custom technique within a step.................................................................. 9-48
Figure 10-1. Pipetting Template Editor ..................................................................................... 10-2
Figure 10-2. New pipetting template ......................................................................................... 10-4
Figure 10-3. Rename pipetting template.................................................................................... 10-5
Figure 10-4. Technique Browser ............................................................................................... 10-5
Figure 10-5. Technique Editor................................................................................................... 10-6
Figure 10-6. Selecting variable from selected group................................................................. 10-9
Figure 10-7. Identifying the location of Technique Editor context variables.......................... 10-10
Figure 10-8. Identifying the location of Liquid Type Editor context variables....................... 10-11
Figure 10-9. Clot Detection step configuration ....................................................................... 10-18
Figure 10-10. Aspirate Air Gap step configuration ................................................................. 10-20
Figure 10-11. Aspirate step configuration ............................................................................... 10-21
Figure 10-12. Moving Aspirate step configuration ................................................................. 10-22
Figure 10-13. Dispense Air Gap step configuration ................................................................ 10-24
Figure 10-14. Dispense step configuration .............................................................................. 10-25
Figure 10-15. Moving Dispense step configuration ................................................................ 10-26
Figure 10-16. Mix step configuration ...................................................................................... 10-28
Figure 10-17. Prewet step configuration.................................................................................. 10-30
Figure 10-18. Tip Touch step configuration ............................................................................ 10-31
Figure 10-19. Axes Move step configuration .......................................................................... 10-33
Figure 10-20. Pause step configuration ................................................................................... 10-34
Figure 10-21. Bulk Dispense step configuration ..................................................................... 10-35
Figure 11-1. Well Patterns ......................................................................................................... 11-2
Figure 11-2. New Pattern........................................................................................................... 11-3
Figure 11-3. Warning when Cancel is chosen ........................................................................... 11-4
Figure 11-4. Copy Pattern.......................................................................................................... 11-5
Figure 11-5. Warning confirming deletion of a pattern............................................................. 11-6
Figure 11-6. Rename Pattern ..................................................................................................... 11-7
Figure 12-1. Biomek Software main editor for method creation............................................... 12-2
Figure 12-2. Biomek Software main editor for dual-pod Biomek FX instrument .................... 12-3
Figure 12-3. Start step and configuration .................................................................................. 12-5
Figure 12-4. Start step with variables configured...................................................................... 12-6
Figure 12-5. Prompt to enter value for variable at runtime ....................................................... 12-7
Figure 12-6. The Finish step configuration for a Biomek FX instrument ................................. 12-8
Figure 12-7. Finish step options for a Biomek 3000 instrument ............................................. 12-10
Figure 12-8. Reporting enabled on Finish step........................................................................ 12-11
Figure 12-9. Prompt when method is aborted.......................................................................... 12-12
Figure 12-10. Inserting a step into a method ........................................................................... 12-13
Figure 12-11. Inserting a step by drag and drop ...................................................................... 12-13
Figure 12-12. Step palette menu .............................................................................................. 12-15
Figure 12-13. Confirmation to delete steps in a method.......................................................... 12-17
Figure 12-14. Method Properties ............................................................................................. 12-19



List of Figures xxvii

Biomek Software User’s Manual

Figure 12-15. Save method...................................................................................................... 12-20
Figure 12-16. Biomek Software main editor after saving method ExampleMethod............... 12-21
Figure 12-17. Check In ............................................................................................................ 12-22
Figure 12-18. Check-In............................................................................................................ 12-23
Figure 12-19. Signature ........................................................................................................... 12-25
Figure 12-20. Signature ........................................................................................................... 12-26
Figure 12-21. Method history .................................................................................................. 12-27
Figure 12-22. Validated Run History displayed in validated mode ........................................ 12-28
Figure 12-23. Print Preview..................................................................................................... 12-29
Figure 12-24. Open saved methods ......................................................................................... 12-30
Figure 12-25. Check Out Method (Accounts & Permissions enabled) ................................... 12-32
Figure 12-26. Export Method .................................................................................................. 12-35
Figure 12-27. Browse For Folder ............................................................................................ 12-36
Figure 12-28. Import Method .................................................................................................. 12-37
Figure 12-29. Confirming the method file(s) to import........................................................... 12-37
Figure 12-30. Choosing to import project items corresponding to the method....................... 12-38
Figure 12-31. Check In Project................................................................................................ 12-38
Figure 12-32. Check-In............................................................................................................ 12-39
Figure 12-33. Open saved methods ......................................................................................... 12-40
Figure 12-34. Confirm deletion of selected method ................................................................ 12-41
Figure 12-35. Open saved methods ......................................................................................... 12-42
Figure 12-36. Recycled methods ............................................................................................. 12-43
Figure 12-37. Deck layout confirmation prompt for a Biomek 3000 method......................... 12-45
Figure 12-38. The Biomek Simulator showing a method run on an NX-MC ......................... 12-46
Figure 12-39. Camera navigation controls .............................................................................. 12-47
Figure 12-40. Biomek Simulator with all simulator controls enabled..................................... 12-48
Figure 12-41. Step disabled in Method View .......................................................................... 12-53
Figure 12-42. Printed method .................................................................................................. 12-55
Figure 12-43. Changing the method speed in Hardware Setup ............................................... 12-56
Figure 13-1. Transfer step using the AspValue variable ........................................................... 13-2
Figure 13-2. Variables configured in the Start step ................................................................... 13-3
Figure 13-3. Transfer step using the AspValue and AspValue2

variables defined in the Start step ...................................................................... 13-5
Figure 14-1. Transfer step in Method View after data set is created......................................... 14-5
Figure 14-2. Transfer step — zoomed-in destination labware .................................................. 14-6
Figure 14-3. Transfer step in Method View after data set is created......................................... 14-8
Figure 15-1. Instrument Setup step and configuration .............................................................. 15-4
Figure 15-2. Pause to Confirm Setup? Deck Layout confirmation prompt............................... 15-6
Figure 15-3. Pod Setup prompt for dual-pod Biomek FX instrument ....................................... 15-8
Figure 15-4. Populating the Deck Layout of a Biomek 3000 instrument.................................. 15-9
Figure 15-5. A second Instrument Setup step with deck positions specified As Is ................. 15-11
Figure 15-6. Toggle applied to the Deck Layout..................................................................... 15-13
Figure 15-7. Clear Deck Layout designation applied to deck position TL1............................ 15-14
Figure 15-8. Confirmation prompt to Clear All labware from the Deck Layout..................... 15-15
Figure 15-9. Labware Properties for tips ................................................................................. 15-16
Figure 15-10. Labware Properties for tips with Available Tips shown................................... 15-17



xxviii List of Figures

Beckman Coulter, Inc.

Figure 15-11. Labware Properties for microplates, reservoirs, and tube racks ....................... 15-18
Figure 15-12. Labware Properties for a 96-well microplate with Labware Volumes shown.. 15-20
Figure 15-13. Labware Properties for a Biomek 3000 Tool Rack........................................... 15-21
Figure 15-14. Labware Properties for a Biomek 3000 Tool Rack with tools loaded .............. 15-22
Figure 15-15. Enabling bar code input in the Instrument Setup step ...................................... 15-23
Figure 15-16. Bar code input ................................................................................................... 15-24
Figure 15-17. Entering sample IDs for labware in Bar code input.......................................... 15-25
Figure 15-18. Custom labware category displayed ................................................................. 15-27
Figure 15-19. Custom labware created .................................................................................... 15-28
Figure 15-20. Transfer step configuration for a Multichannel Pod ......................................... 15-30
Figure 15-21. Combine step — Adding Source Labware ....................................................... 15-34
Figure 15-22. Combine step — Source Labware configuration .............................................. 15-36
Figure 15-23. Transfer Step — Zoomed-in Source Labware configuration............................ 15-37
Figure 15-26. Combine step — Source Labware configuration .............................................. 15-41
Figure 15-27. Custom Height prompt...................................................................................... 15-42
Figure 15-28. Technique Editor — Dispense options ............................................................. 15-43
Figure 15-29. Transfer step — adding destination labware..................................................... 15-45
Figure 15-30. Transfer step — destination labware configuration .......................................... 15-46
Figure 15-33. Transfer step — destination labware technique configuration ......................... 15-50
Figure 15-34. Technique Editor — Dispense options ............................................................. 15-52
Figure 15-35. Transfer step — additional Transfer Details..................................................... 15-53
Figure 15-36. Advanced button — JIT Block ......................................................................... 15-55
Figure 15-37. Move Labware step and configuration.............................................................. 15-56
Figure 15-38. Inserting a Pause step in a method .................................................................... 15-59
Figure 15-39. Pausing a deck position for a specified length of time ..................................... 15-60
Figure 15-40. Pause step that provides instruction .................................................................. 15-61
Figure 15-41. Pause message prompt ...................................................................................... 15-61
Figure 15-42. Comment step after text is inserted................................................................... 15-62
Figure 16-1. Biomek Software main editor with Intermediate Step Palette displayed.............. 16-3
Figure 16-2. Aspirate step and configuration ............................................................................ 16-5
Figure 16-3. Aspirate step — Adjusting the aspirate height...................................................... 16-8
Figure 16-4. Custom Height prompt.......................................................................................... 16-8
Figure 16-5. Dispense step and configuration ......................................................................... 16-10
Figure 16-6. Dispense step — Adjusting the dispense height ................................................. 16-13
Figure 16-7. Custom Height prompt........................................................................................ 16-13
Figure 16-8. Mix step and configuration ................................................................................. 16-15
Figure 16-9. Wash step and configuration............................................................................... 16-17
Figure 16-10. New Tips step and configuration ...................................................................... 16-20
Figure 16-11. Unload Tips step and configuration .................................................................. 16-22
Figure 16-12. Loop step and configuration ............................................................................. 16-23
Figure 16-13. Loop step — variable created in Variable......................................................... 16-24
Figure 16-14. Loop step variable ‘Count’ used in an Aspirate substep................................... 16-26
Figure 16-15. Loop step — using a previously created variable as the Increment.................. 16-27
Figure 16-16. Loop step — the ‘AspValue’ variable is used as the Volume for the substeps 16-29
Figure 16-17. Cleanup step and configuration......................................................................... 16-31
Figure 16-18. Move Pod step and configuration ..................................................................... 16-33



List of Figures xxix

Biomek Software User’s Manual

Figure 16-19. Group step and configuration............................................................................ 16-35
Figure 17-1. Biomek Software main editor with Advanced Step Palette displayed.................. 17-3
Figure 17-2. Run Method step and configuration...................................................................... 17-5
Figure 17-3. Worklist example .................................................................................................. 17-6
Figure 17-4. Worklist step and configuration ............................................................................ 17-7
Figure 17-5. Worklist — text file selection ............................................................................... 17-8
Figure 17-6. Just In Time step ................................................................................................... 17-9
Figure 17-7. Let step and configuration................................................................................... 17-11
Figure 17-8. If step and configuration ..................................................................................... 17-13
Figure 17-9. Script step and configuration .............................................................................. 17-16
Figure 17-10. Scripted Let step and configuration .................................................................. 17-19
Figure 18-1. Biomek main editor with Span-8 Step Palette displayed...................................... 18-3
Figure 18-2. Serial Dilution step and configuration .................................................................. 18-5
Figure 18-3. Serial Dilution step configuration with labware configured ................................. 18-7
Figure 18-4. Serial Dilution from left to right ........................................................................... 18-8
Figure 18-5. Serial Dilution from top to bottom........................................................................ 18-9
Figure 18-6. Serial Dilution — Diluent Properties configuration ........................................... 18-12
Figure 18-7. Serial Dilution step configuration with diluent labware ..................................... 18-13
Figure 18-8. Span-8 Aspirate step and configuration .............................................................. 18-17
Figure 18-9. Span-8 Aspirate step configuration with labware configured............................. 18-18
Figure 18-10. Example of how probe and spacing selection affects well selection ................ 18-19
Figure 18-11. Individual Volumes........................................................................................... 18-20
Figure 18-12. Span-8 Aspirate step — Adjusting the aspirate height ..................................... 18-21
Figure 18-13. Custom Height prompt...................................................................................... 18-22
Figure 18-14. Span-8 Dispense step and configuration ........................................................... 18-24
Figure 18-15. Span-8 Dispense step configuration with labware configured.......................... 18-25
Figure 18-16. Example of how probe and spacing selection affects well selection ................ 18-26
Figure 18-17. Individual Volumes........................................................................................... 18-27
Figure 18-18. Span-8 Dispense step — Adjusting the dispense height................................... 18-28
Figure 18-19. Custom Height prompt...................................................................................... 18-29
Figure 18-20. Span-8 New Tips step and configuration .......................................................... 18-31
Figure 18-21. Span-8 Tip Discard step and configuration....................................................... 18-33
Figure 18-22. Span-8 Wash Tips step — Passive Wash configuration ................................... 18-36
Figure 18-23. Span-8 Wash Tips step — Active Wash configuration .................................... 18-40
Figure 18-27. Transfer From File step and configuration ....................................................... 18-42
Figure 18-28. Transfer From File step — Tip Handling collapsed ......................................... 18-46
Figure 18-29. Transfer From File — File Properties............................................................... 18-47
Figure 18-30. Open dialog ....................................................................................................... 18-48
Figure 18-31. Transfer From File — Example data displayed ................................................ 18-48
Figure 18-32. Transfer From File — Example data with header row ..................................... 18-49
Figure 18-33. Transfer From File step — Source Labware selection...................................... 18-52
Figure 18-34. Transfer From File step — Source Labware configuration .............................. 18-53
Figure 18-35. Custom Height prompt...................................................................................... 18-54
Figure 18-36. Transfer From File step — Destination Labware selection .............................. 18-56
Figure 18-37. Transfer From File step — Destination Labware configuration....................... 18-57
Figure 18-38. Custom Height prompt...................................................................................... 18-58



xxx List of Figures

Beckman Coulter, Inc.

Figure 18-39. Wells accessed down first, then left to right ..................................................... 18-60
Figure 18-40. Wells accessed to the right first, then top to bottom......................................... 18-60
Figure 18-41. Transfer From File step — configuring additional Transfer Details ................ 18-62
Figure 18-42. Advanced button — JIT Block ......................................................................... 18-63
Figure 18-43. Define Pattern step and configuration............................................................... 18-65
Figure 18-44. Define Pattern step — Read from a file configuration ..................................... 18-66
Figure 18-45. Open dialog ....................................................................................................... 18-67
Figure 18-46. Define Pattern step — Example data displayed................................................ 18-67
Figure 18-47. Define Pattern step — Example data with header row ..................................... 18-68
Figure 18-48. Transfer step using Sample pattern ................................................................... 18-70
Figure 19-1. Biomek main editor with HDR Step Palette displayed......................................... 19-2
Figure 19-2. Order of transfer to array positions in destination wells with a 3x3 array............ 19-3
Figure 19-3. HDR Transfer step configuration.......................................................................... 19-4
Figure 19-4. Define Procedure step and configuration.............................................................. 19-6
Figure 19-5. HDR Transfer step — Source Labware configuration.......................................... 19-8
Figure 19-6. HDR Transfer step — Source Labware selected .................................................. 19-9
Figure 19-7. Dipping Configuration ........................................................................................ 19-10
Figure 19-8. Custom Height prompt........................................................................................ 19-12
Figure 19-9. HDR Transfer step — Adding Destination Labware.......................................... 19-14
Figure 19-10. HDR Combine step — Destination Labware configuration ............................. 19-15
Figure 19-11. Dipping Configuration ...................................................................................... 19-16
Figure 19-12. Array Configuration .......................................................................................... 19-18
Figure 19-13. Custom Height prompt...................................................................................... 19-19
Figure 19-14. HDR Tool Cleaning step configuration ............................................................ 19-20
Figure 19-15. HDR Tool Cleaning step — new cleaning operation configuration ................. 19-22
Figure 19-16. HDR Tool Cleaning step — configuration for a wash operation...................... 19-23
Figure 19-17. Dipping Configuration ...................................................................................... 19-25
Figure 19-18. Custom Height prompt...................................................................................... 19-26
Figure 19-19. HDR Tool Cleaning step — new cleaning operation configuration ................. 19-27
Figure 19-20. HDR Tool Cleaning step — configuration for a drying operation ................... 19-28
Figure 19-21. Custom Height prompt...................................................................................... 19-29
Figure 19-22. HDR Move Labware step and configuration .................................................... 19-30
Figure 20-1. Biomek Software main editor with Biomek 3000 Step Palette displayed ............ 20-3
Figure 20-2. Changing tools during a method ........................................................................... 20-4
Figure 20-3. Loading tool during a method............................................................................... 20-5
Figure 20-4. Load Tool step configuration with wash tool selected ......................................... 20-6
Figure 20-5. Unloading a tool during a method......................................................................... 20-7
Figure 20-6. Remove to Waste step configuration .................................................................... 20-8
Figure 20-7. Bulk Dispense step configuration ....................................................................... 20-11
Figure 20-8. Wash Tool Purge step configuration................................................................... 20-14
Figure 20-9. Wash Plate step configuration............................................................................. 20-16
Figure 21-1. Biomek Software main editor with Specialty Step Palette displayed ................... 21-3
Figure 21-2. Create Group step and configuration .................................................................... 21-4
Figure 21-3. Create Group step configuration with labware added........................................... 21-5
Figure 21-4. Next Labware step and configuration ................................................................... 21-7
Figure 21-5. Transfer step using the Sources group defined in a Create Group step ................ 21-9



List of Figures xxxi

Biomek Software User’s Manual

Figure 21-6. Run Program step and configuration .................................................................. 21-10
Figure 21-7. Next Item step and configuration........................................................................ 21-14
Figure 21-8. Set Global step and configuration ....................................................................... 21-16
Figure 21-9. Define Procedure step and configuration............................................................ 21-19
Figure 21-10. Run Procedure step and configuration .............................................................. 21-20
Figure 21-11. Break step and configuration ............................................................................ 21-21
Figure 22-1. Main editor for a Biomek FX with Devices Step Palette displayed ..................... 22-3
Figure 22-2. SPE step and configuration ................................................................................... 22-5
Figure 22-3. Device Editor ........................................................................................................ 22-7
Figure 22-4. Light Curtain Access configuration ...................................................................... 22-8
Figure 22-5. Device Setup step and configuration .................................................................... 22-9
Figure 22-6. Labware Properties for tips ................................................................................. 22-11
Figure 22-7. Labware Properties for tips with available tips shown ....................................... 22-12
Figure 22-8. Labware Properties for microplates, reservoirs, and tube racks ......................... 22-13
Figure 22-9. Labware Properties for 96-well microplate Labware Volumes shown............... 22-15
Figure 22-10. Device Action step and configuration............................................................... 22-16
Figure 22-11. Device Action step for the 6-port valve ............................................................ 22-18
Figure 22-12. Device Action step for the 6-port valve with Device Setup chosen ................. 22-19
Figure 22-13. Device Action step for the autolatch................................................................. 22-20
Figure 22-14. Device Action step for the Drainable/Refillable Reservoir ALP...................... 22-21
Figure 22-15. Device Action step for the MicroMix with Shake chosen ................................ 22-23
Figure 22-16. Device Action step for the MicroMix with Custom Shake chosen................... 22-24
Figure 22-17. Device Action step for the Microplate Shaking ALP ....................................... 22-26
Figure 22-18. Device Action step for a Multichannel Tip Wash ALP .................................... 22-27
Figure 22-19. Device Action Step for the Positive Position ALP ........................................... 22-28
Figure 22-20. Device Action for a Source/Waste Sensor ........................................................ 22-29
Figure 22-21. Device Action step for the Speed Pump ........................................................... 22-30
Figure 22-22. Device Action step for the Stirring ALP........................................................... 22-31
Figure 22-23. Device Action step for the vacuum................................................................... 22-32
Figure 22-24. Device Action for the vacuum with Timed Vacuum chosen ............................ 22-33
Figure 22-25. Device Action for the Wash System ................................................................. 22-34
Figure 22-26. Device Action for the Wash System with Latch chosen................................... 22-35
Figure 22-27. Device Action for the Wash System with Aspirate chosen .............................. 22-36
Figure 22-28. Tip Loader step and configuration .................................................................... 22-37
Figure 22-29. A Barcode Reader SILAS Module Step inserted in a method.......................... 22-39
Figure 22-30. Runtime Data Defaults...................................................................................... 22-41
Figure 22-31. SILAS step with data sets chosen ..................................................................... 22-42
Figure 22-32. Runtime Data Defaults...................................................................................... 22-43
Figure 23-1. Biomek main editor with Stacker Carousel Step Palette displayed ...................... 23-2
Figure 23-2. Stacker Setup step configuration........................................................................... 23-4
Figure 23-3. Dialog to drop labware into hotels ........................................................................ 23-5
Figure 23-4. Menu accessing Labware Properties..................................................................... 23-6
Figure 23-5. Labware Properties for a tip box........................................................................... 23-7
Figure 23-6. Labware Properties for tips with Show Available Tips activated......................... 23-8
Figure 23-7. Labware Properties for microplates, reservoirs, and tube racks ........................... 23-9



xxxii List of Figures

Beckman Coulter, Inc.

Figure 23-8. Labware Properties for microplates, reservoirs, or tube racks
with Show Labware Volumes activated .......................................................... 23-11

Figure 23-9. Present Step configuration .................................................................................. 23-12
Figure 23-10. Store Step configuration.................................................................................... 23-14
Figure 24-1. Biomek Software main editor with Advanced Step Palette displayed.................. 24-2
Figure 24-2. Create Data Set step configuration........................................................................ 24-3
Figure 24-3. Create Data Set step — File Options displayed .................................................... 24-4
Figure 24-4. Create Data Set step — File Options displayed .................................................... 24-5
Figure 24-5. Reading from a database ....................................................................................... 24-6
Figure 24-6. SQL Server Connection ........................................................................................ 24-7
Figure 24-7. Connected to SQL Server ..................................................................................... 24-8
Figure 24-8. Create Data Set step — expanding Input Options ................................................ 24-9
Figure 24-9. Create Data Set step — Input Options displayed................................................ 24-10
Figure 24-10. Create Data Set step — Input Options displayed.............................................. 24-12
Figure 24-11. Create Data Set step — expanding Output Options.......................................... 24-13
Figure 24-12. Create Data Set step — Output Options ........................................................... 24-14
Figure 24-13. Changing data set properties ............................................................................. 24-15
Figure 24-14. Choosing Copy in Data Set Management step.................................................. 24-16
Figure 24-15. Choosing Rename in Data Set Management step ............................................. 24-18
Figure 24-16. Choosing Remove in Data Set Management step ............................................. 24-19
Figure 24-17. Change chosen on Data Set Management step configuration........................... 24-20
Figure 24-18. Data Set Processing step configuration............................................................. 24-22
Figure 24-19. Reporting step configuration............................................................................. 24-25
Figure 24-20. Report saved as Text File.................................................................................. 24-26
Figure 24-21. Report saved as Per-Plate HTML Files............................................................. 24-27
Figure 24-22. Report saved as SQL Server ............................................................................. 24-28
Figure 24-23. SQL Server report style chosen ........................................................................ 24-29
Figure 24-24. SQL Server Connection .................................................................................... 24-30
Figure 24-25. List of databases in SQL Server Connection .................................................... 24-31
Figure 24-26. Server and database chosen............................................................................... 24-32
Figure 25-1. Example of a configuration error generated due to a 

Liquid Type Editor configuration problem........................................................ 25-3
Figure 25-2. Example of a configuration error generated from the Deck Editor ...................... 25-3
Figure 25-3. Example of an error generated during method validation

because a step is not configured correctly ......................................................... 25-4
Figure 25-4. Example of an expanded error message................................................................ 25-5
Figure 25-5. Validate the current method before running it option in Preferences ................... 25-7
Figure 25-6. Example of a validation error message generated during

method development as a result of incomplete step configuration.................... 25-7
Figure 25-7. Example of a validation error message detected before method run .................... 25-9
Figure 25-8. Example of a validation error message detected during method run .................... 25-9
Figure 25-9. Example of a Manual Control error because the

Biomek FX tried to move the pod too far on the Z axis .................................. 25-11
Figure 25-10. An example of a Run-Time error due to undetermined gripper state ............... 25-12
Figure 25-11. Choosing STOP on the front rail of the Biomek 3000...................................... 25-17
Figure 25-12. Inconsistent liquid level value detected error message ..................................... 25-19



List of Figures xxxiii

Biomek Software User’s Manual

Figure 25-13. Clot detection error ........................................................................................... 25-21
Figure 25-14. Error message dialog with multiple errors ........................................................ 25-22
Figure 25-15. An example of multiple error messages............................................................ 25-22
Figure 25-16. An example of multiple error message generated during Run-Time................ 25-22
Figure 25-17. A Continuation method snapped during a Loop step........................................ 25-26
Figure 25-18. Snap Continuation Information......................................................................... 25-27
Figure 25-19. Confirm saving changes to method................................................................... 25-27
Figure 25-20. Single Step prompt............................................................................................ 25-30
Figure 25-21. First move of method using Single Step ........................................................... 25-31
Figure 26-1. Well numbering in log files .................................................................................. 26-8
Figure 26-2. UnifiedPipetting log ............................................................................................ 26-10
Figure 26-3. UnifiedTransfer log............................................................................................. 26-12
Figure 26-4. Select the log type(s) generated here .................................................................. 26-13
Figure 26-5. Span8Pipetting Log viewed in Notepad.............................................................. 26-14
Figure 26-6. Span8Transfer Log viewed in Microsoft Excel .................................................. 26-14
Figure 27-1. Confirms Manual Control is connecting ............................................................... 27-2
Figure 27-2. Manual Control ..................................................................................................... 27-2
Figure 27-3. Information displaying firmware version ............................................................. 27-3
Figure 29-1. Main editor for a Biomek FX................................................................................ 29-2
Figure 29-2. Step Palette Builder............................................................................................... 29-3
Figure 29-3. Preferences ............................................................................................................ 29-4
Figure 29-4. Confirm to delete steps from a method................................................................. 29-6
Figure 29-5. Preferences - View ................................................................................................ 29-7
Figure 29-6. Preferences - Errors............................................................................................... 29-9
Figure 29-7. Parameter Information ........................................................................................ 29-10
Figure 29-8. Options for step palettes and toolbars ................................................................. 29-11
Figure 29-9. Step palette menu for a Biomek FX.................................................................... 29-11
Figure 29-10. Main editor with default toolbar options displayed .......................................... 29-13
Figure 29-11. Step palette views with and without labels ....................................................... 29-14
Figure 29-12. Preferences — main editor setting options ....................................................... 29-15
Figure 29-13. Step Properties .................................................................................................. 29-16
Figure 29-14. Change the step caption in Edit Step Caption................................................... 29-17
Figure 29-15. Modified step caption in Method View ............................................................ 29-17
Figure 29-16. Step Palette Builder........................................................................................... 29-19
Figure 29-17. Step Palette — Steps tab ................................................................................... 29-21
Figure 29-18. Confirmation for adding a step to a step palette ............................................... 29-22
Figure 29-19. New Step Palette ............................................................................................... 29-23
Figure 29-20. Palette Properties............................................................................................... 29-23





Biomek Software User’s Manual

xxxv

List of Tables

Table 2-1. Biomek Software Permissions.................................................................................... 2-6
Table 4-1. Hardware Setup Options ............................................................................................ 4-3
Table 4-2. Materials ................................................................................................................... 4-12
Table 5-1. Deck Editor Options ................................................................................................... 5-5
Table 5-2. ALP and Position Properties. ................................................................................... 5-16
Table 7-1. Tip Properties ............................................................................................................. 7-6
Table 7-2. Labware Type Properties.......................................................................................... 7-14
Table 8-1. Minimum and Maximum Pipetting Speeds in D-Axis ............................................... 8-7
Table 8-2. Span-8 Cutoff Velocities for Syringes for Span-8 Pods............................................. 8-8
Table 9-1. Technique Icons ....................................................................................................... 9-11
Table 9-2. Span-8 Cutoff Velocities for Syringes for Span-8 Pods........................................... 9-33
Table 10-1. Context Variables ................................................................................................. 10-12
Table 12-1. Simulator Lighting Controls................................................................................. 12-49
Table 23-1. Example of a Comma-Separated Value File .......................................................... 23-5
Table 24-1. Some common symbols used in expressions ....................................................... 24-24
Table 24-2. Some expressions and the results ......................................................................... 24-24
Table 27-1. Manual Control Options ......................................................................................... 27-3
Table 29-1. General options....................................................................................................... 29-5
Table 29-2. View Options.......................................................................................................... 29-8
Table 29-3. Toolbar Options.................................................................................................... 29-12





Biomek Software User’s Manual

1-1

1 Biomek Software Introduction

1.1 About Biomek Software
Biomek Software is used to control the Beckman Coulter Biomek line of laboratory 
automation workstations. Biomek Software consists of a method editor and other 
tools and editors for configuring the system to perform desired operations.

Configuring the Biomek instrument is necessary to achieve the desired results from 
automated methods. The software must have information on the deck layout, labware 
and tips utilized in the method, liquid types to pipette, and how to perform pipetting 
operations. 

Biomek Software comes with a default set of parameters suitable for many 
applications; many opportunities are presented for customization to achieve a wide 
variety of desired results.

Information about the liquid-handling system is stored in two separate files. The 
instrument file includes information specific to an instrument, including additional 
components installed, deck layout, and framing information. A project file stores 
information about labware, tip, and liquid types, and pipetting techniques and 
templates. 

Effectively using Biomek Software includes using the method editor for method 
building and the various tools and editors to appropriately configure the instrument 
and project files for the desired task or application.

1.1.1 Instrument Files
An instrument file contains all pertinent information relating to the physical 
hardware. This includes:

• instrument type and configuration.

• devices installed on the instrument deck.

• external devices integrated with the instrument.

• deck layout and framing information.

The instrument configuration must accurately represent the Biomek instrument 
hardware to prevent collisions between the instrument and any on-deck components. 
All instrument configuration is done using Hardware Setup and the Deck Editor.
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Hardware Setup is used to configure the heads, devices, and accessories available to 
the instrument. The Deck Editor is used to configure the precise location of all 
labware positions on the deck and associate any devices or accessories to those 
positions. The pod must then be precisely aligned to each deck position by framing 
the deck.

Refer to Chapter 3, Using Instrument Files and Settings, for more information on 
instrument files.

1.1.2 Project Files
A project file stores custom information about liquid types, labware and tip types, and 
pipetting techniques and templates that are used to configure the actions of the 
instrument in a database. Project files store a history of all changes, additions, and 
deletions from the project file. 

Project items are configured using the following editors:

• Labware Type Editor

• Tip Type Editor

• Liquid Type Editor

• Technique Editor

• Pipetting Template Editor

• Well Patterns Editor

Project items may be checked in, which creates a revision of the project item. 
Checked in revisions can always be recovered and reused, ensuring that checked in or 
validated methods are reproducible even if project items are subsequently modified or 
deleted. Refer to Chapter 6, Understanding and Using Project Files, for more 
information on project files.

1.1.3 Methods
Methods contain the precise information for performing a specific sequence of 
actions to complete a task, and utilize information from the project and instrument 
files to configure and customize those actions.
The Biomek method editor is used to create methods that control the Biomek liquid-
handling system. Methods comprise a series of steps that together perform various 
operations, such as liquid transfers or labware moves using the gripper. Additional 
operations, such as microplate shaking, can be performed in a Biomek method 
through active ALPs or integrated devices that are controlled through the Biomek 
instrument via serial communications. Refer to Chapter 12, Creating and Using 
Methods, for more information on building and working with methods.

Note:  ALPs (Automated Labware Positioners) are removable and interchangeable 
platform structures installed on the Biomek deck to allow automated assays to be 
performed.
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1.2 About this Manual
The information in this manual on Biomek Software generally refers to all Biomek 
instruments; however, the following conventions present specific conditions or 
information that apply to one or more, but not all, Biomek instruments:

FX — Biomek FX Laboratory Automation Workstation

3000 — Biomek 3000 Laboratory Automation Workstation

NX-MC — Biomek NX Multichannel Laboratory Automation Workstation

NX-S8 — Biomek NX Span-8 Laboratory Automation Workstation

This manual should be used in conjunction with the appropriate hardware manual for 
the specific instrument.

An index and glossary are also provided. The glossary contains terms and definitions 
relating to the Biomek instruments, ALPs, and Biomek Software. It is a separate .pdf 
file that may be accessed from this manual or any of the related manuals. 

1.2.1 Related Manuals
The following related user’s manuals for accessing more in-depth information on the 
Biomek instruments and ALPs are included as specific cross-referenced links to this 
manual:

• Biomek® FX Laboratory Automation Workstation User’s Manual

• Biomek® 3000 Laboratory Automation Workstation User’s Manual

• Biomek® NX Multichannel Laboratory Automation Workstation User’s 
Manual

• Biomek® NX Span-8 Laboratory Automation Workstation User’s Manual

• ALPs User’s Manual
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2 Using Accounts & Permissions

2.1 Overview
Beckman Coulter Accounts & Permissions is an integrated set of features built into 
Beckman Coulter software that assists users in complying with electronic signature 
requirements (such as 21 CFR Part 11) for closed systems. With Biomek Software, 
support is extended only for the Biomek instrument; devices integrated with the 
Biomek instrument are not supported unless specified in separate documentation.

Accounts & Permissions only provides support for closed systems; networked 
systems are not supported. In a location where several Beckman Coulter systems are 
present, Accounts & Permissions must be installed and enabled separately for each 
system where compliance is desired. Users require a separate account for each system 
they need to access.

For each Beckman Coulter system, a single administrator sets up the level of support 
provided by Accounts & Permissions, creates, manages, and sets permissions for user 
accounts, and configures system parameters relating to Accounts & Permissions. 

This chapter covers:

• Installing and Setting the Level of Support For Accounts & Permissions 
(Section 2.2).

• Administering User Accounts and Permissions (Section 2.3).

• Restoring the Administrator Password (Section 2.4).

• Viewing the Audit Log (Section 2.5).

• Using the Biomek Software With Accounts & Permissions Enabled 
(Section 2.6).
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2.2 Installing and Setting the Level of Support For 
Accounts & Permissions

Some Accounts & Permissions functionality is built into Biomek Software; however, 
additional options that allow Accounts & Permissions to be enabled and configured 
are installed separately. This section covers:

• Installing Accounts & Permissions (Section 2.2.1).

• Setting the Level of Support For Accounts & Permissions (Section 2.2.2).

2.2.1 Installing Accounts & Permissions
Beckman Coulter Accounts & Permissions support may be installed before or after 
Biomek Software is installed on the system. 

Note:  Site processes should be in place to ensure that access to the Accounts & 
Permissions installation CD is controlled.

To install support for Accounts & Permissions:

1. Close all open applications on the computer.

2. Place the Beckman Coulter Accounts & Permissions Installer CD in the drive, 
and browse to the contents of the CD.

3. Double-click Beckman Coulter Accounts & Permissions.exe. Beckman 
Coulter Accounts & Permissions Setup appears.

Note:  If Accounts & Permissions is already installed, options to repair, modify, 
and remove the application appear. 

4. Follow the steps in the setup wizard.

5. Restart the computer.

6. After the computer is restarted, set the level of Accounts & Permissions support 
desired (refer to Section 2.2.2, Setting the Level of Support For Accounts & 
Permissions).
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2.2.2 Setting the Level of Support For 
Accounts & Permissions

The administrator may change the level of support for Accounts & Permissions at any 
time.

Note:  The site must have processes in place to govern all system administration 
activities, as specified in the 21 CFR Part 11 regulation.

To set the level of support for Accounts & Permissions:

1. Log off and close Biomek Software and any other Beckman Coulter software 
applications using Accounts & Permissions, if necessary.

2. Place the Beckman Coulter Accounts & Permissions Installer CD in the drive, 
and browse to the contents of the CD.

3. Double-click Beckman Coulter Accounts & Permissions - Support 
Options.exe. 

4. When prompted, enter the Administration Password and choose OK. 
Support Options appears (Figure 2-1). A series of tabs displays all installed 
software applications compatible with Beckman Coulter Accounts & 
Permissions.

Note:  If the Administration Password is lost, forgotten, or not known, follow 
the steps in Section 2.4, Restoring the Administrator Password.

Figure 2-1.  Support Options

5. Choose the Biomek Software tab, if multiple Beckman Coulter software 
applications supporting Accounts & Permissions are installed on the system.



2-4 Using Accounts & Permissions

Beckman Coulter, Inc.

6. Select the level of support. When several Beckman Coulter software applications 
are installed on the same system, the level of support selected must be the same 
for each application.

• No support — User accounts are not required to access Biomek 
Software. Users have access to all software operations and functionality.

Note: System activity, such as creating, editing, or running methods, 
is still logged in the audit trail and can be viewed in the Audit Log (refer 
to Section 2.5, Viewing the Audit Log).

• Accounts and Permissions — Enables the use of user accounts and 
permissions for Biomek Software. Users must log in to use the software 
and may access only features and operations for which they have 
permission. Operations such as checking in, validating, or signing 
methods do not require password confirmation.

Note: Accounts and Permissions without password checks may not 
provide adequate support for 21 CFR Part 11 compliance. Each site 
must evaluate the level of support required for a given system.

• Accounts and Permissions, with password checks for 
signing and check-in — Enables the use of user accounts and 
permissions with electronic signatures for Biomek Software. Users must 
log in to use the software and may access only features and operations 
for which they have permission. Support for 21 CFR Part 11 is provided 
by requiring password checks for operations such as checking in, 
validating, and signing methods.

Note:  Compliance with 21 CFR Part 11 requires implementing site processes 
beyond the control of the software.

7. Choose OK to activate the level of support chosen and close Support Options.

OR

Choose Cancel to close Support Options without changing the level of 
support.
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2.3 Administering User Accounts and Permissions
System administration tasks for Beckman Coulter Accounts & Permissions are 
performed in Account Management, a separate application from Biomek Software. 
The system administrator sets up and configures user accounts, passwords, and 
permissions, and configures system settings such as automatic password expiration 
and system logout time.

A single system administrator password is used on a system. System administration 
tasks may be performed only on the computer where Account Management is 
installed; access to Account Management over a network is not supported.

Note:  The administrator is not automatically given a user account on the system. If 
the administrator requires an account, one must be created in Account Management.

Note:  The 21 CFR Part 11 regulation contains additional requirements for account 
management beyond the control of the software.

This section covers opening Account Management and provides an overview of 
permissions available for Biomek Software users (refer to Section 2.3.1, Assigning 
Biomek Software Permissions). Refer to the Account Management online help for 
detailed information about administering user accounts and permissions.

To open Account Management:

1. Log off and close Biomek Software and any other Beckman Coulter software 
applications using Accounts & Permissions.

2. In the Windows® Start menu, choose Settings>Control Panel. Control 
Panel appears.

3. In Control Panel, double-click Administrative Tools. Administrative Tools 
appears.

4. In Administrative Tools, double-click Beckman Coulter Accounts & 
Permissions Administrator. Beckman Coulter Accounts & Permissions 
appears.

5. In Beckman Coulter Accounts & Permissions, enter the administrator 
password and choose OK. Account Management appears (Figure 2-2).

Figure 2-2.  Account Management

Choose ? or press 
F1 to access 
online help.
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2.3.1 Assigning Biomek Software Permissions
Permissions provide the ability to control user access to program operations. The 
administrator assigns permissions for each user in Account Management. Table 2-1 
describes the permissions available for Biomek Software users. 

Note:  Refer to Account Management online help for detailed information about 
assigning permissions. 

Table 2-1.  Biomek Software Permissions
Permission Description

Develop Methods Allows the user to open and run methods that have not 
been validated, develop new methods and edit existing 
methods (refer to Chapter 12, Creating and Using 
Methods).

Develop Projects Allows the user to create and edit project files (refer to 
Chapter 6, Understanding and Using Project Files).

Editor Preferences Allows the user to modify Preferences and Log 
Configurations (refer to Section 29.2, Changing 
Display Preferences and Chapter 26, Generating and 
Using Log Data).

Run Validated Methods Allows the user to open and run validated methods. A 
validated method is a revision of a method that cannot 
be modified or associated with a different instrument 
(refer to Section 12.15, Checking Out a Method).

Setup Instrument Allows the user to configure instrument settings in 
Hardware Setup (refer to Chapter 4, Configuring 
Hardware Setup), the Deck Editor (refer to Chapter 5, 
Preparing and Managing the Deck), the Device 
Editor (refer to Section 22.4.1, Configuring Devices 
Using the Device Editor), and the Import/Export 
Utility (refer to Section 3.4, Sharing Instrument 
Settings Using the Import/Export Utility).

Use Manual Control Allows the user to control instrument actions outside a 
method using Manual Control (refer to Chapter 27, 
Using Manual Control).

Validate Methods Allows the user to validate a revision of a method. 
Once validated, that revision of the method cannot be 
modified or associated with a different instrument 
(refer to Section 12.15, Checking Out a Method).
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2.4 Restoring the Administrator Password
Only one administrator account exists on a system with Accounts & Permissions 
installed. If the administrator password is lost or forgotten, Beckman Coulter 
Customer Technical Support must be contacted to restore access to the Account 
Management application.

To restore the administrator password:

1. Place the Beckman Coulter Accounts & Permissions Installer CD in the drive, 
and browse to the contents of the CD.

2. Double-click Beckman Coulter Accounts & Permissions Admin 
Password Restore.exe. Password Restore appears (Figure 2-3).

Figure 2-3.  Password Restore

3. Contact Beckman Coulter Customer Technical Support and provide the code 
displayed in the upper field of Password Restore.

Note:  Leave Password Restore open until Beckman Coulter Customer 
Technical Support supplies a new code. The new code is based on the code 
displayed in the upper field, which changes each time Password Restore is 
opened.

4. In the lower field of Password Restore, enter the new code provided by 
Beckman Coulter Customer Technical Support. 

5. Choose OK to close Password Restore and accept the new code.

OR

Choose Cancel to close Password Restore without accepting the new code.

6. Follow any additional instructions provided by Beckman Coulter Customer 
Technical Support.
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2.5 Viewing the Audit Log
Audit Log displays the audit trail for all user activity in software applications that 
support Beckman Coulter Accounts & Permissions. System activity is logged, even 
when Accounts & Permissions is set to No Support (refer to Section 2.2.2, Setting 
the Level of Support For Accounts & Permissions).

Note:  Administrator activity other than changing the level of support for Accounts 
& Permissions is not available in the Audit Log. However, all administrator activity is 
logged and may be viewed in Account Management.

To view the Audit Log:

1. In the Windows® Start menu, choose Settings>Control Panel. Control 
Panel appears.

2. In Control Panel, double-click Administrative Tools. Administrative Tools 
appears.

3. In Administrative Tools, double-click Beckman Coulter Accounts & 
Permissions Audit Log. The Audit Log appears (Figure 2-4).

Figure 2-4.  Accounts & Permissions Audit Log

4. Choose Export to export the entire audit log to a text file, if desired. The 
exported file may be opened, read, and printed in any application that supports 
text files.

Note:  When the Audit Log is open while Biomek Software is running, system 
activity is logged, but not refreshed automatically in the Audit Log. Choose Refresh 
to to view system activity logged since the Audit Log was opened or the last time 
displayed data was refreshed.
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2.6 Using the Biomek Software With Accounts & 
Permissions Enabled

When Beckman Coulter Accounts & Permissions is enabled, all users must log on to 
use Biomek Software. Only one user may be logged on at a time. Users are permitted 
to perform only the operations for which the administrator has assigned them 
permission.

Note:  This section covers logging on and off Biomek Software. Refer to Chapter 12, 
Creating and Using Methods for information about checking in, validating, and 
signing methods when Accounts & Permissions is enabled. Refer to Section 6.4, 
Deleting and Restoring Project Files for information about checking in projects.

2.6.1 Logging Onto the Biomek Software
To log onto Biomek Software:

1. On the toolbar, choose the log on/off button (Figure 2-5). Logon appears 
(Figure 2-6).

Figure 2-5.  Log on/off button — no user logged on

Figure 2-6.  Logon

2. Enter the account User Name and Password.

Note:  The first time a user logs on using a new account, or after having the 
password changed by the administrator, Biomek Software automatically prompts 
for the password to be changed.

The new password must be different from the original and may include 
alphanumeric characters and spaces and be up to 250 characters in length. 
Accounts & Permissions passwords are case insensitive.

3. Choose OK to log onto Biomek Software. The name of the user logged on 
appears to the left of the log on/off button (Figure 2-8).

Log on/off button



2-10 Using Accounts & Permissions

Beckman Coulter, Inc.

2.6.1.1 Handling Disabled Accounts
User accounts may be disabled by the administrator, or automatically after a number 
of logon attempts for the account fail. Allowing accounts to be automatically disabled 
after a number of failed logon attempts is optional, and configured by the 
administrator. 

When an account is automatically disabled, Administrator Notification appears 
(Figure 2-7). The administrator password must be entered before Biomek Software 
can be accessed by users. 

Figure 2-7.  Administrator Notification
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2.6.1.2 Viewing the Logged On User’s Permissions
To view the permissions of the user currently logged onto Biomek Software:

1. On the toolbar, choose the user name displayed next to the log on/off button 
(Figure 2-8). Current Permissions appears (Figure 2-9).

Figure 2-8.  Log on/off button — user logged on

Figure 2-9.  Current Permissions

2. Choose OK to close Current Permissions.

2.6.2 Logging Off the Biomek Software
To log off Biomek Software:

On the toolbar, choose the log on/off button (Figure 2-10). The user is logged off 
the system.

Note:  Closing Biomek Software will not automatically log a user off. The 
current user will remain logged on until the software is reopened and the account 
is logged off, or until the login times out automatically.

Figure 2-10.  Log on/off button — user logged on

Full Name

Log on/off button
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3 Using Instrument Files and 
Settings

3.1 Overview
An instrument file stores information about the hardware configuration and deck 
layout of the Biomek instrument. Instrument files can represent different Biomek 
instruments, or different hardware configurations for the same instrument. 

The instrument configuration must accurately represent the Biomek instrument 
hardware to prevent collisions between pods and any on-deck components. All 
instrument configuration is done using Hardware Setup (refer to Chapter 4, 
Configuring Hardware Setup)and the Deck Editor (refer to Chapter 5, Preparing and 
Managing the Deck).

The Instrument menu contains options to open and save instrument files, as well as 
provide access to the editors to configure the instrument file.

The sections in this chapter include:

• Saving and Opening Instrument Files (Section 3.2) — Save the current 
configuration of an instrument or open an existing instrument file.

• Restoring Instrument Settings from Backup Files (Section 3.3) — If settings 
are deleted or lost, workspace settings or an entire workspace can be restored 
from one of the automatic daily, weekly, or monthly backup files created by 
Biomek Software. 

• Sharing Instrument Settings Using the Import/Export Utility (Section 3.4) — 
Settings may be shared with another host computer or sent to Beckman 
Coulter Technical Support for analysis using the Import/Export Utility. This 
utility allows instrument settings (decks, framing tools, pod settings) to be 
imported and exported as import files (.imp).
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3.1.1 Instrument Display in Method Editor
The active instrument file and project file are displayed in the status bar of the 
Biomek method editor (Figure 3-1). Any instrument file can be used with any project 
file and method. Validated methods, however, are validated for a specific instrument 
and are no longer validated when used with a different instrument file, even if the 
instrument file is equivalent to the one on which the method is validated (refer to 
Section 12.11, Validating a Method). 

Note:  A validated method for a specific instrument is not the same as validating a 
method before a run to internally test the method for errors before it is actually run. To 
validate a method to test for errors before it is run, check Validate the current 
method before running it in Preferences (refer to Section 29.2, Changing 
Display Preferences).

Figure 3-1.  Biomek method editor

3.1.2 Contents of an Instrument File
An instrument file contains all:

• Hardware configurations — information about the instrument and integrated 
ALPs or devices as configured in Hardware Setup.

• Pod settings — axis limit values and other settings for the pod(s).

• Deck layouts and framing information — layout of ALPs and devices on the 
instrument deck as configured in the Deck Editor.

Note: When an instrument file is loaded or imported, the deck framing is 
reset to Unframed and the deck must be framed again. 

Active project file
Active instrument file
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3.2 Saving and Opening Instrument Files
Instrument files are saved as *.bif files that may be opened on any system in Biomek 
Software. 

Instrument files can represent different Biomek instruments, or different hardware 
configurations for the same instrument. These instrument files can be used to:

• quickly change the instrument configuration between two or more 
commonly used configurations for an instrument.

• change instruments when developing methods in simulation mode for 
multiple instruments on one computer.

• share the instrument configuration with other users or Beckman Coulter 
Technical Support to ensure a method is being run using an equivalent 
instrument.

3.2.1 Saving an Instrument File
An instrument file may be saved at any time. The instrument file is automatically 
saved when another instrument file is opened or Biomek Software is closed; however, 
to save the current instrument file without closing it, use Save Instrument.

To save changes made to an instrument file:

From the Instrument menu, choose Save Instrument. The active instrument 
file is saved.

3.2.2 Creating a New Instrument File
A new instrument file is created by saving the current active instrument file with a 
new file name. The new instrument file has the same settings as the active instrument 
when it was saved; however, any changes made to the original instrument file are 
saved as the new instrument and not with the original instrument file.

To create a new instrument file:

1. From the Instrument menu, choose Save Instrument As. Save Instrument 
appears (Figure 3-2).

Figure 3-2.  Save Instrument
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2. In Save Instrument, browse to the desired drive and directory in which to save 
the instrument file.

3. In File Name, enter the desired file name for the instrument file.

4. Choose Save. The instrument file is saved in the selected drive and directory 
with the specified file name and opened as the active instrument file.

3.2.3 Opening an Existing Instrument File
Any existing instrument file may be opened at any time to develop methods using a 
specific instrument configuration.

To open an existing instrument file:

1. From the Instrument menu, choose Open. Open Instrument appears.

Figure 3-3.  Open Instrument

2. In Open Instrument, browse to and select the desired instrument file (*.bif) to 
open.

Note:  To open one of the daily, weekly, or monthly backup files, enter 
*.*backup in File name and press Enter. All the backup files are displayed in 
Open Instrument.

3. Choose Open to open the selected instrument file. The selected instrument file is 
opened.
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3.3 Restoring Instrument Settings from Backup Files
Backup files are created daily, weekly, and monthly by Biomek Software whenever 
an instrument file is saved, typically when File>Save Instrument is selected or 
when Biomek Software is closed. 

Note:  By default, backup files for instruments are saved in the C:\Documents and 
Settings\All Users\Shared Documents\Biomek\ directory with the following 
naming convention: 

<Instrument File Name>.bif.DailyBackup
<Instrument File Name>.bif.WeeklyBackup 
<Instrument File Name>.bif.MonthlyBackup

To restore an instrument file from a backup file when settings are deleted or lost:

1. Close the Biomek main editor.

2. Open Windows Explorer and locate the instrument file (*.bif) in the shared 
application data directory. Typically, the path to this directory is: C:\Documents 
and Settings\All Users\Shared Documents\Biomek\.

3. If the instrument file needs to be replaced rather than recovered, rename the latest 
instrument file to <Instrument File Name>.old. 

Note:  Rename the original only if it is available.

OR

If the instrument file needs to be recovered, rename the backup file to the 
instrument file name, such as <Instrument File Name>.bif.DailyBackup to 
<Instrument File Name>.bif.

4. Open the Biomek main editor. The instrument file has been restored.
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3.4 Sharing Instrument Settings Using the Import/
Export Utility

Specific segments of a current instrument file, called instrument file settings, can be 
restored using the Import/Export Utility (Figure 3-4). Exporting settings allows 
settings to be shared with another system, while importing settings allows settings 
developed on another system to be used. Settings are imported from and exported to 
import files (.imp).

To share a method between two computers, any instrument settings different from the 
default installed with the software must be exported from the original computer and 
imported to the new computer using the Import/Export Utility.

Figure 3-4 shows how the Import/Export Utility works. The Instrument side of the 
utility displays the list of settings in the current instrument file. The Import File side 
of the utility displays the list of settings in the currently opened import file.

To restore settings of a current instrument file, settings from Instrument are dragged 
(exported) to the Import File. From Import File, these import settings can be dragged 
(imported) to the current Instrument.

Note:  Settings may also be imported or exported by choosing Import or Export on 
the toolbar.

Figure 3-4.  Import/Export Utility

Instrument
Displays list of settings in the 
current workspace.

Import File
Displays list of settings in the 
current import file.

Export settings from current instrument to the import file.

Import settings from the import file to the current instrument.
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3.4.1 Exporting Settings to an Import File
To export settings to an import file:

1. From the Instrument menu, choose Import/Export Utility. Import/Export 
Utility appears (Figure 3-5).

Figure 3-5.  Exporting deck layout Deck1 to an import file

2. Drag and drop the desired settings from Instrument to Import File. 

OR

Highlight the desired settings from Instrument and choose Export. The folder 
containing the desired setting and the setting itself appear in the Import File 
(Figure 3-5).

Note:  Dragging a folder copies all of the settings in that folder

3. Continue to export settings using step 2 until all desired settings are exported.
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4. Choose Save to save the Biomek Import File. Save As (Figure 3-6) appears.

Figure 3-6.  Save Import File

5. Browse to the desired file location to save the import file.

6. In File name, enter a name for the import file.

7. Choose Save. The import file is created and Save As closes. 

Note:  Note that the name of the new import file is now displayed on the top of 
the Import File window.

8. Choose Close. Import/Export Utility closes.

Note:  When exporting a Deck with a stationary labware type, such as a Wash 
Station, the Wash Station must be present in the destination workspace or exported to 
the Import File.
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3.4.2 Importing Settings from an Import File
To import settings from an import file:

1. From the Instrument menu, choose Import/Export Utility. Import/Export 
Utility appears (Figure 3-5).

2. Choose Open and open the .imp file.

3. Open the desired folder by clicking the + containing the desired settings from the 
import file.

Note:  If a setting with the same name is used in the import file and in the 
current instrument, it can be overwritten.

4. Drag and drop the setting from Import File to Instrument to overwrite the 
setting in the current workspace with the one from the import file.

OR

Rename the setting in the Import side, then drag and drop the setting from 
Import File to Instrument to not overwrite the setting.

Note:  Rename a setting by highlighting the setting, single-clicking, pausing 
until the name becomes editable, typing a new name, and pressing return.

Note:  Dragging an entire folder copies all of the settings in that folder.

Note:  If a setting being imported exists in the instrument file and, therefore, can 
be overwritten, a Confirm similar to Figure 3-7 appears. Answer Yes to 
overwrite the setting in the instrument file. Answer No to cancel the import of 
that setting. Yes to All and No to All allow multiple imported settings to 
overwrite the contents of the instrument file or be cancelled at the same time.

Figure 3-7.  Confirmation to address to overwrite an imported setting

5. Continue to import settings using step 4 until all desired settings are imported.

6. Choose Close to exit the Import/Export Utility.

7. Select Instrument>Save Instrument to save any changes made to the 
workspace.

Note:  When Biomek Software is updated, a backup of the instrument file is made to 
save previous settings. The backup instrument file is located in C:\Documents and 
Settings\All Users\Shared Documents\Biomek\Backup\.
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3.4.3 Restoring Instrument Settings from 
Backup Files

To restore instrument file settings from a backup file, such as when settings are 
deleted or incorrectly changed:

1. From Instrument, choose Open to open the backup file for the instrument file. 
Open Instrument appears (Figure 3-8).

Figure 3-8.  Open Instrument file

2. In File name, enter *.*backup and press Enter to show all daily, weekly, and 
monthly backup files in Open Instrument (Figure 3-9).

Figure 3-9.  Open Instrument showing backup files

3. Select the desired backup file.

4. Choose Open. The selected backup file is opened as the current instrument.
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5. Use the Import/Export Utility to create an import file with the desired settings 
from the backup instrument file (refer to Section 3.4.1, Exporting Settings to an 
Import File).

6. From the Instrument menu, choose Open Instrument.

7. Select the original instrument file, named <Instrument File>.bif.

8. Choose Open.

9. Use the Import/Export Utility to import settings from the import file created in 
step 5 (refer to Section 3.4.2, Importing Settings from an Import File).

Note:  When Biomek Software is updated, a backup of the instrument file is made to 
save previous settings. The backup instrument file is located in C:\Documents and 
Settings\All Users\Shared Documents\Biomek\Backup\.
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4 Configuring Hardware Setup

4.1 Overview
Hardware Setup is used to configure Biomek Software with the appropriate Biomek 
instrument information, including the instrument type and which heads and devices 
are available for use. The Biomek Simulator, which shows a 3-D animation of the 
instrument performing methods, is also configured in Hardware Setup.

After a Beckman Coulter Service Engineer has physically installed a device, the 
device is detected on the Biomek instrument and must be properly installed and 
configured in Hardware Setup. While the Service Engineer normally installs and 
configures new devices, it may be necessary to install, configure, and remove other 
devices using Hardware Setup.

For specific information on configuring Biomek instruments in Hardware Setup, 
refer to the appropriate hardware user’s manual:

FX — Biomek® FX Laboratory Automation Workstation User’s Manual.

3000 — Biomek® 3000 Laboratory Automation Workstation User’s 
Manual.

NX-MC — Biomek® NX Multichannel Laboratory Automation Workstation 
User’s Manual.

NX-S8 — Biomek® NX Span-8 Laboratory Automation Workstation User’s 
Manual.

Refer to ALPs User’s Manual or the appropriate integration manual for information 
on configuring specific ALPs and devices.

The sections in this chapter include:

• Accessing Hardware Setup (Section 4.2).

• Understanding the Options in Hardware Setup (Section 4.3).

• Configuring the Biomek Simulator (Section 4.4).
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4.2 Accessing Hardware Setup
Hardware Setup is accessed from within Biomek Software. 

To access Hardware Setup:

From the Instrument menu, choose Hardware Setup. Hardware Setup 
appears (Figure 4-1).

Figure 4-1.  Hardware Setup for a Biomek FX instrument 
with a Multichannel Pod and Span-8 Pod

Note:  The devices displayed in Hardware Setup are dependent on instrument type 
and configuration.
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4.3 Understanding the Options in Hardware Setup
An understanding of the options on the toolbar in Hardware Setup is necessary to 
properly install, configure, and remove devices.

Table 4-1 lists and describes the toolbar options in Hardware Setup:

Table 4-1.  Hardware Setup Options
Option Description

Reconnect Allows Hardware Setup to reexamine the 
devices present. Choose this option to determine 
what devices are present rather than closing and 
reopening Hardware Setup.

Home All Axes Gives the instrument a point of reference from 
which to make subsequent moves. For a single-
pod system, home position is left, back. For a dual-
pod system, home position for the first (left) pod is 
left, back and for the second (right) pod is right, 
back.

Note:  Pods should be homed each time the 
instrument is powered on. Depending on the type 
of pods on the system, a Warning appears. After 
confirming that the actions have been addressed 
properly, choose OK. 

Add Device Installs a device.
Remove Device Removes a device.
Accept Saves all changes to the instrument and closes 

Hardware Setup. Choose this option after the 
device has been installed and configured. 

Cancel Closes Hardware Setup without saving the 
modifications to the instrument. 
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4.4 Configuring the Biomek Simulator
When a method is run in Simulate mode, the Biomek Simulator appears, showing an 
animated 3-D model of the instrument performing the method. Simulator settings can 
be configured in Hardware Setup.

Note:  Modifying simulator settings is optional. The default settings are appropriate 
for most computers.

Configuring the simulator includes:

• Configuring Simulator Settings (Section 4.4.1).

• Configuring Camera Controls (Section 4.4.2).

• Configuring Materials (Section 4.4.3).

4.4.1 Configuring Simulator Settings
Simulator configures view settings, including animation speed, simulator display 
size, and image quality. Many of the view settings increase or decrease the image 
quality of the 3-D model shown in simulations. In general, increasing image quality, 
such as enabling blending, requires a faster computer to run the animated simulation 
smoothly. Conversely, decreasing image quality requires less computing power, and 
will run simulations more smoothly on slower computers.

The default settings in Simulator provide a good balance between image quality and 
smooth animation playback on most computers. Change the settings only if higher 
image quality or smoother playback is desired.

To configure simulator settings:

1. From the left pane of Hardware Setup, choose Simulator. The Biomek 
Simulator settings appear (Figure 4.2).

Figure 4-2.  Hardware Setup — configuring the simulator settings
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2. In Warp Factor, change the playback speed for simulated methods. Warp 
Factor 1 runs simulated methods in real time.

3. Enter the Max Height in pixels for the simulator display. 

4. Enter the Max Width in pixels for the simulator display.

5. In Max Poly Size, enter the maximum size of the polygons that make up the 
model of the instrument shown in the simulator. Decreasing the polygon size 
creates a more detailed simulator view, but requires more computing power. 
Increasing the polygon size creates a less detailed simulator view, but requires 
less computing power.

6. Choose the method of Perspective Correction:

• Nicest — performs more accurate perspective correction; better for 
faster computers.

• Fastest — performs less accurate correction; better for slower 
computers.

• Don’t Care — Biomek Software automatically chooses the most 
appropriate correction method.

7. Choose Use Textures to include textures, such as microplate wells, on the 
instrument and labware surfaces displayed in the simulator.

8. If Use Textures is chosen, choose a Labware Texture Size, if desired. 
Dragging the slider to the right increases texture detail; dragging to the left 
reduces texture detail.

9. Change Tesselation Type to Triangle Fan or Quad Strip if a slight 
enhancement in image quality is desired. The default setting, Triangle Strip, is 
adequate for most computers. 

10. Choose the colored box to the right of Background Color to change the 
background color in the simulator display. Color appears (Figure 4-3).

Figure 4-3.  Selecting a background color

11. Select a new color, or define a custom color for the simulator background.
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12. Choose OK to set the new background color.

OR

Choose Cancel to retain the original background color.

13. Select Blending to render semi-transparent objects, such as tips, correctly.

Note:  When Blending is disabled, semi-transparent objects appear opaque; 
for example, liquid is not visible inside tips. Leaving Blending disabled is 
recommended for slower computers.

14. Select Round Edges to smooth out and round the edges of the instrument in the 
simulator display.

15. Select Show camera navigation buttons to display camera navigation 
controls by default during simulated method runs and in Simulator Preview.

Note:  The camera is the position from where the 3-D model is being viewed. 
The camera navigation controls are used to move or rotate the camera, which 
changes the viewing angle of the model in the simulator.

Note:  Camera navigation controls may also be toggled on and off during 
simulated method runs by pressing the tilde (~) key to enable the simulator 
controls (refer to Section 12.18.1.1.1, Using the Simulator Controls).

16. Select Use hardware OpenGL acceleration if available to provide 
smoother rendering of the model and animation on supported computers.

17. Hide the bridge or canopy of the instrument to provide an unobstructed view of 
the pod(s) performing the steps in the method.

FX, 3000 — Select Hide front section of pod bridge.

NX-MC, NX-S8 — Select Hide Canopy.

18. Choose Preview to access Simulator Preview at any time during simulator 
configuration (refer to Section 4.4.1.1, Viewing the Simulator Preview).
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4.4.1.1 Viewing the Simulator Preview
Simulator Preview shows the 3-D model of the instrument, including current 
configuration changes, as it appears in animated simulations. Simulator Preview is 
accessible from Simulator, Camera, or Materials at any time.

To view the Simulator Preview:

1. Choose Preview to view changes made to the settings, if desired. Simulator 
Preview appears (Figure 4-4).

Figure 4-4.  Simulator Preview with camera navigation buttons enabled

2. Change the view by placing the cursor in the simulator display, then clicking and 
dragging the mouse in the desired direction of rotation.

OR

Change the view by clicking the cursor in the simulator display and using the 
keyboard control keys defined in Camera (refer to Section 4.4.2, Configuring 
Camera Controls).

OR

Use the camera navigation buttons to change, save, and reset the view
(Figure 4-5). The camera navigation buttons are displayed only when enabled in 
Simulator (refer to Section 4.4.1, Configuring Simulator Settings).

Note:  The camera is the position from where the 3-D model is being viewed. 
The camera navigation buttons move or rotate the camera, which changes the 
angle at which the model is being viewed in the simulator.
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Figure 4-5.  Camera Navigation buttons

3. Choose OK to close Simulator Preview and return to the simulator 
configuration in Hardware Setup.

Reset View
Restores the 
default view.

Store camera position
Choose a position to save 
the current view. Up to ten 
positions may be saved.

Restore camera position
Choose a position to show the view 
stored in that position.

Rotate camera position
Rotates the camera position in 
the indicated direction.

Move In
Moves the 
instrument closer.

Move Out
Moves the 
instrument 
further away.

Move camera position
Moves the camera position 
in the indicated direction.
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4.4.2 Configuring Camera Controls
The camera is the position from where the 3-D model of the instrument is being 
viewed. To change the view of the model, the camera can be moved using the 
keyboard, mouse, or optional camera navigation buttons. In Camera, movements are 
called Actions. Keyboard and mouse controls are called Bindings. Keyboard and 
mouse controls can be created, edited, or deleted in Camera.

Note:  Camera navigation buttons are enabled and disabled in Simulator (refer to 
Section 4.4.1, Configuring Simulator Settings).

To add or modify a camera control:

1. From the left pane of Hardware Setup, expand the Simulator tree, if 
necessary, and choose Camera. Camera appears (Figure 4-6).

Figure 4-6.  Hardware Setup — configuring camera controls

2. In the Actions pane, select the camera control to modify. The current keyboard 
and mouse control settings appear in Bindings.

3. In Bindings, select the binding to delete or modify. 

4. Choose Delete Bind to delete the selected binding.

OR

Modify the binding. Modifications include:

• Creating or Editing a Mouse Binding (Section 4.4.2.1).

• Recording or Editing a Key Binding (Section 4.4.2.2).

Configure 
binding settings
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4.4.2.1 Creating or Editing a Mouse Binding
Mouse bindings control camera actions using mouse controls. They may be 
configured to use a single mouse control, a combination of mouse controls, or a 
combination of mouse controls and modifier keys on the keyboard.

Note:  The mouse buttons, wheel, and directional movement are all considered 
mouse controls.

To create or edit a mouse binding:

1. To create a new mouse binding, choose Add Mouse Bind.

OR

To edit an existing mouse binding, select the desired binding.

2. In Mouse Command, choose the desired command.

3. In Modifiers, select any desired keyboard modifiers and/or mouse commands.

Note:  The Ctrl, Alt, and Shift keys are keyboard modifiers. Mouse command 
modifiers are Right, Left, and Middle, which represent mouse buttons and 
Double, which represents double-clicking.

4. If creating a new mouse binding, choose Add Mouse Bind to add the new 
binding to the selected Action.

5. To test the mouse binding, choose Preview to access Simulator Preview at any 
time during simulator configuration (refer to Section 4.4.1.1, Viewing the 
Simulator Preview).

4.4.2.2 Recording or Editing a Key Binding
Key bindings control camera actions with keys on the keyboard. They may be 
configured to require a single key, such as “T”, or a combination of a key and 
modifier.

To record or edit a key binding:

1. To create a new key binding, choose Record Key Bind.

OR

To edit an existing key binding, select the desired binding.

2. If creating a new binding, press the desired key.

3. In Modifiers, select a modifier key, if desired.

4. To test the key binding, choose Preview to access Simulator Preview at any 
time during simulator configuration (refer to Section 4.4.1.1, Viewing the 
Simulator Preview).
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4.4.3 Configuring Materials
Each component of the 3-D instrument model is made of a material which has visual 
properties, such as color and reflectivity, specified. Properties can be edited in 
Materials. However, configuring the properties of materials is not necessary or 
recommended. 

Materials can also be created and deleted using the buttons in Materials. Materials 
should never be deleted, because the deleted material will no longer be visible in the 
simulator. Likewise, materials created by users will not appear in the simulator either.

Note:  Always preview changes in Simulator Preview before saving the new 
configuration. Refer to Section 4.4.1.1, Viewing the Simulator Preview, for more 
information. 

To configure Materials:

1. From the left pane of Hardware Setup, expand the Simulator tree, if 
necessary, and choose Materials. Materials appears (Figure 4.4).

Figure 4-7.  Hardware Setup — configuring materials

Note:  In Materials, select the material to edit. The properties of the material 
appear. Table 4-2 provides descriptions of each material

2. In Properties, do not change the Name. Changing the name of a material causes 
it to no longer be visible in the simulator.



4-12 Configuring Hardware Setup

Beckman Coulter, Inc.

3. Choose the colored box to the right of a color parameter to change the color of 
the material. Color appears.

Note:  Ambient and Diffuse define the color of the material when light is 
present. Specular defines the color of specular highlights (glare). Emission 
defines the color of the material in the absence of light.

4. In Color, select a new color, or define a custom color for the color parameter.

5. Enter a new value for Shininess, if desired.

Note:  Shininess defines the reflectivity of the material on a scale of 0 – 100, 
with 100 being the most reflective.

6. To view changes made to materials, choose Preview. to access Simulator 
Preview at any time during simulator configuration (refer to Section 4.4.1.1, 
Viewing the Simulator Preview).

Table 4-2.  Materials
Material Description

ALPBase Base or stand of an ALP.
AmberLightCurtainDisplay Color of the front panel indicator light during a 

method run.
BarcodeBeam Laser beam emitted by a barcode reader.
BlackPlastic Biomek 3000 tool bodies.
DAxisIndicator Color band that encircles the head to show upward 

and downward movement.
Deck Instrument deck.
Default Default color of a material when deleted from the 

simulator.
GreenLightCurtainDisplay The color of the front panel indicator light when the 

instrument is not running a method.
Gripper Gripper.
LightCurtain Color of light curtain during a method run.
Pod Instrument pod.
StackerCarouselSupport Brackets that support a Stacker Carousel.
Tips Tips.
TLRods Tip Loader locking rods.
ViolatedLightCurtain Color of light curtain after a violation has occurred.
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5 Preparing and Managing the 
Deck

5.1 Overview
The Deck Editor is used to define and change the deck configurations stored in the 
current instrument file. A deck is a software representation of the Biomek instrument 
deck (Figure 5-1) and can be stored and used for multiple methods; however, the 
software deck must always match the physical deck of the instrument used in the 
method.

A deck is created and modified in the Deck Editor, configured for the method in the 
Instrument Setup step, and used extensively by the software. A deck also stores 
framing information and device associations for each position on the deck.

The Deck Editor can be used to:

• Create new decks.

• Delete unused decks.

• Define the types and locations of ALPs, labware positioners, and devices 
positioned on a Biomek instrument deck.

• Control device associations.

• Frame (teach) the physical positions of ALPs, labware positioners, and 
devices.

The sections in this chapter include:

• Understanding the Deck Editor (Section 5.2)

• Opening, Selecting, Creating, Deleting, or Renaming a Deck (Section 5.3)

• Modifying a Deck (Section 5.4)
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The Deck Editor displays decks to be used during the method-building process. A 
deck is set as the default deck in the Deck Editor. The default deck appears when the 
Deck Editor is opened and is selected automatically when the Instrument Setup 
step is inserted into a method. The Instrument Setup step allows selection of any 
previously defined deck (Figure 5-1). 

Figure 5-1.  Deck relationship in Biomek 3000

Deck Editor
Access from Instrument 
menu. Shows a deck for 
Biomek 3000. Allows for 
deck modification.

Deck
Area used to configure the 
selected deck during 
Instrument Setup.

Deck Selection
Allows a deck to be 
selected during the 
method-building process. 
The deck set as the default 
deck in the Deck Editor is 
selected automatically.

Deck Display
Illustrates the 
configuration of 
the current deck.
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5.1.1 Framing the Deck
Framing the deck allows the Biomek Software to remember each deck position for 
each Biomek pod, and the Deck Editor is used to set the properties of each ALP and 
position. Several properties, such as Position Span and Labware Offset, are 
preprogrammed into Biomek Software; however, other properties, such as Position, 
must be set by teaching.

The position offsets are taught using the framing tools with the Biomek instrument. 
However, different framing tools are used according to the type of instrument, type of 
pod, or the specific deck position. Refer to the appropriate hardware user’s manual for 
information on framing the specific Biomek instrument.



5-4 Preparing and Managing the Deck

Beckman Coulter, Inc.

5.2 Understanding the Deck Editor
The Deck Editor allows for creation and modification of decks. While the 
instructions for opening, creating, renaming, and deleting decks are the same, decks 
for the specific Biomek instrument have different positions since decks in the Deck 
Editor are based on the physical decks of the instruments.

To access the Deck Editor:

Select Instrument>Deck Editor. The Deck Editor appears (Figure 5-2).

Figure 5-2.  Deck Editor showing Deck1 for a Biomek FX

Coordinates of Position on Deck
Shows coordinates of selected position. 
Display can be docked as desired.

Deck View
View of currently open deck.

Deck Notation Area
Provides an area for making notes 
during deck configuration.

Current Deck Name
Name of currently opened deck. The deck set as the default 
in the Deck Editor is identified as (Default Deck).

ALP Type List
Lists available ALPs and 
devices for placement on 
deck. Depending on the 
instrument, different ALPs 
or devices are displayed.

Used to filter specific types of ALPs, such as All, 
Basic, Devices, Span8, Trash, Tubes, and 
Wash.
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The Deck Editor has several options on the toolbar used to modify decks (Table 5-1). 

Table 5-1.  Deck Editor Options
Options Description

New Deck Creates a new deck based upon the 
current deck.

Delete Deck Permanently removes the current 
deck.

Rename Deck Changes the current deck name.
Open Deck Opens an existing deck and sets it as 

the current deck. 
Clear Deck Removes all ALPs and devices from 

the deck.
Renumber Renames all of the deck items based 

on position starting in the upper left 
corner.

Delete ALP Removes an ALP or device from the 
deck.

Properties Opens the properties for the selected 
deck position or ALP.

Save Saves the deck and closes the Deck 
Editor.

Cancel Cancels the changes made to the 
opened deck and closes the Deck 
Editor.
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5.2.1 Viewing the ALP Types List
The ALP Types List (Figure 5-2) shows all standard ALPs, labware positioners, and 
devices available to place on the deck. Only the ALPs, labware positioners, and 
devices that can be placed on the deck for the current instrument type are displayed. 
Use the filter to list only specific types of ALPs.

CAUTION: Make sure the correct ALP is chosen when configuring the 
deck setup in the Deck Editor. ALPs vary in height and failure to choose 
the correct ALP in the Deck Editor may result in collisions between 
pod(s) and ALPs during operation.

Figure 5-3.  Deck Editor for a Biomek FX 

Note:  Refer to Section 5.4.2, Adding ALPs and Deck Positions, for more 
information on adding ALPs to a deck. Refer to the ALPs User’s Manual for more 
information about specific ALPs.

5.2.2 Biomek FX Deck
Each initial Biomek FX deck (Figure 5-2) contains 1 Tip Loader ALP (TipLoader) 
and 19 deck positions (areas where ALPs may be placed). The 19 deck positions are 
made of five 1 x 3 Passive ALPs and four 1 x 1 Passive ALPs.

• Deck1 — initially has 1 Tip Loader ALP position and 19 deck positions; no 
tip loader device is associated with the tip loader position; can be modified 
to include other ALPs and other external hardware devices (Figure 5-2).

• Standard — has 1 Tip Loader ALP position and 19 deck positions; no tip 
loader device is associated with the tip loader position; cannot be modified; 
can be copied to create new decks.

Note: Do not use the Standard deck in a method; it cannot be modified 
and is used only to create new decks by using the New Deck option.

ALP Types List

Filter
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5.2.3 Biomek 3000 Deck
Each initial Biomek 3000 deck (Figure 5-4) contains 1 tool rack position (ToolRack) 
and 7 deck positions (areas where tool racks and devices may be placed). 

• Deck1 — initially has 1 tool rack position and 7 deck positions; can be 
modified to include other tool racks and devices (Figure 5-4).

• Standard — has 1 tool rack position and 7 deck positions; cannot be 
modified; can be copied to create new decks

Note: Do not use the Standard deck in a method; it cannot be modified 
and is used only to create new decks by using the New Deck option.

Figure 5-4.  Deck Editor for a Biomek 3000
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5.2.4 Biomek NX-MC Deck
Each initial Biomek NX-MC deck (Figure 5-5) contains one Tip Loader ALP 
(TipLoader) position and 12 labware positions. One 4 by 3 High Density ALP 
position provides the 12 labware positions. Two more ALPs may be placed in the 
back row to allow a total of 15 positions.

• Deck1 — initially has one Tip Loader ALP position and 12 labware 
positions; no tip loader device is associated with the tip loader position; can 
be modified to include other ALPs and other external hardware devices 
(Figure 5-5).

• Standard — one Tip Loader ALP position and 12 labware positions; no tip 
loader device is associated with the tip loader position; cannot be modified; 
can be copied to create new decks.

Note: Do not use the Standard deck in a method; it cannot be modified 
and is used only to create new decks by using the New Deck option.

Figure 5-5.  Deck Editor for a Biomek NX-MC
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5.2.5 Biomek NX-S8 Deck
Each initial Biomek NX-S8 deck (Figure 5-6) contains one Span-8 Disposal ALP 
(Span8TipTrash) position, one Span-8 Tip Wash position (Span8WashLeft), and 
12 labware positions. One 4 by 3 High Density ALP position provides the 12 labware 
positions. One more ALP may be placed in the back row to allow a total of 15 
positions.

• Deck1 — initially has one Span-8 Disposal ALP position, one Span-8 Tip 
Wash position, and 12 labware positions; can be modified to include other 
ALPs and other external hardware devices (Figure 5-6).

• Standard — has one Span-8 Disposal ALP position, one Span-8 Tip Wash 
position, and 12 labware positions; cannot be modified; can be copied to 
create new decks.

Note: Do not use the Standard deck in a method; it cannot be modified 
and is used only to create new decks by using the New Deck option.

Figure 5-6.  Deck Editor for a Biomek NX-S8
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5.3 Opening, Selecting, Creating, Deleting, or 
Renaming a Deck

The Deck Editor is used to open, select, create, delete, or rename a deck in the 
Biomek Software.

5.3.1 Opening and Selecting a Deck
A deck is selected in Deck Editor as the default deck. Each time an Instrument 
Setup step is inserted into a method, the default deck appears.

To select a deck:

1. In the Deck Editor, choose Open Deck. Select a Deck appears (Figure 5-7).

Figure 5-7.  Previews deck selected

2. Select the desired deck from the Deck List.

3. Choose OK. The deck appears as the current deck.

4. Choose Save to save the deck and exit Deck Editor.

Deck Preview

Notes made in the 
Deck Notation 
Area appear here.

Deck List
Lists available decks.

Checkmark 
opens the 
deck as the 
default.
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5.3.2 Creating a New Deck
When a new deck is created, it is initially a copy of the currently open deck. A new 
deck may be created for many reasons, including:

• To maintain the previous deck configuration when switching between 
different deck layouts.

• When similar deck configurations exist, but with differences between one or 
two positions.

• When devices replace deck positions.

To create a new deck:

1. In the Deck Editor, open the deck to copy as a basis for the new deck
(refer to Section 5.3.1, Opening and Selecting a Deck).

2. Select New Deck. Choose a name for this deck: appears (Figure 5-8).

Figure 5-8.  Enter a new name for the deck

3. Enter a name for the new deck.

4. Choose OK to save the deck name and return to the Deck Editor. A copy of the 
selected deck appears, using the new name and is ready for modification.

5. If desired, make modifications to the new deck.

6. Choose Save to save the new deck and exit Deck Editor.

Note:  Choose Cancel to cancel the modifications made to the deck. A Confirm 
appears to confirm cancellation of the changes (Figure 5-9).

Figure 5-9.  Confirmation to cancel changes
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5.3.3 Deleting a Deck
If a deck is no longer needed, it may be deleted.

Note:  Once a deck is deleted in the Deck Editor, it cannot be retrieved via the Deck 
Editor. It can be retrieved, however, using the Import/Export Utility (refer to Chapter 
3, Using Instrument Files and Settings).

To delete a deck:

1. Open the deck to delete (refer to Section 5.3.1, Opening and Selecting a Deck).

2. Select Delete Deck. A Warning appears (Figure 5-10).

Figure 5-10.  Delete Deck confirmation 

3. Choose Yes to delete the deck. The deck is deleted.

4. Choose Save to exit the Deck Editor.

Note:  Choose Cancel to cancel the deletion of the deck.
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5.3.4 Renaming a Deck
Rename a deck to easily identify it. 

To rename a deck:

1. Open the deck to rename (refer to Section 5.3.1, Opening and Selecting a Deck).

2. Choose Rename Deck. Choose a name for this deck: appears(Figure 5-11).

Figure 5-11.  Change deck name 

3. Enter the desired deck name.

Note:  Names for deck positions must be alphanumeric with no spaces; the only 
non-alphanumeric character allowed is “_” (underscore). The first character must 
be a letter.

4. Choose OK to save the deck under the new name.

Note:  An Error similar to Figure 5-12 appears if the new name already exists. 
Choose another name.

Figure 5-12.  Error in renaming

5. Choose Save to exit the Deck Editor.

Note:  Choose Cancel to cancel the renaming of the deck.
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5.4 Modifying a Deck
3000 — Labware positioners and devices on a Biomek 3000 are referred to 
as ALPs in Deck Editor.

Modifying a deck includes:

• Opening the deck to modify or create a new deck (refer to Section 5.3.2, 
Creating a New Deck).

• Deleting ALPs and deck positions from the open deck as necessary.

• Adding ALPs and deck positions as necessary.

• Setting ALP and deck position properties.

5.4.1 Deleting ALPs and Deck Positions from a 
Deck

When a deck is copied or a new deck is created, it is necessary to remove ALPs no 
longer needed. Remove these ALPs so that other ALPs can be added. 

To remove ALPs:

1. Click on the ALP to delete in the Deck View (Figure 5-2).

Note:  Notice that the ALP is highlighted with a pink border, and deck positions 
are highlighted with a yellow border. If a single position within a multiposition 
ALP is selected, it is highlighted pink.

2. Select Delete ALP from the toolbar. 

OR

Press the Delete key on the keyboard. 

OR

Right-click on the deck position and select Delete from the menu that appears. 
A Warning prompt appears (Figure 5-13).

Figure 5-13.  Confirmation to delete ALP

3. Choose Yes to delete the ALP. The modified deck appears in Deck View (Figure 
5-2).
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5.4.2 Adding ALPs and Deck Positions
New ALPs can be added to the deck in the appropriate locations. Deck positions are 
part of ALPs and are named automatically when added to a deck.

To add ALPs to the deck:

1. Click and hold the mouse button on the desired ALP in the ALP Types List 
(Figure 5-14). Notice that the locations capable of supporting the ALP are 
indicated by dashed boxes.

Figure 5-14.  Possible OneByThree deck positions highlighted on a Biomek FX deck 

2. Drag and drop the ALP from the ALP Types list to the desired location. The 
ALP appears and deck positions are named automatically.

Note:  The positions may be renamed (refer to Section 5.4.3, Setting ALP 
Properties and Deck Positions).

Note:  If the desired ALP is about to be placed where another ALP is currently 
placed on the deck, the following warning appears (Figure 5-15). Delete the 
currently-placed ALP before placing the desired ALP on the deck (refer to 
Section 5.4.1, Deleting ALPs and Deck Positions from a Deck).

Figure 5-15.  Warning appears because an ALP is about to be placed 
where it will overlap another ALP

ALP Types 
List

Dashed lines indicate where the selected ALP 
can be placed on the Biomek FX deck.
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5.4.3 Setting ALP Properties and Deck Positions
After a new ALP is placed on the deck, set the properties of the ALP and related deck 
positions (Table 5-2).

The following properties may be configured for ALPs or deck positions:

Note:  Not all properties listed in Table 5-2 may be present. Properties vary 
according to the instrument and configuration.

Table 5-2.  ALP and Position Properties.
Property Description Applies To

Name The name of the deck position as shown in the Instrument Setup 
step. ALPs have related names that do not appear in the Instrument 
Setup.

Position and ALP

Pod1 and Pod2 
Coordinates

The coordinate location of the back left corner of the position on the 
instrument platform for each pod (Figure 5-16).

Position and ALP

Device Instrument, such as a Stacker Carousel or Tip Loader, associated with 
a deck position (refer to Section 5.4.3.1, Setting ALP Properties). 
Displayed only when More>> is selected.

Position

Device Index Location of labware in the device associated with a deck position 
(refer to Section 5.4.3.1, Setting ALP Properties). Displayed only 
when More>> is selected.

Position

Sensor Device Associates the position with the Source/Waste Sensor which is used 
with an off deck source or waste container.

Position 

Labware Offset The coordinate difference from the Position to the back left corner of 
the labware (Figure 5-16). Refer to Section 5.4.3.1, Setting ALP 
Properties. Displayed only when More>> is selected.

Position

Position Span Area of the Biomek platform the ALP or position covers. (The span 
for an ALP may be different from the span of a position.) Displayed 
only when More>> is selected.

Position and ALP

Min Safe Height Reserved height above position needed to avoid collisions. Displayed 
only when More>> is selected.

Position

Per-Labware 
Offsets

Coordinate difference between the set Labware Offset to where 
specific types of labware sit on the deck position (Figure 5-16). Useful 
for tip loading and when using the SPE Manifold (refer to Section 
5.4.3.1, Setting ALP Properties). Displayed only when More>> is 
selected.

Position
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Figure 5-16.  Position and Labware Offset locations on the OnebyOne ALP

Labware Offset

Labware Position

Position
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5.4.3.1 Setting ALP Properties
To set properties of the ALP:

1. From the Deck View, select the ALP to modify.

Note:  The ALP is selected when the outer edges of the ALP are highlighted 
pink, and the associated deck positions are highlighted in yellow within the Deck 
View. Deck positions with green highlights are associated with devices.

2. Choose Properties.

OR

Right-click on the ALP in the Deck Editor or any of its positions and select ALP 
Properties.

OR

Double-click on the ALP on the deck layout. ALP Properties appears (Figure 5-
17).

Figure 5-17.  ALP Properties of a OneByThree ALP

Note:  Not all properties listed on Figure 5-17 may be present. Properties vary 
according to the instrument and configuration.

3. Change the Name of the ALP, if desired.

4. Choose OK to save the ALP properties. Current Deck appears.

5. Choose Save to close the Deck Editor
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5.4.3.2 Setting Deck Position Properties
Deck position properties are similar to ALP properties; however, deck positions 
include Labware Offsets that place the labware in the appropriate place for pipetting 
operations. Because some deck positions are associated with devices, such as a 
Stacker Carousel, the Device property must be set for these deck positions.

To set deck position properties:

1. Select the position to modify.

2. Select Properties.

OR

Double-click on the deck position.

OR

Right-click on the desired position and select Properties from the menu that 
appears. Position Properties appears (Figure 5-18).

Figure 5-18.  Position Properties for Deck Positions

Note:  Not all properties listed on Figure 5-18 may be present. Properties vary 
according to the instrument and configuration.

Note:  The deck position is highlighted with a pink line inside the ALP.

3. Rename the deck position, if desired.

Note:  Names for deck positions must be alphanumeric with no spaces; the only 
non-alphanumeric character allowed is “_” (underscore). The first character must 
be a letter.
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4. Enter the X, Y, and Z Coordinates of the appropriate pod by framing the ALP: 

FX — refer to the Biomek® FX Laboratory Automation Workstation User’s 
Manual, Chapter 5, Framing the Biomek® FX.

3000 — refer to the Biomek® 3000 Laboratory Automation Workstation 
User’s Manual, Chapter 13, Framing the Biomek® 3000.

NX-MC — refer to the Biomek® NX Multichannel Laboratory Automation 
Workstation User’s Manual, Chapter 4, Framing Instructions.

NX-S8 — refer to the Biomek Software User’s Manual, Chapter 5, 
Preparing and Managing the Deck.

5. Select More>>, if necessary.

6. Choose the Device name to associate with the position, if required.

Note:  For devices controlled through SILAS, the SILAS module for the device 
must be installed prior to associating the device with a deck position.

7. If appropriate, select the Device Index.

Note:  The Device Index works with software modules operating instruments 
that have more than one position, such as the MicroMix 5 Shaker.

8. If appropriate, choose the desired Sensor Device to associate the Waste/Sensor 
with the position.

9. Choose Per-labware Offsets to customize the offsets for specific types of
labware (refer to Section 5.4.3.3, Changing Per-Labware Offsets). 

10. Set the Min Safe Height.

Note:  The Labware Offsets and Position Span are predefined in the software. 
Do not modify these properties.

11. Choose OK to save the deck position properties. Current Deck appears.

12. Choose Save to close the Deck Editor.
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5.4.3.3 Changing Per-Labware Offsets
Modify the per-labware offsets when specialized needs arise. The X, Y, and Z 
coordinates for the deck position may be modified based upon the labware type. For 
example, the Z offsets can be changed for a plasmid filter when performing a 
filtration-based DNA plasmid purification.

To modify the per-labware offsets:

1. Select Instrument>Deck Editor.

2. Open the desired deck (refer to Section 5.3.1, Opening and Selecting a Deck).

3. Select the position to modify.

4. Select Properties

OR

Double-click on the deck position

OR

Right-click on the desired position and select Properties. Position Properties 
appears (Figure 5-18).

5. Choose More>>, if necessary.

6. Choose Per-labware Offsets.

7. In Per-Labware Offsets, select the labware to modify (Figure 5-19).

Figure 5-19.  Per-Labware Offsets

Note:  Per-Labware Offsets includes labware that is specific to the instrument.
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8. Enter the desired X, Y, and Z offsets.

Note:  While the offset values may be calculated using calipers, a more precise 
measurement should be obtained from the manufacturer’s drawings.

9. Choose OK to save the offset values. Position Properties appears (Figure 5-18).

10. Choose OK.

11. Choose Save to close Deck Editor.
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6 Understanding and Using 
Project Files

6.1 Overview
A project file stores information about liquid types; labware and tip types; well 
patterns; and pipetting templates and techniques as revisions that are used by a 
method file to configure the actions of the instrument. Project files store a history of 
all changes, additions, and deletions of items from the project file. 

When a project file is checked in, all items become revisions that are permanently 
saved. If an item is deleted, that item is no longer available in method building; 
however, the revision remains in the project file and is used for older validated 
methods that utilize that revision. If an item is modified, the new definition is stored 
as a separate revision. Older revisions remain as part of the project file and are used 
by older validated methods that utilize that record. However, only the newest 
revision, or working revision, is available in method building. In this way, a validated 
method can always be run with the exact same revisions, even if those revisions have 
since been modified or deleted (refer to Section 12.11, Validating a Method).

Note:  If Beckman Coulter Accounts & Permissions is used with Biomek Software, 
project files also maintain a history of who makes changes to any revisions in the 
project file.
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The active project file and instrument file are displayed in the status bar of the 
Biomek method editor (Figure 6-1). Any project file can be used with any instrument 
file. Validated methods, however, are validated for a specific instrument and are no 
longer validated when used with a different instrument file, even if the instrument file 
is equivalent to the one on which the method is validated. 

Note:  Validating a method for a specific instrument is not the same as validating a 
method before a run to internally test the method for errors before it is run. To validate 
a method to test for errors before it is run, check Validate the current method 
before running it in Preferences (refer to Section 29.2, Changing Display 
Preferences).

Figure 6-1.  Biomek method editor

The Project menu contains options to access, create, view contents, and check in 
projects, as well as provide access to the editors to create, modify, and delete project 
items.

The sections in this chapter include:

• Creating a New Project File (Section 6.2).

• Opening a Project File (Section 6.3).

• Deleting and Restoring Project Files (Section 6.4).

• Renaming a Project File (Section 6.5).

• Creating a Copy of a Project File (Section 6.6).

• Checking In a Project File (Section 6.7).

• Viewing Project Contents (Section 6.8).

• Reverting Projects (Section 6.9).

• Importing and Exporting Project Files (Section 6.10).

Active instrument file

Active project file
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6.1.1 Contents of a Project File

A project file contains all:

• Labware Classes — definitions for microplates, reservoirs, tip boxes, and 
other labware used in a method, as specified in the Labware Type Editor 
(refer to Section 7.3, Defining Labware Types).

• Labware Patterns — definitions of patterns of wells to aspirate or dispense 
from, as specified in the Well Pattern Editor (refer to Chapter 11, Creating 
Well Patterns).

• Liquid Types — definitions for reagents used in a method, as specified in 
the Liquid Type Editor (refer to Chapter 8, Understanding and Creating 
Liquid Types).

• Pipetting Templates — templates of how pipetting operations are 
performed, as specified in the Pipetting Template Editor (refer to Chapter 
10, Using the Pipetting Template Editor).

• Techniques — configuration of properties and parameters for all pipetting 
operations, as specified in the Technique Browser and Technique Editor 
(refer to Chapter 9, Understanding and Creating Techniques).

• Tip Classes — definitions for tips used in a method, as specified in the Tip 
Type Editor (refer to Section 7.2, Defining Tips).

In addition, methods are associated with a project file. To open a method, the project 
file that was used to create the method must be the active project. 

Note:  If a method is open when a project file is closed to open a new project, a 
prompt appears to check in, save, or discard the current method. 
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6.2 Creating a New Project File
Any number of project files may exist on any system. This allows separate project 
files to be created for different applications or different users. Project files customize 
the instrument performance to the needs of users. For example, users could create 
their own project files. In this way, users can guarantee that the definitions used are 
not changed without their knowledge, and keep labware and liquid type catalogs 
limited to only the ones they use. 

Create Project is used to create a new, blank project file. A new project file has no 
existing revisions for labware types, liquid types, tip types, pipetting templates or 
techniques, or well patterns. 

Note:  A default project file is automatically created during installation of Biomek 
Software. The contents of the default project file depend on the options selected 
during the installation wizard.

To create a new blank project file:

1. From the Project menu, choose New Project. Create Project appears (Figure 
6-2).

Figure 6-2.  Create new project

2. Enter a name for the new project file.

Note:  The project file name must be different from all other project files.

3. Choose OK to create a new project with the specified name. Create Project 
closes and the new project becomes the active project file.

OR

Choose Cancel to close Create Project without creating a new project file.
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6.3 Opening a Project File
A project file can be opened at any time. Opening a project file closes the current 
active project and any methods that may be open, and opens the selected project.

To open a project file:

1. From the Project menu, choose Open Project. Open Project appears 
(Figure 6-3).

Figure 6-3.  Opening a project file

2. Select the desired project file to open.

3. Choose OK to open the selected (highlighted) project file. Open Project closes 
and the selected project file becomes the active project.

OR

Choose Cancel to close Open Project without opening a new project file. The 
current project remains active.
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6.4 Deleting and Restoring Project Files
Projects may be deleted, but are never permanently removed from the system, and 
may be restored at any time.

Note:  When multiple instances of the Biomek Software are running simultaneously, 
such as when controlling multiple Biomek instruments, project files are locked. 
Locked project files may be opened, but not deleted, renamed, or saved.

6.4.1 Deleting Projects
To delete a project:

1. From the Project menu, choose Open Project. Open Project appears 
(Figure 6-4).

Figure 6-4.  Open Project

2. Right-click the desired project to delete and choose Delete. A confirmation 
appears (Figure 6-5).

Figure 6-5.  Confirm deletion of selected project

3. Choose Yes to confirm deletion of the selected project. The project is removed 
from My Projects and placed in Recycled.

OR

Choose No to keep the selected project. 
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6.4.2 Restoring Projects
To restore a deleted project:

1. From the Project menu, choose Open Project. Open Project appears 
(Figure 6-4).

2. In the left panel of Open Method, choose Recycled to view all the projects that 
have previously been deleted.

Figure 6-6.  Recycled projects

3. Right-click the desired project to restore and choose Restore. The project is 
moved from Recycled to My Projects.

Note:  A project may be opened directly from the Recycled folder by selecting 
the project and choosing OK. A confirmation appears stating that the project will 
be restored prior to opening the project. Choose OK to restore and open the 
project.
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6.5 Renaming a Project File
A project file may be renamed at any time, regardless of whether it is open or closed. 
Renaming a project file does not create a copy of the file with the new name. 

Note:  To save a copy of a project file with a new name, use the Save Project As 
command (refer to Section 6.6, Creating a Copy of a Project File).

Note:  When multiple instances of the Biomek Software are running simultaneously, 
such as when controlling multiple Biomek instruments, project files are locked. 
Locked project files may be opened, but not deleted, renamed, or saved.

6.5.1 Renaming the Active Project File
To rename the project file currently open in the Biomek Software:

1. From the Project menu, choose Rename Project. Rename Project appears 
(Figure 6-7).

Figure 6-7.  Renaming the open project

2. Enter a new name for the project file.

3. Choose OK to rename the project file.

OR

Choose Cancel to retain the original name.
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6.5.2 Renaming a Saved Project File
To rename a saved project file:

1. From the Project menu, choose Open Project. Open Project appears 
(Figure 6.8).

Figure 6-8.  Open Project

2. Right-click the desired project to rename and choose Rename. The project file 
name is highlighted.

3. Enter a new name, and press Enter.

4. Choose OK to close Open Project, save the project file with the new name, and 
open the new project file.

OR

Choose Cancel to close Open Project and save the project with the new name 
only.
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6.6 Creating a Copy of a Project File
A project file can be copied to create a new project file based on the original using the 
Save Project As command. A new project created using Save Project As maintains 
all the records from the original project in a new project file.

Note:  Using Save Project As copies only the working revision of each project item 
and does not include prior revisions of project items or any method files in the 
project. Methods must be imported separately using the import and export options in 
the File menu. Refer to Section 12.16, Importing and Exporting Methods, Section 
12.16.1, Exporting a Method, and Section 12.16.2, Exporting All Methods Associated 
With a Project File, for more information.

To create a copy of a project file:

1. If the project file to copy is not the active file, open the desired project file (refer 
to Section 6.3, Opening a Project File).

2. From the Project menu, choose Save Project As. Save Project As appears 
(Figure 6-9).

Figure 6-9.  Saving project as to create a copy

3. Enter a name for the new project file.

Note:  The project file name must be different from all other project files.

4. Choose OK to create a new project with the specified name. Save Project As 
closes and the new project becomes the active project file.

OR

Choose Cancel to close Save Project As without creating a new project file.



Understanding and Using Project Files 6-11

Biomek Software User’s Manual

6.7 Checking In a Project File
Changes made to any item in a project file are saved but do not become revisions until 
checked in. Once checked in, a new revision is created for the project items. 
Revisions can never be lost. If a project item is later modified or deleted, any revision 
of the project item may be restored.

Note:  If Beckman Coulter Accounts & Permissions is enabled, methods may be 
validated. A validated method is a revision of a method that is checked in, approved 
with a reason or electronic signature, and protected from further modification (refer to 
Section 12.15, Checking Out a Method). Before a method can be validated, all items 
used in the method must be checked in as revisions in the project file. 

To check in a project file to create new revisions:

1. From the Project menu, choose Check In Project. Check In Project displays 
a list of all project items that differ from the working revision in the project 
(Figure 6-10).

Figure 6-10.  Checking in project items as official records

2. Select all project items to check in as revisions in the project file by selecting the 
checkbox to the left of each project item. By default, all project items are 
selected.

Note:  Project items are listed in a tree structure that lists items by type. 
Branches may be expanded or collapsed using the + and - buttons to the left.

Note:  Right-click on a type of project item and choose Select All from the 
menu to select all project items of that type, or choose Select None to deselect 
all project items of that type. Right-click on whitespace and choose Select All 
or Select None to select or deselect all project items for all types.

3. Choose OK.

Note:  If Beckman Coulter Accounts & Permissions is not in use, check in is 
complete. All selected project items are checked in as revisions in the project file.

OR

Choose Cancel to close Check In Project without checking any project items 
in as revisions.
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4. If Accounts & Permissions is enabled, Check-In appears (Figure 6-11). Enter a 
Reason for checking in the project. 

Figure 6-11.  Check-In (Accounts & Permissions enabled)

5. If Accounts & Permissions is configured to require password checks for signing 
and check-in, enter the user Password.

6. Choose OK to check in all selected project items as revisions in the project file 
and close Check In.

OR

Choose Cancel to close Check-In without checking in the project.

Password
Only appears when Accounts & Permissions is configured to 
require password checks (refer to Section 2.2, Installing and 
Setting the Level of Support For Accounts & Permissions).
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6.8 Viewing Project Contents
The contents of a project file and status of each project item can be viewed at any 
time. 

To view the contents of a project file:

1. From the Project menu, choose Project Contents. Project Contents displays 
a list of all project items and their status (Figure 6-12). There are six possible 
states that may be listed for the status:

• Current — the project item matches the working revision.

• New — there are no existing revisions of the project item that have been 
checked in.

• Removed — the project item has been deleted and is not available for 
method editing.

Note: To view Removed items, right-click in Project Contents and 
select Show Deleted Items. All project items that have been deleted 
are listed in Project Contents with a status of Removed.

• Modified — the project item has changed since it was last checked in.

• Renamed — the project item has been renamed since it was last 
checked in as a revision, but is otherwise unchanged.

• Reverted — the project item has been reverted to a previous revision.

Figure 6-12.  Viewing project contents (Accounts & Permissions enabled)

Note:  When Accounts & Permissions is not enabled, Last Check In does not 
appear and Check In Time is named Modified Time.
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2. Right-click on any project item and choose History from the menu to view the 
history for that record (Figure 6-13). History displays the history of changes, 
who made the changes, the time changes were made, and any comments that may 
have been entered.

Note:  Changed By and Comment are blank unless Beckman Coulter 
Accounts & Permissions is enabled.

Figure 6-13.  History of a project record

3. When finished viewing the history for the record, choose OK to close History.

4. Repeat steps 2 and 3 to view the history for additional records, if desired.

5. Choose OK to close Project Contents.

6.8.1 Restoring Deleted Project Items
A deleted project item may be restored at any time and made available again for 
method building. Restoring a project item makes available the last revision of the 
project item that was checked in before it was deleted.

To restore a deleted project item:

1. From the Project menu, choose Project Contents. Project Contents displays 
a list of all project items and their status. 

2. Right-click in Project Contents and select Show Deleted Items. All project 
items that have been deleted are listed in Project Contents with a status of 
Removed.

3. Right-click on the desired deleted item to restore and select Restore from the 
menu. The status of the project item changes to Current and the project item may 
now be used in method building.
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6.9 Reverting Projects
A project file can be reverted back to a previous revision state, if desired. 

Note:  A revision is created each time a project is checked in.

Options for reverting project files are:

• Reverting Project Contents to a Certain Date and Time (Section 6.9.1).

• Discarding All Changes Since Last Check In (Section 6.9.2).

• Reverting Individual Project Items to a Specific Revision (Section 6.9.3).

6.9.1 Reverting Project Contents to a Certain 
Date and Time

All items in a project file may be reverted to the working revision at a previous date 
and time. When reverting project contents to a date and time, the latest revision 
checked in prior to the specified date and time is restored as the active working 
revision. Revisions checked in after the specified date and time remain in the project 
file, but are not active.

To revert project contents to a specific date and time:

1. From the Project menu, choose Project Contents . Project Contents displays 
a list of all project items and their status (Figure 6-14). 

Figure 6-14.  Viewing project contents
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2. Choose Revert. Revert Project appears (Figure 6-15).

Figure 6-15.  Reverting a project file to a specific date and time

3. Select Revert the project contents back to this date and time.

4. On the calendar, browse to and select the desired date.

5. Beneath the calendar, enter the desired time.

6. Choose OK. Revert Project closes and the project contents are reverted to the 
latest revision checked in prior to the specified date and time.

OR

Choose Cancel to close Revert Project without reverting the project contents.
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6.9.2 Discarding All Changes Since Last Check In
All the changes that have been made to any project contents since the project was last 
checked in may be discarded. Any changes made to a project item since the last time 
that project item was checked in are discarded. 

To discard changes since last check in:

1. From the Project menu, choose Project Contents. Project Contents displays 
a list of all project items and their status (Figure 6-16). 

Figure 6-16.  Viewing project contents
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2. Choose Revert. Revert Project appears (Figure 6-17).

Figure 6-17.  Discarding changes to a project file after a specific date and time

3. Select Discard all changes since the project was last checked in.

4. Choose OK. Revert Project closes and the all changes made to each project 
item since that item was last checked in are discarded.

OR

Choose Cancel to close Revert Project without discarding changes.
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6.9.3 Reverting Individual Project Items to a 
Specific Revision

An individual project item may also be reverted back to a specific revision, if desired.

To restore an individual project item to a specific revision:

1. From the Project menu, choose Project Contents. Project Contents displays 
a list of all project items and their status (Figure 6-18). 

Figure 6-18.  Viewing project contents

2. Right-click the desired project item to revert. History appears and displays a list 
of all the revisions of the project item that have been checked in. A blue arrow 
points to the active working revision for the project item (Figure 6-19).

Figure 6-19.  History of a project item

3. Double-click on the desired revision number of the project item to revert.

OR

Right-click the desired revision number and choose Revert Changes from the 
menu. The blue arrow moves to the revision to use as the working revision.

4. Choose OK. History closes and the selected revision is set as the working 
revision for the project item.
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6.10 Importing and Exporting Project Files
Project files and individual records can be freely shared among projects or transferred 
from one computer to another using Import Project and Export Project.

Note:  When Beckman Coulter Accounts & Permissions is enabled, users with the 
Run Validated Methods or Develop Methods permission may export methods, but 
only those with the Develop Methods permission may import methods into a project 
(refer to Chapter 2, Using Accounts & Permissions).

Note:  Methods may also be imported and exported. Refer to Section 12.16, 
Importing and Exporting Methods, for more information.

This section covers:

• Exporting a Project File to a Biomek Import File (Section 6.10.1).

• Importing a Project File from a Biomek Import File (Section 6.10.2).

6.10.1 Exporting a Project File to a Biomek Import 
File

A project file or individual records from a project file can be exported to a Biomek 
import file, which may be imported into a different project file. Exporting a project 
file always exports the working revisions from the current active project file. The 
specific items to export from the project file are then selected from all available 
project items.

To export a project file:

1. From the Project menu, choose Export Project. Export Project appears, 
displaying a list of all records in the project file (Figure 6-20).

Figure 6-20.  Selecting project contents to export
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2. Select all project items to include in the Biomek import file by selecting the 
checkbox to the left of each project item. By default, all project items are 
selected.

Note:  Project items are listed in a tree structure that lists items by type. 
Branches may be expanded or collapsed using the + and - buttons to the left of 
the project item name.

To select or deselect all project items of a specific type, select the checkbox to the 
left of folder representing the desired type of project item. Alternately, right-click 
on a type of project item and choose Select All from the menu to select all 
project items of that type, or choose Select None to deselect all project items of 
that type. Right-click on whitespace and choose Select All or Select None to 
select or deselect all project items for all types.

3. Choose OK to include all selected project items in the Biomek import file and 
close Export Project. Save As appears (Figure 6-21).

OR

Choose Cancel to close Export Project without exporting the project to a 
Biomek import file.

Figure 6-21.  Save Import File

4. In Save As, browse to and select the location to save the Biomek import file.

5. In File Name, enter a name for the import file.

6. Choose Save to create the new import file.
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6.10.2 Importing a Project File from a Biomek 
Import File

A Biomek import file previously exported from a project file can be imported into the 
current active project file. The records to import are selected from all available 
records in the import file. Biomek Software compares the selected project items in the 
import file to the current project and only imports those items that are different.

To import a project file from a Biomek import file:

1. If necessary, open the project file in which to import the Biomek import file.

2. From the Project menu, choose Import Project. Open Import File appears 
(Figure 6-22).

Figure 6-22.  Open Import File

3. In Open Import File, browse to and select the Biomek import file to import.

Note:  Workspace settings from Biomek FX software versions 2.5 or later may 
also be imported into a project file. To import a Biomek FX 2.5 software 
workspace file, from Files of type, select Biomek® FX Workspace Files to 
show all workspace files (*.wld).
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4. Choose Open. Check In Project appears, displaying a list of all project items in 
the project file to import (Figure 6-23). Only the project items that do not match 
any of the revisions in the current project file are listed.

Note:  Biomek Software compares the project items in the import file to the 
current project. If the item in the import file matches any revision in the current 
project, that item is not displayed in Check In Project; if all items from the 
import file match the current project, Information (Figure 6-24) appears instead 
of Check In Project.

Figure 6-23.  Checking in project items as official records

Figure 6-24.  Information that appears when no project items are imported

5. Select all project items from the Biomek import file to import by selecting the 
checkbox to the left of each project item. By default, all project items are 
selected.

Note:  Project items are listed in a tree structure that lists items by type. 
Branches may be expanded or collapsed using the + and - buttons to the left of 
the project item name.

Right-click on a type of project item and choose Select All from the menu to 
select all project items of that type, or choose Select None to deselect all 
project items of that type.
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6. Choose OK to import all selected project items from the Biomek import file into 
the project file and close Check In Project.

Note:  If Beckman Coulter Accounts & Permissions is not in use, check in is 
complete.

OR

Choose Cancel to close Check In Project without including any project items 
in the Biomek import file.

7. If Accounts & Permissions is enabled, Check-In appears (Figure 6-25). Enter a 
Reason for checking in the project. 

Figure 6-25.  Check-In (Accounts & Permissions enabled)

8. If Accounts & Permissions is configured to require password checks for signing 
and check-in, enter the user Password. 

9. Choose OK to close Check-In. The project items from the import file are 
imported to the project file.

Password
Only appears when Accounts & Permissions is configured to 
require password checks (refer to Section 2.2, Installing and 
Setting the Level of Support For Accounts & Permissions).
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7 Creating and Modifying Tip 
and Labware Types

7.1 Overview
Biomek Software must know the properties of the tips and labware used with the 
instrument to correctly perform liquid handling and gripper movement operations. A 
set of predefined tip and labware types commonly used in automated laboratories is 
preloaded with the software. 

However, there may be instances when a tip or labware type used in the laboratory is 
not predefined in Biomek Software, or specifications of a predefined tip or labware 
type change. When this occurs, tip modifications are made in the Tip Type Editor 
and labware type modifications are made in the Labware Type Editor.

Note:  Tips must be associated with a labware type in order to be used in a method. 

All labware types have a graphic associated with them in Biomek Software. Any new 
labware type created in the Labware Type Editor will have a corresponding graphic 
generated, based upon the labware type properties. The graphic then appears in the 
Labware Category Graphical Display of the Instrument Setup step for use in 
methods (Figure 7-1).

Tip and labware types, along with information about liquid types; well patterns; and 
pipetting templates and techniques, are stored as part of a project file. Project files 
store a history of all changes, additions, and deletions of items from the project file. 
Refer to Chapter 6, Understanding and Using Project Files, for more information on 
project files.

Note:  When Beckman Coulter Accounts & Permissions is enabled, only users with 
the Develop Projects permission assigned may open, edit, create, and delete tip and 
labware types (refer to Chapter 2, Using Accounts & Permissions).
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The sections in this chapter include:

• Defining Tips (Section 7.2)

• Defining Labware Types (Section 7.3)

Figure 7-1.  Relationships for labware and tips in Biomek Software

Labware Type Editor
Provides means to create 
and customize labware 
types, including tip boxes.

Graphical Display 
in Instrument 
Setup Step

Displays labware 
and tips to be 
selected and placed 
on the deck during 
method building.

Tip Type Editor
Provides means to 
accommodate new tip 
types.

Tips must be associated 
with a tip box in the 
Labware Type Editor.
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7.2 Defining Tips
All Beckman Coulter tip types may be used with Biomek instruments with some 
exceptions:

FX — Fixed tips can only be used on the Span-8 Pod. LLS tips should only 
be used on the Span-8 Pod since a Multichannel Pod cannot sense the liquid 
level of wells.

FX — Fixed60 and Fixed100 tips predefined in the Tip Type Editor for a 
Biomek FX project have a maximum capacity that is different from those in 
a Biomek NX project. Use caution when importing and exporting methods to 
and from instruments.

Note: The Span-8 Pod is capable of accessing all types of 
labware supported by the Biomek FX instrument; however, specific 
types of tips are recommended to access specific types of labware 
(refer to the Biomek® FX Laboratory Automation Workstation 
User’s Manual, Section 3.3.2.1, Labware and Tip Compatibility 
with the Span-8 Pod).

3000 — WashTips are only used internally with Biomek Software on the 
wash tool.

Note: The Biomek 3000 head is capable of accessing all types of 
labware supported by the Biomek 3000 instrument; however, some 
tools cannot access specific types of labware. For example, multi-
channel pipette tools cannot access test tubes (refer to the Biomek® 
3000 Laboratory Automation Workstation User’s Manual, Section 
2.3.1, Labware and Tip Compatibility with the Pipette Tools).

NX-S8 — LLS tips are conductive and also used for clot detection which is 
available only on this instrument.

NX-S8 — SeptaFluted tips are conductive and used for clot detection and 
for piercing septa which is available only on this instrument.

FX, NX-S8 — Fixed60 and Fixed100 tips predefined in the Tip Type 
Editor for a Biomek NX project have a maximum capacity that is different 
from those in a Biomek FX project. Use caution when importing and 
exporting methods to and from instruments.

Note: The pod is capable of accessing all types of labware 
supported by the Biomek NX instrument; however, specific types 
of tips are recommended to access specific types of labware (refer 
to the Biomek® NX Span-8 Laboratory Automation Workstation 
User’s Manual, Section 2.3.3.1, Labware and Tip Compatibility 
with the Span-8 Pod).

Note:  Refer to the specific hardware manual for a Biomek instrument for more 
information on tips and tip properties.

In order to use tips that are not predefined, use the Tip Type Editor to:

• Add new tips.

• Change tip properties, such as capacity and size.

• Remove tips.
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7.2.1 Accessing the Tip Type Editor
To access the Tip Type Editor, choose Project>Tip Type Editor.
Tip Types appears (Figure 7-2).

Figure 7-2.  Tip Types

Tip Properties
Displays properties 
of currently selected 
tips.

Tip List
Lists currently 
defined tip types. 
The tips that appear 
here predefined are 
dependent on the 
Biomek instrument 
type and 
configuration.



Creating and Modifying Tip and Labware Types 7-5

Biomek Software User’s Manual

7.2.2 Adding New Tips
Add tips that are not previously defined to ensure that liquid transfers are performed 
accurately.

To add tips:

1. In the Tip Type Editor, highlight the tip type that most closely resembles the new 
tip type.

Note:  Adding tips copies the selected tip type, including its properties. 

2. Choose Add. The tip type appears in the Tip List as “Tip” followed by a number. 
For example, the first tips created are named “Tip1”.

Figure 7-3.  Adding a new tip type

CAUTION: After new tips are added, the correct properties must be 
defined in the Tip Type Editor according to the manufacturer’s 
specifications. Inaccurate specifications may lead to hardware crashes.
3. Modify the tip properties according to the manufacturer’s specifications (refer to 

Section 7.2.3, Changing Tip Properties).

4. Choose OK.

Note:  Choose Cancel to cancel the addition of the tip type. A Warning appears to 
confirm the cancellation of changes (Figure 7-4).

Figure 7-4.  Warning to confirm cancellation of changes
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7.2.3 Changing Tip Properties
Change tip properties in the Tip Type Editor when defining new tips or changing the 
existing tip properties.

Tip properties include the following (Table 7-1):

Table 7-1.  Tip Properties 
Description

Name Names the tips for easy identification. 

Note:  Tip names must begin with a letter, and only 
letters, numbers, and underscores (_)can be used.

Capacity The maximum liquid volume the tip holds.
Air Capacity The total amount of leading air gap, plus liquid that can 

be aspirated. Trailing air gaps are counted against liquid 
capacity since they displace liquid further into the tips 
(Figure 7-5).

Height The total height of the tip (Figure 7-6).
Seating Depth The depth at which the tip seats properly on the mandrels 

(Figure 7-6).
Conic Length The lowest triangular section of a tip (Figure 7-6).
Max Tip Radius Radius of the tip at the top of the conic length

(Figure 7-6).
Min Tip Radius Radius of the tip at its narrowest point (Figure 7-6).
Runout Radius Defined area around a tip to account for manufacturing 

tolerances and tip bending.
LLS Tips Indicates the tips are conductive and capable of Liquid 

Level Sensing and clot detection. 

FX — Liquid Level Sensing is available on a 
Span-8 Pod only. Clot detection is not 
available.

NX-S8 — Liquid Level Sensing and clot 
detection are available.

Fixed Tips Indicates the tips are not disposable. 

FX, NX-S8 — Used on Span-8 Pods only.
Use System 
Tubing

Indicates the sample aspiration is allowed to enter the 
system tubing. 

FX, NX-S8 — Used on Span-8 Pods only.

3000 — Used for WashTips.
Piercing Tips Indicates the tips are capable of piercing septa.

NX-S8 — Septa piercing is available on this 
instrument only.
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Figure 7-5.  Tip capacity and air capacity

Figure 7-6.  Tip dimensions

To change tip properties:

1. In the Tip Type Editor, select the desired tips from the Tip List 
(Figure 7-2). The current properties of the tips display in Tip Properties.

2. Change the desired properties (Table 7-1) according to the manufacturer’s 
specifications.

3. Choose OK.

Note:  Choose Cancel to cancel the changes made to the properties. A Warning 
appears to confirm the cancellation of changes (Figure 7-4).

Air
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Air

This 
amount 
cannot 
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cannot 
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Max Radius
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7.2.4 Removing Tips 
Remove obsolete tips from the Tip List.

Note:  The Tip Type Editor does not allow tips to be deleted that are used by any 
labware class or that are on the pod. To delete a tip type, delete the labware type in the 
Labware Type Editor first (refer to Section 7.3.6, Editing Labware Type Properties).

To remove tips:

1. In the Tip Type Editor, select the desired tips from the Tip List.

2. Choose Remove. A Warning appears (Figure 7-7).

Figure 7-7.  Remove tips warning

3. Choose Yes to confirm the removal. The tips are removed from the Tip List.

4. Choose OK. 

Note:  Choose Cancel to cancel the removal of the tip type. A Warning appears to 
confirm the cancellation of changes (Figure 7-4).
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7.3 Defining Labware Types
Labware types are divided into categories, such as titerplates, reservoirs, tube racks, 
lids, and tip boxes. In Biomek Software, each labware category contains specific 
predefined labware, such as BCDeep96Square, BCUpsideDownTip, BoxLid, and 
BCTuberack_10mm. 

Edit labware type properties. Use the Labware Type Editor for:

• Adding a New Labware Type (Section 7.3.2).

• Copying a Labware Type (Section 7.3.3)

• Deleting a Labware Type (Section 7.3.4)

• Renaming a Labware Type (Section 7.3.5)

• Editing Labware Type Properties (Section 7.3.6)

7.3.1 Accessing the Labware Type Editor
To access the Labware Type Editor, choose Project>Labware Type Editor. 
Labware Types appears (Figure 7-8).

Figure 7-8.  Labware Types

Note:  The labware that is displayed in the Labware Type Editor is dependent on 
the current project file.

Filter
Used to display 
specific categories 
of labware, such as 
Any (which 
displays all 
categories), 
TiterPlate, 
Reservoir, 
Tuberack, Lid, 
Reservation, or 
TipBox.
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7.3.2 Adding a New Labware Type
Add a new labware type when the desired type is not predefined in Biomek Software. 
When a new labware type is added, default properties are inserted into the appropriate 
fields. The default properties may need to be changed to meet the manufacturer’s 
specifications of the new labware type.

To add a new labware type:

1. From Labware Types, select New from the toolbar at the top. New Labware 
appears (Figure 7-9).

Figure 7-9.  New Labware

2. Choose the labware type from the pull-down list.

3. Enter a name for the labware or use the default name.

Note:  The new labware is assigned the default name of Labware plus a number 
representing the order in which the labware was created. For example, the first 
labware created is given the default name Labware1 and the second is given the 
default name Labware2.

4. Choose OK. The new labware appears graphically in Labware Types. 
(Figure 7-8).

Note:  Use Filter or scroll down Labware Types to locate the new labware type 
(Figure 7-8).
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7.3.3 Copying a Labware Type
Copying a labware type creates an exact copy of it, including current properties. The 
properties of the copied labware type can be modified to create a new labware type.

To copy a labware type:

1. From Labware Types, highlight the graphic representing the labware and select 
Copy from the toolbar at the top.

OR

Right-click the graphic for the labware type and choose Copy. Copy Labware 
Type appears (Figure 7-10).

Figure 7-10.  Copy Labware Type

2. Enter a name for the labware or use the default name.

Note:  Labware names must begin with a letter, and can contain only letters, 
numbers, and underscores (_) or an error message appears. The default name 
assigned to a labware type consists of the name of the labware type preceded by 
CopyOf_. For example, a copy of BCFlat96 is CopyOf_BCFlat96.

3. Choose OK. The copied labware appears graphically in Labware Types. 
(Figure 7-8).
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7.3.4 Deleting a Labware Type
Delete any labware type from Labware Types that is no longer used.

To delete a labware type:

1. From Labware Types, highlight the graphic representing the labware and select 
Delete from the toolbar at the top. 

OR

Right-click the graphic for the labware type and choose Delete. Information 
appears (Figure 7-11).

Figure 7-11.  Information 

2. Choose Yes to confirm the removal. The labware is deleted from Labware 
Types (Figure 7-8).
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7.3.5 Renaming a Labware Type
Renaming a labware type provides the opportunity to assign a descriptive name to a 
labware type for easy identification.

Note:  If labware types are renamed, any methods with labware under the old name 
will generate an error when the method is validated. The name must be changed to 
reflect the new name in the Instrument Setup step and any step that refers to the old 
name, such as in the Transfer step.

Note:  The labware type names appear on the Instrument Setup Configuration. 
Refer to Chapter 15.2, Instrument Setup Step, for more information about Instrument 
Setup.

To rename a labware type:

1. From Labware Types, highlight the graphic representing the labware and select 
Rename from the toolbar at the top 

OR

Right-click the graphic for the labware type and choose Rename. Rename 
Labware Type appears (Figure 7-12).

Figure 7-12.  Rename Labware Type

2. Enter a new name.

Note:  Labware type names must begin with a letter, and only letters, numbers, 
and underscores (_)can be used.

3. Choose OK to save the new labware name. The new labware name appears in 
Labware Types (Figure 7-8).
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7.3.6 Editing Labware Type Properties 
The applicable properties for a labware type are arranged in the Labware Type 
Editor according to the following categories (Table 7-2):

Table 7-2.  Labware Type Properties
Category Properties

Basic Information span, height, and description of the 
labware; bitmap graphic; and an 
option to edit the color of the labware 
(refer to Section 7.3.6.1, Changing 
Labware Colors)

Magbead allows properties to be set for labware 
used on the Magnetic Bead ALP, 
such as magnet type; height; and 
options to clamp during pipetting or 
engaging magnet, move arms to 
maximum height when clamping; and 
sense labware before pipetting or 
gripping (refer to the ALPs User’s 
Manual, Section 10.4.3, Configuring 
LabwareTypes for Use on the 
Magnetic Bead ALP).

Miscellaneous name of the default lid, sensitivity, 
and clamp force, an option to hide the 
labware so it is not visible in the 
Biomek editor, and an option to 
require piercing tips when the 
labware is accessed

NX-S8 — Septum piercing is 
available on this instrument only.

Movement Information gripper offset, gripper squeeze, 
gripper unsqueeze, speed limit, and 
an option to use the gripper sensor 
when available

Orbital Shaker allows the maximum speed to be set 
for labware used on the Orbital 
Shaker ALP (refer to the ALPs User’s 
Manual, Section 14.4.2, Configuring 
a New Labware Type for Use on the 
Orbital Shaker ALP).

Ordering Information manufacturer and part number
Sections an option to configure sections used 

in a reservoir (refer to Section 7.3.6.2, 
Configuring a Reservoir with 
Sections)
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To edit labware properties:

1. From Labware Types, highlight the graphic representing the labware and 
choose Edit from the toolbar.

OR

Right-click the graphic and choose Edit.

OR

Double-click the graphic.

2. Choose the appropriate labware category and make the desired changes to the 
labware properties that appear.

Note:  All distances are in centimeters unless otherwise specified.

3. Choose Save.

Note:  Three sections of hints are offered at the bottom of the edit option. The first 
section displays a graphic of the labware, the second section explains the selected 
field, and the third section explains any errors resulting from editing the labware 
properties. Place the cursor over the desired labware properties field and click to 
access these hints.

Stacking stack offsets and options to edit the 
stack offsets (refer to Section 7.3.6.3, 
Specifying Stackable Items) and to 
edit on which labware types or ALP 
types the labware can be securely 
stacked on top (refer to Section 
7.3.6.4, Using Secure Stacking)

Reservation Information “Caption” field that identifies the 
label that appears on the reservation 
and a “Reserve For” field that 
identifies the reason the space is 
reserved

Wells_1 well offset, count, spacing, maximum 
volume, format, column 2 offset, 
default volume, known default 
volume, and an option to configure 
well dimensions (refer to Section 
7.3.6.5, Configuring Well Properties)

Tips tip offset, count, spacing, tip load Z 
offset, tip unload Z offset, and tip 
type

Table 7-2.  Labware Type Properties
Category Properties
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7.3.6.1 Changing Labware Colors
Make labware stand out in the Instrument Setup step by changing the colors of the 
labware as desired. For example, each titerplate could be a different color. Changing 
labware colors also helps to make labware distinguishable in the Biomek main editor.

Note:  The color fuchsia (RGB 255, 0, 255) is the system transparency color and 
causes odd visual behavior.

To change labware colors:

1. From Labware Types, highlight the graphic representing the labware and 
choose Edit from the toolbar at the top. 

OR

Right-click the graphic and choose Edit.

OR

Double-click the graphic.

2. Choose Basic Information (Figure 7-13). 

Figure 7-13.  Basic Information chosen
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3. Choose Edit next to Colors. Labware Colors appears (Figure 7-14).

Figure 7-14.  Labware Colors

4. Choose Set to configure the color for the following sections of the labware:

• Wide Edge

• Narrow Edge

• Top

• Well

Color appears (Figure 7-15).

Figure 7-15.  Color
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5. Select the desired color or define a custom color for the labware section.

6. Choose OK.

Note:  Choose Cancel to cancel the color selections.

7. Repeat the process for each section of the labware, if desired.

8. Choose OK in Labware Colors when complete.

Note:  Choose Cancel to cancel the color selections.

9. Choose Save. Labware Types appears (Figure 7-8).

Note:  Choose Cancel to cancel the changes made to the labware type. A 
Warning appears to confirm the cancellation of unsaved changes to the labware 
(Figure 7-16).

Figure 7-16.  Warning to confirm cancellation of changes made

10. Choose Exit.

7.3.6.2 Configuring a Reservoir with Sections 
Some methods require the use of a reservoir with sections. Use Sections to configure 
a reservoir with sections. This allows the pod to accurately aspirate, dispense, and 
transfer liquid using a reservoir with sections.

To configure a reservoir with sections:

1. Open Labware Types (refer to Section 7.3.1, Accessing the Labware Type 
Editor).

2. Copy an existing reservoir (refer to Section 7.3.3, Copying a Labware Type) or 
create a new one (refer to Section 7.3.2, Adding a New Labware Type). The new 
labware appears in Labware Types.

3. Highlight the graphic representing the new reservoir and choose Edit at the top 
of Labware Types. 

OR

Right-click the graphic and choose Edit.

OR

Double-click the graphic.
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4. Choose Sections (Figure 7-17).

Figure 7-17.  Sections chosen

5. Click in the reservoir. A green rectangle appears.

6. Choose Delete. Error appears as a reminder that sections are deleted and new 
sections must be added (Figure 7-18).

Figure 7-18.  Error reminder that sections are deleted

7. Choose OK.

8. Drag the shape of the section(s) to the reservoir.

9. Click the area around a specific section. A green rectangle appears.

Section shapes

Drag the desired section 
shapes to this areas after 
step 6 below.
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10. Choose Edit Profile. Edit Section Profile appears (Figure 7-19).

Figure 7-19.  Edit Section Profile

11. If necessary, change the values in Height, Max Volume, and Default Volume 
according to the manufacturer’s specifications.

12. Check Bottom Section if the section includes a triangular bottom.

Note:  If Bottom Section is checked, enter the value in Bottom Section 
Height.

13. Choose OK.

14. Choose Edit Top View. Edit Section Top appears (Figure 7-20).

Figure 7-20.  Edit Section Top

15. If necessary, change the values in Left, Right, Back, Front, Max Volume, and 
Default Volume according to the manufacturer’s specifications.

16. Choose OK.
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17. Repeat steps 8 through 16 for each section in the reservoir.

18. When all sections have been configured, choose Save (Figure 7-17). A graphic 
representing the reservoir with the sections appears in Labware Types.

Note:  An Error (Figure 7-21) appears if the sections are not configured 
properly. Choose OK and reconfigure the sections.

Figure 7-21.  Error for an improperly configured reservoir

Note:  Choose Cancel to cancel the changes made to the labware type. A 
Warning appears to confirm the cancellation of unsaved changes to the labware 
(Figure 7-16).

7.3.6.3 Specifying Stackable Items
Many common microplates are stackable up to six centimeters in height; however, 
items such as reservoirs, tube racks, and tip boxes are not. 

Specifying stackable items is necessary to allow the software to effectively move 
labware stacks during liquid-handling operations. For items that are stackable, use 
Stackable Items to specify the distance from one piece of labware to the labware 
above it (stack offset). A stack offset is the distance between stacked plates, measured 
from the bottom, back-left corner on a microplate to the bottom back-left corner on 
the microplate above it. The distance is measured using X, Y, and Z coordinates.

Note:  If it is desired to place more than two pieces of labware in a stack, they must 
stack securely to each other (refer to Section 7.3.6.4, Using Secure Stacking).

Stackable Items: 

• specifies with a checkmark which labware types can be stacked on the 
labware being edited.

• may be configured to allows checkmarks to be entered when it is necessary 
to stack a specific type of labware on labware being edited for a specific 
method. 

The information entered in Stackable Items is used by the software when moving 
labware, for example, in the Move Labware step. 

To specify stacking offset: 

1. From Labware Types, highlight the graphic representing the labware and 
choose Edit from the toolbar at the top.

OR

Right-click the graphic and choose Edit.

OR

Double-click the graphic.
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2. Choose Stacking (Figure 7-22).

Figure 7-22.  Stacking chosen
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3. Choose Edit next to Stack Offsets. Stackable Items appears 
(Figure 7-23).

Figure 7-23.  Stackable Items

4. Choose the desired labware types that can be stacked on top of the labware type 
being edited.

Note:  If an item does not have a checkmark next to it, that type of labware 
cannot be stacked on the labware type being edited (selected in Labware 
Types); however, if Allow Self-stacking is checked in Stacking, it is not 
necessary to check it in Stackable Items. 

5. If applicable, type the desired value for Stack Offset X, Stack Offset Y, and 
Stack Offset Z.

Note:  While the offset values may be calculated using calipers, a more precise 
measurement should be obtained from the manufacturer’s specifications.

6. Choose OK to save the stackable items settings.

7. Choose Save. Labware Types appears.

Note:  Choose Cancel to cancel the changes made to the labware type. A 
Warning appears to confirm the cancellation of unsaved changes to the labware 
(Figure 7-16).

8. Choose Exit.
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7.3.6.4 Using Secure Stacking
Use Secure Stacking when it is necessary to securely stack more than two plates. 
The notations made in Secure Stacking are used by the software to allow the 
creation of stacks for a Solid Phase Extraction (SPE) assembly or tall stacks. It is 
necessary to use Secure Stacking with Stackable Items to ensure that specific 
labware can be stacked on top of other specific labware.

Like Stackable Items, Secure Stacking allows checkmarks to be entered when it is 
necessary to stack a specific type of labware on another specific type of labware for 
certain methods. The information entered in Secure Stacking will be used by the 
software when moving labware, for example, in the Move Labware step.

To effectively use Secure Stacking, an understanding of the Biomek stacking rules 
is necessary. The Biomek stacking rules apply to stacks on all Biomek instrument 
decks.

7.3.6.4.1 Biomek Stacking Rules
When stacking or unstacking labware, Biomek Software works from the bottom up. If 
there is a stack of four microplates on deck, the top three are moved by the gripper, 
then the top two, and finally the top piece of labware. 

The maximum height of stacks of microplates allowed on the Biomek instrument 
decks is as follows:

FX, NX-MC — 5.5 cm (2.17 in.)

3000 — 6.0 cm (2.36 in.)

NX-S8 — 6.5 cm (2.56 in.)

Note:  A stack of four standard 96-well plates is approximately 5.2 cm (2.05 in.) tall.

A plate (or stack of plates) can be removed from the source position if one of the 
following conditions is true:

• The stack at the source position has fewer than three plates.

• The entire stack is being moved. 

• The selected plate to be moved is the plate immediately above the bottom 
plate.

• All of the plates below the selected plate to be moved securely stack to each 
other.

• The selected plate to be moved securely stacks to the source position.

• The plate immediately below the selected plate to be moved securely stacks 
to the source position.

A plate (or stack of plates) can be moved to a destination position if one of the 
following conditions is true:

• The destination position has fewer than two plates (one or none).

• All of the plates that are currently stacked at the destination position securely 
stack to each other.

• The top plate of the destination stack securely stacks to the destination 
position.

• The selected plate to be moved securely stacks to the destination position.
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7.3.6.4.2 Configuring Secure Stacking
To use Secure Stacking:

1. From Labware Type Editor, highlight the graphic representing the labware and 
choose Edit.

OR

Right-click the graphic and choose Edit.

OR

Double-click on the graphic.

2. Choose Stacking (Figure 7-22).

3. Choose Edit next to Secure Stacking. Secure Stacking 
appears (Figure 7-24).

Figure 7-24.  Secure Stacking

4. Check the labware types and/or ALP types which lock securely to the labware 
type being edited.

5. Choose OK to save the settings.

6. Choose Save. Labware Types appears.

Note:  Choose Cancel to cancel the changes made to the labware type. A 
Warning appears to confirm the cancellation of unsaved changes to the labware 
(Figure 7-16).

7. Choose Exit.
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7.3.6.5 Configuring Well Properties
Well properties must be configured when new labware is added to the deck.

CAUTION: The correct well properties must be defined in Labware Types 
according to the manufacturer’s specifications. Inaccurate 
specifications may lead to inaccurate pipetting.
To configure well properties:

1. From Labware Types, highlight the graphic representing the labware and 
choose Edit.

OR

Right-click the graphic and choose Edit.

OR

Double-click the graphic.

2. Choose Wells_1 (Figure 7-25).

Figure 7-25.  Wells_1 chosen
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3. Choose Edit next to Well Configuration. Well Configuration Dialog appears 
(Figure 7-26).

Figure 7-26.  Well Configuration Dialog

4. Choose the Shape from the drop down menu.
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5. Configure the specifications according to the manufacturer’s specifications.

Note:  Placing the cursor in the specification fields identifies the measurement 
area on the graphic shape. Placing a check in the Bottom Section field identifies 
the measurement area on the graphic shape that represents the bottom section of 
the well (Figure 7-27).

Figure 7-27.  Well Configuration Dialog with Bottom Section checked

6. Choose OK in Well Configuration Dialog when complete.

7. Choose Save. Labware Types appears.

Note:  Choose Cancel to cancel the changes made to the labware type. A 
Warning appears to confirm the cancellation of unsaved changes to the labware 
(Figure 7-16).

8. Choose Exit.
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8 Understanding and Creating 
Liquid Types

8.1 Overview
The Liquid Type Editor (Figure 8-1) is used to create new liquid types or to modify 
existing liquid types for methods. Each time a new liquid type is created, it becomes 
available for all new and existing methods created in a Biomek Software project file. 
Any liquid type may be set as the default liquid type. In a method, the default liquid 
type is used when a piece of labware is not configured with a specific liquid.

Note:  When Beckman Coulter Accounts & Permissions is enabled, only users with 
Develop Projects permission may open, edit, create, and delete liquid types (refer to 
Chapter 2, Using Accounts & Permissions).

The following is configured in the Liquid Type Editor:

• Aspirate — configures the delay, speed, and trailing air gap applicable to 
the liquid. 

Note: A trailing air gap draws air into the tips after aspirate to help 
prevent drips during a method run.

• Blowout — configures the amount of air used in the blowout, and the delay 
after the air has been dispensed.

• Prewet — configures the amount of additional liquid to aspirate, and the 
amount of time to pause before dispensing.

• Wash — configures the amount of liquid used to clean a tip and the default 
number of aspirate and dispense cycles used during the wash.

3000 — Wash is not applicable for liquid types.

• Dispense — configures the delay and speed of the dispense operation 
during a method run and the cutoff velocity.

FX, NX-S8 — Cutoff velocity is applicable when the liquid is handled 
by a Span-8 Pod only.

• Tip Touch — configures the position and amount of time to pause while the 
tip is in contact with the side of the well and the speed at which the pod 
should move during the operation.
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• Liquid Level Sensing Sensitivity — configures the sensitivity of the liquid 
level sensing for the liquid type.

FX, NX-S8 — Liquid Level Sensing Sensitivity is applicable when 
the liquid is handled by a Span-8 Pod only.

• Clot Detection Sensitivity — configures the sensitivity of the clot detection 
for the liquid type.

NX-S8— Clot Detection is applicable on this instrument only.

Note:  When Override Liquid Type Settings is selected in the technique, the liquid 
type settings created in Liquid Type Editor are not used (overridden). Refer to 
Chapter 9, Understanding and Creating Techniques for more information about 
creating and editing techniques.

Liquid types, along with information about tip and labware types; well patterns; and 
pipetting templates and techniques, are stored as part of a project file. Project files 
store a history of all changes, additions, and deletions of items from the project file. 
Refer to Chapter 6, Understanding and Using Project Files, for more information on 
project files.

Figure 8-1.  Liquid Type Editor

Default Liquid Type
A checkmark appears next 
to the default liquid type.

Liquid Type View
Shows all defined 
liquid types.

Liquid Type Configuration View
Shows configuration of selected liquid 
type, and allows for modification of 
existing liquid types or the addition of 
new liquid types.

Tip Display
Graphical representation of Trailing Air Gap (at end 
of tip) and Blowout (at top of tip), if applicable. 
Colors correspond with the Tip Display in the 
Current Deck Display of the main editor. Trailing Air 
Gap is always green and Blowout is always red.
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8.1.1 Understanding Liquid Types
Liquid type information is used by techniques to help control the aspirate and 
dispense operations of a method. Due to liquid characteristics such as viscosity or 
volatility, each type of liquid may need to be pipetted in a different way. By defining 
liquid types in the Liquid Type Editor, the liquids will pipette consistently among 
methods. Liquid types containing properties such as Prewet Delay, Tip Touch, or 
Blowout Volume may be configured within the Liquid Type Editor. Any configured 
liquid type may be set as the default and used when labware is not configured for any 
particular liquid type.
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8.2 Creating New Liquid Types
New liquid types are created by setting information in the Liquid Type Editor. Liquid 
type settings are used by Biomek Software in the steps of a method to determine how 
pipetting operations occur. 

To create a new liquid type:

1. Choose Project>Liquid Type Editor. Liquid Type Editor appears 
(Figure 8-1).

2. Choose New. The new liquid type appears in the Liquid Type with the name 
“NewLiquid” (Figure 8-2).

Figure 8-2.  Liquid Type Editor with a new liquid

3. Click on NewLiquid, pause briefly, and click on NewLiquid again to select the 
liquid name as text.

4. Enter the name of the new liquid and press Enter to save it.

Note:  Liquid type names may contain only alphanumeric characters and the 
underscore (_). 

5. In Aspirate, enter the volume of the Trailing Air Gap in microliters (µL). After 
aspirating the liquid, a Trailing Air Gap is aspirated to prevent dripping.
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6. In Aspirate, enter the desired Delay in milliseconds (ms). Delay specifies the 
amount of time after an aspirate operation before continuing.

7. In Aspirate, enter the desired Speed in microliters per second (µL/s). This 
indicates the speed along the D-axis during aspirate.

8. In Blowout, enter the desired Volume of the leading air gap to blow out after 
dispensing the liquid.

9. In Blowout, enter the desired Delay in milliseconds (ms). Delay specifies the 
amount of time after a blowout before continuing.

10. In Prewet, enter the desired Overage in microliters. Overage is the amount of 
liquid to be aspirated over the amount specified in the step configuration.

11. In Prewet, enter the desired Delay in milliseconds (ms). Delay specifies the 
amount of time from when the Prewet volume is completely aspirated until it 
begins to dispense.

12. In Wash, enter the Default Cycles. Default Cycles is the number of aspirate 
and dispense cycles to use when washing.

13. In Wash, enter the Default Volume as a percentage of the maximum used 
volume followed by the percent sign (%) or as an absolute amount in microliters. 
The Default Volume is the amount of liquid to aspirate and dispense in each 
cycle.

14. In Dispense, enter the desired Delay in milliseconds (ms). Delay specifies the 
amount of time after a dispense operation before continuing.

15. In Dispense, enter the desired Speed in microliters per second (µL/s). This 
indicates the speed along the D-axis during dispense. 

16. In Dispense, enter the desired Cutoff Velocity in microliters per 
second (µL/s). 

FX, NX-S8 — Cutoff velocity is applicable when the liquid is handled 
by a Span-8 Pod only.

Note:  Cutoff Velocity is the dispense speed of the syringe before it abruptly 
stops, allowing droplets to break off from the tip of a Span-8 Pod. This is 
particularly useful for low-volume dispensing. 

Note:  The minimum and maximum cutoff velocities vary with the syringe type. 
The value entered must fall within the acceptable range for the syringe type. 
Refer to Table 8-2 for the minimum, maximum, and recommended cutoff 
velocities for each syringe type.

17. In Tip Touch, enter the desired Height. 

Note:  Height, along with from and Angle, specify where along the well the Tip 
Touch occurs.

18. In Tip Touch, select the desired from: Top, Bottom, or Liquid. This indicates 
the location the Height is measured from.

Note:  Top measures from the top of the well, Bottom from the bottom of the 
well, and Liquid from the top of the liquid. 
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19. In Tip Touch, enter the desired Angle.

OR

Select the position along the edge on the graphic by positioning the smaller circle 
at the desired location. The Angle adjusts to the current location. 

Note:  The Angle specifies the location along the well wall where the Tip Touch 
occurs at the specified Height and from location.

20. In Tip Touch, enter the desired Delay.

21. In Tip Touch, enter the desired Speed as a percentage of the total speed.

22. In Liquid Level Sensing, select the desired Sensitivity. Sensitivity is the 
magnitude of change required for LLS to detect the liquid. A larger Sensitivity 
detects smaller changes.

FX, NX-S8 — Liquid Level Sensing Sensitivity is applicable when the 
liquid is handled by a Span-8 Pod only.

Note:  The Sensitivity value is only used if the selected technique has Inherit 
From Liquid Type selected for the technique sensitivity. Refer to Section 9.4.5, 
Setting Liquid Level Sensing Values (FX, 3000, and NX-S8 only).

23. In Clot Detection, select the desired Sensitivity. Sensitivity is the magnitude 
of change required for clots to be detected during an aspiration. A larger 
Sensitivity detects smaller changes.

NX-S8 — Clot Detection is applicable on this instrument only.

Note:  The Sensitivity value is only used if the selected technique has Inherit 
From Liquid Type selected for the technique sensitivity.

24. Choose Color... to designate a new display color for the liquid, if desired.

Note:  The color affects only the display of aspirated liquid. The Trailing Air 
Gap is always green and Blowout is always red. 

25. Choose OK to enter the new liquid type and close the Liquid Type Editor.

OR

Choose Apply to save the new liquid type without closing Liquid Type Editor.

OR

Choose Cancel to close the Liquid Type Editor without saving changes.
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8.2.1 Changing the Aspirate and Dispense 
Speeds in the Liquid Type Editor

The aspirate and dispense speed is expressed in units of microliters per second. This 
represents the speed of the plunger in the D-axis on the Biomek instrument during 
pipetting operations. Each head or tool has a minimum and maximum allowable 
speed, as shown in Table 8-1.

Note:  Earlier versions in Biomek Software expressed this speed as a percentage of 
the maximum speed. 

Table 8-1.  Minimum and Maximum Pipetting Speeds in D-Axis

Pod and Head or Tool Minimum 
Speed (µL/s)

Maximum 
Speed (µL/s)

Biomek FX — Multichannel Pod AP96 96-channel pod: P20 Head 0.3715 37.15
P200 Head 1.486 148.6

AP384 384-channel pod P30 Head 0.3715 37.15
Biomek FX — Span-8 Pod 250 µL syringe 2.083 241.67

500 µL syringe 4.167 483.33
1000 µL syringe 8.333 966.67

Biomek 3000 P20 Single-Tip Pipette Tool 0.039 39.4
MP20 Multi-Tip Pipette Tool 0.039 39.4
P200 Single-Tip Pipette Tool 0.304 304
MP200 Multi-Tip Pipette Tool 0.304 304
P1000 Single-Tip Pipette Tool 1.779 1780

Biomek NX Multichannel AP96 96-channel pod: P20 Head 0.3715 37.15
P200 Head 1.486 148.6

AP384 384-channel pod P30 Head 0.3715 37.15
Biomek NX Span-8 100 µL syringe 0.833 96.667

250 µL syringe 2..083 241.667
500 µL syringe 4.167 483.33
1000 µL syringe 8.333 966.667
2.5 mL 20.833 2416.667
5 mL 41.667 4833.333
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8.2.2 Changing the Cutoff Velocity for Span-8 
Pods in Liquid Type Editor (FX, NX-S8 only)

The minimum and maximum Cutoff Velocity and the instruments on which they are 
supported are listed in Table 8-2. When changes to Cutoff Velocity are required, they 
must be made to the technique governing the pipetting operation in the Technique 
Editor, and to the parameters of the fluid used during the pipetting operation in the 
Liquid Type Editor. 

Note:  The minimum Cutoff Velocity for each syringe is established using the 
equation: 50 x <Syringe size in µL>/6000. The maximum Cutoff Velocity for each 
syringe is established using the equation: 2700 x <Syringe size in µL>/6000.

The cutoff velocity should be adjusted in all Span-8 techniques for better pipetting 
accuracy every time syringes are changed from one type to another. The Cutoff 
Velocities displayed in Table 8-2 are intended as a starting point. The values provided 
should be experimented with to determine the most accurate Cutoff Velocity for a 
specific liquid handling operation.

Table 8-2.  Span-8 Cutoff Velocities for Syringes for Span-8 Pods
Syringe 

Size
Minimum Cutoff 

Velocity
Maximum Cutoff 

Velocity Instruments
100 µL 0.833 µL/second 45.0 µL/second NX-S8
250 µL * 2.08 µL/second 112.5 µL/second FX, NX-S8
500 µL** 4.17 µL/ second 225 µL/second FX, NX-S8
1 mL *** 8.33 µL/ second 450 µL/second FX, NX-S8
2.5 mL 20.8 µL/second 1125 µL/second NX-S8
5 mL 41.7 µL/second 2250 µL/second NX-S8
 * Recommended cutoff velocity is 100 µL/second.
** Recommended cutoff velocity is 150 µL/second.
*** Recommended cutoff velocity is 150 µL/second.
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To change the parameters of a fluid to conform to the Cutoff Velocity supported by 
250 µL and 500 µL syringes:

1. With Biomek Software open, choose Project>Liquid Type Editor. The Liquid 
Type Editor appears (Figure 8-3).

Figure 8-3.  Liquid Type Editor

2. Select the liquid used during the pipetting operation.

3. In Dispense, enter the desired Cutoff Velocity, in microliters per second 
(µL/s) (refer to Table 8-2 for the correct Cutoff Velocity).

4. Choose OK to save the liquid type and exit the Liquid Type Editor. 
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8.3 Removing Liquid Types
If a liquid type is no longer needed, it can be removed from the project.

Note:  When a liquid type is removed, previous revisions of the liquid type will 
remain available for validated methods, but will not be available for future method 
editing tasks.

To remove a liquid type:

1. In the Liquid Type Editor, select the liquid type to remove.

2. Select Remove.

3. Choose OK. The liquid type is removed.

8.4 Copying and Pasting Liquid Types Within a 
Project File

To use the same liquid type with different parameters within a project, copy and paste 
the liquid type within the Liquid Type Editor.

Note:  Liquid types can be exported to and imported from other projects. Refer to 
Section 6.10, Importing and Exporting Project Files for information about importing 
and exporting liquid types.

To copy and paste liquid types:

1. In the Liquid Type Editor, select the liquid type to copy.

2. Choose Copy.

3. Choose Paste. The new liquid appears with the name “Copy_of_(Liquid 
Type)”.

4. Rename the liquid type as desired.

Note:  Liquid type names may contain only alphanumeric characters and the 
underscore (_). 

5. Make any desired changes to the liquid type (refer to Section 8.2, Creating New 
Liquid Types).

6. Choose OK.
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8.5 Specifying the Default Liquid Type
Any defined liquid type can be the default. Any labware on the deck not configured 
with a specific liquid type uses the default liquid type for pipetting operations.

To set the default liquid type:

1. In the Liquid Type Editor, select the liquid type to set as default.

2. Choose Default.

Note:  The default liquid type appears with a check mark in the Liquid Type list. 
When the default liquid type is highlighted in the Liquid Type list, the Default 
button is toggled on.
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9 Understanding and Creating 
Techniques

9.1 Overview
A technique stores a set of values and properties that instruct the Biomek instrument 
in performing pipetting operations, such as aspirate, dispense, mix, pod height, pod 
speed, and tip touch. The Biomek Software also stores a set of properties related to 
each technique, such as labware type and liquid type. Based upon these values and 
properties, the appropriate technique is selected automatically for the pipetting 
operation.

Techniques, along with information about tip and labware types; liquid types; well 
patterns; and pipetting templates, are stored as part of a project file. Project files store 
a history of all changes, additions, and deletions of items from the project file. Refer 
to Chapter 6, Understanding and Using Project Files, for more information on project 
files.

Note:  When Beckman Coulter Accounts & Permissions is enabled, only users with 
the Develop Projects permission assigned may open, edit, create, and delete 
techniques (refer to Chapter 2, Using Accounts & Permissions).

9.1.1 How Techniques Work
Biomek Software is preprogrammed with a variety of techniques. The properties 
input during method building are matched with technique properties to select the most 
appropriate technique for use in the pipetting operation. Techniques are selected 
automatically based upon the number of properties that match the method. For 
example, a technique that matches five properties in a method is selected over a 
technique with four matching properties.

In most instances, one technique will have the closest match with the properties of the 
current pipetting operation; however, if more than one technique matches the same 
number of properties, Biomek Software selects the technique with the highest rank.

Because Biomek Software selects techniques automatically, any change within a 
method may result in a new technique selection. When a single value or property is 
changed in the method, Biomek Software makes sure the technique is still the most 
appropriate technique to use. 
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9.1.2 Why Techniques are Valuable
Techniques are a flexible way to make the pipetting process easier. Techniques allow 
the pipetting settings to be saved globally and used in multiple methods. Each time a 
method is created, the technique most appropriate for the pipetting operation is 
selected with no additional configuration required. When multiple sources and liquids 
are used in a method, each pipetting operation may use a different technique. This 
allows for appropriate pipetting throughout the entire method.

Customized techniques may also be created. Once additional techniques are created, 
they appear and function like predefined techniques.
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9.2 Accessing the Technique Browser
To access the Technique Browser:

From the Project menu, choose Technique Browser. 

The Technique Browser appears (Figure 9-1). The Technique Browser contains 
two main views:

• Groups — displays all user-created groups that contain a subset of 
techniques in the project; refer to Section 9.7, Creating Technique Groups, 
for more information.

• Techniques View — lists all techniques defined in the selected group with 
their technique properties.

Figure 9-1.  Technique Browser

Groups
Selects group to display in 
Techniques View.

Techniques View
Shows defined techniques 
that match selections from 
Context Information.



9-4 Understanding and Creating Techniques

Beckman Coulter, Inc.

9.2.1 Identifying Techniques
Techniques are identified by name in the Technique Browser (Figure 9-2). The 
name of the technique is a control name (identifier) which is related to and identifies 
the values used during a method run. When a technique is selected, the name appears 
in the Technique field (Figure 9-25). 

Figure 9-2.  Technique Browser where technique parameters are displayed

Techniques View
Displays all techniques or 
techniques based upon 
selections in Context 

Groups
Filters all techniques to 
show only those 
techniques in a selected 
group.

Techniques 
Available techniques are 
selected automatically for 
different pipetting 
operations in a method.
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9.3 Creating New Techniques
The default techniques are sufficient for some pipetting operations and are meant as a 
starting point; there are instances when additional techniques may be required. For 
example, a method may call for a technique for a 384-well titerplate that transfers a 
volume between 5 µL and 10 µL of DMSO. When creating a new technique, the 
properties of the technique must be configured. For best results, all techniques should 
be evaluated and fine-tuned for the specific application through experimentation.

Techniques are automatically selected using properties. Properties identify certain 
aspects of the pipetting operation which might affect how the pipetting operation is 
performed. For a technique to be available for selection for a specific pipetting 
operation, all properties for the operation must match the properties in the technique. 

The following properties are used to determine the optimal technique to use:

• Head — identifies the tool types for which the technique is applicable; for 
example, a technique could be created which is only to be used with a 
specific tool or tools, such as single-channel tools, eight-channel tools, or 
wash tools. The technique is only used when the tool used for the pipetting 
operation matches this selection.

• Labware — identifies labware types for which the technique is applicable; 
for example, a technique could be created which is only to be used when 
pipetting from a certain type of labware, such as reservoirs, deepwell 
microplates, or test tube racks. The technique is only used when the labware 
type used in the pipetting operation matches this selection.

• Liquid type — identifies the liquid types for which the technique is 
applicable; for example, a technique could be created which is only to be 
used when pipetting a certain liquid type, such as DMSO or water. This can 
be useful to create special techniques when aspirating or dispensing viscous 
liquids. The technique is only used when the liquid type used in the pipetting 
operation matches this selection.

• Pod — identifies the pod performing the pipetting operation; for example, 
separate techniques could be created for use with each pod type. The 
technique is only used when the pod type used in the pipetting operation 
matches this selection.

• Syringe Type — identifies the syringe sizes for probes on a Span-8 Pod for 
which the technique is applicable. The technique is only used when the 
syringe type for the probes used in the pipetting operation matches this 
selection.

FX, NX-S8 — Applicable for Span-8 Pods only.

• Tips — identifies the tip types for which the technique is applicable; for 
example, a technique could be created which is only to be used with a certain 
type of tips, such as barrier tips or fixed tips. The technique is only used 
when the tip type used in the pipetting operation matches this selection.
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• Volume — identifies the volume range for which a technique is applicable; 
for example, a technique could be created that is only to be used when 
pipetting low volumes, such as 0-10 µL. The technique is only used when 
the volume entered in the step configuration falls within the specified range.

• Group — if groups have been created (refer to Section 9.7, Creating 
Technique Groups), an additional property is listed to allow the new group to 
be added to an existing group, if desired. Group is for organizing techniques 
only and is not used for selecting the technique to use.

Create additional techniques using the Technique Browser (Figure 9-1). 

Note:  Automatic selection of techniques may be turned off and new techniques 
created within a step configuration (refer to Section 9.10, Selecting and Modifying 
Techniques Manually in a Method).
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To create a new technique and set its properties:

1. From the Project menu, choose Technique Browser. Technique Browser 
appears (Figure 9-1).

2. In the Technique Browser, choose New. Technique Properties appears 
(Figure 9-3).

OR

Right-click in the Techniques View and choose New from the menu.

Figure 9-3.  Setting Technique Properties for a Biomek FX technique

3. In Technique Name, enter a name to identify the technique.
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Syringe Type, and 
Tips used for the 
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Do not Auto-
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the possible 
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checked for the 
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for selecting 
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techniques.

Graphical 
Volume Range

Handles allow 
adjustment of 
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maximum pipetting 
volumes.

Volume 
Range

Sets the 
minimum and 
maximum 
volumes that 
the technique 
can pipette.

Technique Name
Allows input of a 
unique name for 
the new technique 
or rename for an 
existing technique.
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4. In Rank, enter a value to set the relative preference of the technique to other 
techniques with similar properties.

Note:  Rank allows Biomek Software to give techniques preference over others. 
For example, if two techniques use a 384-well titerplate and P20 tips, with the 
difference between techniques being the Mix Before Aspirate values, one 
technique may have a higher priority (Rank of 1) over the other (Rank of 2) for 
automatic selection, depending upon properties input during method building.

5. In Context Information, select the desired Head, Labware, Liquid Type, 
Pod, Syringe Type, and Tips to use for the technique. 

Note:  If no selection is made for a category, the technique is applicable for all 
items within that category. For example, if no labware types are selected under 
Labware, the technique is available for use with all labware types.

Note:  To remove all current selections from the Technique Properties, right-
click in Context Information and select Clear Selections. Clear Selections 
removes all selections from all categories.

6. In Volume Range, enter the Minimum Volume and Maximum Volume for 
the technique to aspirate or dispense.

OR

Change the minimum and maximum volumes graphically using the handles on 
the graphical Volume Range (Figure 9-3). 

Note:  The left gauge is for Minimum Volume and the right gauge is for 
Maximum Volume.

7. Select Do not Auto-Select to exclude the new technique from the possible 
selected techniques for a step, such as Transfer or Combine, when the Auto-
Select has been checked for the step configuration. The technique will not be 
automatically selected by Biomek Software for any pipetting operations, but is 
still available when manually selecting a technique if the properties match (refer 
to Section 9.10, Selecting and Modifying Techniques Manually in a Method).

Note:  A technique that has Do not Auto-Select selected is displayed in the 
Technique Browser with a red x in the icon next to a technique.

8. Choose OK. The technique is created and added to the list in Technique Browser.

To access the properties of an existing technique to view or modify them:

Choose the Properties button on the Technique Browser toolbar.

OR

Right-click on the technique entry in the browser and select Properties.

Note:  Check Do not Auto-Select to exclude the existing technique from the 
possible selected techniques for a step, such as Transfer or Combine, when the 
Auto-Select has been checked for the step configuration.
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9.4 Setting Technique Values 
After creating a technique and setting the related properties, set the technique values, 
such as Tip Touch or Mix After Dispense, in Technique Editor before performing a 
method.

Note:  The Technique Browser lists all available techniques. The Technique 
Editor allows for configuration of the technique values for a specific technique.

In the Techniques Editor, a drop-down list is used to select the Pipetting Template 
(refer to Chapter 10, Using the Pipetting Template Editor). When the Pipetting 
Template is selected, the following nine tabs appear depending on instrument type 
and configuration.

The nine tabs are:

• General — Viewing Technique Description (Section 9.4.1).

• Aspirate — Setting Aspirate Values (Section 9.4.2).

• Dispense — Setting Dispense Values (Section 9.4.3).

• Mix — Setting Mix Values (Section 9.4.4).

• Calibration — Calibrating Techniques (Section 9.5).

• Liquid Level Sensing — Setting Liquid Level Sensing Values (FX, 3000, 
and NX-S8 only) (Section 9.4.5).

FX, NX-S8 — Available with a Span-8 Pod.

3000 — Available with P200L or P1000L Single-Tip Pipette Tool

• Clot Detection — Setting Clot Detection Values (NX-S8 only) (Section 
9.4.6).

NX-S8 — Available on this instrument only.

• Piercing — Setting Piercing Values (NX-S8 only) (Section 9.4.7).

NX-S8 — Available on this instrument only.

• Liquid Type — Overriding Liquid Type Values (Section 9.4.8).
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9.4.1 Viewing Technique Description
The General tab (Figure 9-4) summarizes the technique configuration on the 
Aspirate, Dispense, and Mix tabs in sentence form. The icons below each heading 
identify some of the operations the technique performs (Table 9-1).

.
Figure 9-4.  Technique Editor — General tab
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The icons are:

To view technique values in the General tab:

1. From the Project menu, choose Technique Browser. Technique Browser 
appears.

2. In Technique Browser, select the technique to modify.

3. Choose Edit. 

OR

Double-click on the technique. 

OR

Right-click in the Techniques View and choose Edit from the menu. The 
General tab is displayed by default (Figure 9-4).

Note:  Access the Technique Editor (Figure 9-4) through the step configuration 
by choosing Customize... in the step configuration. This overrides the current 
technique in the pipetting operation only.

Table 9-1.  Technique Icons
Icon Associated Operation

Tip Touch — touches the tip on the 
side of the well.

Blowout (used in Dispense 
operations only) — aspirates an air 
gap before the liquid aspirates, and 
dispenses the air gap after the liquid 
has been dispensed.
Follow Liquid — tip follows liquid 
level during pipetting operations.

Prewet (Aspirate operations only) — 
quickly aspirates and dispenses liquid 
before the main aspirate operation 
occurs.
Mix — mixes liquid in wells before 
aspirate or after dispense.

Trailing Air Gap (Aspirate 
operations only) — aspirates air after 
liquid is aspirated to help prevent 
drips.
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9.4.2 Setting Aspirate Values
Setting aspirate values allows for the technique to perform specific aspirate 
operations by changing related values, such as Aspirate Height, Pod Speed, and 
Mix Before Aspirate.

Note:  When setting aspirate values from the Customize button in a step 
configuration, the Technique Editor is specific to the operation 
(Figure 9-5).

To configure Aspirate options:

1. From the Project menu, choose Technique Browser. Technique Browser 
appears.

2. In Technique Browser, select the technique to modify.

3. Choose Edit. 

OR

Double-click on the technique. 

OR

Right-click in the Techniques View and choose Edit from the menu. The 
General tab is displayed by default (Figure 9-4).

4. In Technique Editor, select the Aspirate tab (Figure 9-5).

Figure 9-5.  Technique Editor — Aspirate tab
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5. In Move within the well at, enter the speed as a percentage of the maximum 
speed of the pod. This value must be between 0 and 100.

Note:  This controls the speed of the X-, Y-, and Z-axes. This will affect the 
speed at which the pod moves to the aspirate and dispense heights. The actual 
aspirate and dispense speeds and the speed for tip touch are controlled by settings 
in the Liquid Type Editor (refer to Section 8.2, Creating New Liquid Types).

6. In Aspirate at, enter the distance in millimeters (mm) to measure from the 
selected position for the aspirate.

7. Select from where to measure the aspirate height: Top, Bottom, or Liquid.

Note:  Top measures the aspirate height from the top of the well, Bottom from 
the bottom of the well, and Liquid from the top of the liquid. The only time a 
liquid level is required is when Aspirate is set to Liquid. It is not necessary to 
define the liquid level to use Follow Liquid. 

When a specific height is entered in Aspirate at, the aspirate operation occurs at 
that distance relative to the aspirate position.

Note:  A positive value is measured above the selected location; a negative value 
is measured below the selected location. For example, to aspirate a liquid 1.0 mm 
below the liquid level, a value of -1.0 is entered in Aspirate at and Liquid is 
chosen as the aspirate position.

8. Choose Follow liquid level when aspirating or dispensing liquid to 
allow the tip to follow the liquid level during the aspirate operation.

9. Choose Touch tips on the sides of the wells to allow tips to rest against the 
sides of the wells for a specific amount of time after aspirating (refer to Section 
8.2, Creating New Liquid Types). 

10. Choose Prewet the tips to perform an aspirate and dispense cycle before 
performing the actual aspirate operations (refer to Section 8.2, Creating New 
Liquid Types).

11. Choose Aspirate a leading air gap for blowout to dispense an air gap on the 
Dispense operation.

Note:  Blowout all leading air gaps must also be chosen on the Dispense tab 
to perform a complete blowout; just choosing Aspirate a leading air gap for 
blowout on the Aspirate tab will not perform a complete blowout.

12. Choose Mix prior to aspirating liquid to mix liquid before the aspirate 
occurs, if desired. Refer to Section 9.4.2.1, Setting Mix Before Aspirate Values, 
for instructions on configuring mix properties.

Note:  Mix aspirates and dispenses a specified number of times within a piece of 
labware.

13. Choose Aspirate a trailing air gap after leaving liquid to use the defined 
Trailing Air Gap from the Liquid Type Editor or from the Liquid Type tab 
(refer to Section 8.2, Creating New Liquid Types).
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9.4.2.1 Setting Mix Before Aspirate Values
Set the Mix prior to aspirating liquid values when a mix occurs before the liquid 
aspirates.

To set the Mix prior to aspirating liquid values:

1. In Mix, enter the amount of liquid to mix, and the number of times to mix.

2. Enter the Aspirate at height in millimeters (mm) at which to perform the 
Aspirate.

3. Choose the desired aspirate position: Top, Bottom, or Liquid.

4. Enter the speed at which to aspirate in µL/s.

5. Enter the Dispense at height in millimeters (mm) at which to perform the 
Dispense.

6. Choose the Dispense location: Top, Bottom, or Liquid.

7. Enter the speed at which to dispense in µL/s.

9.4.3 Setting Dispense Values
Setting the dispense values allows for specific dispense operations to occur by 
changing related values, such as Dispense Height, Pod Speed, and Mix After 
Dispense.

Note:  When setting dispense values from the Customize button in a step 
configuration, the Technique Editor is specific to the operation (Figure 9-6).

To set Dispense values, complete the following:

1. From the Project menu, choose Technique Browser. Technique Browser 
appears.

2. In Technique Browser, select the technique to modify.

3. Choose Edit. 

OR

Double-click on the technique. 

OR

Right-click in the Techniques View and choose Edit from the menu. The 
General tab is displayed by default (Figure 9-4).
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4. In Technique Editor, select the Dispense tab (Figure 9-6).

Figure 9-6.  Technique Editor — Dispense tab

5. In Move within the well at, enter the speed as a percentage of the maximum 
speed of the pod. This value must be between 0 and 100.

Note:  This controls the speed of the X-, Y-, and Z-axes. This will affect the 
speed at which the pod moves to the aspirate and dispense heights. The actual 
aspirate and dispense speeds and the speed for tip touch are controlled by settings 
in the Liquid Type Editor (refer to Section 8.2, Creating New Liquid Types).

6. In Dispense at, enter the distance in millimeters (mm) to measure from the 
selected position for the dispense.
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7. Select from where to measure the dispense height: Top, Bottom, or Liquid.

Note:  Top measures the dispense height from the top of the well, Bottom from 
the bottom of the well, and Liquid from the top of the liquid. The only time a 
liquid level is required is when Dispense is set to Liquid. It is not necessary to 
define the liquid level to use Follow Liquid. 

When a specific height is entered in Dispense at, the dispense operation occurs 
at that distance relative to the dispense position.

Note:  A positive value is measured above the selected location; a negative value 
is measured below the selected location. For example, to dispense liquid 1.0 mm 
below the liquid level, a value of -1.0 is entered in Dispense at and Liquid is 
chosen as the dispense position.

8. Choose Follow liquid level when aspirating or dispensing liquid to 
allow the tip to follow the liquid level during the dispense cycle.

9. Choose Touch tips on the sides of the wells to allow tips to rest against the 
sides of the wells for a specific amount of time after dispensing.

10. Choose Blowout all leading air gaps to dispense an air gap, if necessary 
(refer to Section 8.2, Creating New Liquid Types).

Note:  Aspirate a leading air gap for blowout must also be chosen on the 
Aspirate tab to perform a complete blowout; just choosing Blowout all leading 
air gaps on the Dispense tab will not perform a complete blowout.

11. Choose Mix after dispensing liquid to mix liquid after the dispense occurs. 
Refer to Section 9.4.3.1, Setting Mix After Dispense Values, for instructions on 
configuring mix properties.

9.4.3.1 Setting Mix After Dispense Values
Set the Mix after dispensing liquid values when a mix occurs after the liquid 
dispenses.

To set the Mix after dispensing liquid values:

1. In Mix, enter the amount of liquid to mix, and the number of times to mix.

2. Enter the Aspirate height in millimeters (mm) at which to perform the 
Aspirate.

3. Choose the desired aspirate position: Top, Bottom, or Liquid.

4. Enter the speed at which to aspirate liquid in µL/s.

5. Enter the Dispense height in millimeters (mm) at which to perform the 
Dispense.

6. Choose the Dispense location: Top, Bottom, or Liquid.

7. Enter the speed at which to dispense liquid in µL/s.
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9.4.4 Setting Mix Values
Set Mix values to create a custom mix. Mix step aspirates and dispenses liquid a 
specified number of times during a method.

Note:  The number of cycles is configured in the Mix step configuration.

To configure Mix:

1. From the Project menu, choose Technique Browser. Technique Browser 
appears.

2. In Technique Browser, select the technique to modify.

3. Choose Edit. 

OR

Double-click on the technique. 

OR

Right-click in the Techniques View and choose Edit from the menu. The 
General tab is displayed by default (Figure 9-4).

4. In Technique Editor, select the Mix tab (Figure 9-7).

Figure 9-7.  Technique Editor — Mix tab
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5. In Move within the well at, enter the speed as a percentage of the maximum 
speed of the pod. This value must be between 0 and 100.

Note:  This controls the speed of the X, Y, and Z axes. This will affect the speed 
at which the pod moves to the aspirate and dispense heights. The actual aspirate 
and dispense speeds and the speed for tip touch are controlled by settings in the 
Liquid Type Editor (refer to Section 8.2, Creating New Liquid Types).

6. Enter the Aspirate at height in millimeters (mm) at which to perform the 
Aspirate.

7. Choose the desired aspirate position: Top, Bottom, or Liquid.

8. Enter the speed at which to aspirate liquid in µL/s.

9. Enter the Dispense at height in millimeters (mm) at which to perform the 
Dispense.

10. Choose the Dispense location: Top, Bottom, or Liquid.

11. Enter the speed at which to dispense liquid in µL/s.

12. Choose Follow liquid level when aspirating or dispensing liquid to 
allow the tip to follow the liquid level during the aspirate and dispense cycles.

13. Choose Touch tips on the sides of the wells to allow tips to rest against the 
sides of the wells for a specific amount of time after mixing.

14. Choose Aspirate a leading air gap prior to mix and blowout after mix 
is complete to dispense an air gap, if necessary (refer to Chapter 8, 
Understanding and Creating Liquid Types).



Understanding and Creating Techniques 9-19

Biomek Software User’s Manual

9.4.5 Setting Liquid Level Sensing Values (FX, 
3000, and NX-S8 only)

FX — Available with a Span-8 Pod only.

3000 — Available on P200L or P1000L Single-Tip Pipette Tool only. Some 
options are not available with this instrument and do not appear.

Set Liquid Level Sensing values to utilize liquid level sensing to determine the 
liquid level. Liquid level detection is necessary only if the Aspirate, Dispense, or 
Mix height is measured from the liquid and the liquid level is unknown. The pod, 
head, and tips must all be compatible with liquid level sensing to detect the liquid 
level. 

The Liquid Level Sensing tab consists of four collapsible sections to configure 
various aspects of using LLS. Each section is expanded by clicking the down arrow or 
sentence summary for that section and may then be configured. Only one section may 
be expanded at a time. When collapsed, each sections displays a sentence summary 
describing the configuration for that section.

The four sections are:

• General Settings — specify the start height and sense speed.

• Repetition Settings — specify the number of times to perform LLS

FX, NX-S8 — Available on these instruments only.

• Sensitivity Settings — select to inherit sensitivity from labware type, 
liquid type, or define a custom setting

FX, NX-S8 — Available on these instruments only.

• Error Handling Settings — specify the action to take if LLS fails

To configure Liquid Level Sensing:

1. From the Project menu, choose Technique Browser. Technique Browser 
appears.

2. In Technique Browser, select the technique to modify.

3. Choose Edit. 

OR

Double-click on the technique. 

OR

Right-click in the Techniques View and choose Edit from the menu. The 
General tab is displayed by default (Figure 9-4).
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4. In Technique Editor, select the Liquid Level Sensing tab (Figure 9-8).

Figure 9-8.  Technique Editor — General Settings on Liquid Level Sensing tab

9.4.5.1 Configuring General Settings
General Settings is used to configure the starting height of the probe within the well 
and the pod speed in the Z axis during liquid level sense operations.

1. If General Settings is not displayed, click on the topmost sentence summary to 
expand the General Settings configuration (Figure 9-8).

2. Enter the height in millimeters (mm) to Move to and start sensing from.

3. Select the from the start location: Top or Bottom. The probe moves to the 
specified height measured from the top or bottom of the well before sensing.

4. Enter the Sense at speed as a percentage of the maximum speed of the pod.

Note:  The speed affects the Z-axis speed only. The default sense speed is 20 
percent.

Arrow to collapse/expand 
General Settings

General Settings
General Settings 
specify the starting 
height within the 
well and pod speed in 
the Z axis during 
liquid level sensing.
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9.4.5.2 Configuring Repetition Settings (FX, NX-S8 only)
Repetition Settings is used to configure the number of times to sense and conditions 
to accept results early or fail.

1. If Repetition Settings is not displayed, click on the sentence summary second 
from the top to expand the Repetition Settings configuration (Figure 9-9).

Figure 9-9.  Technique Editor — Repetition Settings on Liquid Level Sensing tab

2. In Sense, enter the number of times to sense. Specifying a Sense of zero (0) 
disables liquid level sensing for the technique.

Note:  Sensing multiple times helps to pop air bubbles in the wells and increases 
the accuracy in the liquid level detection.

3. Select Accept LLS result early to halt liquid level sensing if consecutive 
readings are within a specified tolerance, if desired.

4. In drops below, enter the desired tolerance for Accept LLS result early. When 
a reading falls within the entered tolerance of the previous reading, the result is 
accepted as the liquid level.

5. Select Fail if LLS result to fail liquid level sensing if consecutive readings 
never fall within a specified tolerance, if desired.

6. In never drops below, enter the desired tolerance for Fail if LLS result. If 
after completing all the desired Sense readings consecutive values never fall 
within the entered tolerance, the liquid level sensing fails and an error displays.

Repetition 
Settings

Repetition Settings 
configures options 
for multiple senses.

Arrow to collapse/expand 
Repetition Settings
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9.4.5.3 Configuring Sensitivity Settings (FX, NX-S8 only)
Liquid level is determined using specially designed liquid level sensing (LLS) tips 
that detect a shift in the capacitance of the probe. The tip moves to a specified height 
within the well and then slowly moves down into the well. When the tip contacts 
liquid, there is a large change in capacitance detected. The liquid level is sensed by 
determining the height at which this change in capacitance occurs.

Sensitivity Settings is used to configure how sensitive the probes are to changes in 
capacitance. A larger sensitivity value detects smaller capacitance changes more 
easily.

1. If Sensitivity Settings is not displayed, click on the sentence summary second 
from the bottom to expand the Sensitivity Settings configuration (Figure 9-10).

Figure 9-10.  Technique Editor — Sensitivity Settings on Liquid Level Sensing tab 

Arrow to collapse/expand 
Sensitivity Settings

Sensitivity Settings
Sensitivity Settings 
affects the required 
capacitance change to 
sense liquid.
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2. Select the Sensitivity of the liquid detection. Sensitivity is the magnitude of 
change required for LLS to detect the liquid. A larger sensitivity value detects 
smaller capacitance changes more easily. Options include:

• Inherit from Liquid Type — uses sensitivity specified for the liquid in 
Liquid Type Editor; refer to Chapter 8, Understanding and Creating 
Liquid Types.

• Inherit from Labware — uses sensitivity specified for the labware in 
Labware Type Editor; refer to Section 7.3, Defining Labware Types.

• Use this Setting — uses the setting specified in the Technique Editor; 
specify the Sensitivity by entering the value or dragging the bar to the 
desired values.

Note:  The default sensitivity setting is Inherit from Labware.

9.4.5.4 Configuring Error Handling Settings
Error Handling Settings specify the action to take if liquid level sensing fails.

1. If Error Handling Settings is not displayed, click on the last sentence summary 
to expand the Error Handling Settings configuration 
(Figure 9-11).

Figure 9-11.  Technique Editor — Error Handling Settings on Liquid Level Sensing tab

Arrow to collapse/expand 
Error Handling Settings

Error Handling Settings
Error Handling Settings specifies an action 
to perform if liquid level sensing fails.
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2. In Retry, enter the number of times to try to detect the liquid level when a 
sensing error occurs.

FX, NX-S8 — Retry only applies to these instruments.

3. In If the sensing error has not been resolved by retrying, select the action to 
perform:

• Pipette from the bottom of the well instead — measures the 
pipetting height from the bottom of the well instead of from liquid level

Note: When pipetting from the bottom of the well, the minimum 
pipetting height as defined on the Calibration tab for the technique 
(refer to Section 9.5, Calibrating Techniques) is used. 

• Pipette from the top of the well instead — measures the pipetting 
height from the top of the well instead of from liquid level

Note: When pipetting from the top of the well, the operation is 
performed at a height 1.0 millimeters (mm) above the top of the well.

• Prompt the user for further input — prompts the user for further 
instruction (Figure 9-12) and provides options to pipette from the top of 
the well (Pipette Air), pipette from the bottom of the well (Pipette 
from Bottom), retry (Seek Again), snap a continuation (Snap), or stop 
the method (Abort).

Figure 9-12.  Liquid Level Sensing Error Handling prompt for Biomek 3000
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9.4.6 Setting Clot Detection Values (NX-S8 only)
The settings for clot detection allow the technique to perform clot detection during an 
aspirate. Refer to the Biomek® NX Span-8 Laboratory Automation Workstation 
User’s Manual, Chapter 2.3.2, Clot Detection, for information on how clot detection 
works with the Biomek NX Span-8 instrument and Biomek Software.

The Clot Detection tab consists of three collapsible sections to configure various 
aspects of using clot detection. Each section is expanded by clicking the down arrow 
or sentence summary for that section and may then be configured. Only one section 
may be expanded at a time. When collapsed, each sections displays a sentence 
summary describing the configuration for that section.

The three sections are:

• General Settings — specify the detection height and speed.

• Sensitivity Settings — select to inherit sensitivity from labware type, 
liquid type, or define a custom setting

• Error Handling Settings — specify the action to take if a clot is detected.

To configure Clot Detection:

1. From the Project menu, choose Technique Browser. Technique Browser 
appears.

2. In Technique Browser, select the technique to modify.

3. Choose Edit. 

OR

Double-click on the technique. 

OR

Right-click in the Techniques View and choose Edit from the menu. The 
General tab is displayed by default (Figure 9-4).
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4. In Technique Editor, select the Clot Detection tab (Figure 9-13)

Figure 9-13.  Technique Editor — General Settings on Clot Detection tab

9.4.6.1 Configuring General Settings
General Settings is used to configure the height of the probe within the well and the 
pod speed in the Z axis during clot detection operations.

1. If General Settings is not displayed, click on the topmost sentence summary to 
expand the General Settings configuration (Figure 9-13).

2. Enter the height in millimeters (mm) to Move to and detect from.

Note:  The suggested starting height for Move to should be between 3.175 and 
4.7625 mm. The height may be adjusted, but starting with these heights is 
suggested.

3. Select the from the start location: Liquid, Top, or Bottom. The probe moves to 
the specified height measured from the liquid, top, or bottom of the well before 
detecting.

4. Enter the Sense at speed as a percentage of the maximum speed of the pod.

Note:  The speed affects the Z-axis speed only.
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9.4.6.2 Configuring Sensitivity Settings
Sensitivity Settings is used to configure how sensitive the probes are to changes in 
capacitance. A clot is detected by determining the change in capacitance as the tip 
moves up after aspiration. Clot detection is determined using conductive tips 
(identified as LLS tips in the Tip Type Editor), fixed tips, or SeptaFluted tips that 
detect a shift in the capacitance of the probe. 

The tip moves to a specified height within the well and then slowly moves down into 
the well. When the tip aspirates and rises from the liquid and if there is a large change 
in capacitance, no clot is detected. If there is no change or a small change in 
capacitance, a clot is detected. 

To configure Sensitivity Settings:

1. If Sensitivity Settings is not displayed, click on the sentence summary second 
from the bottom to expand the Sensitivity Settings configuration (Figure 9-14).

Figure 9-14.  Technique Editor - Sensitivity Settings on Clot Detection tab

2. Select the Sensitivity of the clot detection. Sensitivity is the magnitude of 
change required for the conductive tips to detect a clot. A smaller sensitivity 
value detects smaller capacitance changes more easily. Options include:

• Inherit from Liquid Type — (default sensitivity setting) uses 
sensitivity specified for the liquid in Liquid Type Editor; refer to 
Chapter 8, Understanding and Creating Liquid Types.

• Inherit from Labware — uses sensitivity specified for the labware in 
Labware Type Editor; refer to Section 7.3, Defining Labware Types.

• Use this Setting — uses the setting specified in the Technique Editor; 
specify the Sensitivity by entering the value or dragging the bar to the 
desired values.
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9.4.6.3 Error Handling Settings
Error Handling Settings specify the action to take if a clot has been detected.

1. If Error Handling Settings is not displayed, click on the last sentence summary 
to expand the Error Handling Settings configuration 
(Figure 9-11).

Figure 9-15.  Technique Editor - Error Handling Settings on Clot Detection tab

2. In Retry detection, enter the number of times to retry the detection of a clot.

3. In If the clot detection has not been resolved by retrying, select the action to 
perform:

• Dispense the sample, aspirate the same again, then retry 
detection. 

• Dispense the sample, then pipette air and continue the method.

• Prompt the user for further input. — Requests further instruction and 
provides the options Dispense, Aspirate Again, then Retry 
Detection; Ignore and Continue; Snap [a Continuation]; or Abort.

• Ignore the error and continue the method. — Ignores the error and 
continues the method.

Note: Ignoring the error and continuing the method when a clot exists 
may contaminate the deck.
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9.4.7 Setting Piercing Values (NX-S8 only)
Setting the piercing values allows the technique to pierce septum within specified 
parameters during an aspirate.

To configure Piercing:

1. From the Project menu, choose Technique Browser. Technique Browser 
appears.

2. In Technique Browser, select the technique to modify.

3. Choose Edit. 

OR

Double-click on the technique. 

OR

Right-click in the Techniques View and choose Edit from the menu. The 
General tab is displayed by default (Figure 9-4).

4. In Technique Editor, select the Piercing tab (Figure 9-13)

Figure 9-16.  Technique Editor - Piercing tab

5. In When access to a well requires a piercing move: first move to, enter the 
distance in millimeters (mm) from the top of the well to move to before piercing.

6. In then move to, enter the distance in millimeters (mm) to then move to from 
the top of the well to pierce.

7. In at, enter the speed as a percentage of the maximum speed of the pod while 
accessing the well. The value must be between 0 and 100.
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8. In Limit all Z moves inside a pierced well to, enter the speed of all Z-axis 
moves as a percentage of the maximum speed of the pod.

9. In When leaving a well that required a piercing move: move to, enter the 
distance in millimeters (mm) to move away from the top of the well that was 
pierced.

10. In at, enter the speed as a percentage of the maximum speed of the pod while 
leaving the well. The value must be between 0 and 100.

9.4.8 Overriding Liquid Type Values
The settings configured on the Liquid Type tab override values set in the Liquid 
Type Editor (refer to Section 8.2, Creating New Liquid Types). Configure the liquid 
type override values so specific pipetting characteristics will result, such as the 
amount of air to use as a blowout, or speeds for aspirate and dispense. 

Configuring the Liquid Type tab is optional. When overriding liquid type values, the 
settings entered in the Liquid Type tab are used instead of the settings from the 
particular liquid type. To use the settings from the liquid type, do not select Override 
Liquid Type Settings.

Note:  Use the Liquid Type tab only when overriding the liquid type. Create 
additional liquid types when using common liquid type settings.

To set liquid type override values for this technique:

1. From the Project menu, choose Technique Browser. Technique Browser 
appears.

2. In Technique Browser, select the technique to modify.

3. Choose Edit. 

OR

Double-click on the technique. 

OR

Right-click in the Techniques View and choose Edit from the menu. The 
General tab is displayed by default (Figure 9-4).
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4. In Technique Editor, choose the Liquid Type tab (Figure 9-17).

Figure 9-17.  Technique Editor — Liquid Type tab

5. Select Override Liquid Type Setting to activate the Liquid Type tab 
configuration. 

Note:  When overriding liquid type values, the settings entered in the Liquid 
Type tab are used instead of the settings from the particular liquid type. To use 
the settings from the liquid type, do not select Override Liquid Type Settings.

6. In Aspirate, enter the volume of the Trailing Air Gap in microliters (µL). After 
aspirating the liquid, a Trailing Air Gap is aspirated to prevent dripping.

7. In Aspirate, enter the desired Delay in milliseconds (ms). Delay specifies the 
amount of time after an aspirate operation before continuing.

8. In Aspirate, enter the desired Speed in microliters per second (µL/s). This 
indicates the speed along the D axis during aspirate.

9. In Blowout, enter the desired Volume of the leading air gap to blow out after 
dispensing the liquid.

10. In Blowout, enter the desired Delay in milliseconds (ms). Delay specifies the 
amount of time after a blowout before continuing.
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11. In Prewet, enter the desired Overage in microliters. Overage is the amount of 
liquid to be aspirated over the amount specified in the step configuration.

12. In Prewet, enter the desired Delay in milliseconds (ms). Delay specifies the 
amount of time from when the Prewet volume is completely aspirated until it 
begins to dispense.

13. In Dispense, enter the desired Delay in milliseconds (ms). Delay specifies the 
amount of time after a dispense operation before continuing.

14. In Dispense, enter the desired Speed in microliters per second (µL/s). This 
indicates the speed along the D axis during dispense.

15. In Dispense, enter the desired Cutoff Velocity, in microliters per second (µL/
s). 

FX, NX-S8 — Cutoff Velocity applies to a Span-8 Pod only. 

Note:  The minimum and maximum cutoff velocity varies with the syringe type. 
The value entered must fall within the acceptable range for the syringe type. 
Refer to Section 9.4.8.1, Syringe Cutoff Velocities (FX, NX-S8 only), for more 
information on the cutoff velocity.

16. In Tip Touch, enter the desired Height. 

Note:  Height, along with from and Angle, specify where along the well the Tip 
Touch occurs.

17. In Tip Touch, select the desired from: Top, Bottom, or Liquid. This indicates 
the location the Height is measured from.

18. In Tip Touch, enter the desired Angle

OR

Select the position along the edge on the graphic by positioning the smaller circle 
at the desired location. The Angle adjusts to the current location. 

Note:  The Angle specifies the location along the well wall where the Tip Touch 
occurs at the specified Height and from location.

19. In Tip Touch, enter the desired Delay.

20. In Tip Touch, enter the desired Speed as a percentage of the total pod speed. 
This indicates the pod speed along the X-, Y-, and Z-axes as the pod moves to the 
tip touch position.

9.4.8.1 Syringe Cutoff Velocities (FX, NX-S8 only)
The speed per second at which fluid is dispensed prior to the dispense action stopping 
abruptly is called the Cutoff Velocity. If the Cutoff Velocity in the technique or liquid 
type governing the pipetting operation is too slow, droplets can be left at the end of 
tips after a dispense pipetting operation. Accurately setting the Cutoff Velocity 
causes the liquid to be ejected at a speed sufficient to prevent droplets from forming 
on the end of a tip.

The minimum and maximum Cutoff Velocity and the instruments on which they are 
supported are listed in Table 9-2. When changes to Cutoff Velocity are required, they 
must be made to the technique governing the pipetting operation in the Technique 
Editor, and to the parameters of the fluid used during the pipetting operation in the 
Liquid Type Editor. 
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The cutoff velocity should be adjusted in all Span-8 techniques for better pipetting 
accuracy every time syringes are changed from one type to another. The Cutoff 
Velocities displayed in Table 9-2 are intended as a starting point. The values provided 
should be experimented with to determine the most accurate Cutoff Velocity for a 
specific liquid handling operation.

Note:  The minimum Cutoff Velocity for each syringe is established using the 
equation: 50 x <Syringe size in µL>/6000. The maximum Cutoff Velocity for each 
syringe is established using the equation: 2700 x <Syringe size in µL>/6000.

To change techniques to conform to the Cutoff Velocity supported by the syringe 
size:
1. From the Project menu, choose Technique Browser. Technique Browser 

appears.

2. In Technique Browser, select the technique to modify.

3. Choose Edit. 
OR

Double-click on the technique. 

OR

Right-click in the Techniques View and choose Edit from the menu. The 
General tab is displayed by default (Figure 9-4).

4. In Technique Editor, choose the Liquid Type tab (Figure 9-17).

5. In Dispense, enter the desired Cutoff Velocity, in microliters per second 
(µL/s).

6. Choose OK to save the technique and exit the Technique Editor. 

7. Choose Close to exit the Technique Browser.

Note:  If the size of syringes installed in the Biomek instrument changes 
frequently, or if two different sizes of syringes are installed at the same time, 
create a duplicate set of the Span-8 techniques for each syringe size (refer to 
Section 9.9, Modifying Saved Techniques) and edit the Cutoff Velocity on the 
Liquid Type tab to support the syringes.

Table 9-2.  Span-8 Cutoff Velocities for Syringes for Span-8 Pods
Syringe 

Size
Minimum Cutoff 

Velocity
Maximum Cutoff 

Velocity Instruments
100 µL 0.833 µL/second 45.0 µL/second NX-S8
250 µL * 2.08 µL/second 112.5 µL/second FX, NX-S8
500 µL** 4.17 µL/ second 225 µL/second FX, NX-S8
1 mL *** 8.33 µL/ second 450 µL/second FX, NX-S8
2.5 mL 20.8 µL/second 1125 µL/second NX-S8
5 mL 41.7 µL/second 2250 µL/second NX-S8
 * Recommended cutoff velocity is 100 µL/second.
** Recommended cutoff velocity is 150 µL/second.
*** Recommended cutoff velocity is 150 µL/second.
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9.5 Calibrating Techniques
Calibrating techniques improves the accuracy of pipetting operations. All method 
steps involving aspirating, dispensing, and mixing volumes of liquids use calibration 
to make sure an accurate volume is aspirated and dispensed. Calibration is also 
necessary to adjust for liquid properties, such as viscosity.

During a method run, the Biomek instrument aspirates and dispenses liquid based on 
the results of the following equation:

Displaced Volume = Desired Volume * Scaling Factor + Offset Volume 

The properties in the equation are:

• Displaced Volume — the amount physically aspirated and dispensed.

• Desired Volume — the amount that is expected to be aspirated and 
dispensed.

• Scaling Factor — the amount to multiply a given volume by to achieve the 
desired calibration.

• Offset Volume — the amount of overage by a specific amount, such as 2 µL.

The results of the equation are displayed in sentence form in the middle section of the 
Calibration tab (Figure 9-18). The displaced volume changes as adjustments are 
made to the Scaling Factor and Offset to indicate the result of the equation.

To calibrate techniques:

1. From the Project menu, choose Technique Browser. Technique Browser 
appears.

2. In Technique Browser, select the technique to modify.

3. Choose Edit. 

OR

Double-click on the technique. 

OR

Right-click in the Techniques View and choose Edit from the menu. The 
General tab is displayed by default (Figure 9-4).

4. In Technique Editor, select the Calibration tab.
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5. If the Volume Calibration configuration is not displayed, click on Volume 
Calibration to expand the Volume Calibration configuration.

Figure 9-18.  Technique Editor — Volume Calibration on Calibration Tab 

6. Enter the Scaling Factor at which to calibrate. The sentence display adjusts 
accordingly.

Note:  Scaling Factor should be greater than 0. A Scaling Factor of 1 and an 
Offset of 0 does not alter the volume manipulated during a pipetting operation.

7. Enter the desired Offset. The sentence display adjusts accordingly.

8. Verify the calibration equation by reading the sentence display. Adjust the 
Scaling Factor and Offset as necessary.

9. In Minimum pipetting height, enter the number of millimeters from the bottom 
of the labware that the tip is not allowed to go below.

10. Choose OK.

11. Choose Close to close Technique Browser.

Note:  It is recommended that techniques be tested after calibrating to verify the 
desired results are achieved.
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9.6 Conditioning Techniques for Multiple Dispense 
(FX, NX-S8 only)

Conditioning is a specified volume of liquid to dispense when performing multiple 
dispense operations from a single aspirate operation, and is used to enhance precision 
when switching from aspirate mode to dispense mode. If a multiple dispense 
technique is not properly conditioned, the first dispense may be greater than the 
volume specified in the step.

When using a technique that utilizes volume conditioning, the Biomek instrument 
aspirates and dispenses liquid according to Figure 9-19:

Note:  Volume conditioning is used by a technique only if the associated pipetting 
template is designed to use volume conditioning. Refer to Chapter 10, Using the 
Pipetting Template Editor, for more information on pipetting templates and the 
Pipetting Template Editor. The Span-8 MultiDispense pipetting template is the 
only standard template designed to use volume conditioning.

Figure 9-19.  Volume Conditioning identification

System Trailing Air Gap

Volume to 
Dispense

Leading 
Conditioning 

Excess

A specified Number of Trailing 
Volume Sections, each with a 
specified Trailing Conditioning 
Volume.
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The volumes displayed in Figure 9-19 are:

• System Trailing Air Gap — air gap between the system fluid and volume 
aspirated. The system trailing air gap is configured in Hardware Setup. 

FX — refer to the Biomek® FX Laboratory Automation Workstation 
User’s Manual, Chapter 4.4.6, Setting Span-8 Pod Properties or

NX-S8 — refer to the Biomek® NX Span-8 Laboratory Automation 
Workstation User’s Manual, Chapter 3.3.6, Setting Span-8 Pod 
Properties 

Note: The System Trailing Air Gap is initially configured by a Beckman 
Coulter Service Engineer and should not be modified without specific 
instructions from a Beckman Coulter Service Engineer or Technical Support.

• Leading Conditioning Excess — volume of source aspirated in excess of 
the sample Volume to Dispense that serves as a buffer between the system 
fluid and the liquid dispensed to protect from sample dilution. The Leading 
Conditioning Excess is purged to waste after completing all dispense 
operations.

Note: The Span-8 MultiDispense pipetting template automatically 
includes an excess of 15 percent of the volume aspirated.

• Volume to Dispense — the total volume of source aspirated for all 
dispense operations. For example, if dispensing 10 µL across 12 wells of a 
microplate, the volume aspirated is 120 µL.

• Trailing Conditioning Volume — an extra volume of source is aspirated a 
specified Number of Trailing Volume Sections times following the 
Volume Aspirated. Each trailing volume section is dispensed back into the 
source well separately prior to leaving the well to condition the dispense 
operation for more precise pipetting. For example, in Figure 9-19, each of 
the three bottom sections is dispensed back into the source well with three 
separate dispense actions.

To condition techniques:

1. From the Project menu, choose Technique Browser. Technique Browser 
appears.

2. In Technique Browser, select the technique to modify.

3. Choose Edit. 

OR

Double-click on the technique. 

OR

Right-click in the Techniques View and choose Edit from the menu. The 
General tab is displayed by default (Figure 9-4).

4. In Technique Editor, select the Calibration tab.
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5. If the Volume Conditioning configuration is not displayed, click on Volume 
Conditioning to expand the Volume Conditioning configuration (Figure 9-
18).

Figure 9-20.  Technique Editor — Volume Conditioning on Calibration Tab

6. Enter the volume of Leading Conditioning Excess to aspirate as an 
additional buffer in excess of that aspirated automatically as part of the pipetting 
template between the system fluid and the source liquid.

Note:  The Span-8 MultiDispense pipetting template automatically includes 
an excess of 15 percent of the volume aspirated. The Leading Conditioning 
Excess is the volume to aspirate in addition to the 15 percent specified in the 
pipetting template for the buffer between the system fluid and source.

7. Enter the Trailing Conditioning Volume to aspirate for each trailing volume 
section. 

8. Enter the Number of Trailing Volume Sections to aspirate.

Note:  After aspirating the volume of source to dispense, an additional volume 
of source equal to the Number of Trailing Volume Sections times the Trailing 
Conditioning Volume is aspirated. Prior to leaving the well, each trailing 
volume section of Trailing Conditioning Volume is dispensed back into the 
source well in separate dispense actions equal to the specified Number of 
Trailing Volume Sections.



Understanding and Creating Techniques 9-39

Biomek Software User’s Manual

9.7 Creating Technique Groups
A Group is a user-created subset of techniques and can be used to organize techniques 
by their properties via the Technique Editor using Groups. For examples, all 
techniques for use with a Span-8 Pod on a Biomek FX instrument could be placed in a 
group called Span-8. 

Techniques may be in more than one group, if desired. For example, another group 
could have all techniques for use with the Multichannel Pod on a Biomek FX 
instrument. Any techniques that can use both the Span-8 Pod and the Multichannel 
Pod would appear in both groups.

To create a new group:

1. From the Project menu, choose Technique Browser. Technique Browser 
appears.

2. Choose New Group.

OR

Right-click under Groups and select New Group from the menu that appears. 
A new group is added under Groups and a checkbox appears to the left of each 
technique (Figure 9-21).

Figure 9-21.  Creating a new group in the Technique Browser

3. Enter a name for the new group.

Sort techniques by properties by 
clicking on column headers.

Select techniques to include in group 
by selecting checkbox.
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4. In the list of techniques, select the checkbox to the left of each technique to 
include that technique in the new group.

Note:  Techniques can be sorted by any of the properties by clicking on the 
column headings. Selecting a heading once sorts the column in ascending order; 
clicking on the same heading a second time sorts that column in descending 
order.

5. Choose Edit to exit group editing mode. The checkboxes disappear and only the 
methods that were selected remain in the group.

Note:  The status bar in the Technique Browser displays how many techniques 
are in the selected group and how many techniques there are in the project.

Figure 9-22.  New group created in the Technique Browser

9.7.1 Renaming Groups
Groups may be renamed at any time, if desired.

To rename a group:

1. From the Project menu, choose Technique Browser. Technique Browser 
appears.

2. Choose Rename Group.

OR

Right-click under Groups and select Rename Group from the menu that 
appears.

3. Enter the desired new name for the group and press Enter. The group is 
renamed.

Status bar displays number of 
techniques in group and number 
of techniques in project.
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9.7.2 Adding and Removing Techniques from 
Groups

Techniques may be added to or removed from a group at any time using the Edit 
Group command.

Note:  Techniques may also be added to a group when they are created by selecting 
the groups to which the technique is to be added when configuring technique 
properties (refer to Section 9.3, Creating New Techniques).

To edit a group:

1. From the Project menu, choose Technique Browser. Technique Browser 
appears.

2. Choose Edit Group.

OR

Right-click under Groups and select Edit Group from the menu that appears. A 
checkbox appears to the left of each technique (Figure 9-21).

Figure 9-23.  Creating a new group in the Technique Browser

Sorts techniques by properties by 
clicking on column headers.

Select techniques to include in group 
by selecting checkbox.
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3. In the list of techniques, select the checkbox to the left of each technique to 
include in the new group, or deselect the checkbox to the left of each technique to 
remove that technique from the group.

Note:  Techniques can be sorted by any of the properties by clicking on the 
column headings. Selecting a heading once sorts the column in ascending order; 
clicking on the same heading a second time sorts that column in descending 
order.

Note:  Right-clicking on the technique in the techniques list and selecting 
Remove removes the technique from the project, not the group.

4. Choose Edit Group to exit group editing mode. The checkboxes disappear and 
only the methods that were selected remain in the group.

Note:  The status bar in the Technique Browser displays how many techniques 
are in the selected group and how many techniques there are in the project.

9.7.3 Removing Groups
When a group is no longer needed, it can be removed from the Technique Browser.

To remove a group:

1. From the Project menu, choose Technique Browser. Technique Browser 
appears.

2. Under Groups, select the desired group to remove.

3. Choose Remove Group.

OR

Right-click under Groups and select Remove Group from the menu that 
appears. The group is removed from the list under Groups.
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9.8 Removing Techniques
To prevent Biomek Software from choosing techniques during a method run that may 
have become obsolete, remove the techniques from the Technique Editor. 

When a technique is removed, it is no longer available in method building. However, 
the latest checked-in revision of the technique remains in the project file and may be 
restored at any time (refer to Section 6.8.1, Restoring Deleted Project Items).

To remove techniques:

1. In Technique Browser, select the technique.

2. Choose Remove. 

OR

Right-click and choose Remove from the menu. A Confirm prompt appears 
(Figure 9-24).

Figure 9-24.  Remove technique confirmation prompt

3. Choose Yes to remove the technique.
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9.9 Modifying Saved Techniques
When a method uses pipetting requirements that are slightly different from the 
requirements of previously created techniques, modify the technique that most closely 
resembles the new pipetting requirements by copying and pasting.

To copy and paste techniques:

1. In Technique Browser, select the technique to copy.

2. Choose Copy.

OR

Right-click and choose Copy from the menu.

3. Choose Paste. The copy appears with the name “Copy of (Technique)”.

OR

Right-click and choose Paste from the menu.

4. Select the copied technique.

5. Choose Properties.

OR

Right-click and choose Properties from the menu.

6. Enter a new name for the technique, if desired.

7. Make any changes to the technique (refer to Section 9.4, Setting Technique 
Values).

8. Choose OK.
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9.10 Selecting and Modifying Techniques Manually in 
a Method

Automatic selection of techniques is turned on by default; however, there may be 
instances when manual selection of techniques is desired. When Auto-Select is 
unchecked, manual selection of techniques is possible in the source and destination 
configuration of a pipetting step, such as Transfer or Combine. Biomek Software 
shows all techniques that match the properties of the step configuration (pod, tips, 
labware type, liquid type, volume) in a drop-down list in the Technique field (Figure 
9-25).

Figure 9-25.  Customize techniques or manually select techniques from a list in 
source or destination configurations of a pipetting step

Techniques used in methods are normally auto-selected by Biomek Software; 
however, circumstances may require modifications to techniques due to the current 
setup or liquid type. Many pipetting steps provide access to the Technique Editor 
during method development. 

Technique Selection
Techniques are selected 
automatically, selected 
manually from the drop-
down list, or customized 
using the Customize 
button.
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9.10.1 Modifying a Technique Through a Method 
Step

Custom techniques created within a method are saved within the current method only 
and are accessible only in the pipetting operation for which the technique was created. 
The technique can be saved for global use after configuration, if desired.

When modifying techniques or creating new techniques within a method, only the 
parameters for the specific operation, along with Liquid Type, Liquid Level 
Detection, and Calibration settings, may be modified.

To modify a technique within a step or method:

1. Select the desired step in the method.

2. Select the desired source or destination.

3. Choose Customize (Figure 9-26). Technique Editor - [Custom] appears 
(Figure 9-27).

Figure 9-26.  Technique selection within a method

Custom Technique
Choose Customize to 
modify the technique.
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4. Customize the technique as needed (refer to Section 9.4, Setting Technique 
Values).

Note:  Technique Properties, such as Labware Type, Liquid Type, and Tips, 
cannot be configured for the custom technique when creating the technique 
within a method. The technique uses the known properties of the specific 
operation being customized. Technique Properties are configured upon saving 
the technique for global use (refer to Section 9.10.2, Saving Custom Techniques).

5. Choose OK. [Custom] replaces the technique name.

Figure 9-27.  Dispense Tab appears when Customize is selected from destination
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9.10.2 Saving Custom Techniques
A custom technique is saved within the method in which it was created; however, any 
custom technique can be saved for global use.

To save a custom technique for global use:

1. Choose Save As in the step configuration (Figure 9-28). Technique Properties 
appears.

Figure 9-28.  Save a custom technique within a step

2. Enter the Technique Name, then select the properties desired for the technique 
(refer to Section 9.3, Creating New Techniques).

3. Choose OK. The new technique name appears in Technique.

Custom Technique
Choose Save As to 
save the technique for 
global use.
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10 Using the Pipetting Template 
Editor

10.1 Overview
Pipetting operations within steps of a method are configured using techniques. 
Techniques are associated with a pipetting template that controls how the instrument 
performs pipetting operations for aspirating, dispensing, and mixing liquids. While 
using the Pipetting Template Editor is not necessary to successfully operate the 
instrument, it does present the opportunity for finer control over pipetting operations 
in order to optimize performance for specific applications. 

A pipetting template is not used unless it is associated with a technique. Likewise, a 
technique is useless without the pipetting template that controls it. Biomek Software 
contains several default pipetting templates by which all predefined techniques are 
controlled.

Pipetting templates can be modified, or new templates created, using the Pipetting 
Template Editor. Templates are created by configuring a series of steps that dictate 
the actions the instrument makes, similar to building a method in the Main Editor. 
Template steps are configured using context variables; however, only the template 
steps that are applicable to the instrument and configuration appear. A context 
variable retrieves values from the technique or liquid type used in the pipetting 
operation. 

Pipetting templates, along with information about liquid types; labware and tip types; 
well patterns; and pipetting techniques, are stored as part of a project file. Project files 
store a history of all changes, additions, and deletions of items from the project file. 
Refer to Chapter 6, Understanding and Using Project Files, for more information on 
project files.

Note:  When Beckman Coulter Accounts & Permissions is enabled, only users with 
the Develop Projects permission assigned may open, edit, create, and delete 
pipetting templates (refer to Chapter 2, Using Accounts & Permissions).
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10.2 Creating and Modifying Pipetting Templates
Creating and modifying pipetting templates is achieved with the Pipetting Template 
Editor. 

To open the Pipetting Template Editor: 

Choose Project>Pipetting Template Editor. The Pipetting Template 
Editor appears (Figure 10-1).

FX, NX-S8 — Bulk Dispense appears only with these instruments.

NX-S8 — Clot Detection appears only with this instrument.

Pipetting templates are created in one of the following ways:

• Create a blank template and insert template steps

• Copy and paste an existing template and modify as needed 

Note:  The most expedient way to create pipetting templates is to copy and paste the 
template that resembles the desired operations most closely (refer to Section 10.2.3, 
Modifying Existing Pipetting Templates).

Figure 10-1.  Pipetting Template Editor

Pipetting Template 
Method View

Displays operations in 
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Configuration

Context variables are inserted in 
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or modifying pipetting 
templates.
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10.2.1 Viewing Existing Pipetting Templates
Several default pipetting templates are included with Biomek Software. These 
templates have specific operations which they perform, and are associated with each 
technique to control liquid-handling operations. In order to understand the operations 
the pipetting template performs, view a pipetting template.

Note:  Refer to Section 10.5, Configuring Pipetting Template Steps, for more 
information regarding each template step within the technique.

To view the pipetting template and related operations:

1. Choose Project>Pipetting Template Editor. The Pipetting Template 
Editor opens (Figure 10-1).

2. Select the desired Pipetting Template.

3. Click on the appropriate step to view the settings for the step.
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10.2.2 Creating a New Pipetting Template
New pipetting templates are created using template steps that make up a pipetting 
procedure (refer to Section 10.5, Configuring Pipetting Template Steps). The template 
steps control the order of operations in aspirate, dispense, and mix operations. 

Note:  Before creating or customizing templates, be sure to understand where each of 
the context variables finds and retrieves the values used in the configured pipetting 
operations (refer to Section 10.3, Understanding Context Variables).

To create a new pipetting template:

1. Choose Project>Pipetting Template Editor. The Pipetting Template 
Editor opens (Figure 10-1).

2. Choose New. A blank template with Aspirate, Dispense and Mix steps appears 
(Figure 10-2).

Figure 10-2.  New pipetting template

3. Insert and configure the desired template steps (refer to Section 10.5, 
Configuring Pipetting Template Steps).
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4. Choose Rename to change the template name. Rename Pipetting Template 
appears (Figure 10-3).

Figure 10-3.  Rename pipetting template

5. Enter the name of the new pipetting template and choose OK.

6. Choose OK. The template is saved and the Pipetting Template Editor closes.

OR

Choose Apply. The template is saved and the Pipetting Template Editor 
remains open.

OR

Choose Cancel. The template is not saved and the Pipetting Template Editor 
closes.

10.2.2.1 Associating a Pipetting Template with a 
Technique

A pipetting template is not used by the instrument unless it has been associated with a 
technique. Every time a pipetting operation occurs in a method that uses a technique 
with the template assigned, the operations are executed as configured in the pipetting 
template.

To associate a pipetting template with a technique:

1. Select Project>Technique Browser. The Technique Browser appears 
(Figure 10-4).

Figure 10-4.  Technique Browser
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2. Select the desired technique and choose Edit from the toolbar.

OR

Double-click the desired technique on the right side of the Technique Browser.

OR

Right-click the desired technique and select Edit from the menu. The Technique 
Editor appears (Figure 10-5).

Figure 10-5.  Technique Editor

3. Select the appropriate Pipetting Template from the list.

4. Choose OK. The changes to the technique are saved and the Technique Editor 
closes.

Pipetting Template associated with 
the technique is selected here.
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10.2.3 Modifying Existing Pipetting Templates
Copy and paste pipetting templates when making modifications to an existing 
template. Once the template is copied and pasted as a new template, any changes 
made do not affect the original.

Note:  Pipetting templates can be exported to and imported from other projects. 
Refer to Section 6.10, Importing and Exporting Project Files for information about 
importing and exporting pipetting templates.

To copy and paste a pipetting template:

1. Choose Project>Pipetting Template Editor to open the Pipetting Template 
Editor.

2. In Pipetting Template, select the template to copy.

3. Choose Copy.

4. Choose Paste to insert the copied template as a new template. The new
template appears with the name “Copy of (Original Template’s Name)”.

5. Choose Rename to change the template name. Rename Pipetting Template 
appears.

6. Enter the name of the new pipetting template and choose OK.

7. Make changes to the pipetting template by inserting and configuring steps (refer 
to Section 10.5, Configuring Pipetting Template Steps).

8. Choose OK. The template is saved and the Pipetting Template Editor
closes.

OR

Choose Apply. The template is saved and the Pipetting Template Editor 
remains open.

OR

Choose Cancel. The template is not saved and the Pipetting Template Editor 
closes.
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10.3 Understanding Context Variables
Pipetting templates make use of context variables to configure pipetting operations. 
Context variables are inserted into the template steps configuration and are used to 
retrieve values from the appropriate technique or liquid type in the Technique Editor 
or Liquid Type Editor. For example, C__DispenseDelay retrieves the value from 
Dispense Delay of the appropriate liquid type in the Liquid Type Editor.

Using context variables gives pipetting templates greater versatility, as the values for 
context variables are determined by the liquid type or technique used for the specific 
pipetting operation.

Note:  Variables configured within Start, Let, and Worklist can be placed into a 
pipetting template, but doing so may limit the usefulness of the pipetting template. 
When variables defined in Start, Let, and Worklist are used in a pipetting template, 
the template may only be used in methods with the same variable names defined. Be 
sure that these variables are defined in the method, or an error may occur during 
method execution. 

10.3.1 Inserting Variables and Expressions
Insert variables the appropriate fields of a pipetting template step, or by using the 
Variables button on the Pipetting Template Editor.

Expressions using a combination of variables, numerical constants, and mathematical 
operators, may also be entered in the fields of the appropriate template steps. For 
example, an expression could be entered for adding a volume or delay to a variable.

To insert variables in a template step:

1. Insert a template step from the Pipetting Template Step Palette into the desired 
operation: Aspirate, Dispense, or Mix.

OR

Select a template step already configured in the current template.

2. Choose the field in which to insert a variable.

3. Enter the variable name (Table 10-1).

Note:  When entering context variables into a field, always use a double-
underscore (__) between C and the variable name.

OR

Choose Variables. Preprogrammed variables arranged by groups appear.

4. Choose the desired variable group. The group variables appear.
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5. Choose the desired variable (Figure 10-6). The variables listed depend on the 
variable group selected.

Figure 10-6.  Selecting variable from selected group

6. Repeat steps 2 to 5 until the template step is configured.

Note:  Refer to Section 10.5, Configuring Pipetting Template Steps, for more 
information about inserting and configuring variables in template steps.
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10.3.2 Defining Context Variables
To retrieve values, context variables reference fields in the Technique Editor and 
Liquid Type Editor. Table 10-1 describes context variables that can be used when 
creating or modifying a pipetting template. Figure 10-7 and Figure 10-8 identify the 
fields in the Technique Editor and Liquid Type Editor from which the context 
variables defined in Table 10-1 reference and retrieve values.

Note:  Template steps default to the most appropriate variable; however, any variable 
may be used in any field.

Figure 10-7.  Identifying the location of Technique Editor context variables 

C_MixAspirateSpeed

C_TipTouch

C_MixCount

C_MixAspirateHeight

C_MixDispenseHeight

C_MixDispenseSpeed

C_Blowout

C_Mix

Technique Editor Variable Reference

C_MixDispenseHeightFrom

C_Prewet

C_MixVolume

C_TipTouch

C_Height

C_Speed

C_FollowLiquid

C_MixAspirateHeightFrom

C_HeightFrom
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Figure 10-8.  Identifying the location of Liquid Type Editor context variables

C_BlowoutVolume

Liquid Type Variable Reference

C_AspirateDelay

C_AspirateSpeed

C_PrewetDelay
C_TipTouchSpeed

C_DispenseSpeed

C_TipTouchDelay

C_DispenseDelay

C_TipTouchTheta

C_TipTouchHeight

C_PrewetOverage

C_BlowoutDelay

C_TipTouchHeightFrom

C_TrailingAirGapVolume
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Table 10-1.  Context Variables
Variable 
Group

Variable Description Associates with:

General C__Blowout Tells Biomek instrument to 
perform a blowout.

Blowout in technique

C__BlowoutDelay The delay in milliseconds after a 
blowout.

Blowout Delay in liquid 
type

C__BlowoutVolume The volume of the air gap to blow 
out.

Blowout Volume in liquid 
type or technique

C__CalibrationOffset Additional volume aspirated or 
dispensed to accurately deliver 
the desired volume.

Offset in technique 
calibration

C__CalibrationSlope Scaling factor used to accurately 
deliver the desired volume

Scaling Factor in 
technique calibration

C__ConditioningExcess Excess volume aspirated as a 
buffer between the system fluid 
and source.

Leading Conditioning 
Excess in technique 
calibration

C__ConditioningSectionCount Number of conditioning sections 
aspirated following the source.

Number of Trailing 
Volume Sections in 
technique calibration

C__ConditioningSectionVolume Volume of each conditioning 
section following the source

Trailing Conditioning 
Volume in technique 
calibration

C__Prewet Tells Biomek instrument to 
perform a prewet cycle.

Prewet in technique

C__PrewetDelay The delay in milliseconds from 
the time the Prewet volume is 
completely aspirated to the time it 
begins to dispense.

Prewet Delay in liquid 
type or technique

C__PrewetOverage The volume to add for a prewet 
cycle.

Prewet Overage in liquid 
type

C__Speed The speed of the pod movement
(X, Y, Z axes).

Pod Speed % in technique

C__TipTouch Tells Biomek instrument to 
perform a tip touch operation.

Tip Touch in technique

C__TipTouchDelay The delay in milliseconds at the 
side of wells.

Tip Touch Delay in liquid 
type or technique

C__TipTouchHeight The height of the tip touch. Tip Touch Height in liquid 
type or technique

C__TipTouchHeightFrom Level — top, bottom, or liquid — 
from which C__TipTouchHeight 
is measured.

Tip Touch Height, from in 
liquid type or technique
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General
(Continued)

C__TipTouchTheta Position along well edge tip touch 
occurs

Tip Touch Angle in liquid 
type or technique

C__TipTouchSpeed The speed of the pod movement. Tip Touch Speed in 
technique

C__Volume The volume given in the pipetting 
operation (such as Transfer or 
Combine).

Volume in step 
configuration

C__CDHeight The height of the clot detection. Clot Detection in 
technique.

C__CDHeightFrom Level—liquid, bottom, or top—
from which C__CDHeight is 
measured

Clot Detection in 
technique.

C__CDSpeed The speed of the pod movement. Clot Detection in 
technique.

Aspirate C__AspirateDelay The delay in milliseconds after an 
aspirate cycle.

Aspirate Delay in liquid 
type

C__AspirateSpeed The speed in µl/sec along the D 
axis for an aspirate cycle.

Aspirate Speed in liquid 
type

C__TrailingAirGapVolume The volume of the post-aspirate 
air gap.

Aspirate Trailing Air Gap 
in liquid type or technique

C__TrailingAirGap Tells Biomek instrument to 
aspirate a trailing air gap.

Trailing Air Gap in 
technique

Dispense C__DispenseDelay The delay in milliseconds after a 
dispense operation.

Dispense Delay in liquid 
type or technique

C__DispenseSpeed The speed in µl/sec of the D axis 
for a dispense operation.

Dispense Speed in liquid 
type or technique

Aspirate/
Dispense

C__Height The height of the aspirate or 
dispense.

Aspirate at x mm in 
technique

C__HeightFrom Level—top, bottom, or liquid—
from which C__Height is 
measured.

Aspirate x mm from (Top, 
Bottom, Liquid) in 
technique

Mix C__Mix Tells Biomek instrument to 
perform a mix operation in 
labware.

Mix Before Aspirate or 
Mix after Dispense in 
technique

C__MixAspirateHeight The height of the mix operation 
from the relative well location.

Aspirate at x mm in 
technique

C__MixAspirateFrom The location for the mix aspirate 
to occur.

In Mix Before Aspirate or 
Mix After Dispense and 
Mix, from (Top, Bottom, 
Liquid) in technique

C__MixAspirateSpeed The speed at which to aspirate for 
the mix cycle.

Aspirate...at x% in 
technique

Table 10-1.  Context Variables (Continued)
Variable 
Group

Variable Description Associates with:
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Mix
(Continued)

C__MixCount The number of cycles in a mix. Number of times to Mix 
Before Aspirate or Mix 
After Dispense in 
technique

C__MixDispenseHeight The height of the mix dispense. In Mix Before Aspirate or 
Mix After Dispense and 
Mix, from (Top, Bottom, 
Liquid) in technique

C__MixDispenseFrom The height of the mix operation 
from the relative well location.

In Mix, from (Top, Bottom, 
Liquid) in technique

C__MixDispenseSpeed The speed at which to dispense in 
a mix cycle.

Dispense...at x% in 
technique

C__MixVolume The volume of the mix. In Mix before Aspirate and 
Mix After Dispense, cycles 
to mix at specific volume in 
technique

Table 10-1.  Context Variables (Continued)
Variable 
Group

Variable Description Associates with:
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10.4 Using Volume Conditioning in Pipetting 
Templates (FX, NX-S8 only)

Some techniques, such as the Span-8 MultiDispense technique, use volume 
conditioning to achieve more precise pipetting for multiple dispenses from a single 
aspirate. To use volume conditioning, the pipetting template associated with that 
technique must be designed to use volume conditioning.

FX — Volume conditioning is available only for a Span-8 pod.

Note:  The Span-8 MultiDispense pipetting template is the only standard template 
that is designed to use volume conditioning. To associate the Span-8 MultiDispense 
pipetting template to a technique, refer to Section 10.2.2.1, Associating a Pipetting 
Template with a Technique.

There are three context variables that are important when using conditioning 
volumes:

• C__ConditioningExcess — the Leading Conditioning Excess from the 
Calibration tab of the Technique Editor

• C__ConditioningSectionVolume — the Trailing Conditioning Volume 
from the Calibration tab of the Technique Editor

• C__ConditioningSectionCount — the Number of Trailing Volume 
Sections from the Calibration tab of the Technique Editor

Note:  Refer to the Biomek Software User’s Manual, Section 9.6, Conditioning 
Techniques for Multiple Dispense (FX, NX-S8 only) for more information on 
conditioning volumes.

10.4.1 About ListMath
Since a Span-8 Pod is capable of aspirating and dispensing up to eight separate 
volumes, the pipetting template must accommodate this ability. ListMath is a special 
set of commands that can be entered in a pipetting template step configuration used to 
perform mathematical operations uniformly through a list.

ListMath takes two parameters and returns a list of values after performing the 
specified operation. A parameter may be a variable, a constant, or an array of 
constants or variables. 

In the Span-8 MultiDispense pipetting template, ListMath is used to calculate the 
volume to aspirate by adding:

• The total volume needed to perform all the desired dispense operations, as 
entered in the step configuration.

• The Leading Conditioning Excess volume, plus 15 percent of the total 
volume needed to perform all the desired dispense operations.

• The Trailing Conditioning Volume times the Number of Trailing Volume 
Sections.

The result of the above operations is a volume for each probe.
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Use ListMath like a variable when configuring a template step. Always start with an 
equal sign (=). 

• To add two parameters, enter =ListMath.Add(Parameter1, 
Parameter2). Parameter2 is added to Parameter1.

• To subtract two parameters, enter =ListMath.Sub(Parameter1, 
Parameter2). Parameter2 is subtracted from Parameter1.

• To multiply two parameters, enter =ListMath.Mult(Parameter1, 
Parameter2). Parameter1 is multiplied by Parameter2.

• To divide two parameters, enter =ListMath.Div(Parameter1, 
Parameter2). Parameter1 is divided by Parameter2.
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10.5 Configuring Pipetting Template Steps
A pipetting template contains template steps that create the pipetting procedure. Steps 
are configured using context variables (Table 10-1) that retrieve information from the 
Technique Editor or Liquid Type Editor, or variables configured in a Start, Let, or 
Worklist configuration. The following conventions apply:

• All template steps, excluding Prewet, may be placed in any part of the 
pipetting process. Prewet is applicable only to Aspirate operations and is 
limited to the Aspirate process.

• Any variable defined in the system or method, including those defined in the 
Start, Let, or Worklist configurations, may be used to configure template 
steps.

• When using variables defined in Start, Let, and Worklist in a pipetting 
template, the template is useful only to those methods with the same variable 
names defined.

• The template steps are available for use in the Pipetting Template Editor 
only. 

• When a step is inserted into the pipetting template, each field is configured 
with the most appropriate context variable by default. These default values 
may be changed to any desired value, variable, or expression.

• Hovering the mouse pointer over a template step button displays a tool tip 
with the name of the template step. Some steps also display information 
about the default configuration for that step.

10.5.1 If, Comment, and Loop
The If, Comment, and Loop steps are available for use in both methods and pipetting 
templates. When creating a pipetting template using these steps, configure the steps in 
the same manner as when configuring the step in the Method View.

Note:  For more information, refer to Section 17.7, If Step; refer to Section 15.6, 
Comment Step; and refer to Section 16.9.1, Configuring a Loop Step and Creating a 
New Variable.
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10.5.2 Clot Detection (NX-S8 only)
Clot Detection allows heights for clot detection to be configured. The template step 
sets the Move to height after aspiration; height measured from the liquid, bottom, or 
top of the well; and speed for clot detection. The heights are used to determine the 
difference in capacitance which indicates a clot exists.

Note:  Clot Detection is usually used immediately after an Aspirate steplet.

To configure Clot Detection:

1. Insert Clot Detection in the desired pipetting operation of the template.
The template step configuration appears (Figure 10-9)

Figure 10-9.  Clot Detection step configuration

2. In Move to, enter the variable or value to specify the desired height, in 
millimeters (mm), after aspiration. The default value for this field is the context 
variable C_CDHeight. (Refer to Table 10-1 for a definition of this context 
variable.)

Clot Detection
Determines if a clot 
exists through a 
difference in capacitance 
from a specific height 
after aspiration to a 
height measured in the 
well.

Clot Detection 
Configuration

Clot detection settings are 
configured here.
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3. In from, select from where to measure the height in the well: Liquid, Bottom, 
or Top. The default value for this field is the context variable 
C_CDHeightFrom. (Refer to Table 10-1 for a definition of this variable.)

Note:  Liquid measures from the top of the liquid, Bottom measures from the 
bottom of the well and Top measures from the top of the well.

Note:  If Liquid is selected in C_CDHeightFrom, the liquid level of the well 
must be known by the time clot detection is executed, either marked as known in 
Labware Properties or successfully liquid level sensed.

4. In at speed, enter the variable or value to specify the speed of the pod during 
clot detection as a percentage of the maximum speed of the pod. The default 
value for this field is the context variable C_CDSpeed. (Refer to Table 10-1 for 
a definition of this variable.)
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10.5.3 Aspirate Air Gap
Aspirate Air Gap aspirates an air gap at a specific volume and speed before liquid is 
aspirated. If a delay between the air gap aspirate and subsequent steps is desired, 
configure a delay into the template step.

Aspirate Air Gap can be used to aspirate a leading air gap before aspirating liquid, or 
a trailing air gap after aspirating liquid, depending on where it is inserted in the 
template.

To configure Aspirate Air Gap:

1. Insert Aspirate Air Gap in the desired pipetting operation of the template.
The template step configuration appears (Figure 10-10).

Figure 10-10.  Aspirate Air Gap step configuration

2. Enter the variable to configure the If condition. When the variable entered is 
True, an air gap is aspirated. The default value, =True, always aspirates an air 
gap.

3. In volume, enter the variable or value to specify the amount of air to aspirate for 
the air gap in microliters (µL). The default value is 0 µL.

Aspirate Air Gap 
Aspirates air at the 
specified volume and the 
percentage of actual 
speed of the pod. Aspirate Air Gap 

Configuration
Aspirate air gap settings 
are configured here.
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4. In speed, enter the variable or value to specify the speed of the pod in the D-axis 
in microliters per second (µl/sec) during the aspirate operation. The default value 
is the context variable C__Speed. (Refer to Table 10-1 for a definition of this 
variable.)

5. In delay, enter the variable or value to specify the length of the delay in 
milliseconds (ms) after aspirating an air gap. The pod pauses for the specified 
duration before continuing with the next operation. The default value for this 
field is the context variable C__AspirateDelay. (Refer to Table 10-1 for a 
definition of this variable.)

10.5.4 Aspirate
Aspirate aspirates a specific volume at a speed specified in microliters per second 
(µl/sec). To pause for a specific amount of time after aspirating, add a delay to the 
Aspirate template step.

To configure Aspirate:

1. Insert Aspirate at the desired position. The template step configuration appears 
(Figure 10-11).

Figure 10-11.  Aspirate step configuration

2. In volume, enter the variable or value to specify the volume of liquid to aspirate 
in microliters (µL). The default value for this field is the context variable 
C__Volume. (Refer to Table 10-1 for a definition of this variable.)

Aspirate 
Aspirates volume at a 
percentage of the 
maximum aspirate speed.

Aspirate 
Configuration

Aspirate settings are 
configured here.
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3. In speed, enter the variable or value to specify the speed of the pod in the D-axis 
in microliters per second (µl/sec) during the aspirate operation. The default value 
for this field is the context variable C__Speed. (Refer to Table 10-1 for a 
definition of this variable.)

4. In delay, enter the variable or value to specify the length of the delay in 
milliseconds (ms) after the aspirate operation. The pod pauses for the specified 
duration before continuing with the next operation. The default value for this 
field is the context variable C__AspirateDelay. (Refer to Table 10-1 for a 
definition of this variable.)

10.5.5 Moving Aspirate
Moving Aspirate aspirates while tips are moving within a well. The template step 
sets the initial position, final position, and a specific volume for the aspiration.

To configure Moving Aspirate:

1. Insert Moving Aspirate into the pipetting method. The template step 
configuration appears (Figure 10-12).

Figure 10-12.  Moving Aspirate step configuration

2. Check Set Initial Position to set the start position for aspirate, if desired. 

Note:  Set Initial Position is used if an aspirate must begin at a specific well 
location on the labware. If this is not set, the pod moves from its current location. 
Set Initial Position is not selected by default.

Moving Aspirate 
Configuration

Moving Aspirate settings are 
configured here.

Dials for adjusting the angle 
of movement from the 
center of the well. (Number 
in degrees changes 
accordingly.)

Moving Aspirate
Performs an aspirate 
operation while moving 
the tip within the well.
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If Set Initial Position is checked, complete the following steps to configure Initial 
position parameters:

1. In Move to, enter the variable or value to specify where within the well the 
aspirate operation begins, either as a percentage of the distance from the center of 
the well to the well edge or in centimeters (cm). The default for this field is 0.

2. Select the units for the variable or value entered in Move to: % (percentage) or 
cm (centimeters). The default value for this field is %.

3. In from the well center, at, enter the variable or value to specify the angle at 
which the Move to measurement is performed.

OR

In the graphic representing the well, position the dial at the desired angle at 
which the Move to measurement is performed. The value in from the well 
center, at displays the current angle, in degrees. The default value for the angle 
is 0 degrees.

4. In and, enter the variable or value to specify the height of the tip, in millimeters 
(mm). The default value for this field is the context variable C__Height. (Refer 
to Table 10-1 for a definition of this variable.)

5. In from, enter the variable or value to specify from where the height in and is 
measured. The default value for this field is the context variable 
C__HeightFrom. (Refer to Table 10-1 for a definition of this variable.)

To configure the Final position parameters:

1. In Move to, enter the variable or value to specify where within the well the 
aspirate operation moves, either as a percentage of the distance from the center of 
the well to the well edge or in centimeters (cm). The default for this field is 0.

2. Select the units for the variable or value entered in Move to: % (percentage) or 
cm (centimeters). The default value for this field is %.

3. In from the well center, at, enter the variable or value to specify the angle at 
which the Move to measurement is performed. The default value for the angle is 
0 degrees.

OR

In the graphic representing the well, position the dial at the desired angle at 
which the Move to measurement is performed. The value in from the well 
center, at displays the current angle, in degrees. 

4. In and, enter the variable or value to specify the height of the tip, in millimeters 
(mm). The default for this field is 0 mm.

5. In from, enter the variable or value to specify from where the height in and is 
measured. The default for this field is Bottom.
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To complete the Moving Aspirate configuration:

1. In Volume, enter the variable or value to specify the volume of liquid to aspirate, 
in microliters (µL). The default value for this field is the context variable 
C__Volume. (Refer to Table 10-1 for a definition of this variable.)

2. In Speed, enter the variable or value to specify the speed of the pod in the D-
axis in the D-axis in microliters per second (µl/sec) during the moving aspirate 
operation. The default value for this field is the context variable C__Speed. 
(Refer to Table 10-1 for a definition of this variable.)

3. In Post Delay, enter the variable or value to specify the length of the delay in 
milliseconds (ms) after the aspirate operation. The pod pauses for the specified 
duration before continuing with the next operation. The default value for this 
field is the context variable C__AspirateDelay. (Refer to Table 10-1 for a 
definition of this variable.)

10.5.6 Dispense Air Gap
Dispense Air Gap dispenses an air gap at a specified speed and allows a delay 
before further operations occur. Dispensing an air gap is sometimes called a blowout 
because it blows out the leading air gap.
Dispense Air Gap can be used to dispense a trailing or leading air gap, depending on 
where within the pipetting template it is inserted.
To configure Dispense Air Gap:
1. Insert Dispense Air Gap into the pipetting method. The template step 

configuration appears (Figure 10-13).

Figure 10-13.  Dispense Air Gap step configuration

Dispense Air Gap 
Configuration

Dispense Air Gap settings are 
configured here.

Dispense Air Gap 
Dispenses an air gap at 
the specified speed.
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2. In speed, enter the variable or value to specify the speed of the pod in the D-axis 
in microliters per second (µl/sec) during the blowout. The default value for this 
field is the context variable C__Speed. (Refer to Table 10-1 for a definition of 
this variable.)

3. In delay, enter the variable or value to specify the length of the delay in 
milliseconds (ms) after the blowout. The pod pauses for the specified duration 
before continuing with the next operation. The default value for this field is the 
context variable C__DispenseDelay. (Refer to Table 10-1 for a definition of 
this variable.)

10.5.7 Dispense 
Dispense dispenses a specific volume at a speed specified in microliters per second 
(µl/sec). To pause for a specific amount of time after dispensing, add a delay to the 
Dispense template step.

To configure Dispense:

1. Insert Dispense into the pipetting method. The template steps configuration 
appears (Figure 10-14).

Figure 10-14.  Dispense step configuration

2. In volume, enter the variable or value to specify the volume of liquid to 
dispense in microliters (µL). The default value for this field is the context 
variable C__Volume. (Refer to Table 10-1 for a definition of this variable.)

Dispense Configuration
Dispense volume settings are 
configured here.

Dispense 
Dispenses a specific volume 
at the designated speed.
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3. In speed, enter the variable or value to specify the speed of the pod during the 
dispense operation as a percentage of the maximum speed of the pod. The default 
value for this field is the context variable C__Speed. (Refer to Table 10-1 for a 
definition of this variable.)

4. In delay, enter the variable or value to specify the length of the delay in 
milliseconds (ms) after the dispense operation. The pod pauses for the specified 
duration before continuing. The default value for this field is the context variable 
C__DispenseDelay. (Refer to Table 10-1 for a definition of this variable.)

10.5.8 Moving Dispense
Moving Dispense dispenses a specific volume of liquid while moving between 
positions relative to the center of the well. 

To configure Moving Dispense:

1. Insert Moving Dispense into the pipetting method. The template step 
configuration appears (Figure 10-15).

Figure 10-15.  Moving Dispense step configuration

2. Check Set Initial Position to set the start position for dispense, if desired.

Note:  Set Initial Position is used if a dispense must begin at a specific well 
location on the labware. If this is not set, the pod moves from its current location. 
Set Initial Position is not selected by default.

Dials for adjusting the 
angle of movement from 
the center of the well. 
(Number in degrees 
changes accordingly.)

Moving Dispense
Dispenses a specified 
amount while moving 
the tips inside wells.

Moving Dispense 
Configuration

Configure Moving 
Dispense settings 
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If Set Initial Position is checked, complete the following steps to configure Initial 
position parameters:

1. In Move to, enter the variable or value to specify where within the well the 
dispense operation begins, either as a percentage of the distance from the center 
of the well to the well edge or in centimeters (cm). The default for this field is 0.

2. Select the units for the variable or value entered in Move to: % (percentage) or 
cm (centimeters). The default value for this field is %.

3. In from the well center, at, enter the variable or value to specify the angle at 
which the Move to measurement is performed. The default value for the angle is 
0 degrees.

OR

In the graphic representing the well, position the dial at the desired angle at 
which the Move to measurement is performed. The value in from the well 
center, at displays the current angle, in degrees. 

4. In and, enter the variable or value to specify the height of the tip, in millimeters 
(mm). The default value for this field is the context variable C__Height. (Refer 
to Table 10-1 for a definition of this variable.)

5. In from, enter the variable or value to specify from where the height in and is 
measured. The default value for this field is the context variable 
C__HeightFrom. (Refer to Table 10-1 for a definition of this variable.)

To configure the Final position parameters:

1. In Move to, enter the variable or value to specify where within the well the 
dispense operation moves, either as a percentage of the distance from the center 
of the well to the well edge or in centimeters (cm). The default for this field is 0.

2. Select the units for the variable or value entered in Move to: % (percentage) or 
cm (centimeters). The default value for this field is %.

3. In from the well center, at, enter the variable or value to specify the angle at 
which the Move to measurement is performed. The default value for the angle is 
0 degrees.

OR

In the graphic representing the well, position the dial at the desired angle at 
which the Move to measurement is performed. The value in from the well 
center, at displays the current angle, in degrees.

4. In and, enter the variable or value to specify the height of the tip, in millimeters 
(mm). The default for this field is 0 mm.

5. In from, enter the variable or value to specify from where the height in and is 
measured. The default for this field is Bottom.
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To complete the Moving Dispense configuration:

1. In Volume, enter the variable or value to specify the volume of liquid to 
dispense, in microliters (µL). The default value for this field is the context 
variable C__Volume. (Refer to Table 10-1 for a definition of this variable.)

2. In Speed, enter the variable or value to specify the speed of the pod in the D-
axis in microliters per second (µl/sec) during the moving dispense operation.The 
default value for this field is the context variable C__Speed. (Refer to Table 10-
1 for a definition of this variable.)

3. In Post Delay, enter the variable or value to specify the length of the delay in 
milliseconds (ms) after the dispense operation. The pod pauses for the specified 
duration before continuing. The default value for this field is the context variable 
C__DispenseDelay. (Refer to Table 10-1 for a definition of this variable.)

10.5.9 Mix
Mix aspirates and dispenses liquid in wells of labware as a mixing operation. 

Note:  This template step performs operations only when Mix is selected in the 
Technique Editor for the technique being used during method run. 

To configure Mix:

1. Insert Mix into the pipetting method. The template steps configuration appears 
(Figure 10-16).

Figure 10-16.  Mix step configuration

Mix Configuration
Mix settings are configured 
here.

Mix
Performs an aspirate 
and dispense to mix 
liquids.
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2. In Mix, enter the variable or value to specify the volume of liquid to mix, in 
microliters (µL). The default value for this field is the context variable 
C__MixVolume. (Refer to Table 10-1 for a definition of this variable.)

3. In times, enter the variable or value to specify the number of times to mix the 
liquid. The default value for this field is the context variable C__MixCount. 
(Refer to Table 10-1 for a definition of this variable.)

4. In Aspirate at, enter the variable or value to specify the speed of the pod in the 
D-axis in microliters per second (µl/sec) for the aspirate operation. The default 
value for this field is the context variable C__MixAspirateSpeed. (Refer to 
Table 10-1 for a definition of this variable.)

5. In then delay, enter the variable or value to specify the length of the delay in 
milliseconds (ms) after the mix operation. The pod pauses for the specified 
duration before continuing with the next operation. The default value for this 
field is 0 ms. 

6. Check Set Aspirate Height to enter the variable or expression for the height of 
the tips during aspiration.

Note:  If Set Aspirate Height is not selected, the mix operation occurs at the 
current height and the tips do not move vertically before aspirating.

7. In Go to, enter the variable or value to specify the height of the tip for the 
aspirate operations, in millimeters (mm). The default value for this field is the 
context variable C__MixAspirateHeight. (Refer to Table 10-1 for a definition 
of this variable.)

8. In from, enter the variable or value to specify from where the height in Go to is 
measured. The default value for this field is the context variable 
C__MixAspirateFrom. (Refer to Table 10-1 for a definition of this variable.)

9. In Dispense at, enter the variable or value to specify the speed of the pod in the 
D-axis in microliters per second (µl/sec) for the dispense operation. The default 
value for this field is the context variable C__MixDispenseSpeed. (Refer to 
Table 10-1 for a definition of this variable.)

10. In then delay, enter the variable or value to specify the length of the delay in 
milliseconds (ms) after the mix operation. The pod pauses for the specified 
duration before continuing with the next operation. The default value for this 
field is 0 ms. 

11. Check Set Dispense Height to enter the variable or expression for the height 
of the tips during dispense.

Note:  If Set Dispense Height is not selected, the mix operation occurs at the 
current height and the tips do not move vertically before dispensing.

12. In Go to, enter the variable or value to specify the height of the tip for the 
dispense operations, in millimeters (mm). The default value for this field is the 
context variable C__MixDispenseHeight. (Refer to Table 10-1 for a definition 
of this variable.)

13. In from, enter the variable or value to specify from where the height in Go to is 
measured. The default value for this field is the context variable 
C__MixDispenseFrom. (Refer to Table 10-1 for a definition of this variable.)
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10.5.10 Prewet
Prewet aspirates, then dispenses the liquid to prepare tips for the main aspiration. 
Prewet should only be used in the Aspirate operation of a pipetting template. The 
delay occurs between the aspirate and dispense of the Prewet.

Note:  This template step performs operations only when Prewet is selected in the 
Technique Editor for the technique being used during method run. 

To configure Prewet:

1. Insert Prewet into the pipetting method. The template steps configuration 
appears (Figure 10-17).

Figure 10-17.  Prewet step configuration

2. In volume, enter the variable or value to specify the volume of liquid used to 
prewet the tips. The default value for this field is the context variable 
C__PrewetOverage. (Refer to Table 10-1 for a definition of this variable.)

3. In speed, enter the variable or value to specify the speed of the pod in the D-axis 
in microliters per second (µl/sec) during the prewet operation. The default value 
for this field is the context variable C__Speed. (Refer to Table 10-1 for a 
definition of this variable.)

4. In pause, enter the length of time to delay between aspirating and dispensing the 
prewet liquid. The pod pauses for the specified duration after aspirating the 
prewet liquid and before dispensing the prewet liquid. The default value for this 
field is the context variable C__PrewetDelay. (Refer to Table 10-1 for a 
definition of this variable.)

Prewet Configuration
Configure Prewet settings here.

Prewet
Performs an aspirate and 
dispense cycle before 
the actual aspirate cycle 
to improve accuracy.
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10.5.11 Tip Touch
If Tip Touch is selected in the technique, the tip touches the side of the well and 
performs any specified delays. The tip then moves back to the center of the well.

Note:  This template step performs operations only when Tip Touch is selected in 
the Technique Editor for the technique being used during method run. 

To configure Tip Touch:

1. Insert Tip Touch into the pipetting method. The template step configuration 
appears (Figure 10-18).

Figure 10-18.  Tip Touch step configuration

2. In move to height, enter the variable or value to specify the desired height, in 
millimeters (mm), at which to touch the well edge. The default value for this field 
is the context variable C__TipTouchHeight. (Refer to Table 10-1 for a 
definition of this variable.)

3. In from, enter the variable or value to specify from where the move to height is 
measured for the tip touch location. The default value for this field is the context 
variable C__TipTouchHeightFrom. (Refer to Table 10-1 for a definition of 
this variable.)

TipTouch
Performs a tip touch to 
aspirate, delay, then 
dispense liquids.

Tip Touch Configuration
Tip Touch settings are 
configured here.

Dial for adjusting the angle of movement 
from the center of the well.
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4. In at, enter the desired variable or value to specify the angle along the well edge 
at which to touch. The default value for the angle is the context variable 
C__TipTouchTheta. (Refer to Table 10-1 for a definition of this variable.)

OR

In the graphic representing the well, position the dial at the desired angle at 
which the Move to measurement is performed. The value in from the well 
center, at displays the current angle, in degrees.

5. In then delay, enter the variable or value to specify the length of the delay 
before returning to the center of the well. The default value for this field is 0 
milliseconds (ms).

6. To control the tip touch speed, check Specify tip touch speed. 

Note:  If Specify tip touch speed is not selected, the tip touch operation occurs 
at the operation speed as defined in the technique.

7. In the text box below Specify tip touch speed, enter the variable or value to 
specify the speed of the pod during the tip touch operation as a percentage of the 
maximum speed of the pod. The default value for this field is the context variable 
C__TipTouchSpeed. (Refer to Table 10-1 for a definition of this variable.)

8. To add a blowout, check Blowout during tip touch.

Note:  The blowout occurs during the vertical move configured at the beginning 
of the tip touch.

9. In the text box below Blowout during tip touch, enter the variable or value to 
specify the speed of the pod during the blowout operation as a percentage of the 
maximum speed of the pod. The default value for this field is the context variable 
C__Speed. (Refer to Table 10-1 for a definition of this variable.)
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10.5.12 Axes Move
Axes Move moves the tips to a defined place within a well. For example, the 
template steps may move the tips 10% from the well center and 90 degrees around the 
edge of the well.

To configure Axes Move:

1. Insert Axes Move into the pipetting method. The template step configuration 
appears (Figure 10-19).

Figure 10-19.  Axes Move step configuration

2. In Move to, enter the variable or value to specify where within the well to move 
the tip, either as a percentage of the distance from the center of the well to the 
well edge or in centimeters (cm). The default for this field is 0.

3. Select the units for the variable or value entered in Move to: % (percentage) or 
cm (centimeters). The default value for this field is %.

4. In from the well center, at, enter the variable or value to specify the angle at 
which the Move to measurement is performed. The default value for the angle is 
0 degrees.

OR

In the graphic representing the well, position the dial at the desired angle at 
which the Move to measurement is performed. The value in from the well 
center, at displays the current angle, in degrees.

Axes Move
Moves tips within a well 
the specified distance, 
degrees, and height.

Axes Move Configuration
Axes Move settings are 
configured here.

Dials for adjusting 
the degree of 
movement from the 
center of the well.



10-34 Using the Pipetting Template Editor

Beckman Coulter, Inc.

5. In and, enter the variable or value to specify the height of the tip, in millimeters 
(mm). The default value for this field is 0 mm.

6. In from, enter the variable or value to specify from where the height in and is 
measured. The default value for this field is Bottom. 

7. In at speed, enter the variable or value to specify the speed of the pod during 
the axes move as a percentage of the maximum speed of the pod. The default 
value for this field is 0%.

10.5.13 Pause
Pause allows the template to stop operations temporarily. Pause is configured in 
milliseconds only.

To configure Pause:

1. Insert the Pause template steps into the pipetting method. The template steps 
configuration appears (Figure 10-20).

Figure 10-20.  Pause step configuration

2. In Duration, enter the variable or value for the length of the pause, in 
milliseconds (ms). The default value for this field is 0 ms.

Pause Configuration
Enter the milliseconds to 
pause operations.

Pause 
Places a pause in 
an operation.
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10.5.14 Bulk Dispense (FX and NX-S8 only)
Bulk Dispense dispenses system fluid through the system tubing using the tips and 
syringes of the Span-8 Pod.

To configure Bulk Dispense:

1. Insert Bulk Dispense into the pipetting method. The template step 
configuration appears (Figure 10-21).

Figure 10-21.  Bulk Dispense step configuration

2. In volume, enter the variable or value to specify the amount of system fluid to 
dispense, in microliters (µL). The default value for this field is the context 
variable C__Volume. (Refer to Table 10-1 for a definition of this variable.)

Bulk Dispense
Places a bulk dispense 
in an operation.

Bulk Dispense 
Configuration

Bulk Dispense settings are 
configured here.
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3. In speed, enter the variable or value to specify the speed of the pod in 
microliters per second (µl/sec) during the bulk dispense operation. The default 
value for this field is the context variable C__Speed. (Refer to Table 10-1 for a 
definition of this variable.)

4. In delay, enter the variable or value to specify the length of the delay in 
milliseconds (ms) after the bulk dispense operation. The pod pauses for the 
specified duration before continuing with the next operation. The default value 
for this field is the context variable C__DispenseDelay. (Refer to Table 10-1 
for a definition of this variable.)

5. Depending on instrument configuration, speed pump or purge pump appears.

FX — Choose speed pump to use this optional device.

NX-S8 — Choose purge pump to use it.
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11 Creating Well Patterns

11.1 Overview
FX, NX-S8 — Only the Span-8 Pod can be used to create well patterns.

3000 — Only a Single-Tip Pipette Tool can be used to create well patterns.

Creating certain methods requires the probes to access specific wells in labware. Well 
Patterns (Figure 11-1) is an editor which allows patterns for accessing specific wells 
to be created and stored. There are also well patterns already created in the editor 
which may be used, copied, or revised to create new patterns. Any well pattern stored 
in Well Patterns may be renamed or deleted.

The patterns created and stored in Well Patterns are accessible in the Transfer and 
Combine steps (refer to Section 15.3, Configuring Transfer and Combine Steps). 
Well patterns may also be created in the Transfer and Combine steps and then stored 
in Well Patterns.

Well patterns, along with information about tip and labware types; liquid types; and 
pipetting templates and techniques, are stored as part of a project file. Project files 
store a history of all changes, additions, and deletions of items from the project file. 
Refer to Chapter 6, Understanding and Using Project Files, for more information on 
project files.

Note:  When Beckman Coulter Accounts & Permissions is enabled, only users with 
the Develop Projects permission assigned may open, edit, create, and delete well 
patterns (refer to Chapter 2, Using Accounts & Permissions).
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To access the Well Pattern Editor, choose Project>Well Pattern Editor. Well 
Patterns appears (Figure 11-1).

Figure 11-1.  Well Patterns

Use the Well Pattern Editor for:

• Creating a New Well Pattern (Section 11.2)

• Copying a Well Pattern (Section 11.3)

• Deleting a Well Pattern (Section 11.4) 

• Renaming a Well Pattern (Section 11.5)

Well Pattern List
Lists the available 
patterns.

Displays the 
highlighted 
pattern from 
Well Pattern 
List.
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11.2 Creating a New Well Pattern
New well patterns are created based on the type of labware accessed by the specific 
probes.

Note:  To make sure the desired pattern is not already created, view the patterns in 
Well Patterns by highlighting the well pattern in the list displayed in Well Patterns 
(Figure 11-1).

To create a new well pattern:

1. From Well Patterns (Figure 11-1), choose New. New Pattern appears (Figure 
11-2).

Figure 11-2.  New Pattern

2. From the list of labware, choose a labware type on which to base the new pattern.

3. In Pick a name for your pattern:, rename the new pattern, if desired.

Note:  By default, the first new pattern is named after the number of wells on the 
labware type. Subsequent patterns using the same labware type are named after 
the number of wells plus a number. For example, the first new pattern created for 
a 96 well would be Pattern96, the second new pattern would be Pattern96_1, 
and the third new pattern would be Pattern96_2.

4. Choose OK. The labware grid based on the labware type appears in Well 
Patterns.

List of labware on which to 
base a new pattern.
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5. Create the new pattern from the labware grid by dragging the mouse and using 
Ctrl and Shift on the keyboard.

Note:  To create a new pattern, select wells while holding down the Shift key. To 
deselect wells, use the Ctrl key to toggle the wells from select to deselect. To 
invert the well selection, drag the mouse across the pattern while holding down 
the Ctrl key.

Note:  If Shift is not held down when dragging and selecting, the previous 
selection will be deleted when subsequent selections are made.

6. Choose Save to save the changes. Well Patterns closes and all the changes 
made in the dialog are saved.

OR

Choose Cancel to cancel the changes. A Warning (Figure 11-3) appears. 
Choose Yes. Well Patterns closes and all the changes made in the dialog are 
cancelled.

Figure 11-3.  Warning when Cancel is chosen
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11.3 Copying a Well Pattern
Copying a well pattern creates an exact copy of it. The copied well pattern can be 
modified to create a new well pattern.

To copy a well pattern:

1. From Well Patterns (Figure 11-1), highlight the desired pattern from the Well 
Pattern List.

2. Choose Copy. Copy Pattern (Figure 11-4) appears.

Figure 11-4.  Copy Pattern

3. Rename the pattern, if desired.

Note:  By default, the first new pattern is named after the number of wells on the 
labware type. Subsequent patterns using the same labware type are named after 
the number of wells plus a number. For example, the first new pattern created for 
a 96 well would be Pattern96, the second new pattern would be Pattern96_1, 
and the third new pattern would be Pattern96_2.

4. Choose OK. The copied pattern appears in Well Patterns.

Note:  If desired, modify the well pattern.

5. Choose Save to save the changes. Well Patterns closes and all the changes 
made in the dialog are saved.

OR

Choose Cancel to cancel the changes. A Warning (Figure 11-3) appears. 
Choose Yes. Well Patterns closes and all the changes made in the dialog are 
cancelled.
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11.4 Deleting a Well Pattern
To delete a well pattern stored in Well Patterns:

1. From Well Patterns (Figure 11-1), highlight the desired pattern from the Well 
Pattern List.

2. Choose Delete. A Warning (Figure 11-5) appears, confirming the deletion.

Figure 11-5.  Warning confirming deletion of a pattern

3. Choose OK. The pattern is deleted from the list of patterns in Well Patterns.

4. Choose Save to save the changes. Well Patterns closes and all the changes 
made in the dialog are saved.

OR

Choose Cancel to cancel the changes. A Warning (Figure 11-3) appears. 
Choose Yes. Well Patterns closes and all the changes made in the dialog are 
cancelled.
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11.5 Renaming a Well Pattern
Renaming a labware type provides the opportunity to assign a descriptive name to a 
well pattern for easy identification.

To rename a well pattern in Well Patterns:

1. From Well Patterns (Figure 11-1), highlight the desired pattern from the Well 
Pattern List.

2. Choose Rename. Rename Pattern (Figure 11-6) appears.

Figure 11-6.  Rename Pattern

3. Rename the pattern.

4. Choose OK. The pattern is renamed in the list of patterns in Well Patterns.

5. Choose Save to save the changes. Well Patterns closes and all the changes 
made in the dialog are saved.

OR

Choose Cancel to cancel the changes. A Warning (Figure 11-3) appears. 
Choose Yes. Well Patterns closes and all the changes made in the dialog are 
cancelled.
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12 Creating and Using Methods

12.1 Overview
A method is a series of steps controlling the operations of the Biomek instrument. 
When steps are inserted into a method, they represent operations performed during 
the method run. The steps available for insertion into a method are located on the left 
of the Biomek main editor in the Step Palettes (Figure 12-1). 

Note:  When Beckman Coulter Accounts & Permissions is enabled, only users with 
Develop Methods permission may develop, open, and edit methods (refer to 
Chapter 2, Using Accounts & Permissions).

Biomek Software does a substantial amount of the method-building work while at the 
same time allowing direct and precise control over the building of methods.

Methods are saved as part of a project file, and may also have revisions created by 
checking in the method. A revision of a method is connected to the current revision 
for all project items. When a specific revision of a method is opened, it uses the 
revision of all project items that was current at the time the method was checked in.

Note:  The appearance of the main editor (Figure 12-1), such as the Current Deck 
Display and step palettes, varies based on the current instrument file and project file. 
The current instrument and project file names are displayed in the status bar of the 
main editor. 
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Figure 12-1.  Biomek Software main editor for method creation

Using methods to control the operations of the Biomek instrument includes:

• Creating a New Method (Section 12.2).

• Inserting Steps in a Method (Section 12.3).

• Using Additional Step Palettes (Section 12.4).

• Copying, Cutting, and Pasting Steps in a Method (Section 12.5).

• Deleting Steps in a Method (Section 12.6).

• Using Undo and Redo in Method Building (Section 12.7).

• Entering and Viewing Method Properties (Section 12.8).

• Saving a Method (Section 12.9)

• Checking In a Method (Section 12.10).

• Validating a Method (Section 12.11)

• Signing a Method (Section 12.12).

• Viewing Method History (Section 12.13).

• Opening a Saved Method (Section 12.14).

• Checking Out a Method (Section 12.15).

• Importing and Exporting Methods (Section 12.16).

• Running, Pausing, and Stopping a Method (Section 12.18).

• Printing a Method (Section 12.19).

• Improving a Method (Section 12.20).

Step palettes

Current 
project

Current instrument

Current Deck Display
Displays the status of the 
deck upon completion of the 
previous step.
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12.2 Creating a New Method
The main editor (Figure 12-1) is the starting point for creating a liquid-handling 
method using the Biomek instrument. Method steps from the step palette are inserted 
into the Method View in a linear fashion. 

When steps are inserted into a method, the configuration associated with that step 
appears on the right side of the Biomek main editor (Figure 12-2).

Note:  Steps not configured appropriately generate errors when the method is 
validated or run.

To create a new method:

1. Launch Biomek Software. The main editor appears (Figure 12-1).

2. From the toolbar, select the New Method icon.

OR

From the File menu, choose New.

OR

Drag and drop a step, such as Instrument Setup, into the Method View. A new 
method is created and assigned the default name Method# [New] (Figure 12-2).

Note:  The Start and Finish steps appear automatically in a new method.

Figure 12-2.  Biomek Software main editor for dual-pod Biomek FX instrument

Method View
The method is built 
step by step in this 
area. 

Step configuration area
When a step is highlighted in the Method View, 
the corresponding configuration appears in this 
area.

Current Deck Display
Displays the status of the deck upon 
completion of the previous step.

Basic Step Palette
Displays the steps available 
for insertion into a method. 
Additional steps are 
available through other step 
palettes or the Step Palette 
Builder (refer to Section 
29.5, Using the Step Palette 
Builder).
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There are two steps automatically present in every method created and executed by 
Biomek Software:

• Start — the first step in a method; allows creation of global variables that 
are applicable to the entire method, as opposed to a variable applicable only 
to one step within the method.

• Finish — the final step in a method; provides options to clear the Biomek 
instrument deck, clear the devices on the deck, unload tips from the pod, 
clear all global variables, and generate a report on data sets.

12.2.1 Configuring the Start Step
Use the Start step to define variables used throughout the entire method, as opposed 
to variables defined within individual steps. A variable is a value that has been 
assigned a name (Figure 12-3).

Note:  Variables defined in individual steps, such as the Let step, are applicable only 
to that step and any nested substeps. Refer to Section 17.6, Let Step, for more 
information about the Let step.

To use a variable created in the Start step, that variable name is entered into the 
configuration of the step using the variable. In the example, the variable AspValue, 
created in the Start configuration (Figure 12-4), is entered in the µL (volume) field of 
the Transfer step.

The Biomek Software internally substitutes the name with its value, but the name 
remains in the field. In the example (Figure 12-4), AspValue is substituted internally 
by the value ‘10’. The value of ‘10’ is never displayed, only the variable name 
AspValue. The method can be run subsequently with a different value for AspValue, 
and the software automatically replaces AspValue with the new value.

Variables created in the Start step can also give a prompt at the start of a method run 
allowing new values to be entered for each variable at runtime.

Note:  Refer to Chapter 13, Using Variables and Expressions in a Method, for more 
information on using variables in a method.
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To configure a variable in the Start step:

1. Select Start in the Method View. The Start step configuration appears (Figure 
12-3).

Figure 12-3.  Start step and configuration

Start step configuration
Variables defined in the Start step configuration 
can be used throughout the method.

Method View
Every method 
contains the Start 
and Finish steps, 
which appear 
automatically when 
a new method is 
created.
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2. Click under Variable Name (Figure 12-4) to position the cursor in the Variable 
Name field.

Figure 12-4.  Start step with variables configured

3. Enter a Variable Name. 

Note:  Variable names must begin with a letter, may only use alphanumeric 
characters (0-9, A-Z) and the underscore (_), and may not exceed 255 characters. 
Variable names are not case sensitive.

4. Enter the desired default Value for the variable.

5. Check the box under Overridable (Figure 12-4) if the variable can be 
overridden by a previously defined value. For example, a variable Test is created 
in the Start step with a value of 10. A Let step later in the method assigns a value 
of 15 to the Test variable. If Overridable is selected in the Let step, the 
previously existing value from the Start step of 10 overrides the value in the Let 
step. If Overridable is not selected, however, the variable is assigned the value 
of 15 defined in the Let step.

Examples of variables defined in the 
Start step configuration.

Select this checkbox to be prompted at 
runtime to enter a value for the variable.

Select this checkbox to allow 
the variable to be overwritten 
by a previously defined value.
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6. Check the box under Prompt (Figure 12-4) to activate a prompt for the variable 
at run time. Each time the method is run, a prompt similar to the one shown in 
Figure 12-5 asks for verification of the variables and their values. Verification of 
the variables provides an opportunity to change the default values associated with 
the variables each time the method is run, if desired.

Note:  A separate prompt appears for each variable that has Prompt selected.

Figure 12-5.  Prompt to enter value for variable at runtime

7. Repeat steps 2-6 for each variable.

Note:  To get a new line for another variable, press Enter with the cursor in the 
Value field of the last defined variable.

12.2.2 Configuring the Finish Step
The Finish step is the last step in every Biomek method. The Finish step indicates the 
end of a method and provides opportunities to control pod, deck, and device status 
upon completion of a method. 

When highlighted in the Method View: 

• The Finish step configuration is displayed on the right side of the Biomek 
main editor.

• The software runs an internal validation to check for errors in the method.

• An Estimated Time to Completion (ETC) of the method is displayed in 
the status bar at the bottom of the Biomek main editor.

Note: When the Finish step is highlighted in the Method View, the 
software estimates the real time required to complete the entire method. 
When any other step is highlighted in the Method View, the length of time 
displayed in the ETC field represents the time required to complete the 
method up to the selected step. If an error is found in validation, ETC is 
displayed as Failed.

Use the Finish step to re-initialize the software state of the deck and external 
hardware devices, and to physically remove tips from the pod when a method is 
completed. 
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The default configuration for the Finish step is all options selected (Figure 12-6). If 
the options are not selected, errors may occur due to conflicts between the labware in 
a new method and the labware from the previous method. The error occurs because 
software and hardware remain in their final state after a method is run, unless told 
otherwise.

Note:  Each of the Finish step options is independent of the others, so any 
combination of the options may be selected.

Note:  If the Finish step configuration options are not used, steps must be added to 
the new method to reset the software and hardware.

The options of the Finish step reset the hardware and software so a new method can 
populate the deck as required, without encountering labware errors. The Finish step 
also allows for reports to be generated on labware data from data sets (refer to 
Chapter 14, Using Sample Tracking and Data Sets in a Method).

Figure 12-6.  The Finish step configuration for a Biomek FX instrument

Estimated Time to 
Completion appears 
only when a step is 
highlighted in the 
Method View.

Finish step 
configuration

The Finish step 
configuration informs the 
software that the 
Instrument Setup and any 
external hardware devices 
are clear of labware and 
physically removes any 
tips loaded on the pod.
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12.2.2.1 Clear Current Instrument Setup of All Labware 
After the Method Completes

The Current Deck Display represents the status of the labware on the deck upon 
completion of a method run (Figure 12-6). Typically, a clear deck is needed at the 
start of a method. 

To clear the deck in the software after a method, select Clear current instrument 
setup of all labware after method completes in the Finish step configuration. 
This ensures a clear deck for the next method.

Note:  To use the same deck setup for a subsequent method, do not select Clear 
current instrument setup of all labware after method completes in the 
Finish step configuration. The labware positions, volumes, and marks carry over to 
the next method. Use the As Is option in the Instrument Setup step in the 
subsequent method to leave those positions in their current state.

12.2.2.2 Clear Current Device Setup of All Labware After 
the Method Completes

The Device Setup remembers the contents of the devices on the deck at completion 
of a method run (Figure 12-6). Typically, devices are clear of labware at the start of a 
method. 

To clear all devices of labware, select Clear current device setup of all labware 
after method completes in the Finish step configuration. This ensures clear 
devices for the next method.

Note:  Insert an Instrument Setup step at the beginning of the next method to 
specify where labware is located on the deck (refer to Section 15.2, Instrument Setup 
Step). Use the Deck Editor to specify the location of devices on the deck (refer to 
Chapter 5, Preparing and Managing the Deck), and use the Device Setup step to 
configure the contents of the external devices. Refer to Section 22.4, Using External 
Devices with Biomek Laboratory Automation Workstations, and Section 22.5, Device 
Setup Step, for more information about configuring external devices.

12.2.2.3 Unload Disposable Tips from All Pods and Wash 
Any Fixed Tips After the Method Completes

Tips remain on the pod(s) or tools unless they are removed during a step or in the 
Finish step (Figure 12-6). Typically, the pod or tool needs to be clear of tips at the 
start of a method. 

FX, NX-MC, NX-S8 — Disposable tips can be removed from any 
Multichannel Pod and any probes on a Span-8 Pod. If any probes on a Span-
8 Pod are equipped with fixed tips, they can be washed at the conclusion of 
the method.

Note: To wash any fixed tips on a Span-8 Pod, the deck must 
have a Span-8 Wash ALP accessible by the Span-8 Pod (refer to the 
ALPs User’s Manual, Chapter 18, Span-8 Tip Wash ALP) and 
configured in the Deck Editor (refer to Chapter 5, Preparing and 
Managing the Deck).

3000 — Disposable tips can be removed from any pipetting tool. 

To clear all pods of disposable tips and wash any fixed tips, select Unload 
disposable tips from all pods and wash any fixed tips after method 
completes in the Finish step configuration.
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12.2.2.4 Clear All Global Variables After the Method 
Completes

Global variables are set in the Start or Set Global steps. A variable is a value that has 
been assigned a name and can be referenced repeatedly during a method. Global 
variables are carried over into subsequent methods unless they are cleared in the 
Finish step.

To clear all global variables, select Clear all global variables after the method 
completes in the Finish step configuration.

12.2.2.5 Unload the Current Tool After the Method 
Completes (3000 Only)

When using Biomek Software to create methods for the Biomek 3000 instrument, an 
additional option to unload whatever tool is installed on the Biomek 3000 head 
assembly at the end of the method is available (Figure 12-7). Selecting this option 
instructs the instrument to unload any tool installed on the Biomek 3000 head 
assembly upon completion of the method to ensure no tool is installed at the start of 
the next method. 

If Unload the current tool after method completes is not selected, it may be 
necessary to add additional steps to the start of any subsequent methods to unload or 
change the tool on the head assembly.

To unload the tool at the end of the method, select Unload the current tool after 
the method completes in the Finish step configuration. Any tool loaded onto the 
Biomek 3000 head assembly is removed and placed back onto the tool rack at the 
conclusion of the method.

Figure 12-7.  Finish step options for a Biomek 3000 instrument

Additional option to 
unload a tool from the 
Biomek 3000 head 
assembly at the end of 
a method.

No Reporting
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12.2.2.6 Configuring a Report in the Finish Step
The Finish step may be configured to create a report on data sets at the end of the 
method. Refer to Chapter 14, Using Sample Tracking and Data Sets in a Method, for 
more information on using data sets in a method.

Note:  To create a report on data sets after any transfer or pipetting operation, a 
Reporting step may be inserted into a method at any time (refer to Section 24.6, 
Configuring the Reporting Step)

To choose the report style and location of a report at the end of a method:

1. From the Finish step, check No Reporting (Figure 12-7) to open the 
Reporting configuration (Figure 12-8).

Figure 12-8.  Reporting enabled on Finish step

2. Select Report on all labware data after the method completes to enable 
reporting.
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3. From Report Style, choose one of the following:

• Text File 

• Per-Plate HTML Files 

• Per-Plate Text Files 

• SQL Server (refer to Section 24.6.2, Configuring a SQL Server Report 
Style)

Note:  Refer to Section 24.6.1, Report Styles, for examples and information on 
the types of reports that may be generated.

4. In Report Location, browse to find the location where the file is saved. 
Reporting on the Finish step is configured.

12.2.2.6.1 Generating a Report When a Method Stops
When a method is stopped or aborted and reporting is configured in the Finish step, a 
prompt appears asking if a report should be generated as configured in the Finish step 
(Figure 12-9) (refer to Section 12.2.2.6, Configuring a Report in the Finish Step).

Figure 12-9.  Prompt when method is aborted

To generate a report when a method stops:

From Figure 12-9, choose Yes. The report is generated as configured in the 
Finish step.

12.2.2.7 Completing Finish Step Configuration
Once all the desired options on the Finish step have been selected, the method can be 
run. When the method is completed, any actions selected in the Finish step are 
performed.
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12.3 Inserting Steps in a Method
Steps can be added to a method in a sequential order or inserted at any location in the 
Method View during the method building process; however, steps must represent the 
desired order of execution when the method is run. 

To insert a step in a method, choose one of the following procedures:

1. Select the step above the desired insertion point (Figure 12-10).

2. Click the desired step on the step palette. The step is inserted below the selected 
step.

Figure 12-10.  Inserting a step into a method

OR

Drag and drop the desired step from the step palette to the desired location in the 
Method View. A black bar appears at the insertion point (Figure 12-11). 

Figure 12-11.  Inserting a step by drag and drop

Select the step above where the 
inserted step should appear.

Choose the step from the Basic Step 
Palette, and it is inserted 
automatically into the method.

New step 
inserted in the 
method.

Step above 
desired 
insertion 
point

Insertion bar
The insertion bar 
indicates the target 
point where the step 
will be inserted into 
the method.
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12.3.1 Understanding Techniques
All pipetting operations in a method are controlled using techniques. A technique 
instructs the Biomek instrument in performing pipetting operations, such as aspirate, 
dispense, and mix. Technique selections are made anytime liquid needs to be 
aspirated or dispensed during a method.

A technique stores a set of values, such as aspirate and dispense height, pod speed, 
and tip touch, used in pipetting operation. Biomek Software also stores a set of 
properties, such as labware type and liquid type, related to each technique. Based 
upon these values and properties, the appropriate technique is selected automatically 
for the pipetting operation. This auto-selection can be overridden and a technique 
selected manually for each operation, if desired.

Pipetting options used in the selected technique are represented visually under the 
Auto-Select field in the step configuration. These pipetting options may include:

• Prewet the tips — aspirates and dispenses a specified volume of liquid
before pipetting to prewet the tips.

• Tip Touch — allows tips to touch a designated location briefly in a well 
after aspirating or dispensing. 

Note: Movement of a tip touch first centers the tip in the well, performs 
the pipetting operation, moves to the side of the well, performs a specified 
delay, and returns to the center of the well for dispensing.

• Mix prior to aspirating liquid or Mix after dispensing liquid — mixes 
the liquid before aspirating or after dispensing.

• Follow liquid level when aspirating or dispensing — is 
accomplished with calculations that determine the difference in height
of a liquid level after an aspirate or dispense operation is completed.
The Z and D axis are coordinated according to that liquid level.

• Aspirate a trailing air gap after leaving the liquid — draws air into
tips after aspirating liquid, and blows out that air before dispensing.

• Blowout all leading air gaps — draws air into tips before aspirating 
liquid, and blows out that air after dispensing to ensure all liquid has 
been dispensed.

Note:  Refer to Chapter 9, Understanding and Creating Techniques, for more 
information on pipetting techniques.
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12.4 Using Additional Step Palettes
Additional steps, other than those displayed on the Basic Step Palette, may be added 
to a method by displaying one of the existing step palettes or creating a new step 
palette using the Step Palette Builder (refer to Chapter 29.5, Using the Step Palette 
Builder).

To display an existing step palette:

• From the Options menu, select Toolbars and then select the desired step 
palette to display.

Note: The step palettes available depend on instrument type and 
configuration.

OR

Right-click any empty palette space, and select the desired step palette to 
display from the step palette menu (Figure 12-12).

Figure 12-12.  Step palette menu

Note: To create a custom step palette or add steps to existing step palettes, 
select Palette Builder to open the Step Palette Builder.
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12.5 Copying, Cutting, and Pasting Steps in a Method
One or more steps can be copied, cut, and pasted within a method or between methods 
in a sequential order. Steps can be inserted at any location in the Method View during 
the method building process; however, they must represent the desired order of 
execution when the method is run. 

The originating method and the destination method must use the same deck and 
instrument setups when copying, cutting, and pasting steps between methods. 
Verifying that the deck and instrument setups are the same in both methods ensures 
that Biomek Software knows where labware is physically located on the deck. If the 
decks do not match, steps copied from another method may need to be modified to 
work in the new method.

To copy, cut, and paste one or more steps in a method:

1. Highlight a step in the Method View for copy (or cut).

2. To select multiple steps to copy (or cut):

• While holding down Shift, select the final step in the series to copy (or 
cut). All the steps between the first and second steps selected are now 
highlighted.

• While holding down Ctrl, select additional steps to copy (or cut). All 
the selected steps are highlighted.

3. From the Edit menu, select Copy (or Cut).

OR

Right-click on any of the selected steps and select Copy (or Cut) from the menu 
that appears.

Note:  If Cut is selected, the highlighted step(s) are removed from the Method 
View. If any other step is Copied or Cut prior to Pasting the first step in the 
Method View, the first copied or cut step is lost or overwritten.

4. If the step is to be pasted in a different method, open the desired method (refer to 
Section 12.14, Opening a Saved Method).

5. Highlight the step below where the copied or cut step(s) are to be pasted.

6. From the Edit menu, select Paste.

OR

Right-click the step below where the copied or cut step(s) are to be pasted and 
select Paste from the menu that appears. The step(s) are inserted above the 
highlighted step.
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12.6 Deleting Steps in a Method
Steps can be deleted from a method during the method-building process if they are no 
longer desired. 

To delete a step from a method:

1. Highlight the step in the Method View.

2. To select multiple steps to delete:

• While holding down Shift, select the final step in the series to delete. 
All the steps between the first and second steps selected are now 
highlighted.

• While holding down Ctrl, select additional steps to delete. All the 
selected steps are highlighted.

3. Press Delete on the keyboard. 

OR

From the Edit menu, select Clear. The highlighted step(s) are deleted.

OR

Right-click on any of the selected steps and select Clear from the menu that 
appears.

4. If Ask for confirmation before removing a step from a method is selected in 
Preferences, a prompt appears asking for confirmation each time a step is 
deleted from a method (Figure 12-13).

5. Choose Yes to delete the step from the method.

OR

Choose No to cancel the deletion.

Figure 12-13.  Confirmation to delete steps in a method
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12.7 Using Undo and Redo in Method Building
The Biomek Software maintains a history of actions performed during method 
building. By using the Undo and Redo features located on the toolbar, this history 
can be accessed and the actions undone or redone while building a method. Hovering 
the mouse over the Undo or Redo button on the toolbar displays a tool tip indicating 
what action will be undone or redone.

The following actions are stored in the history and may be undone and redone while 
building a method:

• Adding a step.

• Removing a step.

• Moving a step.

• Configuring a step.

• Changing active selection.

Note: The active selection is the currently selected (highlighted) step 
within the method. Selecting another step in the method changes the active 
selection.

12.7.1 Using Undo
Undo is used to undo the most recent method-building action. Multiple actions may 
be undone by performing consecutive Undo actions; there is no limit to how many 
actions can be undone.

To undo an action:

• Select Undo from the Edit menu

OR

• Click Undo on the toolbar

Note:  When Undo is used while configuring a step, it undoes all actions made to the 
configuration. For example, while configuring Instrument Setup step and placing 
labware on deck positions, choosing Undo will undo the entire Instrument Setup 
step and not just the last deck position that was configured.

12.7.2 Using Redo
Redo is used to redo an action that has been undone using the Undo feature. By 
performing consecutive Redo actions, multiple actions can be redone if multiple 
actions were undone. 

Note:  If another action is performed after undoing an action, Redo is disabled and 
the previously undone action cannot be redone.

To redo an undone action:

• Select Redo from the Edit menu

OR

• Click Redo on the toolbar
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12.8 Entering and Viewing Method Properties
Method Properties allows for entry of a description of the method that can be 
viewed or modified.

Note:  Method properties can be viewed, but not modified when running a method in 
validated mode (refer to Section 12.14, Opening a Saved Method). Validated mode is 
available only when Beckman Coulter Accounts & Permissions is enabled (refer to 
Chapter 2, Using Accounts & Permissions).

To enter or view Method Properties:

1. From the File menu, select Properties. Method Properties appears (Figure 
12-14).

Figure 12-14.  Method Properties

2. In Author, enter the name or user name of the method designer. 

3. In Description, enter a description of the method.

4. Choose OK to save changes and close Method Properties.

OR

Choose Cancel to close Method Properties without saving changes.
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12.9 Saving a Method
Methods may be saved at any time during their development. Saving a method only 
saves the current status of the method and does not create a revision or check in 
project items as revisions. If any of the project items, such as labware class definitions 
or techniques, changes after the method is saved, when the method is opened next, it 
uses the latest definitions. 

Methods are saved as elements of the project file, not as separate files. To use a 
method in another project file or on another system, it must be exported to a Biomek 
method file (*.bmf) and imported into the desired project (refer to Section 12.16, 
Importing and Exporting Methods). 

To save a method:

1. Choose the Save Method icon on the toolbar.

OR

From the File menu, choose Save. Save Method appears (Figure 12-15).

Note:  Save Method appears only the first time the method is saved; 
subsequent saves to the method do not prompt for a new file name. To save an 
existing method with a different file name, choose Save As from the File menu.

Figure 12-15.  Save method



Creating and Using Methods 12-21

Biomek Software User’s Manual

2. In Enter method name, enter the name under which the method is saved. 

3. Choose OK. The method is saved with the specified method name and Save 
Method closes. The title bar of the Biomek Software main editor displays the 
method name as MethodName [Development] (Figure 12-16).

OR

Choose Cancel. Save Method closes without saving the method.

Figure 12-16.  Biomek Software main editor after saving method ExampleMethod

Method name displayed in title bar
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12.10 Checking In a Method
Checking in a method is similar to saving a method, but in addition creates a new 
revision of the method, checks in all project items of the project file, and creates new 
revisions for any items that have changed. A relational link is created between the 
method and all items in the project file.

Note:  Methods must be saved once before being checked in. A prompt to save 
appears automatically if the method has not been saved before.

To check in a method:

1. From the File menu, choose Check In. If any project items have changed since 
the last revision, Check In appears, listing all project items that have changed 
(Figure 12-17).

Figure 12-17.  Check In

2. Select the project items to check in as new revisions. By default, all project items 
in Check In are selected.

Note:  When a method is checked in, the title bar updates the method title to 
show the current revision of the method and that it is in Development mode. 
Methods can only be validated or opened in validated mode when Beckman 
Coulter Accounts & Permissions is enabled (refer to Section 12.11, Validating a 
Method).

3. Choose OK to check in the new revisions of project items.

Note:  If Accounts & Permissions is not enabled, check in is complete.

OR

Choose Cancel to close Check In without checking in the method.

4. If Accounts & Permissions is enabled, Check-In appears (Figure 12-18). In 
Reason, enter information or notes about the method or project revision being 
checked in. Text entered in Reason is date and time stamped, and stored in the 
audit log of all user activity.
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5. If Accounts & Permissions is configured to require password checks for signing 
and check-in, enter the user Password.

Figure 12-18.  Check-In 

6. Choose OK to check in the method or project. If project items were modified, 
only the project was checked in. Check-In appears a second time to check in the 
method.

OR

7. Choose Cancel to close Check-In without checking in the method or project.

8. Repeat steps 4 – 6 to check in the method, if necessary.

Password
Appears only when Accounts & Permissions is configured to 
require password checks (refer to Section 2.2, Installing and 
Setting the Level of Support For Accounts & Permissions).
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12.11 Validating a Method
When Beckman Coulter Accounts & Permissions is enabled, methods may be 
validated. A validated method is a revision of a method that is checked in, approved 
with an electronic signature, and protected from further modification. Revisions of 
project items required to run the validated method are also checked in and protected 
from further modification. This ensures that validated method runs are reproducible.

Validating a revision of a method is not the same as validating a method before a run 
to internally test for errors before the method is actually run. To validate a method to 
test for errors before it is run, check Validate the current method before 
running it in Preferences (refer to Section 29.2, Changing Display Preferences).

Note:  Only users with Validate Methods permission can validate methods. Refer to 
Chapter 2, Using Accounts & Permissions for more information about Beckman 
Coulter Accounts & Permissions. Permissions can be configured so that a user may 
be permitted to run only validated methods (refer to Section 12.14, Opening a Saved 
Method).

To validate a method:

1. From the File menu, choose Validate. If any project items have changed since 
the last revision, Check In appears, listing all project items that have changed 
(Figure 12-17).

Note:  Methods must be saved at least once before being checked in. A prompt 
to save appears automatically if the method has not yet been saved.

2. Select the project items to check in as new revisions. By default, all project items 
in Check In are selected.

Note:  All project items used in the method must be checked in order for the 
correct revision of each item to be used in a validated method run.

3. Choose OK to check in the new revisions of project items. Check-In appears 
(Figure 12-18).

OR

Choose Cancel to close Check In without checking in and validating the 
method.

4. In Reason, enter information or notes about the method or project revision being 
checked in. Text entered in Reason is date and time stamped, and stored in the 
audit log of all user activity.

5. If Accounts & Permissions is configured to require password checks for signing 
and check-in, enter the user Password (refer to Section 2.2, Installing and 
Setting the Level of Support For Accounts & Permissions).

6. Choose OK to check in the method or project. If project items were modified, 
only the project was checked in. Check-In appears a second time to check in the 
method. Repeat steps 4 – 6.

OR

Choose Cancel to close Check-In without checking in or validating the method.
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7. After the project and method are checked in, Signature appears (Figure 12-19). 
In Reason, enter information or notes about the method being validated. Text 
entered in Reason is date and time stamped, and stored in the audit log of all 
user activity.

Figure 12-19.  Signature

8. If Accounts & Permissions is configured to require password checks for signing 
and check-in, enter the user Password (refer to Section 2.2, Installing and 
Setting the Level of Support For Accounts & Permissions).

9. Choose OK to validate the method.

OR

10. Choose Cancel to close Signature without validating the method.

Note:  After validating a method, it remains in development mode. To use the 
method in validated mode, it must be closed and then opened in validated mode. 
Refer to Section 12.14, Opening a Saved Method for more information about opening 
methods in validated mode.

Password
Appears only when Accounts & Permissions is configured to 
require password checks (refer to Section 2.2, Installing and 
Setting the Level of Support For Accounts & Permissions).
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12.12 Signing a Method
When Beckman Coulter Accounts & Permissions is enabled, methods that are 
checked in or validated may be signed. Signing allows users to add comments with an 
electronic signature to the audit trail for the method open in the editor. Signing is 
useful when laboratory policies require personnel to review and sign off on 
procedures; for example, a supervisor could approve a new validated method via the 
electronic signature generated by signing the method in Biomek Software.

Note:  Refer to Chapter 2, Using Accounts & Permissions for more information 
about Beckman Coulter Accounts & Permissions.

To sign a method:

1. Ensure the method has been checked in (refer to Section 12.10, Checking In a 
Method).

2. From the File menu, choose Sign. Signature appears (Figure 12-20).

Figure 12-20.  Signature

3. In Reason, enter information or notes about the method being signed. Text 
entered in Reason is date and time stamped, and stored in the audit log of all 
user activity.

4. If Accounts & Permissions is configured to require password checks for signing 
and check-in, enter the user Password (refer to Section 2.2, Installing and 
Setting the Level of Support For Accounts & Permissions).

5. Choose OK to sign the method.

OR

6. Choose Cancel to close Signature without signing the method.

Password
Appears only when Accounts & Permissions is configured to 
require password checks (refer to Section 2.2, Installing and 
Setting the Level of Support For Accounts & Permissions).
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12.13 Viewing Method History
Revision and run history for the current method can be viewed at any time. Method 
history is viewed in two windows:

• History — view all checked in and validated revisions of the current method 
(refer to Section 12.13.1, Viewing Revision History).

• Validated Run History — view information about each validated run of the 
current method (refer to Section 12.13.2, Viewing Validated Run History).

Note:  Validated methods and Validated Run History are available only when 
Beckman Coulter Accounts & Permissions is enabled (refer to Chapter 2, Using 
Accounts & Permissions).

12.13.1 Viewing Revision History
A revision history that tracks each time the current method has been checked in or 
validated can be viewed when the method is open.

Note:  Methods can be validated only when Beckman Coulter Accounts & 
Permissions is enabled (refer to Chapter 2, Using Accounts & Permissions).

To view the history for a method:

1. From the File menu, choose History. History appears (Figure 12-21).

Note:  Revision history details are listed in a tree structure that lists information 
by run and type. Branches may be expanded or collapsed using the + and - 
buttons to the left.

The Changed By and Comment columns appear only when Accounts & 
Permissions is enabled.

Figure 12-21.  Method history

2. When finished viewing the history, choose OK to close History.
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12.13.2 Viewing Validated Run History
Validated methods run in validated mode generate a run history that can be viewed 
when the method is open. A run history includes access to all dialog alerts, log 
reports, worklists, and other files associated with or generated by the method during 
the run. 

Many of the files listed in the run history can be viewed, saved, and printed (refer to 
Section 12.13.2.1, Viewing, Saving, and Printing Run History Details).

Note:  Validated methods and their run history are available only when Beckman 
Coulter Accounts & Permissions is enabled. Refer to Section 2, Using Accounts & 
Permissions and Section 12.15, Checking Out a Method.

Note:  Text files, such as *.csv files used by the Worklist, Define Pattern, and 
Transfer From File steps, appear in the run history and may be opened directly from 
the window. However, when a project or validated method is exported, they are 
excluded from the Biomek import (*.imp) or method (*.bmf) file. To use a *.csv file 
in a method exported to another system, it must be copied to the system along with 
the Biomek import or method file. 

To view the validated run history for a method:

1. From the File menu, choose Run History. Validated Run History appears 
(Figure 12-22).

Note:  Run history details are listed in a tree structure that lists information by 
run and type. Branches may be expanded or collapsed using the + and - buttons to 
the left.

Figure 12-22.  Validated Run History displayed in validated mode

2. When finished viewing the history, choose OK to close History.

Run history 
details
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12.13.2.1 Viewing, Saving, and Printing Run History 
Details

Many of the files listed in the run history details can be viewed, saved, and printed.

To view and print log and other text files:

Right click on the desired file and choose Open from the menu. The file opens in 
Print Preview with printing and viewing options (Figure 12-23).

To save a file listed in the run history:

Note:  Dialog details cannot be viewed or saved.

1. Right click on a file and choose Save from the menu that appears.

2. Save files in text format by appending .txt to the end of the filename for best file 
compatibility.

Figure 12-23.  Print Preview

Print

Change view 
magnification 

Zoom in 
and out
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12.14 Opening a Saved Method
Methods saved in a project file can be opened only in that project file. Opening a 
method using the Open command opens it in development mode using the current 
revision for all project items. A revision of a method can be opened in read-only 
mode using the Check Out command (refer to Section 12.15, Checking Out a 
Method).

Note:  Methods may also be opened from Recent Methods on the File menu. A 
deleted method may be opened from the Recycled folder. Opening a deleted method 
automatically restores it.

To open a saved method:

1. Choose Open Method on the toolbar 

OR

From the File menu, choose Open. Open Method appears, listing all methods 
saved in the project file (Figure 12-24).

2. Right-click on a method and select History to view the history for the selected 
method. 

3. Use Check Out (refer to Section 12.15, Checking Out a Method) to open a 
specific revision of a method in read-only mode.

4. Choose View and select the desired option, Icon, List, or Details, to change how 
methods are displayed in Open Method. Icon is the default view selection.

Figure 12-24.  Open saved methods

Validated Methods
Available only when Accounts 
& Permissions is enabled.
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5. Select the desired method to open.

Note:  When Accounts & Permissions is enabled, validated methods are denoted 
by a circled check (Figure 12-24). Only validated methods appear in Open 
Method for users that only have Run Validated Methods permission. 

Users with Develop Methods permission have the option to Open method in 
validated mode. Only previously validated methods can be opened in validated 
mode. Methods opened in validated mode are locked and cannot be modified.

6. Choose OK. The selected method is opened in the main editor.

OR

Choose Cancel to close Open Method without opening a method.
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12.15 Checking Out a Method
Methods that have been checked in may be checked out. Checking out a method 
allows any revision of the method to be opened in read-only mode. The links created 
when the method was checked in allows Biomek Software to open the method with 
the same project items as when it was checked in. A method revision that is checked 
out may also be exported to a Biomek method file for use in another project or on a 
different system (refer to Section 12.16.1, Exporting a Method).

Note:  Validated methods may be checked out in validated mode when Accounts & 
Permissions is enabled.

To check out a method:

1. From the File menu, choose Check Out. Check Out Method appears (Figure 
12-25). 

Figure 12-25.  Check Out Method (Accounts & Permissions enabled)

Validated method options 
and Changed by are visible 
only when Accounts & 
Permissions is enabled.
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2. In Select a method to open, select the desired method. All revisions of the 
selected method appear in Select a revision to check out.

Note:  When Accounts & Permissions is enabled, validated methods are denoted 
by a circled check (Figure 12-25). Only validated methods appear in Check Out 
Method for users that only have Run Validated Methods permission. 

Users with Develop Methods permission also have the option to Open method 
in validated mode. Only previously validated methods can be checked out in 
validated mode. When methods are checked out in validated mode, Accounts & 
Permissions generates the audit log during method runs.

3. In Select a revision to check out, select the desired revision.

4. Choose OK to check out the selected revision of the method.

OR

Choose Cancel to close Check Out Method.
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12.16 Importing and Exporting Methods
Methods can be freely shared between projects or transferred between computers by 
exporting and importing Biomek method files. A method file is created by exporting a 
method from the active project file, and contains the method and all records required 
to execute the method. This allows the method to execute correctly when the method 
file is imported into a different project.

Note:  When Beckman Coulter Accounts & Permissions is enabled, users with the 
Run Validated Methods or Develop Methods permission may export methods, but 
only those with the Develop Methods permission may import methods into a project 
(refer to Chapter 2, Using Accounts & Permissions).

Note:  Projects may also be imported and exported. Refer to Section 6.10, Importing 
and Exporting Project Files, for more information.

This section covers:

• Exporting a Method (Section 12.16.1).

• Exporting All Methods Associated With a Project File (Section 12.16.2).

• Importing Methods (Section 12.16.3).
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12.16.1 Exporting a Method
The method currently open in Biomek Software can be exported to a Biomek method 
file (*.bmf). The method file contains all records necessary to allow the method to be 
imported into another project file and executed.

Note:  Method files exported from Biomek 3.0 or later are not compatible with 
earlier versions of the Biomek FX software.

Note:  When Accounts & Permissions is enabled, users with Run Validated 
Methods or Develop Methods permission may export the currently open method. 
However, when validated methods are exported and later imported into different 
projects, they are no longer considered validated and open in development mode. 
After being imported, they can then be validated by users with Validate Methods 
permission.

Note:  Text files, such as *.csv files used by the Worklist, Define Pattern, and 
Transfer From File steps, appear in the run history and may be opened directly from 
the window. However, when a project or validated method is exported, they are 
excluded from the Biomek import (*.imp) or method (*.bmf) file. To use a *.csv file 
in a method exported to another system, it must be copied to the system along with 
the Biomek import or method file. 

To export the currently open method:

1. From the File menu, choose Export. Export Method appears (Figure 12-26).

Figure 12-26.  Export Method

2. In Save in, browse to the desired location to save the exported Biomek method 
file.

3. In File name, enter a name for the method file.

4. Choose Save to export and save the method file.

OR

Choose Cancel to close Export Method without exporting the method.



12-36 Creating and Using Methods

Beckman Coulter, Inc.

12.16.2 Exporting All Methods Associated With a 
Project File

All methods associated with the currently open project file may be exported at the 
same time. Method files are exported to a folder selected or created by the user.

Note:  When Accounts & Permissions is enabled, users with Run Validated 
Methods or Develop Methods permission may export the currently open method. 
However, when validated methods are exported and later imported into different 
projects, they are no longer considered validated and open in development mode. 
After being imported, they can then be validated by users with Validate Methods 
permission.

To export all saved methods:

1. From the File menu, choose Export All. Browse For Folder appears (Figure 
12-27).

Figure 12-27.  Browse For Folder

2. Use the tree view to browse to the folder where the exported method files will be 
saved.

OR

Choose New Folder to create a new folder for the method files. The new folder 
appears in the tree view with the name highlighted.

Note:  New Folder is available only when Biomek Software is run on a 
Windows 2000 or Windows XP system.

3. If a new folder has been created, enter a new name for it.

OR

To change the name of an existing folder, select the folder, click on the folder 
name a second time, and enter the new name.

4. Choose OK to export all methods to the selected folder.

OR

Choose Cancel to stop the operation without exporting any methods.
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12.16.3 Importing Methods
Biomek method files previously exported from a project file can be imported into the 
project file currently active. Importing a method file also imports all the necessary 
records to execute the method. 

Multiple methods can be selected and imported simultaneously.

To import methods into the project file:

1. From the File menu, choose Import. Import Method appears (Figure 12-28).

Figure 12-28.  Import Method

2. In Look in, browse to the location where the desired Biomek method file(s) is 
saved.

3. Select the desired method file(s) to import. To import several method files, hold 
the CTRL key while selecting each method desired to import.

4. Choose Open to import the selected method file(s). Confirm appears 
(Figure 12-29).

OR

Choose Cancel to close Import Method without importing the method file.

Figure 12-29.  Confirming the method file(s) to import
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5. Choose Yes to confirm the desired method file is selected. Confirm appears 
(Figure 12-30).

OR

Choose No to cancel the import operation without importing the method file.

Figure 12-30.  Choosing to import project items corresponding to the method

6. Choose Yes to import the method and project items used by the method, but not 
currently stored in the active project file. Check In Project appears, listing only 
project items used by the method that do not currently exist in the current project. 
These project items will be imported into the current project and linked to the 
method.

Note:  Check In Project may not appear if all project items in the current 
project file are compatible with the imported method.

Items in the current project that are not used by the imported method are not 
linked to the method.

OR

Choose No to import the method but not the project items. No project items are 
linked to the method. The import operation is complete.

Note:  Importing project items used by the method is recommended. Choosing 
No may prevent the imported method from executing properly.

Figure 12-31.  Check In Project
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7. Choose OK to check in the revisions of project items associated with the method. 
If Accounts & Permissions is enabled, Check-In appears (Figure 12-32).

Note:  If Accounts & Permissions is not enabled, importing the method is 
complete.

OR

Choose Cancel to close Check In without checking in the project items.

8. In Reason, enter information or notes about the method or project revision being 
checked in. Text entered in Reason is date and time stamped, and stored in the 
audit log of all user activity.

9. If Accounts & Permissions is configured to require password checks for signing 
and check-in, enter the user Password.

Figure 12-32.  Check-In 

10. Choose OK to check in the project items associated with the imported method(s).

OR

Choose Cancel to close Check-In without checking in project items associated 
with the imported method.

Password
Only appears when Accounts & Permissions is configured to 
require password checks (refer to Section 2.2, Installing and 
Setting the Level of Support For Accounts & Permissions).
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12.17 Deleting and Restoring Methods
Methods may be deleted from a project file, but are not removed from the project file 
and may be restored at any time. 

12.17.1 Deleting Methods
To delete a saved method:

1. Choose Open Method on the toolbar.

OR

From the File menu, choose Open. Open Method appears, listing all methods 
saved in the project file (Figure 12-33).

2. Right-click on a method and select History to view the history for the selected 
method.

3. Choose View and select the desired option, Icon, List, or Details, to change how 
methods are displayed in Open Method. Icon is the default view selection.

Figure 12-33.  Open saved methods 
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4. Right-click the desired method to delete and select Delete. A confirmation 
appears (Figure 12-34).

Figure 12-34.  Confirm deletion of selected method

5. Choose Yes to confirm deletion of the selected method. The method is removed 
from My Methods and placed in Recycled.

OR

Choose No to keep the selected method. 

12.17.2 Restoring Methods
To restore a deleted method:

1. Choose Open Method on the toolbar.

OR

From the File menu, choose Open. Open Method appears, listing all methods 
saved in the project file (Figure 12-33).

2. Right-click on a method and select History to view the history for the selected 
method.
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3. Choose View and select the desired option, Icon, List, or Details, to change how 
methods are displayed in Open Method. Icon is the default view selection.

Figure 12-35.  Open saved methods 

4. Choose Recycled on the left side of Open Method to display all the methods 
that have previously been deleted (Figure 12-36).
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5. Choose View and select the desired option, Icon, List, or Detail, to change how 
methods are displayed in Open Method. Icon is the default view selection.

Figure 12-36.  Recycled methods

6. Right-click the desired method to restore and choose Restore. The method is 
moved from Recycled to My Methods.

Note:  A method may be opened directly from the Recycled folder by selecting 
the method and choosing OK. A confirmation appears stating that the method 
will be restored prior to opening the method. Choose OK to restore and open the 
method.
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12.18 Running, Pausing, and Stopping a Method
Methods may be run on the Biomek instrument or in simulation mode immediately 
after they are built. If desired, methods may be configured to check for internal errors 
and confirm that labware on the instrument deck matches the layout specified in the 
method before every run. 

This section covers:

• Running a Method (Section 12.18.1).

• Pausing a Method in Progress (Section 12.18.2).

• Stopping a Method in Progress (Section 12.18.3).

• Snapping a Continuation (FX, NX only) (Section 12.18.4).

• Disabling Steps Within a Method (Section 12.18.5).

• Purging Air From Span-8 Pod Before a Method Run (FX and NX-S8 Only) 
(Section 12.18.6).

12.18.1 Running a Method
After a method has been built, it may be run immediately on the Biomek instrument 
or in Simulate mode. In simulate mode, the software runs the method and checks for 
configuration errors in each step. While the method is running, the Biomek Simulator 
shows an animated 3-D model of the instrument performing the method.

When simulate mode is chosen, validated methods run in validated mode are recorded 
in Run History. Validated methods run in development mode are not logged. 
Validated methods are only available when Accounts & Permissions is enabled.

Note:  When Beckman Coulter Accounts & Permissions is enabled, only users with 
Develop Methods or Run Validated Methods permission may run methods. Users 
with Develop Methods permission may run any method saved on the system; users 
with Run Validated Methods permission may only run validated methods. Refer to 
Section 2.3.1, Assigning Biomek Software Permissions for more information about 
the permissions available to users of Biomek Software.

To run a Biomek method:

1. From Hardware Setup in Port, choose:

• Simulate to run the method in simulated mode.

OR

• Com1 to run the method on the instrument.

2. If running the method on the instrument, from the Instrument menu, choose 
Home All Axes to home the pod(s), if necessary. The pod(s) must be homed 
before performing methods each time the instrument is powered on.

Note:  Refer to the instrument hardware manual for more information about 
homing the pod(s).

3. To start the method run, on the toolbar, click the green arrow button.

OR

From the Execution menu, choose Run.
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The method run begins. Depending on how Biomek Software is configured, two 
events may precede the execution of steps in the method:

• If Validate Before Run is selected in Options>Preferences, the method is 
validated internally to check for errors (refer to Section 29.2.1, Configuring 
General Options). 

Note: Validating the method for errors is a different process from 
validating a revision of a method when Accounts & Permissions is enabled. 
Refer to Section 12.11, Validating a Method for more information about 
validating a revision of a method.

• If Pause to confirm setup? is selected in the Instrument Setup step, a 
deck confirmation prompt appears (Figure 12-37).

CAUTION: Make sure the correct ALP is chosen when configuring the 
deck setup in the Deck Editor. ALPs vary in height and failure to choose 
each ALP correctly in the software may result in collisions between 
pod(s) and ALPs during operation.
To confirm that the deck setup is correct:

1. Visually confirm the deck setup on the instrument matches the display.

Figure 12-37.  Deck layout confirmation prompt for a Biomek 3000 method

2. Choose OK if the setup is acceptable.

OR

Choose Abort to close the deck confirmation prompt and cancel the method run.

Note:  To set up the deck correctly, either set up labware on the instrument deck 
to match the layout displayed in the deck confirmation prompt, or change the 
Deck Layout in the Instrument Setup step (refer to Section 15.2.4, Populating 
the Deck with Labware).
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The method runs as soon as the deck setup is confirmed. The method run can be 
visually followed in the Method View; steps are highlighted in green as they are 
executed. 

When a method runs in simulate mode, the Biomek Simulator appears and shows a 3-
D animation of the method being performed (refer to Section 12.18.1.1, Viewing the 
Method Run In the Biomek Simulator).

Note:  If Accounts & Permissions is configured to automatically log off users after a 
set period of operating system inactivity, the possibility exists that a user may be 
logged off automatically during a method run. When a user is logged off, the method 
run continues, but any prompts, such as the deck layout confirmation (Figure 12-37), 
are hidden from view until the same user, or another user with permission to run 
methods, logs on.

12.18.1.1 Viewing the Method Run In the Biomek Simulator
When a method is run in simulate mode, the Biomek Simulator appears and shows an 
animated 3-D model of the instrument performing the method (Figure 12-38).

Figure 12-38.  The Biomek Simulator showing a method run on an NX-MC

Simulation Display
Toggles the Biomek Simulator 
on and off during a method run.

Camera Navigation
Buttons appear when enabled in Hardware 
Setup or when toggled on in the simulator 
controls (refer to Section 12.18.1.1.1, Using 
the Simulator Controls).
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Five methods of controlling the simulator view are available:

• From the toolbar, choose Simulation Display to toggle the Biomek 
Simulator on and off while the method is executing.

Note: The simulator automatically launches when the method run begins 
and closes when it is finished. If the animation does not run smoothly, try 
reducing the image quality setting in Hardware Setup (refer to Section 
4.4.1, Configuring Simulator Settings).

• Change the view by placing the cursor in the simulator display, then clicking 
and dragging the mouse in the desired direction of rotation.

• Change the view by clicking the cursor in the simulator display and using the 
keyboard control keys defined in Camera (refer to Section 4.4.2, 
Configuring Camera Controls).

• Use the camera navigation controls to change, save, and reset the view 
(Figure 12-39). The navigation controls are displayed when enabled in 
Hardware Setup or when toggled on using the simulator controls (refer to 
Section 12.18.1.1.1, Using the Simulator Controls).

Note: Additional simulator parameters may also be configured in 
Hardware Setup (refer to Section 4.4, Configuring the Biomek Simulator).

• Press the tilde (~) key to access the simulator controls (refer to Section 
12.18.1.1.1, Using the Simulator Controls). The simulator controls provide 
the ability to change the simulation playback speed, toggle the camera 
navigation controls on and off, and modify the lighting that illuminates the 
simulated instrument.

Figure 12-39.  Camera navigation controls

Reset View
Restores the 
default view.

Store camera position
Choose a position to save 
the current view. Up to ten 
positions may be saved.

Restore camera position
Choose a position to show the view 
stored in that position.

Rotate camera position
Rotates the camera position in 
the indicated direction.

Move In
Moves the 
instrument closer.

Move Out
Moves the 
instrument 
further away.

Move camera position
Moves the camera position 
in the indicated direction.
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12.18.1.1.1 Using the Simulator Controls
The simulator controls provide the ability to change the simulation playback speed, 
toggle the camera navigation controls on and off, and modify the lighting that 
illuminates the simulated instrument.

To access and use the simulator controls:

1. During a simulated method run, press the tilde (~) key to toggle the simulator 
controls on. The simulator controls appear (Figure 12-40).

Figure 12-40.  Biomek Simulator with all simulator controls enabled

2. Enter a new Warp Factor and choose Apply to change the simulator playback 
speed, if desired. Warp Factor 1 runs the simulation in real time, Warp Factor 
2 at twice normal speed, and so on.

3. Choose Lights to toggle the lighting controls on, if necessary.

4. Create a new light or choose an existing light from the pull-down menu, and use 
the lighting controls to modify the lighting properties as desired. Table 12-1 
provides a description of each lighting control.

Note:  Modifying the lighting parameters is not recommended because the 
default parameters cannot be restored if changed or deleted.

5. Choose Navigation to toggle the camera navigation controls on, if necessary. 
Refer to Section 12.18.1.1, Viewing the Method Run In the Biomek Simulator, for 
detailed information about using the navigation controls.

6. Press the tilde (~) key to toggle the simulator controls off, if desired.

Warp Factor
Sets the simulator 
playback speed.

Lights
Toggles lighting 
controls on and off.

Navigation
Toggles navigation 
controls on and off.

Lighting 
controls

Navigation 
controls

Light currently 
being configured
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Table 12-1.  Simulator Lighting Controls
Control Description Additional Information

Global Light Properties
Local View Select to subtly change the intensity 

of light.
Global Ambient Choose the color of ambient light 

present in the simulator view. 
Lights

 (new light) Create a new light.

 (delete light) Delete the light currently selected 
in the pull-down menu.

A light that has been deleted cannot be 
restored.

 (save light) Save the configuration of the light 
currently selected in the pull-down 
menu.

Draw Lights Select to display the light sources in 
the simulator view.

Properties
Name Change or enter a new name for the 

selected light.
Enabled Select to enable (turn on) the 

selected light.
Type Choose the type of light: 

Positional or Directional.
Positional light radiates from the source in 
all directions; directional light radiates from 
the source in a single direction.

Direction Enter X, Y, and Z coordinates for 
the direction from which the 
selected light is directed at the 
instrument.

Light Choose colors for the Ambient, 
Diffuse, and Specular properties 
of the light.

Ambient and Diffuse define the color of 
the 3-D model of the instrument when the 
light is enabled. Specular defines the color 
of specular highlights (glare).

Attenuation Enter values in each field to define 
the fall off from the center of the 
light.

Available only when Positional is the type 
of light selected. 

Entering higher values causes the light to 
fall off quicker.

Spotlight Choose to cast a tightly focused 
beam of light at the 3-D model of 
the instrument.

Available only when Positional is the type 
of light selected.

Spot Direction Enter X, Y, and Z coordinates for 
the direction from which the 
spotlight is directed at the 
instrument.

Available only when Spotlight is the type 
of light selected.
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Spot Exponent Enter a value to set the focus of the 
spotlight. 

Available only when Spotlight is the type 
of light selected. 

A low value distributes the light evenly 
across the illuminated area; a high value 
concentrates more light in the center of the 
spotlight.

Spot Cutoff Enter a value to set the size of the 
spotlight cone, which determines 
the total surface area covered by the 
spotlight.

Available only when Spotlight is the type 
of light selected.

Table 12-1.  Simulator Lighting Controls
Control Description Additional Information
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12.18.2 Pausing a Method in Progress
Pause causes the method to halt after the Biomek instrument has completed the 
move in progress. For example, if the instrument is in the process of loading tips 
when Pause is selected, it finishes loading the tips before the system halts. When the 
method is resumed, it continues as though it were never halted.

Note:  A method cannot be edited during a pause.

Use one of the following procedures to pause a method:

CAUTION: No changes to the Biomek state are permitted while a method 
is paused. Changes can be made to the labware contents, but not the 
deck or the devices.

From the Execution menu, choose Pause.

OR

Choose Pause on the toolbar. The instrument completes the move in progress 
and stops. 

FX, NX-MC, NX-S8 — The instrument deactivates the light curtain when 
the method is paused.

To resume the method run, choose Pause again. The light curtain is reactivated, 
and the method resumes from the point where it was paused.
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12.18.3 Stopping a Method in Progress
WARNING: The light curtain is a safety device. Use it to stop a method 
only in an emergency.
Use Stop to halt a method during its run when there is no intent to resume method 
execution. If the pod is in the process of a move, the operation is not completed. Since 
the method is halted, this option allows edits to the method or changes to the 
hardware and deck.

Note:  Stop may not halt operations already in progress on external devices, such as 
Stacker Carousels.

Use one of the following procedures to stop a method during a run:

• From the Execution menu, choose Stop. 

OR

• Choose Stop on the toolbar.

OR

FX, NX-MC, NX-S8 — Break (violate) the light curtain by no more than 
one inch, and choose Abort.

3000 — Press the STOP button on the front of the instrument

Note:  Use standard procedures to rerun the method.

12.18.4 Snapping a Continuation (FX, NX only)
Another way to halt a method in progress is by snapping a Continuation. 
Continuations stop the current method and allow corrections in the middle of a 
method run. The method can be restarted from the point where the method was halted. 
For more information about Continuations, refer to Section 25.11, Using 
Continuations (not available on a 3000).

To snap a continuation, choose Snap to create a Continuation (refer to Section 25.11, 
Using Continuations (not available on a 3000)).
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12.18.5 Disabling Steps Within a Method
Individual steps within a method can be disabled for execution. When the method is 
run, Biomek Software ignores any disabled steps. 

Disabling steps is useful for experimenting with the configuration of certain steps 
during method development, or when only a subset of the steps in a method need to 
be executed in a method run for an assay.

Note:  If a method is checked out in validated mode, steps cannot be disabled or 
enabled.

To disable a step in a method:

1. Select the desired step to disable.

2. From the Edit menu, choose Disable step.

OR

Right-click the step and choose Disable step from the menu. The step icon 
changes to grayscale with a red X to indicate the step is disabled.

Figure 12-41.  Step disabled in Method View

To enable a previously disabled step:

1. Select the disabled step to enable.

2. From the Edit menu, choose Enable step.

OR

Right-click the step and choose Enable step from the menu. The red X 
disappears and the step icon changes to color to indicate the step is enabled.

Disabled step
Disabled step icon displayed 
in grayscale with red X.
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12.18.6 Purging Air From Span-8 Pod Before a 
Method Run (FX and NX-S8 Only)

When a Span-8 Pod is idle, air bubbles form in the tubing and syringes and interfere 
with pipetting accuracy. These air bubbles may form prior to beginning a method run 
or while the pod is sitting idle during a method run. Therefore to accurately transfer 
liquid, air must be purged from the tubing and syringes of the Span-8 Pod. The 
purging process draws system fluid through the tubing and syringes until all air 
bubbles are removed.

Purging the tubing and syringes of air is accomplished through Manual Control 
(refer to Section 6.5.7, Purging Air from the Syringes and Tubing) or by inserting a 
Span-8 Wash Tips step (refer to Section 18.8.1, Configuring the Span-8 Wash Tips 
Step for a Passive Wash) in a method before the Span-8 Pod moves: 

• Use Manual Control immediately before running a method or insert a 
Span-8 Wash Tips step at the beginning of the method to purge the tubing 
and syringes of air. 

• A Span-8 Wash Tips step using approximately 10 to 15 mL of system fluid 
may be inserted after the Instrument Setup step to purge the tubing and 
syringes of air.

• When using a dual-pod system, it may be necessary to insert another Span-
8 Wash Tips step into the method immediately before a Span-8 Pod begins 
to move if the pod has been idle. 
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12.19 Printing a Method
Printing a hard copy of a method is useful if a computer monitor is some distance 
from the instrument, it is necessary to show the method steps to someone away from 
the lab, or a hard-copy record of the method is needed to recreate the method. All of 
the step configurations are listed in the hard copy.

To print a Biomek method in sequential text form:

1. Select the File menu.

2. Choose Print. A print-out similar to Figure 12-42 is produced at the default 
printer.

Note:  Use Print Preview from the File menu to open a dialog which displays how 
the method appears when printed.

Figure 12-42.  Printed method
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12.20 Improving a Method 
Biomek provides procedures that allow a method to be observed in order to make 
adjustments to improve the way it runs.

Here are three procedures to improve the way a method runs:

• Running the Method at Slow Speed (Section 12.20.1).

• Snapping a Continuation (FX and NX Only) (Section 12.20.2).

• Using Logging (Section 12.20.3).

12.20.1 Running the Method at Slow Speed
To slow down the pod speed to provide more time to examine the method in progress:

1. From the Instrument menu, choose Hardware Setup. Hardware Setup 
appears (Figure 12-43).

2. On the left side of Hardware Setup, select the desired pod.

3. Expand the Additional Pod Settings.

4. Set the Speed Limit to 20%. This is the recommended speed for observing a 
method as it runs (Figure 12-43).

Figure 12-43.  Changing the method speed in Hardware Setup

Selected Pod

Speed Limit

Additional Pod 
Settings (expanded)
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5. Choose Accept to save the changes and close Hardware Setup.

6. From the Execution menu, choose Run to start the method.

Note:  Another way to run the method slowly is to use Single Step on the 
Execution menu. Single Step allows the unit to move one operation at a time by 
clicking the launch button for each move. Refer to Section 25.12, Performing Single 
Operations Within Steps, for more information about using Single Step.

12.20.2 Snapping a Continuation (FX and NX Only)
Possible changes in a method may be desired after observing a method. Snapping a 
Continuation stops the method in progress, allows settings to be changed, and then 
continues the run. Another option is to snap a Continuation after the run has been 
observed at slow speed to return the speed to 100%. This causes the first part of the 
method to run slowly to observe the execution, but the rest of the method runs at full 
speed.

Note:  Refer to Chapter 25, Handling and Preventing Errors, for more information 
about continuations.

1. Once the method is running, choose Snap Continuation from the toolbar.

2. Modify the method as desired.

3. Start the continuation.
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12.20.3 Using Logging
Text format logs are used for close examination of every operation that occurs during 
method execution in order to modify the run to improve the method. These generated 
logs give detailed information, including the date and time.

There are several logs available in the Biomek Software:

• Details — Provides comprehensive information on every operation the 
instrument performs.

• Errors — Lists errors for a method, if any.

• Pipetting — Lists aspirate and dispense operations.

• Span8Pipetting — captures only Span-8 pipetting operations that occur 
during a method run, including location and labware name or type.

• Span8Transfer — captures only Span-8 transfer operations that occur 
during a method run, including location and labware name or type.

Note: The addition of SampleID data sets also allows the 
Span8Pipetting and Span8Transfer logs to include well identification 
information.

FX, NX-S8 — Span8Pipetting and Span8Transfer logs are available 
only for these instruments.

• UnifiedPipetting — Captures pipetting operations, along with Sample IDs 
for wells, performed by any pods, including information on where the 
aspirate or dispense operation occurs.

• UnifiedTransfer — Captures transfer operations, along with Sample IDs for 
wells, performed by any pods, including information on the source and 
destination labware.

To turn logging on or off:

1. From the toolbar, choose Options.

2. Choose Log Configuration.

3. Check or uncheck the desired Log(s).

Note:  Refer to Chapter 26, Generating and Using Log Data, for more information 
on generating and using log data.
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13 Using Variables and 
Expressions in a Method

13.1 Overview
A variable is a value that has been assigned a name. A value can contain text strings, 
arrays, expressions, objects, operators, or numerical constants. Any value assigned a 
name can be referenced repeatedly during a method by inserting the variable name in 
any applicable field in a step configuration. 

An expression is a one-line combination of alphanumeric characters and/or variables 
combined using mathematical operations. An expression can be used anywhere a 
variable can be used, and it may use one or more variables.

Note:  For example the variable Volume may be required in a field, but accuracy 
may require additional information. The variable Volume may be modified into an 
expression, such as Volume+ 10 or Volume/4.

.Advantages to using variables include:

• Several variables can be created in one step; for example, the Start step can 
be used to define multiple variables that are available to every step within a 
method, while the Let and Worklist steps can be used to create multiple 
variables that can be used by their substeps.

• Several variables can be used in one step.

• A name can be entered as a variable or expression in any step configuration 
field where the value associated with the variable or expression is required. 
Biomek Software then interprets the variable or expression and replaces it 
with the associated value.

• A variable can be used as many times as necessary; for example, multiple 
steps within Let and Loop steps can all use the same variable.

Note: To make variables available to all steps in a method, define the 
variables in the Start step.

• Variables used extensively in a method need only be changed in the step they 
are defined to change the value in every step in the method that uses the 
variable.

• When a method is run more than once, the value associated with that 
variable can be changed in the step, and the associated values within the 
method automatically change accordingly.
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13.2 Using Variables
A variable consists of a name and a value. To use a variable, enter an equal sign (=) 
followed by the variable name into the step configuration requiring the variable. For 
example, in Figure 13-1, the variable =AspValue, created in the Start step 
configuration of the method (Figure 13-2), is entered in the Volume field. 

The Biomek Software internally substitutes the name with its value, but the name 
remains in the field. In the example, the variable AspValue is substituted internally 
by the value 25. The value of 25 is never displayed, only the variable name.

Variable values are not assigned a unit of measure. When a variable is identified in a 
step, the unit of measure is defined by the requirements of the step. For example, if a 
variable named Aspirate is assigned a value of 5, and =AspValue is entered in a 
field that requires microliters, the software interprets the value of 5 as 5 microliters; 
likewise, if =AspValue is entered in a field that requires seconds, the software 
interprets the value as 5 seconds.

Note:  If a variable is used in a pipetting step with an auto-selected technique, and 
the value of the variable changes such that a new technique would be selected, the 
technique is automatically updated when the step is executed.

Note:  Enter the variable name preceded by the equal (=) sign in any field where the 
value it represents is appropriate.

Figure 13-1.  Transfer step using the AspValue variable

Using a variable to specify volume
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13.2.1 Creating Variables
Variables may be created in several steps. Refer to the section for the step for more 
specific information on creating variables with that step:

• Configuring the Start Step (Section 12.2.1).

• Loop Step (Section 16.9).

• Run Method Step (Section 17.3).

• Worklist Step (Section 17.4).

• Let Step (Section 17.6).

• Create Group Step (Section 21.3).

• Set Global Step (Section 21.7).

• Define Procedure Step (Section 21.8.1).

• Run Procedure Step (Section 21.8.2).

Figure 13-2.  Variables configured in the Start step

Variables defined in the Start 
step can be used in any step 
within the method.
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13.2.2 Using Variables in a Method
To use a variable created previously in the method, the variable name is entered into 
the configuration of the step. In the example, the variable AspValue, created in the 
Start configuration (Figure 13-2), is entered in the µL (volume) field of the Transfer 
step (Figure 13-3).

Note:  Enter the Variable Name in any field where the value it represents is 
appropriate.

The Biomek Software internally substitutes the name with its value, but the name 
remains in the field. In the example (Figure 13-2), AspValue is substituted internally 
by the value 25. The value of 25 is never displayed, only the variable name 
AspValue.

Variables previously configured in any step may be used in any field where the value 
of the variable is a valid value for the field. For example, a variable with a value of 50 
would be appropriate in a Volume field, but not in a field asking for a deck position.

Any variables used in a method must be defined prior to the step in which they are 
used, or an error occurs. For example, if the variable AspValue is not defined when it 
is entered in the Transfer step, an error results.

Note:  Keep this in mind when writing a method that will be run in another method 
using the Run Method step. If the Run Method step in the other method specifies 
any variable values, those variables must be created in the method for method 
validation. When the method is run through the Run Method step, it is run using the 
variable values specified in the Run Method step.

Note:  Variables created with some steps are only applicable for that step and its 
substeps. For example, a variable created with a Let step may only be used for 
substeps of the Let step.
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To use a previously created variable in a step configuration:

1. Select the appropriate field in the desired step configuration.

2. Enter the variable name, preceded by an equal sign. For example, =AspValue in 
the Volume field of the Transfer step (Figure 13-3) indicates that a volume 
equal to the value of the variable AspValue is dispensed in the selected 
destination labware.

Note:  Variables may be used in any field which the value is a valid entry. For 
example, a variable that has a text value cannot be entered in a field that is 
expecting a numerical input.

Figure 13-3.  Transfer step using the AspValue and AspValue2
variables defined in the Start step

Using variables defined 
in the Start Step
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13.3 Using Expressions
An expression is a one-line combination of variables, such as Aspirate; mathematical 
operators, such as addition (+); string constants, such as “P4”; and numeric constants. 
An expression can be used anywhere a variable can be used and may contain one or 
more variables; for example, the variable Volume may be required in a field, but 
accuracy may require additional information. The variable Volume may be modified 
into an expression, such as Volume + 10 or Volume/4. 

Like variables, expressions start with an equal sign and can contain operators allowed 
in VBScript programming, such as addition (+), division (/), exponentiation (^), 
concatenation of strings (&), and functions like random (Rnd), rounding (Round), or 
absolute value (Abs). 

An expression can be entered in any step configuration field where the value 
associated with the expression is required. Biomek Software interprets the expression 
and replaces it with the associated value. 

Three examples of expressions are:

• If a variable called my_volume is defined, transferring from a 96-well 
microplate to each quadrant of a 384-well microplate could be accomplished 
by placing =my_volume / 4 in the volume field. 

• If the three variables VolumeA, VolumeB, and VolumeC are defined to 
represent the volumes transferred to a destination microplate from three 
different sources, mixing the entire contents of the destination microplate 
could be accomplished by configuring a Mix step using the expression = 
VolumeA + VolumeB + VolumeC in the volume field.

• In a Loop step, a variable called count is created and appended to the letter 
“P” in a step configuration as the expression = “P” & count. If the Loop is 
configured to start at 1 and end at 10, the Loop results would be P1, P2, ..., 
P10.
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14 Using Sample Tracking and 
Data Sets in a Method

14.1 Overview
Sample tracking means the contents of the plate or tube are known at any time in the 
method and decisions may be made during transfer or pipetting operations based on 
the contents of the plate or tube. 

Sample tracking is possible in Biomek Software using data sets, which store specific 
information about wells or tubes (refer to Section 14.1.2, Data Set Definition).

14.1.1 Sample Tracking
Sample tracking allows information about a sample in an individual well to be moved 
along with the sample when it is moved to another well. Sample tracking is enabled 
through the following functions of Biomek Software:

• association of a sample ID with wells or tubes through data sets.

• automatic copying of the SampleID data set (and any other data sets) during 
transfer and pipetting operations.

• reporting of information.

14.1.2 Data Set Definition
Data sets allow information about a sample in an individual well or tube to be tracked 
when the sample is moved to another well or tube. During any transfer or pipetting 
operation, all data sets associated with a plate are automatically copied from the 
source plate to the destination plate; however, only the wells in the data set affected 
by the transfer or pipetting operation are copied to the destination plate. The 
information in the data set can be used in decision-making; for example, during a 
Transfer or Combine step, a data set can be used to determine from which wells or 
tubes liquid should be aspirated or dispensed.
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14.1.3 Data Set Steps in the Biomek Software
Four steps in Biomek Software allow data sets to track samples. Knowledge of these 
steps is necessary to understand how data sets are used in Biomek Software to track 
samples:

• Create Data Set — specifies data in a data set (refer to Section 24.3, 
Configuring the Create Data Set Step).

• Data Set Management — renames, removes, copies, or modifies the 
properties of a data set (refer to Section 24.4, Configuring the Data Set 
Management Step)

• Data Set Processing — applies a transformation expression to an existing 
data set to create a new data set (refer to Section 24.5, Configuring the Data 
Set Processing Step).

• Reporting — generates a report on data sets at any point during a method 
(refer to Section 24.6, Configuring the Reporting Step).

Note:  Refer to Chapter 24, Using the Data Sets Step Palette, for complete 
information on displaying the Data Sets Step Palette and configuring the data sets 
steps.

14.1.4 Example of Sample Tracking Using Data 
Sets

While there are numerous ways in which sample tracking can be implemented using 
data sets, the following is an example of using data sets to track sample ID:

If a sample ID is associated with a tube and an amount is transferred from the tube to 
specified wells on a microplate, the Sample ID data set for the tube is copied to the 
specified wells on the microplate. The report will show the sample ID in the tube and 
the sample ID in the specified wells.



Using Sample Tracking and Data Sets in a Method 14-3

Biomek Software User’s Manual

14.2 Understanding How Data Sets Are Created
The information contained in a data set is chosen in the Create Data Set step (refer 
to Section 24.3, Configuring the Create Data Set Step); however, some data sets may 
be generated in other ways through the software. 

Biomek Software creates data sets in several ways:

• automatically (refer to Section 14.2.1, Understanding the Volume Data Set).

Note: The Volume data set is created automatically.

• using the Instrument Setup step (refer to Section 15.2.6, Creating the 
SampleID Data Set Using the Instrument Setup Step).

• using the Create Data Set step (refer to Section 24.3, Configuring the 
Create Data Set Step).

• using the SILAS step (refer to Section 22.8.3, Creating Data Sets from 
SILAS Messages).

• using VB scripting (refer to Section 28.3, Scripting Data Sets).

Note: Creating data sets using scripting requires prior knowledge of 
Visual Basic scripting.

Note:  While Biomek Software retains information on all data sets and allows the 
information to be used anytime during the method, the specific information on a data 
set can only be viewed in a report configured in the Reporting (refer to Section 24.6, 
Configuring the Reporting Step) or Finish steps (refer to Section 12.2.2, Configuring 
the Finish Step).

14.2.1 Understanding the Volume Data Set
The volume of each well or tube is automatically tracked and stored for each piece of 
labware in a data set called Volume. The Volume data set is read-only and cannot be 
changed or manipulated, but may be used in other steps in the method to specify well 
patterns or volumes. 

The Volume data set is reported when reports on data sets are generated and 
configured in the Reporting step (refer to Section 24.6, Configuring the Reporting 
Step). The Volume data set allows the volume of a well or tube to be known at any 
time during a method by inserting a Reporting step after any transfer or pipetting 
operation.
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14.3 Using Data Sets in a Transfer or Combine Step
FX, NX-S8 — Only the Span-8 Pod can be used to define patterns with data 
sets in a Transfer or Combine step.

3000 — Only a Single-Tip Pipette Tool can be used to define patterns with 
data sets in a Transfer or Combine step.

Not only are data sets automatically copied from the source plate to the destination 
plate during all transfer and pipetting operations, data sets may also be used in a 
Transfer or Combine step to define patterns for aspirating and dispensing liquid or 
to specify transfer volumes to specific wells. However, to use data sets to define well 
patterns for the Transfer and Combine steps, a data set must first be created for the 
source or destination labware in the Create Data Set step (refer to Section 24.3, 
Configuring the Create Data Set Step).

Note:  The well patterns defined using data sets are for use during the transfer 
operation for the specific Transfer or Combine step; they cannot be saved in the 
Well Pattern Editor.

Data sets can be used in a Transfer or Combine step for:

• Defining Well Patterns Using Data Sets (Section 14.3.1).

• Specifying Volumes Using Data Sets (Section 14.3.2).
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14.3.1 Defining Well Patterns Using Data Sets
Data sets may be used in a method to define well patterns for aspirating and 
dispensing liquid using the Transfer and Combine steps.

To use data sets to configure source or destination labware in a Transfer or Combine 
step:

1. Insert a Transfer or Combine step into the Method View anywhere after the 
specific data set that is used has been created (Figure 14-1). 

Figure 14-1.  Transfer step in Method View after data set is created

2. In Use Pod, select the Span-8 Pod. Use Probes is displayed (Figure 14-1).

Note:  If using a single-pod instrument, Pod1 is the only available selection.

3. In Use Probes, select the probes of the Span-8 Pod to use for the transfer.

3000 — Use Probes is not displayed.

4. Configure the Tip Handling as desired.

Note:  Refer to Section 15.3.1, Configuring Tip Handling, for information on 
configuring Tip Handling.

5. Select the Source or Destination labware.
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6. Double-click on the graphic of the labware to zoom in (Figure 14-2).

Figure 14-2.  Transfer step — zoomed-in destination labware

7. Select Use Data Set to define a pattern using a data set.

Note:  All data sets defined for the specified Source or Destination labware are 
available for selection.

Use Data Sets
Select this option and 
configure the expression 
to define a well pattern 
using a data set.
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8. In where its values, select the desired option:

• are equal to — wells that have a value for the selected data set that are 
equal to a specified value or string are included in the pattern.

Note: Strings used with are equal to must be entered as =“string”.

• are greater than — wells that have a value for the selected data set that 
are greater than a specified value are included in the pattern.

• are greater than or equal to — wells that have a value for the selected 
data set that are greater than or equal to a specified value are included in 
the pattern.

• are less than — wells that have a value for the selected data set that are 
less than a specified value are included in the pattern.

• are less than or equal to — wells that have a value for the selected 
data set that are less than or equal to a specified value are included in the 
pattern.

• are not equal to — wells that have a value for the selected data set that 
are not equal to a specified value or string are included in the pattern.

Note: Strings used with are not equal to must be entered as 
=“string”.

• contains — wells that contain a specified numeric or text string within 
their value for the selected data set are included in the pattern.

Note: Strings used with contains must be entered as =“string”.

9. Enter a value to complete the expression.

10. Double-click the graphic of the labware or choose Zoom Out to return to the 
Transfer step configuration.
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14.3.2 Specifying Volumes Using Data Sets
Data sets may be used in a method to specify transfer volumes using the Transfer and 
Combine steps.

To use data sets to configure volumes in a Transfer or Combine step:

1. Insert a Transfer or Combine step into the Method View anywhere after the 
specific data set that is used has been created (Figure 14-3). 

Figure 14-3.  Transfer step in Method View after data set is created

2. In Use Pod, select the Span-8 Pod.

Note:  If using a single-pod instrument, Pod1 is the only available selection.

3. In Use Probes, select the probes of the Span-8 Pod to use for the transfer.

3000 — Use Probes is not displayed.

4. Configure the Tip Handling as desired.

Note:  Refer to Section 15.3.1, Configuring Tip Handling, for information on 
configuring Tip Handling.

5. Select the Source or Destination labware.

Note:  For a Transfer step, Volume is configured in the destination labware; for 
a Combine step, Volume is configured in the source labware.
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6. In Volume, choose one of the following: 

• To retrieve all values of a data set, enter
=positions.PositionName.labware.DataSets(“name”).GetAll, 
where PositionName is the name of the deck position assigned by the 
Deck Editor (for example, p5 or p8) and name is the name of the data 
set from which to retrieve values.

• To get a single value from the data set, enter 
=positions.PositionName.labware.DataSets(“name”)(“A1”), 
where “A1” is the position in the data set of the desired value.

• To get a subset of values from the data set, enter 
=positions.PositionName.labware.DataSets(“name”)(array(“
A1”, “B1, “C1”)), where “A1”, “B1”, and “C1” are the positions in the 
data set of the desired values.

Note:  Data sets can also be used in an expression using the above and the ListMath 
functions (refer to Section 10.4.1, About ListMath). For example, to normalize the 
volume of all wells on the plate at P5 to 250 µL, enter:
= Listmath.Sub (250, positions.p5.labware.DataSets(“Volume”).GetAll).
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15 Using the Basic Step Palette

15.1 Overview
The Basic Step Palette incorporates the basic steps that provide essential functionality 
for the Biomek instruments, including general instrument setup, pipeting operations, 
and labware manipulation.

CAUTION: Make sure the correct ALP is chosen when configuring the 
deck setup in the Deck Editor. ALPs vary in height and failure to choose 
each ALP correctly in the software may result in collisions between 
pod(s) and ALPs during operation.
The steps available in the Basic Step Palette are:

• Instrument Setup — specifies the type of labware used for a liquid transfer, 
the position the labware occupies on the Biomek instrument deck, and some 
labware content configuration. 

Note: The type and position of ALPs and other hardware on the deck is 
specified in the Deck Editor.

• Transfer — comprises tip load, aspirate, dispense, and unload tip functions 
in one step to transfer liquid from a single source to one or more 
destinations.

• Combine— similar to a Transfer step, except Combine transfers liquids 
from one or more sources to a single destination.

• Move Labware — moves labware via automatic manipulation using the 
gripper on the Biomek instrument.

NX-S8 — The optional gripper must be installed to move labware.
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• Pause — halts instrument interaction with a lab position for a specified 
amount of time or the entire deck for an indefinite period of time. 

• Comment — documents the method or adds instructions in the Method 
View.
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15.2 Instrument Setup Step
CAUTION: An inaccurate Instrument Setup may result in pod and 
labware collisions, or in inappropriate pipetting.
When preparing the Biomek instrument for a method, it is important to understand a 
critical concept that applies every time the instrument is set up: obstacle avoidance. 
When building a method, always tell the software what labware and ALPs are on the 
deck, and the deck position each occupies. In the Instrument Setup step, labware is 
selected and positioned on the Biomek instrument deck.

As the bridge and pod move during method execution, the pod rises just enough to 
clear the objects sitting on the deck, and not much higher; therefore, if the software is 
not aware of what and where objects are on the deck, a hardware crash may occur.

Insert an Instrument Setup step to specify the labware, devices, and ALPs that are 
on the deck and the deck position each occupies. The Instrument Setup step can be 
inserted immediately after the Start step (Figure 15-1), or at any point in the method 
flow. 

The Sample ID data set is also created in the Instrument Setup step by configuring 
the option Pause for bar code (refer to Section 15.2.6, Creating the SampleID Data 
Set Using the Instrument Setup Step).

Note:  It is not necessary to add the Instrument Setup to a method if the current 
method is using the same deck setup as the previously run method, and the setup was 
not cleared in the Finish step of the previous method.
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To insert an Instrument Setup step into a method, drag and drop Instrument 
Setup into the Method View (Figure 15-1).

Figure 15-1.  Instrument Setup step and configuration

CAUTION: To make sure the Biomek pod avoids all obstacles during its 
travel, always specify the labware, ALPs, and devices that are on the 
deck, and the deck position each occupies.
Configuring the Instrument Setup step includes:

• Selecting a Deck Layout (Section 15.2.1).

• Verifying Deck Layout (Section 15.2.2).

• Configuring Pod Setup Options (Section 15.2.3).

• Populating the Deck with Labware (Section 15.2.4).

• Configuring Tip and Labware Properties (Section 15.2.5).

• Creating the SampleID Data Set Using the Instrument Setup Step 
(Section 15.2.6).

• Creating Custom Labware (Section 15.2.7).

Change Pod Setup

Verify Pod Setup Option
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15.2.1 Selecting a Deck Layout 
CAUTION: Make sure the correct ALP is chosen when configuring the 
deck setup in the Deck Editor. ALPs vary in height, and failure to choose 
each ALP correctly in the software may result in collisions between 
pod(s) and ALPs during operation.
The Instrument Setup step uses a Deck Layout as a map for the placement of 
labware, ALPs, and external hardware devices, such as stacker carousels. 

A Deck Layout is a blueprint, or map, of the Biomek instrument deck. Biomek 
Software provides two predefined Deck Layout options: Deck1 and Standard. 
These two deck layouts represent the basic deck layout for the specific instrument 
with only standard deck positions.

Note:  The Standard deck layout is read-only and may not be modified.

When an Instrument Setup step is inserted into a method, the default Deck Layout 
set in the Deck Editor is automatically selected. If another deck layout other than the 
default deck is desired, choose any existing Deck Layout in Deck from the drop-
down list.

Note:  Refer to Chapter 5, Preparing and Managing the Deck, for more information 
on creating and modifying a deck layout and setting the default deck layout.
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15.2.2 Verifying Deck Layout 
It is possible to verify the Deck Layout selected for a method before the method is run 
by selecting the Pause to Confirm Setup? option (Figure 15-2). The default 
selection for the Pause to Confirm Setup? option is On.

Verification of the Deck Layout is recommended when a method is run repeatedly, or 
when modifications have been made to a method. A prompt appears (similar to the 
one below) when Pause to Confirm Setup? is selected prior to running the method. 
The prompt displays the deck layout and the labware type and name (if assigned a 
name in Labware Properties) of the labware on each position.

Figure 15-2.  Pause to Confirm Setup? Deck Layout confirmation prompt
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15.2.3 Configuring Pod Setup Options
Verify Pod Setup? is used to configure the current state of the pod or tool on the 
Biomek instrument at the beginning of the Instrument Setup step. However, 
selecting Tips Loaded or Tool Loaded informs the Biomek Software that tips or a 
tool are loaded on the instrument; it does not instruct the instrument to load tips or a 
tool.

Verify Pod Setup? is recommended when multiple methods are run one following 
another, when a single method is run repeatedly, or when tips are not loaded during 
the method.

Options for Verify Pod Setup depend on the instrument and pod type.

FX — With a Multichannel Pod, has two options to verify the pod setup:

• Pod must have the gripper retracted instructs the instrument to 
retract the gripper on the pod. The default setting is On. 

• Tips Loaded informs the software that tips are loaded at the time of the 
Instrument Setup step. The default setting for the Tips Loaded option 
is Off.

FX — With Span-8 Pod, has only one option to verify the pod setup:

• Tips Loaded informs the software that tips are loaded at the time of the 
Instrument Setup step. The default setting is Off.

3000 — Has two options to verify the pod setup:

• Tool Loaded informs software that a tool is loaded on the head 
assembly at the time of the Instrument Setup step. The default setting 
is Off.

• Tips Loaded informs the software that tips are loaded onto the tool at 
the time of the Instrument Setup step, if Tool Loaded is On and a 
pipetting tool is selected. The default setting is Off.

NX-MC — Has two options to verify the pod setup:

• Pod must have the gripper retracted instructs the instrument to 
retract the gripper on the pod. The default setting is On. 

• Tips Loaded informs the software that tips are loaded at the time of the 
Instrument Setup step. The default setting is Off.

NX-S8 — Has only one option to verify pod setup:

• Tips Loaded informs the software that tips are loaded at the time of the 
Instrument Setup step. The default setting is Off.
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To verify the pod setup prior to a method run:

1. Select Verify Pod Setup?. 

2. Choose Configure to change the Pod Setup, if desired. Pod Setup appears 
(Figure 15-3).

Figure 15-3.  Pod Setup prompt for dual-pod Biomek FX instrument

FX — If the instrument is a dual-pod system, Pod Setup provides options 
for the Left Pod and the Right Pod. 

3. Uncheck Pod must have the gripper retracted, if the gripper position is not 
critical.

4. Select Tips Loaded, if tips must be loaded at the beginning of the method. The 
Tips Loaded field has three states: 

• Checked — indicates tips are loaded

• Unchecked — indicates tips are not loaded

• Gray-checked — instructs the software to leave the tips in their current 
state, whether tips are loaded or not loaded

5. If Tips Loaded is selected, select the tip type loaded at the beginning of the 
method.

6. Choose OK to save the changes made to the Pod Setup.



Using the Basic Step Palette 15-9

Biomek Software User’s Manual

15.2.4 Populating the Deck with Labware
The labware available for selection is displayed graphically below Labware 
Category (Figure 15-4). A specific type of labware can be viewed in the graphical 
display, or all types of labware available can be viewed simultaneously, using the 
Labware Category filter.

Figure 15-4.  Populating the Deck Layout of a Biomek 3000 instrument

Labware Category 
graphical display

Graphical representation 
of the types of labware 
available for populating 
the Deck Layout. The 
labware displayed here is 
based on the Labware 
Category selected above.

Labware Category selection

Clear
Drag a piece of 
labware from the 
deck position to the 
trash to remove it.

Instrument Setup display
Displays the setup of the deck. 
Once labware is added to the 
deck, it is displayed here. If 
names have been assigned to 
labware, the names are 
displayed.
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To populate the Deck Layout with labware, select from the graphical display below 
Labware Category and add them to the Deck Layout display. 

Note:  When populating the deck with labware, consider the tip to labware 
accessibility of the instrument pod or tool as described in the hardware manual for the 
specific instrument.

1. To display labware, select the type of labware desired in Labware Category. 
Labware Category choices include:

• Any — lists all types of labware available, including lids and deck 
positions reserved for swapping labware.

• Custom — lists any labware stored with defined properties (refer to 
Section 15.2.7, Creating Custom Labware).

• Lid — lists lids associated with labware available.

• Reservation — reserves deck positions for specific purposes; for 
example, to enable swapping of labware between positions or tip 
loading for the Span-8 Pod.

• Reservoir — lists reservoirs available.

• TipBox — lists types of tips available.

• Titerplate — lists types of microplates available.

• Tuberack — lists types of tube racks available.

Note:  Labware types and their characteristics are defined in the Labware Type 
Editor. Refer to Chapter 7, Creating and Modifying Tip and Labware Types, for 
information using the Labware Type Editor. If the Hide Labware option was 
chosen while defining a labware type, it will not be displayed in the Instrument 
Setup step.

CAUTION: Do not place labware other than a tip box on a tip loader 
position (TL#).
2. To place labware on the Deck Layout, drag and drop each desired labware 

graphic to the desired position on the Deck Layout display.

OR

Click on the labware graphic, and then on the desired position in Deck Layout 
display. The same type of labware can be added to as many deck positions as 
required by continuing to click on deck positions.

OR

Click on the labware graphic, and then click and drag the mouse over multiple 
deck positions in the Deck Layout display. This places the labware in all the 
highlighted positions.

Note:  To move labware to a different position, drag the desired labware to the 
new position in the Deck Layout.

3. To remove unwanted labware from the Deck Display during setup, drag and drop 
the labware to the Clear (trash) icon (Figure 15-4).

OR

Right-click the unwanted labware and select Delete from the menu that appears.
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15.2.4.1 Changing Instrument Setup During a Method
When changing the instrument setup during a method, a second Instrument Setup 
step must be added. The additional Instrument Setup step reflects modifications to 
the current state of the deck (Figure 15-5).

Figure 15-5.  A second Instrument Setup step with deck positions specified As Is

Additional Instrument Setup steps can be inserted into a method as many times as 
necessary to complete a liquid-handling process, and to accommodate the addition of 
labware to the deck throughout a method.

The following options are available to help modify all instrument setups, either 
globally or by individual deck positions. These options are:

• As Is — individual deck positions retain their current state, whether empty 
or occupied by labware or a device.

• Toggle — toggles all empty deck positions to the As Is state and from the 
As Is state to their initial status, allowing those deck positions to retain their 
empty state.

• Clear — clears individual deck positions, whether empty or occupied by 
labware.

• Clear All — clears all deck positions, whether empty or occupied by 
labware or a device.

Instrument Setup 
display

Displays the setup of 
the deck. Once labware 
is added to the deck, it 
is displayed here. If 
names have been 
assigned to labware, the 
names are displayed. Instrument Setup options

Allows manipulation of the deck 
positions for addition and removal 
of labware during a method run.
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15.2.4.1.1 As Is and Toggle 
As Is indicates that a deck position retains its current state, whether empty or 
occupied by labware or a device. Previously populated deck positions are indicated 
with the As Is option in the subsequent Instrument Setup step configuration. When 
As Is is applied to a deck position, the position becomes grayed out in the Deck 
Layout display (Figure 15-5).

As Is may also be used at the start of a method to indicate that deck positions retain 
their state from a previously run method that did not clear the deck of all labware in 
the Finish step.

To indicate that a deck position retains its current state:

1. Click As Is.

2. Click any deck position on the Deck Layout, and it is displayed As Is.

3. Repeat step 2 for each desired deck position.

OR

Click on a deck position, and then click and drag the mouse over multiple deck 
positions in the Deck Layout display. This toggles all the highlighted positions to 
the As Is state.

Toggle toggles all empty deck positions in the Instrument Setup Display between As 
Is, preserving the deck position’s current state (Figure 15-6), and Clear, which 
empties a deck position. When Toggle is selected, deck positions labeled As Is revert 
to Clear.

Note:  Adding labware to a deck position that is set to As Is removes the As Is status 
and replaces that position with the added labware. Any labware at that position is 
assumed to be removed from the deck and replaced with the new labware. 
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To indicate that a deck position retains its current state:

Click Toggle, and any deck position not occupied by a piece of labware in the 
Instrument Setup display is toggled to the As Is state.

Figure 15-6.  Toggle applied to the Deck Layout

Instrument Setup 
display

Toggle
Changes all 
unpopulated deck 
positions to the As 
Is state.
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15.2.4.1.2 Clear and Clear All
Clear removes labware or the As Is designation from individual deck positions. 
There is no confirmation for Clear, so once Clear is chosen, and a deck position is 
selected, the position is cleared of any labware or the As Is option (Figure 15-7).

Figure 15-7.  Clear Deck Layout designation applied to deck position TL1

The Clear All option removes all labware and As Is designations from the Instrument 
Setup. Clear All displays a prompt before the deck is cleared of all labware and As Is 
designations.

Note:  If a deck position that contained labware from a previous Instrument Setup 
step is set to Clear, the labware is assumed to have been removed from the deck and 
that position no longer contains any labware.

To remove labware from the Instrument Setup configuration: 

1. Choose Clear to clear a single deck position of labware or an As Is designation.

2. Click on the deck position in the Deck Layout display. 

3. Continue to click on individual deck positions to empty them.

OR

Drag and drop labware from Deck Layout into Clear.

OR

Right-click on the labware in the Deck Layout display and select Delete.

Instrument Setup 
Display

Clear and 
Clear All
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4. To clear the entire deck at one time, choose Clear All. 

5. A confirmation prompt asking for verification appears. Choose Yes to remove 
all labware from the deck (Figure 15-8).

Figure 15-8.  Confirmation prompt to Clear All labware from the Deck Layout 

15.2.5 Configuring Tip and Labware Properties
Labware Properties is used to configure properties for each piece of labware added to 
the Deck Layout. The information provided in Labware Properties is used when a 
pipetting technique is selected, and when tips are loaded and unloaded.

To access Labware Properties: 

1. Double-click on a piece of labware in the Deck Layout.

OR

Right-click on a piece of labware in the Deck Layout and choose Properties to 
open Labware Properties.

Note:  If there is a stack of labware at the selected position, a submenu appears 
from Properties listing labware from bottom to top.

The configuration options in Labware Properties provide the following 
information, if it applies to the type of labware selected:

• Name assigned to a piece of labware, if desired

• Labware type

• Maximum volume per well

• Bar code 

• Sense liquid level options

• Volume for each well, if known The default volume for a labware type may 
be set in the Labware Type Editor (refer to Section 7.3.6, Editing Labware 
Type Properties).

• Liquid type

• Where to dispose of tips

• Where to dispose of tip boxes

• Maximum number of times tips may be loaded

• Available tips

Note:  Variables and expressions may be entered in any field that can be configured. 
Refer to Section 13.2, Using Variables, and Section 13.3, Using Expressions, for more 
information on using variables and expressions.
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15.2.5.1 Configuring Labware Properties for Tips
When the labware selected for configuration is a tip box, Labware Properties 
provides the ability to configure the following information:

1. Double-click the tip box to configure in the Deck Layout.

OR

Right-click the tip box to configure in the Deck Layout and select Properties 
from the menu. Labware Properties for tips appears (Figure 15-9).

Figure 15-9.  Labware Properties for tips

2. In Name, enter the name assigned to the tip box, if applicable. Naming a tip box 
forces the instrument to look for the specific box of tips, rather than any tip box 
on the deck that contains the specified tip type.

Note:  Multiple tip boxes can be given the same name. This is useful for creating 
a pool of tip boxes for a specific use.

OR

Leave Name blank. When Name is blank, tips are accessed by the information 
displayed in the Labware Type field. 

3. In Labware Type, verify the tip type.

4. In Bar Code, enter the bar code. Use the bar code field to identify a specific tip 
box in certain methods, such as plate replication. This field may be left blank. 

5. In When empty, send to, select a final destination for the tip box at the end of 
the method.

6. In Unload Tips Into, select the location reserved for tip disposal.

7. In Load no more than, enter the number of times tips can be loaded onto the 
pod during the method.
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8. Choose Show Available Tips to display a graphic of the tip box 
(Figure 15-10).

Figure 15-10.  Labware Properties for tips with Available Tips shown

9. On the graphic of the tip box, select the usable tips. By default, all tips are 
selected. This can be used to indicate missing tips or tips that are otherwise not 
used in the method.

10. Choose Hide Available Tips to collapse the graphic of the tip box.

11. Choose OK to save Labware Properties and return to the Instrument Setup 
step configuration.
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15.2.5.2 Configuring Labware Properties of Microplates, 
Reservoirs, and Tube Racks

When the labware selected for configuration is a microplate, reservoir, or tube rack, 
Labware Properties provides the opportunity for configuration (Figure 15-11).

1. Double-click the piece of labware to configure in Deck Layout.

OR

Right-click the piece of labware to configure in Deck Layout and select 
Properties from the menu. Labware Properties for microplates, reservoirs, 
and tube racks appears (Figure 15-11).

Figure 15-11.  Labware Properties for microplates, reservoirs, and tube racks

2. Verify the Labware Type.

3. In Name, enter a name for the labware. 

Note:  When a deck is populated by numerous pieces of labware, naming 
labware is recommended. Names should be descriptive of the contents of the 
labware or the work being accomplished during the method. Naming labware in a 
meaningful fashion may reduce confusion.

4. In Bar Code, enter the bar code to identify a specific plate in certain methods, 
such as plate replication. This field may be left blank.

5. Make a selection in Labware contains. This information is used by many of 
the techniques supplied with Biomek Software that aspirate or dispense at a 
certain offset from the liquid level.

Note:  Some pods or tools can detect the liquid level using liquid-level sensing 
technology.

• If Known is selected, the liquid level is not detected during method run 
and the entered value is used during validation and method run. Known 
Volume should be supplied whenever possible. 

• If Unknown is selected, the liquid level is detected during method run if 
required by the technique, and the wells are assumed to be full when 
validating the method.

• If Nominal is selected, the liquid level is detected during method run, 
but the volume in the wells is assumed to be the entered value when 
validating the method. 

6. Enter the Volume, if Nominal or Known volume is selected. A value entered in 
Volume is assigned to each well on the selected labware.
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7. Select the Liquid Type contained in the labware. Specifying liquid type is 
useful when Biomek Software auto-selects a pipetting technique for any aspirate 
and dispense operations on this piece of labware. This technique is auto-selected 
based on the physical factors of the liquid, as well as the physical attributes of the 
labware, and the pod or tool performing the operation. For more information on 
liquid types, refer to Chapter 8, Understanding and Creating Liquid Types.

8. Select Sense the liquid level the first time a well with Unknown or 
Nominal volume is accessed “from the Liquid” to use liquid level 
sensing to determine the liquid level only the first time it accesses a well with an 
Unknown or Nominal volume from the liquid. When the same well on the piece 
of labware is accessed, the liquid level is calculated internally based on the result 
of the earlier liquid level sense and the amount aspirated or dispensed to the well 
in previous steps.

OR

Select Sense the liquid level every time a well is accessed “from the 
Liquid” to use liquid level sensing to determine the liquid level every time it 
accesses a well with an Unknown or Nominal volume from the liquid.

Note:  Liquid level sensing options apply only if the pod or tool accessing the 
labware is liquid level sensing capable. If not, the selected option is ignored.
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9. If the labware does not contain uniform volumes, choose Show Labware 
Volumes to display a graphic of the labware (Figure 15-12) and assign two or 
more volumes to wells on the same piece of labware. 

Note:  If a volume for all wells is specified in step 6, proceed to step 15.

Figure 15-12.  Labware Properties for a 96-well microplate 
with Labware Volumes shown

Note:  Show Labware Volumes may appear different depending on the 
number of wells on the selected labware.

10. Select the desired wells on the graphic. 

Note:  Hold down Ctrl to toggle wells between selected and deselected without 
affecting the selection status of other wells. Click a column or row heading to 
select all wells of a column or row.

11. Enter the volume to assign to the currently selected wells in Amount.

12. Choose Set to assign the current Amount to the currently selected wells. The 
wells are given a color code that corresponds to the list of set volumes under 
Volume.

13. Repeat steps 10-12 until all desired wells have been assigned the desired volume. 
Clear sets the volume for all wells back to zero.

14. Choose Hide Labware Volumes to collapse the graphic of the labware.

15. Choose OK to save Labware Properties and return to the Instrument Setup 
step configuration.
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15.2.5.3 Configuring Labware Properties for a Biomek 
3000 Tool Rack

The Tool Rack on the Biomek 3000 instrument stores various interchangeable tools 
for head assembly on the instrument deck during a method. The Biomek 3000 can 
load and unload tools from the Tool Rack to give the instrument different capabilities. 
The tools available to the head assembly are configured from Labware Properties in 
an Instrument Setup step.

Since a gripper tool may be placed physically on the Gripper Tool Rack only (refer to 
the Biomek® 3000 Laboratory Automation Workstation User’s Manual, Chapter 3.2, 
Installing the Gripper Tool in the Tool Rack), it must be configured in Instrument 
Setup using a Gripper Tool Rack.

Since the HDR tool occupies all five positions of a standard tool rack and cannot be 
placed on the gripper tool rack (refer to the Biomek® 3000 Laboratory Automation 
Workstation User’s Manual, Chapter 5.2.2, Installing the HDR Tool on a Tool Rack), 
it must be configured in Instrument Setup occupying all five positions of a Tool 
Rack. However, if the tool rack is installed on the left end of the Biomek 3000 deck, 
and there is no disposal unit installed on the left side, the HDR tool body may be 
installed in slot 1 or 2 of the tool rack. Additional tools may then be installed in slots 
4 and 5 of the tool rack.

To configure the tools available at a Tool Rack in Instrument Setup:

1. Double-click the piece of labware to configure in Instrument Setup 

OR

Right-click the piece of labware to configure in Instrument Setup and select 
Properties from the menu. Labware Properties for the Biomek 3000 Tool 
Rack appears (Figure 15-13).

Figure 15-13.  Labware Properties for a Biomek 3000 Tool Rack
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2. Locate the desired tool on the right side of Labware Properties and drag it to 
one of the unoccupied (black) positions on the Tool Rack. The selected tool is 
placed in the position (Figure 15-14).

Figure 15-14.  Labware Properties for a Biomek 3000 Tool Rack with tools loaded

3. Repeat step 2 until the Tool Rack is full or all desired tools have been placed on 
the Tool Rack.

4. Choose OK to save the Labware Properties for the Tool Rack.
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15.2.6 Creating the SampleID Data Set Using the 
Instrument Setup Step

The Instrument Setup step contains an option to Pause for bar code input? 
during a method run (Figure 3-11). When this option is selected, the method pauses at 
the Instrument Setup step and allows for per-well or per-tube bar codes to be 
entered for all labware on the deck. Using the specified bar codes, a data set called 
SampleID is created for each piece of labware. 

Figure 15-15.  Enabling bar code input in the Instrument Setup step

Select to enable bar code input.
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When Pause for bar code input? is selected, Bar code input (Figure 15-16) 
appears during the method run at the Instrument Setup step. 

If Pause to confirm setup? is also selected, Bar code input appears after the Deck 
Confirmation prompt (refer to Section 15.2.2, Verifying Deck Layout).

Figure 15-16.  Bar code input
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If desired, only labware IDs or only sample IDs may be entered in Bar code input. It 
is not necessary to enter both labware and sample IDs for any piece of labware.

Note:  Labware must be unstacked to assign Labware ID and/or Well/Tube ID in Bar 
code input.

To enter labware and sample IDs:

5. In Position, select the deck position of the labware to specify labware or sample 
IDs.

OR

Click on the desired piece of labware in the Deck Display. A graphic of the 
selected labware type appears (Figure 15-17).

Figure 15-17.  Entering sample IDs for labware in Bar code input

6. In Labware ID, enter the plate bar code or name.

7. Select Increment by Row to enter sample IDs by row.

OR

Select Increment by Column to enter sample IDs by column.

Note:  The Increment selection determines which well is automatically selected 
when a sample ID is set by choosing Set or pressing Enter.

8. Select the well or tube in the labware graphic to assign a sample ID.

9. In Well/Tube ID, enter the bar code or sample ID to assign to the selected well or 
tube.
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10. Press Enter or choose Set to assign the Labware ID and Well/Tube ID to the 
selected labware and well or tube. The well or tube is assigned the sample ID and 
turns green to indicate a sample ID has been assigned to that well or tube. The 
next well or tube on the labware is automatically selected.

11. After each Well/Tube ID assignment and/or Labware ID assignment, press 
Enter or choose Set.

Note:  If using a handheld bar code reader, ensure the bar code on the plate or 
tube ends with a carriage return and line feed.

12. Repeat steps 4-6 to assign a sample ID to all desired wells or tubes of the 
labware.

13. Repeat steps 1-7 to assign sample IDs to each desired piece of labware.

14. After sample IDs have been entered to all desired labware, choose Close. The 
SampleID data set is created for every piece of labware on the deck.

Each Instrument Setup step with Pause for bar code input? selected allows wells 
or tubes to be assigned IDs. If a new ID is assigned to a well or tube that previously 
had a SampleID created, the new value overwrites the old value. To maintain a 
record of all SampleIDs for a well or tube, use the Data Set Management step to 
rename or create a copy of the SampleID data set before the additional Instrument 
Setup step assigns the new sample ID (refer to Section 24.4, Configuring the Data 
Set Management Step).

15.2.7 Creating Custom Labware
The Custom labware category offers the option to create and reuse labware with 
defined and stored Labware Properties. New labware stored in the Custom labware 
category maintains the Labware Properties defined when the labware was created 
or added to the deck, including the name, bar code, liquid type, and volume 
information. 

Custom labware creates an instance of the labware type containing the attributes of 
the working revision of the labware type it is based on at the time the custom labware 
is created and the configured Labware Properties. Custom labware is saved to the 
instrument file. 

Note:  The default volume for a labware type can be specified in the labware 
definition stored in the Labware Type Editor (refer to Section 7.3.6, Editing 
Labware Type Properties).

To create Custom labware:

1. Highlight the Instrument Setup step.

2. Add the desired labware to create the custom labware from to the deck; for 
example, if creating a custom reservoir, add a reservoir to the deck. Refer to 
Section 15.2.4, Populating the Deck with Labware.

3. Configure the Labware Properties for that piece of labware. (Refer to Section 
15.2.5.1, Configuring Labware Properties for Tips and Section 15.2.5.2, 
Configuring Labware Properties of Microplates, Reservoirs, and Tube Racks to 
configure Labware Properties.)
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4. In Labware Category, display the <Custom> labware category. If no custom 
labware has been created, no labware is displayed.

Figure 15-18.  Custom labware category displayed

Custom must be 
selected in 
Labware Category 
to create custom 
labware.
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5. Drag and drop the labware graphic from the Deck Layout to the <Custom> 
Labware Category display. If the <Custom> labware category is not visible, 
dragging and dropping the labware has no effect.

Note:  Multiple pieces of labware, or stacks of labware, cannot be added to the 
<Custom> labware category simultaneously; each piece of labware must be 
added individually.

Figure 15-19.  Custom labware created

6. To delete a piece of labware from the <Custom> labware category, drag the 
labware from the <Custom> labware category display to Clear.

Note:  Custom labware added to the <Custom> labware category in the 
Instrument Setup step is visible in the Device Setup (refer to Section 22.5, 
Device Setup Step) and Stacker Carousel Setup (refer to Section 23.3, Using 
the Stacker Setup Step).

Drag configured 
labware from the deck 
layout configuration to 
the graphical labware 
display with Custom 
selected in Labware 
Category to create a 
custom labware.
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15.3 Configuring Transfer and Combine Steps
The Transfer and Combine steps configure multiple aspirate and dispense 
operations using the selected pod or tool to transfer liquid from all specified source 
wells to all specified destination wells. The Transfer step transfers liquid from a 
single source to one or more destinations, while the Combine step transfers liquid 
from one or more sources to a single destination. 

The Transfer and Combine steps may be used with any Biomek instrument; 
however, the capabilities of the steps vary depending on the pod or tool configuration 
of the instrument:

FX, NX-MC — Using the Multichannel Pod, the same volume is transferred 
from each of the 96 or 384 channels in each aspirate and dispense cycle. 

FX, NX-S8 — Using the Span-8 Pod, a different volume may be aspirated 
from each well of a source labware and a different volume may be dispensed 
to each destination. The pod may also use only selected probes to aspirate 
from specified wells on the source labware and dispense to specified wells 
on the destination labware. 

3000 — The pipetting tool aspirates from all channels at once (one for a 
single-channel tool or eight for an eight-channel tool). The tool transfers the 
same volume from each channel in each aspirate and dispense cycle.

Note:  If there are multiple sources or destinations, each source or destination may 
have a different volume transferred, but all wells on any single source or destination 
must have the same volume transferred. To transfer different volumes to or from wells 
on the same piece of labware, configure multiple sources or destinations using the 
same labware but specify different wells and volumes.

The Transfer and Combine steps perform four liquid-handling functions through the 
step configuration, eliminating the need to insert multiple steps to complete the liquid 
transfer:

• Load tips onto pod or tool.

• Aspirate liquid from source(s).

• Dispense liquid to destination(s).

• Unload tips from pod or tool.

The Transfer and Combine step configuration includes:

• Configuring Tip Handling (Section 15.3.1).

• Configuring Source Labware (Section 15.3.2).

• Configuring Destination Labware (Section 15.3.3).

• Configuring Transfer Details (Section 15.3.4).
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Insert a Transfer or Combine step into the Method View (Figure 15-20).

3000 — If a specific pipetting tool is desired, it must first be loaded using 
either a Change Tool (refer to Section 20.3, Change Tool Step) or a Load 
Tool step (refer to Section 20.4, Load Tool Step).

Note:  The appearance of the Transfer or Combine step configuration varies 
depending on the instrument and pod selection.

Figure 15-20.  Transfer step configuration for a Multichannel Pod

15.3.1 Configuring Tip Handling
Configuring Tip Handling in the Transfer and Combine steps is not required, 
because the default Tip Handling configuration locates and loads clean tips 
automatically every time a Transfer or Combine steps is initiated and unloads them 
when the step is completed. It is recommended, however, that Tip Handling 
configuration be supplied if cross contamination or conserving consumables is a 
concern, or a specific tip type should be used.

Tip Handling is also used to configure washing or changing tips between transfer 
operations. Tips may be washed or changed between sources or between destinations. 
Options for washing or changing tips vary according to the instrument and 
configuration.

3000 — Tip wash options are not available for this instrument.

Tip Handling Configuration
Tip Handling parameters specify 
tip type, whether tips remain on the 
pod at the end of the liquid transfer, 
when to change tips, and tip wash 
options.

Pod Configuration
The pod performing the 
liquid transfer must be 
specified. If only one 
pod is attached to the 
instrument, the default 
Pod1 is displayed. If 
running a two-pod 
system, use the drop-
down list to make a 
selection.
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To configure Tip Handling (Figure 15-20) for the Transfer or Combine steps:

1. If using a dual-pod FX instrument, specify the Pod to perform the transfer 
operation. The pod configured as the default pod is displayed in Pod. If the other 
pod is desired, select the pod from the drop-down list or the Current Deck 
Display.

2. If using a Span-8 Pod on FX or NX-S8, select the probes used in the transfer by 
clicking the probe numbers in Use Probes. Any combination of probes may be 
used as long as all selected probes are using the same type of tips and syringes. 

OR

Right-click any of the probe numbers in Use Probes and make a selection from 
the menu. Options include:

• Use Disposable Tips — selects all probes with disposable tips

• Use Fixed Tips — selects all probes with fixed tips

• Use Selection — allows for custom selection

Note:  If the probes selected are equipped with fixed tips, the Load and unload 
them/leave them on options (steps 4 to 6) are unavailable and the fixed tips are 
used for the transfer. Proceed to step 7.

Note:  Disposable tips are selected by default. If the pod has only fixed tips, all 
fixed tips are selected by default. For example, if the pod is equipped with fixed 
tips on probes 1-4 and disposable tips on probes 5-8, probes 5-8 are selected by 
default. However, if probes 5-8 are also equipped with fixed tips, all eight probes 
are selected by default.

3. If Tip Handling is not already displayed, click the arrow or sentence summary to 
expand the Tip Handling configuration (Figure 15-20).

4. Select Load to load new tips at the start of the Transfer or Combine step. 

Note:  If Load is not selected, the Transfer or Combine step uses previously 
loaded tips, rather than loading new tips at the start of the step. 

If Load is selected and the tips loaded to the pod have been used, an error may 
occur. To increase the number of uses allowed for tips, increase the Usages 
count in the Labware Properties configuration in the Instrument Setup step 
(refer to Section 15.2.5, Configuring Tip and Labware Properties).

5. If Load is selected, select the type of tips to load from the drop-down list, or 
from the Current Deck Display. 

Note:  If tips are selected from the Current Deck Display, and the tips are named, 
Load displays the name, not the tip type. If a name was not assigned to the tips, 
the tip type is displayed in Load.

It is recommended that tips not be named in the Instrument Setup step, because 
this could restrict the instrument from locating available tips.
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6. To return tips to the tip box after the Transfer or Combine step is completed, 
select unload them.

OR

To leave tips on after the Transfer or Combine steps is completed, select leave 
them on.

Note:  To conserve tips when using the Transfer or Combine steps within a 
Loop step, uncheck Load and select leave them on (steps 4 and 6 above). Add 
a New Tips step to the method prior to the Loop step, and an Unload Tips step 
after the Loop. This loads new tips before the Loop step, uses the same set of tips 
for all Transfer or Combine steps completed as part of the Loop, and unloads 
the tips when the Loop step is completed. 

7. Choose Wash tips in to use a Multichannel Channel Tip Wash ALP to wash 
disposable or fixed tips.

3000 — Options to wash tips are not available. Proceed to step 15.

Note:  If Wash tips in is not selected, proceed to step 11.

Note:  A Multichannel Tip Wash ALP must be added to the deck and configured 
in the Deck Editor before washing can occur. Clicking on the ALP while the 
Transfer and Combine steps is being configured places a check in Wash tips 
in, and populates Wash tips in with the solution configured for the Multichannel 
Tip Wash ALP in Labware Properties on the Instrument Setup step (refer to 
Section 15.2.5, Configuring Tip and Labware Properties).

8. In Wash tips in, select a solution for the wash cycle if the field does not already 
contain a solution.

Note:  The wash solution specified in the Transfer and Combine steps must 
match the solution selected in the Multichannel Tip Wash ALP configuration, or 
an error occurs.

9. Choose the number of cycles to aspirate and dispense during wash.

10. In %, provide the maximum volume of fluid contained in the tips in previous 
steps; for example, if the maximum volume of fluid transferred is 50 µL, and the 
% is set for 110%, the Transfer and Combine steps washes the tips with 55 µL 
of solution.

Note:  If the % sign is deleted in the % field, the field label changes to µL. Any 
value entered is now interpreted as a specific volume, not a percentage.

11. If using a Span-8 Pod on FX or NX-S8, choose Wash tips with to use the 
passive Span-8 Tip Wash ALP to wash fixed tips.

Note:  Only fixed tips can be washed with the Span-8 Tip Wash ALP. If using 
disposable tips or Wash tips with is not selected, proceed to step 15.

Note:  A Span-8 Tip Wash ALP must be added to the deck and configured in the 
Deck Editor before washing can occur. Clicking on a Span-8 Tip Wash ALP 
while the Transfer step is being configured places a check in Wash tips with, 
and uses default values of 2 mL of system liquid after dispensing 1 mL to 
waste.
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12. In Wash tips with, enter the volume of system fluid to use when washing the 
outside of the tips.

13. In after dispensing, enter the volume of system fluid to use when washing the 
inside of the tips.

14. If using a Span-8 Pod on FX, select Speed Pump to use the speed pump when 
flushing the tips with system fluid, if desired.

OR

If using a Span-8 Pod on NX-S8, select purge pump to use the purge pump 
when flushing tips with system fluid, if desired.

Note:  The speed pump or purge pump is an optional device that can be used to 
shorten the time it takes to wash tips. A speed pump or purge pump must be 
added as a device and configured with the Span-8 Pod in Hardware Setup to 
use it when washing tips.

15. If using a Multichannel Pod on FX or NX-MC, or a 3000, select Change/Wash 
tips between sources, to change or wash tips each time a new source well is 
accessed. 

3000 — Tips can only be changed.

Note:  Change/Wash tips between sources changes or washes tips any time 
it is required to aspirate liquid from a different well or wells than the previous 
aspirate operation. For example, if aspirating from quadrants of a 384-well 
microplate with a 96-channel head, Biomek Software instructs the instrument to 
use new tips when aspirating from each quadrant.

16. If using a Multichannel Pod on FX or NX-MC, or a 3000, select Change/Wash 
tips between destinations, to change or wash tips each time a new 
destination well is accessed.

3000 — Tips can only be changed.

Note:  Change/Wash tips between destinations changes or washes tips after 
all dispense operations, except the last. Tips are removed after the last dispense 
operation only if unload them is selected in Tip Handling. If there is only one 
Destination Labware configured, Change tips between destinations does 
not change tips. 

17. If using a Span-8 Pod on FX or NX-S8, select Change/Wash tips between 
transfers, to change or wash tips between each liquid transfer.
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The Tip Handling configuration can be collapsed to allow more room during Source 
and Destination Labware configuration. When collapsed, the tip handling 
configuration is displayed as a sentence summary (Figure 15-21). Use the sentence 
summary to verify that tip handling has been configured appropriately.

To collapse or expand the Tip Handling configuration, click the arrow to the left of 
Tip Handling or the textual display (Figure 15-21).

Figure 15-21.  Combine step — Adding Source Labware

Click here to add Source Labware. 
The Source Labware configuration 
opens.

Collapsed Tip Handling 
configuration

Arrow to collapse/
expand Tip Handling
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15.3.2 Configuring Source Labware
A ‘source’ is a group of wells accessed at one time by the Biomek instrument to 
aspirate liquid; for example:

FX, NX-MC — A Multichannel Pod aspirates from either 96 or 384 wells at 
a time, depending on the head installed.

Note: If configuring a 384-well microplate using a 96-channel pod or a 
1536-well microplate using a 384-channel pod as source labware, any 
combination of quadrants may be used. For example, if it is desired to 
transfer liquid from the first, second, and third quadrants but not the fourth, 
the source labware may be configured to transfer only from those quadrants.

FX, NX-S8— A Span-8 Pod aspirates from one to eight wells at a time, 
depending on the selected probes.

3000 — Depending on the tool loaded onto the head assembly, aspirates 
from either 1 or 8 wells at a time.

Note:  If there are multiple sources in a Combine step, each source may have a 
different volume transferred, but all wells on each source must have the same volume 
transferred. To transfer different volumes from wells or quadrants on the same 
microplate, configure multiple sources using the same source plate but specifying 
different well or quadrants and volumes.

The Source Labware configuration for the Transfer and Combine steps includes 
specifying:

• Labware type

• Labware location

• Liquid amount to transfer (for Combine step only)

• Liquid type

• Well pattern or quadrants to access

Note: Quadrants are applicable only when accessing a 384-well 
microplate using a 96-channel pod or a 1536-well microplate using a 384-
channel pod.

• Technique selection

• Pipetting height

Note:  A single source is configured for the Transfer step, because the Transfer step 
moves liquid from a single source to one or more destinations. Multiple sources can 
be configured for the Combine step, because the Combine step moves liquid from 
multiple sources to a single destination. 
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To configure Source Labware for the Transfer and Combine steps:

1. Select Click here to add a source (Figure 15-21). The Source Labware 
configuration appears. 

2. Click on the desired piece of labware in the Current Deck Display. The labware 
type and position for that piece of labware is entered automatically into the 
Source Labware configuration.

Note:  If the selected labware is named, the name of the labware appears instead 
of the deck position.

OR

Select a Source Labware (Figure 15-22) type and specify the deck position.

Note:  To configure additional Source Labware for a Combine step, select 
Click here to add a source, and then select another piece of labware from the 
Current Deck Display. A Destination labware must be configured before 
configuring additional source labware. If an incorrect piece of labware is 
selected, right-click on the labware title and select Delete on the menu that 
appears, or change the Source Labware selection by clicking anywhere in the 
source labware configuration area, and selecting another piece of labware.

Figure 15-22.  Combine step — Source Labware configuration

3. Verify the deck position of the labware. 

Note:  A bright blue outline appears in the Current Deck Display around the 
labware designated as the Source Labware.

Deck position selection

Source labware configuration

Source labware title

Current Deck Display
The Current Deck 
Display is used for 
labware selection, and it 
displays the status of the 
deck upon completion of 
the previous step. 

Source Labware selection
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4. To specify the wells or quadrants in a microplate to access, double-click the 
source labware in the step configuration to zoom in on the labware (Figure 15-
23). 

Note:  To call up a menu for Zoom and a Specify Selection as Text option, 
right-click on the labware. 

Specify Selection as Text allows selection of wells or quadrants as targets for 
aspirate and dispense operations. Specify Selection as Text may also be used to 
enter variables or expressions.

Note:  Specify Selection as Text is not applicable for 96-well microplates, 
reservoirs, or 384-well microplates accessed by a 384-channel pod.

Figure 15-23.  Transfer Step — Zoomed-in Source Labware configuration

FX, NX-MC — Using a Multichannel Pod, some options are not available

3000 — Using a Multi-Tip Pipette Tool, some options are not available.

Start
Select the first 
well accessed.

Use pattern
Use a well pattern 
created using the 
Define Pattern step.

Direction
Select the 
direction in 
which wells 
are accessed.

Copy pattern
Use a well pattern created in 
the Well Patterns Editor.

Mark last well 
that is used

This option will 
mark the last 
well accessed 
when the step is 
completed.
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5. Select the wells from which to transfer using one of the following techniques:

FX, NX-MC — A Multichannel Pod can only select quadrants of a 
microplate.

FX, NX-S8 — A Span-8 Pod can select individual wells.

3000 — A multi-tip pipette tool always selects groups of wells in columns 
of 8 while a single-tip pipette tool can select individual wells. 

• Choose Copy Pattern and select the desired pattern to use a 
previously defined well pattern created using the Well Patterns Editor 
(refer to Chapter 11, Creating Well Patterns). 

Note: The pattern must be compatible with the head or tool installed 
and the labware type.

• Select Use pattern and choose the previously defined pattern from the 
list to use a pattern created in a Well Patterns Editor or Define 
Pattern step.

Note: Refer to Section 18.10, Define Pattern Step (including 3000), 
for more information about creating patterns using the Define Pattern 
step.

• Define a well pattern using data sets (refer to Section 14.3.1, Defining 
Well Patterns Using Data Sets).

• Create a custom well pattern from the labware grid by dragging the 
mouse and using Ctrl and Shift on the keyboard. 

Note: Hold Shift and click a well to select additional wells without 
deselecting any wells. Hold Ctrl and click a well to toggle the selection 
status of selected wells without affecting the status of other wells. If 
Shift or Ctrl is not held down when selecting wells, any previous 
selection is deleted.

Note:  To save the new pattern, right click the labware graphic and select Save 
Pattern from the menu. Enter a name for the pattern in New Pattern and 
choose OK.
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6. Select the Direction in which source wells are mapped to destinations. Down 
first, then left to right is the default selection.

FX, NX-S8 — Direction options only apply when using a Span-8 Pod.

Note:  Direction controls how source wells are mapped to the destination, not 
the physical order in which wells are transferred. The Transfer step 
automatically determines the most efficient way to complete the transfer.

• Down first, then left to right — goes down each column from top to 
bottom, then goes right to the next column (Figure 15-24)

Figure 15-24.  Wells accessed down first, then left to right

OR

• To the right first, then top to bottom — goes across each row from 
left to right, then goes down to the next row (Figure 15-25)

Figure 15-25.  Wells accessed to the right first, then top to bottom

 
Note:  The direction can also be selected when the labware is zoomed out by 
using the Down, then right or Right, then down buttons beneath the labware.

1

2

3

4

5

6

7

8

Down first, then left to right
Wells are mapped to destination 
labware in the order indicated, 
going down each column and then 
moving to the right to the next 
column.

1 5 6

7 8

To the right first, then top to bottom
Wells are mapped to the destination labware in the 
order indicated, going across each row and then 
moving down to the next row.

2 3 4
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7. Select the first well accessed in Start. At first selected well is the default 
selection.

FX, NX-S8 — Start options only apply when using a Span-8 Pod.

Note:  Start controls how source wells are mapped to the destination, not the 
physical order in which wells are transferred. The Transfer step automatically 
determines the most efficient way to complete the transfer.

• At first selected well — moves in the selected Direction starting 
from the first well selected on the labware

OR

• After last marked well — moves in the selected Direction starting 
from the first selected well on the labware after the marked well

Note: The selected labware must have marks from a previous step with 
Mark last well that is used selected.

 
Note:  The start location can also be selected when the labware is zoomed out by 
using the Start at selection or Start at last mark buttons beneath the labware.

Note:  When transferring liquid, the first accessed source well is transferred to 
the first accessed destination well, the second accessed source well is transferred 
to the second accessed destination well, and so forth.

8. De-select Mark last well that is used, if it is not desired to mark wells. This 
option must be selected to use any options later in the method that make use of 
marks. For example, if Mark last well that is used is selected and the Transfer 
step runs out of sources before using all destinations, it marks the last well that 
had liquid transferred to it. Another Transfer step is transferring liquid to the 
same plate. By selecting After last marked well as the Start condition, the 
first source well will be transferred to the first unused destination well and 
continue according to the specified Direction. Mark last well that is used is 
selected by default. 

3000— Marks only apply when using a single-tip pipette tool.

Note:  Mark last well that is used can also be selected when the labware is 
zoomed out by using the Set mark button beneath the labware.

9. Choose Zoom Out to return to the step configuration screen.

10. For a Combine step, enter the amount of liquid (µL) to aspirate from the Source 
Labware. This will also be the amount of liquid dispensed into the destination 
labware. If using a variable or expression, enter an equal sign (=) followed by the 
variable name or expression; for example, =AspValue (Figure 15-26). 

Note:  Refer to Section 14.3.2, Specifying Volumes Using Data Sets, for 
information on specifying volumes using a data set.
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11. In Using liquid type, select the type of liquid in the Source Labware
(Figure 15-26).

Figure 15-26.  Combine step — Source Labware configuration 

12. Keep the auto-selected Technique (refer to Section 15.3.2.1, Auto-Selection of 
a Technique).

Note:  The software automatically selects a Technique based on the liquid type, 
labware type, tip type, and volume being aspirated. 

OR

Manually select the desired Technique, or customize the selected Technique 
(refer to Section 15.3.2.2, Customizing and Saving a Technique). 

Liquid type selection

Technique selection

Adjust aspirate height

Overrides Technique
Indicates that the height of the 
tip has been manipulated.

Tip height
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13. Leave the height as is to use the settings specified in the pipetting technique.

OR

Set the aspirate height manually using one of the following techniques:

• Set the aspirate height by positioning the cursor over the graphic of a tip 
inside a well (Figure 15-26). Click and drag the graphic up or down. The 
tip moves with the cursor, and the height displayed below the graphic is 
adjusted as the graphic is manipulated.

Note: The cursor changes to a hand when positioned over the 
graphic. 

• Position the cursor in the graphic of a tip inside a well, and adjust the 
height using the ↑ and ↓ keys.

• Right-click on the graphic of a tip inside a well, and a menu appears. 
Select Custom Height, and Custom Height appears (Figure 15-27). 
Insert the Height in millimeters (mm) and, in from, select a reference 
point from the drop-down list. 

Note:  The phrase (Overrides Technique) appears below the graphic when the 
tip height is changed by manipulating the graphic (Figure 15-26), or when the 
technique is changed with the Customize option.

Figure 15-27.  Custom Height prompt

14. For a Combine step, repeat steps 1 to 13 for each Source Labware desired.

Note:  A Destination Labware must first be selected before additional Source 
Labware can be configured.

15.3.2.1 Auto-Selection of a Technique
Auto-Select option is the default setting in the Transfer and Combine steps 
configuration. Disabling Auto-Select provides access to a list of predefined 
techniques, as well as allowing access to the Technique Editor so changes can be 
made to existing techniques.

Note:  For more information on creating, editing, and saving techniques, refer to 
Section 15.3.2.2, Customizing and Saving a Technique, and Chapter 9, Understanding 
and Creating Techniques.
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15.3.2.2 Customizing and Saving a Technique
Disabling Auto-Select provides access to a list of predefined techniques, as well as 
allowing access to the Technique Editor so changes can be made to existing 
techniques.

Note:  For more information on creating, editing, and saving techniques, refer to 
Chapter 9, Understanding and Creating Techniques.

To select a Technique other than the technique selected automatically by Biomek 
Software:

1. Uncheck Auto-Select. The Technique: field is activated. 

2. Select a Technique: from the list of predefined techniques.

3. Click Customize to modify the technique, if desired. The Technique Editor 
appears (Figure 15-28). 

Figure 15-28.  Technique Editor — Dispense options

Note:  The Aspirate tab is virtually the same as the Dispense tab, with the 
exception of the Aspirate a trailing air gap after leaving the liquid and 
Prewet the tips pipetting options which appear on the Aspirate tab. When 
dispense operations are being configured, only the Dispense tab is displayed, 
while the Aspirate tab is displayed only when configuring aspirate operations. 
The Liquid Level Sensing tab only appears if the pod or tool supports liquid 
level detection.

4. Make desired changes in the applicable tabs of the Technique Editor.
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5. Click OK to save the edited technique and return to the Transfer and Combine 
steps.

6. Click Save As to save an edited technique for use in this method and others. 

Note:  If Save As is not selected, the technique is saved with the current 
method, but it is not accessible to other methods or other steps within the current 
method.

15.3.3 Configuring Destination Labware
A ‘destination’ is a group of wells accessed at one time by the Biomek instrument to 
dispense liquid; for example:

FX, NX-MC — A Multichannel Pod aspirates from either 96 or 384 wells at 
a time, depending on the head installed.

Note: If configuring a 384-well microplate using a 96-channel pod or a 
1536-well microplate using a 384-channel pod as source labware, any 
combination of quadrants may be used. For example, if it is desired to 
transfer liquid from the first, second, and third quadrants but not the fourth, 
the source labware may be configured to transfer only from those quadrants.

FX, NX-S8 — A Span-8 Pod dispenses to one to eight wells at a time, 
depending on the selected probes.

3000 — Depending on the tool loaded onto the head assembly, aspirates 
from either 1 or 8 wells at a time.

Note:  If there are multiple destinations, each destination may have a different 
volume transferred, but all wells on each destination must have the same volume 
transferred. For example, to transfer different volumes to quadrants on the same 384-
well plate, configure multiple destinations using the same destination plate but 
specifying different quadrants and volumes.

The Destination Labware configuration for the Transfer and Combine steps 
includes specifying:

• Labware type

• Labware location

• Liquid amount to transfer (for Transfer step only)

• Liquid type

• Well pattern or quadrants to access

Note: Quadrants are applicable when accessing a 384-well microplate 
using a 96-channel pod or a 1536-well microplate using a 384-channel pod.

• Technique selection

• Pipetting height

Note:  Multiple destinations can be configured for the Transfer step, because the 
Transfer step moves liquid from a single source to one or more destinations. A single 
destination is configured for the Combine step, because the Combine step moves 
liquid from one or more sources to a single destination.
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To configure Destination Labware for the Transfer and Combine steps:

1. Select Click here to add a destination (Figure 15-29). The Destination 
Labware configuration appears.

Figure 15-29.  Transfer step — adding destination labware

Click this button to add Destination 
Labware and open the Destination 
Labware configuration.

Configured Source Labware
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2. Click on the desired piece of labware in the Current Deck Display. The labware 
type and position for that piece of labware is entered automatically into the 
Destination Labware configuration.

Note:  If the selected labware is named, the name of the labware appears instead 
of the deck position.

OR

Select a Destination Labware (Figure 15-30) type and deck position.

Note:  Once the first Destination Labware has been selected, the Source 
Labware parameters are collapsed to display a sentence summary. To reopen the 
Source labware parameters, click anywhere in the Source Labware 
configuration area.

Note:  Subsequent labware selections modify the active Source or Destination 
Labware configuration. To configure additional Destination Labware, select 
Click here to add a destination, or select outside a labware configuration, 
and then select another piece of labware from the Current Deck Display. If an 
incorrect piece of labware is selected, right-click on the labware title and select 
Delete on the menu that appears.

Figure 15-30.  Transfer step — destination labware configuration

3. Verify the deck position of the labware. 

Note:  A bright yellow outline appears in the Current Deck Display around the 
labware designated as the Destination Labware.

Destination labware 
configuration

Current Deck Display
Displays the status of the 
deck upon completion of 
the previous step. Also 
useful for labware 
selection.

Select Destination 
Labware type

Deck position selection

Additional Destination 
Labware

Continue adding 
Destination Labware by 
clicking this button, or by 
selecting more labware in 
the Current Deck Display.
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4. To specify the wells or quadrants of a microplate to access, double-click the 
source labware in the step configuration to zoom in on the labware. 

Note:  To call up a menu for Zoom and a Specify Selection as Text option, 
right-click on the labware. 

Specify Selection as Text allows selection of wells or quadrants as targets for 
aspirate and dispense operations. Specify Selection as Text may also be used to 
enter variables or expressions.

Note:  Specify Selection as Text is not applicable for 96-well microplates, 
reservoirs, or 384-well microplates accessed by a 384-channel pod.

5. Select the wells from which to transfer using one of the following techniques:

FX, NX-MC — A Multichannel Pod can only select quadrants of a 
microplate.

FX, NX-S8 — Can select individual wells.

3000 — A multi-tip pipette tool always selects groups of wells in columns 
of 8 while a single-tip pipette tool can select individual wells. 

• Choose Copy Pattern and select the desired pattern to use a 
previously defined well pattern created using the Well Patterns Editor 
(refer to Chapter 11, Creating Well Patterns). 

Note: The pattern must be compatible with the head or tool installed.

• Select Use pattern and choose the previously defined pattern from the 
list to use a pattern created in a Well Patterns Editor or Define 
Pattern step.

Note: Refer to Section 18.10, Define Pattern Step (including 3000), 
for more information about creating patterns using the Define Pattern 
step.

• Define a well pattern using data sets (refer to Section 14.3.1, Defining 
Well Patterns Using Data Sets).

• Create a custom well pattern from the labware grid by dragging the 
mouse and using Ctrl and Shift on the keyboard. 

Note: Hold Shift and click a well to select additional wells without 
deselecting any wells. Hold Ctrl and click a well to toggle the selection 
status of selected wells without affecting the status of other wells. If 
Shift or Ctrl is not held down when selecting wells, any previous 
selection is deleted.

Note:  To save the new pattern, right click the labware graphic and select Save 
Pattern from the menu. Enter a name for the pattern in New Pattern and 
choose OK.
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6. Select the Direction in which source wells are mapped to destinations. Down 
first, then left to right is the default selection.

FX, NX-S8 — Direction options only apply when using a Span-8 Pod.

Note:  Direction controls how source wells are mapped to the destination, not 
the physical order in which wells are transferred. The Transfer step 
automatically determines the most efficient way to complete the transfer.

• Down first, then left to right — goes down each column from top to 
bottom, then goes right to the next column (Figure 15-31)

Figure 15-31.  Wells accessed down first, then left to right

OR

• To the right first, then top to bottom — goes across each row from 
left to right, then goes down to the next row (Figure 15-32)

Figure 15-32.  Wells accessed to the right first, then top to bottom

 
Note:  The direction can also be selected when the labware is zoomed out by 
using the Down, then right or Right, then down buttons beneath the labware.

1

2

3

4

5

6

7

8

Down first, then left to right
Wells are mapped to destination 
labware in the order indicated, 
going down each column and then 
moving to the right to the next 
column.

1 5 6

7 8

To the right first, then top to bottom
Wells are mapped to the destination labware in the 
order indicated, going across each row and then 
moving down to the next row.

2 3 4
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7. Select the first well accessed in Start. At first selected well is the default 
selection.

FX, NX-S8 — Start options only apply when using a Span-8 Pod.

Note:  Start controls how source wells are mapped to the destination, not the 
physical order in which wells are transferred. The Transfer step automatically 
determines the most efficient way to complete the transfer.

• At first selected well — moves in the selected Direction starting 
from the first well selected on the labware

OR

• After last marked well — moves in the selected Direction starting 
from the first selected well on the labware after the marked well

Note: The selected labware must have marks from a previous step with 
Mark last well that is used selected.

 
Note:  The start location can also be selected when the labware is zoomed out by 
using the Start at selection or Start at last mark buttons beneath the labware.

Note:  When transferring liquid, the first accessed source well is transferred to 
the first accessed destination well, the second accessed source well is transferred 
to the second accessed destination well, and so forth.

8. De-select Mark last well that is used, if it is not desired to mark wells. This 
option must be selected to use any options later in the method that make use of 
marks. For example, if Mark last well that is used is selected and the Transfer 
step runs out of sources before using all destinations, it marks the last well that 
had liquid transferred to it. Another Transfer step is transferring liquid to the 
same plate. By selecting After last marked well as the Start condition, the 
first source well will be transferred to the first unused destination well and 
continue according to the specified Direction. Mark last well that is used is 
selected by default.

FX, NX-S8 — Marks only apply when using a Span-8 Pod.

Note:  Mark last well that is used can also be selected when the labware is 
zoomed out by using the Set mark button beneath the labware.

9. Choose Zoom Out to return to the step configuration screen.
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10. For a Transfer step, enter the amount of liquid (µL) to dispense into the 
Destination Labware. This will also be the amount of liquid aspirated from the 
source labware. If using a variable or expression, enter an equal sign (=) followed 
by the variable name or expression; for example, =AspValue (Figure 15-33).

Note:  Refer to Section 14.3.2, Specifying Volumes Using Data Sets, for 
information on specifying volumes using a data set.

Figure 15-33.  Transfer step — destination labware technique configuration 

11. Verify that the liquid type indicated is correct. The liquid type dispensed to the 
Destination Labware should match the liquid type in the Source Labware 
configuration.

12. Keep the auto-selected Technique (refer to Section 15.3.2.1, Auto-Selection of 
a Technique).

Note:  The software automatically selects a Technique based on the liquid type, 
labware type, tip type, and volume being aspirated. 

OR

Manually select the desired Technique, or customize the selected Technique 
(refer to Section 15.3.2.2, Customizing and Saving a Technique).

Liquid type selection

Technique selection

Adjust dispense height

Continue adding 
Destination Labware by 
clicking this button, or by 
selecting more labware in 
the Current Deck Display.

Amount to dispense



Using the Basic Step Palette 15-51

Biomek Software User’s Manual

13. Leave the height as is to use the settings specified in the pipetting technique.

OR

Set the dispense height manually using one of the following techniques:

• Set the dispense height by positioning the cursor over the graphic of a 
tip inside a well (Figure 15-33). Click and drag the graphic up or down. 
The tip moves with the cursor, and the height displayed below the 
graphic is adjusted as the graphic is manipulated.

Note: The cursor changes to a hand when positioned over the 
graphic. 

• Position the cursor in the graphic of a tip inside a well, and adjust the 
height using the ↑ and ↓ keys.

• Right-click on the graphic of a tip inside a well, and a menu appears. 
Select Custom Height, and Custom Height appears (Figure 15-27). 
Insert the Height in millimeters (mm) and, in from, select a reference 
point from the drop-down list. 

Note:  The phrase (Overrides Technique) appears below the graphic when the 
tip height is changed by manipulating the graphic, or when the technique is 
changed with the Customize option.

14. For a Transfer step, repeat steps 1 to 13 for each additional piece of Destination 
Labware.

15.3.3.1 Auto-Selection of a Technique
Auto-Select option is the default setting in the Transfer and Combine steps 
configuration. Disabling Auto-Select provides access to a list of predefined 
techniques, as well as allowing access to the Technique Editor so changes can be 
made to existing techniques.

Note:  For more information on creating, editing, and saving techniques, refer to 
Section 15.3.2.2, Customizing and Saving a Technique, and Chapter 9, Understanding 
and Creating Techniques.

15.3.3.2 Customizing and Saving a Technique
Disabling Auto-Select provides access to a list of predefined techniques, as well as 
allowing access to the Technique Editor so changes can be made to existing 
techniques.

Note:  For more information on creating, editing, and saving techniques, refer to 
Chapter 9, Understanding and Creating Techniques.

To select a Technique other than the technique selected automatically by Biomek 
Software:

1. Uncheck Auto-Select. The Technique: field is activated. 

2. Select a Technique: from the list of predefined techniques.
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3. Click Customize to modify the technique, if desired. The Technique Editor 
appears (Figure 15-34). 

Note:  refer to Chapter 9, Understanding and Creating Techniques, for more 
information about the Technique Editor.

Figure 15-34.  Technique Editor — Dispense options

Note:  The Aspirate tab is virtually the same as the Dispense tab, with the 
exception of the Aspirate a trailing air gap after leaving the liquid and 
Prewet the tips pipetting options which appear on the Aspirate tab. When 
dispense operations are being configured, only the Dispense tab is displayed, 
while the Aspirate tab is displayed only when configuring aspirate operations.

Note:  If the pod performing the pipetting operation is a Span-8 Pod, there is an 
additional Liquid Level Sensing tab displayed as part of the Technique Editor.

4. Make desired changes in the applicable tabs of the Technique Editor.

5. Click OK to save the edited technique and return to the Transfer and Combine 
steps.

6. Click Save As to save an edited technique for use in this method and others. 

Note:  If Save As is not selected, the technique is saved with the current 
method, but it is not accessible to other methods or other steps within the current 
method.
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15.3.4 Configuring Transfer Details
Transfer Details (Figure 15-35) includes specifying:

• a stop condition for transfer operations.

• the number of replicates 

FX, NX-S8 — Replicates are available only with a Span-8 Pod.

• a repeat pipetting configuration.

• a maximum tolerance in timing between transfer operations (Figure 15-36).

Figure 15-35.  Transfer step — additional Transfer Details

Stop Condition
The stop option controls 
when the liquid transfer 
operation stops: after all 
destination labware has 
been used, or after all 
source labware has been 
used.

Repeat pipetting 
configuration

The repeat pipetting 
option controls how many 
dispense operations are 
allowed per aspirate 
operation.

Advanced Option
The Advanced option provides access 
to a Just-In-Time (JIT) configuration 
option for the Transfer and Combine 
steps. JIT specifies the maximum 
tolerance in timing between transfer 
operations.

Replicates
The number of destination 
wells to which each source 
well is transferred.
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To configure Transfer Details for the Transfer and Combine steps:

1. Click the arrow or sentence summary below the labware configuration section to 
expand Transfer Details.

2. In Stop when finished with, choose to determine when the liquid transfer 
operation stops: after Sources, Destinations, or Either.

• Sources — the Transfer or Combine is complete when it runs out of 
sources

• Destinations — the Transfer or Combine is complete when it runs 
out of destinations

• Either — the Transfer or Combine is complete when it runs out of 
either sources or destinations

Note:  The default setting for Stop when finished with is Destinations to 
avoid cross contamination.

Note:  If there are more source wells than destination wells and Stop when 
finished with is set to Sources, after dispensing to the final destination it will 
go to the first selected destination and continue until it runs out of sources. If 
Destinations is selected, it will stop after dispensing to the last destination and 
not use the remaining sources. If Either is selected, it will stop after dispensing 
to the last destination and not use the remaining sources.

If marks are being used, the last source and/or destination wells used will be 
marked. Future operations may continue from the marked wells.

3. In Replicate each well, enter the number of destination wells to transfer each 
source well to. Each source well is transferred to the specified number of 
consecutive destination wells.

FX, NX-S8 — Replicates are available only with a Span-8 Pod.

4. Select one of the repeat pipetting configuration options: Dispense up to or 
Aspirate at most.

Note:  If Tip Handling is configured to Change tips between destinations, 
the repeat pipetting options are unavailable for selection. 

Note:  Only one repeat pipetting option may be selected. Either Dispense up to 
or Aspirate at most may be selected, but not both.

5. In Dispense up to, select the number of times the instrument is allowed to 
dispense per draw (aspirate). For example, if dispensing 75 µL to each of six 
microplates, three aspirate operations of 150 µL can each dispense into two 
destinations. In this case, Dispense up to is set to no fewer than two.

Note:  The default setting in Dispense up to is one, which does not allow a 
repeat pipetting operation. Settings of two or more allow repeat pipetting.

OR

In Aspirate at most, select the maximum volume to aspirate from the source 
for repeat pipetting. For example, if dispensing 75 µL to each of six microplates, 
three aspirate operations of 150 µL can each dispense into two destinations. In 
this case, Aspirate at most is set to no less than 150 µL.
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6. In Replicates, enter the number of times each source well should be transferred 
to the destination labware. For example, if Replicates is set at 3, the first source 
well is transferred to the first three destination wells; the second source well is 
transferred to the next three destination wells; and so forth.

7. Select Advanced to change the default setting of applying a Just-In-Time (JIT) 
block to aspirate and dispense operations. Just In Time synchronizes the 
execution of the substeps within the Transfer or Combine step. The Advanced 
Options prompt appears (Figure 15-36).

Figure 15-36.  Advanced button — JIT Block

8. Uncheck Tie Aspirate to Dispense with a JIT Block to deactivate the JIT 
block.

9. Click OK to save any changes.

The Transfer Details configuration can be collapsed to allow more room during 
Source and Destination Labware configuration. When collapsed, the Transfer 
Details configuration is displayed as a sentence summary. Use the sentence summary 
to verify that Transfer Details has been configured appropriately.

To collapse or expand the Transfer Details configuration, click the arrow to the left 
of Transfer Details or the textual display.
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15.4 Move Labware Step
3000 — The gripper tool is required to move labware.

NX-S8 — The optional gripper must be installed to move labware.

The Move Labware step moves labware from one position on the Biomek 
instrument deck to another position. Move Labware can also remove labware from 
the deck by placing it in an appropriate disposal position, or to an external hardware 
device without halting the Biomek instrument or the method. 

15.4.1 Inserting a Move Labware Step
Insert a Move Labware step into the Method View (Figure 15-37).

Figure 15-37.  Move Labware step and configuration

Move Labware step configuration
The stacking options configure how labware is 
moved from stacks on the deck.

Current deck display
The origination position 
is outlined in blue. The 
destination location is 
outlined in yellow.
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15.4.2 Configuring the Move Labware Step 
CAUTION: Make sure the correct ALP is chosen when configuring the 
deck setup in the Deck Editor. ALPs vary in height, and failure to choose 
each ALP correctly in the software may result in collisions between 
pod(s) and ALPs during operation.
To configure a Move Labware step, complete the following steps:

3000 — To use the Move Labware step with the Biomek 3000, a gripper 
tool must be added and configured in Hardware Setup (refer to the 
Biomek® 3000 Laboratory Automation Workstation User’s Manual, Section 
12.3, Adding and Removing Tools and Devices) and placed on a tool rack in 
an Instrument Setup step (refer to Section 15.2, Instrument Setup Step).

1. If using a dual-pod FX instrument, specify the Pod to move the labware in Using 
Pod. The pod configured as the default pod is automatically selected. If the other 
pod is desired, select the pod from the drop-down list or the Current Deck 
Display.

2. In Move labware from, select the original deck position for the labware from 
the Current Deck display. This instructs the Biomek instrument to Move 
labware from a specific deck position in preparation for leaving it at a final 
destination.

3. In to, select the final deck position for the labware from the Current Deck 
display. This instructs the Biomek instrument to move the labware to a final deck 
position.

4. Select the desired option for moving stacked labware:

FX, NX-MC — Gripper on the Multichannel Pod can move up to four plates 
at a time. 

NX-S8 — The optional gripper, if installed, can move up to four plates at a 
time.

3000 — Gripper tool can move up to three microplates at a time. 

• Move the entire stack of labware — moves all labware in the 
stack; this option should be selected when moving a single unstacked 
piece of labware.

• Move stack, leaving the bottom piece of labware at the 
source position — moves all labware in the stack except for the 
bottom piece.

Note: Selecting Move stack, leaving the bottom piece of labware 
at the source position when the source deck position contains only 
one piece of labware results in an error. 

• Move the topmost . . .piece(s) of labware from the stack — 
moves only the specified number of labware from the top of the stack. 

Note:  Refer to Section 7.3.6.4.1, Biomek Stacking Rules, for complete 
information on using stacks on Biomek instruments.
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15.5 Pause Step
The Pause step is used to either halt a deck position or device during a method for a 
specified amount of time, or pause the instrument for an indefinite period of time. 
During the pause, the instrument may still move and act on other deck positions. 
Depending on the purpose of the pause, the step can be configured in one of two 
ways:

• To incubate a piece of labware in a specific position for a specific amount of 
time, configure the desired time in seconds to hold that position idle and 
unavailable for interaction with the instrument (Figure 15-38). Refer to 
Section 15.5.1, Configuring a Pause for a Specific Deck Position or Pod.

• To manipulate the deck by hand during a method, configure the step to pause 
the instrument for an indefinite period of time (Figure 15-40). When the 
Pause step halts the instrument, the amber indicator lights on the front of 
the unit are activated, and a prompt appears. The prompt displays the text 
inserted in the Pause step configuration and requires acknowledgement 
before the method continues. Refer to Section 15.5.2, Pausing the Whole 
System and Displaying a Message.

Note:  When the Pause step occurs during a method run, the Biomek pod remains in 
the position of the last action completed before the pause. If the purpose of the Pause 
step is to move labware on or off the deck, a Move Pod step must be inserted in the 
method prior to the Pause step so that the pod is out of the way (refer to Section 
16.11, Move Pod Step).
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Insert a Pause step into the Method View (Figure 15-38). 

Figure 15-38.  Inserting a Pause step in a method

Method View
When pausing a specific 
deck position, the Pause 
step indicates the deck 
position affected and the 
length of the pause. Current Deck 

Display
The Current Deck 
display outlines the 
affected deck 
position in blue.
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15.5.1 Configuring a Pause for a Specific Deck 
Position or Pod

To configure a Pause for a specific deck position:

1. Choose Pause in the Pause step configuration (Figure 15-38).

2. In Pause, select the deck position or pod in the Current Deck Display or from 
the drop-down list (Figure 15-39).

Note:  To pause the instrument for a specified length of time, select the whole 
system in Pause.

Figure 15-39.  Pausing a deck position for a specified length of time

3. Choose the length of the pause, in seconds.

Note:  The method continues with operations not affected by the Pause, when 
possible. If the next step is dependent upon the deck position or pod paused, the 
method waits until the Pause has been completed.

Pause a deck position
To stop action on a piece of labware in a specific 
position for a specific amount of time (for example, to 
incubate), configure the desired time in seconds to 
hold that position idle and unavailable for interaction 
with the instrument. 
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15.5.2 Pausing the Whole System and Displaying 
a Message

To configure a Pause for the entire Biomek instrument and display a message:

1. Select Pause the whole system and display this message: in the Pause 
step configuration (Figure 15-40).

Figure 15-40.  Pause step that provides instruction

2. Enter the message to display when the Pause is initiated.

Note:  When Pause the whole system and display this message: is 
selected, a prompt (Figure 15-41) appears in the Biomek Software with the text 
entered in the Pause step configuration. When the action requested is 
completed, click OK to continue the method, or select Abort to halt the method 
without completing it.

Figure 15-41.  Pause message prompt

Pause the Biomek instrument
Configure the step to pause the whole system 
for an indefinite period of time; for example, to 
manipulate the deck by hand during a method.

Method View
When pausing the entire 
system, the Pause step 
indicates that a pause has 
been requested by the 
‘User’. A prompt appears 
when the method reaches 
the Pause step, asking 
for verification that the 
method can continue.



15-62 Using the Basic Step Palette

Beckman Coulter, Inc.

15.6 Comment Step
The Comment step documents a method and/or adds instructions in the Method 
View. Text inserted into the Comment step configuration may indicate the purpose of 
a segment of a method, prompt for an action, or convey any other desired information 
in the Method View. The Comment step does not initiate any actions on the Biomek 
instrument and is used only to provide descriptive information and notes to a method.

Note:  Comments are printed when a method is printed. Choose Print from the File 
menu to print a method (refer to Section 12.19, Printing a Method).

Insert a Comment step into the Method View (Figure 15-42).

To configure Comment:

1. In Description, enter short summary of the comment. The text entered in 
Description is used as the step caption in the Method View.

2. In Comment, enter the full text for the comment. 

3. Click the next step, and the Comment step in the Method View displays the text 
entered in Description (Figure 15-42).

Figure 15-42.  Comment step after text is inserted

Method View
The text entered in 
the Comment step 
configuration 
appears in the 
Method View.

Comment step configuration
Any text can be inserted into the 
Comment step configuration. The text 
inserted can be a directive, an 
identifier, a reminder, or descriptive.

Configured Comment step
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16 Using the Intermediate Step 
Palette

16.1 Overview
Steps on the Intermediate Step Palette provide individual control over liquid-handling 
functions outside the Transfer and Combine steps, including tip handling operations, 
flow of control, tip and tip box relocation options, and pod movement.

CAUTION: Make sure the correct ALP is chosen when configuring the 
deck setup in the Deck Editor. ALPs vary in height and failure to choose 
the correct ALP in the Deck Editor may result in collisions between 
pod(s) and ALPs during operation.

The steps available in the Intermediate Step Palette are:

FX, NX-S8 — The pipetting and tip handling steps on the Intermediate 
step palette cannot be used with the Span-8 Pod; refer to Chapter 18, Using 
the Span-8 Step Palette, to perform similar functions.

• Aspirate — aspirates a specified amount of liquid from a single source in 
preparation for the Dispense step.

• Dispense — dispenses a specified amount of liquid into a single 
destination, following the Aspirate step.

• Mix — mixes the contents of a piece of labware using repeated aspirate and 
dispense.

• Wash — washes tips by aspirating and dispensing repeatedly at a Tip Wash 
ALP.

3000 — The Wash step cannnot be used with the Biomek 3000 and 
does not appear on the Intermediate Step Palette.
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• New Tips— loads new tips to the head.

• Unload Tips — unloads tips from the head.

• Loop — executes one or more steps a configured number of times.

• Cleanup — places tips and tip boxes at specified locations.

• Move Pod — moves the pod to a specified deck location.

• Group Step — groups a series of steps in a nested fashion under a logical 
name that appears in the Method View.

When one of the above steps is added to a method, the configuration associated with 
that step appears on the right side of the Biomek Software main editor, in step 
configuration (Figure 16-1).

Note:  Steps not configured appropriately generate errors when the method is 
validated or run.
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16.2 Displaying the Intermediate Step Palette
In order to add intermediate steps to a method, display the Intermediate Step Palette 
(Figure 16-1).

FX, NX-S8 — Only the Loop, Cleanup, Move Pod, and Group steps 
appear on the Intermediate step palette for Span-8 only instruments.

3000 — The Wash step does not appear on the Intermediate step palette.

Figure 16-1.  Biomek Software main editor with Intermediate Step Palette displayed

To display the Intermediate Step Palette, complete the following:

• Right-click any empty palette space, and the Step Palette menu appears. 
Select Intermediate.

OR

• From the toolbar, select Options>Toolbars>Intermediate.

Method View
The method is built 
step by step in the 
Method View.

Step Configuration
When a step is highlighted in the Method 
View, the corresponding configuration 
appears in this area.

Intermediate 
Step Palette
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16.3 Aspirate Step
NX-S8 — To aspirate using a Span-8 Pod, refer to Section 18.4, Span-8 
Aspirate Step.

The Aspirate step removes liquid from source labware in preparation for dispensing 
to destination labware. Each tip of the head or tool descends into the wells of the 
source labware and aspirates the desired volume. The Aspirate step is often used in 
conjunction with the Dispense, New Tips, and Unload Tips steps (Figure 16-2), but 
it can be used with any combination of steps. Aspirate provides more direct control 
over pipetting operations than the Transfer or Combine steps because any step or 
combination of steps can complete the liquid transfer operation started with the 
Aspirate step.

3000 — A Load Tool or Change Tool step must be inserted and configured 
to load an appropriate pipetting tool prior to an Aspirate step in the method 
(refer to Section 20.4, Load Tool Step). Depending on the tool loaded, either 
a single well or eight wells in a column are selected when aspirating with the 
Biomek 3000 instrument. 

Note:  A Loop step and variable can be used to aspirate to more wells on a 
microplate (refer to Section 16.9, Loop Step).

The Aspirate step configuration includes specifying:

• Labware type accessed during aspirate

• Position of the labware on the deck

• Type of liquid to aspirate

• Volume to aspirate

• Pod that performs aspirate

• Tip refresh, if desired, and the type of tips used

• Technique selection

• Quadrant or well(s) accessed, if applicable

FX, NX-MC — Quadrants are applicable only when accessing a 384-
well microplate using a 96-channel pod or a 1536-well microplate using 
a 384-channel pod.

3000 — Either a single well or eight wells in a column are selected, 
depending on the tool loaded.
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Insert an Aspirate step into the method (Figure 16-2).

Figure 16-2.  Aspirate step and configuration

Method View
Note that tips are loaded 
prior to the Aspirate step 
and unloaded after the 
Dispense step. 

Aspirate step configuration

Refresh Tips
Refresh Tips is unchecked when loading tips prior to 
the Aspirate step. Refresh Tips loads a new box of tips 
prior to the Aspirate operation.

Current Deck Display
The Current Deck Display is 
used for labware selection, 
and it displays the status of 
the deck upon completion of 
the previous step. 
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16.3.1 Configuring the Aspirate Step
When an Aspirate step is added to a method, the Aspirate step configuration appears 
(Figure 16-2). 

To configure the Aspirate step:

1. Click on the desired piece of labware in the Current Deck Display from which to 
aspirate. Information for that piece of labware is entered automatically into the 
Aspirate step configuration.

OR

Select a Labware Type (Figure 16-2).

2. Verify the Position of the labware. 

Note:  A bright blue outline appears in the Current Deck Display around the 
selected labware.

3. Indicate the Liquid Type contained in the selected labware.

Note:  The liquid type defaults to the liquid specified for the labware in 
Instrument Setup.

4. Enter the Volume aspirated from the selected labware. If using a variable or 
expression, enter an equal sign (=) followed by the variable name or expression; 
for example, =AspValue (Figure 16-2). 

5. Select the well(s) or quadrant to aspirate from by highlighting the desired 
quadrant on the labware graphic.

FX, NX-MC — Quadrants may be selected when aspirating from a 384-
well plate using a 96-channel pod or a 1536-well plate using a 384-
channel pod.

3000 — Either a single well or eight wells in a column are selected, 
depending on the tool loaded.

Note:  To zoom in on the labware, double-click on the labware. To call up a 
menu for Zoom In and a Specify Selection as Text option, right-click on the 
labware. 

Specify Selection as Text allows the selection of a quadrant as a target for the 
aspirate operation. Specify Selection as Text is not applicable for 96-well 
microplates with a Multichannel Pod on FX or NX-MC, but is applicable with 
pipetting tools on the 3000. It is never applicable with reservoirs. 

6. If using a dual-pod FX instrument, specify the Multichannel Pod performing the 
aspirate operation from the drop-down list. The pod configured as the default pod 
is displayed in Pod. If the other pod is desired, select the pod from the drop-
down list or the Current Deck Display.

7. Check Refresh Tips, if desired, and specify the tip type. Refresh Tips loads 
new tips to the pod whether tips are currently loaded or not.

Note:  If Biomek Software determines that tips are already loaded, the default 
setting for Refresh Tips is Off. If Biomek Software does not determine tips are 
loaded, the default setting for Refresh Tips is On. 
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8. The software automatically selects a Pipetting Technique based on the liquid 
type, labware type, tip type, and volume being transferred. To override this 
selection, deselect Auto-Select and choose the desired Technique 

OR

Choose Customize and configure the technique as desired in the Technique 
Editor. 

Note:  For more information on customizing, configuring, and saving a 
technique, refer to Section 12.3.1, Understanding Techniques.

9. In some cases, it may be necessary to override the aspiration height. Leave the 
height as is to use the settings specified in the pipetting technique.

OR

Set the aspirate height manually using one of the following techniques:

• Set the aspirate height by positioning the cursor over the graphic of a tip 
inside a well (Figure 16-3). Click and drag the graphic up or down. The 
tip moves with the cursor, and the height displayed below the graphic is 
adjusted as the graphic is manipulated.

Note: The cursor changes to a hand when positioned over the 
graphic. The phrase (Overrides Technique) appears below the graphic 
when the tip height is changed by manipulating the graphic (Figure 16-
3) or when the technique is changed with the Customize option. For 
more information on selecting and editing a technique for this method, 
refer to Chapter 9, Understanding and Creating Techniques.

• Adjust the aspirate height by selecting the graphic of a tip inside a well 
and using the ↑ and ↓ keys. The textual representation of the height, 
which is displayed below the graphic, adjusts in 0.1 millimeters (mm) 
increments.

• Right-click on the graphic of a tip inside a well, and a menu appears. 
Select Custom Height, and the Custom Height prompt appears 
(Figure 16-4). Insert the height in mm and, in from, select a reference 
point from the drop-down list. Click OK to save the edits and return to 
the Aspirate step configuration.

Note:  For more information on creating, editing, and saving techniques for use 
with other methods, refer to Chapter 9, Understanding and Creating Techniques.
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Figure 16-3.  Aspirate step — Adjusting the aspirate height

Figure 16-4.  Custom Height prompt

10. Select a step that occurs after the Aspirate step or the Finish step to validate the 
step configuration.

Notifies that the technique is not 
using the default settings

Height display

Adjust the tip height for 
Aspirate, if needed



Using the Intermediate Step Palette 16-9

Biomek Software User’s Manual

16.4 Dispense Step
FX, NX-S8 — To dispense using a Span-8 Pod, refer to Section 18.5, Span-
8 Dispense Step.

The Dispense step dispenses liquid into a single destination labware following 
aspirate. Each tip of the head or tool descends into the wells of the destination 
labware and dispenses the desired volume. The Dispense step is often used in 
conjunction with the Aspirate, New Tips, and Unload tips steps, but it can be used 
with any combination of steps. Dispense provides more direct control over pipetting 
operations than the Transfer or Combine steps because any step or combination of 
steps can initiate the liquid transfer operation.

Note:  Tips must be loaded and have liquid in them from a previous step, such as an 
Aspirate step, prior to using a Dispense step.

Note:  A Loop step and variable can be used to dispense from more wells on a 
microplate (refer to Section 16.9, Loop Step).

The Dispense step configuration includes specifying:

• Labware type accessed during dispense

• Position of the labware on the deck

• Type of liquid to dispense

• Volume to dispense

• Pod that performs dispense

• Empty tips, if desired

• Technique selection

• Quadrant or well(s) accessed, if applicable

FX, NX-MC — Quadrants are applicable only when accessing a 384-
well microplate using a 96-channel pod or a 1536-well microplate using 
a 384-channel pod.

3000 — Either a single well or eight wells in a column are selected, 
depending on the tool loaded.
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Insert a Dispense step into the method (Figure 16-5).

Figure 16-5.  Dispense step and configuration

16.4.1 Configuring the Dispense Step
When a Dispense step is added to a method, the Dispense step configuration 
appears (Figure 16-5). 

To configure the Dispense step:

1. Click on the desired piece of labware in the Current Deck Display. Information 
for that piece of labware is entered automatically into the Dispense step 
configuration.

OR

Select a Labware Type (Figure 16-5).

2. Verify the Position of the labware. 

Note:  A bright yellow outline appears in the Current Deck Display around the 
selected labware.

Method View
The method displayed contains a 
Dispense step. The location of 
the dispense operation is 
specified in the Dispense 
caption in the Method View. 
Note that tips are loaded prior to 
the Aspirate step and unloaded 
after the Dispense step. 

Dispense step configuration
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3. Indicate the Liquid Type contained in the selected labware.

Note:  The liquid type defaults to the liquid specified for the labware in 
Instrument Setup.

4. Enter the Volume dispensed to the selected labware. If using a variable or 
expression, enter an equal sign (=) followed by the variable name or expression; 
for example, =AspValue (Figure 16-5). 

5. Select the well(s) or quadrant to dispense to by highlighting the desired well(s) or 
quadrant on the labware graphic.

FX, NX-MC — Quadrants may be selected when dispensing to a 384-well 
plate using a 96-channel pod or a 1536-well plate using a 384-channel pod. 

3000 — Either a single well or eight wells in a column are selected when 
dispensing with the Biomek 3000 instrument, depending on the tool loaded. 

Note:  To zoom in on the labware, double-click on the labware. To call up a 
menu for Zoom In and a Specify Selection as Text option, right-click on the 
labware. 

Specify Selection as Text allows the selection of a quadrant as a target for the 
aspirate operation. Specify Selection as Text is not applicable for 96-well 
microplates with a Multichannel Pod on FX or NX-MC, but is applicable with 
pipetting tools on the 3000. It is never applicable with reservoirs. 

6. If using a dual-pod FX instrument, specify the Multichannel Pod performing the 
dispense operation from the drop-down list. The pod configured as the default 
pod is displayed in Pod. If the other pod is desired, select the pod from the drop-
down list or from the Current Deck Display.

7. Check Empty Tips, if desired. Empty Tips expels the Trailing Air Gap, the 
fluid contained in the tip, and the Blow Out all at one time, rather than as 
separate operations.

Note:  The default setting for Empty Tips is Off.

8. The software automatically selects a Pipetting Technique based on the liquid 
type, labware type, tip type, and volume being transferred. To override this 
selection, deselect Auto-Select and choose the desired Technique 

OR

Choose Customize and configure the technique as desired in the Technique 
Editor. 

Note:  For more information on customizing, configuring, and saving a 
technique, refer to Section 12.3.1, Understanding Techniques.
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9. In some cases, it may be necessary to override the aspiration height. Leave the 
height as is to use the settings specified in the pipetting technique.

OR

Set the aspirate height manually using one of the following techniques:

• Set the aspirate height by positioning the cursor over the graphic of a tip 
inside a well (Figure 16-6). Click and drag the graphic up or down. The 
tip moves with the cursor, and the height displayed below the graphic is 
adjusted as the graphic is manipulated.

Note: The cursor changes to a hand when positioned over the 
graphic. The phrase (Overrides Technique) appears below the graphic 
when the tip height is changed by manipulating the graphic (Figure 16-
6) or when the technique is changed with the Customize option. For 
more information on selecting and editing a technique for this method, 
refer to Chapter 9, Understanding and Creating Techniques.

• Adjust the aspirate height by selecting the graphic of a tip inside a well 
and using the ↑ and ↓ keys. The textual representation of the height, 
which is displayed below the graphic, adjusts in 0.1 millimeters (mm) 
increments.

• Right-click on the graphic of a tip inside a well, and a menu appears. 
Select Custom Height, and the Custom Height prompt appears 
(Figure 16-7). Insert the height in mm and, in from, select a reference 
point from the drop-down list. Click OK to save the edits and return to 
the Aspirate step configuration.

Note:  For more information on creating, editing, and saving techniques for use 
with other methods, refer to Chapter 9, Understanding and Creating Techniques.
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Figure 16-6.  Dispense step — Adjusting the dispense height

Figure 16-7.  Custom Height prompt

10. Select a step that occurs after the Dispense step or the Finish step to validate 
the step configuration.

Notifies that the 
technique is not using 

the default settings

Adjust the 
height for the 

Dispense 
operation



16-14 Using the Intermediate Step Palette

Beckman Coulter, Inc.

16.5 Mix Step 
FX, NX-S8 — The Mix step cannot be used with a Span-8 Pod. 

The Mix step provides a mixing motion for the contents of a piece of labware by 
performing one or more aspirate and dispense operations within a single microplate. 
The Mix step can be used to mix the contents of a piece of labware that has been 
inactive for an extended length of time, prior to aspirating.

3000 — A Load Tool or Change Tool step must be configured with an 
appropriate pipetting tool prior to a Mix step in the method (refer to Section 
20.4, Load Tool Step). Depending on the tool loaded, either a single well or 
eight wells in a column are selected when mixing. 

Note:  A Loop step and variable can be used to mix more wells on a microplate 
(refer to Section 16.9, Loop Step).

The Mix step configuration includes specifying:

• Labware type accessed during mix 

• Position of the labware on the deck

• Type of liquid mixed

• Volume mixed

• Pod performing the mix

• Tip refresh, if desired, and the type of tips to load

• Number of aspirate and dispense cycles to perform during the mix process

• Technique selection

• Quadrant or wells accessed, if applicable

FX, NX-MC — Quadrants are applicable only when accessing a 384-
well microplate using a 96-channel pod or a 1536-well microplate using 
a 384-channel pod.

3000 — Either a single well or eight wells in a column are selected, 
depending on the tool loaded.
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Insert a Mix step into the method (Figure 16-8).

Figure 16-8.  Mix step and configuration

16.5.1 Configuring the Mix Step
When a Mix step is added to a method, the Mix step configuration appears (Figure 16-
8). 

To configure the Mix step:

1. Click on the desired piece of labware in the Current Deck Display (Figure 16-8). 
Information for that piece of labware is entered automatically into the Mix step 
configuration.

OR

Select a Labware Type from the drop-down list.

2. Verify the Position of the labware. 

Note:  A bright blue outline appears in the Current Deck Display around the 
selected labware.

Mix step configuration 

Method View
The method displayed 
contains multiple Mix 
steps. The location of 
the mix operation is 
specified in the Mix 
captions in the Method 
View. Note that tips 
are loaded prior to and 
unloaded after the Mix 
step. 
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3. Select the well(s) or quadrant to mix by highlighting the desired well(s) or 
quadrant on the labware graphic.

FX, NX-MC — Quadrants may be selected when mixing wells in a 384-well 
plate using a 96-channel pod or a 1536-well plate using a 384-channel pod. 

3000 — Either a single well or eight wells in a column are selected when 
mixing wells, depending on the tool loaded. 

Note:  To zoom in on the labware, double-click on the labware. To call up a 
menu for Zoom In and a Specify Selection as Text option, right-click on the 
labware. 

Specify Selection as Text allows the selection of a quadrant as a target for the 
aspirate operation. Specify Selection as Text is not applicable for 96-well 
microplates with a Multichannel Pod on FX or NX-MC, but is applicable with 
pipetting tools on the 3000. It is never applicable with reservoirs. 

4. Indicate the Liquid Type contained in the selected labware.

5. Enter the Volume mixed in the selected labware. If using a variable or 
expression, enter an equal sign (=) followed by the variable name or expression; 
for example, =AspValue. 

6. If using a dual-pod FX instrument, specify the Multichannel Pod performing the 
mix operation from the drop-down list. The pod configured as the default pod is 
displayed in Pod. If the other pod is desired, select the pod from the drop-down 
list.

7. Check Refresh Tips, if desired, and specify the tip type. Refresh Tips loads 
new tips to the pod whether tips are currently loaded or not.

Note:  If Biomek Software detects that tips are already loaded, the default 
setting for Refresh Tips is Off. If Biomek Software does not detect tips, the 
Default setting Refresh Tips is On. 

8. In Mix, enter the number of times the mix operation is performed.

9. The software automatically selects a Pipetting Technique based on the liquid 
type, labware type, tip type, and volume being transferred. To override this 
selection, deselect Auto-Select and choose the desired Technique 

OR

Choose Customize and configure the technique as desired in the Technique 
Editor. 

Note:  For more information on customizing, configuring, and saving a 
technique, refer to Section 12.3.1, Understanding Techniques.

10. Select a step that occurs after the Mix step or the Finish step to validate the step 
configuration.
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16.6 Wash Step
FX, NX-S8 — To wash tips on a Span-8 Pod, refer to Section 18.8, Span-8 
Wash Tips Step. 

3000 — The Wash step is not for use with the Biomek 3000 and does not 
appear on the Intermediate Step Palette.

The Wash step combines aspirate and dispense operations into one step that cleans 
tips using the Multichannel Tip Wash ALP. Use the Deck Editor to add and configure 
the Wash Station ALP.

The Wash step configuration includes specifying:

• Pod performing the wash operation.

• Wash station accessed.

• Type of liquid contained in the wash station.

• Volume used in the wash process.

• Number of wash cycles completed.

Insert a Wash step into the method (Figure 16-9).

Figure 16-9.  Wash step and configuration

Wash step configuration 

Method View
The method displayed contains a Wash step. The fluid used 
in the wash operation and the location of the Wash Station 
ALP is specified in the Wash caption in the Method View. 
Note that tips are loaded prior to the Wash step. 
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16.6.1 Configuring the Wash Step
When a Wash step is added to a method, the Wash step configuration appears 
(Figure 16-9). 

To configure the Wash step:

1. If using a dual-pod FX instrument, specify the Multichannel Pod performing the 
wash operation from the drop-down list. The pod configured as the default pod is 
displayed in Pod. If the other pod is desired, select the pod from the drop-down 
list or from the Current Deck Display.

2. Click on the Wash Station device in the Current Deck Display. Information for 
that wash station is entered automatically into the Wash step configuration.

OR

Select a Wash Station device from the drop-down list.

Note:  The Wash Station ALP can be added to the deck and configured for use 
with the Deck Editor.

Note:  A Wash Station does not have to be specified as long as the Liquid Type 
is selected. If no Wash Station is specified, the software determines the wash 
station with the specified Liquid Type that can be accessed by the pod.

3. Verify the Liquid Type contained in the selected Wash Station.

Note:  The Liquid Type contained in the Wash Station ALP is configured in the 
Instrument Setup step. If the Wash Station is selected from the Current Deck 
Display, the information is automatically inserted.

4. In Volume, provide the volume of fluid to use when washing the tips.

Note:  Enter the volume as a percent (including the percent sign, %) to specify 
the volume as a percent of the maximum volume of fluid contained in the tips in 
previous steps. For example, if the maximum volume of fluid transferred is 50 
µL, and the % is set for 110%, the Wash step washes the tips with 55 µL of 
solution. However, if no fluid has been transferred and the volume is entered as a 
percent, no action is taken and tips are not washed.

5. In Wash Cycles, select the number of aspirate and dispense operations 
completed during the wash operation.

6. Select a step that occurs after the Wash step or the Finish step to validate the 
step configuration.
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16.7 New Tips Step
FX, NX-S8 — To load new tips onto a Span-8 Pod, refer to Section 18.6, 
Span-8 New Tips Step.

The New Tips step instructs the instrument to load new tips at a specific point in a 
method. New Tips is used when precise tip control is required. New Tips is used in 
conjunction with the Unload Tips steps. Also, since tips must be loaded prior to 
aspirate, the New Tips step should be positioned prior to any Aspirate step if tips 
have not been previously loaded. 

3000 — A Load Tool step must be configured with an appropriate pipetting 
tool prior to a New Tips step in the method (refer to Section 20.4, Load Tool 
Step).

The New Tips step is used in place of the Refresh Tips option in the Mix and 
Aspirate steps or the Load tips option in the Transfer and Combine steps, when 
more tip control is desired. New Tips is particularly useful with the Loop and 
Worklist steps; for example, when a Worklist step is performing a transfer that 
accesses the same tip box repeatedly at different points throughout the worklist, the 
tips can be loaded and unloaded as many times as their tip configuration allows.

Loading new tips is recommended when:

• The current tips have manipulated a caustic fluid.

• The current tips have been loaded the maximum number of times allowed in 
their Labware Properties.

Note: To increase the number of uses allowed for each set of tips, increase 
the Load no more than count in the Labware Properties configuration in 
the Instrument Setup step.

• The integrity of the current tips is in question.
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Insert a New Tips into the method (Figure 16-10).

Figure 16-10.  New Tips step and configuration

To configure New Tips:

1. If using a dual-pod FX instrument, specify the Multichannel Pod requiring new 
tips from the drop-down list. The pod configured as the default pod is displayed 
in Pod. If the other pod is desired, select the pod from the drop-down list or from 
the Current Deck Display.

2. Select the Tips loaded in the New Tips step from the drop-down list. 

OR

Select the tip box from the Current Deck Display. Selecting tips from the Current 
Deck Display automatically updates Tips in the Step Configuration.

Note:  The name of a specific tip box can be entered in Tips if tip boxes were 
assigned names in the Instrument Setup step. If a name is specified, the New 
Tips step only uses tip boxes with that name. However, if the tip box type is used, 
New Tips uses any available tip box of that type.

3. Select a step that occurs after the New Tips step or the Finish step to validate 
the step configuration.

New Tips Step 
Configuration
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16.8 Unload Tips Step
FX, NX-S8 — To unload tips from a Span-8 Pod, refer to Section 18.7, 
Span-8 Tip Discard Step.

The Unload Tips step instructs the instrument to unload tips at a specific point in a 
method. Unload Tips is used when precise tip control is required. Unload Tips is 
often used in conjunction with the New Tips steps, but it can be used with any 
combination of steps. It is acceptable to use the Unload Tips step multiple times 
throughout a method.

Unload Tips is used when tip integrity is in question or when cross-contamination 
between labware is a concern. Unload Tips can be used in place of the Unload 
(Tips) option in the Transfer and Combine steps, and is particularly useful with 
Loop and Worklist steps; for example, when a Worklist step performs a transfer 
accessing the same tip box repeatedly, the tips can be loaded and unloaded as many 
times as the tip configuration allows with the New Tips and Unload Tips steps.

Unloading tips is recommended when:

• The current tips have manipulated a caustic fluid.

• The current tips have been loaded the maximum number of times allowed in 
their Labware Properties.

Note: To increase the number of uses allowed for each set of tips, increase 
the Load no more than count in the Labware Properties configuration in 
the Instrument Setup step.

• The integrity of the current tips is in question.

• To avoid cross-contamination of samples.
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Insert an Unload Tips step into the Method View (Figure 16-11).

Figure 16-11.  Unload Tips step and configuration

To configure Unload Tips:

1. If using a dual-pod FX instrument, specify the Multichannel Pod requiring tip 
removal from the drop-down list. The pod configured as the default pod is 
displayed in Pod. If the other pod is desired, select the pod from the drop-down 
list or Current Deck Display.

2. Select a step that occurs after the Unload Tips step or the Finish step to validate 
the step configuration.

Unload Tips Configuration
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16.9 Loop Step
The Loop step executes any steps located between the Loop and End Loop icons as 
many times as specified in the Loop Step Configuration; for example, if a method 
requires multiple repetitions of the same aspirate and dispense operations, the Loop 
step allows the repetition of those steps as many times as required. The steps 
requiring repetition, in this case the Aspirate and Dispense steps, are ‘substeps’ of 
the Loop step.

When the Loop step is added to a method, the Loop icon appears in the Method View, 
as well as the End Loop icon. All steps placed between the Loop and End Loop 
icons are contained within the Loop and are repeated as many times as indicated in 
the Loop Step Configuration (Figure 16-12).

Note:  While the Loop step is executing, a number appears in parentheses behind 
each substep within the Loop step, indicating the current iteration of the loop.

Note:  Variables defined in a Loop step apply only to the Loop and its substeps.

Insert a Loop step into the Method View (Figure 16-12).

Figure 16-12.  Loop step and configuration

Method View
The method displayed contains a Loop step. Note 
that the Aspirate and Dispense steps are 
positioned between the Loop icon and the End 
Loop icon. The configured Variable, Start, End, 
and Increment values are displayed in the Loop 
caption in the Method View.

Loop Step Configuration
The Loop Step Configuration is used to 
specify an optional variable used by the 
substeps within the Loop step, the start 
and end count numbers, and the 
increment used to proceed from the start 
number to the end number.
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16.9.1 Configuring a Loop Step and Creating a 
New Variable

To configure a Loop step and create a new variable:

1. In Variable, insert a variable for the Loop step and any substeps (Figure 16-13). 
Variable creates a variable that can be used in the Step Configurations for any 
substep of the Loop (Figure 16-14). A variable name cannot contain a space or a 
punctuation mark, such as a period (.), a comma (,), or an ampersand (&). 

Note:  An entry in Variable is optional. The Loop step can function without a 
Variable.

Figure 16-13.  Loop step — variable created in Variable

2. Insert the Start value for the Loop count (Figure 16-13). 

Note:  A Loop usually begins counting at ‘1’; for example, if the Increment is 
‘25’, Start is ‘1’, and End is ‘100’, four passes of the loop are completed for the 
Increment values of 1, 26, 51, and 76. It is occasionally desirable, however, to 
count the passes of a loop by the Increment value; for example, if the Start 
value is changed from ‘1’ to ‘25’, four passes of the loop are completed for the 
Increment values of 25, 50, 75, and 100.

The variable ‘Count’ has 
been created for the Loop
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3. Insert the End value for the Loop count. 

Note:  Each time the method completes a loop, its count is advanced. The 
method drops out of the Loop when the next pass would exceed the End number; 
for example, if the Increment is ‘25’, Start is ‘1’, and End is ‘100’, four passes 
of the loop are completed for the Increment values of 1, 26, 51, and 76. The 
Loop stops at 76 because the value of the next pass would be 101, which exceeds 
the End value of 100.

4. Insert an Increment value for the Loop count. The Increment advances the 
iterations of the Loop from the Start value to the End value. Variables can be 
used in Increment; however, the variable must be preceded by an equal (=) sign 
(Figure 16-14).

Note:  When the variable is accessed in the substeps, the value of the variable is 
incremented until the value reaches the End value, without going over. For 
example, if the Increment for Count is 25, and if Start is ‘1’, End is ‘100’, four 
iterations of the loop are completed for the values 1, 26, 51, and 76. The variable 
‘Count’ is used in the volume fields of the Aspirate and Dispense substeps of 
the Loop step (Figure 13-22). 

5. Select End Loop in the Method View to add steps to the Loop.



16-26 Using the Intermediate Step Palette

Beckman Coulter, Inc.

6. Insert the desired substeps between Loop and End Loop.

7. Configure the substeps, using the variable created in Variable where applicable .

Figure 16-14.  Loop step variable ‘Count’ used in an Aspirate substep

Note:  In the example, the variable ‘Count’ is used in the volume fields of the 
Aspirate and Dispense substeps of the Loop step (Figure 16-14). 

The variable ‘Count’ used in 
the Aspirate step within a 

Loop step.
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16.9.2 Configuring a Loop Step Using an Existing 
Variable

To configure a Loop step without creating a new variable, but using an existing 
variable:

1. Leave Variable blank (Figure 16-15). 

Note:  An entry in Variable is optional. The Loop step can function without an 
entry in Variable.

Figure 16-15.  Loop step — using a previously created variable as the Increment

2. Insert the Start value for the Loop count. 

Note:  A Loop usually begins counting at ‘1’; for example, if Increment is 
‘=AspValue2’ and AspValue2 has an assigned value of 25, and if Start is ‘1’ 
and End is ‘100’, four iterations of the loop are completed for the values 1, 26, 
51, and 76. It is occasionally desirable, however, to count the passes of a loop by 
the Increment value; for example, if the Start value is changed from ‘1’ to ‘25’, 
four passes of the loop are completed for the Increment values of 25, 50, 75, and 
100.

Variable is left blank.

The variable 
‘AspValue’ is being 

used as an Increment 
for the Loop step.
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3. Insert the End value for the Loop count. 

Note:  Each time the method completes a loop, its count is advanced. The 
method drops out of the Loop when the next pass would exceed the End number; 
for example, if Increment is ‘=AspValue2’ and AspValue2 has an assigned 
value of 25, and if Start is ‘1’ and End is ‘100’, four iterations of the loop are 
completed for the values 1, 26, 51, and 76. The Loop stops at 76 because the 
value of the next pass would be 101, which exceeds the End value of 100.

4. Insert a previously created variable in Increment (Figure 16-15). The value of 
the variable is used as the Increment to advance the iterations of the Loop from 
the Start value to the End value. Variables must be preceded by an equal (=) sign 
in the Loop step configuration, as well as in the substep configurations.

Note:  When the variable is accessed in the substeps, the value of the variable is 
incremented until the value reaches the End value, without going over. For 
example, if Increment is ‘=AspValue2’ and AspValue2 has an assigned value 
of 25, and if Start is ‘1’ and End is ‘100’, four iterations of the loop are 
completed for the values 1, 26, 51, and 76. 

5. Select End Loop in the Method View to add steps to the Loop.

6. Insert the desired substeps between Loop and End Loop.
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7. Configure the substeps using the previously created variable where applicable.

Note:  The variable ‘AspValue’ is used in the volume fields of the Aspirate and 
Dispense substeps of the Loop step (Figure 16-16).

Figure 16-16.  Loop step — the ‘AspValue’ variable is used as the 
Volume for the substeps

The variable ‘AspValue’ 
is used in the volume 
field of the substeps
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16.10 Cleanup Step
The Cleanup step is used to direct the instrument to dispose of tips and tip boxes. 
Normally, when a method is completed, tips and tip boxes are left in their final 
positions, regardless of their originating positions. The Cleanup step can return tips 
and tip boxes to their original deck position or hardware device; place them in a trash 
receptacle; or leave them wherever they are when the method is completed.

The Cleanup Step Configuration includes:

• With no configuration options selected, all tips are sent to their configured 
location at the end of the method.

• When Send tip boxes to their configured final destinations is checked, 
all the tip boxes that came from off deck and all those that were configured 
to go to trash are sent to those final destinations.

• When Send boxes that started on deck back to their original locations 
is checked, in addition to the operations resulting from the box checked 
above, any tip boxes that started on the deck are returned to their starting 
position. (This option is activated only when Send tip boxes to their 
configured final destinations is selected.)

Cleanup resets the hardware by physically returning tips and tip boxes to their 
original positions, while the Finish step only unloads tips and resets the software to 
its original state at the completion of the method. Use the Cleanup step with the 
Finish step to reset both the hardware and the software to the state they were in at the 
onset of the method, or to clear the deck of used tips and tip boxes. The Cleanup step 
is useful when the same method is run repeatedly, one time after another, and when 
trying to track which tips and tip boxes were used for which fluids and labware.
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Insert a Cleanup step into the Method View (Figure 16-17).

Figure 16-17.  Cleanup step and configuration

To configure the Cleanup step:
1. Select Send tip boxes to their configured final destination, if desired. 

This sends the tip boxes to the final destination configured in the Labware 
Properties for that tip box. 

Note:  The default setting for the Cleanup step is both options Unchecked. 
Inserting the Cleanup step without selecting either option instructs the Biomek 
instrument to unload any tips currently on the pod to the final destination 
configured in Labware Properties for those tips. 

Cleanup Configuration
The Cleanup Step Configuration provides the options 
to:

• Send tip boxes to the final destinations 
configured in the Labware Properties for 
that tip box.

• Return the tip boxes to their starting location, 
regardless of whether they originated on the 
deck or in an external hardware device.
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2. Select Send tip boxes that started on deck back to their original 
locations, if desired. This returns the tip boxes to their starting location, 
regardless of whether they originated on the deck or in an external hardware 
device, such as a stacker carousel. 

Note:  Send tip boxes that started on deck back to their original locations 
is only available when Send tip boxes to their configured final destination is 
selected.

3. Select a step that occurs after the Cleanup step or the Finish step to validate the 
step configuration.



Using the Intermediate Step Palette 16-33

Biomek Software User’s Manual

16.11 Move Pod Step 
The Move Pod step moves the pod to a deck position that does not hamper access to 
the labware, ALPs, and devices on the deck. 

Use Move Pod to ensure that the pod does not interfere with activities taking place 
on the deck, such as the addition, removal, or relocation of labware or devices.

Insert a Move Pod step into the Method View (Figure 16-18).

Figure 16-18.  Move Pod step and configuration

Method View
The method displayed 
contains a Move Pod 
step. Note that the step is 
labeled as a “Move” of 
“Pod1” to deck position 
“P19” with offset values 
of “0,0.”

Move Pod Configuration
The Move Pod Step Configuration 
indicates the pod being moved, the deck 
position the selected pod is moved to, and 
any offset values required to provide an 
accurate position.
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To configure the Move Pod step:

1. Specify the Pod being moved from the drop-down list.

OR

Select the Pod from the Current Deck Display. The tip diagram on the left of the 
Current Deck Display represents Pod1, while the tip diagram on the right 
represents Pod2. Selecting a pod from the Current Deck Display automatically 
updates Pod in the Step Configuration.

Note:  In Pod, Pod1 is the default for a one-pod Biomek FX or Biomek 3000 
system. In a two-pod Biomek FX system, the pod configured as the default pod is 
displayed in Pod. If the other pod is desired, select the pod from the drop-down 
list or the Current Deck Display.

2. In Location, select the deck position from the drop-down list.

OR

Select the Location from the Current Deck Display. Selecting a location from 
the Current Deck Display automatically updates Location in the Step 
Configuration.

Note:  A bright blue outline appears in the Current Deck Display around the 
selected location.

3. Insert the X Offset value in centimeters (cm).

4. Insert the Y Offset value in centimeters (cm).

Note:  Selecting the deck position without offset values is usually sufficient to 
relocate the pod; however, X and Y Offset values can be used to provide a more 
specific position. 

The final position of the pod when using X and Y Offsets is the deck position 
specified in Location PLUS the values inserted into the X and Y Offsets. For 
example, when framing an ALP, the labware positioned on the ALP is ‘offset’ 
from the zero (0) point, or back-left corner, of the ALP to the actual edge of the 
labware itself.

5. Select a step that occurs after the Move Pod step or the Finish step to validate 
the step configuration.
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16.12 Group Step
The Group step gathers steps performing similar functions or steps achieving a 
specific result together. Group reduces the confusion that can arise when viewing 
large methods by consolidating and applying a single label to a number of steps. 
Multiple Group steps can be used within a method, and they can be placed in a 
Group step together to further abbreviate the steps displayed in the Method View.

Advantages to grouping steps are:

• The steps contained in the Group step are hidden from the Method View by 
collapsing the Group step.

• The Group step is collapsed by default when a method is opened. This 
means long methods appear shorter and more concise.

• Multiple steps can be identified by a single label.

• All steps related to a specific operation can be grouped together under a 
single label to identify the operation they perform.

Insert a Group step into the Method View (Figure 16-19). 

Figure 16-19.  Group step and configuration

Group Step Configuration
The Group Step Configuration provides the 
label applied to the steps grouped together.

Method View
The method displayed contains a Group step. 
The Group is labeled ‘Aspirate and Dispense 
Operations’ because that phrase is inserted in 
the Group Step Configuration.
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When a Group step is added to a method, the Group Step Configuration appears 
(Figure 16-19). 

To configure the Group step:

1. Double-click on the Group step to expand it so that the End icon is visible.

2. In Group Label, enter text to identify the group. 

Note:  The text inserted in Group Label appears in the Group steps caption in 
the Method View.

3. Insert steps between the Group and End icons.

4. Double-click on the Group step to collapse it so that the steps contained within 
the Group step are hidden from view.

Note:  The Group step is collapsed by default when the method opens.
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17 Using the Advanced Step 
Palette

17.1 Overview
The steps presented in the Advanced Step Palette (Figure 17-1) provide tools for more 
complex management of methods. These steps are used to perform the following:

• Repeat a series of steps using a list of specified values without entering and 
configuring the steps repeatedly

• Access and run a method within a method

• Conditionally execute steps based on an aspect of the environment, such as 
the volume in a microplate

Note:  The steps available in the Advanced Step Palette do not use the pod directly 
and may be used with any single- or dual-pod instrument.

The steps available in the Advanced Step Palette are:

• Run Method — accesses and runs a method within a method.

• Worklist — fills in variables based on a worklist file.

• Just in Time — synchronizes the execution of steps.

• Let — defines variables for its substeps.
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• If — evaluates a condition within a method and runs either the “then” 
substeps or the “else” substeps according to the condition.

• Script — runs a list of commands providing customized control over the 
instrument.

• Scripted Let —similar to Script step, with the exception that it allows 
variables to be extended outside the script and used in the method.

When one of the above steps is inserted into a method, the configuration options 
associated with that step appear on the right side of the Biomek Software main editor, 
in Step Configuration.

Note:  Steps not configured appropriately may generate errors when the method is 
validated or run.
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17.2 Displaying the Advanced Step Palette
In order to add advanced steps to a method, display the Advanced Step Palette 
(Figure 17-1).

Figure 17-1.  Biomek Software main editor with Advanced Step Palette displayed

To display the Advanced Step Palette:

• Right-click any empty palette space, and select Advanced from the menu.

OR

• From the toolbar, select Options>Toolbars>Advanced.

Method View
The method is built 
step by step in this 
area.

Step Configuration
When a step is highlighted in the Method View, 
set the corresponding configuration in this area.

Advanced Step Palette
Displays the steps available for insertion into a method. 
Additional step palettes include Basic, Intermediate, 
Span-8, Stacker Carousel, and Devices.
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17.3 Run Method Step
The Run Method step executes a previously created method within the method in 
progress. Run Method saves time by assigning variables accessible by the previously 
created method and by preventing unnecessary duplication of steps. If the same series 
of steps is used in a number of methods, a method can be created containing only 
those steps and accessed using a Run Method step. Multiple Run Method steps can 
be used within a method. Methods referenced by a Run Method step must be stored 
in the active project file.

Although it is not visible in the Method View, the Run Method step ‘inserts’ all of 
the steps from the referenced method into the current method at the point the Run 
Method step appears. All of the steps contained in the submethod are completed as a 
part of the current method; they are not completed as a separate method. 

Note:  A ‘submethod’ is a method run within another method. It is recommended 
that the submethod use the same Instrument Setup step configuration as the method 
in progress. If the submethod and the method in progress do not use the same 
Instrument Setup, an Instrument Setup step must be added to the method in 
progress to ensure that all labware for both methods is visible to the instrument.

The advantages of using Run Method are:

• The ability to run a method within a method

• Allows repetition of steps configured in a previously created method without 
recreating those steps

• Variables assigned in the Run Method step are accessible by the submethod 

• Controls the size of the current method and reduces confusion by listing only 
the Run Method step in the Method View, not all of the steps accessed by 
the Run Method step
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Insert Run Method into the Method View (Figure 17-2).

Figure 17-2.  Run Method step and configuration

17.3.1 Configuring the Run Method Step
To configure the Run Method step:

1. In File Name, select a submethod to run within the method in progress. The Run 
Method step shows the name of the submethod.

Note:  Only submethods stored in the same project file as the method in progress 
are available. To access a submethod stored in another project file, import the 
desired submethod into the project (refer to Section 6.10, Importing and 
Exporting Project Files).

2. Configure any variables as needed (refer to Section 13.1, Overview).

Method View
The method displayed 
contains a Run Method 
step. Note that the Run 
Method step shows the 
name of the submethod.

Run Method Step Configuration 
The Run Method Step Configuration allows the selection of a 
previously created method and then runs it as a submethod within 
the current method. Variables configured in the Run Method 
Step Configuration are accessible by the submethod.



17-6 Using the Advanced Step Palette

Beckman Coulter, Inc.

17.4 Worklist Step
The Worklist step uses a text file to supply multiple values for one or more variables 
(Figure 17-3). Worklist is useful when repetition of the same step(s) is required, but a 
variable, or variables, needs to change each time the step(s) is executed. When a 
group of steps using the variable(s) defined in a text file are placed inside a Worklist 
step, Worklist automatically performs each step once for each line in the text file. The 
steps using the variable(s) defined in the text file are substeps within the Worklist step 
in the Method View.

Figure 17-3.  Worklist example

Note:  Values read from the text file must be formatted correctly in order for Biomek 
Software to create the worklist with the desired row and column formatting. Each row 
in the text file represents a row in the worklist. In each row, columns are designated 
by separating individual values with commas. 

Worklist text files may be created in a database, spreadsheet, or text editor. When 
creating a worklist in a database or spreadsheet, save the file in comma-separated 
values (*.csv) format. When using a text editor or word processor, manually separate 
values on a single line with commas and save the file in text (*.txt) format.

Note:  Quotation marks may be used in the text file, but they must come in pairs. The 
Worklist step looks at the first set of quotation marks and interprets that everything 
after them is included as a row of data up to the second set of quotation marks. If 
quotation marks are desired in a row of data, use another set of quotation marks 
around the data within the quotations marks. For example, type ““this is a comment”” 
in the text file and “this is a comment” will appear in the row of data in the Worklist 
step.

The Worklist step operates like a combined Let/Loop step because it ‘lets’ a variable 
in the Worklist text file use different values for each pass of the Worklist ‘loop’. 
Worklist ‘loops’ through the substeps until each step has used each line of the 
Worklist text file specified.

When Worklist is added to a method, the Worklist icon and an End Worklist icon 
appear in the Method View. Any step(s) inserted between the Worklist and End 
Worklist icons use the variables contained in the Worklist text file configured in the 
Worklist step.

Rows of data

Values Used During the 
Worklist Step

Value assigned during each pass of 
the Worklist for each of the steps 
within the Worklist step.

Rows of Data
Each row of data represents a pass 
for the step(s) nested within the 
Worklist step.

Loop Variable
The variable assigned in the 
Worklist configuration that holds 
the current iteration of the 
Worklist ‘loop’.



Using the Advanced Step Palette 17-7

Biomek Software User’s Manual

Advantages of using a Worklist include:

• Data in a text file is accessible by any Biomek Software method.

• Selecting the text file in the Worklist Step Configuration copies all of the 
variable data from the text file into the Worklist Step Configuration without 
individually entering all of the variables and their values in each of the steps 
performed inside the Worklist step (Figure 17-4).

• A dynamic link exists between the method and the text file. The Worklist 
step accesses the text file each time the method is run; therefore, any updates 
made to the text file are included in the next method run.

Note: The text file configured in the Worklist step must maintain its 
original file path, or the method will not be able to find the text file. If the 
text file path changes, update the Worklist Step Configuration to reflect the 
new file path.

Figure 17-4.  Worklist step and configuration

Insert Worklist into the Method View (Figure 17-4).

Worklist Step Configuration
The Worklist configuration allows the selection of a text file that can be 
used by the method under development. When a file is selected, the 
Worklist configuration updates to display the contents of the specified file; 
however, the Worklist configuration cannot edit the contents of the file.

Loop Variable
Specify a name for the loop 
variable and which values of 
the Loop variable to use here.

Browse
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17.4.1 Configuring the Worklist Step
To configure Worklist, complete the following:

1. Click the Browse. . . button following File Name. Open appears (Figure 17-5).

Figure 17-5.  Worklist — text file selection

2. Browse to and select the text file accessed during the method run.

Note:  The file path and the file name of the text file are included in the Worklist 
step in the Method View.

3. Click Open to add the file to the Worklist configuration and return to the main 
Biomek Software window.

4. Enter a name for the Loop Variable. The loop variable holds the current 
iteration number of the worklist.

5. Select Loop entire worklist to use all rows of the worklist.

OR

Select Loop from line and enter the start and end row numbers to use a specific 
range of rows from the worklist.
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17.5 Just in Time Step
Just In Time synchronizes the execution of the substeps within the Just In Time step 
(Figure 17-6). 

The steps within the Just In Time step are queued in the order in which they appear 
in the Method View, but it is possible to execute two or more steps simultaneously. In 
Figure 17-6, for example, the first two substeps are completed, then deck position P8 
is paused. While the pause on P8 is in process, the next four steps are completed 
because they do not require access to deck position P8. Finally, the last two steps are 
completed once the pause is finished because they require access to deck position P8.

Note:  An incubation period is accomplished using the Pause step (refer to Section 
15.5, Pause Step). 

Figure 17-6.  Just In Time step

Since Just In Time is a part of the Transfer, Combine, and Move Labware steps, it 
is not necessary to use these steps in conjunction with the Just In Time step. 

Method View
The method displayed contains a 
Just In Time step. Note that the 
Just In Time step contains 
nested steps, which can be 
hidden from view to control the 
size of the method displayed in 
the Method View.



17-10 Using the Advanced Step Palette

Beckman Coulter, Inc.

Use Just In Time when an Aspirate operation and its subsequent Dispense 
operation must occur immediately following an incubation period (Figure 17-6) or 
when a method requires that a preparatory operation should not occur too early with 
respect to another related operation.

Note:  Any steps placed between the Just In Time and End Just In Time icons are 
configured in their individual Step Configurations, but they are completed when 
appropriate within the Just In Time step.

Insert Just In Time into the Method View. The Just In Time icon appears in the 
method, as well as an End Just In Time icon (Figure 17-6). 

To configure Just In Time, enter the steps requiring synchronized timing between the 
Just In Time and End Just In Time icons.

Note:  The Just In Time step does not affect the Estimated Time to Completion for 
the method when its substeps are already synchronized steps, such as the Transfer, 
Combine, or Move Labware steps.
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17.6 Let Step
The Let step is used to create variables accessible only to the sub-steps of the Let step 
(Figure 17-7). The variables can be used by multiple steps within the Let step, and 
they allow configuration of the steps by specifying explicit values for things like 
volumes and heights. For example, instead of typing the number of microliters into 
the volume field of an Aspirate step, the name of a variable is inserted. Every time 
the Aspirate step is executed, the current value of that variable is used as the volume.

Figure 17-7.  Let step and configuration

When the Let step is added to a method, the Let and End Let icons appear (Figure 
17-7). Any steps placed between the Let and End Let icons are substeps controlled 
by the Let step, but they are configured through their individual Step Configurations. 
Substeps are enqueued for execution in the order of appearance in the Method View; 
however, it is possible to execute two or more steps simultaneously.

Any of the substeps within the Let step can use variables created in the Let Step 
Configuration. Only the Name is displayed in the step configuration, not the Value 
associated with that Name. The Biomek Software automatically uses the associated 
Value when the step is executed.

Let configuration
The Let configuration assigns a Name and 
Value to variables used by the steps nested 
within the Let step. Variables assigned in 
the Let step are only available to the 
substeps within the Let step; they are not 
available to steps outside the Let step.

Method View
The method displayed contains a Let 
step. Variables assigned in the Let Step 
Configuration can appear in the Let step 
caption in the Method View; however, 
if numerous variables are assigned and 
they cannot all be displayed in the Let 
step caption, an ellipsis appears in the 
caption instead.
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17.6.1 Configuring the Let Step
Configuring the Let step involves creating the variables used by the substeps within 
the Let step (Figure 17-7).

Insert Let into the Method View (Figure 17-7).

To configure the Let step:

1. Insert the variables desired (refer to Section 13.1, Overview).

2. Enter desired steps between Let and End Let icons.

3. Configure the substeps between Let and End Let.
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17.7 If Step
The If step controls which steps in a method are executed based on a condition, such 
as the volume of liquid in a piece of labware. When If is run, Biomek Software tests 
the If condition, then processes the appropriate block of substeps based on the results 
of the test. 

The substeps of If are:

• Then — substeps following Then are processed if the condition is true.

• Else — substeps following Else are processed if the condition is false.

• End — the End substep terminates each If, Then, and Else block of steps 
(Figure 17-8). 

To insert an If step into a method, insert If into the Method View. The If Step 
Configuration appears (Figure 17-8).

Figure 17-8.  If step and configuration

If Step Configuration
The condition being verified and acted upon is 
input in the If Step Configuration. 

Method View
The condition being tested appears in the If step 
command in the Method View. Note the nested 
Then and Else steps which are completed, 
depending on the results of the condition tested.
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17.7.1 Configuring the If Step
To configure the If step:

1. Enter the Condition in the configuration.

Note:  A Condition must be a valid VBScript expression and can refer to 
variables defined in other steps.

2. Highlight End under the Then substep.

3. Add and configure the steps performed if the condition is true.

4. Highlight End under the Else substep.

5. Add and configure the steps to perform if the condition is false.

Note:  Any steps placed between the Then and End or Else and End icons are 
configured in their individual Step Configurations using the same procedures as 
though they were a main step in the method.
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17.8 Script Step
Note:  The information in this section is intended only to assist in gaining an 
understanding of what the scripting function does. It is not intended to be a tutorial on 
scripting. The Script step is provided only for the use of methods developed within 
Beckman Coulter at this time. This function is not currently supported for end-user 
applications.

More information is available at http://msdn.microsoft.com/scripting and in VBScript 
in a Nutshell, 2nd Edition, Matt Childs, Paul Lomax, and Ron Petrusha 2003, 
O’Reilly & Associates, Inc.

Note:  Refer to Chapter 28, Scripting, for other information on scripting.

While the editors and templates in Biomek Software provide the means to perform 
most operations, it is possible that some highly specialized liquid-handling 
applications are beyond this scope. Although not an activity typically required by 
users, Biomek Software uses the Script step for writing script to accommodate these 
advanced needs.

A Biomek Software script consists of lines of code that provide instructions for 
instrument operations. The lines of code, or commands, may be typed into the Script 
Step Configuration. Running the method invokes a Visual Basic® script interpreter 
that evaluates each line of code and performs the requested operation.

Dragging a Script step from the Method View to the Step Palette makes it available as 
a step to any method (refer to Chapter 29, Changing Window Appearance). To make 
the values defined in a Let step available to the Script step, place the Script step 
within the Let step.

The Script step provides a configuration area in which a description of the script step 
may be entered and lines of code may be written (Figure 17-9). 

[ /Rect [ XLL YLL XUR YUR ] /Action << /Subtype /URI /URI (http://msdn.microsoft.com/scripting) >> /Border [ 0 0 0 ] /Subtype /Link /ANN
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Insert Script into the Method View (Figure 17-9).

Note:  Place the Script step within a Let block of steps (refer to Section 17.6, Let 
Step) to use the variables defined in the Let step in the Script.

Figure 17-9.  Script step and configuration

Script Step Configuration
Code is entered here in this Script step 
configuration area.

Method View
The Description 
entered in the Script 
step configuration 
appears in the method.

Enter the description here. 
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17.8.1 Configuring the Script Step
To configure the Script step:

1. In Description, enter a description for the operation or purpose of the Script 
Step.

Note:  The Description replaces the word "Script" in the Script step caption in 
the Method View.

2. Position the cursor in the Script Step Configuration.

Note:  The lines of code can be entered in a word processor and then copied and 
pasted into the Script Step Configuration using standard Windows™ procedures. 
Use standard Windows™ techniques for editing scripts.

3. Write and edit the script.

Note:  The Biomek Software scripting feature is based on Visual Basic Scripting, a 
subset of the Microsoft® Visual Basic programming language. Any code interpreted 
by Visual Basic Scripting can be interpreted by the instrument and may be included in 
a method. More Visual Basic Scripting information is available at 
http://msdn.microsoft.com/scripting and in the book, VBScript in a Nutshell, 2nd 
Edition, Matt Childs, Paul Lomax, and Ron Petrusha 2003, O’Reilly & Associates, 
Inc. For more specific Biomek Software scripting help, contact Beckman Coulter 
Technical Support.
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17.9 Scripted Let Step
Note:  The information in this section is intended only to assist in gaining an 
understanding of what the scripting function does. It is not intended to be a tutorial on 
scripting. The Scripted Let step is provided only for the use of methods developed 
within Beckman Coulter at this time. This function is not currently supported for end-
user applications.

More information is available at http://msdn.microsoft.com/scripting and in VBScript 
in a Nutshell, 2nd Edition, Matt Childs, Paul Lomax, and Ron Petrusha 2003, 
O’Reilly & Associates, Inc.

Note:  Refer to Chapter 28, Scripting, for other information on scripting.

The Scripted Let step is similar to the Script step (refer to Section 17.8, Script Step), 
except it allows for variables created within a Script to be extended outside the Script 
and used in the method like variables created in a Let step (refer to Section 17.6, Let 
Step). Two additional commands are available to set variables — Extend and 
WeakExtend. 

• Extend — sets the variable name to the specified value for all steps 
contained within the Scripted Let. The proper syntax for Extend is Extend 
“Variable Name”, Value.

• WeakExtend — sets the variable name to the specified value for all steps 
contained within the Scripted Let step if the specified variable does not 
already have a value. This is similar to a Let variable with Overridable 
selected. The proper syntax for WeakExtend is WeakExtend “Variable 
Name”, Value.

The Scripted Let step provides a configuration area in which a description of the 
script step may be entered and lines of code may be written. 
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Insert Scripted Let into the Method View (Figure 17-10).

Note:  Place the Scripted Let step within a Let block of steps (refer to Section 17.6, 
Let Step) to use the variables defined in the Let step in the Script.

Figure 17-10.  Scripted Let step and configuration

Scripted Let Step Configuration
Code is entered here in this Scripted Let step 
configuration area.

Method View
The Description 
entered in the Script 
step configuration 
appears in the method.

Enter the description here. 
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17.9.1 Configuring the Scripted Let Step
To configure the Scripted Let step:

1. In Description, enter a description for the operation or purpose of the Scripted 
Let Step.

Note:  The Description replaces the words “Scripted Let” in the Scripted Let 
step caption in the Method View.

2. Position the cursor in the Scripted Let Step Configuration.

Note:  The lines of code can be entered in a word processor and then copied and 
pasted into the Scripted Let Step Configuration using standard Windows® 
procedures. Use standard Windows techniques for editing scripts.

3. Write and edit the script.

Note:  The Biomek Software scripting feature is based on Visual Basic 
Scripting, a subset of the Microsoft® Visual Basic programming language. Any 
code interpreted by Visual Basic Scripting can be interpreted by the instrument 
and may be included in a method. More Visual Basic Scripting information is 
available at http://msdn.microsoft.com/scripting and in the book, VBScript in a 
Nutshell, 2nd Edition, Matt Childs, Paul Lomax, and Ron Petrusha 2003, 
O’Reilly & Associates, Inc. For more specific Biomek Software scripting help, 
contact Beckman Coulter Technical Support.

4. Insert any substeps between Scripted Let and End Scripted Let that utilize any 
variables defined in the Scripted Let.

Note:  Variables extended outside of a script in the Scripted Let step are only 
available to the substeps within the Scripted Let.
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18 Using the Span-8 Step Palette

18.1 Overview
FX, NX-S8 — Only the Span-8 Pod may be used with steps on the Span-8 
step palette.

3000 — The Serial Dilution, Transfer From File, and Define Pattern 
steps can all be used with pipetting tools on the Biomek 3000.

Steps on the Span-8 Step Palette provide individual control over liquid-handling 
functions, including tip handling and pipetting operations, using the Span-8 Pod 
outside the Transfer and Combine steps. Additional steps, such as Serial Dilution 
and Transfer From File, configure larger operations involving multiple liquid-
handling functions.

The Transfer and Combine steps on the Basic Step Palette are used with the Span-8 
Pod to configure larger operations involving multiple liquid-handling functions when 
strict control of every operation is not necessary.

Note:  For information on using and configuring the Transfer and Combine steps 
using a Span-8 Pod, refer to Section 15.3, Configuring Transfer and Combine Steps.

CAUTION: Make sure the correct ALP is chosen when configuring the 
deck setup in the Deck Editor. ALPs vary in height and failure to choose 
the correct ALP in the Deck Editor may result in collisions between 
pod(s) and ALPs during operation.

The steps available in the Span-8 Step Palette are:

• Serial Dilution — performs a series of dilutions on a single microplate.

3000 — Serial Dilution can be used in methods on the Biomek 3000.

• Span-8 Aspirate — aspirates a specified amount of liquid from a single 
source in preparation for the Span-8 Dispense step.
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• Span-8 Dispense — dispenses a specified amount of liquid into destination 
labware, following the Span-8 Aspirate step.

• Span-8 New Tips — loads new tips to the Span-8 probes.

• Span-8 Tip Discard — unloads tips from the Span-8 probes.

• Span-8 Wash Tips — washes tips by flushing tips with system fluid at a 
Span-8 Tip Wash ALP or by aspirating and dispensing at a Wash Station 96 
ALP. The Span-8 Wash Tips step is also used to purge air from system 
tubing and syringes during a method.

• Transfer From File — performs well-to-well transfers using a comma-
separated data file.

3000 — Transfer From File can be used in methods on the Biomek 
3000.

• Define Pattern — create a method-specific well pattern manually or by 
reading well information from a file.

3000 — Define Pattern can be used in methods on the Biomek 3000.

When one of the above steps is added to a method, the configuration associated with 
that step appears on the right side of the Biomek Software main editor, in Step 
Configuration (Figure 18-1).

Note:  Steps not configured appropriately in Step Configuration generate errors when 
the method is validated or run.
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18.2 Displaying the Span-8 Step Palette
In order to add Span-8 steps to a method, display the Span-8 Step Palette 
(Figure 18-1). 

3000 — Only the Serial Dilution, Transfer From File, and Define Pattern 
steps are displayed for a Biomek 3000 instrument.

Figure 18-1.  Biomek main editor with Span-8 Step Palette displayed

To display the Span-8 Step Palette, complete the following:

• Right-click any empty palette space, and the Step Palette menu appears. 
Select Span-8.

OR

• From the menu bar, select Options>Toolbars>Span-8.

Method View
The method is 
built step by step 
in the Method 
View.

Step Configuration
When a step is highlighted in the Method 
View, the corresponding configuration 
appears in this area.

Span-8 Step 
Palette
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18.3 Serial Dilution Step (including 3000)
The Serial Dilution step is used to perform multiple dilutions of a sample on a single 
microplate. The Serial Dilution step transfers liquid from wells on a microplate to 
other wells on the same microplate and may also add diluent to those wells. The 
microplate may be prepared by the Serial Dilution step or in the same method prior to 
the Serial Dilution step.

Serial dilution completes multiple dilutions by performing the following actions in 
sequence:

• Transfer a volume of diluent from the diluent labware to all selected wells 
except the first row or column (unless specified otherwise).

• Transfer a volume of sample from the first selected well to the next selected 
well.

• Mix the solution.

Note: The Serial Dilution step does not automatically mix the solution. 
Select Customize to add mixing to the technique or create a new technique 
in the Technique Editor. Refer to Section 9.3, Creating New Techniques, for 
information on creating and modifying techniques.

• Transfer a volume of solution to the next selected well.

• Mix the solution.

• Repeat transfer and mix operations until all selected wells are used.

Note:  The labware may be previously prepared, either by hand or by using the 
Biomek instrument, with a specific volume of diluent in the selected wells. If the 
labware is previously prepared, skip the step that adds diluent to the wells.

The Serial Dilution step specifies:

• Pod that performs the dilution.

• Probes that are used during dilution.

• Tips used during dilution.

• Labware type accessed during serial dilution.

• Position of the labware on the deck.

• Liquid type of the labware.

• Wells in the selected labware to use for dilution.

• Volume being diluted.

• Direction in which wells are accessed during dilution.

• Technique.

• Diluent labware type accessed during serial dilution.

• Position of the diluent labware on the deck.

• Liquid type of the diluent labware.

• Wells in the selected diluent labware to use for dilution.

• Dilution ratio.
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Insert a Serial Dilution step into the method (Figure 18-2).

Figure 18-2.  Serial Dilution step and configuration

Method View
The method displayed 
contains a Serial 
Dilution step.

Serial Dilution Step 
Configuration
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18.3.1 Configuring the Serial Dilution Step
When a Serial Dilution step is added to a method, the Serial Dilution Step 
Configuration appears (Figure 18-2).

Note:  If it is desired to have diluent in any unused wells as a standard, tips can be 
conserved by using a Transfer step to transfer diluent to the unused wells and 
selecting Leave them on in the Tip Handling configuration.

To configure Serial Dilution:

1. If using a dual-pod FX instrument, specify the Pod performing the dilution 
operation by selecting a Span-8 Pod from the list. The pod configured as the 
default pod is displayed in Pod. If the other pod is desired, select the pod from 
the drop-down list or the Current Deck Display.

OR

If using a 3000, insert and configure a Load Tool or Change Tool step to load 
an MP20 or MP200 tool in the method before the Serial Dilution.

Note:  Refer to Section 20.3, Change Tool Step or Section 20.4, Load Tool Step 
for information about configuring the desired step.

2. If using a Span-8 pod on the FX or NX-S8, select the probes used in the dilution 
by highlighting the desired numbers next to Probes. Any combination of probes 
may be used as long as all selected probes are using the same type of tips and 
syringes.

Note:  All disposable tips are selected by default. If there are only fixed tips, all 
tips are selected by default. For example, if the Span-8 Pod is equipped with 
fixed tips on probes 1-4 and disposable tips on probes 5-8, probes 5-8 will be 
selected by default. However, if probes 5-8 are also equipped with fixed tips, all 
eight probes are selected by default.

3. In Use Tips, select the tip type loaded from the drop-down list. 

OR

Select the tip box from the Current Deck Display with the desired tip type. 
Selecting tips from the Current Deck Display automatically updates Tips in the 
Step Configuration.

FX, NX-S8 — If the selected Probes are equipped with fixed tips, Use 
Tips is set to Fixed and is not configurable.

Note:  If tip boxes were assigned names in the Instrument Setup step, enter 
that name in Use Tips. If tips were not assigned names, select the tip type. It is 
recommended that tips not be named in the Instrument Setup step because this 
could restrict the step from locating available tips.
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4. Click on the desired piece of labware in the Current Deck Display in which the 
serial dilution is performed. Information for that piece of labware is entered 
automatically into the Serial Dilution Step Configuration.

OR

Select a Labware Type from the list (Figure 18-3).

Note:  The labware contains the sample that is diluted in the first row or column 
of selected wells, depending on the direction of dilution selected.

Figure 18-3.  Serial Dilution step configuration with labware configured

5. Verify the Position of the labware. 

Note:  A green outline appears in the Current Deck Display around the selected 
labware.

6. Select the Liquid Type being diluted in the selected labware.

7. Select the wells on the labware to use in the serial dilution. Select the wells 
according to the procedures described in Chapter 11, Creating Well Patterns.

Note:  To zoom in on the labware, double-click on the labware. To call up a 
menu for Zoom In and a Specify Selection as Text option, right-click on the 
labware. 

Specify Selection as Text allows the selection of the first well in a microplate 
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as a target for the dispense operation. Specify Selection as Text may also be 
used to enter variables or expressions. Wells are numbered left to right and down 
(for example, the first row is wells 1-12, the second row wells 13-24, etc., for a 
96-well microplate).

8. Enter the Volume diluted in each well of the selected labware. If using a variable 
or expression, enter an equal sign (=) followed by the variable name or 
expression; for example, =AspValue. Otherwise, just enter the desired value.

Note:  This is the volume of each diluted solution that is transferred to the next 
well for the next dilution.

9. Select the Direction to dilute. The specified Volume is transferred from each 
well to the next selected well in the chosen Direction for the next dilution. 
Available options are:

• Left to right — dilutes across rows of microplate (Figure 18-4).

• Top to bottom — dilutes down columns of microplate (Figure 18-5).

3000 — The direction must be Left to right.

Figure 18-4.  Serial Dilution from left to right

Leftmost selected well
Contains sample to dilute. 

Diluted sample is transferred in 
direction of arrows, as indicated in 
Direction. Diluent is added to well 
and mixed before transferring to 
next selected well.
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Figure 18-5.  Serial Dilution from top to bottom

10. Select Discard extra volume from last wells to aspirate the extra Volume 
from the last wells and discard it at the Span-8 Tip Wash ALP so that each well 
contains the same volume of solution. 

11. If using an FX or NX-S8, choose Wash tips in to use the active 96-Channel Tip 
Wash ALP to wash the tips.

3000 — Tip wash options are not available. Proceed to step 19.

Note:  A WashStation96 ALP must be added to the deck and configured in the 
Deck Editor before washing can occur. Clicking on a WashStation96 ALP while 
the Serial Dilution step is being configured places a check in Wash tips in, and 
populates Wash tips in with the solution configured for the WashStation96 ALP 
in Labware Properties on the Instrument Setup step.

Note:  If Wash tips in is not selected, proceed to step 15.

12. In Wash tips in, select a solution for the wash cycle if the field does not already 
contain a solution.

Note:  The wash solution specified in the Serial Dilution step must match the 
solution selected in Labware Properties for the WashStation96 ALP on the 
Instrument Setup step configuration, or an error occurs.

13. Choose the number of cycles to aspirate and dispense during wash.

Topmost selected well
Contains sample to dilute. 

Diluted sample is transferred in 
direction of arrows, as indicated in 
Direction. Diluent is added to well 
and mixed before transferring to 
next selected well.
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14. In %, provide the volume of wash fluid to use when washing tips as a percentage 
of the maximum volume of fluid contained in the tips in previous steps; for 
example, if the maximum volume of fluid transferred is 50 µL, and the % is set 
for 110%, the Transfer step washes the tips with 55 µL of solution.

Note:  If the % sign is deleted in the % field, the field label changes to µL. Any 
value entered is now interpreted as a specific volume, not a percentage.

15. If using an FX or NX-S8 with fixed tips installed, choose Wash tips with to 
use the passive Span-8 Tip Wash ALP to wash fixed tips.

Note:  A Span-8 Tip Wash ALP must be added to the deck and configured in the 
Deck Editor before washing can occur. Only fixed tips can be washed with the 
Span-8 Tip Wash ALP. If using disposable tips and washing is desired, go back to 
11. If Wash tips with is not selected, proceed to step 19.

16. In Wash tips with, enter the volume of system fluid to use when washing the 
outside of the tips.

17. In after dispensing, enter the volume of system fluid to use when washing the 
inside of the tips.

18. If using a Span-8 Pod on FX, select Speed Pump to use the speed pump when 
flushing the tips with system fluid, if desired.

OR

If using a Span-8 Pod on NX-S8, select purge pump to use the purge pump 
when flushing tips with system fluid, if desired.

Note:  The speed pump or purge pump is an optional device that can be used to 
shorten the time it takes to wash tips. A speed pump or purge pump must be 
added as a device and configured with the Span-8 Pod in Hardware Setup to 
use it when washing tips.

19. Choose Change tips between transfers to change tips between transferring 
diluent and sample.

Note:  Change tips between transfers is available only when disposable tips 
are installed on all probes.
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20. The software automatically selects a Technique based on the liquid type, 
labware type, tip type, and volume being transferred. To override this selection, 
deselect Auto-Select and choose the desired Technique.

OR

Choose Customize and configure the technique as desired in the Technique 
Editor. 

Note:  For more information on customizing, configuring, and saving a 
technique, refer to Section 12.3.1, Understanding Techniques.

Note:  It is recommended a technique include mixing for best results. Select 
Customize to add mixing to the technique or create a new technique in the 
Technique Editor. Refer to Section 9.3, Creating New Techniques, for 
information on creating and modifying techniques.

21. If the labware is previously prepared with diluent, select a step that occurs after 
the Serial Dilution step or the Finish step to validate the step configuration.

OR

If the labware is not previously prepared with diluent, configure Diluent 
Properties. Proceed to Section 18.3.2, Configuring Diluent Properties.
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18.3.2 Configuring Diluent Properties
Diluent Properties are configured if the sample microplate is not previously 
prepared with diluent. The Diluent Properties configuration allows for diluent to be 
transferred from a piece of labware to the wells used for the dilution.

The Diluent Properties configuration can be collapsed to allow more room during 
configuration. When collapsed, the diluent properties configuration is displayed as 
the text Diluent Properties.

To collapse or expand the Diluent Properties configuration, click the arrow to the 
left of Diluent Properties or the textual display.

To configure Diluent Properties for the Serial Dilution step:

1. Click the arrow to the left of Diluent Properties or the textual display to expand 
the Diluent Properties configuration (Figure 18-6).

Figure 18-6.  Serial Dilution — Diluent Properties configuration

2. Select Add diluent before transfer to activate the Diluent Properties 
configuration.

Arrow to collapse/
expand Diluent 
Properties.

Diluent Properties
Diluent labware is 
configured in the 
expanded Diluent 
Properties section.
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3. Click on the desired piece of labware in the Current Deck Display to select the 
labware with the diluent. Information for that piece of labware is entered 
automatically into the Diluent Properties configuration.

OR

Select a Diluent Labware Type from the list (Figure 18-7).

Note:  Reservoirs are the only labware type valid for diluent retrieval.

Figure 18-7.  Serial Dilution step configuration with diluent labware

4. Verify the Diluent Position of the diluent labware. 

5. Select the Diluent Liquid Type of the diluent in the diluent labware.

6. Enter the desired Dilution Ratio. If using a variable, enter an equal sign (=) 
followed by the variable name; for example, =AspValue. Otherwise, just enter 
the desired value.

Note:  The Dilution Ratio is set up as a ratio of volume of sample to total 
solution (sample plus diluent) volume. For example, a Dilution Ratio of 1:2 
indicates that for every microliter of sample there are two microliters of solution, 
or a 50 percent dilution (one microliter of diluent added).
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7. Select the wells on the labware from which to aspirate diluent. Select the wells 
according to the procedures described in Chapter 11, Creating Well Patterns.

Note:  To zoom in on the labware, double-click on the labware. To call up a 
menu for Zoom In and a Specify Selection as Text option, right-click on the 
labware. 

Specify Selection as Text allows the selection of the first well in a microplate 
as a target for the dispense operation. Specify Selection as Text may also be 
used to enter variables or expressions. Wells are numbered left to right and top to 
bottom (for example, the first row is wells 1-12, the second row wells 13-24, etc., 
for a 96-well microplate).

8. Select Add Diluent to leftmost/topmost selected wells if it is desired to 
use the first selected well for the first dilution. Enough diluent to achieve the 
entered Dilution Ratio is added to the first selected well.

Note:  If the dilution Direction is configured as Left to Right, Add diluent to 
leftmost selected wells is available (Figure 18-4). If the dilution Direction is 
configured as Top to Bottom, Add diluent to topmost selected wells is 
available (Figure 18-5). 

9. If using an FX or NX-S8, choose Wash tips in to use the active 96-Channel Tip 
Wash ALP to wash the tips.

3000 — Tip wash options are not available. Proceed to step 17.

Note:  A WashStation96 ALP must be added to the deck and configured in the 
Deck Editor before washing can occur. Clicking on a WashStation96 ALP while 
the Serial Dilution step is being configured places a check in Wash tips in, and 
populates Wash tips in with the solution configured for the WashStation96 ALP 
in Labware Properties on the Instrument Setup step.

Note:  If Wash tips in is not selected, proceed to step 13.

10. In Wash tips in, select a solution for the wash cycle if the field does not already 
contain a solution.

Note:  The wash solution specified in the Serial Dilution step must match the 
solution selected in Labware Properties for the WashStation96 ALP on the 
Instrument Setup step configuration, or an error occurs.

11. Choose the number of cycles to aspirate and dispense during wash.

12. In %, provide the volume of wash fluid to use when washing tips as a percentage 
of the maximum volume of fluid contained in the tips in previous steps; for 
example, if the maximum volume of fluid transferred is 50 µL, and the % is set 
for 110%, the Transfer step washes the tips with 55 µL of solution.

Note:  If the % sign is deleted in the % field, the field label changes to µL. Any 
value entered is now interpreted as a specific volume, not a percentage.
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13. If using an FX or NX-S8 with fixed tips installed, choose Wash tips with to 
use the passive Span-8 Tip Wash ALP to wash fixed tips.

Note:  A Span-8 Tip Wash ALP must be added to the deck and configured in the 
Deck Editor before washing can occur. Only fixed tips can be washed with the 
Span-8 Tip Wash ALP. If using disposable tips and washing is desired, go back to 
9. If Wash tips with is not selected, proceed to step 17.

14. In Wash tips with, enter the volume of system fluid to use when washing the 
outside of the tips.

15. In after dispensing, enter the volume of system fluid to use when washing the 
inside of the tips.

16. If using a Span-8 Pod on FX, select Speed Pump to use the speed pump when 
flushing the tips with system fluid, if desired.

OR

If using a Span-8 Pod on NX-S8, select purge pump to use the purge pump 
when flushing tips with system fluid, if desired.

Note:  The speed pump or purge pump is an optional device that can be used to 
shorten the time it takes to wash tips. A speed pump or purge pump must be 
added as a device and configured with the Span-8 Pod in Hardware Setup to 
use it when washing tips.

17. Choose Change tips between diluent transfers to change tips between 
each diluent transfer.

Note:  Change tips between diluent transfers is available only when 
disposable tips are installed on all probes.

18. The software automatically selects a Technique based on the liquid type, 
labware type, tip type, and volume being transferred. To override this selection, 
deselect Auto-Select and choose the desired Technique.

OR

Choose Customize and configure the technique as desired in the Technique 
Editor. 

Note:  For more information on customizing, configuring, and saving a 
technique, refer to Section 12.3.1, Understanding Techniques.

Note:  It is recommended to use a technique that includes mixing for best 
results. Select Customize to add mixing to the technique or create a new 
technique in the Technique Editor.

19. Select a step that occurs after the Serial Dilution step or the Finish step to 
validate the step configuration.
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18.4 Span-8 Aspirate Step 
The Span-8 Aspirate step (Figure 18-8) removes liquid from source labware in 
preparation for dispensing to destination labware. The Span-8 Aspirate step is often 
used in conjunction with the Span-8 Dispense, Span-8 New Tips, and Span-8 
Discard Tips steps, but it can be used with any combination of steps. Span-8 
Aspirate provides more direct control over pipetting operations than the Transfer or 
Combine steps because it offers more explicit control over individual probe 
aspiration volumes and well access.

Note:  If the Span-8 Pod is equipped with disposable tips, it is necessary to load tips 
to the probes using a Span-8 New Tips step prior to aspirating.

The Span-8 Aspirate Step Configuration includes specifying:

• Labware type accessed during aspirate.

• Position of the labware on the deck.

• Type of liquid to aspirate.

• Volume to aspirate.

• Pod that performs the aspirate.

• Probes that are used during aspirate.

• Spacing between probes during aspirate.

• Tip refresh, if desired, and the type of tips used.

• Wells in the selected labware from which to aspirate.

• Technique.

• Pipetting height.
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Insert a Span-8 Aspirate step into the method (Figure 18-8).

Figure 18-8.  Span-8 Aspirate step and configuration

Method View
The method 
displayed contains a 
Span-8 Aspirate 
step. Note that tips 
are loaded prior to the 
Span-8 Aspirate 
step and unloaded 
after the Span-8 
Dispense step.

Span-8 Aspirate 
Step Configuration

Spacing
Sets the separation 
between probes using 
a number of wells.

Pod and Probe Selection
Allows for the selection of the 
pod and probes used for the 
Span-8 Aspirate operation.
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18.4.1 Configuring the Span-8 Aspirate Step
When a Span-8 Aspirate step is added to a method, the Span-8 Aspirate Step 
Configuration appears (Figure 18-8). 

To configure the Span-8 Aspirate step:

1. Click on the desired piece of labware in the Current Deck Display. Information 
for that piece of labware is entered automatically into the Span-8 Aspirate Step 
Configuration.

OR

Select a Labware Type from the drop-down list (Figure 18-9).

Figure 18-9.  Span-8 Aspirate step configuration with labware configured

2. Verify the Position of the labware. 

Note:  A bright blue outline appears in the Current Deck Display around the 
selected labware.

3. Select the Liquid Type contained in the selected labware.

4. If using a dual-pod FX instrument, specify the Pod performing the aspirate 
operation by selecting a Span-8 Pod from the list. The pod configured as the 
default pod is displayed in Pod. If the other pod is desired, select the pod from 
the drop-down list or the Current Deck Display.
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5. Select the Probes used in the aspirate step by highlighting the desired probe 
numbers. Any combination of probes may be used as long as all selected probes 
are using the same type of tips and syringes.

Note:  All disposable tips are selected by default. If there are only fixed tips, all 
tips are selected by default. For example, if the Span-8 Pod is equipped with 
fixed tips on probes 1-4 and disposable tips on probes 5-8, probes 5-8 are 
selected by default. However, if probes 5-8 are also equipped with fixed tips, all 
eight probes are selected by default.

6. Select the Spacing. Spacing is the number of wells between probes. For 
example, if a spacing of 3 is selected, the probes hit every third well.

Note:  When aspirating from a 384-well microplate, it is not possible to aspirate 
from adjacent wells. A minimum spacing of 2 wells is required. When aspirating 
from some tube racks, it must aspirate from adjacent wells and probe spacing is 
not possible.

7. Select the wells on the labware to aspirate from by hovering the mouse over the 
graphic representing the labware. The wells highlighted in yellow indicate the 
wells accessed based on the selected probes and spacing. Click to select the 
wells. The wells appear blue after they are selected. 

For example, if aspirating from a 384-well plate, probes 1-4 are selected, and 
Spacing is set at 4, wells are selected as shown in Figure 18-10.

Figure 18-10.  Example of how probe and spacing selection affects well selection

Note:  To zoom in on the selected labware, double-click on the labware. To call 
up a menu for Zoom In and a Specify Selection as Text option, right-click on 
the labware. 

Specify Selection as Text allows the selection of the first well in a microplate 
as a target for the aspirate operation. The first selected probe (lowest probe 
number) aspirates from the specified well. Remaining probes aspirate from wells 
based on the specified well and Spacing. Specify Selection as Text may also 
be used to enter variables or expressions. Wells are numbered left to right and 
down (for example, the first row is wells 1-12, the second row wells 13-24, etc., 
for a 96-well microplate).

8. Enter the Volume aspirated from the selected labware. If using a variable or 
expression, enter an equal sign (=) followed by the variable name or expression; 
for example, =AspValue. The Volume is aspirated by all selected Probes.

Spacing of four leaves 
three empty wells between 
selected wells.
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9. To aspirate a different volume in each probe, select Individual Volumes and 
choose Edit. Individual Volumes appears (Figure 18-11).

Figure 18-11.  Individual Volumes

10. Enter the volume each probe is to aspirate in Individual Volumes. If using a 
variable or expression, enter an equal sign (=) followed by the variable name or 
expression; for example, =AspValue. A volume may only be entered for the 
probes that are selected on the Span-8 Aspirate step configuration. Deselected 
probes appear grayed out in Individual Volumes.

11. Choose OK. Individual Volumes closes.

12. Check Refresh Tips, if desired, and specify the tip type to load new tips to the 
pod whether tips are currently loaded or not.

A probe that is 
not selected on 
the step 
configuration 
appears grayed 
out in 
Individual 
Volumes.
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13. The software automatically selects a Technique based on the liquid type, 
labware type, tip type, and volume being aspirated. To override this selection, 
deselect Auto-Select and select the desired Technique (Figure 18-12).

OR

Choose Customize and configure the technique as desired in the Technique 
Editor. 

Note:  For more information on customizing, configuring, and saving a 
technique, refer to Section 12.3.1, Understanding Techniques.

Note:  If the technique is auto-selected and the volumes specified differ enough 
to require different techniques, an aspiration is performed for each unique 
technique.

Figure 18-12.  Span-8 Aspirate step — Adjusting the aspirate height

Adjust the tip height 
for Span-8 Aspirate 

Height display

Notifies that the technique is 
not using the default settings

Technique 
selection
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14. Leave the tip height as is to use the settings specified in the pipetting technique.

OR

Set the aspirate height manually using one of the following techniques:

• Set the aspirate height by positioning the cursor over the graphic of a tip 
inside a well (Figure 18-12). Click and drag the graphic up or down. The 
tip moves with the cursor, and the height displayed below the graphic is 
adjusted as the graphic is manipulated.

Note: The cursor changes to a hand when positioned over the 
graphic. 

• Position the cursor in the graphic of a tip inside a well, and adjust the 
height using the ↑ and ↓ keys.

• Right-click on the graphic of a tip inside a well, and a menu appears. 
Select Custom Height, and Custom Height appears (Figure 18-13). 
Insert the Height in millimeters (mm) and, in from, select a reference 
point from the drop-down list. 

Figure 18-13.  Custom Height prompt

Note:  The phrase (Overrides Technique) appears below the graphic when the 
tip height is changed by manipulating the graphic (Figure 18-12), or when the 
technique is changed with the Customize option.

15. If desired, right-click on the graphic of a tip inside a well and choose how the tip 
height is measured:

• Measure from Liquid — The tip height is measured from the surface 
of the liquid in the well.

Note: With standard tips, Measure from Liquid requires that a 
known volume of liquid be entered in Labware Properties for the 
labware to aspirate from. If the volume of liquid is not known, liquid 
level sensing (LLS) tips must be used to measure the tip height from the 
surface of the liquid in the well (refer to Section 9.4.5, Setting Liquid 
Level Sensing Values (FX, 3000, and NX-S8 only)).

• Measure from Bottom — The tip height is measured from the 
bottom of the well.

• Measure from Top — The tip height is measured from the top of the 
well.

16. Select a step that occurs after the Span-8 Aspirate step or the Finish step to 
validate the step configuration.
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18.5 Span-8 Dispense Step
The Span-8 Dispense step dispenses liquid into a single destination labware 
following aspirate. The Span-8 Dispense step is often used in conjunction with the 
Span-8 Aspirate, Span-8 New Tips, and Span-8 Discard Tips steps, but it can be 
used with any combination of steps. Span-8 Dispense provides more direct control 
over pipetting operations than the Transfer or Combine steps because it offers more 
explicit control over individual probe dispense volumes and well access.

Tips must be loaded and have liquid in them from a previous step, such as a Span-8 
Aspirate step, prior to using a Span-8 Dispense step.

The Span-8 Dispense Step Configuration includes specifying:

• Labware type accessed during dispense.

• Position of the labware on the deck.

• Type of liquid to dispense.

• Volume to dispense.

• Pod that performs the dispense.

• Probes that are used during dispense.

• Spacing of the probes during dispense.

• Empty tips, if desired.

• Wells in the selected labware to dispense.

• Technique.

• Pipetting height.

• Disposal of excess liquid into the reservoir section of the nearest Span-8 
Wash ALP.
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Insert a Span-8 Dispense step into the method (Figure 18-14).

Figure 18-14.  Span-8 Dispense step and configuration

Method View
The method 
displayed contains a 
Span-8 Dispense 
step. The location of 
the dispense 
operation is specified 
in the Dispense 
caption in the 
Method View. 

Span-8 Dispense Step Configuration
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18.5.1 Configuring the Span-8 Dispense Step
When a Span-8 Dispense step is added to a method, the Span-8 Dispense Step 
Configuration appears (Figure 18-14). 

To configure the Span-8 Dispense step:

1. Click on the desired piece of labware in the Current Deck Display. Information 
for that piece of labware is entered automatically into the Span-8 Dispense 
Step Configuration.

OR

Select a Labware Type from the list (Figure 18-15).

Figure 18-15.  Span-8 Dispense step configuration with labware configured

2. Verify the Position of the labware. 

Note:  A bright yellow outline appears in the Current Deck Display around the 
selected labware.

3. Select the Liquid Type contained in the tips.

4. If using a dual-pod FX instrument, specify the Pod performing the dispense 
operation by selecting a Span-8 Pod from the list. The pod configured as the 
default pod is displayed in Pod. If the other pod is desired, select the pod from 
the drop-down list or the Current Deck Display.
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5. Select the Probes that will be used in the dispense step by highlighting the 
desired probe numbers. Any combination of probes may be used as long as all 
selected probes are using the same type of tips and syringes.

Note:  All disposable tips are selected by default. If there are only fixed tips, all 
tips are selected by default. For example, if the Span-8 Pod is equipped with 
fixed tips on probes 1-4 and disposable tips on probes 5-8, probes 5-8 are 
selected by default. However, if probes 5-8 are also equipped with fixed tips, all 
eight probes are selected by default.

6. Select the Spacing. Spacing is the number of wells between probes. For 
example, if a spacing of 3 is selected, the probes will hit every third well.

Note:  When dispensing to a 384-well microplate, it is not possible to dispense 
to adjacent wells. A minimum spacing of 2 wells is required. When dispensing to 
tube racks, it must dispense to adjacent tubes and probe spacing is not possible.

7. Check Empty Tips, if desired, to expel the Trailing Air Gap, the fluid contained 
in the tip, and the Blow Out all at one time, rather than as separate operations.

Note:  The default setting for Empty Tips is Off.

8. Select the wells on the labware to dispense to by hovering the mouse over the 
graphic representing the labware. The wells highlighted in yellow indicate the 
wells accessed based on the selected probes and spacing. Click to select the 
wells. The wells appear blue after they are selected.

For example, if dispensing to a 384-well plate, probes 1-4 are selected, and 
Spacing is set at 4, wells are selected as shown in Figure 18-16.

Figure 18-16.  Example of how probe and spacing selection affects well selection

Note:  To zoom in on the selected labware, double-click on the labware. To call 
up a menu for Zoom In and a Specify Selection as Text option, right-click on 
the labware. 

Specify Selection as Text allows the selection of the first well in a microplate 
as a target for the dispense operation. The first selected probe (lowest probe 
number) dispenses from the specified well. Remaining probes dispense from 
wells based on the specified well and Spacing. Specify Selection as Text may 
also be used to enter variables or expressions. Wells are numbered left to right 
and down (for example, the first row is wells 1-12, the second row wells 13-24, 
etc., for a 96-well microplate).

Spacing of four leaves three 
empty wells between 
selected wells.
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9. Enter the Volume dispensed to the selected labware. If using a variable or 
expression, enter an equal sign (=) followed by the variable name or expression; 
for example, =AspValue. The Volume is dispensed from all selected Probes.

10. To dispense a different volume in each probe, select Individual Volumes and 
choose Edit. Individual Volumes appears (Figure 18-17).

Figure 18-17.  Individual Volumes

11. Enter the volume each probe is to dispense in Individual Volumes. If using a 
variable or expression, enter an equal sign (=) followed by the variable name or 
expression; for example, =AspValue. A volume may only be entered for the 
probes that are selected on the Span-8 Dispense step configuration. De-selected 
probes appear grayed-out in Individual Volumes.

12. Choose OK. Individual Volumes closes.

A probe that is 
not selected on 
the step 
configuration 
appears grayed 
out in 
Individual 
Volumes.
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13. The software automatically selects a Technique based on the liquid type, 
labware type, tip type, and volume being dispensed. To override this selection, 
deselect Auto-Select and select the desired Technique (Figure 18-18).

OR

Choose Customize and configure the technique as desired in the Technique 
Editor. 

Note:  For more information on customizing, configuring, and saving a 
technique, refer to Section 12.3.1, Understanding Techniques.

Note:  If the technique is auto-selected and the volumes specified differ enough 
to require different techniques, a dispense is performed for each unique 
technique.

Figure 18-18.  Span-8 Dispense step — Adjusting the dispense height

Height display

Adjust the tip height 
for Span-8 Dispense 

Notifies that the technique is 
not using the default settings



Using the Span-8 Step Palette 18-29

Biomek Software User’s Manual

14. Leave the tip height as is to use the settings specified in the pipetting technique.

OR

Set the aspirate height manually using one of the following techniques:

• Set the aspirate height by positioning the cursor over the graphic of a tip 
inside a well (Figure 18-18). Click and drag the graphic up or down. The 
tip moves with the cursor, and the height displayed below the graphic is 
adjusted as the graphic is manipulated.

Note: The cursor changes to a hand when positioned over the 
graphic. 

• Position the cursor in the graphic of a tip inside a well, and adjust the 
height using the ↑ and ↓ keys.

• Right-click on the graphic of a tip inside a well, and a menu appears. 
Select Custom Height, and Custom Height appears (Figure 18-19). 
Insert the Height in millimeters (mm) and, in from, select a reference 
point from the drop-down list. 

Figure 18-19.  Custom Height prompt

Note:  The phrase (Overrides Technique) appears below the graphic when the 
tip height is changed by manipulating the graphic (Figure 18-18), or when the 
technique is changed with the Customize option.
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15. If desired, right-click on the graphic of a tip inside a well and choose how the tip 
height is measured:

• Measure from Liquid — The tip height is measured from the surface 
of the liquid in the well.

Note: With standard tips, Measure from Liquid requires that a 
known volume of liquid be entered in Labware Properties for the 
labware to dispense to. If the volume of liquid is not known, liquid level 
sensing (LLS) tips must be used to measure the tip height from the 
surface of the liquid in the well.

• Measure from Bottom — The tip height is measured from the 
bottom of the well.

• Measure from Top — The tip height is measured from the top of the 
well.

16. Check Discard Excess to dispense any excess liquid into the reservoir section 
of the nearest Span-8 Wash ALP. 

Note:  The default setting for Discard Excess is Off.

17. Select a step that occurs after the Span-8 Dispense step or the Finish step to 
validate the step configuration.
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18.6 Span-8 New Tips Step
The Span-8 New Tips step instructs the Biomek instrument to load new tips to the 
Span-8 Pod at a specific point in a method. Tips may also be loaded onto the probes of 
the Span-8 Pod automatically as part of a Transfer, Combine, or Span-8 Aspirate 
step. Span-8 New Tips is used when precise tip control is required. Span-8 New 
Tips is used in conjunction with the Span-8 Discard Tips step (refer to Section 18.7, 
Span-8 Tip Discard Step). 

Loading new tips is recommended when:

• Current tips have been used and carryover must be avoided.

• Current tips have manipulated a caustic fluid.

• Current tips are not seated properly.

• Integrity of the current tips is in question.

Insert a Span-8 New Tips into the method (Figure 18-20).

Figure 18-20.  Span-8 New Tips step and configuration

Span-8 New Tips 
Step Configuration

Method View
The method 
displayed contains a 
Span-8 New Tips 
step prior to the 
Span-8 Aspirate 
step.
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18.6.1 Configuring the Span-8 New Tips Step
When a Span-8 New Tips step is added to a method, the Span-8 New Tips Step 
Configuration appears (Figure 18-20). 

To configure Span-8 New Tips:

1. If using a dual-pod FX instrument, specify the Pod requiring new tips by 
selecting a Span-8 Pod from the list. The pod configured as the default pod is 
displayed in Pod. If the other pod is desired, select the pod from the drop-down 
list or the Current Deck Display.

2. Select the Tips to load in the Span-8 New Tips step. 

OR

Select the tip box from the Current Deck Display with the desired tip type. 
Selecting tips from the Current Deck Display automatically updates Tips in the 
Step Configuration.

Note:  If tip boxes were assigned names in the Instrument Setup step, enter 
that name in Tips. If tips were not assigned names, select the tip type. It is 
recommended that tips not be named in the Instrument Setup step because this 
could restrict the Span-8 New Tips step from locating available tips.

3. Select the Probes that need new tips by highlighting the probe numbers.

Note:  All disposable tips are selected by default. If there are only fixed tips, all 
tips are selected by default. For example, if the Span-8 Pod is equipped with 
fixed tips on probes 1-4 and disposable tips on probes 5-8, probes 5-8 will be 
selected by default. However, if probes 5-8 are also equipped with fixed tips, all 
eight probes are selected by default.

Note:  Probes equipped with fixed tips cannot have tips loaded.

4. Select a step that occurs after the Span-8 New Tips step or the Finish step to 
validate the step configuration.
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18.7 Span-8 Tip Discard Step
The Span-8 Tip Discard step instructs the Biomek instrument to unload tips from a 
Span-8 Pod at a specific point in a method. Tips may also be discarded from the 
probes of the Span-8 Pod automatically as part of a Transfer, Combine, or Span-8 
Dispense step. Span-8 Tip Discard is used when precise tip control is required. 
Span-8 Tip Discard is often used in conjunction with the Span-8 New Tips step, 
but it can be used with any combination of steps. 

Span-8 Tip Discard is used when tip integrity is in question or when cross-
contamination between labware is a concern. Span-8 Tip Discard can be used in 
place of the Unload (Tips) option in the Transfer and Combine steps, and is 
particularly useful with Loop and Worklist steps.

Unloading tips is recommended when:

• Current tips have been used and carryover must be avoided.

• Current tips have manipulated a caustic fluid.

• Current tips are not seated properly.

• Integrity of the current tips is in question.

• To avoid cross-contamination of samples.

Insert a Span-8 Tip Discard step into the method (Figure 18-21).

Figure 18-21.  Span-8 Tip Discard step and configuration

Span-8 Tip Discard 
Step Configuration

Method View
The method 
displayed contains a 
Span-8 Tip Discard 
step after the Span-8 
Dispense step.
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18.7.1 Configuring the Span-8 Tip Discard Step
When a Span-8 Tip Discard step is added to a method, the Span-8 Tip Discard 
Step Configuration appears (Figure 18-21). 

To configure Span-8 Tip Discard:

1. If using a dual-pod FX instrument, specify the Pod requiring tip removal by 
selecting a Span-8 Pod from the list. The pod configured as the default pod is 
displayed in Pod. If the other pod is desired, select the pod from the drop-down 
list or the Current Deck Display.

2. Select the Probes that will discard tips by highlighting the probe numbers.

Note:  All disposable tips are selected by default. If there are only fixed tips, all 
tips are selected by default. For example, if the Span-8 Pod is equipped with 
fixed tips on probes 1-4 and disposable tips on probes 5-8, probes 5-8 will be 
selected by default. However, if probes 5-8 are also equipped with fixed tips, all 
eight probes are selected by default.

Note:  Probes equipped with fixed tips cannot discard tips.

3. Select a step that occurs after the Span-8 Tip Discard step or the Finish step to 
validate the step configuration.
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18.8 Span-8 Wash Tips Step
The Span-8 Wash Tips step flushes fixed tips with system fluid and cleans tips using 
the Span-8 Tip Wash ALP (refer to the ALPs User’s Manual, Chapter 18, Span-8 Tip 
Wash ALP), or washes disposable tips by performing multiple aspirate and dispense 
cycles at a 96-Channel Tip Wash ALP (refer to the ALPs User’s Manual, Chapter 13, 
Multichannel Tip Wash ALPs). Use the Deck Editor to add and configure the 
appropriate wash ALP to the deck (refer to Chapter 5, Preparing and Managing the 
Deck). 

The Span-8 Wash Tips step can be configured to perform either a passive wash or 
an active wash. A Passive Wash uses the Span-8 Tip Wash ALP, a Passive ALP, to 
wash fixed tips. An Active Wash uses a 96-Channel Tip Wash ALP, an Active ALP, 
to wash disposable or fixed tips.

Note:  It is recommended that a Span-8 Wash Tips step be inserted at the start of 
every method to purge the tubing and syringes of air. If the Span-8 Pod is idle during 
the method, it may be necessary to insert another Span-8 Wash Tips step into the 
method immediately before a Span-8 Pod begins to move.

Note:  If using a system with mixed fixed and disposable tips, it is necessary to insert 
separate Span-8 Wash Tips steps to purge each set of four probes used in the 
method.

The Span-8 Wash Tips Step Configuration includes specifying:

• Pod performing the wash operation.

• Wash station position on the deck.

• Type of wash to perform: Active Wash or Passive Wash.

• Volume of system fluid used in the wash process.

• Technique, liquid type, and number of wash cycles if an Active Wash is 
chosen.

• Delay before proceeding with method.

• Which probes to wash.
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Insert a Span-8 Wash Tips step into the method (Figure 18-22).

Figure 18-22.  Span-8 Wash Tips step — Passive Wash configuration

18.8.1 Configuring the Span-8 Wash Tips Step for 
a Passive Wash

When a Span-8 Wash Tips step is added to a method, the Span-8 Wash Tips Step 
Configuration appears (Figure 18-22). 

A Passive Wash uses the Span-8 Tip Wash ALP to cleanse fixed tips. To perform a 
Passive Wash, a Span-8 Tip Wash ALP must be physically on the deck and configured 
in Instrument Setup (refer to Chapter 4, Configuring Hardware Setup) and the Deck 
Editor (refer to Chapter 5, Preparing and Managing the Deck).

The Span-8 Tip Wash ALP has two parts: an open drain for dispensing waste, and 
eight wells used to clean the tips with system fluid. System fluid washes the inside of 
the tips and is dispensed through the open drain. Then the tips fit into the wells and 
the outside of the tips are washed with system fluid. 

Span-8 Wash Tips 
Step Passive Wash 

Configuration 

Method View
The method displayed 
contains a Span-8 Wash 
Tips step. The Span-8 
Wash Tips step can be 
used at the start of a method 
to clear the system of any 
air bubbles. 

Wash Options
Options to wash tips 
using a Passive Wash 
or an Active Wash.
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CAUTION: Do not purge the system without mandrels installed and 
tubing attached to disposable or fixed tips. Purging the system without 
the mandrels installed and the tubing attached to tips may cause 
corrosion in the tip interface.

Note:  The Span-8 Wash Tips step Passive Wash can be used at the beginning of 
a method or during a method in which the Span-8 Pod is idle to purge the tubing and 
syringes of air rather than using Manual Control.

Note:  All disposable tips must be discarded prior to initiating a Span-8 Tip Wash 
Passive Wash to clean the probes or purge the system.

To configure the Span-8 Wash Tips step for a Passive Wash:

1. If using a dual-pod FX instrument, specify the Pod performing the wash 
operation by selecting a Span-8 Pod from the list. The pod configured as the 
default pod is displayed in Pod. If the other pod is desired, select the pod from 
the drop-down list or the Current Deck Display.

2. Select a Position from the drop-down list.

Note:  The Span-8 Wash ALP is added to the deck and configured for use with 
the Deck Editor (refer to Chapter 5, Preparing and Managing the Deck).

Note:  If a wash station is not selected, the closest available wash station is used.

3. Select the Probes to wash.

Note:  All disposable tips are selected by default. If there are only fixed tips, all 
tips are selected by default. For example, if the Span-8 Pod is equipped with 
fixed tips on probes 1-4 and disposable tips on probes 5-8, probes 5-8 will be 
selected by default. However, if probes 5-8 are also equipped with fixed tips, all 
eight probes are selected by default.

Note:  All disposable tips must be discarded prior to initiating a Span-8 Tip 
Wash Passive Wash to clean the probes or purge the system.

4. Select Only wash tips that have been used to automatically wash only the 
probes have been used. The software determines from the method which probes 
require washing and washes only those tips.

Note:  When using the Passive Wash to purge the tubing and syringes of air, 
make sure that Only wash tips that have been used is not selected to flush all 
probes with system fluid.

5. Select Passive Wash to wash the fixed tips using a Span-8 Wash ALP. The 
Passive Wash configuration appears (Figure 18-22).

Note:  When using the Passive Wash to purge system tubing of air bubbles for 
probes equipped with disposable tips, make sure that no tips are loaded to the 
probes.
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6. In Dispense, enter the volume of system fluid, in milliliters (mL), to use to 
wash the inside of the tips. The inside of the tips are flushed with the specified 
volume of system fluid and dispensed into the open drain on the Span-8 Tip 
Wash ALP.

Note:  When using the Passive Wash to purge the tubing and syringes of air, 
use approximately 10 to 15 mL of system fluid.

7. In Wash, enter the volume of system fluid, in milliliters (mL), to use to wash the 
outside of the tips. The outside of the tips are washed with the specified volume 
of system fluid while the tips are positioned in the wells of the Span-8 Tip Wash 
ALP.

Note:  If Dispense tip contents only is selected, any liquid in the tips is 
dispensed to the open drain, but the tips are not flushed with system fluid. The 
Dispense to waste and Wash while in the wells options are unavailable when 
Dispense tip contents only is selected.

8. In Delay, enter the time, in milliseconds (ms), to hold the pod over the Span-8 
Wash ALP after each dispense.

Note:  The default Delay is 300 milliseconds (ms).

9. If using a Span-8 Pod on FX, select Speed Pump to use the speed pump when 
flushing the tips with system fluid, if desired.

OR

If using a Span-8 Pod on NX-S8, select purge pump to use the purge pump 
when flushing tips with system fluid, if desired.

Note:  The speed pump or purge pump is an optional device that can be used to 
shorten the time it takes to wash tips. A speed pump or purge pump must be 
added as a device and configured with the Span-8 Pod in Hardware Setup to 
use it when washing tips.

10. Select a step that occurs after the Span-8 Wash Tips step or the Finish step to 
validate the step configuration.
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18.8.2 Configuring the Span-8 Wash Tips Step for 
an Active Wash

When a Span-8 Wash Tips step is added to a method, the Span-8 Wash Tips Step 
Configuration appears (Figure 18-22). 

An Active Wash uses the 96-Channel Tip Wash ALP to cleanse disposable or fixed 
tips. To perform an Active Wash, a 96-Channel Tip Wash ALP must be physically on 
the deck and configured in Instrument Setup (refer to Chapter 4, Configuring 
Hardware Setup) and the Deck Editor (refer to Chapter 5, Preparing and Managing 
the Deck).

FX — In a dual-pod system, the 96-Channel Tip Wash ALP must be located 
in a deck position accessible by the Span-8 Pod to use Active Wash options.

To configure the Span-8 Wash Tips step for an Active wash:

1. If using a dual-pod FX instrument, specify the Pod performing the wash 
operation by selecting a Span-8 Pod from the list. The pod configured as the 
default pod is displayed in Pod. If the other pod is desired, select the pod from 
the drop-down list or the Current Deck Display.

2. Click on the Wash Station 96 ALP in the Current Deck Display. Information 
for that wash station is entered automatically into the Wash Step Configuration.

OR

Select a Position.

Note:  The Wash Station 96 ALP is added to the deck and configured for use 
with the Deck Editor (refer to Chapter 5, Preparing and Managing the Deck).

Note:  If a wash station is not selected, the closest available wash station is used.

3. Select the Probes to wash.

Note:  All disposable tips are selected by default. If there are only fixed tips, all 
tips are selected by default. For example, if the Span-8 Pod is equipped with 
fixed tips on probes 1-4 and disposable tips on probes 5-8, probes 5-8 will be 
selected by default. However, if probes 5-8 are also equipped with fixed tips, all 
eight probes are selected by default.

4. Select Only wash tips that have been used to automatically wash only the 
tips that have been used. The software determines from the method which tips 
require washing and washes only those tips.
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5. Select Active wash to wash the disposable or fixed tips using a 96-Channel Tip 
Wash ALP. The Active wash configuration appears (Figure 18-23).

Figure 18-23.  Span-8 Wash Tips step — Active Wash configuration

6. Enter the Volume of fluid to use when washing the tips.

Note:  Enter the volume as a percent (including the percent sign, %) to specify 
the volume of wash fluid as a percent of the maximum volume of fluid contained 
in the tips in previous steps. For example, if the maximum volume of fluid 
transferred is 50 µL, and the % is set for 110%, the Wash step washes the tips 
with 55 µL of solution. However, if no fluid has been transferred and the volume 
is entered as a percent, no action is taken and tips are not washed.

7. Specify in Wash Cycles the number of aspirate and dispense operations 
completed during the wash operation.

8. Verify the Liquid Type contained in the selected 96-Channel Tip Wash ALP.

Note:  The Liquid Type contained in the 96-Channel Tip Wash ALP is 
configured in the Instrument Setup step. If the Wash Station is selected from 
the Current Deck Display, the information is automatically inserted.

9. Select a step that occurs after the Span-8 Wash Tips step or the Finish step to 
validate the step configuration.

Span-8 Wash Tips 
Step Active Wash 

Configuration 

Wash Options
Options to wash tips 
using a Passive wash 
or an Active wash.
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18.9 Transfer From File Step (including 3000)
Transfer From File allows a specified volume to be transferred from a specified 
source well to a specified destination well by reading data from a comma-delimited 
text file (.txt or .csv). A comma-delimited text file is a text file that specifies the 
values of a table by separating each column with a comma and each row with a return. 

3000 — Transfer From File may only be used with a single-tip pipette 
tool.

The Transfer From File configuration specifies:

• Pod that performs the transfer.

• Probes that are used during the transfer.

• Tip handling.

• File properties.

• Source labware.

• Destination labware.

• Transfer details.
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Insert a Transfer From File step into the Method View. The Transfer From File 
Step Configuration appears (Figure 18-27). 

Figure 18-27.  Transfer From File step and configuration

Pod and Probe Configuration
The pod and probes performing the 
liquid transfer must be specified. A 
Span-8 Pod on an FX or NX-S8 or 
pipetting tool on a 3000 must be 
used for the transfer operation.

Tip Handling Configuration
Tip Handling parameters specify tip 
type, whether tips remain on the pod at 
the end of the liquid transfer, when to 
change tips, and tip wash options.
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18.9.1 Configuring Tip Handling
Configuring Tip Handling in the Transfer From File step is optional, because the 
Biomek instrument locates and loads clean tips automatically every time a Transfer 
From File step is initiated. It is recommended, however, that Tip Handling 
configuration be supplied if cross contamination or conserving consumables is a 
concern. 

Tip Handling is also used to configure washing fixed tips using the Span-8 Wash 
ALP or disposable tips using the 96-Channel Tip Wash ALP. Refer to Section 18.8, 
Span-8 Wash Tips Step, for more information on washing tips on the Span-8 Pod.

To configure Tip Handling (Figure 18-27) for the Transfer From File step:

1. If using a dual-pod FX instrument, specify the Pod performing the transfer 
operation. The pod configured as the default pod is displayed in Pod. If the other 
pod is desired, select the pod from the drop-down list or the Current Deck 
Display.

OR

If using a 3000, configure a Load Tool or Change Tool step with a P20 or 
P200L tool in the method before the Transfer From File.

Note:  Refer to Section 20.3, Change Tool Step or Section 20.4, Load Tool Step 
for information about configuring the desired step.

2. If using a Span-8 pod on the FX or NX-S8, select the probes used in the transfer 
by clicking the probe numbers in Use Probes. Any combination of probes may 
be used as long as all selected probes are using the same type of tips and syringes. 

OR

Right-click any of the probe numbers in Use Probes and make a selection from 
the menu. Options include:

• Use Disposable Tips — selects all probes with disposable tips.

• Use Fixed Tips — selects all probes with fixed tips.

• Use Selection — allows for custom selection.

Note:  Disposable tips are selected by default. If the Span-8 Pod has only fixed 
tips, all tips are selected by default. For example, if the Span-8 Pod is equipped 
with fixed tips on probes 1-4 and disposable tips on probes 5-8, probes 5-8 are 
selected by default. However, if probes 5-8 are also equipped with fixed tips, all 
eight probes are selected by default.

Note:  If the probes selected are equipped with fixed tips, the Load and unload 
them/leave them on options (steps 4 and 5) are unavailable and the fixed tips 
are used for the transfer. Proceed to step 6.

3. If Tip Handling is not already displayed, click the arrow or sentence summary to 
expand the Tip Handling configuration.
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4. Check Load and select the type of tips used in the transfer to load tips at the start 
of the Transfer From File step. If Load is unchecked, the Transfer From File 
step uses previously loaded tips, rather than loading new tips at the start of the 
Transfer From File step. Unchecking Load deactivates initial tip loading for the 
Transfer From File step.

Note:  Tips are selected from the drop-down list, or from the Current Deck 
Display. If tips are selected via the Current Deck Display, and the tips are named, 
Load displays the name, not the tip type. If a name was not assigned to the tips, 
the tip type is displayed in Load.

It is recommended that tips not be named in the Instrument Setup step, because 
this could restrict the instrument from locating available tips.

Note:  If Load is checked and the tips loaded on the pod have been used, an 
error may occur. To increase the number of uses allowed for tips, increase the 
Load no more than count in the Labware Properties configuration in the 
Instrument Setup step.

5. To discard tips after the Transfer From File step is completed, select unload 
them.

OR

To leave tips on after the Transfer From File step is completed, select leave 
them on.

Note:  The Load and unload them/leave them on fields (steps 4 and 5 above) 
are useful when multiple Transfer From File steps are used within a method; for 
example, in the first Transfer From File step, check Load and select leave 
them on. In the second Transfer From File step, uncheck Load and select 
leave them on. In the third Transfer From File step, uncheck Load and 
select unload them. This loads new tips for the first Transfer From File step, 
uses the same set of tips for all three Transfer From File steps, and unloads the 
tips when the third Transfer From File step is completed. This is useful when 
trying to conserve consumables.

6. If using an FX or NX-S8, choose Wash tips in to use the active 96-Channel Tip 
Wash ALP to wash the tips.

3000 — Tip wash options are not available for the Biomek 3000. Proceed to 
step 14.

Note:  If Wash tips in is not selected, proceed to step 10.

Note:  A WashStation96 ALP must be added to the deck and configured in the 
Deck Editor before washing can occur. Clicking on a WashStation96 ALP while 
the Transfer From File step is being configured places a check in Wash tips in, 
and populates Wash tips in with the solution configured for the WashStation96 
ALP in Labware Properties on the Instrument Setup step.

7. In Wash tips in, select a solution for the wash cycle if the field does not already 
contain a solution.

Note:  The wash solution specified in the Transfer From File step must match 
the solution selected in Labware Properties for the Wash Station ALP on the 
Instrument Setup step configuration, or an error occurs.
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8. Choose the number of cycles to aspirate and dispense during wash.

9. In %, provide the volume of wash fluid to use when washing tips as a percentage 
of the maximum volume of fluid contained in the tips in previous steps; for 
example, if the maximum volume of fluid transferred is 50 µL, and the % is set 
for 110%, the Transfer step washes the tips with 55 µL of solution.

Note:  If the % sign is deleted in the % field, the field label changes to µL. Any 
value entered is now interpreted as a specific volume, not a percentage.

10. If using an FX or NX-S8 with fixed tips installed, choose Wash tips with to 
use the passive Span-8 Wash ALP to wash fixed tips.

Note:  A Span-8 Wash ALP must be added to the deck and configured in the 
Deck Editor before washing can occur. Clicking on a Span-8 Wash ALP while 
the Transfer From File step is being configured places a check in Wash tips 
with, and uses default values of 2 mL of system liquid after dispensing 1 mL 
to waste.

Note:  Only fixed tips can be washed with the Span-8 Wash ALP. If using 
disposable tips or Wash tips with is not selected, proceed to step 14.

11. In Wash tips with, enter the volume of system fluid to use when washing the 
outside of the tips.

12. In after dispensing, enter the volume of system fluid to use when washing the 
inside of the tips.

13. If using a Span-8 Pod on FX, select Speed Pump to use the speed pump when 
flushing the tips with system fluid, if desired.

OR

If using a Span-8 Pod on NX-S8, select purge pump to use the purge pump 
when flushing tips with system fluid, if desired.

Note:  The speed pump or purge pump is an optional device that can be used to 
shorten the time it takes to wash tips. A speed pump or purge pump must be 
added as a device and configured with the Span-8 Pod in Hardware Setup to 
use it when washing tips.

14. Select Change/Wash tips between transfers to change or wash tips 
between liquid transfers, if desired.

Note:  If the probes used for transfer are equipped with disposable tips and 
Wash tips in is not selected, the option to Change tips between transfers is 
available. If the probes used for transfer are equipped with fixed tips or 
disposable tips with Wash tips in selected, the option to Wash tips between 
transfers is available.

The Tip Handling configuration can be collapsed to allow more room during File 
Properties, Source Labware, and Destination Labware configuration. When 
collapsed, the Tip Handling configuration is displayed as a sentence summary 
(Figure 18-28). Use the sentence summary to verify that Tip Handling has been 
configured appropriately.
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To collapse or expand the Tip Handling configuration, click the arrow to the left of 
Tip Handling or the textual display (Figure 18-28).

Figure 18-28.  Transfer From File step — Tip Handling collapsed

Collapsed Tip Handling 
configuration.

Arrow to collapse/
expand Tip Handling

Pod and probe 
selection
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18.9.2 Configuring File Properties
Transfer From File uses a comma-separated value file to configure parts of the 
transfer operation. The File Properties configuration is needed to specify the file to 
use and which columns indicate what information.

The file must contain at least information on source wells accessed, but may also 
specify the position on deck or name of source labware, position on deck or name of 
destination labware, destination wells accessed, and volume transferred. If all 
information is specified by the data file, each row is a single well-to-well transfer. 

To configure File Properties for the Transfer From File step:

1. If File Properties is not already displayed, click the arrow or textual display to 
expand the File Properties configuration (Figure 18-29).

Figure 18-29.  Transfer From File — File Properties

File Properties 
Configuration

File Properties specifies 
the file to use for the 
transfer information and 
the type of information 
stored in each column.
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2. In File Name, enter the full path and file name of the data file from which to 
read the transfer information.

OR

Choose the browse button next to File Name and select the directory and file 
from which to read the transfer information in Open (Figure 18-30). The 
selected file is read and Example data is displayed (Figure 18-31).

Note:  The data file must be a comma-delimited text file (.txt or .csv).

Figure 18-30.  Open dialog

Figure 18-31.  Transfer From File — Example data displayed

Example Data
Data is read from the file 
selected in File Name and 
displayed here.

File Name
Select the file from 
which to read. 
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3. If the file read has a header row identifying the columns, select File has a 
header row. The first row of the data file is used to identify the columns (Figure 
18-32).

Figure 18-32.  Transfer From File — Example data with header row

4. Select File specifies source position in column if a column of the data file 
stores information about the position of source labware and select the desired 
column from the list.

Note:  The source position column may contain either deck positions (P4, P7, 
etc.) or labware names (Source1, Dest1, etc.). If information is stored as labware 
names, there must be labware on the deck with the specified labware name 
(Figure 18-32).

5. In File contains source well information in column, select the column of 
the data file that stores information about source wells from which to transfer 
from the list.

Note:  The source well column may specify wells with either alphanumeric well 
addresses (A1-H12 for a 96-well plate) or numeric well numbers (1-96 on a 96-
well plate). The same data file may contain both alphanumeric and numeric well 
information (Figure 18-32).

Specify the type of 
information stored in 
each column.

File has a header row
Uses the first row of the data 
file to identify columns.
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6. Select File specifies destination position in column if a column of the 
data file stores information about the position of destination labware and select 
the desired column from the list.

Note:  The destination position column may contain either deck positions (P4, 
P7, etc.) or labware names (Source1, Dest1, etc.). If information is stored as 
labware names, there must be labware on the deck with the specified labware 
name (Figure 18-32).

7. Select File contains destination well information in column if a column 
of the data file stores information about destination wells to which to transfer and 
select the desired column from the list.

Note:  The destination well column may specify wells with either alphanumeric 
well addresses (A1-H12 for a 96-well plate) or numeric well numbers (1-96 on a 
96-well plate). The same data file may contain both alphanumeric and numeric 
well information.

8. Select File contains volume information in column if a column of the data 
file stores information about the volume to transfer and select the desired column 
from the list.

Note:  All volumes are specified in microliters (µL).

9. Select Skip zero volume transfers to ignore any rows that specify a volume 
of 0 when performing the Transfer From File step.

The File Properties configuration can be collapsed to allow more room during 
Source Labware and Destination Labware configuration. When collapsed, the 
File Properties configuration is displayed as text. 

To collapse or expand the File Properties configuration, click the arrow to the left of 
File Properties or the textual display.
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18.9.3 Configuring Source Labware
A ‘source’ is a group of wells accessed at one time by the Biomek instrument to 
aspirate liquid; for example:

FX, NX-S8— A Span-8 Pod aspirates from one to eight wells at a time, 
depending on the selected probes.

3000 — Using a single-tip pipette tool, aspirates from a single well at a 
time.

The Transfer From File step configures multiple aspirate and dispense operations 
using the selected probes to transfer all source wells to the destination labware.

The Source Labware configuration for the Transfer From File step includes 
choosing:

• the labware type

• the labware location, if not specified by the file

• the liquid type

• the technique

• the pipetting height

Note:  Only one piece of Source Labware is configured, because the Transfer 
From File step moves liquid from a single source to one or more destinations. 
However, if the source position is specified by the file, multiple sources are accessed 
for the transfer, but all sources are configured by a single source configuration. 
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To configure Source Labware for the Transfer From File step:

1. Click on the Source configuration area to activate it (Figure 18-33).

Figure 18-33.  Transfer From File step — Source Labware selection

2. If the source position is not specified by the file, click on the desired piece of 
labware in the Current Deck Display (Figure 18-33). Information for that piece of 
labware is entered automatically into the Source Labware configuration.

OR

If the source position is specified by the data file, select the labware type of the 
source labware. All sources must use the same labware type. 

Note:  Reservoirs may not be used as Source Labware.

Note:  Once Source Labware has been selected, any subsequent selections 
become Destination Labware. If an incorrect piece of labware is selected, 
right-click on the labware title and select Delete on the menu that appears. 
If the Source Labware is incorrect, activate the Source Labware configuration 
by clicking anywhere in the source labware configuration area, and select another 
piece of labware.

Current Deck Display
The Current Deck Display is 
used for labware selection, 
and it displays the status of 
the deck upon completion of 
the previous step. 

Source labware selection

Source Labware 
configuration

If the position is specified by 
the file, the source labware 
title displays <file specified 
position>.



Using the Span-8 Step Palette 18-53

Biomek Software User’s Manual

3. Verify the deck position of the labware, if not specified by the data file. 

Note:  A bright blue outline appears in the Current Deck Display around the 
labware designated as the Source Labware.

4. In Using liquid type, select the type of liquid in the Source Labware
(Figure 18-34).

Note:  The default liquid type is the liquid type specified as the default in the 
Liquid Type Editor.

Figure 18-34.  Transfer From File step — Source Labware configuration

5. De-select Mark last well that is used, if it is not desired to mark wells. This 
option must be selected to use any options later in the method that make use of 
marks. For example, if Mark last well that is used is selected and the Transfer 
From File step runs out of sources before using all destinations, it will mark the 
last well that had liquid transferred to it. Another Transfer From File step is 
transferring liquid to the same plate. By selecting After last marked well as 
the Start condition, the first source well will be transferred to the first unused 
destination well.

Note:  Mark last well that is used can also be selected when the labware is 
zoomed out by using the Set mark button beneath the labware.

Note:  Mark last well that is used is selected by default.

Liquid type selection

Tip height
The question mark 
indicates that the labware 
contains an unknown 
volume and the pipetting 
operation is measured 
from the liquid level. 
Liquid Level Sensing is 
required.

Technique 
selectionMark last well that 

is used icon
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6. Keep the auto-selected Technique (refer to Section 15.3.2.1, Auto-Selection of 
a Technique).

Note:  The software automatically selects a Technique based on the liquid type, 
labware type, tip type, and volume being aspirated. 

OR

Manually select the desired Technique, or customize the selected Technique 
(refer to Section 15.3.2.2, Customizing and Saving a Technique). 

7. Leave the height as is to use the settings specified in the pipetting technique.

OR

Set the aspirate height manually using one of the following techniques:

• Set the aspirate height by positioning the cursor over the graphic of a tip 
inside a well. Click and drag the graphic up or down. The tip moves 
with the cursor, and the height displayed below the graphic is adjusted 
as the graphic is manipulated.

Note: The cursor changes to a hand when positioned over the 
graphic. 

• Position the cursor in the graphic of a tip inside a well, and adjust the 
height using the ↑ and ↓ keys.

• Right-click on the graphic of a tip inside a well, and a menu appears. 
Select Custom Height, and Custom Height appears (Figure 18-35). 
Insert the Height in millimeters (mm) and, in from, select a reference 
point from the drop-down list. 

Note:  The phrase (Overrides Technique) appears below the graphic when the 
tip height is changed by manipulating the graphic, or when the technique is 
changed with the Customize option.

Figure 18-35.  Custom Height prompt
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18.9.4 Configuring Destination Labware
A ‘destination’ is a group of wells accessed at one time by the Biomek instrument to 
dispense liquid; for example:

FX, NX-S8 — A Span-8 Pod dispenses to one to eight wells at a time, 
depending on the selected probes.

3000 — Using a single-tip pipette tool, dispenses to a single well at a time.

The Transfer From File step configures multiple aspirate and dispense operations 
using the selected probes to transfer all source wells to the destination labware when 
using the Span-8 Pod.

The Destination Labware configuration includes choosing:

• the labware type

• the labware location, if not specified in the data file

• the wells on labware used, if not specified in the data file

• the liquid amount to transfer, if not specified in the data file

• the liquid type

• the technique

• the pipetting height

Note:  Multiple pieces of Destination Labware can be configured for the Transfer 
From File step, because the Transfer step can move liquid from a single source to 
one or more destinations. However, if the destination position is specified in the data 
file, all destinations are configured by a single destination configuration.

To configure Destination Labware for the Transfer From File step:

1. If the destination position is not specified by the data file, click on the desired 
piece of labware in the Current Deck Display. Information for that piece of 
labware is entered automatically into the Destination Labware configuration.

OR

If the destination position is specified by the data file, select the Destination 
Labware type of the destination labware. All destinations must use the same 
labware type.

Note:  Once the first Destination Labware has been selected, the Source 
Labware parameters are collapsed to display a sentence summary. To reopen the 
Source labware parameters, click anywhere in the Source Labware 
configuration area.

Note:  Subsequent labware selections modify the active Source or Destination 
Labware configuration. To configure additional Destination Labware, select 
Click here to add a destination, or select outside a labware configuration, 
and then select another piece of labware from the Current Deck Display. If an 
incorrect piece of labware is selected, right-click on the labware title and select 
Delete on the menu that appears.

If either the destination position or destination wells are specified by the data file, 
additional destinations cannot be configured.
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Figure 18-36.  Transfer From File step — Destination Labware selection

Current Deck Display
The Current Deck 
Display is used for 
labware selection, and it 
displays the status of the 
deck upon completion of 
the previous step. 

Destination Labware 
selection

Destination Labware 
configuration

If the position is specified 
by the file, the Destination 
Labware title displays <file 
specified position>.
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2. Verify the deck position of the labware, if not specified by the data file. 

Note:  A bright yellow outline appears in the Current Deck Display around the 
labware designated as the Destination Labware.

Figure 18-37.  Transfer From File step — Destination Labware configuration 

3. Enter the amount of liquid (µL) dispensed into the Destination Labware, if not 
specified by the data file. If using a variable or expression, enter an equal sign (=) 
followed by the variable name or expression; for example, =AspValue (Figure 
18-37). 

4. Verify that the liquid type indicated is correct. The liquid type dispensed to the 
Destination Labware should match the liquid type in the Source Labware 
configuration.

5. Deselect Mark last well that is used, if it is not desired to mark wells. This 
option must be selected to use any options later in the method that make use of 
marks. For example, if Mark last well that is used is selected and the Transfer 
From File step runs out of sources before using all destinations, it will mark the 
last well that had liquid transferred to it. Another Transfer From File step is 
transferring liquid to the same plate. By selecting After last marked well as 
the Start condition, the first source well will be transferred to the first unused 
destination well. Mark last well that is used is selected by default.

Note:  Mark last well that is used can also be selected when the labware is 
zoomed out by using the Set mark button beneath the labware.

Technique selectionAdjust dispense 
height

Liquid type 
selection
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6. Keep the auto-selected Technique (refer to Section 15.3.2.1, Auto-Selection of 
a Technique).

Note:  The software automatically selects a Technique based on the liquid type, 
labware type, tip type, and volume being aspirated. 

OR

Manually select the desired Technique, or customize the selected Technique 
(refer to Section 15.3.2.2, Customizing and Saving a Technique). 

7. Leave the height as is to use the settings specified in the pipetting technique.

OR

Set the dispense height manually using one of the following techniques:

• Set the dispense height by positioning the cursor over the graphic of a 
tip inside a well. Click and drag the graphic up or down. The tip moves 
with the cursor, and the height displayed below the graphic is adjusted 
as the graphic is manipulated.

Note: The cursor changes to a hand when positioned over the 
graphic. 

• Position the cursor in the graphic of a tip inside a well, and adjust the 
height using the ↑ and ↓ keys.

• Right-click on the graphic of a tip inside a well, and a menu appears. 
Select Custom Height, and Custom Height appears (Figure 18-35). 
Insert the Height in millimeters (mm) and, in from, select a reference 
point from the drop-down list. 

Note:  The phrase (Overrides Technique) appears below the graphic when the 
tip height is changed by manipulating the graphic, or when the technique is 
changed with the Customize option.

Figure 18-38.  Custom Height prompt

8. If destination wells are not specified by the data file, go to Section 18.9.4.1, 
Configuring Destination Wells.

9. Repeat steps 1-8 for each additional piece of Destination Labware if neither 
destination positions nor destination wells are specified by the data file.
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18.9.4.1 Configuring Destination Wells
If destination wells were not specified by the data file, further configuration of the 
destination labware is required. 

To complete the Destination Labware configuration:

1. Double-click the Destination Labware graphic in the step configuration to 
zoom in on the labware.

Note:  To call up a menu for Zoom In and a Specify Selection as Text option, 
right-click on the labware. 

Specify Selection as Text allows the selection of wells in a microplate as 
targets for the transfer operation as comma-delimited text. Wells are numbered 
left to right and down (for example, the first row is wells 1-12, the second row 
wells 13-24, etc., for a 96-well plate). Specify Selection as Text may also be 
used to enter variables or expressions.

2. Select the wells that are destinations for the transfer using one of the following 
techniques:

FX, NX-S8 — Can select individual wells.

3000 — A single-tip pipette tool can select individual wells. 

• Choose Copy Pattern and select the desired pattern to use a 
previously defined well pattern created using the Well Patterns Editor 
(refer to Chapter 11, Creating Well Patterns). 

Note: The pattern must be compatible with the head or tool installed.

• Select Use pattern and choose a previously defined pattern from the 
list to use a pattern created in the Well Patterns Editor or a Define 
Pattern step.

Note: Refer to Section 18.10, Define Pattern Step (including 3000), 
for more information about creating patterns using the Define Pattern 
step.

• Define a well pattern using data sets (refer to Section 14.3.1, Defining 
Well Patterns Using Data Sets).

• Create a custom well pattern from the labware grid by dragging the 
mouse and using Ctrl and Shift on the keyboard. 

Note: Hold Shift and click a well to select additional wells without 
deselecting any wells. Hold Ctrl and click a well to toggle the selection 
status of selected wells without affecting the status of other wells. If 
Shift or Ctrl is not held down when selecting wells, any previous 
selection is deleted.

Note:  To save the pattern, right click the labware graphic and select Save 
Pattern from the menu. Enter a name for the pattern in New Pattern and 
choose OK.
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3. Select the Direction in which destination wells are mapped to sources. Down 
first, then left to right is the default selection.

Note:  Direction controls how source wells are mapped to the destination, not 
the physical order in which wells are transferred. The Transfer From File step 
automatically determines the most efficient way to complete the transfer.

• Down first, then left to right — goes down each column from top to 
bottom, then goes right to the next column (Figure 18-39)

Figure 18-39.  Wells accessed down first, then left to right

OR

• To the right first, then top to bottom — goes across each row from 
left to right, then goes down to the next row (Figure 18-40)

Figure 18-40.  Wells accessed to the right first, then top to bottom

Note:  The direction can also be selected when the labware is zoomed out by 
using the Down, then right or Right, then down buttons beneath the labware.
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Down first, then left to right
Wells are mapped to destination 
labware in the order indicated, 
going down each column and then 
moving to the right to the next 
column.

1 5 6

7 8

To the right first, then top to bottom
Wells are mapped to the destination labware in the 
order indicated, going across each row and then 
moving down to the next row.

2 3 4
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4. Select the first well accessed in Start. At first selected well is the default 
selection.

Note:  Start controls how source wells are mapped to the destination, not the 
physical order in which wells are transferred. The Transfer From File step 
automatically determines the most efficient way to complete the transfer.

• At first selected well — moves in the selected Direction starting from 
the first well selected on the labware

OR

• After last marked well — moves in the selected Direction starting 
from the first selected well on the labware after the marked well

Note: The selected labware must have marks from a previous step with 
Mark last well that is used selected.

Note:  The start location can also be selected when the labware is zoomed out by 
using the Start at selection or Start at last mark buttons beneath the labware.

Note:  When transferring liquid, the source well in the first row of the data file is 
transferred to the first accessed destination well, the second source well is 
transferred to the second accessed destination well, and so forth.

5. Choose Zoom Out to return to the step configuration screen.
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18.9.5 Configuring Transfer Details
Transfer Details includes specifying:

• a repeat pipetting configuration (Figure 18-41).

• the maximum tolerance in timing between transfer operations 
(Figure 18-42).

Figure 18-41.  Transfer From File step — configuring additional Transfer Details

To configure Transfer Details for the Transfer From File step:

1. Click the arrow or sentence summary below the labware configuration section to 
expand Transfer Details.

2. Select one of the repeat pipetting configuration options: Dispense up to or 
Aspirate at most.

Note:  Only one repeat pipetting option may be selected. Either Dispense up to 
or Aspirate at most may be selected, but not both.

Advanced Option
The Advanced option provides access 
to a Just-In-Time (JIT) configuration 
option for the Transfer From File step. 
JIT specifies the maximum tolerance in 
timing between transfer operations.

Arrow to collapse/
expand Transfer Details

Repeat pipetting 
configuration

The repeat pipetting 
options control how 
many dispense 
operations are allowed 
per aspirate operation.
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3. In Dispense up to, select the number of times the Biomek instrument is 
allowed to dispense per aspirate. For example, if dispensing 75 µL to each of six 
microplates, three aspirate operations of 150 µL can each dispense into two 
destinations. In this case, Dispense up to is set to no fewer than two.

OR

In Aspirate at most, select the maximum volume to aspirate from the source 
for repeat pipetting. For example, if dispensing 75 µL to each of six microplates, 
three aspirate operations of 150 µL can each dispense into two destinations. In 
this case, Aspirate at most is set to no less than 150 µL.

Note:  The default repeat pipetting setting is Dispense up to one time per 
draw, which does not allow a repeat pipetting operation. Settings of two or more 
allow repeat pipetting.

4. Click Advanced to change the default setting of applying a Just-In-Time (JIT) 
block to aspirate and dispense operations. The Advanced Options prompt 
appears (Figure 18-42).

Figure 18-42.  Advanced button — JIT Block

5. Uncheck Tie Aspirate to Dispense with a JIT Block to deactivate the JIT 
block.

6. Click OK to save any changes.

The Transfer Details configuration can be collapsed to allow more room during 
Source and Destination Labware configuration. When collapsed, the Transfer 
Details configuration is displayed as a sentence summary. Use the sentence summary 
to verify that Transfer Details has been configured appropriately.

To collapse or expand the Transfer Details configuration, click the arrow to the left 
of Transfer Details or the textual display (Figure 18-41).
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18.10 Define Pattern Step (including 3000)
Define Pattern is used to create patterns and assign names to them for use in other 
steps in the method, such as a Transfer or Combine step. Well patterns defined using 
the Define Pattern step are method specific and embedded as part of the method.

Embedding the well patterns as part of the method has several advantages:

• Sharing methods among other users is simpler because the pattern 
information is stored in the method, not in the project. 

• Common well patterns can be modified for individual methods without 
changing the well pattern in the project.

• The pattern definition can be changed while keeping the same pattern name, 
making it simple to modify methods by changing the well pattern definition. 
Since the Transfer and Combine steps use the pattern name, changes to the 
pattern are automatically updated in the Transfer and Combine steps. 

Note: This is particularly useful when the pattern is defined by a file using 
rows that match a bar code or other value. In a Loop step, the pattern could 
change based on the bar code of the current labware in a group created with a 
Create Group step. Each iteration of the Loop would transfer using a 
different pattern as defined by the file in the Define Pattern step.
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Insert a Define Pattern step into the method. The Define Pattern Step 
Configuration appears (Figure 18-43). 

Figure 18-43.  Define Pattern step and configuration

Define Pattern has two different configuration options. It can define a pattern by 
manually specifying wells or reading from a file.

18.10.1 Configuring the Define Pattern Step by 
Specifying the Wells Manually

To configure the Define Pattern step by manually specifying the wells:
1. In Create a pattern named, enter a name for the pattern. 

2. In Model it after the labware type, select the labware type for the pattern.

3. Select Specify the wells manually.

4. On the graphic representing the labware, select the wells to be included in the 
pattern. All wells are selected by default (Figure 18-43).

Note:  Click on a well to select it and deselect the current selection. Hold down 
Shift and click on additional wells to select wells without affecting the current 
selection. Hold down Ctrl and click on wells to toggle wells between selected 
and deselected without affecting the current selection.

5. To use or modify a well pattern defined in the Well Patterns Editor, select 
Copy Pattern and choose the pattern from the list.

Specify the wells manually
Used to manually specify the 
wells in a pattern.

Define Pattern 
configuration options

The pattern has two options for 
selecting the wells in a pattern: 
Specify the wells manually or 
Read from a file.
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18.10.2 Configuring the Define Pattern Step 
Reading from a File

To configure the Define Pattern step by reading well information from a file:

1. In Create a pattern named, enter a name for the pattern. 

2. In Model it after the labware type, select the labware type for the pattern.

3. Select Read from a file. The Read from a file configuration options appear 
(Figure 18-44).

Figure 18-44.  Define Pattern step — Read from a file configuration

File selection
Used to select the file to 
read to create the pattern.
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4. Enter the full path and file name of the data file from which to read the pattern 
information.

OR

Choose the browse button and select the directory and file from which to read the 
pattern information in Open (Figure 18-45). The selected file is read and 
Example data is displayed (Figure 18-46).

Note:  The data file must be a comma-delimited text file (.txt or .csv).

Figure 18-45.  Open dialog

Figure 18-46.  Define Pattern step — Example data displayed

Example Data
The selected file 
is read and data 
displayed in the 
Example data 
section.
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5. If the file read has a header row identifying the columns, select File has a 
header row. The first row of the data file is used to identify the columns (Figure 
18-47).

Figure 18-47.  Define Pattern step — Example data with header row

6. Beneath the Example data, select which lines from the data file to use when 
defining the pattern. 

• To use all rows of the data file, select Use all lines.

• To use specific wells where a certain column matches a specified 
bar code or value, refer to Section 18.10.2.1, Specifying Lines to Use.

7. In Wells are specified by, select whether wells are identified using 
alphanumeric well addresses (for example, A1-H12 for a 96-well plate) or 
numeric well numbers (for example, 1-96 for a 96-well plate), and specify the 
column that contains the well information.

8. Choose a step that occurs after the Define Pattern step or the Finish step to 
validate the step configuration.

Specify the lines of 
the data file to use.

File has a header row
Uses the first row of the data 
file to identify columns.
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18.10.2.1 Specifying Lines to Use
Sometimes it may be desired to only use specific rows from the data file. For 
example, if a data file contains information on several plates, the file can be 
configured to use only the rows pertaining to the current plate using the bar code, 
deck position, or other factor.

To use selected lines from the data file:

1. Select Use lines where column to activate the configuration.

2. In column matches, select the column from the data file that must match the 
specified value to use the row.

3. Select whether the selected column must match the Bar code or Name of the 
labware selected in from and specify a deck position or labware name to match 
against in from.

OR

Select the value and enter a variable or expression that must match the column 
selected.

The rows that match the specified condition are used to define the well pattern 
using the column that specifies the well information.

18.10.3 Using a Defined Pattern in a Transfer or 
Combine Step

Once a pattern has been created using a Define Pattern step, it may be used in any 
Transfer or Combine step within the method that uses a Span-8 Pod on the FX or 
NX-S8 or a pipetting tool on the 3000.

To use a defined pattern in a Transfer or Combine step:

1. Select the desired Transfer or Combine step in the Method View. The step 
configuration appears.

2. Select the desired Source or Destination configuration to display the 
configuration for the selected labware.

3. Double-click the graphic of the labware to zoom in on it.

4. Select Use pattern to use a pattern created in a Define Pattern step.
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5. Choose the desired pattern created in a Define Pattern step from the list (Figure 
18-48). During method run, the configured step uses the specified pattern. 

Figure 18-48.  Transfer step using Sample pattern

Note:  Only patterns that are defined in the current method or from a previously 
run method that did not clear global variables appear in the list.

6. Choose a step that occurs after the configured Transfer or Combine step or the 
Finish step to validate the step configuration.

Use Pattern
Specify the pattern to use 
for the selected labware. 
The current definition of the 
selected pattern is displayed 
on the labware graphic
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19 Using the HDR Step Palette 
(FX, 3000 only)

19.1 Overview
CAUTION: Do not attempt to access a 96-Channel or 384-Channel Tip 
Wash ALP with a Multichannel Pod equipped with an HDR Tool Body. 
The gripper may crash and damage the pod, HDR Tool Body, or Tip 
Wash ALP.
The HDR Step Palette provides access to steps used to control the HDR Tool Body on 
the Biomek FX instrument or the HDR tool on a Biomek 3000 instrument. The HDR 
steps include the means to transfer liquid, wash pins, and move labware using the 
HDR Tool Body.

The steps available in HDR Step Palette include:

• HDR Transfer — transfers liquid from a single source to one or more 
destinations using the HDR Tool Body

• HDR Combine — transfers liquid from a one or more sources to a single 
destination using the HDR Tool Body

• HDR Tool Cleaning — cleans pins on the HDR Tool Body by dipping the 
pins in one or more reservoirs and drying them at the HDR Pin Drying ALP

• HDR Move Labware — moves labware using the gripper on the 
Multichannel Pod with the HDR Tool Body installed.

3000 — HDR Move Labware is not available.

Note:  In addition to the HDR steps, the Device Action step may be used to control 
the wash pumps for the circulating reservoirs or the fan for the HDR Pin Drying ALP 
independently during a method (refer to Section 22.6, Device Action Step). 
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19.2 Displaying the HDR Step Palette
In order to add HDR steps to a method, display the HDR Step Palette 
(Figure 19-1).

Figure 19-1.  Biomek main editor with HDR Step Palette displayed

To display the HDR Step Palette, complete the following:

• Right-click any empty palette space, and the Step Palette menu appears. 
Select HDR.

OR

• From the menu bar, select Options>Toolbars>HDR.

Method View
The method is 
built step by step 
in the Method 
View.

Step Configuration
When a step is highlighted in the Method 
View, the corresponding configuration 
appears in this area.

HDR Step 
Palette
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19.3 Using the HDR Transfer and Combine Steps
The HDR Transfer and HDR Combine steps transfer a volume of sample from each 
well of a source labware to each well of the destination labware. Each destination 
well may contain up to 36 samples per well in a 6 x 6 array for a 96-well microplate or 
up to 16 samples per well in a 4 x 4 array for a 384-well microplate.

Note:  Only a 384-pin plate with 0.015” post pins can access quadrants of a 1536-
well microplate.

The HDR Transfer step transfers liquid from a single source to one or more 
destinations, while the HDR Combine step transfers liquid from a one or more 
sources to a single destination. 

A liquid transfer operation deposits samples in the same array position of each 
destination well, starting in the upper left corner position. Each subsequent liquid 
transfer operation deposits samples in the next available array position, going across 
each row before moving down to the next row of the array (Figure 19-2).

Figure 19-2.  Order of transfer to array positions in destination wells with a 3x3 array

Note:  Destination labware should be placed on a Positive Position ALP during 
gridding applications. Refer to the ALPs User’s Manual, Chapter 15, Positive 
Position ALP, for more information on the Positive Position ALP.

The HDR Transfer and HDR Combine steps perform liquid-handling functions 
through the step configuration (Figure 19-3). An HDR Transfer step transfers 
sources such that each destination receives exactly one source; an HDR Combine 
step transfers each source to exactly one destination.

• If there are the same number of sources and destinations (wells x array 
positions), all sources are transferred and each destination receives exactly 
one source.

• If there are more sources than destinations (wells x array positions), an HDR 
Transfer step transfers only enough sources so that each destination receives 
exactly one source (some sources are unused); an HDR Combine step 
transfers all sources to exactly one destination (some destinations receive 
more than one source).

• If there are fewer sources than destinations (wells x array positions), an 
HDR Transfer step transfers all sources until each destinations receives 
exactly one source (some sources are used multiple times); an HDR 
Combine step transfers all sources to exactly one destination (not all 
destinations receive a source).

Note: The HDR Transfer and HDR Combine steps must be used with 
either a Multichannel Pod equipped with the HDR Tool Body on the Biomek 
FX instrument, or an HDR tool installed on the head assembly of a Biomek 
3000 instrument.

1 2 3
4 5 6
7 8 9
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The HDR Transfer or HDR Combine step configuration includes specifying:

• Pod that performs the transfer.

FX only — The pod that performs the transfer is specified.

• Pin washing procedure between transfers, if desired.

Note: Pin washing between transfers requires that a procedure is defined 
using the Define Procedure step (refer to Section 19.3.1, Washing Pins 
Between Transfers).

• Source labware configuration(s).

• Destination labware configuration(s).

To configure an HDR Transfer step:

1. Insert an HDR Transfer or HDR Combine step into the Method View (Figure 
19-3).

Figure 19-3.  HDR Transfer step configuration

Pod selection

Click this button to add Source 
Labware and open the Source 
Labware configuration.
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2. In Use pod, specify the pod with the HDR Tool Body used to perform the 
transfer operations.

3000 — Use pod does not appear in the step configuration.

3. Select Wash between transfers with protocol to wash pins between 
transfers using a specified procedure.

Note:  Pin washing between transfers requires that a procedure is defined using 
the Define Procedure step (refer to Section 19.3.1, Washing Pins Between 
Transfers).

4. In Wash between transfers with protocol, select a previously defined 
procedure to use to wash pins between transfers.

5. Configure Source and Destination labware as described in Sections 19.3.2, 
Configuring Source Labware, and 19.3.3, Configuring Destination Labware.
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19.3.1 Washing Pins Between Transfers
Pins are washed between transfers in an HDR Transfer or HDR Combine step using 
a wash procedure defined in a Define Procedure step (refer to Section 21.8.1, Define 
Procedure Step). After defining the procedure, it is selected in the HDR Transfer or 
HDR Combine step configuration.

To wash pins between transfers in an HDR Transfer or HDR Combine step:

1. Insert a Define Procedure step in the Method View. The Define Procedure 
Step Configuration appears (Figure 19-4). 

Note:  Define Procedure is not on any of the default step palettes and must be 
added to a step palette from the Specialty step category in the Palette Builder. 
Refer to Section 29.5, Using the Step Palette Builder, for more information on 
adding Define Procedure to a step palette.

Figure 19-4.  Define Procedure step and configuration

2. In Procedure, enter a name for the procedure. 

Note:  The procedure name may contain only alphanumeric characters and the 
underscore (_), and is not case-sensitive.

3. Double-click the Define Procedure icon in the Method View to open the 
procedure. The End Procedure icon appears below the Define Procedure icon.

4. Insert the HDR Tool Cleaning step between the Define Procedure and End 
Procedure icons.

Method View
The method displayed 
contains a Define 
Procedure step. The 
name assigned to the 
procedure appears in 
the step caption.

Variables
Insert any variables used in the procedure 
here. The values for the variables may be 
assigned new values when the procedure is 
run in a Run Procedure step.

Procedure
Assign a name to the procedure.
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5. Configure the HDR Tool Cleaning step as desired to perform all pin washing 
between transfers (refer to Section 19.4, Using the HDR Tool Cleaning Step).

6. If desired, insert and configure additional steps between the Define Procedure 
and End Procedure icons.

Note:  All steps included in this procedure are performed between every transfer 
of an HDR Transfer or HDR Combine step.

7. Double-click the Define Procedure icon in the Method View to collapse the 
procedure and hide all steps between the Define Procedure and End 
Procedure icons.

Note:  After defining the procedure and configuring all steps within the 
procedure as desired, drag it onto one of the step palettes to create a custom step. 
When writing other methods, insert the custom Define Procedure step into the 
Method View to use the same pin washing procedure and ensure consistent pin 
washing across methods.

8. When configuring an HDR Transfer or HDR Combine step, select the 
procedure created above in Wash between transfers with protocol.

19.3.2 Configuring Source Labware
A ‘source’ is a group of wells accessed at one time by the HDR Tool Body; for 
example, a 96-pin plate accesses 96 wells at a time while a 384-pin plate accesses 384 
wells at a time. 

Note:  If configuring a 384-well microplate for access by a 96-pin plate or a 1536-
well microplate for access by a 384-pin plate as source labware, any combination of 
quadrants may be used. For example, if it is desired to transfer liquid from the first, 
second, and third quadrants but not the fourth, the source labware may be configured 
to transfer only from those quadrants.

Note:  Only a 384-pin plate with 0.015” post pins can access quadrants of a 1536-
well microplate.

In the HDR Transfer and HDR Combine steps, the HDR Tool Body dips the pins in 
the source labware at a specified height for a specified length of time a specified 
number of times to pick up samples by liquid adhesion. 

Note:  The volume of sample that adheres to the pins is dependent on many factors, 
including environmental factors, the liquid type, the surface area of the pins immersed 
in the sample, the length of time the pins are in contact with the sample, pin washing 
technique, and dryness of the pins. Conduct tests to determine the optimal settings to 
transfer the desired volume of a specific liquid type with a specific pin size.
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The Source Labware configuration for the Transfer step includes choosing:

• Labware type

• Labware location

• Dipping configuration

• Quadrants used, if applicable

Note: Quadrants are applicable when accessing a 384-well microplate 
using a 96-pin plate or a 1536-well microplate using a 384-pin plate. Only a 
384-pin plate with 0.015” post pins can access quadrants of a 1536-well 
microplate.

Note:  A single source is configured for the HDR Transfer step, because the HDR 
Transfer step moves liquid from a single source to one or more destinations. Multiple 
sources can be configured for the HDR Combine step, because the HDR Combine 
step moves liquid from multiple sources to a single destination. 

To configure Source Labware for the HDR Transfer and HDR Combine steps:

CAUTION: Do not access labware positioned on a 1 x 5 Passive ALP 
with the HDR Tool Body. The gripper may crash into the ALP.

CAUTION: Do not access labware on a Stirring ALP with the HDR Tool 
Body. The magnetic stirrer may bend the pins or interfere with the liquid 
transfer performance of the pins.
1. Select Click here to add a source (Figure 19-3). The Source Labware 

configuration appears (Figure 19-5). 

Figure 19-5.  HDR Transfer step — Source Labware configuration
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2. Click on the desired piece of labware in the Current Deck Display. The labware 
type and position for that piece of labware is entered automatically into the 
Source Labware configuration (Figure 19-6).

OR

Select a Source Labware type and specify the deck position.

Note:  To configure additional Source Labware for an HDR Combine step, 
select Click here to add a source, and then select another piece of labware 
from the Current Deck Display. If an incorrect piece of labware is selected, right-
click on the labware title and select Delete on the menu that appears, or change 
the Source Labware selection by clicking anywhere in the source labware 
configuration area, and selecting another piece of labware.

Figure 19-6.  HDR Transfer step — Source Labware selected

3. Verify the deck position of the labware. 

Note:  A bright blue outline appears in the Current Deck Display around the 
labware designated as the Source Labware.

Deck position selection

HDR Transfer Step - Source Labware configurationCurrent Deck Display
The Current Deck 
Display is used for 
labware selection, and it 
displays the status of the 
deck upon completion of 
the previous step. 

Source Labware selection

Source Labware title
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4. To specify quadrants in a microplate to access, double-click the source labware in 
the step configuration to zoom in on the labware. 

Note:  To call up a menu for Zoom In and a Specify Selection as Text option, 
right-click on the labware. 

Specify Selection as Text allows selection of quadrants as targets for aspirate 
and dispense operations. Specify Selection as Text may also be used to enter 
variables or expressions (refer to Section 13.2, Using Variables and Section 13.3, 
Using Expressions).

Note:  Specify Selection as Text is not applicable for 96-well microplates, 
reservoirs, or 384-well microplates accessed by a 384-channel pod.

5. Select the desired quadrant(s) on the zoomed-in graphic of the labware.

Note:  Selecting any well automatically selects all wells in that quadrant.

Note:  To select multiple quadrants, click and drag over the desired quadrants or 
hold down Ctrl or Shift and select the desired quadrants.

6. Choose Zoom Out to return to the step configuration screen.

7. Choose Dipping Configuration to configure the dipping operation. Dipping 
Configuration appears (Figure 19-7).

Note:  The Dipping Configuration is similar to a pipetting technique. It 
specifies the method in which liquid is picked up by the pins.

Figure 19-7.  Dipping Configuration
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8. In Dip Cycles, enter the number of times the pins should descend into the wells 
to pick up liquid.

Note:  For Dip Cycles greater than 1, Move up to must be configured.

9. In Move down to, specify the height the pins descend to for each dipping cycle.

Note:  By default, Move down to is measured from bottom of the well. To 
measure from top of the well or from liquid, right click the graphic of the pin in 
the well and make the desired selection from the menu.

Note:  The Move down to height can go as much as 2 mm below the bottom of 
the well as long as the pod can descend that far. Descending below the bottom of 
the well potentially corrects for any slight imperfections in the labware or ALP 
heights and can be done safely because the pin push plate is in a floating position, 
allowing the pins to move up and down freely without resistance. To specify a 
height below the bottom of the well, right-click the graphic of the pin in the well 
and select Custom Height. Enter a negative value in Custom Height to move 
the pins below the bottom of the well.

10. In Move down at, enter the speed of the descent of the HDR Tool Body as a 
percentage of the maximum speed of the pod.

11. In Move up to, specify the height the pins ascend to between each dipping cycle.

Note:  If Dip Cycles is set to 1, Move up to is disabled.

Note:  By default, Move up to is measured from bottom of the well. To 
measure from top of the well or from liquid, right click the graphic of the pin in 
the well and make the desired selection from the menu.

12. In Move up at, enter the speed of the ascent of the HDR Tool Body as a 
percentage of the maximum speed of the pod.

13. In Pause for, enter the length of time the pod pauses at the down position for 
each Dip Cycle to pick up liquid.

14. Choose OK to save the Dipping Configuration and return to the source labware 
configuration.
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15. Leave the pin height as is to use the settings for the Move down to height 
specified in the Dipping Configuration. 

OR

Set the pin height manually using one of the following methods:

• Position the cursor over the graphic of a pin inside a well. Click and 
drag the graphic up or down. The pin moves with the cursor, and the 
height displayed below the graphic is adjusted as the graphic is 
manipulated.

• Select the graphic of a pin inside a well, and use the ↑ and ↓ keys. The 
textual representation of the height, which is displayed below the 
graphic, adjusts in 0.1 millimeter (mm) increments.

• Right-click on the graphic of a pin inside a well, and a menu appears. 
Select Custom Height, and Custom Height appears (Figure 19-8). 
Insert the Height in millimeters (mm) and, in from, select a reference 
point from the drop-down list. Choose OK.

Note: The cursor changes to a hand when positioned over the 
graphic. 

Figure 19-8.  Custom Height prompt

16. Repeat steps 1 to 15 for each additional piece of Source Labware.

Note:  A Destination Labware must be selected before additional Source 
Labware can be configured.
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19.3.3 Configuring Destination Labware
A ‘destination’ is a group of wells accessed at one time by the HDR Tool Body; for 
example, a 96-pin plate accesses 96 wells at a time while a 384-pin plate accesses 384 
wells at a time. 

Destination wells may be configured to hold an array of destination sites, allowing for 
a greater number of samples on a single microplate. All destination wells must have 
the same array configuration.

Note:  If configuring a 384-well microplate using a 96-pin plate or a 1536-well 
microplate using a 384-pin plate as source labware, any combination of quadrants 
may be used. For example, if it is desired to transfer liquid to the first, second, and 
third quadrants but not the fourth, the destination labware may be configured to 
transfer only to those quadrants.

3000 — 1536-well plates are not used.

Note:  Only a 384-pin plate with 0.015” post pins can access quadrants of a 1536-
well microplate.

In the HDR Transfer and HDR Combine steps, the HDR Tool Body dips the pins in 
the destination labware at a specified height for a specified length of time a specified 
number of times to deposit samples by liquid adhesion. Multiple samples can be 
deposited in a single destination well in an array format. 

Note:  The volume of sample that deposits from the pins to the destination labware is 
dependent on many factors, including environmental factors, the liquid type, the 
surface area of the pins in contact with the labware, and the length of time the pins are 
in contact with the labware. Conduct tests to determine the optimal settings to transfer 
the desired volume of a specific liquid type with a specific pin size.

The Destination Labware configuration includes choosing:

• Labware type

• Labware location

• Dipping configuration

• Array configuration for gridding

Note: Destination labware should be placed on a Positive Position ALP 
during gridding applications. Refer to the ALPs User’s Manual, Chapter 15, 
Positive Position ALP, for more information on the Positive Position ALP.

• Quadrants used, if applicable

Note: Quadrants are applicable when accessing a 384-well microplate 
using a 96-pin plate or a 1536-well microplate using a 384-pin plate. Only a 
384-pin plate with 0.015” post pins can access quadrants of a 1536-well 
microplate.

3000 — 1536-well plates are not used.

Note:  Multiple destinations can be configured for the HDR Transfer step, because 
the HDR Transfer step moves liquid from a single source to one or more 
destinations. A single destination is configured for the HDR Combine step, because 
the HDR Combine step moves liquid from one or more sources to a single 
destination.
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To configure Destination Labware for the HDR Transfer step:

CAUTION: Do not access labware positioned on a 1 x 5 Passive ALP 
with the HDR Tool Body. The gripper may crash with the ALP. 

CAUTION: Do not access labware on a Stirring ALP with the HDR Tool 
Body. The magnetic stirrer may bend the pins or interfere with the liquid 
transfer performance of the pins.
1. Select Click here to add a destination (Figure 19-9). The Destination 

Labware configuration appears.

Figure 19-9.  HDR Transfer step — Adding Destination Labware

Destination labware configuration

Configured Source Labware
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2. Click on the desired piece of labware in the Current Deck Display. The labware 
type and position for that piece of labware is entered automatically into the 
Destination Labware configuration (Figure 19-6).

OR

Select a Destination Labware type and specify the deck position.

Note:  Once the Destination Labware has been selected, the Source Labware 
parameters are collapsed to display a sentence summary. To reopen the Source 
labware parameters, click anywhere in the Source Labware configuration area.

Note:  To configure additional Destination Labware for an HDR Transfer 
step, select Click here to add a destination, and then select another piece of 
labware from the Current Deck Display. If an incorrect piece of labware is 
selected, right-click on the labware title and select Delete on the menu that 
appears, or change the Destination Labware selection by clicking anywhere in 
the destination labware configuration area, and selecting another piece of 
labware.

Figure 19-10.  HDR Combine step — Destination Labware configuration

3. Verify the deck position of the labware. 

Note:  A bright yellow outline appears in the Current Deck Display around 
labware designated as Destination Labware.

Destination 
labware 

configuration

Current Deck Display
Displays the status of the 
deck upon completion of the 
previous step. Also useful 
for labware selection.

Select Destination 
Labware type

Deck position selection

Additional Source 
Labware

Continue adding 
Source Labware by 
clicking this button, 
or by selecting more 
labware in the Current 
Deck Display.
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4. To specify the quadrants of a microplate to access, double-click the destination 
labware in the step configuration to zoom in on the labware. 

Note:  To call up a menu for Zoom and a Specify Selection as Text option, 
right-click on the labware. 

Specify Selection as Text allows selection of quadrants as targets for aspirate 
and dispense operations. Specify Selection as Text may also be used to enter 
variables or expressions (refer to Section 13.2, Using Variables and Section 13.3, 
Using Expressions).

Note:  Specify Selection as Text is not applicable for 96-well microplates, 
reservoirs, or 384-well microplates accessed by a 384-pin plate.

5. Select the desired quadrant(s) on the zoomed-in graphic of the labware.

Note:  Selecting any well automatically selects all wells in that quadrant.

Note:  To select multiple quadrants, click and drag over the desired quadrants or 
hold down Ctrl or Shift and select the desired quadrants.

6. Choose Zoom Out to return to the step configuration screen.

7. Choose Dipping Configuration to configure the operation. Dipping 
Configuration appears (Figure 19-11).

Note:  The Dipping Configuration is similar to a pipetting technique. It 
specifies the method in which liquid is deposited by the pins.

Figure 19-11.  Dipping Configuration

8. In Dip Cycles, enter the number of times the pins should descend into the wells 
to deposit liquid.

Note:  For Dip Cycles greater than 1, Move up to must be configured.
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9. In Move down to, specify the height the pins descend to for each dipping cycle.

Note:  By default, Move down to is measured from bottom of the well. To 
measure from top of the well or from liquid, right click the graphic of the pin in 
the well and make the desired selection from the menu.

Note:  The Move down to height can go as much as 2 mm below the bottom of 
the well as long as the pod can descend that far. Descending below the bottom of 
the well potentially corrects for any slight imperfections in the labware or deck 
position heights and can be done safely because the pin push plate is in a floating 
position, allowing the pins to move up and down freely without resistance. To 
specify a height below the bottom of the well, right-click the graphic of the pin in 
the well and select Custom Height. Enter a negative value in Custom Height to 
move the pins below the bottom of the well.

10. In Move down at, enter the speed of the descent of the HDR Tool Body as a 
percentage of the maximum speed of the pod.

11. In Move up to, specify the height the pins ascend to between each dipping cycle.

Note:  If Dip Cycles is set to 1, Move up to is disabled.

Note:  By default, Move up to is measured from bottom of the well. To 
measure from top of the well or from liquid, right click the graphic of the pin in 
the well and make the desired selection from the menu.

12. In Move up at, enter the speed at which the HDR Tool Body moves up as a 
percentage of the maximum speed of the pod.

13. In Pause for, enter the length of time the pod pauses at the down position for 
each Dip Cycle to deposit liquid.

14. Choose OK to save the Dipping Configuration and return to the source labware 
configuration.
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15. Choose Array Configuration to configure arrays for the destination wells. 
Array Configuration appears (Figure 19-12).

Figure 19-12.  Array Configuration

Note:  It is recommended that destination labware is placed on a Positive 
Position ALP during gridding applications for best results. Refer to the ALPs 
User’s Manual, Chapter 15, Positive Position ALP, for more information on the 
Positive Position ALP.

16. In Array dimensions, select the desired size of the array. The first value changes 
the number of rows in the array and the second value changes the number of 
columns in the array.

Note:  The maximum Array dimension is 6x6 when transferring to a 96-well 
microplate or 4x4 when transferring to a 384-well microplate.

17. In X distance between spot centers, enter the distance in millimeters (mm) 
between the centers of adjacent spots in each row.

Note:  The X distance between spot centers updates automatically as the 
second value in Array dimensions changes.

18. In Y distance between spot centers, enter the distance in millimeters (mm) 
between the centers of adjacent spots in each column.

Note:  The Y distance between spot centers updates automatically as the 
first value in Array dimensions changes.

19. Choose OK to save the Array Configuration and return to the Destination 
Labware configuration.



Using the HDR Step Palette (FX, 3000 only) 19-19

Biomek Software User’s Manual

20. Leave the pin height as is to use the settings for the Move down to height 
specified in the Dipping Configuration. 

OR

Set the pin height manually using one of the following methods:

• Position the cursor over the graphic of a pin inside a well. Click and 
drag the graphic up or down. The pin moves with the cursor, and the 
height displayed below the graphic is adjusted as the graphic is 
manipulated.

Note: The cursor changes to a hand when positioned over the 
graphic. 

• Select the graphic of a pin inside a well, and use the ↑ and ↓ keys. The 
textual representation of the height, which is displayed below the 
graphic, adjusts in 0.1 millimeter (mm) increments.

• Right-click on the graphic of a pin inside a well, and a menu appears. 
Select Custom Height, and Custom Height appears (Figure 19-8). 
Insert the Height in millimeters (mm) and, in from, select a reference 
point from the drop-down list. Choose OK.

Figure 19-13.  Custom Height prompt

21. For an HDR Transfer step, repeat steps 1 to 20 for each additional piece of 
Destination Labware.
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19.4 Using the HDR Tool Cleaning Step
The HDR Tool Cleaning step washes pins on the HDR Tool Body. The HDR Tool 
Cleaning step uses a “dunk and dry” methodology to wash pins by dipping the pins 
in one or more reservoirs with wash solutions and drying the pins over a fan.

Note:  To clean pins between transfers of an HDR Transfer or HDR Combine step, 
the HDR Tool Cleaning step must be inserted in a Define Procedure step.

The HDR Tool Cleaning step configuration is similar to that of the HDR Transfer or 
HDR Combine step. Instead of Source and Destination configurations, however, a 
series of wash operations — either dipping the pins into a wash reservoir or drying the 
pins at the HDR Pin Drying ALP — are configured. Cleaning operations are 
performed in the order they are configured.

The HDR Tool Cleaning step configuration includes specifying:

• Pod that performs the cleaning operations.

• Cleaning operation configuration(s).

To configure an HDR Tool Cleaning step:

1. Insert an HDR Tool Cleaning step into the Method View (Figure 19-14).

Figure 19-14.  HDR Tool Cleaning step configuration

Pod selection

Click this button to add Source 
Labware and open the Source 
Labware configuration.
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2. In Use pod, specify the pod with the HDR Tool Body used to perform the 
transfer operations.

3000 — Use pod does not appear in the step configuration.

3. Configure Cleaning Operations as described in Section 19.4.1, Configuring 
Cleaning Operations.

19.4.1 Configuring Cleaning Operations
The HDR Tool Cleaning step is configured through a series of cleaning operations. 
There are two types of Cleaning Operations:

• Wash Operations — pins are dipped in wash solution in a reservoir, deep-
well microplate, or other labware type (refer to Section 19.4.1.1, 
Configuring a Wash Operation).

• Drying Operations — pins are air-dried by a fan at the HDR Pin Drying ALP 
on a Biomek FX instrument or the HDR Fan on the tool rack on a Biomek 
3000 instrument (refer to Section 19.4.1.2, Configuring a Drying 
Operation).

As many Cleaning Operations as desired can be configured in the HDR Tool 
Cleaning step. 

Note:  Cleaning operations are performed in the order they are listed in the step 
configuration.
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19.4.1.1 Configuring a Wash Operation
A Wash operation dips pins in a piece of labware a specified number of times for a 
specified length of time. Usually a reservoir is used as Wash labware, but pins can be 
dipped in any labware type.

To configure a wash operation for the HDR Tool Cleaning step:

CAUTION: Do not attempt to access a 96-Channel or 384-Channel Tip 
Wash ALP with a Multichannel Pod equipped with an HDR Tool Body. 
The gripper may crash and damage the pod, HDR Tool Body, or Tip 
Wash ALP.
CAUTION: Do not access labware positioned on a 1 x 5 Passive ALP 
with the HDR Tool Body. The gripper may crash with the ALP. 

CAUTION: Do not access labware on a Stirring ALP with the HDR Tool 
Body. The magnetic stirrer may bend the pins or interfere with the liquid 
transfer performance of the pins.
1. Select Click here to add a cleaning operation (Figure 19-14). The 

Cleaning Operation configuration appears.

Figure 19-15.  HDR Tool Cleaning step — new cleaning operation configuration
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2. Click on the piece of labware with the desired wash solution in the Current Deck 
Display. The labware type and position for that piece of labware is entered 
automatically into the Cleaning Operation configuration (Figure 19-14).

Note:  If the selected labware is named, the name of the labware appears instead 
of the deck position.

OR

Select a Cleaning Labware type (Figure 19-14) and deck position.

Note:  Subsequent labware selections modify the active Cleaning Operation 
configuration. To configure additional Cleaning Operations, select Click here 
to add a cleaning operation, or select outside a cleaning operation 
configuration, and then select another piece of labware from the Current Deck 
Display. If an incorrect piece of labware is selected, right-click on the labware 
title and select Delete on the menu that appears.

Figure 19-16.  HDR Tool Cleaning step — configuration for a wash operation

Cleaning Operation 
configuration for washing 
with a circulating reservoir

Current Deck Display
Displays the status of the 
deck upon completion of the 
previous step. Also useful for 
labware selection.

Additional Cleaning 
Operations

Continue adding 
Cleaning Operations 
by clicking this button, 
or by selecting more 
labware in the Current 
Deck Display.
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3. If the Cleaning labware selected is a static reservoir or microplate, verify the 
labware type and deck position of the labware. 

Note:  A bright blue outline appears in the Current Deck Display around the 
labware designated for the first Cleaning operation; a yellow outline appears in 
the Current Deck Display around labware designated for any subsequent 
Cleaning operations.

OR

On an FX instrument, if the Cleaning labware selected is a circulating reservoir 
(Figure 19-14):

• In Turn pump on for, enter the length of time in seconds to turn the 
wash pump on before the HDR Tool Body moves to the circulating 
reservoir.

Note: The default value for Turn pump on for is 2 seconds.

• In Leave pump on for, enter the length of time in seconds to leave the 
wash pump on after the HDR Tool Body moves away from the 
circulating reservoir.

Note: The default value for Leave pump on for is 2 seconds.

4. To specify the quadrants of a microplate to access, double-click the source 
labware in the step configuration to zoom in on the labware. 

Note:  To call up a menu for Zoom and a Specify Selection as Text option, 
right-click on the labware. 

Specify Selection as Text allows selection of quadrants as targets for aspirate 
and dispense operations. Specify Selection as Text may also be used to enter 
variables or expressions (refer to Section 13.2, Using Variables and Section 13.3, 
Using Expressions).

Note:  Specify Selection as Text is not applicable for 96-well microplates, 
reservoirs, or 384-well microplates accessed by a 384-pin plate.

5. Select the desired quadrant(s) on the zoomed-in graphic of the labware.

Note:  Selecting any well automatically selects all wells in that quadrant.

Note:  To select multiple quadrants, click and drag over the desired quadrants or 
hold down Ctrl or Shift and select the desired quadrants.

6. Choose Zoom Out to return to the step configuration screen.
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7. Choose Dipping Configuration to configure the wash operation. Dipping 
Configuration appears (Figure 19-17).

Note:  The Dipping Configuration is similar to a pipetting technique. It 
specifies the method in which pins are washed.

Figure 19-17.  Dipping Configuration

8. In Dip Cycles, enter the number of times the pins should descend into the wells.

Note:  For Dip Cycles greater than 1, Move up to must be configured.

9. In Move down to, specify the height the pins descend to for each dipping cycle.

Note:  By default, Move down to is measured from bottom of the well. To 
measure from top of the well or from liquid, right click the graphic of the pin in 
the well and make the desired selection from the menu.

Note:  The Move down to height can go as much as 2 mm below the bottom of 
the well as long as the pod can descend that far. Descending below the bottom of 
the well potentially corrects for any slight imperfections in the labware or deck 
position heights and can be done safely because the pin push plate is in a floating 
position, allowing the pins to move up and down freely without resistance. To 
specify a height below the bottom of the well, right-click the graphic of the pin in 
the well and select Custom Height. Enter a negative value in Custom Height to 
move the pins below the bottom of the well.

10. In Move down at, enter the speed of the descent of the HDR Tool Body as a 
percentage of the maximum speed of the pod.
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11. In Move up to, specify the height the pins ascend to between each dipping cycle.

Note:  If Dip Cycles is set to 1, Move up to is disabled.

Note:  By default, Move up to is measured from bottom of the well. To 
measure from top of the well or from liquid, right click the graphic of the pin in 
the well and make the desired selection from the menu.

12. In Move up at, enter the speed at which the HDR Tool Body moves up as a 
percentage of the maximum speed of the pod.

13. In Pause for, enter the length of time the pod pauses at the down position for 
each Dip Cycle to wash pins.

14. Choose OK to save the Dipping Configuration and return to the source labware 
configuration.

15. Leave the pin height as is to use the settings for the Move down to height 
specified in the Dipping Configuration.

OR

Set the pin height manually using one of the following methods:

• Position the cursor over the graphic of a pin inside a well. Click and 
drag the graphic up or down. The pin moves with the cursor, and the 
height displayed below the graphic is adjusted as the graphic is 
manipulated.

Note: The cursor changes to a hand when positioned over the 
graphic. 

• Selecting the graphic of a pin inside a well, and use the ↑ and ↓ keys. 
The textual representation of the height, which is displayed below the 
graphic, adjusts in 0.1 millimeter (mm) increments.

• Right-click on the graphic of a pin inside a well, and a menu appears. 
Select Custom Height, and Custom Height appears (Figure 19-8). 
Insert the Height in millimeters (mm) and, in from, select a reference 
point from the drop-down list. Choose OK.

Figure 19-18.  Custom Height prompt

16. Configure additional Cleaning Operations following the procedures in Sections 
19.4.1.1, Configuring a Wash Operation and 19.4.1.2, Configuring a Drying 
Operation.
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19.4.1.2 Configuring a Drying Operation
To configure a drying operation for the HDR Tool Cleaning step:

1. Select Click here to add a cleaning/drying operation. The Cleaning 
Operation configuration appears (Figure 19-19).

Figure 19-19.  HDR Tool Cleaning step — new cleaning operation configuration
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2. Click on the position with the fan (either the HDR Pin Drying ALP on the 
Biomek FX instrument or the tool rack with the HDRFan tool installed on the 
Biomek 3000 instrument) in the Current Deck Display. Information for the fan is 
entered automatically into the Cleaning Operation configuration.

Note:  Subsequent labware selections modify the active Cleaning Operation 
configuration. To configure additional Cleaning Operations, select Click here 
to add a cleaning operation, or select outside a cleaning operation 
configuration, and then select another piece of labware from the Current Deck 
Display. If an incorrect piece of labware is selected, right-click on the labware 
title and select Delete on the menu that appears.

Figure 19-20.  HDR Tool Cleaning step — configuration for a drying operation

3. In Turn fan on for, enter the length of time in seconds to turn the fan on before 
the HDR Tool Body moves to the HDR Pin Drying ALP.

Note:  The default value for Turn fan on for is 2 seconds.

3000 — Turn on for is not available because the fan unit is not controlled 
by Biomek Software.

4. In Dry for, enter the length of time in seconds to keep the HDR Tool Body at the 
HDR Pin Drying ALP to dry.

Note:  The default value for Dry for is 5 seconds.

Cleaning Operation 
configuration for drying

Current Deck Display
Displays the status of the 
deck upon completion of the 
previous step. Also useful for 
labware selection.

Additional Cleaning 
Operations

Continue adding 
Cleaning Operations 
by clicking this button, 
or by selecting more 
labware in the Current 
Deck Display.
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5. In Leave fan on for, enter the length of time in seconds to leave the fan on after 
the HDR Tool Body moves away from the HDR Pin Drying ALP.

Note:  The default value for Leave fan on for is 2 seconds.

3000 — Leave on for is not available because the fan unit is not controlled 
by Biomek Software.

6. Leave the pin height as is to use the default setting.

OR

Set the pin height manually using one of the following methods:

• Position the cursor over the graphic of a pin inside a well. Click and 
drag the graphic up or down. The pin moves with the cursor, and the 
height displayed below the graphic is adjusted as the graphic is 
manipulated.

• Selecting the graphic of a pin inside a well, and use the ↑ and ↓ keys. 
The textual representation of the height, which is displayed below the 
graphic, adjusts in 0.1 millimeter (mm) increments.

• Right-click on the graphic of a pin inside a well, and a menu appears. 
Select Custom Height, and Custom Height appears (Figure 19-8). 
Insert the Height in millimeters (mm) and, in from, select a reference 
point from the drop-down list. Choose OK.

Note:  The cursor changes to a hand when positioned over the graphic. 

Figure 19-21.  Custom Height prompt

7. Configure additional Cleaning Operations following the procedures in Sections 
19.4.1.1, Configuring a Wash Operation and 19.4.1.2, Configuring a Drying 
Operation.
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19.5 Using the HDR Move Labware Step (FX only)
The HDR Move Labware step moves labware from one position on the Biomek FX 
deck to another position. HDR Move Labware can also remove labware from the 
deck by placing it in a Disposal ALP or moving it to an external hardware device 
without halting the Biomek FX or the method, and without causing a light curtain 
violation.

Note:  The HDR Move Labware step should be used only when moving labware 
with a Multichannel Pod that has the HDR Tool Body installed. If the pod is equipped 
with any other multichannel head, use the Move Labware step found on the Basic 
Step Palette (refer to Section 15.4, Move Labware Step). A validation error results if 
the inappropriate Move Labware step is used.

Insert an HDR Move Labware step into the Method View (Figure 19-22).

Figure 19-22.  HDR Move Labware step and configuration

HDR Move Labware Step Configuration
The stacking options configure how labware is 
moved from stacks on the deck.

Current Deck Display
The origination position is 
outlined in blue. The 
destination location is 
outlined in yellow.
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19.5.1 Configuring the HDR Move Labware Step 
To configure an HDR Move Labware step, complete the following steps:

CAUTION: Make sure the correct ALP is chosen when configuring the 
deck setup in the Deck Editor. ALPs vary in height, and failure to choose 
each ALP correctly in the software may result in collisions between 
pod(s) and ALPs during operation.
CAUTION: Do not access labware positioned on a 1 x 5 Passive ALP 
with the HDR Tool Body. The gripper may crash with the ALP. 
1. In Using Pod, select the pod moving the labware. 

Note:  In Using Pod, Pod1 is the default for a one-pod Biomek FX system. In a 
two-pod Biomek FX system, the pod configured as the default pod is displayed in 
Using Pod. If the other pod is desired, select the pod from the drop-down list. 
Only a Multichannel Pod with the HDR Tool Body installed may use the HDR 
Move Labware step.

2. In Move labware from, select the original deck position for the labware from 
the Current Deck Display. This instructs the Biomek FX to Move labware from 
a specific deck position in preparation for leaving it at a final destination.

3. In to, select the final deck position for the labware from the Current Deck 
Display. This instructs the Biomek FX to move the labware to a final deck 
position.

4. Select the desired option for moving stacked labware:

• Move the entire stack of labware — moves all labware in the 
stack; this option should be selected when moving a single unstacked 
piece of labware.

• Move stack, leaving the bottom piece of labware at the 
source position — moves all labware in the stack except for the 
bottom piece.

Note: Selecting Move stack, leaving the bottom piece of labware 
at the source position when the source deck position contains only 
one piece of labware results in an error. 

• Move the topmost . . .piece(s) of labware from the stack — 
moves only the specified number of labware from the top of the stack.

Note:  Refer to Section 7.3.6.4.1, Biomek Stacking Rules, for complete 
information on using stacks with the Biomek FX instrument.
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20 Using the Biomek 3000 Step 
Palette

20.1 Overview
The Biomek 3000 Step Palette provides steps for use specifically with a Biomek 3000 
workstation, including tool loading and unloading and aspirate and dispense 
operations with the Wash System.

The steps available in the Biomek 3000 Step Palette are:

• Change Tool — unloads the tool currently loaded on the Biomek 3000 head 
assembly to an empty tool rack position and loads the specified tool.

• Load Tool — locates the specified tool on the deck and loads it to the 
Biomek 3000 head assembly.

• Unload Tool — unloads the tool currently loaded on the Biomek 3000 head 
assembly to an empty tool rack position.

• Remove to Waste — aspirates liquid to waste using a wash tool.

• Bulk Dispense — performs a bulk dispense operation from a wash liquid 
container using a wash tool.
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• Purge Wash Tool — purges the tubing of the wash system and wash tool.

• Wash Plate — perform a plate washing operation using a wash tool.

When one of the above steps is added to a method, the configuration for the 
step appears on the right side of the Biomek main editor, in step configuration 
(Figure 20-1).

Note:  Steps not configured appropriately in Step Configuration generate errors when 
the method is validated or run.
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20.2 Displaying the Biomek 3000 Step Palette
In order to add Biomek 3000 steps to a method, display the Biomek 3000 Step Palette 
(Figure 20-1).

Figure 20-1.  Biomek Software main editor with Biomek 3000 Step Palette displayed

To display the Biomek 3000 Step Palette, complete the following:

• Right-click any empty palette space, and the Step Palette menu appears. 
Select Biomek3000.

OR

• From the toolbar, select Options>Toolbars>Biomek3000.

Method View
The method is built 
step by step in the 
Method View.

Step Configuration
When a step is highlighted in the Method 
View, the corresponding configuration 
appears in this area.

Biomek 3000 
Step Palette
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20.3 Change Tool Step
The Change Tool step is used to instruct the Biomek 3000 workstation to unload the 
tool installed on the head assembly and load a different tool. The Biomek 3000 
workstation automatically locates an empty tool rack position, unloads the tool at the 
empty position, locates the desired tool, and loads the tool to the head assembly.

Note:  The Transfer, Combine, and Move Labware steps automatically change to 
an appropriate tool to perform the operation. However, if a specific tool is desired for 
an operation, a Change Tool or Load Tool step should be inserted prior to the 
operation to guarantee the desired tool is used.

Insert a Change Tool step into the method. The Change Tool step configuration 
appears (Figure 20-2).

Figure 20-2.  Changing tools during a method

To configure the Change Tool step configuration:

1. In Change to Tool, specify the tool to load after unloading the current tool. All 
tools located on the deck in a tool rack (as configured in Labware Properties 
for the tool rack in an Instrument Setup step) are available for selection. 

2. Select a step that occurs after the Change Tool step or the Finish step to 
validate the step configuration.
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20.4 Load Tool Step
The Load Tool step is used to instruct the Biomek 3000 workstation to load a tool to 
the Biomek 3000 head assembly when no tool is currently installed. The Biomek 
3000 workstation automatically locates the desired tool in a tool rack and loads the 
tool to the head assembly.

Note:  The Transfer, Combine, and Move Labware steps will automatically 
change to an appropriate tool to perform the operation. However, if a specific tool is 
desired for an operation, a Change Tool or Load Tool step should be inserted prior 
to the operation to guarantee the desired tool is used.

Insert a Load Tool step into the method. The Load Tool step configuration appears 
(Figure 20-3).

Figure 20-3.  Loading tool during a method
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To configure the Load Tool step configuration:

1. In Load Tool, specify the tool to load to the head assembly. All tools that are 
located on the deck in a tool rack (as configured in the Labware Properties for 
the tool rack in an Instrument Setup step) are available for selection.

2. If the tool selected in Load Tool is a wash tool, in Liquid, select the liquid type to 
purge the tubing and wash tool with after loading the tool. Biomek Software 
automatically performs a purge operation similar to a Purge Wash Tool Step 
(Section 20.8) with the selected Liquid when the tool is loaded.

Figure 20-4.  Load Tool step configuration with wash tool selected

3. Select a step that occurs after the Load Tool step or the Finish step to validate 
the step configuration.
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20.5 Unload Tool Step
The Unload Tool step is used to instruct the Biomek 3000 workstation to unload the 
tool installed on the head assembly. The Biomek 3000 workstation automatically 
locates an empty tool rack position and unloads the tool at the empty position.

A tool must be unloaded before loading a new tool. Many steps, such as Transfer, 
Combine, and Move Labware automatically unload the current tool and load a more 
appropriate tool for the operation It is only necessary to use an Unload Tool step 
when it is desired to unload the current tool prior to loading a specific tool to the head 
assembly using a Load Tool step.

Note:  The Biomek 3000 head assembly can be instructed to automatically unload 
any tools installed at the end of a method in the Finish step.

Insert an Unload Tool step into the method. The Unload Tool step configuration 
appears (Figure 20-5).

Figure 20-5.  Unloading a tool during a method

The Unload Tool step requires no additional configuration. Select a step that occurs 
after the Unload Tool step or the Finish step to validate the step configuration.
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20.6 Remove to Waste Step
The Remove to Waste step is used to aspirate liquid using a single-channel or eight-
channel wash tool to an off-deck waste container. The wash tools has two needles for 
each channel: a long aspiration needle and a shorter dispense needle. Liquid is 
aspirated from the wells using the aspiration needles by applying a vacuum for a 
specified amount of time and removed to an off-deck waste container. 

Note:  A Wash Unit must be installed on the Biomek 3000 workstation and 
connected to an external vacuum pump or vacuum source to aspirate liquid using the 
Remove to Waste step.

Insert a Remove to Waste step into the method. The Remove to Waste step 
configuration appears (Figure 20-6).

Figure 20-6.  Remove to Waste step configuration

Note:  A wash tool must be loaded onto the Biomek 3000 head assembly using either 
a Load Tool or Change Tool step prior to the Remove to Waste step.

Note:  If a 6-port valve is installed with the Wash Unit, a Device Action step must 
be inserted to configure the wash liquids available from each port.
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To configure the Remove to Waste step:

1. Click on the desired piece of labware in the Current Deck Display. The Labware 
Type and Position for that piece of labware is entered automatically into the 
Remove to Waste step configuration.

OR

Select a Labware Type and Position from the drop-down list.

2. On the plate map, select the wells from which to aspirate liquid to waste.

Note:  Hold Shift and click a well to select additional wells without deselecting 
any wells. Hold Ctrl and click a well to toggle the selection status of selected 
wells without affecting the status of other wells. If Shift or Ctrl is not held down 
when selecting wells, any previous selection is deleted.

3. In Liquid Type, select the liquid type to aspirate.

4. In Aspirate for, enter the length of time in seconds to apply vacuum and aspirate 
liquid to waste for each well.

5. Select a step that occurs after the Remove to Waste step or the Finish step to 
validate the step configuration.
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20.7 Bulk Dispense Step
The Bulk Dispense step is used to dispense liquid using a single-channel or eight-
channel wash tool. The wash tools have two needles for each channel: a long 
aspiration needle and a shorter dispense needle. Liquid is dispensed from the source 
wash liquid container through the dispense needles. The volume dispensed is limited 
only by the amount of liquid in the source container.

After dispensing, a Backup Volume is aspirated by the dispense needles to prevent 
droplets from forming on the dispense needles. The Backup Volume is set in 
Hardware Setup (refer to the Biomek® 3000 Laboratory Automation Workstation 
User’s Manual, Section 12.4.3, Configuring Wash Tools). 

Note:  A Wash Unit must be installed on the Biomek 3000 workstation to dispense 
liquid using the Bulk Dispense step.
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Insert a Bulk Dispense step into the method. The Bulk Dispense step configuration 
appears (Figure 20-7).

Figure 20-7.  Bulk Dispense step configuration

Note:  A wash tool must be loaded onto the Biomek 3000 head assembly using either 
a Load Tool or Change Tool step prior to the Bulk Dispense step.

Note:  If a 6-port valve is installed with the Wash Unit, a Device Action step must 
be inserted to configure the wash liquids available from each port.

To configure the Bulk Dispense step:

1. Click on the desired piece of labware in the Current Deck Display. The Labware 
Type and Position for that piece of labware is entered automatically into the 
Bulk Dispense step configuration.

OR

Select a Labware Type and Position from the drop-down list.
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2. On the plate map, select the wells from which to aspirate liquid to waste.

Note:  Hold Shift and click a well to select additional wells without deselecting 
any wells. Hold Ctrl and click a well to toggle the selection status of selected 
wells without affecting the status of other wells. If Shift or Ctrl is not held down 
when selecting wells, any previous selection is deleted.

3. In Liquid Type, select the liquid type to dispense. 

Note:  If using the Wash Tool Dispense step with a six-port valve, the liquid 
type must be one of the liquid types configured for the six-port valve in the 
Device Action step.

4. In Volume, enter the volume to dispense in microliters (µL).

5. In Speed, enter the speed at which to dispense.

6. Select a step that occurs after the Bulk Dispense step or the Finish step to 
validate the step configuration.
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20.8 Purge Wash Tool Step
The Purge Wash Tool step is used to rinse the tubing and needles of the tools before 
use. A purge is automatically performed when a wash tool is loaded or when liquids 
are switched using the 6-port valve. The Purge Wash Tool step enables another 
purge to occur at any time during a method. The Purge Wash Tool step is useful for 
rinsing the tubing and wash tool when changing wash liquids using a 6-port valve.

During a purge, a wash liquid is dispensed through the dispense tubing and dispense 
needles on the wash tool. At the same time, wash liquid is aspirated using the aspirate 
needles on the wash tool and removed to waste through the aspirate tubing. The purge 
process effectively rinses the wash system tubing and wash tool, preparing it for use 
with the specified wash liquid. 

After a purge operation, the dispense needles aspirate a Return Volume to prevent 
droplets from forming on the dispense needles. The Return Volume is set in 
Hardware Setup (refer to the Biomek® 3000 Laboratory Automation Workstation 
User’s Manual, Section 12.4.3, Configuring Wash Tools).

Note:  It is recommended to insert a Purge Wash Tool step using distilled or 
deionized water at the end of each method that uses the wash tool to maintain the 
wash system. 

Note:  A Wash Unit must be installed on the Biomek 3000 workstation to purge 
using the Purge Wash Tool step.
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Insert a Purge Wash Tool step into the method. The Purge Wash Tool step 
configuration appears (Figure 20-8).

Figure 20-8.  Wash Tool Purge step configuration

Note:  A wash tool must be loaded onto the Biomek 3000 head assembly using either 
a Load Tool or Change Tool step prior to the Wash Tool Purge step.

Note:  If a 6-port valve is installed with the Wash Unit, a Device Action step must 
be inserted to configure the wash liquids available from each port.

To configure the Purge Wash Tool step:

1. In Liquid, select the liquid type to use for the purge. 

Note:  If using the Wash Tool Dispense step with a six-port valve, the liquid 
type must be one of the liquid types configured for the six-port valve in the 
Device Action step.

2. In Purge, enter the volume to dispense from each channel in microliters (µL).

3. In Speed, enter the speed at which to purge.

4. Select a step that occurs after the Purge Wash Tool step or the Finish step to 
validate the step configuration.
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20.9 Wash Plate Step
The Wash Plate step is used to perform plate washing operations using a wash tool on 
the Biomek 3000 head assembly. Plate washing is performed as part of many assays 
to remove any unbound substrates before further processing.

A typical plate washing procedure performs the following actions:

• dispense liquid into wells from dispense needles on the wash tool.

• after dispensing, aspirate a Backup Volume with dispense needles to 
prevent droplets from forming on the dispense needles. The Backup 
Volume is set in Hardware Setup (refer to the Biomek® 3000 Laboratory 
Automation Workstation User’s Manual, Section 12.4.3, Configuring Wash 
Tools). 

• pause for a specified length of time.

• aspirate liquid from the wells using the aspirate needles on the wash tool and 
remove it to waste.

• repeat a specified number of times.

Note:  A Wash Unit must be installed on the Biomek 3000 workstation to wash 
plates using the Wash Plate step.
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Insert a Wash Plate step into the method. The Wash Plate step configuration 
appears (Figure 20-9).

Figure 20-9.  Wash Plate step configuration

To configure the Wash Plate step:

Note:  A wash tool must be loaded onto the Biomek 3000 head assembly using either 
a Load Tool or Change Tool step prior to the Wash Plate step.

Note:  If a 6-port valve is installed with the Wash Unit, a Device Action step must 
be inserted to configure the wash liquids available from each port (refer to Section 
22.6.1.1, Configuring the Device Action Step for 6-Port Valve (3000 only)).

1. Click on the desired piece of labware in the Current Deck Display. The Labware 
Type and Position for that piece of labware is entered automatically into the 
Wash Plate step configuration.

OR

Select a Labware Type and Position from the drop-down list.
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2. On the plate map, select the wells of the microplate to wash.

Note:  Hold Shift and click a well to select additional wells without deselecting 
any wells. Hold Ctrl and click a well to toggle the selection status of selected 
wells without affecting the status of other wells. If Shift or Ctrl is not held down 
when selecting wells, any previous selection is deleted. Wells are selected 
individually or in rows, depending on the wash tool used.

3. In Liquid Type, select the liquid type to use for plate washing. 

Note:  If using the Wash Plate step with a 6-port valve, the liquid type must be 
one of the liquid types configured for the 6-port valve in the Device Action step.

4. In Wash ... times, enter the number of cycles to perform to wash the plate.

5. In Volume, enter the volume to dispense to each well from the dispense needles 
during each cycle of the plate wash in microliters (µL).

6. In Speed, enter the speed at which to dispense.

7. In Aspirate for, enter the length of time in seconds to apply vacuum and aspirate 
liquid to waste for each well using the aspirate needles.

8. In Pause after dispense, enter the length of time after the dispense to pause 
before beginning the aspirate operation.

9. Select a step that occurs after the Wash Plate step or the Finish step to validate 
the step configuration.
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21 Using the Specialty Step 
Palette

21.1 Overview
The steps presented in the Specialty Step Palette allow more control over methods. 
These steps are used to:

• Set variables and make non-incremental changes to variables.

• Break out of loops.

• Create and use groups of labware.

• Run executables.

• Define and run procedures.

Note:  The steps available in the Specialty Step Palette do not use the pod directly 
and may be used with any single or dual-pod configuration.

Steps available in Specialty include:

• Create Group — creates a group of labware.

• Next Labware — accesses the next piece of labware in a group of 
labware created using Create Group.

• Run Program — runs any executable file during a method.

• Next Item — binds a series of values to a global variable. 
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• Set Global — defines a global variable that can be used in subsequent 
steps of a method.

• Run Procedure — runs a series of steps previously created in a 
Define Procedure step.

• Define Procedure — creates a series of steps that can be run at any
point during a method using a Run Procedure step.

• Break — breaks out of one or more loops.
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21.2 Displaying the Speciality Step Palette
To add specialty steps to a method, display the Specialty Step Palette (Figure 21-1).

Figure 21-1.  Biomek Software main editor with Specialty Step Palette displayed

To display the Specialty Step Palette:

• Right-click any empty palette space, and select Specialty from the menu.

OR

• From the toolbar, select Options>Toolbars>Specialty.

Method View
The method is built 
step by step in this 
area.

Step Configuration
When a step is highlighted in the Method View, 
set the corresponding configuration in this area.

Specialty Step Palette
Displays the steps available for insertion into a method. 
Additional step palettes include Basic, Intermediate, 
Advanced, Span-8, Data Sets, HDR, SILAS, Stacker 
Carousel, and Devices. Biomek3000 is only available 
for use on a Biomek 3000 instrument.
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21.3 Create Group Step
The Create Group step creates and names a group of labware that may be accessed 
during a method run using a Next Labware step. 

21.3.1 Configuring the Create Group Step
To insert a Create Group step into a method, insert the Create Group in the 
Method View. The Create Group Step Configuration appears (Figure 21-2).

Figure 21-2.  Create Group step and configuration

Create Group configuration
Create Group is used to create a 
group of labware and assign a name 
to that group. Method View

The method displayed 
contains a Create 
Group step. The group 
name appears in the step 
caption.
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To configure the Create Group step:

1. In Group, enter a name for the group of labware (Figure 21-3).

2. Click on labware in the Current Deck Display to add them to the group.

Note:  Choose Delete to remove the labware from the group.

Figure 21-3.  Create Group step configuration with labware added

3. Choose Move the first labware to to allow the pod to move labware to a 
specific position, if desired.

Note:  Selecting Move the first labware to is equivalent to inserting a Next 
Labware step right after the Create Group step. The group variable is assigned 
the value of the first labware in the group and is moved to the specified position.

FX — When selecting Move the first labware to, the chosen pod must be a 
Multichannel Pod; these pods have a gripper that can grasp and move 
labware. 

3000, NX-S8 — To use a gripper tool, it must be installed in Hardware 
Setup, configured in Instrument Setup, and available on the deck.

Current Deck 
Display

Clicking on labware 
here adds them to the 
group.

Provides an option to allow a Multichannel 
Pod or Gripper tool to move labware to the 
appropriate deck position. 

Enter the name of the group here.

Delete labware 
from the group 
here.
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4. If Move the first labware to is selected, select the deck position to which to 
move the first labware.

Note:  Click on any empty deck position in Current Deck Display. Move the 
first labware to is selected, and the deck position chosen in the Current Deck 
Display is selected. 

If a deck position is not selected, it leaves the labware at its current location.

5. If Move the first labware to is selected, select the pod used to move the first 
labware to the selected position.

Note:  Choosing the position and pod is a necessary option if a Stacker Carousel 
presents a piece of labware that must be moved to a deck position. 

FX — The chosen pod must be a Multichannel Pod; these pods have a 
gripper that can grasp and move labware. 

3000, NX-S8 — To use a gripper tool, it must be installed in Hardware 
Setup, configured in Instrument Setup, and available on the deck.
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21.4 Next Labware Step
Next Labware assigns the next labware in the group as the value of the global 
variable created in the Create Group step. The global variable created in the Create 
Group step is not assigned a value until a Next Labware step has assigned a value to 
the global variable. The Next Labware step also has options to get the next labware 
only when a pattern is completed or to break out of the current loop when all labware 
is used.

21.4.1 Configuring the Next Labware Step
Insert the Next Labware step in the Method View. The Next Labware Step 
Configuration appears (Figure 21-4)

Figure 21-4.  Next Labware step and configuration

To configure the Next Labware step:

1. Choose the Group from the pull-down menu.

Note:  All the groups created in the current method are listed.

2. In To Location, choose the deck position to which the next listed labware in the 
selected Group is moved by selecting from the list

OR

Click on the empty deck position in the Current Deck Display.
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3. Check If the labware is on deck leave it where it is to leave the labware in 
its current location instead of moving it to the To Location, if desired.

4. Choose the Pod moving the labware to the specified To Location.

Note:  Choosing the position and pod is necessary when a Stacker Carousel 
presents a piece of labware that must be moved to a deck position. 

FX — On the Biomek FX, the chosen pod must be a Multichannel Pod; 
these pods have a gripper that can grasp and move labware. 

3000, NX-S8 — To use a gripper tool, it must be installed in Hardware 
Setup, configured in Instrument Setup, and available on the deck.

5. Choose Get the next labware only if the last pattern used on the 
labware was completed to allow the next piece of labware in the group to be 
accessed only if all the selected wells on the current piece of labware have been 
accessed in a Transfer or Combine step.

6. Choose Break out of the current loop if there are no more unused 
labware in the given group to break out of the current loop and allow the 
method to continue when all the labware in the group has been accessed.
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21.4.2 Using Group Variables in a Method
Group names configured in a Create Group step and assigned a value with a Next 
Labware step may be used in any deck position field in any step within the method.

To use a group variable in another step:

1. Select a field that requires a deck position in the desired step configuration. For 
example, the group Sources is used to specify the deck location of the 
destination for the Transfer step (Figure 21-5).

2. Enter the group name, preceded by an equal sign. For example, =Sources in the 
at field of the destination in the Transfer step indicates a volume is transferred to 
the labware at the deck position indicated by the group variable Sources.

Note:  Group names may be used in any field where a deck position is a valid 
value for that field.

Figure 21-5.  Transfer step using the Sources group defined in a Create Group step

Using a group defined in 
the Create Group step



21-10 Using the Specialty Step Palette

Beckman Coulter, Inc.

21.5 Run Program Step
Run Program executes any application within a method. It can be used, for example, 
to run a custom data logger, display a read-me file or special instructions at specified 
times during a method, or access a database.

21.5.1 Configuring the Run Program Step
Insert the Run Program step in the Method View. The Run Program Step 
Configuration appears (Figure 21-6).

Figure 21-6.  Run Program step and configuration
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To configure the Run Program step:

1. In Open, enter the full path and file name for the program to execute during 
method run

OR

Choose Browse and select the desired program from Open.

Note:  Any executable file (.exe, .bat, etc.) in any accessible directory (local or 
network) may be selected in the Run Program step. Web sites can be accessed 
(http://www.beckmancoulter.com) or email (mailto:jdoe@example.com) sent.

2. Select how the program should be run in so that it is. Options are Visible or 
Invisible.

Note:  Any application that is Visible is run and displayed in a visible window. 
Any application that is Invisible is run in the background with no visual display. 
Certain executables, such as Notepad or Calculator, cannot be executed as 
Invisible.

3. In starting in the directory, specify the directory to search for the parameter 
entered in with.

Note:  When the Run Program step is executed, it searches the indicated 
directory for the specified parameter. Results depend on the application run and 
whether or not the specified parameter is found.

4. In with, enter any parameters used when running the program. For example, if 
the selected program is Microsoft® Word, the full path and file name of a Word 
document can be entered as a parameter. The program runs and opens the Word 
file entered as a parameter in with.

5. In after the resource, select a pod, deck position, or ALP. The program 
executes when the selected resource is available.

Note:  Select <Everything> to run the program when everything on the deck is 
available.

6. Make a selection in When a program is started:

• Allow the method to continue independently — after starting 
the program, the method continues independent from the program; that 
is, it does not wait for the program to finish before continuing with the 
method. This is useful for displaying nonfatal information.

• Hold the resource until the program completes — the selected 
resource is paused while the program is running and may not be 
accessed until the program is finished and closed.

• Block all method activity including look-ahead until the 
program completes — the method pauses and waits for the program 
to finish before enqueueing the next step and continuing with the 
method. This is useful when data from the executable is used to make 
choices in a Biomek method; for example, a LIMS system driving a hit 
picking method.
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7. In This program will take approximately, enter the estimated length of time to 
run the program in seconds. 

Note:  The time entered in This program will take approximately is only used 
to calculate the ETC and does not affect the method run or actual run time for the 
method.

8. If desired, select Allow the light curtain to be broken while the program 
is running. While the program is running, the Biomek instrument is paused and 
the light curtain may be broken without causing an error. This is useful for 
integrating third-party devices onto a Biomek system.

Note:  Allow the light curtain to be broken while the program is running is 
available when the resource <Everything> is selected and Allow the method 
to continue independently is deselected.

3000 — Does not have light curtain.

9. Select a step that occurs after the Run Program step or the Finish step to 
validate the step configuration.
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21.6 Next Item Step
The Next Item step is used to iterate over a sequence of values. When configured, the 
Next Item step names a global variable, provides a list of VB script expressions, and 
specifies behavior when the list is exhausted.

When the Next Item step is used in a method, the named global variable may be 
assigned a new value. Each expression is evaluated to form a list of values. 

If the named global variable is not assigned a value, it is assigned the first value of the 
list. If the global variable is assigned a value, the step searches for a matching value in 
the list and performs one of the following actions based on the results of the search:

• If a match is found, the global variable is assigned the next value in the list. 

• If the matching value is the last value in the list, the action to take when the 
list is exhausted is applied.

• If no match is found, the global variable is assigned the first value in the list. 

Note: Use a Set Global step prior to the first appearance of a Next Item 
step to create the variable used in the Next Item step and assign it no value 
(leave the Value field empty). This guarantees that the first Next Item step 
assigns the first value in the list to the variable.

The Next Item step is often used with a Loop step, with the value of the variable 
changing with each iteration of the loop.

Note:  Refer to Section 16.9, Loop Step, for more information on using the Loop 
step.
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21.6.1 Configuring the Next Item Step
Insert Next Item into the Method View. The Next Item Step Configuration appears 
(Figure 21-7).

Figure 21-7.  Next Item step and configuration

To configure the Next Item step:

1. Select a previously defined Variable

OR

Enter a new Variable name.

Method View
The method displayed 
contains a Next Item 
step inside a Loop step. 

Variable
Select a previously 
created variable or 
create a new variable 
here. The Current 
variable, created in 
the Set Global step, 
is selected here.Values

Enter the list of values here, 
separated by commas. 

Current Deck Display
Clicking on deck positions adds 
them to the list of Values.
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2. Enter the Values of the Variable, separating each with a comma.

Note:  Deck positions must be entered in double quotes. For example, deck 
position P4 is entered as “P4” in Values. Deck positions may also be entered by 
clicking on each position in the Current Deck Display.

Note:  All Values must be unique. If a value is repeated in the list, an error 
occurs during validation.

3. Indicate the action to take when all values have been used:

• Break out of current loop — ends the current loop and continues with 
the method; Next Item must be placed inside a Loop step or a 
procedure that is run from inside a Loop step to use this option

• Set variable to — sets the variable to a specified value and uses that 
value for the variable

• Start over with the first value — sets the variable to the first value and 
continues; loops the Next Item values
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21.7 Set Global Step
The Set Global step is used to create a global variable accessible to all steps 
following the Set Global step in a method. It allows steps to be parameterized by 
specifying explicit values for fields like volumes and heights. For example, instead of 
typing the number of microliters into the volume field of an Aspirate step, the name 
of a variable is inserted. Every time the Aspirate step is executed, the current value of 
that variable is used as the volume.

Any of the steps following the Set Global step can use variables created in the Set 
Global Step Configuration. A step uses a global variable by referencing it in its step 
configuration. The Biomek Software automatically uses the associated value when 
the step is executed.

Note:  For information on variables and expressions, refer to Chapter 13, Using 
Variables and Expressions in a Method.

21.7.1 Configuring the Set Global Step
Configuring the Set Global step involves naming the variable and setting its initial 
value.

Insert Set Global into the Method View. The Set Global Step Configuration 
appears (Figure 21-8).

Figure 21-8.  Set Global step and configuration

Method View
The method displayed contains 
a Set Global step. The variable 
assigned in Set Global appears 
in the step caption.

Set Global configuration
The Set Global configuration consists 
of a variable name and value. Variables 
assigned in a Set Global step are 
available to all steps following the Set 
Global step and may be used in any 
field instead of entering a value. Here, 
the variable Current is created and is 
later used in a Next Item step.
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To configure the Set Global step:

1. Select Set Global in the Method View. The Set Global Step Configuration 
appears.

2. Enter the Variable name (refer to Chapter 13, Using Variables and Expressions 
in a Method).

3. Enter the desired Value for the Variable.

Note:  The value of the variable is assigned the appropriate units when used in a 
step configuration. For example, if a variable AspValue with a value of 10 is 
used in the Volume field of a Transfer step, the software interprets this as 10 
microliters (µL). 

Note:  Deck positions must be entered in double quotes. For example, deck 
position P4 is entered as “P4” in Values.
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21.8 Defining and Running Procedures
The Define Procedure and Run Procedure steps are used to create a series of steps 
that may be used multiple times in a method. A procedure is created by adding and 
configuring steps within a Define Procedure step. 

Variables may be created in the Define Procedure step and used to configure the 
steps in the procedure. Variables created in the Define Procedure step configuration 
can be overridden in the Run Procedure step configuration.

Multiple procedures can be defined in a method, and a procedure can be run multiple 
times within a method.

The advantages of using procedures are:

• The ability to run the same steps multiple times within a method but 
configuring them only once

• The size of the current method is controlled which reduces confusion by 
listing only the Run Procedure step in the Method View, not all of the steps 
accessed by the Run Procedure step

21.8.1 Define Procedure Step
The Define Procedure step is used to create procedures that may be called any time 
during a method with a Run Procedure step. 

When the Define Procedure step is added to a method, the Define Procedure icon 
appears. Double-click the icon to expand the procedure and display the End 
Procedure icon. Any steps placed between the Define Procedure and End 
Procedure icons are run when the procedure is called with a Run Procedure step. 
These steps are configured through their individual step configurations. 

The procedure may be collapsed to conserve space in the Method View by double-
clicking the Define Procedure icon.
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21.8.1.1 Configuring the Define Procedure Step
Insert Define Procedure in the Method View. The Define Procedure Step 
Configuration appears (Figure 21-9). Define Procedure is added to a method 
collapsed.

Figure 21-9.  Define Procedure step and configuration

To configure the Define Procedure step:
1. In Procedure, enter a name for the procedure.

Note:  The procedure name may contain only alphanumeric characters and the 
underscore (_), and are not case-sensitive.

2. Insert the variables desired (refer to Chapter 13, Using Variables and Expressions 
in a Method).

Note:  Variables created in a Define Procedure step are accessible only to the 
substeps within that procedure.

3. Double-click the Define Procedure icon in the Method View to open the 
procedure. The End Procedure icon appears below the Define Procedure icon.

4. Insert the desired steps between Define Procedure and End Procedure.

5. Configure the steps between Define Procedure and End Procedure as desired.

6. Double-click the Define Procedure icon to collapse the procedure and hide all 
steps between the Define Procedure and End Procedure icons.

Procedure
Assign a name to 
the procedure.

Method View
The method displayed contains a 
Define Procedure step. The 
name assigned to the procedure 
appears in the step caption.

Variables
Insert any variables used in the procedure 
here. The values for the variables may be 
assigned new values when the procedure is 
run in a Run Procedure step.
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21.8.2 Run Procedure Step
The Run Procedure step executes a procedure previously created with the Define 
Procedure step. The step inserts all of the steps from the referenced procedure into 
the current method at the point the Run Procedure step appears. The called 
procedure then behaves exactly as if the steps were configured at the point where the 
procedure is called.

The Run Procedure step may also assign new values to variables created in the 
called procedure. These values override any value configured in the Define 
Procedure step. This allows a procedure to be used as a template that can be 
customized each time it is performed by a Run Procedure step by changing the 
values of the variables.

21.8.2.1 Configuring the Run Procedure Step
Insert Run Procedure in the Method View. The Run Procedure Step 
Configuration appears (Figure 21-10).

Note:  The procedure to run in a Run Procedure step must be defined in a Define 
Procedure step earlier in the method. or in a previously run method that did not clear 
all global variables in the Finish step

Figure 21-10.  Run Procedure step and configuration

1. Select the desired procedure from the list of defined procedures. The variables 
used in that procedure are displayed.

2. Enter the desired values for the variables (refer to Chapter 13, Using Variables 
and Expressions in a Method). 

Note:  Variables in a Run Procedure step are accessible only to the called 
procedure.

Method View
The method displayed 
contains a Run 
Procedure step. The 
name of the procedure 
to execute appears in 
the step caption.

Procedure
Select a previously 
defined procedure.

Variables
Assign new values to 
the procedure variables, 
if desired.
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21.9 Break Step
The Break step is used to break out of one or more loops during a method. Break is 
usually used as part of an If step to break out of a Loop under certain conditions. 
When Break is placed under the Then substep and the If statement is true, the Break 
step ends the Loop. 

Note:  The Break step must be placed inside of a Loop step or a procedure run from 
inside a Loop step or errors are generated during validation or method run.

Note:  Refer to Section 16.9, Loop Step, for more information on using a Loop step. 
Refer to Section 17.7, If Step, for more information on using an If Step.

21.9.1 Configuring the Break Step
To insert a Break step into a method, insert the Break step inside a Loop step in the 
Method View. The Break Step Configuration appears (Figure 21-11).

[
Figure 21-11.  Break step and configuration

Levels
The number of nested Loop steps to 
break out of. This value must be 
less than or equal to the total 
number of nested loops in which 
the Break step is found.

Method View
The method displayed includes 
a Break step inserted inside a 
Loop in an If step. When the If 
condition is true, the Loop step 
ends even if all iterations have 
not been completed.
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To configure the Break step:

Select the number of Levels to break out of. 

Note:  Levels refers to the number of nested Loop steps that are discontinued. 
Break terminates the number of Loop steps specified in Levels and continues with 
the method. 

For example, a method contains a Loop step that contains a second Loop step nested. 
Within the second Loop step is an If step with a Break step with Levels set at 2 under 
the Then branch. When the If statement in the second Loop step is true, the Break 
step terminates both Loop steps and continues with the method. If Levels was set to 
1, the Break step terminates the second Loop step and continues with the first Loop 
step.

Note:  There must be a number of nested Loop steps greater than or equal to the 
number of Levels or an error occurs during method validation and run.
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22 Using the Devices Step Palette

22.1 Overview
The steps presented in the Devices Step Palette (Figure 22-1) integrate active ALPs 
and other devices with the Biomek instrument. The integration allows Biomek 
Software to control the device. 

After an active ALP or device is integrated, Biomek Software understands the 
attributes of the device, displays the configuration for the device, and receives 
information for operating the device.

Note:  Devices must be installed and configured in Hardware Setup. Refer to the 
instrument hardware manual for more information.

Note:  Devices must also be configured on the deck in the Deck Editor (refer to 
Chapter 5, Preparing and Managing the Deck).

The steps displayed on the Devices Step Palette include:

• SPE — allows a method to easily assemble and disassemble the stack
of labware required for an SPE operation.

• Device Setup — configures labware contained in external devices that hold 
multiple pieces of labware.

• Device Action — controls devices during a method run.

FX — controls devices and active ALPs such as the Tip Wash ALP or 
Stirring ALP.

3000 — controls devices such as the autolatch, 6-port valve, vacuum, 
Wash System, and MicroMix.

NX — controls devices and active ALPs such as the Source/Waste 
Sensor and Drainable/Refillable Reservoir ALP.
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• Tip Loader — configures a Tip Loader ALP location and status.

FX, NX-MC — The Tip Loader ALP is used only with a Multichannel 
Pod.

The following step is displayed when a SILAS device and the software associated 
with it are installed on the system:

• SILAS™ Module step — controls operation of the associated SILAS
Module, such as a barcode reader or a SILAS consumer that has been 
added to a step palette.

Note: The icon for a SILAS Module step varies according to the device 
the step represents; for example, a Barcode Reader SILAS Module step 
displays an icon of a barcode reader.

When a device integration step is added to a method, the configuration associated 
with that step appears on the right side of the Biomek main editor in Step 
Configuration (Figure 22-1). Steps not configured appropriately can generate errors 
when the method is validated or run.
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22.2 Displaying the Devices Step Palette
In order to add device steps to a method, the Devices Step Palette must be displayed 
(Figure 22-1).

Figure 22-1.  Main editor for a Biomek FX with Devices Step Palette displayed

To display the Devices Step Palette, complete the following:

• Right-click any empty palette space, and the Step Palette menu appears. 
Select Devices from the menu.

OR

• From the toolbar, select Options>Toolbars>Devices

Step Configuration
When a step is highlighted in the 
Method View, set the corresponding 
Step Configuration in this area.
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22.3 SPE Step
The Solid Phase Extraction (SPE) ALP applies a vacuum to remove liquid from a 
filter microplate. The SPE step is a convenient way of executing the assembly and 
disassembly of the SPE ALP system. The configuration for the SPE step informs 
Biomek Software of the:

• Operation required of the SPE step (Figure 22-2)

• Location of the filtered microplate used by the SPE ALP

• Locations of the SPE vacuum manifold and receiver

• Location of the SPE ALP on the deck

• Pod constructing/destroying the SPE stack

FX, NX-MC — The SPE step is for use with a Multichannel Pod; the 
gripper must be used to assemble and disassemble the SPE ALP.

3000 — A gripper tool must be installed and configured on the deck.

NX-S8 — The SPE step may only be used on the NX Span-8 with 
gripper; the gripper must be used to assemble and disassemble the SPE 
ALP.

Note:  The SPE ALP can only be used on a DNA Preparation Deck Layout and 
occupies two deck positions.
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Insert a SPE step into the Method View (Figure 22-2).

Figure 22-2.  SPE step and configuration

22.3.1 Configuring the SPE Step
When an SPE step is added to a method, the SPE Step Configuration appears 
(Figure 22-2). 

To configure the SPE step:

1. Select the Operation performed by the SPE ALP from the options listed below:

• Create — assembles the various pieces of an SPE stack

• Destroy — disassembles an SPE stack

2. Select the location of the Filter Source used by the SPE stack. The Filter 
Source is the location on the deck of the filtered microplate that is placed on top 
of the SPE ALP stack.

3. Select the location of the Manifold Source for the SPE stack. The Manifold 
Source is the location of the Manifold, which is referred to as the Collar in the 
ALPs User’s Manual (refer to the ALPs User’s Manual, Chapter 16, Solid Phase 
Extraction (SPE) Vacuum Manifold ALP).

Receiver Plate Configuration
When the receiver microplate is 
positioned in a microplate holder, 
the presence of the holder must be 
indicated by selecting Receiver 
plate has a holder.

SPE Step Configuration
The operation performed by the 
SPE step, as well as the position 
and identity of the components of 
the SPE ALP are provided in the 
SPE Step Configuration. 
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4. Select the location of the Receiver Source for the SPE stack. The Receiver 
Source is any filtered microplate that is positioned inside the SPE Collar and the 
SPE ALP. If no receiver microplate is defined, the fluid flows through the source 
filtered microplate into the SPE ALP Base. The fluid is removed from the base 
via the vacuum hose (refer to the ALPs User’s Manual, Chapter 16, Solid Phase 
Extraction (SPE) Vacuum Manifold ALP).

Note:  Filter Source, Manifold Source, and Receiver Source all change to 
Destination when Operation is set to Destroy.

5. Select Receiver plate has a holder if the receiving microplate is positioned 
in a Filter Holder. The Filter Holder is used to keep the tips of a filtered 
microplate from touching the base of an ALP stand. A filter microplate without a 
Filter Holder can be positioned inside a 1x1 ALP without damaging the 
microplate.

Note:  Labware, including the Filter Holder, is positioned on the Deck Layout in 
the Instrument Setup step.

6. Select the Location of SPE ALP on the Biomek deck.

7. Specify the Pod accessing the SPE stack.

Note:  In Pod, Pod1 is the default for a one-pod Biomek system. In a two-pod 
system, the pod configured as the default pod is displayed in Pod. If the other 
pod is desired, select the pod from the drop-down list. 

8. Select a step that occurs after the SPE step or the Finish step to validate the step 
configuration.
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22.4 Using External Devices with Biomek Laboratory 
Automation Workstations

External devices may be used during a method run. In order to use these devices in a 
method, there are three components that must be configured for proper operation of 
the device. These components are:

• Device Editor — sets the attributes of the device within the
Biomek Software (refer to Section 22.4.1, Configuring Devices Using the 
Device Editor).

• Device Setup Step — configures the labware within a device
for use in a method (refer to Section 22.5, Device Setup Step).

• SILAS Module — configures the operation of the device for the method 
(refer to Section 22.8.1, Configuring the SILAS Module).

22.4.1 Configuring Devices Using the Device 
Editor

Use the Device Editor to configure external devices for use with the Biomek 
instrument. Each external device may contain different setup options, such as the 
number and type of labware the device is capable of holding. In order to use the 
device, this information must be provided through the Device Editor.

Note:  For specific operating instructions for external devices, refer to the user’s 
manual for each specific device.

To open the Device Editor:

Choose Instrument>Device Editor. Device Editor appears (Figure 22-3).

Figure 22-3.  Device Editor
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To configure a device for use with the Biomek instrument:

1. In Device, select an installed device. 

2. Choose the desired option:

• Configuration Options — configures the device to be used with the 
Biomek instrument. Refer to the device user’s manual for more 
information about available options.

• Action Commands — select and manually operate individual device 
operations. Refer to the device user’s manual for more information 
about availble operations.

• Light Curtain Access (Figure 22-4) — allows light curtain 
violations caused by a device action to be ignored.

Figure 22-4.  Light Curtain Access configuration

To configure Light Curtain Access:

FX, NX — Device Crosses Light Curtain is deselected by default. When 
selected, light curtain violation parameters must be specified. Light curtain 
violations occurring within the specified parameters are ignored; violations 
occuring outside the parameters stop the method run or action in progress.

3000 — does not have a light curtain.

1. Select Device Crosses Light Curtain to enable Light Curtain Access.

2. In Access Side, choose the side of the deck where the device action passes 
through the light curtain: Left, Center, Right.

3. In Access Extent, enter the extent in centimeters that the device passes through 
the light curtain.

4. Choose OK to close Light Curtain Access and save changes.

OR

Choose Cancel to close Light Curtain Access without saving changes. Device 
Editor appears.
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22.5 Device Setup Step
The Device Setup step is used to configure the labware contained in multiple slot 
external devices, such as a carousel (Figure 22-5). A Device Setup step only 
configures one device, so multiple Device Setup steps must be used when multiple 
external devices are used.

Device Setup is used to select the type of labware contained in each slot in the 
device, and it allows the Labware Properties to be set for each piece of labware in 
the device.

Note:  The software included with an external device must be installed before the 
device can be configured in the Device Setup step and accessed by the Biomek 
instrument.

Insert a Device Setup step into the Method View (Figure 22-5).

Figure 22-5.  Device Setup step and configuration

Device Setup Step Configuration
The Device Setup Step Configuration 
displayed is dependent upon the device 
being configured.
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22.5.1 Configuring the Device Setup Step
When a Device Setup step is inserted into a method, the Device Setup Step 
Configuration appears (Figure 22-5). The Device Setup Step Configuration 
includes:

• Configure Selection — displays the Labware Properties for the selected 
piece of labware.

• Delete — removes labware from the selected slot.

• Add Lid — communicates to the software that a lid is included with a piece 
of labware, such as a tip box or microplate with a lid. When Add Lid is 
applied to any piece of labware, an asterisk appears next to the labware 
indicating that a lid is present.

• Remove Lid — communicates to the software that a lid has been removed 
from the labware. When Remove Lid is applied to any piece of labware 
with an asterisk next to its name, the asterisk disappears indicating that a lid 
is no longer present.

To configure the Device Setup step:

1. Select the Device from the options listed. The configuration for the device is 
displayed in Step Configuration.

2. Select a Labware Category. 

3. Select a position, or multiple positions, within the configuration of the device to 
populate with labware.

4. Select a piece of labware from the graphical labware display.

OR

Drag and drop a piece of labware from the graphical labware display to the 
desired position in the device.

5. Right-click a piece of labware in the Step Configuration and select Configure 
Selection. Labware Properties appears for the type of labware being 
configured (Figure 22-6 and Figure 22-7). Use Labware Properties to 
configure each piece of labware within the device (refer to Section 22.5.1.1, 
Configuring Labware Properties for Tips and Labware).

6. Choose OK to save Labware Properties and return to the Device Setup Step 
Configuration.

7. Use Add Lid and Remove Lid as necessary to configure the lid status for the 
labware in the device. 

Note:  When Add Lid is selected, it indicates that a lid is included with a piece 
of labware. An asterisk appears next to the labware in the graphical 
representation of the stack (Figure 22-5). 

When Remove Lids is used on a piece of labware preceded by an asterisk, the 
asterisk disappears indicating that the lids are not present.
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22.5.1.1 Configuring Labware Properties for Tips and 
Labware

Specific tips and labware used in a method can be configured using Labware 
Properties. The information provided in Labware Properties is used when a 
pipetting technique is selected, and when tips are loaded and unloaded.

To access Labware Properties:

Double-click on a piece of labware in the Device Setup Step Configuration.

OR

Choose Configure Selection.

OR

Right-click on a piece of labware in the Device Setup Step Configuration, and 
choose Configure Selection. Labware Properties appears (Figure 22-6).

Figure 22-6.  Labware Properties for tips

22.5.1.1.1 Configuring Labware Properties for Tips
When the labware selected for configuration is tip box, Labware Properties 
provides the ability to configure (Figure 22-6):

• Name assigned to the tip box

• Bar code

• Where to dispose of tips

• Where to dispose of tip boxes

• Maximum number of times tips can be loaded

• Available tips

Note:  Variables and expressions may entered in any field that can be configured. 
Refer to Chapter 13, Using Variables and Expressions in a Method, for more 
information on using variables and expressions.
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To configure Labware Properties:

1. In Labware Type, verify the tip type.

2. In Name, enter name for the tip box, if applicable.

OR

Leave Name blank. When Name is blank, tips are accessed by the information 
displayed in the Labware Type field.

Note:  Naming tip boxes forces the instrument to look for a specific box of tips, 
rather than any tip box containing the specified tip type, located anywhere on the 
deck. Multiple tip boxes can be given the same name. This is used to create a 
pool of tip boxes for a specific use.

3. In Bar Code, enter the bar code.

Note:  Use the bar code field to identify a specific tip box in certain methods, 
such as plate replication. This field may be left blank. 

4. In When empty, send to, select a final destination for the tip box at the end of 
the method.

5. In Unload Tips Into, select the location reserved for tip disposal.

6. In Load no more than, enter the number of times tips can be loaded onto the 
pod during the method.

7. Choose Show Available Tips to display a graphic of the tip box 
(Figure 22-7).

Figure 22-7.  Labware Properties for tips with available tips shown

8. On the graphic of the tip box, select the usable tips. This can be used to indicate 
missing tips or tips that are otherwise not used in the method. By default, all tips 
are selected. 
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9. Choose Hide Available Tips to collapse the graphic of the tipbox.

10. Choose OK to save Labware Properties and return to the Device Setup step 
configuration.

22.5.1.1.2 Configuring Labware Properties for Labware
For labware other than tip boxes, Labware Properties provides the ability to 
configure (Figure 22-8):

• Name assigned to the labware

• Bar code

• Maximum volume per well 

• Volume for each well, if known

• Liquid type

Note:  Variables and expressions may entered in any field that can be configured. 
Refer to Chapter 13, Using Variables and Expressions in a Method, for more 
information on using variables and expressions.

Figure 22-8.  Labware Properties for microplates, reservoirs, and tube racks

To configure Labware Properties:

1. Verify the Labware Type.

2. In Name, enter a name for the labware. 

Note:  When a deck is populated by numerous pieces of labware, naming 
labware is recommended. Names should be descriptive of the contents of the 
labware or the work being accomplished during the method. Naming labware in a 
meaningful fashion may reduce confusion.

3. In Bar Code, enter the bar code.

Note:  Use the bar code field to identify a specific plate in certain methods, such 
as plate replication. This field may be left blank. 
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4. Make a selection in Labware contains. Options are Unknown, Nominal, and 
Known. This information is used by many of the techniques supplied with 
Biomek Software which aspirate or dispense liquid a certain offset from the 
liquid level. Some pods or tools can detect the liquid level using liquid-level 
sensing technology.

• If Known is selected, the liquid level is not detected during method run 
and the entered value is used during validation and method run. Known 
Volume should be supplied whenever possible. 

• If Unknown is selected, the liquid level is detected during method run if 
required by the technique, and the wells are assumed to be full when 
validating the method.

• If Nominal is selected, the liquid level is detected during method run, 
but the volume in the wells is assumed to be the entered value when 
validating the method. 

5. Enter the Volume, if Nominal or Known Volume is selected. A value entered in 
Volume is assigned to all wells.

6. Select the Liquid Type contained in the labware. The liquid type is useful 
information when Biomek Software auto-selects a technique for any aspirate and 
dispense operations acted upon this piece of labware. The technique auto-
selected to aspirate and dispense the liquid is selected based on the physical 
factors of the liquid, as well as the physical attributes of the labware. For more 
information on liquid types, refer to Chapter 8, Understanding and Creating 
Liquid Types.

7. Select Sense the liquid level the first time a well with Unknown or 
Nominal volume is accessed “from the Liquid” to use liquid level 
sensing to determine the liquid level only the first time it accesses a well with an 
Unknown or Nominal volume from the liquid. Any instances the same well on 
the piece of labware is accessed, the liquid level is calculated internally based on 
the result of the earlier liquid level sense and the amount aspirated or dispensed 
to the well in previous steps.

OR

Select Sense the liquid level every time a well is accessed “from the 
Liquid” to use liquid level sensing to determine the liquid level every time it 
accesses a well with an Unknown or Nominal volume from the liquid.

Note:  Liquid level sensing options only apply if the pod or tool accessing the 
labware is capable of sensing the liquid level. If not, the option selected is 
ignored.
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8. If the labware does not contain uniform volumes, choose Show Labware 
Volumes to display a graphic of the labware (Figure 22-9).

Note:  If Known Volume or Nominal Volume was selected in Labware 
contains a, Show Labware Volumes activates.

Figure 22-9.  Labware Properties for 96-well microplate Labware Volumes shown

9. Select the desired wells on the graphic.

Note:  Hold down Ctrl to toggle wells between selected and deselected without 
affecting the selection status of other wells.

10. Enter the volume to assign to the currently selected wells in Amount.

11. Choose Set to assign the current Amount to the currently selected wells. The 
wells are given a color code that corresponds to the list of set volumes under 
Volume.

Note:  Clear sets the volume for all wells back to zero.

12. Repeat steps 10-12 until all desired wells have been assigned the desired volume.

13. Choose Hide Labware Volumes to collapse the graphic of the labware.

14. Choose OK to save Labware Properties and return to the Device Setup step 
configuration.
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22.6 Device Action Step
The Device Action step is used to configure the actions of active ALPs and devices.

FX — controls actions, such as operating the wash pump for the Wash ALP, 
stirring actions for the Stirring ALP, shaking actions for the Microplate 
Shaking ALP, and positioning actions for the Positive Position ALP.

3000 — controls devices, such as the autolatch, 6-port valve, vacuum, Wash 
System, and MicroMix.

NX — controls devices and active ALPs, such as the Source/Waste Sensor 
and Drainable/Refillable Reservoir ALP.

Note:  Any devices installed in Hardware Setup, except Tip Loaders and Device 
Controllers, are listed under Device in the Device Action Step Configuration.

Insert a Device Action step into the Method View (Figure 22-10).

Figure 22-10.  Device Action step and configuration

Device
Select the device 
to control here.

Command
Select the action for the 
device to execute here. 
Some commands require 
further configuration.
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22.6.1 Configuring the Device Action Step
When Device Action is added to a method, the associated configuration appears. 

The configuration options available for the Device Action step depend upon the 
device selected for configuration. 

The Device Action step is used to control the following ALPs and devices:

• Configuring the Device Action Step for 6-Port Valve (3000 only) (Section 
22.6.1.1).

• Configuring the Device Action Step for an Autolatch (3000 only) 
(Section 22.6.1.2).

• Configuring the Device Action Step for a Drainable/Refillable Reservoir 
ALP (FX, NX only) (Section 22.6.1.3).

• Configuring the Device Action Step for the MicroMix (3000 only) 
(Section 22.6.1.4).

• Configuring the Device Action Step for the Microplate Shaking ALP (FX, 
NX only) (Section 22.6.1.5).

• Configuring the Device Action Step for a Multichannel Tip Wash ALP 
(FX, NX-MC only) (Section 22.6.1.6).

• Configuring the Device Action Step for a Positive Position ALP (FX, NX 
only) (Section 22.6.1.7).

• Configuring the Device Action Step for a Source/Waste Sensor (FX and NX 
only) (Section 22.6.1.8)

• Configuring the Device Action Step for a Speed Pump (FX only) (Section 
22.6.1.9).

• Configuring the Device Action Step for the Stirring ALP (FX, NX only) 
(Section 22.6.1.10).

• Configuring the Device Action Step for the Vacuum (3000 only) 
(Section 22.6.1.11).

• Configuring the Device Action Step for the Wash System (3000 only) 
(Section 22.6.1.12).
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22.6.1.1 Configuring the Device Action Step for 6-Port 
Valve (3000 only)

To configure the Device Action step for the 6-port valve:

1. From Device, select the 6-port valve performing the required operation. 

Note:  Biomek Software refers to the 6-port valve as SixPortValve.

OR

2. Click on the 6-port valve in the Current Deck Display to select it. The 
configuration for the 6-port valve appears (Figure 22-11).

Figure 22-11.  Device Action step for the 6-port valve

Device Action Step Configuration
The Device Action Step Configuration 
specifies an operation performed by the 
6-port valve. 



Using the Devices Step Palette 22-19

Biomek Software User’s Manual

3. In Command, choose: 

• Select Wash Liquid — to enter the liquid number in Liquid Number.

• Device Setup — to select the liquid type for the six ports from the drop-
down menus. Figure 22-12 appears.

Figure 22-12.  Device Action step for the 6-port valve with Device Setup chosen
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22.6.1.2 Configuring the Device Action Step for an 
Autolatch (3000 only)

To configure the Device Action step for the Auto-Latching Tip Rack Holder or 
autolatch:

1. From Device, select the autolatch performing the required operation.

OR

Click on the autolatch in the Current Deck Display to select it. The configuration 
for the autolatch appears (Figure 22-13).

Note:  The deck position has a blue border in the Current Deck Display and is 
displayed to the right of Device. 

Figure 22-13.  Device Action step for the autolatch

2. In Command, indicate the desired state for the autolatch: Open or Close.

Device Action Step Configuration
The Device Action Step Configuration 
specifies an operation performed by the 
autolatch. 
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22.6.1.3 Configuring the Device Action Step for a 
Drainable/Refillable Reservoir ALP (FX, NX only)

To configure the Device Action step for the Drainable/Refillable Reservoir ALP:

1. From Device, select the Drainable/Refillable Reservoir ALP performing the 
operation.

Note:  Biomek Software refers to the ALP as DrainableRefillableReservoir.

OR

Click on the desired ALP in the Current Deck Display. The deck position is 
highlighted by a blue border and named to the right of Device. The configuration 
for the ALP appears (Figure 22-14).

Figure 22-14.  Device Action step for the Drainable/Refillable Reservoir ALP

2. In Command, choose the operation performed by the ALP:

• Fill — fills the reservoir to the maximum level.

• Drain — drains the reservoir.

• AssertSensor — has the sensor check for the presence of liquid in the 
reservoir. Sensor State appears in the configuration.

• AutoFill — keeps the reservoir supplied with liquid during the method 
run. AutoFill should be appears in the configuration.
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3. If AssertSensor is selected, in Sensor State, choose 

• On — allows the method run to proceed when sufficient liquid is 
detected in the reservoir. 

• Off — allows the method run to proceed when liquid is not detected in 
the reservoir.

4. If AutoFill is the selected Command, in AutoFill should be, choose:

• On — turns AutoFill on for the duration of the method run.

• Off — turns AutoFill off. Liquid remains in the reservoir.

Note:  To turn off AutoFill and drain the reservoir, insert a Device Action step 
configured to Drain the reservoir. Draining the reservoir is useful for reducing 
evaporation during a long pause in a method run. For example, insert a Device 
Action step configured to Drain the reservoir right before the pause. When the 
pause ends, insert a Device Action step configured to turn AutoFill On. The 
reservoir will be supplied with liquid during subsequent pipetting operations in 
the method run.

22.6.1.4 Configuring the Device Action Step for the 
MicroMix (3000 only)

To configure the Device Action step for the MicroMix:

1. From Device, select the MicroMix performing the required operation.

OR

Click on the MicroMix in the Current Deck Display to select it. The 
configuration for the MicroMix appears.

Note:  The deck position has a blue border in the Current Deck Display and is 
displayed to the right of Device. 

2. In Command, choose:

• Shake — to configure a shake operation (refer to Section 22.6.1.4.1, 
Configuring Shake).

• Custom Shake — to configure a custom shake operation (refer to Section 
22.6.1.4.2, Configuring Custom Shake).

• On — to turn on the MicroMix 

• Off — to turn off the MicroMix.
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22.6.1.4.1 Configuring Shake 
To configure a shake operation for the MicroMix:

1. In Command, choose Shake.

Figure 22-15.  Device Action step for the MicroMix with Shake chosen

2. In Amplitude, enter the magnitude of power.

Note:  The selection for Amplitude ranges from 1 to 9; the minimum amplitude 
is 1 and the maximum is 9.

3. In Duration, enter the time in minutes.

4. In Form, enter the form number.

Note:  Sixty Forms (preset shaking cycle patterns) are available. See the 
Appendix in the MicroMix 5 Shaker User’s Manual for a list of the available 
forms.
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22.6.1.4.2 Configuring Custom Shake
To configure a custom shake operation:

1. In Command, choose Custom Shake (Figure 22-16).

Figure 22-16.  Device Action step for the MicroMix with Custom Shake chosen

2. In Amplitude, enter the magnitude of power.

Note:  The selection for Amplitude ranges from 1 to 9; the minimum amplitude 
is 1 and the maximum is 9.

3. In Duration, enter the time in minutes.

4. In Mode, choose one of the following:

• Clockwise, constant direction, constant speed.

• Counter-clockwise, constant direction, constant speed.

• Ramp frequency up, ramp frequency down, gap, change direction.

• Ramp frequency up, gap, change direction, ramp frequency down, 
gap, change direction.
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5. In Start Frequency, enter the starting orbital speed.

Note:  The allowable range of Start Frequency is 10 to 30.

6. In End Frequency, enter the ending orbital speed.

Note:  The allowable range of End Frequency is 10 to 30.

7. In Ramp rate, enter the speed of change from the Start Frequency to the End 
Frequency.

Note:  The allowable range of Ramp rate is 1 to 250.

8. In Gap time, enter the non-shaking period prior to change of direction in 
seconds.

Note:  The allowable range of Gap time is 0 to 2.55.

22.6.1.5 Configuring the Device Action Step for the 
Microplate Shaking ALP (FX, NX only)

To configure the Device Action step for the Microplate Shaking ALP (Figure 22-17):

1. From Device, select the Microplate Shaking ALP performing the required 
operation.

Note:  The Biomek Software refers to the Microplate Shaking ALP as 
ShakerALP.

OR

Click on the Microplate Shaking ALP on the Current Deck Display to select it. 
The configuration for the Microplate Shaking ALP appears (Figure 22-17).

Note:  The deck position has a blue border in the Current Deck Display and is 
displayed to the right of Device. 
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Figure 22-17.  Device Action step for the Microplate Shaking ALP

2. In Command, indicate the operation performed by the device: Shake, Timed 
Shake, Off, Clamp, or Unclamp.

Note:  Shake and Timed Shake activate the Microplate Shaker ALP and 
require further configuration, as described below. Off deactivates the Microplate 
Shaker ALP and does not require further configuration. Clamp and Unclamp 
tighten and loosen the clamp on the Microplate Shaker ALP and do not require 
further configuration.

3. Select the Shaking speed, which is in the range of 1-100 indicating a 
percentage of the Microplate Shaking ALP’s maximum shaking speed.

4. In Time to reach full speed, select how long (in seconds) it should take to 
reach the full shaking speed.

Note:  The Microplate Shaking ALP stops shaking automatically when pipetting 
to or from the ALP and restarts when the pipetting operation is finished. The 
Microplate Shaking ALP stops shaking when a gripper operation is performed, 
but does not restart when the operation is completed. The Microplate Shaking 
ALP stops shaking when the Finish step is executed.

5. For a Timed Shake action only, select how long (in seconds) to shake the 
microplate in Time to shake.

Device Action Step Configuration
The Device Action Step Configuration 
specifies an operation performed by a 
Microplate Shaking ALP. 
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22.6.1.6 Configuring the Device Action Step for a 
Multichannel Tip Wash ALP (FX, NX-MC only)

To configure the Device Action step for the wash pump associated with a 
Multichannel Tip Wash ALP (Figure 22-18):

Note:  A Multichannel Tip Wash ALP may be a 96-Channel or 384-Channel Tip 
Wash ALP.

1. From Device, select the wash pump associated with the Multichannel Tip Wash 
ALP performing the required operation.

OR

Click on the Multichannel Tip Wash ALP in the Current Deck Display to select 
it. The configuration for the Multichannel Tip Wash ALP appears (Figure 22-18)

Note:  The deck position has a blue border in the Current Deck Display and is 
displayed to the right of Device. 

Figure 22-18.  Device Action step for a Multichannel Tip Wash ALP

2. In Command, indicate the desired state for the Multichannel Tip Wash ALP: 
On or Off.

Note:  The Multichannel Tip Wash ALP stops washing when the Finish step is 
executed.

Device Action Step 
Configuration

The Device Action Step 
Configuration configures On or Off 
for the wash pump associated with the 
Multichannel Tip Wash ALP. 
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22.6.1.7 Configuring the Device Action Step for a Positive 
Position ALP (FX, NX only)

To configure the Device Action step for the Positive Position ALP:

1. From Device, select the Positive Position ALP performing the required 
operation.

OR

Click on the Positive Position ALP in the Current Deck Display to select it. The 
configuration for the Positive Position ALP appears (Figure 22-19).

Note:  The deck position has a blue border in the Current Deck Display and is 
displayed to the right of Device. 

Figure 22-19.  Device Action Step for the Positive Position ALP

2. In Command, indicate the desired action for the Positive Position ALP:

• Clamp — tightens the clamp to hold the labware in place

• Unclamp — releases the clamp to allow the labware to be removed 
from the ALP

• VerifyLabware — verifies that labware is currently on the Positive 
Position ALP; an error displays and the method stops if no labware is 
found

• VerifyNoLabware — verifies that there is currently no labware on the 
Positive Position ALP; an error displays and the method stops if labware 
is found

Device Action Step Configuration
The Device Action Step Configuration 
specifies an operation performed by the 
Positive Position ALP. 
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22.6.1.8 Configuring the Device Action Step for a Source/
Waste Sensor (FX and NX only)

To configure the Device Action step for a Source/Waste Sensor:

1. From Device, select the SourceWasteSensor performing the operation. 
Configuration options for the sensor appear (Figure 22-20).

Figure 22-20.  Device Action for a Source/Waste Sensor

2. In Command, select the operation to perform:

• AssertSource — has the source container sensor check for the 
presence of liquid.

• AssertWaste — has the waste container sensor check for the presence 
of liquid.

3. In Sensor State, set the sensor action:

• On — allows the method run to continue if sufficient liquid is detected 
in the source container, or if the liquid level in the waste container is 
sufficiently low.

• Off — allows the method run to continue when insufficient liquid is 
detected in the source container, or if the waste container is filled to the 
maximum level allowed.
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22.6.1.9 Configuring the Device Action Step for a Speed 
Pump (FX only)

The Speed Pump is used in conjunction with the Span-8 Wash ALP. To configure the 
Device Action step for the Speed Pump:

1. From Device, select the Speed Pump performing the required operation.

OR

Click on the Span-8 Wash ALP in the Current Deck Display to select it. The 
configuration for the Speed Pump appears (Figure 22-21).

Note:  The deck position has a blue border in the Current Deck Display and is 
displayed to the right of Device. 

Figure 22-21.  Device Action step for the Speed Pump

2. In Command, indicate the desired state for the Wash Station ALP: On or Off.

Note:  The Speed Pump stops when the Finish step is executed.

Device Action Step Configuration
The Device Action Step Configuration 
specifies an operation performed by a 
Speed Pump. 
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22.6.1.10 Configuring the Device Action Step for the 
Stirring ALP (FX, NX only)

CAUTION: When setting the height for pipetting operations on the 
Stirring ALP, the presence of the stir bar must be taken into 
consideration. Pipetting operations that do not account for the height of 
the stir bar could damage the tips. 
To configure the Device Action step for the Stirring ALP (Figure 22-22):

1. From Device, select the Stirring ALP performing the required operation.

Note:  Biomek Software refers to the Stirring ALP as StirrerALP.

OR

Click on the Stirring ALP on the Current Deck Display to select it. The 
configuration for the Stirring ALP appears (Figure 22-22).

Note:  The deck position has a blue border in the Current Deck Display and is 
displayed to the right of Device. 

Figure 22-22.  Device Action step for the Stirring ALP

2. In Command, indicate the operation performed by the device: Stir or Off.

Note:  The Stir command requires further configuration, as described below. Off 
deactivates the Stirring ALP and does not require further configuration.

3. Select the Stirring speed, which is in the range of 1-100 indicating a 
percentage of the Stirring ALP’s maximum stirring speed.

Device Action Step Configuration
The Device Action Step Configuration 
specifies an operation performed by a 
Stirring ALP. 
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4. In Time to reach full speed, select how long (in seconds) it should take to 
reach the full stirring speed.

5. In Stop for Pipetting?, select whether or not to stop the stirring operation for 
pipetting. If Yes is selected, when performing pipetting operations to labware on 
the Stirring ALP it stops stirring while the tips access the labware and resumes 
stirring when finished.

Note:  The Stirring ALP stops stirring when the Finish step is executed.

22.6.1.11 Configuring the Device Action Step for the 
Vacuum (3000 only)

To configure the Device Action step for the vacuum:

1. From Device, select the vacuum performing the required operation.

OR

Click on the vacuum in the Current Deck Display to select it. The configuration 
for the vacuum appears (Figure 22-23).

Note:  The deck position has a blue border in the Current Deck Display and is 
displayed to the right of Device. 

Figure 22-23.  Device Action step for the vacuum

Device Action Step Configuration
The Device Action Step Configuration 
specifies an operation performed by the 
vacuum. 
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2. In Command, choose: 

• Close — to close the vacuum.

• Open — to open the vacuum.

• Timed Vacuum — to select the vacuum time in seconds. Figure 22-24 
appears.

Figure 22-24.  Device Action for the vacuum with Timed Vacuum chosen
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22.6.1.12 Configuring the Device Action Step for the Wash 
System (3000 only)

To configure the Device Action step for the Wash System:

1. From Device, select the Wash System performing the required operation.

OR

Click on the Wash System in the Current Deck Display to select it. The 
configuration for the Wash System appears (Figure 22-25).

Note:  The deck position has a blue border in the Current Deck Display and is 
displayed to the right of Device. 

Figure 22-25.  Device Action for the Wash System

Device Action Step Configuration
The Device Action Step Configuration 
specifies an operation performed by the 
Wash System. 
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2. In Command, choose: 

• InitializeWash — to initialize the wash.

• Latch — to open or close the latch on the wash by choosing Open or Close 
from Direction (Figure 22-26).

• Aspirate — to aspirate the wash liquid by entering Speed and Volume 
(Figure 22-27).

• Dispense — to dispense the wash liquid by entering Speed and Volume 
(Figure 22-27).

Figure 22-26.  Device Action for the Wash System with Latch chosen
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Figure 22-27.  Device Action for the Wash System with Aspirate chosen
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22.7 Tip Loader Step (FX, NX-MC only)
The Tip Loader step provides more control over a Tip Loader ALP than other steps 
using the Tip Loader ALP, such as New Tips and Unload Tips (Figure 22-28). 

FX — the Tip Loader is used only for loading and unloading tips to a 
Multichannel Pod.

The Tip Loader step is used when precise control over tip loading and unloading is 
required, such as when performing multiple aspirate and dispense operations with 
each operation requiring a specific set of tips.

Note:  A usable tip box must be present on the Tip Loader ALP before using the Tip 
Loader step. The Tip Loader step does not automatically locate a tip box prior to 
performing an operation. 

Insert a Tip Loader step into the Method View (Figure 22-28).

Figure 22-28.  Tip Loader step and configuration

Tip Loader Step Configuration
The Tip Loader Step Configuration 
indicates the operation performed by 
the Tip Loader, the deck location of the 
Tip Loader used, and the pod used with 
the Tip Loader.
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22.7.1 Configuring the Tip Loader Step
When the Tip Loader step is added to a method, the associated configuration appears 
(Figure 22-28). 

To configure Tip Loader:

1. In Tips, specify whether to Load or Unload tips.

Note:  If the Tips field indicates that a load is performed, the Tip Loader caption 
in Method View indicates the operation with “Load 96 Tips from …”; however, 
if Unload is requested, the caption reads, “Unload 96 Tips from …”.

2. Specify the Location of the Tip Loader on the deck.

3. Specify the Pod performing the tip load operation from the drop-down list.

OR

Select the Pod from the Current Deck Display. The tip diagram on the left of the 
Current Deck Display represents Pod1, while the tip on the right represents 
Pod2. Selecting a pod from the Current Deck Display automatically updates 
Pod in the Step Configuration.

FX — The pod can be selected from the Current Deck Display only if the 
instrument has two Multichannel Pods; Span-8 Pod cannot be used with this 
step. 

Note: In Pod, Pod1 is the default for a single-pod system. In a dual-pod 
system, the pod configured as the default pod is initially displayed in Pod.
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22.8 SILAS Module Step
Any external device requiring a SILAS module for operation during a method is 
configured using a SILAS step. SILAS steps operate devices on a Biomek deck 
during a method run by communicating between Biomek Software and the SILAS 
modules.

22.8.1 Configuring the SILAS Module
Note:  Before inserting a SILAS step into a method, it must be placed on a step 
palette. Refer to Chapter 29, Changing Window Appearance, for more information.

When configuring a SILAS Module, any required labware movement must be known 
and the appropriate selection must be made. All SILAS modules for external devices 
are configured using the same procedure, but some devices may have additional fields 
to configure.

To configure a SILAS Module Step:

1. Insert a SILAS Module Step into the method in the Method View (Figure 22-29).

Note:  The SILAS Module Step is labeled according to the device it represents; 
for example, the SILAS Module Step for the barcode reader is labeled as a 
Barcode Reader step.

Figure 22-29.  A Barcode Reader SILAS Module Step inserted in a method

2. Select Configure Action. Configure the operation of the device as desired.

Labware
Labware options indicate whether 
labware is received from the device, 
sent to the device, or when no change 
has been made with respect to labware 
for the device.
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3. Select Update after completing the action configuration.

4. Select the appropriate Labware movement.

Labware options include:

• Retrieving From Module — retrieves labware from the device

• Sending To Module — sends labware from the deck to the device

• No Change — labware remains in the current position after operations 
are completed

5. Select Crosses Light Curtain if the action taken by the device causes 
something to cross the light curtain. If selected, the instrument disables the light 
curtain while this command is executing. 

3000 — This instrument does not have a light curtain.

Note:  Refer to Section 22.4.1, Configuring Devices Using the Device Editor, to 
configure the Crosses Light Curtain option.

6. Select Wait for Runtime Data, if required. Wait for Runtime Data allows 
Biomek Software to use data resulting from an action to make decisions on 
operations. Refer to Section 22.8.2, Configuring Runtime Data, for more 
information.

Note:  When Wait for Runtime Data is checked, the Biomek instrument will 
not validate beyond this step until it is completed.
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22.8.2 Configuring Runtime Data
Runtime Data allows Biomek Software to read specific data about labware and to 
perform operations that meet specific criteria during a method. For example, the 
results of a bar code read can determine the specific operations performed on the 
labware using an If step.

Note:  Information entered in Runtime Data Defaults during method validation is 
used because real data has not yet been obtained by Biomek Software. 

To configure and use Runtime Data:

1. Select Simulated Data. Runtime Data Defaults appears (Figure 22-30).

Figure 22-30.  Runtime Data Defaults

2. Choose Set Labware Barcode to provide data for future decisions.

3. Choose one of the following:

• Random Number — sets the Barcode property to a random number

• Specific String — sets the Barcode property to the string indicated

4. In the Property field, enter the name of the property to set.

5. Enter the Default Value for the property when the property is not present for the 
labware.

6. Choose OK when configuration is complete.
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22.8.3 Creating Data Sets from SILAS Messages
Data sets can be created from messages sent by a SILAS step for a device. For 
example, the results of a measurement from a microplate reader can be stored in a 
data set created from the SILAS step.

To create a data set from a SILAS message using a SILAS step:

1. Insert the desired SILAS step into the Method View.

Figure 22-31.  SILAS step with data sets chosen

2. Select Configure Action and configure the action of the device as desired.

3. Select Wait for Runtime Data, if required. Wait for Runtime Data allows 
Biomek Software to use data resulting from an action to make decisions on 
operations (refer to Section 22.8.2, Configuring Runtime Data). 

Note:  When Wait for Runtime Data is checked, the Biomek instrument will 
not validate beyond this step until the step is completed.

4. Select Generate Data Set From Runtime Data to create a data set from the 
results of the configured action.

5. In Data Set Name, enter a name for the data set.

Note:  If the configured action produces more than one result per well, such as a 
multiple wavelength or kinetic read, a data set is created for each result and the 
Data Set Name is appended with an incremental number; for example, 
DataSet1, DataSet2, DataSet3, and so forth.

Use to create data sets 
from SILAS messages.
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6. Select The data in the new Data Set should be tracked during 
pipetting to allow the system to track the data during pipetting operations.

7. Choose Simulated Data. Runtime Data Defaults appears (Figure 22-32).

Note:  Information entered in Runtime Data Defaults during method 
validation is used because real data has not yet been obtained by Biomek 
Software (refer to Section 22.8.2, Configuring Runtime Data).

Figure 22-32.  Runtime Data Defaults

8. In Property, enter the Data Set Name.

9. In Default Value, enter a default value to use for the data set during method 
validation. This value is used for all wells on the plate.

Note:  At run time, the actual values of the data set will be used. The Default 
Value is only used for method validation.
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23 Using the Stacker Carousel 
Step Palette

23.1 Overview
Steps on the Stacker Carousel Step Palette allow labware to be moved to and from the 
Stacker Carousel and the Biomek deck. The Stacker Carousel and steps expand 
labware capacity and increase walk-away automation during a method. 

Note:  Refer to the hardware manual for the specific instrument for detailed 
information on integrating and framing a Stacker Carousel on a Biomek Laboratory 
Automation Workstation. 

The steps available in the Stacker Carousel Step Palette are:

• Present — configures from which hotel labware is presented to the deck 
and bar code reading options.

• Stacker Setup — configures the placement and properties of labware in the 
hotels on the Stacker Carousel. 

• Store — configures to which hotel labware is stored from the deck.
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23.2 Displaying the Stacker Carousel Step Palette
In order to use the Stacker Carousel steps in a method, display the Stacker Carousel 
Step Palette (Figure 23-1).

Figure 23-1.  Biomek main editor with Stacker Carousel Step Palette displayed

To display the Stacker Carousel Step Palette, complete the following:

• Right-click any empty palette space and the step palette menu appears. 
Select StackerCarousel.

OR

• From the toolbar, select Options>Toolbars>StackerCarousel.
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23.3 Using the Stacker Setup Step
Use the Stacker Setup step to:

• configure the placement of labware in the hotels on the Stacker Carousel.

• configure the properties of the labware in the hotels.

23.3.1 Configuring the Placement of Labware in 
the Hotels

To configure the placement of labware in the hotels, labware is dragged from the 
Labware Category and dropped onto the slots of the hotels. As labware is dragged to 
the slot, the options Drop One, Fill Slot, and Fill Stack appear to allow the hotel to 
be quickly configured with labware.

The slots in hotels visually indicate the pieces of labware contained in each slot. A 
piece of labware that cannot be placed in a particular slot due to the configuration 
rules cannot be dropped into the slot (refer to Section 23.3.1.1, Following the Rules to 
Configure the Placement of Labware in Hotels).

23.3.1.1 Following the Rules to Configure the Placement 
of Labware in Hotels

These rules must be followed to configure the placement of labware in the hotels:

• Labware cannot be placed in a None hotel.

• Labware that cannot be stacked cannot be substacked. For example, in 
normal operation a tipbox cannot be stacked on a BCFlat96 plate, so in the 
Stacker Setup step, a tipbox cannot be substacked on a BCFlat96 plate in a 
hotel.

Note: Substacking refers to stacking labware in the same slot of the hotel.

• Labware that is taller than the hotel’s slot height cannot be placed in the 
hotel.

• A substack of labware that is taller than the hotel’s slot height cannot be 
placed in hotel.

• A substack of labware cannot be placed in an HD (high-density) hotel.
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To configure the placement of labware in the hotels on the Stacker Carousel:

1. Drag and drop a Stacker Setup step into the Method View (Figure 23-2).

Figure 23-2.  Stacker Setup step configuration

2. Choose the appropriate Stacker Carousel in Device.

Note:  Multiple Stacker Carousels may be installed on a Biomek instrument.

Note:  The Stacker Carousel must be installed and configured in Hardware 
Setup to appear in Device. Refer to the hardware manual for the specific 
instrument for detailed information on integrating and framing a Stacker 
Carousel on a Biomek instrument. 

Stacker Carousel 
Step Palette
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3. Drag and drop labware into the slots of the desired hotels.

Note:  As labware is dropped into a slot, a dialog with options Drop One, Fill 
Slot, and Fill Stack appears (Figure 23-3). Choose one.

 
Figure 23-3.  Dialog to drop labware into hotels

OR

Check Configuration from File to use a stacker configuration from a .csv file. 
File and Browse appear to allow the desired file to be chosen.

Note:  Comma-Separated Value Files (.csv)  (Table 23-1) are files that include 
data from a table that can be imported into another application. In this case, the 
.csv file used with the Stacker Setup step must contain Hotel, Slot, and 
LabwareType, and it may contain Name, LiquidType, UnloadTipsInto, 
BoxFinalLocation, Volume, BarCode, and SlotOrder.

Table 23-1.  Example of a Comma-Separated Value File
Hotel Slot Slot

Order
Labware

Type
Name Volume Liquid

Type
Bar 

Code
Unload
TipsInto

BoxFinal
Location

A 3 1 AP96200µL na <Tipbox> <Home>
A 1 1 BCFlat96 Dest1 Water
A 2 1 BCFlat96 Dest2 120 Water
A 4 1 BCFlat96 Dest3 130 Water
B 1 1 BCFlat96 110 Water
B 2 1 BCFlat96 120 Water
B 3 1 BCFlat96 130 Water
B 4 1 BCFlat96 140 Water
B 5 1 BCFlat96 150 Water
B 6 1 BCFlat96 160 Water
C 1 1 BCFlat96 Water
D 1 1 BCFlat96 Water
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23.3.2 Configuring the Properties of the Labware 
in the Hotels

Each piece of labware in a hotel that will eventually be brought onto the instrument 
deck is configured using Labware Properties. The information provided in 
Labware Properties is used when a technique is selected, and when tips are loaded 
and unloaded.

To access Labware Properties: 

1. Double-click on a piece of labware in the Stacker Setup.

OR

Right-click on a piece of labware in the Stacker Setup to open the menu to 
Labware Properties (Figure 23-4).

Figure 23-4.  Menu accessing Labware Properties

Note:  Right-clicking a piece of labware also provides the options of Copy, Paste, 
and Delete to populate the hotels with labware. Choosing Copy after labware has 
been configured in Labware Properties allows configured labware to be copied. 
Then choosing Paste allows a copied version of the configured labware to be pasted 
into another space on a hotel. Choosing Delete will delete the labware from the hotel.

Note:  Right-clicking a tip box also provides the option of Remove Tips to 
configure an empty tip box.

The configuration options in Labware Properties provide the following 
information, if it applies to the type of labware selected:

• Name assigned to a piece of labware, if desired

• Labware type

• Maximum volume per well

• Bar code 

• Volume for each well, if known

• Liquid type

• Where to dispose of tips

• Where to dispose of tip boxes

• Maximum number of times tips can be loaded

• Available tips

Note:  Variables and expressions may be entered in any field that can be configured. 
Refer to Chapter 13, Using Variables and Expressions in a Method, for more 
information on using variables and expressions.
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23.3.2.1 Configuring Tip Properties
When the labware selected for configuration is a tip box, Labware Properties 
provides the ability to configure the following information

1. Double-click the tip box to configure in the Stacker Setup Display

OR

Right-click the tip box to configure in the Stacker Setup Display and select 
Properties from the menu. Labware Properties for tips appears (Figure 23-5):

Figure 23-5.  Labware Properties for a tip box

2. In Name, enter the name that is assigned or will be assigned to the tip box in the 
Stacker Setup step, if applicable.

OR

Leave Name blank. When Name is blank, tips are accessed by the information 
displayed in the Labware Type field.

Note:  Naming tip boxes forces the instrument to look for a specific box of tips, 
rather than any tip box containing the specified tip type located anywhere on the 
deck.

Note:  Multiple tip boxes can be given the same name. This is used to create a 
pool of tip boxes for a specific use.

3. In Labware Type, verify the tip type.

4. In Bar Code, enter the bar code.

Note:  Use the bar code field to identify a specific tip box in certain methods, 
such as plate replication. This field may be left blank. 

5. In When empty, send to, select a final destination for the tip box at the end of 
the method.

6. In Unload Tips Into, select the location reserved for tip disposal.

7. In Load no more than, enter the number of times tips can be loaded onto the 
pod during the method.
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8. Choose Show Available Tips to display a graphic of the tip box 
(Figure 23-6).

Figure 23-6.  Labware Properties for tips with Show Available Tips activated

9. On the graphic of the tip box, select the usable tips. By default, all tips are 
selected. 

Note:  This can be used to indicate missing tips or tips that are otherwise not to 
be used in the method.

10. Choose Hide Available Tips to collapse the graphic of the tip box.

11. Choose OK to save Labware Properties.
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23.3.2.2 Configuring Labware Properties
When the labware selected for configuration is a microplate or small tube rack, 
Labware Properties provides the ability to configure the following information: 

1. Double-click the piece of labware to configure in the Stacker Setup Display

OR

Right-click the piece of labware to configure in the Stacker Setup Display and 
select Properties from the menu. Labware Properties for microplates, 
reservoirs, and tube racks appears (Figure 23-7).

Figure 23-7.  Labware Properties for microplates, reservoirs, and tube racks

2. Verify the Labware Type.

3. In Name, enter a name for the labware. 

Note:  When a deck is populated by numerous pieces of labware, naming 
labware is recommended. Names should be descriptive of the contents of the 
labware or the work being accomplished during the method. Naming labware in a 
meaningful fashion may reduce confusion.

4. In Bar Code, enter the bar code.

Note:  Use the bar code field to identify a specific plate in certain methods, such 
as plate replication. This field may be left blank. 
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5. Make a selection in Labware contains. Options are Unknown, Nominal, and 
Known. This information is used by many of the techniques supplied with 
Biomek Software which aspirate or dispense liquid a certain offset from the 
liquid level. Some pods or tools can detect the liquid level using liquid-level 
sensing technology.

• If Known is selected, the liquid level is not detected during method run 
and the entered value is used during validation and method run. Known 
Volume should be supplied whenever possible. 

• If Unknown is selected, the liquid level is detected during method run if 
required by the technique, and the wells are assumed to be full when 
validating the method.

• If Nominal is selected, the liquid level is detected during method run, 
but the volume in the wells is assumed to be the entered value when 
validating the method. 

6. Enter the Volume, if Nominal or Known volume is selected.

Note:  A value entered in Volume is assigned to all wells.

7. Select the Liquid Type contained in the labware. The liquid type is useful 
information when Biomek Software auto-selects a pipetting technique for any 
aspirate and dispense operations acted upon this piece of labware. The pipetting 
technique auto-selected to aspirate and dispense the liquid is selected based on 
the physical factors of the liquid, as well as the physical attributes of the labware. 
For more information on liquid types, refer to Chapter 8, Understanding and 
Creating Liquid Types.

8. Select Sense the liquid level the first time a well with Unknown or 
Nominal volume is accessed “from the Liquid” to use liquid level 
sensing to determine the liquid level only the first time it accesses a well with an 
Unknown or Nominal volume from the liquid. Any instances the same well on 
the piece of labware is accessed, the liquid level is calculated internally based on 
the result of the earlier liquid level sense and the amount aspirated or dispensed 
to the well in previous steps.

OR

Select Sense the liquid level every time a well is accessed “from the 
Liquid” to use liquid level sensing to determine the liquid level every time it 
accesses a well with an Unknown or Nominal volume from the liquid.

Note:  Liquid level sensing options only apply if the pod or tool accessing the 
labware is capable of sensing the liquid level. If not, the option selected is 
ignored.
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9. If the labware does not contain uniform volumes, choose Show Labware 
Volumes to display a graphic of the labware (Figure 23-8).

Figure 23-8.  Labware Properties for microplates, reservoirs, or tube racks
with Show Labware Volumes activated

Note:  Show Labware Volumes may appear different depending on the number of 
wells on the selected labware. The graphic shown is for a 96-well microplate.

10. Select the desired wells on the graphic.

Note:  Hold down Ctrl to toggle wells between selected and deselected without 
affecting the selection status of other wells.

Note:  Clicking on a column or row heading selects all wells in that column or 
row.

11. Enter the volume to assign to the currently selected wells in Amount.

12. Choose Set to assign the current Amount to the currently selected wells. The 
wells are given a color code that corresponds to the list of set volumes under 
Volume.

13. Repeat steps 10-12 until all desired wells have been assigned the desired volume.

Note:  Clear sets the volume for all wells back to zero.

14. Choose Hide Labware Volumes to collapse the graphic of the labware.

15. Choose OK to save Labware Properties and return to the Stacker Setup step 
configuration.
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23.4 Using the Present Step
Use the Present step for:

• Configuring from which Hotel Labware is Presented (Section 23.4.1).

• Configuring Bar Code Reading Options (Section 23.4.2).

23.4.1 Configuring from which Hotel Labware is 
Presented

To configure a Present step in a method:

1. Drag and drop a Present step into the Method View.

2. Choose a hotel and the desired stacker carousel from Present labware from 
hotel. . .of . . . . The chosen hotel is highlighted (Figure 23-9).

Figure 23-9.  Present Step configuration

Note:  Multiple Stacker Carousels may be installed on a Biomek instrument.

3. Choose Do not read bar code, Read bar code for logging, or Read bar 
code for decision making (refer to Section 23.4.2, Configuring Bar Code 
Reading Options).

Note:  The step in the Method View is more descriptive once the step is configured 
and Finish selected; for example “Present from hotel B of Stacker 1.”
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23.4.2 Configuring Bar Code Reading Options
The bar code reading options available in the Present step are defined as follows:

• Do not read bar code — the bar code is not read when the Stacker 
Carousel presents the plate.

• Read bar code for logging — the bar code is captured in the pipetting logs 
(refer to Sections 26.2.3, Pipetting Log, 26.2.4, Span8Pipetting Log (FX, 
NX-S8 only), and 26.3.6, UnifiedPipetting Log Contents).

• Read bar code for decision making — the results of the bar code read 
determine the next operation of the method. The software waits for the 
results of the bar code before continuing method execution.

Note: Because the Read bar code for decision making option creates a 
dependent operation (similar to the If Step and Then and Else), it impacts 
the validation process during method building. The method validation stops 
at this point as it waits for the results of the bar code read before it continues; 
however, since there is no actual bar code read during validation the 
software does not know what operation to validate next. To make sure the 
validation process finishes satisfactorily, in Read bar code for decision 
making using. . . for method validation, type in a value to use as the bar 
code during method validation. 

For example, to check for an exact bar code, use the If step with the 
condition 
=(Labware(“SC1”).Properties.Barcode=“SRC”) 
or to check for plates whose bar code begin with SRC, use the If Step with 
the condition 
=(Left(Labware(“SC1”).Properties.Barcode,3)=
“SRC”).
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23.5 Using the Store Step
Use the Store step to configure to which hotel on the Stacker Carousel labware is 
stored from the deck.

To configure a Store step in a method:

1. Drag and drop a Store step into the Method View.

2. Choose a hotel and the desired stacker carousel from Store labware in hotel. . 
.of . . . . The chosen hotel is highlighted (Figure 23-10).

Figure 23-10.  Store Step configuration

Note:  The step in the Method View is more descriptive once the step is configured 
and Finish selected; for example “Store to hotel B of Stacker 1.”
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24 Using the Data Sets Step 
Palette

24.1 Overview
Steps on the Data Sets Step Palette allow data sets to be created, managed, used, and 
reported in Biomek methods. Data sets allow sample tracking which means the 
contents of the plate or tube are known at any time in the method and decisions may 
be made during transfer or pipetting operations based on the contents of the plate or 
tube.

Note:  Refer to Chapter 14, Using Sample Tracking and Data Sets in a Method, for 
more information on using sample tracking and data sets in a method.

The steps available on the Data Sets are:

• Create Data Set — specifies data in a data set.

• Data Set Management — renames, removes, copies, or modifies the 
properties of a data set.

• Data Set Processing — applies a transformation expression to an existing 
data set to create a new data set.

• Reporting — generates a report on data sets at any point during a method.
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24.2 Displaying the Data Sets Step Palette
In order to add data set steps to a method, display the Data Sets Step Palette (Figure 
24-1).

Figure 24-1.  Biomek Software main editor with Advanced Step Palette displayed

To display the Data Sets Step Palette:

• Right-click any empty palette space, and select DataSets from the menu.

OR

• From the toolbar, select Options>Toolbars>DataSets.

Method View
The method is 
built step by step 
in this area. Step Configuration

When a step is highlighted in the Method View, 
set the corresponding configuration in this area.

Data Sets Step Palette
Displays the steps available for insertion into a method. 
Additional step palettes are available.
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24.3 Configuring the Create Data Set Step
The Create Data Set step is used to create data sets from a text file or a database 
table. The specified file or database table is read and compared to either the plate bar 
code and well number of the plate or a data set specifying the sample ID. Data sets are 
created from the specified columns of the file or database table using the rows that 
matched the plate bar code and well number or data set specifying the sample ID.

Note:  The text file must reside on the local computer.

Note:  SQL Server 2000 SP3 is the version requirement to import the datatbase table.

Insert a Create Data Set step into the Method View (Figure 24-2).

Figure 24-2.  Create Data Set step configuration

The Create Data Set step consists of three collapsible configuration areas. Each area 
can be collapsed or expanded independently from each other to display the 
configuration options for that section (Figure 24-2). To collapse or expand any of the 
configuration areas, click on the sentence summary.

Configuring the Create Data Set step includes configuring:

• the file or database to read (refer to Section 24.3.1, Configuring File 
Options).

• the columns of the file or database table to compare (refer to Section 24.3.2, 
Configuring Input Options).

• the columns of the file or database table used to create data sets (refer to 
Section 24.3.3, Configuring Output Options).

Output Options

File Options

Input Options
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24.3.1 Configuring File Options
File Options is used to select a comma- or tab-delimited text file (refer to Section 
24.3.1.1, Reading from a Text File) or a database table (refer to Section 24.3.1.2, 
Reading From a Database Table) to use to create data sets for a piece of labware.

24.3.1.1 Reading from a Text File
To configure File Options to read from a file:

1. If not expanded, select the sentence summary to display File Options (Figure 24-
3).

Note:  By default, File Options is expanded when a Create Data Set step is 
inserted.

Figure 24-3.  Create Data Set step — File Options displayed

2. Under File Options, select Read from a file.

3. In Read the file, enter the full directory path and file name of the text file to read 
and press Enter. The first four rows of the selected data file are displayed in File 
Preview.

Note:  Browse to select the file using standard Windows techniques.

Note:  The text file must reside on the local computer.

4. In Begin reading at row, select the first row of the data file that should be read. 
File Preview updates.

File Preview
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5. Select The file has a header row if a header row is included in the data file. 
The first row that is read is used for column headings in File Preview (Figure 
24-3). For example, if Begin reading at row is set to 5 and The file has a 
header row is selected, the contents of row 5 are used as the column headings.

Note:  If The file has a header row is not selected, column headings are given 
a generic label Column#.

6. Select the appropriate file type option: Comma-Delimited or Tab-Delimited. 
File Preview updates accordingly.

24.3.1.2 Reading From a Database Table
File Options can be configured to read data from a database table stored in the SQL 
Server database. 

Note:  SQL Server is a Microsoft product that allows queries and provides analysis, 
and is required to run Biomek Software. The installation of this product is the 
responsibility of the user and is not supported by Beckman Coulter Service 
Engineers. SQL Server 2000 SP3 is the version requirement. 

To configure File Options to read from a database:

1. If necessary, select the sentence summary to display File Options (Figure 24-4).

Note:  File Options is expanded when a Create Data Set step is inserted.

Figure 24-4.  Create Data Set step — File Options displayed
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2. Under File Options, select Read from a Database. File Options changes to 
display the database options (Figure 24-5).

Figure 24-5.  Reading from a database

Table Preview
Displays the first 
four rows of the 
database table.
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3. Browse to find the location of the desired database on that server. SQL Server 
Connection (Figure 24-6) appears on top of the Create Data Set step 
configuration.

Note:  SQL Server is a Microsoft product that allows queries and provides 
analysis. The installation of this product is the responsibility of the user and is not 
supported by Beckman Coulter Service Engineers. SQL Server 2000 SP3 is the 
version requirement.

.
Figure 24-6.  SQL Server Connection

4. Select the desired server from the list of servers on the left.

5. Enter the User name and Password to log in to the selected server.

OR

Select Use NT Authentication.

Note:  The administrator of the SQL Server Connection sets the logging 
protocol for user and password or NT authentication.
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6. Choose Connect. A list of the available databases appears in Databases 
(Figure 24-7).

Figure 24-7.  Connected to SQL Server

7. In Databases, select the desired database found on the server to use to create 
data sets.

OR

Repeat steps 3-6 to connect to a different server, if desired.

8. Choose OK to accept the server and close SQL Server Connection.

9. In Read from the table (Figure 24-5), select the database table to read. The first 
four rows of the selected database table are displayed in Table Preview (Figure 
24-5).
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24.3.2 Configuring Input Options
Input Options (Figure 24-9) is used to configure the columns of the file or database 
table to compare to the plate bar code and well number or data set specifying the 
sample ID of the specified plate. Rows that match the plate bar code and well number 
or data set specifying the sample ID are used to create the data set(s).

By default, Input Options is collapsed when a Create Data Set is inserted into a 
method (Figure 24-8). 

Figure 24-8.  Create Data Set step — expanding Input Options 

Collapsed Input 
Options

Click on the sentence 
summary to expand 
Input Options.
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Click on the sentence summary to expand Input Options (Figure 24-9).

Figure 24-9.  Create Data Set step — Input Options displayed
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24.3.2.1 Matching Plate Bar Code and Well Number
The specified file or database table is compared to the plate bar code and well number 
to determine which rows of the file or database table to use to create the data set. Only 
the rows of the file or database table that match the plate bar code are used. The 
column for well number is used to assign the correct value of the data set to each well.

To configure Input Options to match the plate bar code and well number:

1. In For the labware at, select the deck position of the labware to compare the 
plate bar code and well number or data set specifying the sample ID to the file or 
database table (Figure 24-9).

OR

Click on the desired labware in the Current Deck Display.

2. If the labware is in a stack, enter the stack depth.

Note:  Depth refers to a specific piece of labware in a stack. To use the top piece 
of labware, enter 0; to use the second from the top piece of labware, enter 1; to 
use the third from the top piece of labware, enter 2; and so on. Refer to Section 
7.3.6.4.1, Biomek Stacking Rules, for information on using stacks.

3. Select Match the Plate Barcode and Well Number to compare the plate bar 
code and well number of the selected plate to the file or database table (Figure 
24-9).

4. In For the labware’s barcode, use the field, select the column of the file or 
database table to compare to the plate bar code. 

Note:  For the labware’s barcode, use the field is optional. If no field is 
specified, all rows of the file or database table are assumed to apply to that plate. 
If a well number is repeated, the last row of the file or database table to use that 
well number is used. 

5. In and for the well number, use the field, select the column of the file or 
database table to compare to the well number.
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24.3.2.2 Matching Sample IDs
The specified file or database table is compared to a data set that specified the sample 
IDs for the selected plate to determine which rows of the file or database table to use 
to create the data set. Only the rows of the file or database table that match one of the 
sample IDs on the plate are used to create data sets. 
To configure Input Options to match the plate bar code and well number:
1. In For the labware at, select the deck position of the labware to compare the 

plate bar code and well number or data set specifying the sample ID to the file or 
database table (Figure 24-10).

OR

Click on the desired labware in the Current Deck Display.

Figure 24-10.  Create Data Set step — Input Options displayed

2. If the labware is in a stack, enter the stack depth.

Note:  Depth refers to a specific piece of labware in a stack. To use the top piece 
of labware, enter 0; to use the second from the top piece of labware, enter 1; to 
use the third from the top piece of labware, enter 2; and so on. Refer to Section 
7.3.6.4.1, Biomek Stacking Rules, for information on using stacks.

3. Select Match the Sample ID to compare a data set specifying the sample IDs 
for the selected plate to the file or database table (Figure 24-10).

4. In For the Sample ID, use the field, select the column of the file or database 
table to compare to the data set specifying sample IDs for the plate.

5. In to match with the Data Set, select the data set that specifies the sample IDs 
for the plate.
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24.3.3 Configuring Output Options
Output Options is used to configure the plate for which data sets are created and to 
specify the columns of the file or database table to use to create data sets.

By default, Output Options is collapsed when a Create Data Set is inserted into the 
Method View.

Figure 24-11.  Create Data Set step — expanding Output Options

Collapsed Output 
Options

Click on the sentence 
summary to expand 
Output Options.
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To configure Output Options:

1. Click on the sentence summary to expand the Output Options configuration 
(Figure 24-12).

Figure 24-12.  Create Data Set step — Output Options

2. In For the labware at, select the deck position of the labware for which data sets 
are created.

OR

Click on the desired labware in the Current Deck Display.

3. If the labware is in a stack, enter the stack depth.

Note:  Depth refers to a specific piece of labware in a stack. To use the top piece 
of labware, enter 0; to use the second from the top piece of labware, enter 1; to 
use the third from the top piece of labware, enter 2; and so on. Refer to Section 
7.3.6.4.1, Biomek Stacking Rules, for information on using stacks.

4. Under Available Fields, select the desired columns from the file or database 
table from which to create data sets. The selected fields appear highlighted.
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5. Select ---> to move the selected fields to Data Sets to be Created.

Note:  To add all columns from Available Fields to Data Sets to be Created, 
select Add All.

6. To remove an option from Data Sets to be Created, select the desired data set 
to remove and select <---. The selected field(s) are moved back to Available 
Fields.

Note:  To remove all columns from Data Sets to be Created, select Remove 
All.

24.3.3.1 Setting Data Set Properties
Properties for each data set can be modified in Output Options by right-clicking on 
the data set name under Data Sets To Be Created. Properties that can be modified 
are:

• data set name

• including the data set in reports

• tracking the data set during pipetting

To modify properties of a data set:

1. In Data Sets To Be Created, right-click the desired data set. The data set 
properties menu appears.

Figure 24-13.  Changing data set properties

2. Select the desired option from the menu:

• Select Set Destination Name and enter a new name for the data set to 
rename the data set.

• Select Include in Reports to allow the data set to be included in the 
reports chosen in the Reporting (refer to Section 24.6, Configuring the 
Reporting Step) or Finish steps (refer to Section 12.2.2, Configuring the 
Finish Step). 

• Select Track Data While Pipetting to allow the system to track the 
data during pipetting operations.

Note: When Track Data While Pipetting is selected, the data set is 
copied to the destination labware during pipetting.

3. Repeat steps 1 and 2 to select additional options, if desired.
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24.4 Configuring the Data Set Management Step
The Data Set Management step is used to manage data sets that have been created 
automatically or created using the Instrument Setup step, the Create Data Set step, 
the SILAS step, or Visual Basic scripting. 

Note:  Data sets are not created or processed in the Data Set Management step.

Managing data sets includes using the Data Set Management step for:

• Copying a Data Set (Section 24.4.1). 

• Renaming a Data Set (Section 24.4.2).

• Removing a Data Set (Section 24.4.3).

• Changing the Properties of a Data Set (Section 24.4.4).

24.4.1 Copying a Data Set
To copy a data set:

1. Insert a Data Set Management step into the Method View. The Data Set 
Management step configuration appears (Figure 24-14).

Figure 24-14.  Choosing Copy in Data Set Management step
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2. From For the labware at, choose the labware where the data set is copied.

3. If in a stack, enter the depth of the labware.

Note:  Depth refers to a specific piece of labware in a stack. To use the top piece 
of labware, enter 0; to use the second from the top piece of labware, enter 1; to 
use the third from the top piece of labware, enter 2; and so on. Refer to Section 
7.3.6.4.1, Biomek Stacking Rules, for information on using stacks.

4. From the drop-down menu, choose Copy.

5. From the Data Set named, choose the data set to copy.

Note:  Each data set must have a unique name. The method displays an error 
during validation if two data sets have the same name.

6. At to, enter the name of the copied data set. A copy of the data set is created with 
the entered name.

24.4.2 Renaming a Data Set
Rename renames a data set. Renaming data sets is an important function for sample 
tracking because only one data set named Sample ID can exist on a single piece of 
labware. When another data set is created from the Instrument Setup step using 
sample IDs, it overwrites the previous data set.

Rename a data set when sample IDs from the Instrument Setup are necessary for a 
transfer operation and then another set of sample IDs is necessary for a second 
transfer operation. For example, the name of the first Sample ID data set can be used 
to maintain a record of the first transfer operation and then the second Sample ID 
data set may be renamed before the second transfer operation.

Note:  Each data set must have a unique name. The method displays an error during 
validation if two data sets have the same name.

Note:  Refer to Section 15.2.6, Creating the SampleID Data Set Using the Instrument 
Setup Step, for more information on creating the Sample ID data set using the 
Instrument Setup step.

To rename a data set:

1. Insert a Data Set Management step into the Method View. The Data Set 
Management step configuration appears (Figure 24-14).

2. From For the labware at, choose the labware where the data set is renamed.

3. If in a stack, enter the depth of the labware.

Note:  Depth refers to a specific piece of labware in a stack. To use the top piece 
of labware, enter 0; to use the second from the top piece of labware, enter 1; to 
use the third from the top piece of labware, enter 2; and so on. Refer to Section 
7.3.6.4.1, Biomek Stacking Rules, for information on using stacks.
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4. From the drop-down menu, choose Rename. Figure 24-15 appears.

Figure 24-15.  Choosing Rename in Data Set Management step

5. From the Data Set named, choose the data set to rename.

Note:  Each data set must have a unique name. The method displays an error 
during validation if two data sets have the same name.

6. At to, enter the new name of the data set. The data set is renamed.
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24.4.3 Removing a Data Set
When a data set is no longer needed, it may be removed.

To remove a data set:

1. Insert a Data Set Management step into the Method View. The Data Set 
Management step configuration appears (Figure 24-14).

2. From For the labware at, choose the labware where the data set is removed.

3. If in a stack, enter the depth of the labware.

Note:  Depth refers to a specific piece of labware in a stack. To use the top piece 
of labware, enter 0; to use the second from the top piece of labware, enter 1; to 
use the third from the top piece of labware, enter 2; and so on. Refer to Section 
7.3.6.4.1, Biomek Stacking Rules, for information on using stacks.

4. From the drop-down menu, choose Remove. Figure 24-16 appears.

Figure 24-16.  Choosing Remove in Data Set Management step

5. From the Data Set named, choose the data set to remove. The data set is 
removed.
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24.4.4 Changing the Properties of a Data Set
When Change is chosen in the Data Set Management step, two options are 
available:

• Including or not including the data set in reports.

• Tracking or not tracking the data in the data sets during pipetting.

To change the reporting properties of a data set:

1. Insert a Data Set Management step into the Method View. The Data Set 
Management step configuration appears (Figure 24-14).

2. From For the labware at, choose the labware where the data set properties are 
changed.

3. If in a stack, enter the depth of the labware.

Note:  Depth refers to a specific piece of labware in a stack. To use the top piece 
of labware, enter 0; to use the second from the top piece of labware, enter 1; to 
use the third from the top piece of labware, enter 2; and so on. Refer to Section 
7.3.6.4.1, Biomek Stacking Rules, for information on using stacks.

4. From the drop-down menu, choose Change. Figure 24-17 appears.

Figure 24-17.  Change chosen on Data Set Management step configuration

5. From the Data Set named, choose the data set to be changed.
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6. Ensure The Data Set should be included in reports is checked to allow 
the data set to be included in the reports chosen in the Reporting or Finish steps.

7. Ensure The data in the Data Set should be tracked during pipetting is 
checked to allow the system to track the data during pipetting operations.

Note:  If the data set applies only to the source labware and should not be 
tracked, do not check The data in the new Data Set should be tracked 
during pipetting. Not checking this option may be useful for complex methods 
that use data sets, but may not require the data set to be transferred to the 
destination labware.
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24.5 Configuring the Data Set Processing Step
The Data Set Processing step allows a transformation expression to be applied to 
an existing data set to create a new data set. The expression is applied to each well or 
tube in the destination data set and the result is stored in the corresponding well or 
tube of the newly created data set. 

Note:  A transformation expression is an operation stated in symbolic form (refer to 
Section 24.5.1, Understanding Expressions).

Note:  The destination data set is the result of the transformation expression applied 
to the existing data set.

The applied expression may result in numeric or Boolean values for the new data set 
(Table 24-2). These values are presented in a report on data sets that is configured in 
the Reporting (refer to Section 24.6, Configuring the Reporting Step) or Finish steps 
(refer to Section 12.2.2, Configuring the Finish Step).

Note:  Boolean values are expressed as True or False in the reports configured in the 
Reporting or Finish steps.

Insert a Data Set Processing step into the Method View. The Data Set 
Processing step configuration appears (Figure 24-18).

Figure 24-18.  Data Set Processing step configuration



Using the Data Sets Step Palette 24-23

Biomek Software User’s Manual

To configure the Data Set Processing step:

1. At For the labware at, choose the labware where the new data set is located.

2. If in a stack, enter the depth of the labware.

Note:  Depth refers to a specific piece of labware in a stack. To use the top piece 
of labware, enter 0; to use the second from the top piece of labware, enter 1; to 
use the third from the top piece of labware, enter 2; and so on. Refer to Section 
7.3.6.4.1, Biomek Stacking Rules, for information on using stacks.

3. In Create a new Data Set named, enter the name of the new data set.

Note:  Each data set must have a unique name. The method displays an error 
during validation if two data sets have the same name.

4. In with each element defined by the expression:, enter the expression.

Note:  Refer to Section 24.5.1, Understanding Expressions, for information on 
common symbols used in expressions.

Note:  An equal (=) sign must precede the expression entered in the Data 
Processing step.

5. At Allow the Data Set named. . . to be used in the expression, choose the 
previously created data set to be used in the expression.

Note:  The previously created data sets are available for selection.

Note:  Leave Allow the Data Set named. . .to be used in the expression 
blank to not use an existing data set as the basis for the transformation.

6. Ensure The new Data Set should be included in reports is checked to 
allow the new data set to be included in reports chosen in the Reporting or 
Finish steps.

7. Ensure The data in the new Data Set should be tracked during 
pipetting is checked to allow the data from the new data set to be tracked during 
pipetting operations.

Note:  If the expression is applied only to the source labware and should not be 
tracked, do not check The data in the new Data Set should be tracked 
during pipetting. Not checking this option may be useful for complex methods 
that use data sets, but may not require the data set to be tracked.
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24.5.1 Understanding Expressions
Expressions, using symbols, allow a customized operation to be performed in the 
Data Set Processing step. 

Using expressions in the Data Set Processing step includes understanding:

• some common symbols necessary to create an expression (Table 24-1).

• results of expressions on data sets (Table 24-2).

Note:  An equal (=) sign must precede an expression entered in the Data Set 
Processing step.

Note:  Refer to Section 13.3, Using Expressions, for more information on using 
expressions. 

Note:  Element refers to the value associated with a well or tube.

Table 24-1.  Some common symbols used in expressions 
Symbol Definition

+ addition
- subtraction
* multiplication
/ division; returns a rational number
\ integer division; returns an integer, 

no remainder; for example, 13 \ 5 
returns a value of 2

a MOD b returns the remainder after a is 
divided by b; for example, 13 MOD 5 
returns a value of 3

> greater than
< less than
= equal to
< > not equal to
^ exponentiation; for example, a ^ b = 

ab

Table 24-2.  Some expressions and the results
Expression Result

= DataSetName > 5 creates a new data set where each 
element is True if the value in the 
existing data set is greater than 5 and 
False if the value is less than or equal 
to 5

= DataSetName * 1.05 creates a new data set where each 
value is the product of the existing 
data set multiplied by 1.05
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24.6 Configuring the Reporting Step
The Reporting step (refer to Section 24.6, Configuring the Reporting Step) allows a 
report to be generated on data sets at any point during a method. While specifying the 
data desired from the data sets may be accomplished in the Create Data Set, Data 
Set Management, Data Set Processing, and Script steps, the report style and 
saved location of the report are chosen in the Reporting step. 

The report contains data from all data sets that are configured to be included in reports 
and the type may be selected from four styles (refer to Section 24.6.1, Report Styles). 

Since the Volume data set (refer to Section 14.2.1, Understanding the Volume Data 
Set) is reported in every report, the volume in each well in a microplate or tube in a 
rack can be tracked throughout a method if a Reporting step is inserted after every 
transfer or pipetting operation.

Note:  The report style and saved location of the report on data sets generated at the 
end of a method may also be chosen in the Finish step (refer to Section 12.2.2, 
Configuring the Finish Step).

Insert a Reporting step into the Method View. The Reporting step configuration 
appears (Figure 24-19).

Figure 24-19.  Reporting step configuration
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To choose the report style and location of the report:

1. From Report Style, choose one of the following:

• Text File 

• Per-Plate HTML Files 

• Per-Plate Text Files 

• SQL Server (refer to Section 24.6.2, Configuring a SQL Server Report 
Style) 

Note:  Refer to Section 24.6.1, Report Styles, for examples and information on 
the types of reports that may be generated.

2. In Report Location, browse to find the location where the file is to be saved. 
The Reporting step is configured.

24.6.1 Report Styles
The report styles on data sets that may be generated are:

• Text File — a single text file listing all plates in the system. The columns in 
this file include the SequentialID, plate name, plate bar code, well number, 
sample ID (if the SampleID data set is created), and volume. A column for 
each data set that has reporting enabled is also included (Figure 24-20). 

Note: The SequentialID is a number assigned to each plate. This number 
is the only way to identify a plate in a report if the plate name or bar code 
were not specified.

Figure 24-20.  Report saved as Text File
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• Per-Plate HTML Files — a folder containing an HTML file for each plate 
in the system. Each file contains the plate name, plate bar code, and an 
HTML table indexed by well number that includes the sample ID (if the 
SampleID data set is created) and volume. An entry for each data set that 
has reporting enabled is also included. The SequentialID is listed at the top 
of the file (Figure 24-21).

Note: The SequentialID is a number assigned to each plate. This number 
is the only way to identify a plate in a report if the plate name or bar code 
were not specified.

Figure 24-21.  Report saved as Per-Plate HTML Files
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• Per-Plate Text Files — a folder containing a text file for each plate in the 
system. Each file contains the SequentialID, plate name, plate bar code, and 
columns that include the well number, and sample ID (if the SampleID data 
set is created). A column for each data set that has reporting enabled is also 
included. 

Note: The SequentialID is a number assigned to each plate. This number 
is the only way to identify a plate in a report if the plate name or bar code 
were not specified.

Note: The text files in the folder for each plate in the system look similar 
to Figure 24-20.

• SQL Server — a single database table listing all plates in the system. The 
columns of this table include the SequentialID, plate name, plate bar code, 
well number, and sample ID (if the SampleID data set is created). A column 
for each data set that has reporting enabled is also included. The table is 
created with a time-date stamp appended to the name (Figure 24-22).

Note: The SequentialID is a number assigned to each plate. This number 
is the only way to identify a plate in a report if the plate name or bar code 
were not specified.

Note: SQL Server is a Microsoft product that allows queries and provides 
analysis. The installation of this product is the responsibility of the user and 
is not supported by Beckman Coulter Service Engineers. SQL Server 2000 
SP3 is the version requirement.

Note: Refer to Section 24.6.2, Configuring a SQL Server Report Style, for 
specific information on configuring a SQL Server report.

Figure 24-22.  Report saved as SQL Server
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24.6.2 Configuring a SQL Server Report Style
When SQL Server is chosen as the report style, the server, database, and table name 
are configured.

Note:  SQL Server is a Microsoft product that allows queries and provides analysis. 
The installation of this product is the responsibility of the user and is not supported by 
Beckman Coulter Service Engineers. SQL Server 2000 SP3 is the version 
requirement. 

Note:  Refer to Figure 24-22 for an example of a SQL Server report style.

To configure a SQL server report style:

1. In Report Style, choose SQL Server. Figure 24-23 appears.

Figure 24-23.  SQL Server report style chosen
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2. Browse to find the location of the desired database on that server. SQL Server 
Connection (Figure 24-24) appears on top of the Reporting step configuration.

Figure 24-24.  SQL Server Connection

3. Highlight the desired server.

4. Enter the User and Password.

OR  

Check Use NT Authentication.

Note:  The administrator of the SQL Server Connection sets the logging 
protocol for user and password or NT authentication.
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5. Choose Connect. A list of the available databases appears in Databases 
(Figure 24-25). 

Figure 24-25.  List of databases in SQL Server Connection

6. From Databases, highlight the desired database.



24-32 Using the Data Sets Step Palette

Beckman Coulter, Inc.

7. Choose OK. SQL Server Connection closes and the chosen server and 
database are entered in the Reporting step configuration.

Figure 24-26.  Server and database chosen

8. From the Reporting step configuration (Figure 24-19), enter the name of the 
Table Name.

Note:  Table names must begin with a letter, and only letters, numbers and 
underscores (_) can be used.

Note:  The table is created with a time-date stamp appended to the name.
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25 Handling and Preventing 
Errors

25.1 Overview
Biomek Software provides extensive error handling and error prevention capabilities 
to help make sure the method being built, edited, set up, and run executes 
appropriately. Included in the Biomek Software error handling and prevention 
capabilities are:

• Error notification and cause messages.

• Error recovery options.

• Constant internal validation during method building and editing.

• Internal validation before running a method.

25.1.1 Error Message Overview
There are several types of error messages that may display while building and running 
methods using Biomek Software. The types of error messages generated depend on 
the type of error that has occurred. While errors may originate from more than one 
source, most errors fall into the following general categories:

• Configuration Errors (Section 25.2) — occur when a device or step is not 
configured correctly during method development or instrument 
configuration.

• Validation Errors (Section 25.3) — occur when a method or step is 
validating.

• Manual Control Errors (Section 25.4) — occur when a manual control 
movement requested of the ALPs, bridge, pod, head, or gripper is not 
compatible with Biomek instrument capabilities.

• Run-Time Errors (Section 25.5) — occur while a method is running.

• Light Curtain Errors (Section 25.6) — occur when there is a light curtain 
violation.

• Liquid Level Sensing Errors (Section 25.7) — occur while attempting to 
determine the liquid level in a piece of labware during a method run.



25-2 Handling and Preventing Errors

Beckman Coulter, Inc.

• Clot Detection Error Message (NX-S8 only) (Section 25.8) — occurs when a 
clot has been detected

• Multiple Error Messages (Section 25.9) — numerous errors may occur 
during validation or method run.

• Observed Errors (Section 25.10) — an error observed by the operator as the 
method runs.

25.1.2 Error Recovery Overview
Error recovery is the process of making changes to ensure a method can be 
completed. When changes are made and no subsequent errors are detected, the 
method completes. Depending on the conditions causing the error, the error message 
displays the appropriate error recovery options available. 

Error recovery options may include:

• Fixing the error and continuing the method from the point of interruption.

• Stopping the current method, making modifications, and running the entire 
method from the beginning.

• Ignoring the error and continuing with the method.

• If a method using a dual-pod FX instrument is in progress when an error 
occurs, one pod can continue its tasks as long as its operations are not 
dependent upon the pod with the error.

25.1.3 Error Prevention Overview
Errors may be prevented by validating a method during the method-building process. 
Validation detects a large class of common errors before they occur by internally 
simulating the method prior to execution. This internal simulation provides an 
opportunity to change the method before it is run.

Operations for validating a method include:

• Validating the method immediately before a run starts by selecting Validate 
the current method before running it in Preferences.

• Individually validating steps by highlighting subsequent steps or the Finish 
step in the Method View.

• Individually validating operations by using the Single Step tool, available 
from the Execution menu.
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25.2 Configuration Errors
Configuration errors occur when steps, labware, or devices are not configured 
correctly during method development or system setup.

25.2.1 Configuration Error Messages
When a configuration error is encountered during system setup, an error message may 
be displayed immediately (Figure 25-1). 

Figure 25-1.  Example of a configuration error generated due to a 
Liquid Type Editor configuration problem

A configuration error notification can also be generated as soon as a device 
configuration entry is made; for example, an incorrect entry in the Deck Editor 
appears red rather than black (Figure 25-2). 

Figure 25-2.  Example of a configuration error generated from the Deck Editor

Erroneous Entry in 
the Deck Editor

The erroneous entry of 
‘-6737’ is highlighted 
in red.
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When a step is not configured correctly, the step causing the error is highlighted in red 
in the Method View (Figure 25-3), and a message describing the error in detail is 
displayed at the bottom of the Biomek method editor and in a tool tip when the cursor 
is hovered over the step.

Figure 25-3.  Example of an error generated during method validation
because a step is not configured correctly

Note:  The Error Message status bar may be hidden by choosing 
Options>Toolbars and deselecting Method Error.

To view multiple lines for a long error message, click the More button (Figure 25-3) 
to expand the error display to show the entire error message (Figure 25-4). 

Step Producing the Error
The step producing the error is 
highlighted in red in the Method 
View. 

Error Message
The error message is 
displayed in the status bar 
and as a tool tip.

More/Less
Expands and collapses 
status bar to view 
applicable error message 
content.
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Click the Less button (Figure 25-4) to collapse the error display back to a single line 
(Figure 25-3).

Figure 25-4.  Example of an expanded error message

25.2.2 Recovering from Configuration Errors
To recover from configuration errors, ensure that all of the facts pertaining to the step, 
labware, or device configuration have been supplied and are acceptable values. For 
example, make sure that volumes do not exceed the maximum capacity of the 
specified tips or labware. 

Expanded Error 
Message

The error message is 
displayed in the status bar 
and as a tool tip.

Less
Collapses status bar 
to display one line of 
error message.
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25.3 Validation Errors
Validating a method prior to execution internally simulates the method to test for 
errors. If an error is detected during validation, an error message displays information 
about the error.

Note:  In this section, validation refers only to running methods in simulation mode 
to test for step or instrument configuration errors. It does not refer to validating a 
revision of a method using Beckman Coulter Accounts & Permissions. Refer to 
Section 12.15, Checking Out a Method for more information about validating 
checked in revisions of methods.

Note:  Validation errors can occur due to step configuration or instrument 
configuration errors, as noted in Section 25.2, Configuration Errors.

25.3.1 Validation Error Messages
Errors encountered during validation may display the following information in the 
error messages:

• Source 

• Type

• Cause

• Location

• Error Code

• Recovery Option(s)

• Date and Time

25.3.2 Validating a Method Before Run
When Validate the current method before running it is checked in Preferences 
(Figure 25-5), a method is internally simulated to test for errors when the method is 
run. If no errors are detected during this validation, the method is executed. If an error 
is encountered during this validation, the process stops and an error message displays 
information about the nature of the error. 

When Validate the current method before running it is selected, the first step 
causing an error is highlighted in the Method View (Figure 25-6). Validate the 
current method before running it is enabled by default. 



Handling and Preventing Errors 25-7

Biomek Software User’s Manual

To prevent the system from slowing down due to unnecessary memory consumption, 
use Look ahead up to [1800] seconds in the method while it is running (refer to 
Section 25.3.2.1, Using Look ahead up to [1800] seconds in the method while it is 
running).

Figure 25-5.  Validate the current method before running it option in Preferences

Figure 25-6.  Example of a validation error message generated during
method development as a result of incomplete step configuration

Method Validation
Simulates methods internally to test 
for errors before the method is run.

Step Producing the Error
The step producing the error is 
highlighted in red in the Method View. 

Error Message
The error message is 
displayed in the status bar 
and as a tool tip.

More/Less
Expands or collapses status 
bar to display more or less of 
the error message. 
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To use Validate the current method before running it:

1. From the toolbar, choose Options>Preferences. Preferences appears 
(Figure 25-5).

2. Make sure Validate the current method before running it is checked.

3. Choose OK. 

4. Run the method.

Note:  Validating a complex or lengthy method could result in occupying system 
resources for a long period of time. Validate the current method before running it 
can be disabled prior to running a previously validated method, or a method not 
requiring validation, by using Options>Preferences and deselecting Validate the 
current method before running it.

25.3.2.1 Using Look ahead up to [1800] seconds in the 
method while it is running

When a method is run, the software translates the steps of the method into “to do” 
lists of actions to be performed on each device. This translation process occurs while 
the method is running. Since methods can be arbitrarily long, the lists of actions can 
consume large amounts of computer memory, possibly slowing the system.

To prevent unnecessary slowing of the system due to memory consumption, the Look 
ahead up to [1800] seconds in the method while it is running option in 
Preferences (Figure 25-5) designates a time-based governor for suspending the 
translation process. The time in seconds entered into Look ahead up to [1800] 
seconds in the method while it is running is a threshold at which the translation 
process may be suspended so that the “to do” lists do not become too large. If each 
currently active device requires more than the time-designated threshold to complete 
its “to do” list, the suspension may occur. (The translation process is never suspended 
during a Just In Time step.) Once the system determines that some device may finish 
its list earlier than this threshold, it automatically resumes the translation process.

Note:  To prevent problems with executing actions that should occur simultaneously, 
such as in a dual-pod system, it is important to enter a high enough Look ahead up 
to [1800] seconds in the method while it is running time.

25.3.2.2 Validation Error Messages Detected During 
Method Development

During method building, Biomek Software validates constantly. Errors that are 
detected during this process are displayed when a subsequent step in the method is 
highlighted. When the Finish step is highlighted, the entire method is validated.The 
step causing the error is highlighted in red in the Method View, and a message 
describing the error in detail is displayed in the status bar at the bottom of the method 
editor as well as a tool tip when the mouse pointer is hovered over the step.

25.3.2.3 Validation Error Messages Detected During 
Method Run

Validation errors may also be detected during method execution. The display of the 
error message depends on whether Validate the current method before running it 
is selected or not (refer to Section 25.3.2, Validating a Method Before Run).
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If Validate the current method before running it is selected, the method is 
validated before it starts. If an error is found, it displays an error message similar to 
Figure 25-7.

Figure 25-7.  Example of a validation error message detected before method run

If a method has not been previously validated and the Validate the current method 
before running it option is not selected, it displays an error message similar to Figure 
25-8.

Figure 25-8.  Example of a validation error message detected during method run
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25.3.3 Recovering from Validation Errors
To recover from Validation errors encountered during method execution, choose one 
of the options provided on the error message. Validation error messages have either 
the OK recovery option or both Abort and Snap recovery options.

Validation error message recovery options include:

• Abort — stops the method after Biomek instrument completes the move in 
progress.

• Snap — stops the method after Biomek instrument completes the move in 
progress and creates a Continuation method (refer to Section 25.11.2, 
Snapping a Continuation).

• If the method is in the process of performing a move, such as aspirating or 
dispensing, the Biomek instrument completes the move; however, the 
instrument may not complete the entire step. For example, if the Biomek 
instrument is in the process of performing a Transfer step and an error 
occurs while it is aspirating, selecting Abort or Snap results in completing 
the aspiration but not the Transfer step.

3000 — Snapping a Continuation is not available.

• OK — stops the method, allowing changes.

Note: OK is presented only as an option for a validation error detected 
before the run has started if Validate the current method before running it 
is turned on (refer to Section 25.3.2, Validating a Method Before Run).

25.3.3.1 Choosing Abort
Choose Abort to stop a method after completing the move in progress and leave the 
method open for editing. 

To use Abort:

1. Read the error message to determine the cause of the problem.

2. Choose Abort to make the necessary changes in the original method file.

25.3.3.2 Choosing Snap (not available on a 3000)
Snap allows the method to be modified without changing the original method. When 
Snap is chosen, a Continuation method is created. A Continuation method is a new 
method consisting of the step causing the error, any steps not yet completed, and, if 
applicable, any incomplete substeps of the step which generated the error (refer to 
Section 25.11.2, Snapping a Continuation).

To use Snap:

1. Read the error message to determine the cause of the problem.

2. Choose Snap to create a Continuation method (refer to Section 25.11.2, 
Snapping a Continuation). 
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25.4 Manual Control Errors
Manual Control errors occur when a manual control movement requested of the 
bridge, pod, head, or gripper is not compatible with Biomek instrument capabilities.

25.4.1 Manual Control Error Messages and 
Recovery

Manual Control errors have only one recovery option, and that is to choose OK on the 
error message (Figure 25-9). Manual Control error messages should be carefully read 
to determine whether the problem lies in the hardware or software. Once that 
determination has been made, appropriate changes can be made to recover from the 
error.

To recover from Manual Control errors:

1. Read the error message to determine the problem.

2. Choose OK, then make the necessary changes.

Figure 25-9.  Example of a Manual Control error because the
Biomek FX tried to move the pod too far on the Z axis
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25.5 Run-Time Errors
Run-Time errors result from problems that occur while a method is executing; for 
example, tips cannot load because the tiploader rods are not operating correctly. Run-
Time error recovery options are presented on each error message. 

25.5.1 Run-Time Error Messages
Run-Time error messages (Figure 25-10 and Figure 25-14) display the:

• Source

• Device

• Error Message

• Error Number

• Recovery Option(s)

• Date and Time

Figure 25-10.  An example of a Run-Time error due to undetermined gripper state

Error Message
This error message indicates that the gripper state could not 
be sensed when the system state was being saved before 
pausing the method.

Date/Time
Provides the date and time 
the error occurred.

Recovery Options
Refer to Section 25.5.2, 
Recovering from Run-Time 
Errors, for more information 
on recovery options.
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25.5.2 Recovering from Run-Time Errors
To recover from errors, choose one of the Recovery Options and correct the problem 
that caused the error.

The options available for recovering are:

• Abort — stops the method after Biomek instrument completes the move in 
progress.

• Retry — attempts to complete the move in progress when the error was 
encountered and complete the method (refer to Section 25.5.2.2, Choosing 
Retry).

WARNING: The Ignore error recovery option is potentially dangerous 
since almost every action depends upon the successful completion of 
previous actions. Choose Ignore at your own risk.

• Ignore — skips the move in progress and proceeds with the rest of the 
method, if possible (refer to Section 25.5.2.3, Choosing Ignore). 

• Snap — stops the method after the Biomek instrument completes the move 
in progress and creates a Continuation method (refer to Section 25.10.1.3, 
Snapping a Continuation (not available on a 3000)).

Note: If the method is in the process of performing a move, such as 
aspirating or dispensing, the Biomek instrument completes the move; 
however, the instrument may not complete the entire step. For example, if 
the Biomek instrument is in the process of performing a Transfer step and 
an error occurs while it is aspirating, selecting Abort or Snap results in 
completing the aspiration but not the remainder of the Transfer step.

3000 — Snapping a Continuation is not available.

After the errors are corrected, the method can be rerun or continued from where the 
error occurred.

25.5.2.1 Choosing Abort
Choose Abort to stop a method after completing the move in progress and leave the 
method open for editing. 

To recover from errors using Abort:

1. Read the error message to determine the cause of the problem.

2. Choose Abort to make the necessary changes in the original method file.
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25.5.2.2 Choosing Retry
Choose Retry to attempt to complete the step that is in progress when the error was 
encountered. If the step is completed successfully, the method continues. 

CAUTION: Resuming a method assumes that the Biomek instrument is 
in the same state as when the error occurred. The pod may be moved to 
deal with a problem, but no changes can be made to the Biomek 
instrument deck.
To recover from errors using Retry:

1. Read the error message to determine the cause of the problem.

2. Examine the instrument to verify it is safe to restart the method.

3. Choose Retry. The instrument attempts to perform the move in progress when 
the error occurred, and, if successful, the method continues. If the method cannot 
continue after choosing Retry, another error message appears.

25.5.2.3 Choosing Ignore
WARNING: The Ignore error recovery option is potentially dangerous 
since almost every action depends upon the successful completion of 
previous actions. Choose Ignore at your own risk.
Choose Ignore to bypass the error and proceed with the method. The move in 
progress when the hardware error is detected does not complete, but the method 
attempts to continue the run. 

To recover from errors using Ignore:

1. Read the error message to determine the cause of the problem.

2. Choose Ignore. The error is ignored, and the method continues to run, if 
possible. If the method cannot continue after choosing Ignore, another error 
message appears.

Note:  Ignore may be useful for failed SILAS steps such as failed bar code reads 
or device time-out errors that do actually complete.

25.5.2.4 Choosing Snap (not available on a 3000)
Snap allows the method to be modified without changing the original method. When 
Snap is chosen, a Continuation method is created (refer to Section 25.11, Using 
Continuations (not available on a 3000)).

To recover from errors using Snap:

1. Read the error message to determine the cause of the problem.

2. Choose Snap to create a Continuation method (refer to Section 25.11.2, 
Snapping a Continuation).
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25.6 Light Curtain Errors
The light curtain is a perimeter diffuse-reflective safety component that stops the 
Biomek FX or Biomek NX instrument when objects more than one inch in diameter 
penetrate the light curtains protective zone. Light curtain errors occur when an object 
penetrates (or violates) the light curtain protective zone and a light curtain error 
message is displayed.

3000 — Does not have a light curtain, although pressing the STOP button 
on the front rail of the instrument allows recovery options similar to those 
for a light curtain violation (refer to Section 25.6.3, Using the Stop Button on 
the Biomek 3000).

A light curtain violation does not stop the entire instrument. Certain on-deck devices 
and all devices controlled by SILAS may continue to operate despite a light curtain 
violation. However, new commands will not be issued once a light curtain violation 
has occurred and the system will come to a stop once all currently issued commands 
are completed.

25.6.1 Light Curtain Error Messages
Light curtain error messages appear when there is a light curtain violation. The light 
curtain error message displays:

• a graphic.

• an OK button.

• error message text.

25.6.2 Recovery Options for Light Curtain Errors
Light curtain errors can be recovered from by:

• Removing the obstruction and responding to the light curtain error message.

• Aborting a method during a light curtain violation using the buttons on the 
toolbar.

• Snapping a continuation during a light curtain violation using the buttons on 
the toolbar. 

Note:  If a light curtain violation occurs during a pause, the light curtain error must 
be resolved before the method can be resumed.

25.6.2.1 Removing the Obstruction and Responding to 
the Light Curtain Error Message

When a light curtain error message appears, the following text is displayed in the 
error:

“A light curtain violation has occurred. When you are clear of the light curtain, 
press OK. The pods will move back to where they were before the light curtain 
violation and the method will resume. If you wish to abort the method, you 
may press the stop button on the toolbar.”
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To recover from a light curtain error message:

1. Remove the violating object from the light curtain.

2. Click OK. The pod position is restored to its position before the light curtain 
violation and the method continues. If the light curtain violation remains, another 
error message is displayed.

Note:  The system will not check or restore the position of the D axis. More 
specifically, the system will not resume a pipetting action from the point the light 
curtain error occurred. The entire pipetting operation must be restarted; it cannot be 
completed from where it left off. 

FX — If using a dual-pod system, each pod will be moved back to position 
one at a time to avoid collisions.

25.6.2.2 Aborting a Method During a Light Curtain 
Violation

Abort stops the method and leaves it open for editing. The method may not be 
continued from the point the error occurred.

To abort during a light curtain violation, click Abort on the toolbar.

25.6.2.3 Snapping a Continuation During a Light Curtain 
Violation

Snap stops the method and creates a Continuation method. A Continuation method 
allows the method to be modified without changing the original method.

To snap a continuation during a light curtain violation, click Snap Continuation on 
the toolbar. A Recovery step is inserted at the start of the continuation method that 
will restore pod positions.

CAUTION: The partially completed steps assume the pods are in the 
same position they were in when the method was halted. Removing the 
Recovery step without also removing these partially completed steps 
could result in a crash.
If it is not desired for the pod(s) to restore position, delete the Recovery step and any 
partially complete steps that come after it in the continuation.

Note:  For more information about continuations, refer to Section 25.11, Using 
Continuations (not available on a 3000).
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25.6.3 Using the Stop Button on the Biomek 3000
Pressing the emergency STOP button on the front rail of the Biomek 3000 stops 
movement of the bridge and head assembly.

When the STOP button is pressed, Figure 25-11 appears.

Figure 25-11.  Choosing STOP on the front rail of the Biomek 3000

Two options are possible after pressing the emergency STOP:

• Choose OK to resume the method.

Note: If the STOP button is pressed while a tool is being loaded, the 
instrument must be homed before the method is resumed.

• From the toolbar, choose Execution>Stop to abort the method.
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25.7 Liquid Level Sensing Errors
The technologies for Liquid Level Sensing are different on the Biomek FX and NX 
instruments and the Biomek 3000 which accounts for the difference in error messages 
and recovery options for the instruments.

25.7.1 Liquid Level Sensing on the FX and NX-S8
If the liquid level in a piece of labware is not known, the Span-8 Pod can determine 
the liquid level when Liquid Level Sensing (LLS) capable tips are used. 

LLS tips are used to determine the liquid level in a piece of labware by detecting a 
shift in the capacitance of a probe. The LLS tip moves to a specified height within a 
well and then slowly moves down into the well. When the tip contacts liquid, there is 
a large change in the capacitance detected. The liquid level is sensed by determining 
the height at which this change in capacitance occurs. 

25.7.2 Liquid Level Sensing on the Biomek 3000
The P200L Single-Tip Pipette Tool includes patented technology that sonically 
detects the liquid level. Liquid level sensing is performed using an acoustic process 
involving a transmitter and receiver within the single-channel tools. The transmitter 
emits a sound wave through the tip that bounces back when it contacts liquid. The 
receiver detects the wave as it bounces back past the end of the tip.

25.7.3 Recovering from Liquid Level Sensing 
Errors

Liquid level sensing error messages appear when no liquid is sensed or when the 
amount of liquid sensed is incompatible with the operation performed. Liquid level 
sensing error messages display one of the following error messages:

“There is insufficient volume in well ## for this operation. Check mandrel # 
before continuing.”

“There is too much volume in well ## for this operation. Check mandrel # 
before continuing.”

“Validation failure in Move to #. Consecutive senses did not provide a 
stable value. This can be caused by bubbles in the well or by the 
meniscus of the liquid.”

Liquid level sensing errors display a variety of recovery options in the error message, 
based on the instrument and type of liquid level sensing error encountered. 
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25.7.3.1 No Liquid is Detected on a FX or NX-S8
When no liquid is detected on a FX or NX-S8, the error message provides 
information on the probes (mandrel) generating the error and the following recovery 
options:

• Seek Again — Repeats liquid level sensing operation.

• Seek Slower— Repeats liquid level sensing with tip descending into the 
labware at a slower rate of speed.

• Move Up — Positions tip higher in well and repeats liquid level sensing.

• Snap [a Continuation] — Stops the method after the instrument completes 
the move in progress and creates a Continuation method (refer to Section 
25.11, Using Continuations (not available on a 3000)).

• Abort — Stops the method after the instrument completes the move in 
progress.

25.7.3.2 Liquid Level Sensing Returning an Unstable 
Value on a FX or NX-S8

When a consistent value is not detected after numerous attempts to verify the liquid 
level on a FX or NX-S8, the error message (Figure 25-12) provides information on 
the pipetting operation generating the error, specific information on the error 
received, possible causes for the error, and the following recovery options:

• Abort — Stops the method after the instrument completes the move in 
progress

• Snap [a Continuation] — Stops the method after the instrument completes 
the move in progress and creates a Continuation method (refer to Section 
25.11, Using Continuations (not available on a 3000))

Figure 25-12.  Inconsistent liquid level value detected error message
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25.7.3.3 Liquid Level is Incompatible with the Operation
When the liquid level detected is incompatible with the pipetting operation, the error 
message is dependent on the instrument type (refer to Section 25.7.3.3.1, 
Incompatible Pipetting Operation on a FX or NX-S8 and 25.7.3.3.2, Incompatible 
Pipetting Operation on a 3000) and provides information on the specific probe 
(mandrel) generating the error and recovery options.

25.7.3.3.1 Incompatible Pipetting Operation on a FX or 
NX-S8 

The following recovery options are available:

• Seek Again — Repeats liquid level sensing operation.

• Pipette Air — Pipettes air when liquid is not available.

• Pipette From Bottom — Moves tip to bottom of well and continues 
pipetting operation.

• Snap [a Continuation] — Stops the method after the instrument completes 
the move in progress and creates a Continuation method (refer to Section 
25.11, Using Continuations (not available on a 3000)).

• Abort — Stops the method after the instrument completes the move in 
progress.

25.7.3.3.2 Incompatible Pipetting Operation on a 3000
The following recovery options are available:

• Pipette Air — Pipettes air when liquid is not available.

• Pipette From Bottom — Moves tip to bottom of well and continue 
pipetting operation.

• Abort — Stops the method after the instrument completes the move in 
progress.
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25.8 Clot Detection Error Message (NX-S8 only)
In order for clots to be detected, conductive disposable tips (called LLS in the Tip 
Type Editor) or fixed tips must be used and the technique must include clot detection. 
Biomek Software views the detection of a clot as an error and provides recovery 
options when a clot is detected.

25.8.1 Retrying Has Not Resolved the Clot
If the clot has not been resolved by retrying and Prompt user for further input is 
selected in the technique, an error message appears providing information on the 
probes (mandrel) generating the error and the following recovery options:

• Dispense, Aspirate Again, then Retry Detection — Dispenses the liquid 
back into the well, aspirates again, and retries clot detection.

• Ignore and Continue — Ignores the error and continues the method. 

Note: Ignoring the error and continuing the method when a clot exists 
may contaminate the deck.

• Snap [a Continuation}— Stops the method after the instrument completes 
the move in progress and creates a Continuation method (refer to Section 
25.11, Using Continuations (not available on a 3000)).

• Abort — Stops the method after the instrument completes the move in 
progress.

Figure 25-13.  Clot detection error
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25.9 Multiple Error Messages
When multiple error messages are generated during method validation, a dialog 
appears in the Instrument Setup prompt that contains a list of the errors (Figure 25-
14). Specific information about each error in the list is displayed in the message area 
by highlighting the message in the error list. Recovery options for each message are 
also displayed.

Figure 25-14.  Error message dialog with multiple errors

When multiple errors are encountered, the error messages appear in prompts similar 
to the examples displayed in Figure 25-15 and Figure 25-16.

Figure 25-15.  An example of multiple error messages

Figure 25-16.  An example of multiple error message generated during Run-Time

25.9.1 Recovering from Multiple Errors
Multiple error messages should be read carefully to determine where the problem lies: 
in the hardware, software, or in the method. Once that determination has been made, 
appropriate changes can be made to recover from the errors. Errors can be resolved in 
any order. Refer to Section 25.5.2, Recovering from Run-Time Errors, for more 
information on error recovery options.

Recovery options

Error list Message area

Validation Error Message

Message AreaInstrument Setup Message

Error List

Message Area
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25.10 Observed Errors
Occasionally, errors are observed while watching the Biomek instrument execute a 
run. For example, the instrument may attempt to aspirate from an empty or missing 
microplate.

Observed errors may result from setup, hardware, or software issues. 

25.10.1 Recovering from Observed Errors
The Biomek Software provides three options for recovering from observed errors 
while the method is running:

• Pause — halts a method without causing a light curtain violation.

• Stop — halts a method when there is no intent to resume the method from 
the point where it was stopped.

• Snap — stops the method after Biomek instrument completes the move in 
progress and creates a Continuation method (refer to Section 25.11, Using 
Continuations (not available on a 3000)).

3000 — Snapping a Continuation is not available.

25.10.1.1 Pausing a Method
Use Pause to halt a method without causing a light curtain violation. Pause causes 
the method to halt after the Biomek instrument has completed the move in progress. 
For example, if the Biomek instrument is in the process of loading tips when Pause 
is selected, it finishes loading the tips before the system halts. When the method is 
resumed, it continues as though it were never halted.

Note:  A method cannot be edited during a pause.

Use one of the following procedures to pause a method:

CAUTION: No changes to the Biomek instrument state are permitted 
while a method is paused. Changes can be made to the labware 
contents, but not the deck or the Biomek devices.
1. Choose Execution>Pause.

OR

Choose Pause on the toolbar. The instrument completes the move in progress, 
stops, and deactivates the light curtain.

2. Make the necessary changes to correct the observed error.

3. To resume the method run, choose Pause again. The light curtain is reactivated, 
and the method resumes from the point where it was paused.
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25.10.1.2 Stopping a Method 
WARNING: The light curtain is a safety device. Use it to stop a method 
only in an emergency.
Use Stop to halt a method during its run when there is no intent to resume method 
execution. If the pod is in the process of a move, the operation is not completed. Since 
the method is halted, this option allows edits to the method or changes to the 
hardware and deck.

Note:  Stop may not halt operations already in progress on external devices, such as 
Stacker Carousels.

Use one of the following procedures to stop a method during a run:

• Choose Execution>Stop. 

OR

• Choose Stop on the toolbar.

OR

FX, NX-S8 — Break (violate) the light curtain by no more than one 
inch, and Abort (refer to Section 25.6, Light Curtain Errors).

OR

3000 — Press the STOP button on the front of the instrument (refer to 
Section 25.6.3, Using the Stop Button on the Biomek 3000) and choose 
Stop from the toolbar.

Note:  Use standard procedures to rerun the method.

25.10.1.3 Snapping a Continuation (not available on a 
3000)

Another way to recover from observed errors is by snapping a Continuation. 
Snapping a Continuation stops the current method and allows corrections in the 
middle of a method run. The method can be restarted from the point where the 
method was halted. 

To snap a continuation, choose Snap to create a Continuation (refer to Section 25.11, 
Using Continuations (not available on a 3000)).
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25.11 Using Continuations (not available on a 3000)
Continuation methods allow error recovery or method modification after a method 
has begun execution. A Continuation is a temporary method with steps generated 
automatically that complete the original method from the point at which the 
Continuation method was snapped. A Continuation method is displayed in the 
Method View and can be edited; however, it cannot be saved and used as a regular 
method.

FX — If two pods are in use, one pod can continue to perform operations 
after an error occurs on the other pod. In this case, it is acceptable to allow 
the pod that is still performing operations to complete what it can before 
snapping a Continuation.

Note:  When Beckman Coulter Accounts & Permissions is enabled, only users with 
permission to run the method may snap, edit, and run continuations (refer to Chapter 
2, Using Accounts & Permissions).

25.11.1 Characteristics of Continuations
Continuation methods have several distinct characteristics such as:

• A Continuation method may not have a Start step.

• Icons for steps unavailable for editing appear gray, not colored. If a step 
containing multiple operations, such as Transfer or Combine, is in progress 
when a Continuation method is created, the incomplete operations are 
displayed as substeps under the main step at the start of the Continuation 
method in a Recovery Step (Figure 25-17). For example, if the Transfer step 
is in progress when a Continuation is snapped, the first step in the 
Continuation method is Transfer. Double-click on the Transfer step to view 
the substeps. 

Note: For light curtain violations, the Recovery step also includes steps to 
restore the pod to its position when the Light Curtain violation occurred.

• When a Continuation method is run successfully, the Continuation 
automatically closes.

• Only the last Continuation method generated is saved. Each subsequent 
Continuation method overwrites the previous Continuation method. 

WARNING: To eliminate the possibility of replacing a Continuation 
method before corrections are made, it is recommended that a 
Continuation method be edited and run as soon as it is created.

• A Continuation method that contains a partially completed loop appears as 
one or more Loop steps. The first Loop is the partially completed loop 
iterations, while the last Loop step represents the remaining iterations of the 
loop. The number appearing with the first Loop indicates the iteration 
number the loop was on when the Continuation method was created (Figure 
25-17).

Note:  There are many dependencies among actions taken by different steps; 
therefore, take great care in modifying steps or substeps in a Continuation method.
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Figure 25-17.  A Continuation method snapped during a Loop step

25.11.2 Snapping a Continuation
CAUTION: A Continuation method assumes that the instrument is in the 
same state as when the Continuation was snapped. If this is not true, the 
Continuation method must be edited to account for the changes.
A Continuation method is a temporary method created when Snap is chosen on an 
error message or when Snap Continuation is chosen from the toolbar during a 
method run.

The method is stopped during the Loop 
step. The Continuation method begins 
with the incomplete Loop step, and 
double-clicking on the Loop step 
expands the step to display the 
incomplete substeps. The incomplete 
substeps may be available for 
modification.

The second Loop step runs the remaining 
iterations of the original Loop. 

Cont’d appears on the title bar after 
the method file name
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To abort the current method and create a Continuation method:

1. Choose Execution>Snap Continuation. Snap Continuation Information 
appears (Figure 25-18).

OR

Choose Snap from an error dialog.

OR

Choose Snap Continuation on the toolbar. Snap Continuation Information 
appears (Figure 25-18).

Figure 25-18.  Snap Continuation Information

2. Choose OK. The Confirm prompt (Figure 25-19) appears if there are unsaved 
changes in the original method.

Figure 25-19.  Confirm saving changes to method
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3. If prompted to save, choose from among the following options:

• Choose Save to save and close the current method and to open the 
Continuation method. 

Note: Refer to Section 12.9, Saving a Method for more information. 
After the method is saved, the Continuation method opens.

• Choose Check In to save and check in the method and open the 
Continuation method. 

Note: Refer to Section 12.10, Checking In a Method, for more 
information. After the method is saved and checked in, the Continuation 
method opens.

• Choose Discard Changes to close the original method without saving 
the changes. Any unsaved changes in the method are lost and the 
Continuation opens and is active for editing.

• Choose Cancel Method Close to keep the original method active 
without saving and create a Continuation method for later use (refer to 
Section 25.11.3, Loading and Running a Continuation). 

Note:  Once the Continuation method is opened, the title changes in the titlebar 
indicating that the Continuation method is now active; for example, <Method 
Name> Cont’d.

Note:  To access a Continuation method that is saved but not executed, follow 
the procedures outlined in Section 25.11.3, Loading and Running a Continuation.

4. Edit the Continuation method as needed (perhaps to correct an error). 

5. Run the Continuation method.

6. Repeat steps 1 through 5 as many times as necessary to correct all errors. 

When the Continuation method is run successfully, the Continuation method closes 
and cannot be loaded and run again.
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25.11.3 Loading and Running a Continuation
If the Cancel Method Close option is chosen when snapping a Continuation (refer 
to Section 25.11.2, Snapping a Continuation), a Continuation method is created and 
saved for later use. To use the Continuation method later, it must be loaded.

Note:  Continuation methods performed successfully are automatically deleted. 
Load Continuation is available only if a Continuation method exists. If a second 
Continuation is snapped before the first Continuation method is run, the first 
Continuation method is lost.

To load and run a Continuation method:

1. Choose File>Load Continuation. The Continuation method loads and appears 
in Method View.

2. Edit the Continuation method by adding, deleting, and editing steps.

3. Run the Continuation. 

Note:  If the Continuation method runs successfully, the Continuation method 
closes, and the Continuation is deleted. If further errors occur while running the 
Continuation method, handle them as outlined in this chapter.
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25.12 Performing Single Operations Within Steps
The Single Step option performs single operations within Biomek steps, such as 
Aspirate or New Tips. Single Step pauses the Biomek instrument between each 
operation in a step, allowing visual verification that the operation is correct. 
Performing single operations can help when fine tuning a method.

To open Single Step:

Choose Execution>Single Step. Single Step appears (Figure 25-20):

Figure 25-20.  Single Step prompt

Single Step allows a method to be executed, one operation at a time. For example, to 
visually verify that tips are loading properly, use Single Step to walk through the 
New Tips step operation by operation. It is important to move slowly when using 
Single Step. Moving too quickly through the method may by-pass steps that need 
verification.

When visually verifying steps using Single Step, there are multiple operations that 
occur. For example, the New Tips step may walk through operations that include:

• Moving to a tip box.

• Extending the gripper.

• Gripping the tip box.

• Lifting the tip box.

• Moving to the tip loader.

• Placing the tip box on the tip loader.

• Retracting the gripper.

• Preparing to load tips.

• Loading Tips.
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To run a method using Single Step:

1. Open the Single Step prompt. This can be done during a method run.

2. Start the method using the Start button on the toolbar. The method will stop for 
the first movement of a pod or bridge and the prompt will display the operation to 
perform (Figure 25-21).

Figure 25-21.  First move of method using Single Step

3. To perform the next move, choose Launch.

4. To perform all steps in the method after verifying the desired steps, uncheck 
Single Step.

Note:  Choose Launch All to launch all operations listed in the Single Step 
prompt. When there is more than one Launch button available, Launch All 
simultaneously presses all the Launch buttons.

5. Choose Exit to leave Single Step at any time.
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26 Generating and Using Log 
Data

26.1 Overview
Logs provide text records of a method run. The contents of the text record, or log file, 
is based upon the type of log requested. Logs include information on liquid transfer 
operations, errors, and gripper movements, as well as information contained in data 
sets.

Log types include:

• Details — captures every operation that occurs during a method run, 
including Instrument Setup, absolute moves, pod movements, and gripper 
movements.

• Errors — captures any errors that occur during a method run.

• Pipetting — captures pipetting operations completed by a pod during a 
method run, deck location, and labware name or type.

FX — available only for instruments with a Multichannel pod.

3000 — available with all pipetting tools.

NX-MC — available for this instrument.

NX-S8 — not available for this instrument.

• Span8Pipetting — captures only Span-8 pipetting operations that occur 
during a method run, including location and labware name or type.

• Span8Transfer — captures only Span-8 transfer operations that occur 
during a method run, including location and labware name or type.

FX — Span8Pipetting and Span8Transfer are available only for 
instruments with a Span-8 pod.

3000, NX-MC — Span8Pipetting and Span8Transfer are not 
available for these instruments.

NX-S8 — available for this instrument.

Note: The addition of SampleID data sets also allows the 
Span8Pipetting and Span8Transfer logs to include well identification 
information.
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• UnifiedPipetting — captures pipetting operations, along with Sample IDs 
for wells, performed by any pod, including information on the where the 
aspirate or dispense operation occurs.

• UnifiedTransfer — captures transfer operations, along with Sample IDs for 
wells, performed by any pod, including information on the source and 
destination labware.

Log files are used to generate reports and capture the history of a method run. Log 
files can be printed using a standard text editor or by inserting them into a spreadsheet 
program, such as Microsoft® Excel.
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26.2 Types of Logs
The seven types of logs available capture either a complete account of a method or 
specific operations that occur during a method run. The type of log captured is 
indicated by the file name in the Logs subdirectory. Logs is a subdirectory of the 
Biomek directory.

To access Logs:

Browse to C:\Documents and Settings\All Users\Documents\Biomek\Logs.

OR

Choose Start>Beckman Coulter>Tools>Biomek Files to open the Biomek 
directory and access Logs.

Examples of the naming procedures for log files are:

• Details — Details03-09-2000 17.11.20.log

• Errors — Errors03-27-2000 10.27.41.log

• Pipetting — Pipetting03-09-200 17.11.20.log

• Span8Pipetting — Span8Pipetting03-05-2001 16.51.18.log

• Span8Transfer — Span8Transfer03-05-2001 16.51.18.log

• UnifiedPipetting — UnifiedPipetting09-27-2002 12.11.41.log

• UnifiedTransfer — UnifiedTransfer09-27-2002 12.11.41.log

26.2.1 Details Log
The Details log provides comprehensive information about each move made by the 
Biomek instrument. It is used when trying to identify and correct movement problems 
for any pod. 

Refer to Section 26.3.1, Details Log Contents, for specific information about the 
Details Log contents.

Note:  The default setting for the Details log is Off. 

Note:  The Details log is most useful to Beckman Coulter Service Engineers when 
troubleshooting an instrument.
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26.2.2 Errors Log
The Errors log lists any errors or interruptions that occur during a method run. It is 
used to get the exact error message to include in a report or a discussion with 
Technical Support. 

Refer to Section 26.3.2, Errors Log Contents, for specific information about the 
Errors log contents.

Note:  The default setting for the Errors log is On.

26.2.3 Pipetting Log
The Pipetting log lists aspirate and dispense operations that are executed during a 
method run. It is used when validating a method or generating a comprehensive report 
about the pipetting operations used during a method. 

FX — available only for instruments with a Multichannel pod.

3000 — available with all pipetting tools.

NX-MC — available for this instrument.

NX-S8 — not available with this instrument.

Refer to Section 26.3.3, Pipetting Log Contents, for specific information about the 
Pipetting log contents.

Note:  The default setting for the Pipetting log is Off. 

26.2.4 Span8Pipetting Log (FX, NX-S8 only)
The Span8Pipetting log lists aspirate and dispense operations performed by the 
Span-8 Pod during a method run. It is used when validating a method or generating a 
comprehensive report about Span-8 pipetting operations used during a method. The 
SampleID data sets allows the Span-8Pipetting log to include the sample ID 
assigned in the Instrument Setup step for wells on labware. The sample ID is 
captured in the Well Identification field.

Refer to Section 26.3.4, Span-8Pipetting Log Contents (FX, NX-S8 only), for specific 
information about the Span8Pipetting Log contents.

FX — default setting is On when a Span-8 Pod is installed and configured in 
Instrument Setup. However, a Span8Pipetting log is available only after a 
method has been run with a Span-8 pod.

NX-S8 — default setting is On. However, a Span8Pipetting log is 
available only after a method has been run with a Span-8 pod.
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26.2.5 Span8Transfer Log (FX, NX-S8 only)
The Span8Transfer log lists liquid transfer operations performed by the Span-8 Pod 
during a method run. It is used when validating a method or generating a 
comprehensive report about Span-8 liquid transfer operations used during a method. 
The SampleID data sets allows the Span-8Transfer log to include the sample ID 
assigned in the Instrument Setup step for wells on labware. The sample ID is 
captured in the Well Identification field.

Refer to Section 26.3.5, Span-8Transfer Log Contents (FX, NX-S8 only), for specific 
information about the Span8Transfer Log contents.

FX — default setting is On when a Span-8 Pod is installed and configured in 
Instrument Setup. However, a Span8Pipetting log is available only after a 
method has been run with a Span-8 pod.

NX-S8 — default setting is On. However, a Span8Pipetting log is 
available only after a method has been run with a Span-8 pod.

26.2.6 UnifiedPipetting Log
The UnifiedPipetting log lists aspirate and dispense operations, along with Sample 
IDs for wells, performed by any pod. It includes information on the labware where the 
aspirate or dispense operation occurs and is used when validating a method or 
generating a comprehensive report about pipetting operations used during a method. 

Refer to Section 26.3.6, UnifiedPipetting Log Contents, for specific information 
about the UnifiedPipetting log contents.

Note:  The default setting for the UnifiedPipetting log is Off.

26.2.7 UnifiedTransfer Log
The UnifiedTransfer log lists transfer operations, along with Sample IDs for wells, 
performed by any pod. It includes information on the source and destination labware 
and is used when validating a method or generating a comprehensive report about 
liquid transfer operations used during a method. 

Refer to Section 26.3.7, UnifiedTransfer Log Contents, for specific information about 
the UnifiedTransfer log contents.

Note:  The default setting for the UnifiedTransfer log is Off.
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26.3 Log Contents
Each of the logs provide specific types of information; however, all log files provide 
the following information in their header:

• Method name and file path.

• User.

• Method start date and time.

• Unit serial number.

• Pod serial number.

• Last date the pod was validated (by a Beckman Coulter Service Engineer).

• A blank line (used as a separation between the header and the information 
captured during the method run).

Each line below the header can contain the following information:

• Date the information was captured.

• Time the information was captured.

• Information captured during the method run that is specific to the type of log 
requested.

Note: The information captured during the method run is based on the 
type of log generated. More specifically, when a Pipetting Log is generated, 
pipetting information such as the pod performing the operation, the type of 
pipetting operation performed, and the labware position and name are 
captured, along with other pipetting specific information. 

The last line of a log file contains the date and time the method run ended. 

26.3.1 Details Log Contents
Each line below the header of a Details log contains the following information:

• Date/Time — when the error occurred.

• Action Completed — action performed by the Biomek instrument.

• Device Completing the Action — the device performing the action (if 
applicable).

26.3.2 Errors Log Contents
Each line below the header of an Errors log contains the following information:

• Date/Time — when the error occurred.

• Error Description — provides the exact error message.
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26.3.3 Pipetting Log Contents
Each line below the header of a Pipetting log contains the following information:

• Date/Time — when the error occurred.

• Pod Name — which pod performed the operation (Pod1 or Pod2).

• Position — the location on the deck (P1, P2...).

• Labware Name — name assigned to the labware in Labware Properties.

• Labware Barcode — barcode assigned to the labware in Labware 
Properties.

• Labware Section — the quadrant accessed.

Note: Quadrants are numbered 1 through 4. A 96 well microplate is 
always Quadrant 1.

• Amount — the amount of fluid pipetted.

Note:  If no information was supplied for a particular field, the field is blank in the 
Pipetting log.

26.3.4 Span-8Pipetting Log Contents (FX, NX-S8 
only)

Each line below the header of a Span-8Pipetting log contains the following 
information:

• Date/Time — when the error occurred.

• Pod Name — which pod performed the operation (Pod1 or Pod2).

• Operation — the pipetting operation performed (aspirate or dispense).

• Position — the location on the deck (P1, P2...).

• Labware Name — name assigned to the labware in Labware Properties.

• Labware Barcode — barcode assigned to the labware in Labware 
Properties.

• Well Number — the well number pipetted to or from.

Note: Wells are numbered left to right, top to bottom for all types of 
labware (Figure 26-1).

• Well Identification — sample ID assigned in the Instrument Setup step for 
wells on labware.

• Probe Number — the probe used for the pipetting operation.

Note: Probes are numbered 1 through 8, from the back of the Biomek 
instrument to the front.
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• Amount — the amount of fluid pipetted.

• Technique — the name of the technique used to govern the pipetting 
operation, or Custom if a customized technique was used.

Note:  If no information was supplied for a particular field, the field is blank in the 
Span-8Pipetting log.

Figure 26-1.  Well numbering in log files

26.3.5 Span-8Transfer Log Contents (FX, NX-S8 
only)

Each line below the header of a Span-8Transfer log contains the following 
information:

• Date/Time — when the error occurred.

• Pod Name — which pod performed the operation (Pod1 or Pod2).

• Source Position — location of the source labware for the pipetting operation.

• Source Labware Name — name assigned to the source labware in Labware 
Properties.

• Source Well Number — the number of the well pipetted from in the source 
labware.

Note: Wells are numbered left to right, top to bottom for all types of 
labware (Figure 26-1).

• Source Well Identification — sample ID assigned in the Instrument Setup 
step for wells on labware. 

• Destination Position — location of the destination labware for the pipetting 
operation.

• Destination Labware Name — name assigned to the destination labware in 
Labware Properties.

1 2 3 4 5 6 7 8 9 10 11 12

22 23 2419 20 2116 17 1813 14 15

34 35 3631 32 3328 29 3025 26 27
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• Destination Well Number — the number of the well pipetted to in the 
destination labware.

Note: Wells are numbered left to right, top to bottom for all types of 
labware (Figure 26-1).

• Destination Well Identification —sample ID assigned in the Instrument 
Setup step for wells on labware.

• Probe Number — the probe used for the pipetting operation.

Note: Probes are numbered 1 through 8, from the back of the Biomek 
instrument to the front.

• Amount — the amount of fluid pipetted.

• Technique — the name of the technique used to govern the pipetting 
operation, or Custom if a customized technique was used.

Note:  If no information was supplied for a particular field, the field is blank in the 
Span-8Transfer log.

26.3.6 UnifiedPipetting Log Contents
Each line below the header of a UnifiedPipetting log (Figure 26-2) contains the 
following information:

• Date/Time — when the pipetting operation occurred.

• Pod Name — which pod performed the pipetting operation (Pod1 or Pod2).

• Type of Pipetting Operation — aspirate or dispense.

• Source Position — location of the source labware for the pipetting operation.

• Labware Name — name assigned to the labware in Labware Properties.

• Labware Bar Code — bar code assigned to the labware in Labware 
Properties.

• Labware Well Number— number of the well pipetted from in the labware.

Note: Wells are numbered left to right, top to bottom for all types of 
labware (Figure 26-1).

• Labware Sample ID for Well — sample ID assigned in Instrument Setup 
step for well for labware.

• Probe or Tip Number — probe or tip used for the pipetting operation.

FX — probes for the Span-8 Pod are numbered 1 through 8, from the 
back the instrument to the front. Tips for the Multichannel Pod are 
numbered left to right, top to bottom (like well numbering) for all types 
of labware.

3000 — Tips for the Multi-Tip Pipette Tools are numbered 1 through 8, 
from the back of the Biomek instrument to the front.

NX-MC — tips for the Multichannel Pod are numbered left to right, top 
to bottom (like well numbering) for all types of labware.

NX-S8 — probes for the Span-8 Pod are numbered 1 through 8, from 
the back the instrument to the front.
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• Volume — amount of fluid pipetted.

• Technique — the name of the technique used to govern the pipetting 
operation, or Custom if a customized technique was used.

Note:  If no information was supplied for a particular field, the field is blank in the 
UnifiedPipetting log.

Figure 26-2.  UnifiedPipetting log
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26.3.7 UnifiedTransfer Log Contents
Each line below the head of a UnifiedTransfer log (Figure 26-3) contains the 
following information:

• Date/Time — when the transfer occurred.

• Pod Name — which pod performed the transfer (Pod1 or Pod2).

• Source Position — location of the source labware for the transfer operation.

• Source Labware Name — name assigned to the source labware in Labware 
Properties.

• Source Labware Bar Code — bar code assigned to the source labware in 
Labware Properties.

• Source Labware Well — number of the well pipetted from in the source 
labware.

Note: Wells are numbered left to right, top to bottom for all types of 
labware (Figure 26-1).

• Source Labware Sample ID for Well — sample ID assigned in Instrument 
Setup step for well for source labware.

• Destination Position — location of the destination labware for the transfer 
operation.

• Destination Labware Name — name assigned to the destination labware in 
Labware Properties.

• Destination Labware Bar Code — bar code assigned to the destination 
labware in Labware Properties.

• Destination Labware Well — the number of the well transferred to in the 
destination labware.

• Destination Labware Sample ID for Well — sample ID assigned in 
Instrument Setup step for well for destination labware. 
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• Probe or tip number — probe or tip used for the transfer operation.

FX — probes for the Span-8 Pod are numbered 1 through 8, from the 
back the instrument to the front. Tips for the Multichannel Pod are 
numbered left to right, top to bottom (like well numbering) for all types 
of labware.

3000 — Tips for the Multi-Tip Pipette Tools are numbered 1 through 8, 
from the back of the Biomek instrument to the front.

NX-MC — tips for the Multichannel Pod are numbered left to right, top 
to bottom (like well numbering) for all types of labware.

NX-S8 — probes for the Span-8 Pod are numbered 1 through 8, from 
the back the instrument to the front.

• Volume — amount of fluid transferred.

Note:  If no information was supplied for a particular field, the field is blank in the 
UnifiedTransfer log.

Figure 26-3.  UnifiedTransfer log
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26.4 Selecting Log Types
To generate log(s) during a method run, the only information required is a selection of 
the type of log(s) desired. 

To select log(s):

1. Choose Options>Log Configuration. Log Configuration appears (Figure 
26-4).

Figure 26-4.  Select the log type(s) generated here

Note:  The default setting for Errors is On. The default settings for Details, 
Pipetting, UnifiedPipetting,and UnifiedTransfer logs are Off.

FX — Span8Pipetting and Span8Transfer logs only appear when a Span-
8 Pod is installed and configured for use and after a method has been run 
with a Span-8 pod. When these conditions are met, the default settings for 
the Span8Pipetting and Span8Transfer logs are On.

3000, NX-MC — Span8Pipetting and Span8Transfer logs are not 
available for these instruments.

NX-S8 — Span8Pipetting and Span8Transfer logs only appear after a 
method has been run. The default settings for the Span8Pipetting and 
Span8Transfer logs are On.

2. Check the logs desired. 
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26.5 Viewing Log Files
View log files when creating reports or obtaining detailed information about a 
method. Log files are viewed in a standard text processor, such as Notepad (Figure 
26-5), or in a spreadsheet, such as Microsoft Excel (Figure 26-6).

Figure 26-5.  Span8Pipetting Log viewed in Notepad

Figure 26-6.  Span8Transfer Log viewed in Microsoft Excel
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27 Using Manual Control

27.1 Overview
Manual Control and Advanced Manual Control are used to control:

• Movement of the bridge, head, and gripper independently of a method. 

• Pod when framing the deck or gripper and recovering from errors. 

• Device Controllers and ALPs on a Biomek FX or Biomek NX manually.

• Devices on a Biomek 3000 manually.

For information on manually controlling Biomek instruments, ALPs, or other devices 
through Manual Control, refer to the appropriate hardware user’s manual:

FX — Biomek® FX Laboratory Automation Workstation User’s Manual

3000 — Biomek® 3000 Laboratory Automation Workstation User’s Manual

NX-MC — Biomek® NX Multichannel Laboratory Automation Workstation 
User’s Manual

NX-S8 — Biomek® NX Span-8 Laboratory Automation Workstation User’s 
Manual

Refer to the ALPs User’s Manual or the appropriate integration manual for 
information on using Manual Control with specific ALPs or devices.



27-2 Using Manual Control

Beckman Coulter, Inc.

27.2 Accessing Manual Control
To open Manual Control, choose Instrument>Manual Control. An Information 
dialog (Figure 27-1) appears briefly as the connection is made with the Biomek 
instrument, immediately followed by Manual Control (Figure 27-2).

Note:  Manual Control is available only when a method is not being executed. If a 
need for manual control is realized during a method run, stop the method using the 
Stop button or Snap Continuation button (refer to Chapter 25.11.2, Snapping a 
Continuation) on the toolbar before accessing Manual Control.

3000 — Snapping a Continuation is not available.

Figure 27-1.  Confirms Manual Control is connecting

Figure 27-2.  Manual Control
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27.3 Understanding the Options in Manual Control
Table 27-1 lists and describes the options in Manual Control:

Figure 27-3.  Information displaying firmware version 

Table 27-1.  Manual Control Options
Option Description

Advanced Controls Accesses Advanced Manual Control which 
allows a pod, ALP, or device to be selected. Refer 
to the specific hardware manual for details on 
using Advanced Manual Control for a device.

Home All Axes Gives the instrument a point of reference from 
which to make subsequent moves. For a single-
pod system, home position is left, back. For a dual-
pod system, home position for the first (left) pod is 
left, back and for the second (right) pod is right, 
back.

Note:  Pods should be homed each time the 
instrument is powered on. Depending on the type 
of pods on the system, a Warning appears. After 
confirming that the actions have been addressed 
properly, choose OK. 

Get Version Shows the current firmware version for installed 
devices, pods, and devices (Figure 27-3).

Stop Stops a pod once movement has started after 
selecting the desired pod from Click on a position 
to move.

Click on a position to 
move

Moves the pod to a specific deck position after 
selecting the desired pod. Manual Control moves 
the pod to the top of the Z axis, then centers it over 
the selected position. 

Exit Closes Manual Control. 
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28 Scripting

28.1 Overview
The Biomek scripting feature is based on Visual Basic Scripting, a subset of the 
Microsoft® Visual Basic programming language. Any Visual Basic Scripting code 
can be interpreted by Biomek Software and may be included in a method.

Note:  For more Visual Basic Scripting information, go to 
http://msdn.microsoft.com/scripting.

The Advanced Step Palette provides a Script step and a Scripted Let step, which 
provide a configuration area in which code can be entered. These steps invoke a 
Visual Basic Scripting Engine that evaluates the code.

The Script step and Scripted Let step expose objects that are used internally by 
Biomek Software. This is accomplished through the use of Microsoft’s Component 
Object Model (COM).

Data from a reader or LIMS file in a .csv file format may be translated into a data set 
using scripting. The data sets created from scripting behave like any other data set 
created in the Create Data Set step, from sample IDs in the Instrument Setup step, 
or in the SILAS step.

The sections in this chapter include:

• refer to Section 28.2, Using the Script Steps

• refer to Section 28.3, Scripting Data Sets
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28.2 Using the Script Steps
A Script step, available from the Advanced Step Palette, provides a configuration 
area in which a description of the script step may be entered, and lines of code may be 
written.

Note:  Refer to Section 17.8, Script Step, for information on configuring a Script 
step.

A Scripted Let step is also available from the Advanced Step Palette and provides a 
configuration area in which a description of the script step may be entered, and lines 
of code may be written. However, two additional commands may be entered in the 
Scripted Let step that allow for variables created in the script to be extended outside 
of the script and used in configuring other steps in the method. These two new 
commands are:

• Extend — sets the variable name to the specified value for all steps 
contained within the Scripted Let. The proper syntax for Extend is Extend 
“Variable Name”, Value.

• WeakExtend — sets the variable name to the specified value for all steps 
contained within the Scripted Let step if the specified variable does not 
already have a value. This is similar to a Let variable with Overridable 
selected. The proper syntax for WeakExtend is WeakExtend “Variable 
Name”, Value.

Note:  Refer to Section 17.9, Scripted Let Step, for information on configuring a 
Scripted Let step.

28.3 Scripting Data Sets
Note:  The information in this section requires an advanced skill level; it is not 
intended to offer instructions on learning VBScript. Scripting data sets is not 
supported by Beckman Coulter Service Engineers; however, information is available 
at http://msdn.microsoft.com/library/default.asp and in VBScript in a Nutshell: A 
Desktop Quick Reference, 2nd Edition, Matt Childs, Paul Lomax, and Ron Petrusha 
2003, O'Reilly & Associates, Inc.

Data from a reader or LIMS file in a .csv file format may be translated into a data set 
using scripting. The data sets created from scripting behave like any other data set 
created in the Create Data Set step, from sample IDs in the Instrument Setup step, 
or in the SILAS step.

The procedure (refer to Section 28.3.1, Procedure to Script Data Sets) to script data 
sets includes:

• Creating a new data set to hold imported data.

• Opening a .csv file.

• Translating data from a .csv file to a new data set called Sample ID.

• Placing the translated data (the new data set called Sample ID) into the new 
data set to hold imported data.
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28.3.1 Procedure to Script Data Sets
Execute the following script code:

' Create a new Data Set to hold our imported data.

Set DestinationDataSet = Labware("P5").DataSets.Add("SampleID")

' Create the Windows file system object. This object will allow us

' to find our data file on the disk.

Set FileSystemObject = CreateObject("Scripting.FileSystemObject")

' Check to see if the file is on the disk.

If Not FileSystemObject.FileExists("c:\demodata.csv") Then

' Call the system’s error creator. This will cause a sensible

' error message to be shown to the person running the method.

' The first parameter is an error code number. 500 was chosen

' because it is not already in use by Windows.

' The second parameter is the source of the error.

' The third parameter is the description of the error.

Err.Raise 500, "My Import Script", "File does not exist."

End If

' Open the data file.

Set FileStream = FileSystemObject.OpenTextFile("c:\demodata.csv")

' Loop over the rows in the file.

For i = 0 To 7

' Read a line out of the file.

RowLine = File.Stream.ReadLine

' Split the values in the line into an array of values, using

' the comma as a delimiter.

' Note that the array contains values 0, 1, ..., 11.

RowDataArray = Split(Rowline, ",")

' Loop over the columns in the row.

For j = 0 To 11

' Put the data from the array into our new Data Set.

' The expression "(i*12) + (j+1)" converts from the 0-based

' loop variables to well identifiers.

DestinationDataSet((i*12) + (j+1)) = RowDataArray(j)

Next ' end the column loop

Next ' end the row loop

' Close the file when we’re done.

FileStream.Close
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29 Changing Window Appearance

29.1 Overview
The Biomek main editor (Figure 29-1) contains the basic tools necessary to create and 
run methods; however, there may be times when additional tools are needed. To 
address this situation, steps and step palettes may be added to the main editor as 
necessary. These additional steps and step palettes provide more functionality when 
creating and running methods. By using Preferences (Figure 29-12) and Step 
Palette Builder (Figure 29-2), the look of the main editor can be changed to fit the 
needs of the laboratory.

Preferences is used to alter the Method View and change the size of the steps (or 
step buttons) in a step palette. For example, graph lines and + and - buttons may be 
added to the Method View (Figure 29-1), and toolbar and step palette positions may 
be saved automatically when the appropriate settings are checked in Preferences.

The Step Palette Builder allows the addition, removal, and manipulation of steps on 
the step palettes. Steps may be added to any step palette or combined into a new step 
palette. Individual devices, such as an incubator, operating with a SILAS module 
must be added to a step palette after the SILAS module has been installed so the 
device can be used in a method and controlled by Biomek Software.

Note:  The Current Deck Display can be manipulated like a toolbar, except it can 
be docked only below the user interface area.
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Figure 29-1.  Main editor for a Biomek FX

Method View
Preferences allows the 
Method View to be altered.

Two options selected in 
Preferences are displayed 
in this Method View:

Display graph lines 
between steps of a 
method in the Method 
View 
and
Display + and - buttons in 
the Method View when 
expanded or collapsed 
substeps are present in a 
method.
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Figure 29-2.  Step Palette Builder

Note:  The available step palettes in the Step Palette Builder are based on the 
instrument.

3000 — the Span-8 Step Palette is available because the Serial Dilution, 
Transfer from File, and Define Pattern steps may be used with the 
instrument.

Step Palette Builder
Allows the addition, removal, and 
manipulation of steps on the step 
palettes. A custom step palette may be 
created to display frequently used steps 
on a single palette.
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29.2 Changing Display Preferences
Preferences allows the main editor appearance to be customized. Preferences 
allows the customization of the main editor using options organized under General, 
View, and Errors.

To customize the appearance of the main editor:

1. Choose Options>Preferences.... Preferences appears (Figure 29-3).

Figure 29-3.  Preferences

2. Choose General to configure options concerning validating and saving methods 
(refer to Section 29.2.1, Configuring General Options).

OR

Choose View to configure options concerning the appearance of the Method 
View (refer to Section 29.2.2, Configuring View Options).

OR

Choose Errors to configure options concerning the notifications of errors (refer 
to Section 29.2.3, Configuring Errors Options).



Changing Window Appearance 29-5

Biomek Software User’s Manual

29.2.1 Configuring General Options
General options concern validating and saving methods.

To configure General options:

1. From Preferences, highlight General (Figure 29-3).

2. Check the desired options using Table 29-1.

3. Choose OK to save the checked options.

OR

Choose Cancel to cancel the checked options.

OR

Choose Reset to reset all customizations, including custom labware, toolbar/
palette organization, options chosen in Preferences, and position of the main 
editor.

Table 29-1.  General options
Option Description

Validate the current method 
before running it.

Simulates methods internally to test for 
errors before the method is run. If no 
errors are detected, the method is 
executed. If an error is detected, the 
process stops and an error message 
displays information about the error.

Ask for confirmation before 
removing a step from a method.

Displays a confirmation prompt when 
deleting a step from a method (Figure 29-
4). 

Automatically save all Editor 
settings listed below.

Automatically saves the following three 
settings. (Enabled by default.)

Save changes to the screen 
position of the Editor.

When checked, automatically saves the 
size and position of the editor on the 
screen. (Available when Automatically 
save all Editor settings listed below is 
not selected.)

Save changes to the toolbar 
and step palette layout of the 
Editor.

When checked, automatically saves 
toolbar and step palette size, arrangement, 
and location. (Available when 
Automatically save all Editor settings 
listed below is not selected.)
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Note:  When Automatically save all Editor settings listed below is not selected, 
and when Save changes to the screen position of the Editor, Save changes to 
the toolbar and step palette layout of the Editor, and Save changes to the 
steps configured within step palettes of the Editor are also not selected, the main 
editor opens at default size with the last saved configuration for the editor, toolbars, 
and palettes.

Figure 29-4.  Confirm to delete steps from a method

Save changes to the steps 
configured within step palettes 
of the Editor.

When checked, automatically saves steps 
on step palette (modified by Palette 
Builder).(Available when Automatically 
save all Editor settings listed below is 
not selected.)

Look ahead up to [1800] 
seconds in the method while it 
is running.

To prevent the system from bogging 
down due to unnecessary memory 
consumption, the software translate the 
steps of the method into “to do” lists of 
actions. This option prevents the software 
from bogging down by designating a 
length of time for suspending the 
translation process (refer to Section 
25.3.2.1, Using Look ahead up to [1800] 
seconds in the method while it is running).

Table 29-1.  General options (Continued)
Option Description
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29.2.2 Configuring View Options
View options concern the appearance of the Method View.

To configure View options:

1. From Preferences, highlight View (Figure 29-5).

Figure 29-5.  Preferences - View
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2. Check the desired options using Table 29-2.

3. Choose OK to save the checked options.

OR

Choose Cancel to cancel the checked options.

OR

Choose Reset to reset all customizations, including custom labware, toolbar/
palette organization, options chosen in Preferences, and position of the main 
editor.

Table 29-2.  View Options
Option Description

Use large icons in the Method 
View.

Displays text and icons in the Method 
View in a larger size. (Enabled by 
default.)

Use large icons and a caption 
for steps within a step palette.

Displays large icons with labels 
(descriptive text) under the steps on the 
step palettes. (Enabled by default.)

Use large icons and a caption 
for toolbar buttons.

Displays large toolbars with labels 
(descriptive text) when checked.

Display graph lines between 
steps of a method in the Method 
View.

Displays lines which connect steps in the 
Method View when checked.

Display + and - buttons in the 
Method View when expanded 
or collapsed substeps are 
present in a method.

Displays + and - in front of steps such as 
Loop which contain nested steps. Click 
the + or - to expand or collapse the main 
step.
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29.2.3 Configuring Errors Options
Error options concern the notifications of errors. An option to play a .wav file when 
an error occurs is available while another option allows a program, such as an .exe 
file, to be run when an error occurs.

To configure Errors options:

1. From Preferences, highlight Errors (Figure 29-6).

Figure 29-6.  Preferences - Errors

2. Choose Play a sound on errors during runs to run a .wav file when an error 
message appears.

3. In Play this sound, use Browse to find the desired .wav file.

4. Choose the desired .wav file. The desired file appears in Play this sound.

5. From Play the sound, choose one of the following options from the drop-down 
menu to play the sound the desired number of times when an error message 
appears:

• once

• twice

• three times

• repeatedly until dismissed
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6. From intervals, choose one of the following options from the drop-down menu 
to play the sound at the desired intervals when an error message appears:

• 10 second

• 1

• 5

• 30

• 1 minute

• 5 minute

7. Choose Launch a program on errors during runs to run an .exe file when 
an error message appears.

8. In Launch this program, use Browse to find the desired .exe file.

9. Choose the desired file. The desired file appears in Launch this program.

10. In Send these parameters, enter the desired parameters using the information 
displayed in Figure 29-7.

Note:  Choose click here to display Parameter Information (Figure 29-7). 
Choose OK to close Parameter Information. Highlighting the Parameter and 
Value and choosing OK does not enter the desired parameter; the desired 
parameters must be manually entered in Send these parameters.

Figure 29-7.  Parameter Information

11. In Start in this directory, use Browse to start browsing in the desired directory.

12. From If a window appears, start in this state, choose one of the following 
options from the drop-down menu to display the style of the program:

• Don’t care — the message appears in the default style of the program.

• Maximize — the message appears in the maximized state of the program.

• Minimize — the message appears in the minimized state of the program.

13. Choose OK to save the checked options.

OR

Choose Cancel to cancel the checked options.

OR

Choose Reset to reset all customizations, including custom labware, toolbar 
organization, options chosen in Preferences, and position of the main editor.
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29.3 Toggling Toolbars and Step Palettes
The Biomek main editor provides toolbars and step palettes to allow quick access to 
method-building tools. Descriptions of the options in Toolbars are shown in Table 
29-3.

To toggle toolbars and step palettes on and off:

1. Choose Options>Toolbars. A submenu appears listing the toolbars and step 
palettes (Figure 29-8).

Figure 29-8.  Options for step palettes and toolbars

Note:  The available step palettes in the Step Palette Builder are based on the 
instrument.

3000 — the Span-8 Step Palette is available because the Serial Dilution, 
Transfer from File, and Define Pattern steps may be used with the 
instrument.

Note:  Any custom step palettes created with the Step Palette Builder also 
appear in the submenu (refer to Section 29.5.4, Creating a New Step Palette).

OR

Right-click in a gray area around the toolbars or step palettes. A menu listing 
only the step palettes appears (Figure 29-9). 

Figure 29-9.  Step palette menu for a Biomek FX

Note:  The step palette menu is based on the instrument; for example.

Note:  Any custom step palettes created with the Step Palette Builder also 
appear in the submenu (refer to Section 29.5.4, Creating a New Step Palette).
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2. Choose the desired toolbar or step palette to toggle it on or off. The 
corresponding toolbar or step palette appears or is hidden from view.

Note:  A check to the left of a toolbar or step palette in Options>Toolbars 
indicates that it is currently displayed.

Note:  Use the Step Palette Builder as an alternative method for displaying and 
hiding step palettes (refer to Section 29.5.2, Displaying and Hiding Step 
Palettes).

Table 29-3.  Toolbar Options
Option Description

Advanced Toggles on or off the Advanced Step 
Palette.

Basic Toggles on or off the Basic Step 
Palette (Figure 29-10).

Biomek3000 Toggles on or off the Biomek 3000 
Step Palette.

Deck Display Toggles on or off the Deck Display 
(Figure 29-10).

Devices Toggles on or off the Devices Step 
Palette.

Execution Toggles on or off the part of the 
toolbar that is associated with the 
running of methods (Figure 29-10).

Files Toggles on or off the part of the 
toolbar that is associated with the 
building of methods (Figure 29-10).

Intermediate Toggles on or off the Intermediate 
Step Palette.

Method Error Toggles on or off the description of 
errors (Figure 29-10).

Span-8 Toggles on or off the Span-8 Step 
Palette.

3000 — the Span-8 Step 
Palette is available because 
the Serial Dilution, 
Transfer from File, and 
Define Pattern steps may 
be used with the instrument.

Specialty Toggles on or off the Specialty Step 
Palette.

StackerCarousel Toggles on or off the Stacker 
Carousel Step Palette.
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Figure 29-10.  Main editor with default toolbar options displayed

Execution
Not displayed when deselected 
from Options>Toolbars.

Files
Not displayed when deselected 
from Options>Toolbars.

Deck Display
Not displayed when deselected 
from Options>Toolbars.

Method Error
Displays details of error. 
Not displayed when 
deselected from 
Options>Toolbars.

Basic
Not displayed when 
deselected from 
Options>Toolbars.
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29.4 Customizing Step Palettes
Customize a step palette to add custom steps, change the view of the step palettes, or 
modify tool tips and labels of any step. 

29.4.1 Displaying Large Step Palette and Toolbar 
Views

Labels for toolbars and step palettes can be displayed using Preferences. The Large 
Step Palette View and the Large Toolbar View display labels for the steps and 
tools (Figure 29-11).

Figure 29-11.  Step palette views with and without labels

Small Step Palette View

Large Step Palette View
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To toggle the step palette view:

1. Choose Options>Preferences>View. Figure 29-12 appears.

Figure 29-12.  Preferences — main editor setting options

2. Choose Use large icons and a caption for steps within a step palette to 
toggle the step labels (Figure 29-12).

Note:  The default for Use large icons and a caption for steps within a step 
palette is On.

3. Choose Use large icons and a caption for toolbar buttons to toggle the 
toolbar labels.

Note:  The default for Use large icons and a caption for toolbar buttons is 
Off.

4. Choose OK.
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29.4.2 Changing Step Properties
Change the properties associated with each step to make the step purpose easier to 
identify, or to distinguish custom, configured steps from standard steps. Each step has 
three properties:

• Tool Tip — brief tip on the steps usage that displays when the mouse pointer 
hovers over the step.

• Label — text describing operations of a step.

• Bitmap — graphic displayed on the step button.

To change step properties:

1. On the step palette, right-click on the desired step.

2. Choose Properties. Step Properties appears (Figure 29-13).

Figure 29-13.  Step Properties

3. In Tool Tip, enter a new Tool Tip.

4. In Label, enter a new Label.

5. In Bitmap, choose a different graphic for the step button by clicking on Browse, 
and selecting the desired bitmap.

6. Choose Open to accept the new bitmap and return to Step Properties.

7. Choose OK to save changes to the Step Properties and return to the main editor.

Browse
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29.4.3 Modifying a Step Caption in Method View
A step caption may be modified in the Method View. This allows differentiation of 
the steps by their captions.

To change a step caption in the Method View:

1. Highlight the desired step in the Method View.

2. Right-click on the step to open a menu.

3. Select Change Caption. Edit Step Caption appears (Figure 29-14).

Figure 29-14.  Change the step caption in Edit Step Caption

4. Enter the new step caption for the step.

5. Choose OK. The new caption appears at the appropriate spot in the Method 
View.

Figure 29-15.  Modified step caption in Method View

Step caption entered 
in Edit Step Caption 
is now shown in 
Method View.
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29.5 Using the Step Palette Builder
The Step Palette Builder is used to create, delete, and modify step palettes. If a step 
is no longer needed on a step palette, it can be removed easily with the Step Palette 
Builder.

Use the Step Palette Builder to:

• Display a step palette.

• Hide a step palette.

• Add steps.

• Remove steps.

• Rearrange steps.

• Create a step palette.

• Modify step palette properties.

• Delete a step palette.
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29.5.1 Accessing the Step Palette Builder
To access the Step Palette Builder: 

Choose Options>Palette Builder....Step Palette Builder appears 
(Figure 29-16).

OR

1. Right-click in a gray area around the toolbars or step palettes. A menu listing 
available step palettes appears (Figure 29-9).

2. Choose Palette Builder....Step Palette Builder appears (Figure 29-16).

Figure 29-16.  Step Palette Builder

Note:  The Step Palette Builder is based on the instrument.

3000 — the Span-8 Step Palette is available because the Serial Dilution, 
Transfer from File, and Define Pattern steps may be used with the 
instrument.
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29.5.2 Displaying and Hiding Step Palettes
Display and hide step palettes using the Step Palette Builder.

To display or hide a step palette:

1. Choose Options>Palette Builder....Step Palette Builder appears (Figure 29-
16).

OR

Right-click in a gray area around the toolbars or step palettes. A menu listing 
available step palettes appears (Figure 29-9). Choose Palette Builder....Step 
Palette Builder appears (Figure 29-16).

2. In the Step Palette Builder, click on the check box to the left of the desired 
palette to toggle the display on and off. 

3. Choose OK. The selected step palettes are displayed or hidden from the Biomek 
main editor.

Note:  As an alternative method for toggling a step palette on or off, use the 
Options>Toolbars menu (refer to Section 29.3, Toggling Toolbars and Step 
Palettes). This alternative method is available only when Palette Builder is not 
open.

29.5.3 Customizing Step Palettes
There are two main sources for steps added to step palettes:

• With Step Palette Builder not open, steps can be moved from the Method 
View onto a step palette.

• With Step Palette Builder open, steps can be moved from the Step Palette 
Builder to a step palette or moved between palettes.

Note: In order to use a SILAS module, such as the bar code reader, it must 
be placed on a step palette.
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29.5.3.1 Adding Non-Configured Steps to a Step Palette
To add steps to a step palette:

1. Choose Options>Palette Builder....Step Palette Builder appears (Figure 29-
16).

OR

Right-click in a gray area around the toolbars or step palettes. A menu listing 
available step palettes appears (Figure 29-9). Choose Palette Builder....Step 
Palette Builder appears (Figure 29-16).

2. Choose the Steps tab (Figure 29-17).

Figure 29-17.  Step Palette — Steps tab

3. In Categories, choose the desired category of steps. Steps from the selected 
category appear on the right side of the Step Palette Builder.

Note:  Multiple selections can be highlighted at once in the Steps tab by holding 
down Ctrl or Shift.

4. Drag the desired step from Steps to a step palette on the main editor. The step is 
added to the step palette.

OR

Drag the desired step from one palette to another on the main editor.

5. From the Step Palette Builder, choose OK.

Categories
Each category 
available for 
placement on step 
palettes consists of 
steps from 
predefined groups 
and installed SILAS 
modules.
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29.5.3.2 Adding Configured Steps to a Step Palette
If a step configuration used in a method is to be used several times in various 
methods, add it to a step palette to save time during the method building process. By 
adding a configured step, any subsequent uses of the same configuration are added to 
a method easily.

To add configured steps to a step palette:

1. Configure the step in the Method View.

2. Highlight the step to add to the step palette.

3. Drag the step to the desired step palette. The addition of the step must be 
confirmed before it is added to the palette (Figure 29-18).

Figure 29-18.  Confirmation for adding a step to a step palette

29.5.3.3 Rearranging Steps on a Step Palette
To rearrange steps on a step palette:

1. Choose Options>Palette Builder....Step Palette Builder appears (Figure 30-
12).

OR

Right-click in a gray area around the toolbars or step palettes. A menu listing 
available step palettes appears (Figure 29-9). Choose Palette Builder....Step 
Palette Builder appears (Figure 29-16).

2. Drag and drop the desired step on the step below the desired location on the 
palette. The step inserts itself above the step on which it was dropped.

3. From the Step Palette Builder, choose OK.

29.5.3.4 Removing Steps From a Step Palette
Remove steps no longer needed to keep step palettes manageable.

To remove steps from a step palette:

1. Choose Options>Palette Builder....Step Palette Builder appears 
(Figure 29-16).

OR

Right-click in a gray area around the toolbars or step palettes. A menu listing 
available step palettes appears (Figure 29-9). Choose Palette Builder.... Step 
Palette Builder appears (Figure 29-16).

2. Drag and drop the desired step to a location where a step palette is not present.

3. From the Step Palette Builder, choose OK.
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29.5.4 Creating a New Step Palette
Create custom step palettes to display frequently used or commonly used configured 
steps on a single palette.

To create a step palette:

1. Choose Options>Palette Builder....Step Palette Builder appears 
(Figure 29-16).

OR

Right-click in a gray area around the toolbars or step palettes. A menu listing 
available step palettes appears (Figure 29-9). Choose Palette Builder....Step 
Palette Builder appears (Figure 29-16).

2. Choose New. A new step palette appears in the upper left corner of the main 
editor (Figure 29-19).

Figure 29-19.  New Step Palette

3. Change the new palettes properties (refer to Section 29.5.5, Modifying Step 
Palette Properties).

4. Add steps to the step palette (refer to Section 29.5.3.1, Adding Non-Configured 
Steps to a Step Palette).

5. From the Step Palette Builder, choose OK.

29.5.5 Modifying Step Palette Properties
The Step Palette Properties is the Name of the palette that appears in the Step 
Palette Builder and in Options>Toolbars.

To change a step palettes properties:

1. Choose Options>Palette Builder....Step Palette Builder appears 
(Figure 29-16).

OR

Right-click in a gray area around the toolbars or step palettes. A menu listing 
available step palettes appears (Figure 29-9). Choose Palette Builder....Step 
Palette Builder appears (Figure 29-16).

2. Select the desired palette.

3. Choose Properties.... Palette Properties appears (Figure 29-20).

Figure 29-20.  Palette Properties
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4. Type a descriptive name for the step palette.

Note:  All alphanumeric and non-alphanumeric characters are allowed in palette 
names.

5. From Palette Properties, choose OK to save the name.

6. From Step Palette Builder, choose OK.

29.5.6 Deleting a Step Palette
Delete any step palettes that are no longer needed.

To delete a step palette:

1. Choose Options>Palette Builder....Step Palette Builder appears (Figure 29-
16).

OR

Right-click in a gray area around the toolbars or step palettes. A menu listing 
available step palettes appears (Figure 29-9). Choose Palette Builder....Step 
Palette Builder appears (Figure 29-16).

2. Select the desired palette.

3. Choose Delete. The step palette is removed from the main editor.

Note:  Deleting a step palette cannot be undone. There is no confirmation for 
deleting a step palette. If a step palette is accidentally deleted, choose Cancel in 
Step Palette Builder.

4. Choose OK.
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using 13-1, 13-6
using in the Data Set Processing Step 24-24

external devices
configuring labware for 22-7
setting attributes 22-7
using SILAS Module 22-7
using SILAS Module Step to 

configure 22-39
using with Biomek FX 22-7

F
File Options

configuring in Create Data Set Step 24-4
File Properties

configuring in Transfer From File 
Step 18-47

Finish Step 12-7
clearing devices of labware 12-9
clearing global variables 12-10
clearing instrument of labware 12-9
configuring 12-7
configuring a report in 12-11
defined 12-4
unloading and washing tips 12-9

Follow Liquid
defined 9-11
defined in Transfer Step 12-14

framing (teaching)
reasons for 5-3

G
Group Step

advantages to using 16-35
configuring 16-36
defined 16-2, 16-35
inserting into method 16-35

groups
creating technique 9-39
using in a method 21-9

H
Hardware Setup

accessing 4-2
overview 4-1
understanding the options in 4-3
using Accept in 4-3
using Add Device in 4-3
using Cancel in 4-3
using Home All Axes in 4-3
using Reconnect in 4-3
using Remove Device in 4-3

HDR Combine Step
configuring destination labware 19-13
configuring source labware 19-7
defined 19-3
inserting into method 19-4
using 19-3
washing pins in 19-6

HDR Move Labware Step
configuring 19-30, 19-31
defined 19-30
inserting into method 19-30
using 19-30

HDR pins
defining wash procedure 19-6
washing between transfers 19-6

HDR Step Palette
displaying 19-2

HDR steps
defined 19-1

HDR System
operating in software 19-1
using in a method 19-1

HDR Tool Cleaning Step
cleaning operations 19-21

configuring drying operations 19-27
configuring wash operations 19-22

inserting into method 19-20
using 19-20

HDR Transfer Step
configuring destination labware 19-13
configuring source labware 19-7
defined 19-3
inserting into method 19-4
using 19-3
washing pins in 19-6
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history
printing validated method run 

history 12-28, 12-29
viewing method revision 12-27

Home All Axes 4-3

I
If Step

configuring 17-14
defined 17-2, 17-13
inserting into method 17-13
substeps of 17-13
using in pipetting template 10-17

ignore
choosing to 25-14
how to 25-14

import
methods into projects 12-37

Import File
exporting setting to 3-7
importing settings from 3-9

Import/Export Utility
sharing instrument settings 3-6

importing
project files 6-22

Input Options
configuring in Create Data Set Step 24-9
matching plate bar code and well 

number 24-11
matching sample IDs 24-12

instrument file
definition 1-1
restoring settings 3-5
settings 3-1

Instrument Setup Step
changing during a method 15-11
defined 15-1
using additional 15-11

Intermediate Step Palette
displaying 16-3
overview 16-1
steps displayed on 16-1

J
Just In Time (JIT) Step

configuring 17-10
defined 17-1, 17-9
inserting into method 17-10

L
labware

category defined 15-10
changing colors in Labware Type 

Editor 7-16
changing type properties in Labware Type 

Editor 7-14
copying a type in Labware Type 

Editor 7-11
creating custom 15-26
defining in Labware Type Editor 7-9
defining new types in Labware Type 

Editor 7-10
deleting a type in Labware Type 

Editor 7-12
populating deck with 15-9
properties 15-15
renaming a type in Labware Type 

Editor 7-13
specifying stackable items in Labware 

Type Editor 7-21
Labware Category

Any defined 15-10
Custom defined 15-10
Lid defined 15-10
Reservation defined 15-10
Reservoir defined 15-10
TipBox defined 15-10
Titerplate defined 15-10
Tuberack defined 15-10

Labware Properties
accessing 15-15, 23-6
accessing in Device Setup step 22-11
configuring for microplates 15-18
configuring for reservoirs 15-18
configuring for tube racks 15-18
configuring in Device Setup step 22-13
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Known Volume defined 15-18, 22-14, 
23-10

Nominal Volume defined 15-18, 22-14, 
23-10

Unknown Volume defined 15-18, 22-14, 
23-10

Labware Type Editor
accessing 7-9
adding a new labware type in 7-10
categories in 7-14
changing colors of labware in 7-16
configuring a reservoir with added 

sections 7-18
configuring well properties in 7-26
copying a labware type in 7-11
deleting a labware type in 7-12
editing labware type properties in 7-14
overview 7-1
renaming a labware type in 7-13
specifying stackable items in 7-21
using Secure Stacking in 7-24

Let Step
configuring 17-12
defined 17-1, 17-11
inserting into method 17-12

Liquid Level Sensing (LLS)
defined 9-22, 9-27
errors

Liquid Level is Incompatible with the 
Operation 25-20

Liquid Level Sensing Returning an 
Unstable Value 25-19

No Liquid is Detected 25-19
overview 25-18
recovering from 25-18

sensitivity defined 8-6, 9-23, 9-27
Liquid Type Editor

accessing 8-4
configuration view 8-2
cutoff velocity

defined 8-5
defined 8-1
liquid type view 8-2
overage

defined 8-5

sensitivity
defined 8-6

using the 8-3
liquid types

copying/pasting in Liquid Type Editor 8-10
creating new 8-1
creating new in Liquid Type Editor 8-4
default 8-1
defined 8-3
overriding values using Technique 

Editor 9-30
removing/deleting from Liquid Type 

Editor 8-10
setting default type in Liquid Type 

Editor 8-11
understanding 8-1

ListMath
defined 10-15
using in pipetting template steps 10-16

Load Tool Step
configuring 20-5
defined 20-1

log types 26-1
Details log

contents 26-6
defined 26-1
overview 26-3

Errors log
contents 26-6
defined 26-1
overview 26-4

Pipetting log
contents 26-7
defined 26-1
overview 26-4

Span-8 Pipetting log
contents 26-7
defined 12-58, 26-1
overview 26-4

Span-8 Transfer log
contents 26-8
defined 12-58, 26-1
overview 26-5

Unified Pipetting log
contents 26-9
defined 26-2
overview 26-5
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Unified Transfer log
contents 26-11
defined 26-2
overview 26-5

logging
configuring 12-58
defined 12-58
using 12-58

logging off system 2-11
logging onto system 2-9
logs

content 26-6
defined 26-1
generating 26-13
generating data 26-1
selecting to generate 26-13
viewing 26-14

Look ahead up to 1800 seconds in the method 
while it is running
defined 25-8
enabling 25-8

Loop Step
configuring 16-24
creating a new variable in 16-24
defined 16-2, 16-23
End 16-23
incrementing 16-24
inserting into method 16-23
using existing variable in 16-27
using in pipetting template 10-17
using variables in 16-25
variables defined in 16-23

M
main editor

changing appearance of 29-1
displaying Step Palettes 29-11
toggling toolbars 29-11

Manual Control
accessing 27-2
defined 27-1
dialog display 27-1, 27-2

method 12-1
checking in a 12-22
checking out a 12-32
copying steps in a 12-16
creating a new 12-3

creating techniques within 9-45
cutting steps in a 12-16
defined 1-2
deleting steps in a 12-17
exporting all associated with a project 

file 12-36
exporting the currently open 12-35
halting without light curtain 

violation 12-51, 25-23
importing into projects 12-37
improving way method is run 12-56
inserting steps in a 12-13
modifying techniques through steps 9-45
opening a saved 12-30, 12-40, 12-41
opening a validated 12-31, 12-33
pasting steps in a 12-16
printing 12-28, 12-29
printing a hardcopy of 12-55
purging air before a run with a Span-8 

Pod 12-54
running at slow speed 12-56
saving a 12-20
scripting in 28-1
signing 12-26
stopping a 12-52, 25-24
using groups in 21-9
using Redo when building a 12-18
using Undo when building a 12-18
using variables in 13-4
validating 12-24
validating before a run 25-6
viewing revision history 12-27

Microplate Shaking ALP
configuring in Device Action Step 22-25

Mix
defined 9-11
defined in Transfer Step 12-14

Mix Step
configuring 16-15
defined 16-1, 16-14
inserting into method 16-15
inserting into pipetting templates 10-28
pipetting templates

configuring 10-28
defined 10-28
inserting 10-28
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Move Labware Step
configuring 15-56, 15-57
defined 15-1, 15-56
inserting into method 15-56

Move Pod Step
configuring 16-34
defined 16-2
inserting into method 16-33

Multiple Dispense
conditioning techniques for 9-36
conditioning volumes defined 9-37

N
New Tips Step

defined 16-2, 16-19
inserting into method 16-20
when to use 16-19

Next Item Step
breaking out of current loop 21-15
configuring 21-14
defined 21-1
inserting into method 21-14
setting variable to value 21-15
starting over with first value 21-15
using 21-13

Next Labware Step
configuring 21-7
defined 21-1
inserting into method 21-7
using 21-7

O
Obstacle Avoidance 15-3
offsets

changing per-labware 5-21
Output Options

configuring in Create Data Set Step 24-13
setting data set properties 24-15

overage
defined 8-5

P
Passive Wash

defined 18-35
patterns

using in Transfer or Combine Steps 18-69

Pause Step
configuring 15-61
configuring for a pod 15-60
configuring for specific deck 

position 15-60
defined 15-2, 15-58
inserting into method 15-59
inserting into pipetting templates 10-34
pausing whole system 15-61
pipetting templates

configuring 10-34
defined 10-34
inserting 10-34

pausing
a specific deck position 15-60
pod 15-60
the whole system 15-61
without light curtain violation 12-51, 

25-23
per-labware offset

changing 5-21
Per-Plate HTML Files report style

choosing 24-26
Per-Plate Text Files report style

choosing 24-26
Piercing 9-29
Pipetting log

contents 26-7
defined 26-1
overview 26-4

Pipetting Technique
selecting a 12-14

Pipetting Template Editor
accessing 10-2
Aspirate Air Gap Step

configuring 10-18, 10-20
defined 10-20
inserting into pipetting template 10-20
using in pipetting template 10-20

Axes Move Step
configuring 10-33
defined 10-33
inserting into pipetting template 10-33

Bulk Dispense Step
configuring 10-35
defined 10-35
inserting into pipetting template 10-35
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Clot Detection Step
configuring 10-18

Dispense Air Gap Step
configuring 10-24
defined 10-24
inserting into pipetting template 10-24

Moving Aspirate Step
configuring 10-22
configuring final position 10-23
configuring initial position 10-23
defined 10-22
inserting into pipetting template 10-22

Moving Dispense Step
configuring 10-26
configuring final position 10-27
configuring initial position 10-27
defined 10-26
inserting into pipetting template 10-26

overview 10-1
Prewet Step

configuring 10-30
defined 10-30
inserting into pipetting template 10-30

Tip Touch Step
configuring 10-31
defined 10-31
inserting into pipetting template 10-31

pipetting templates
associating with technique 10-5
configuring steps in 10-2, 10-17
context variable reference 10-10
context variables in 10-8
copying and pasting 10-7
creating 10-2
creating new 10-4
default 10-1
defined 10-1
defining context variables 10-10
inserting variables 10-8
liquid type context information 10-11
modifying existing 10-7
renaming 10-7
understanding context variables 10-8
using Aspirate Air Gap Step in 10-20
using Aspirate Step in 10-21
using Axes Move Step in 10-33

using Bulk Dispense Step in 10-35
using Comment Step in 10-17
using Dispense Air Gap Step in 10-24
using Dispense Step in 10-25
using If Step in 10-17
using ListMath in 10-16
using Loop Step in 10-17
using Mix Step in 10-28
using Moving Aspirate Step in 10-22
using Moving Dispense Step in 10-26
using Pause Step in 10-34
using Prewet Step in 10-30
using Tip Touch Step in 10-31
viewing existing 10-3

pod
Home All Axes 4-3
setup options 15-7

Pod Setup Options 15-7
Positive Position ALP

configuring in Device Action Step 22-28
Preferences

accessing 29-4
using to change main editor 

appearance 29-1
Present Step

configuring bar code reading 
instructions 23-12

configuring from which hotel 23-12
Present step

defined 23-1
Prewet

defined 9-11
defined in Transfer Step 12-14

printing
hardcopy of method 12-55

Procedures
advantages of using 21-18
collapsing 21-18
defining 21-18
expanding 21-18
running 21-18

project file
importing 6-22
renaming the active file 6-8
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project files
checking in 6-11
contents of 6-3
creating copies of 6-10
creating new 6-4
defined 1-2
deleting 6-6
discarding all changes since last check 

in 6-17
exporting 6-20
exporting all methods associated 

with 12-36
opening 6-5
overview 6-1
renaming saved files 6-9
restoring deleted 6-7
restoring deleted project items 6-14
reverting individual project items to a 

specific revision 6-19
reverting project contents to a previous 

state 6-15
viewing contents 6-13

Purge Wash Tool Step
configuring 20-13
defined 20-2

R
Reconnect

using in Hardware Setup 4-3
Redo

using in method building 12-18
Remove Device

using in Hardware Setup 4-3
Remove to Waste Step

defined 20-1
Remove to Waste step

configuring 20-8
report styles

Per-Plate HTML Files
choosing 24-26
description 24-27

Per-Plate Text Files
choosing 24-26
description 24-28

SQL Server
choosing 24-26
configuring 24-26
description 24-28

Text File
choosing 24-26
description 24-26

types 24-26
Reporting step

configuring 24-25
overview 24-25

reservoirs
configuring with sections in Labware Type 

Editor 7-18
restoring

deck display 29-12
instrument settings 3-5
instrument settings from backup files 3-10
project items 6-14

retry
choosing to 25-14
how to 25-14

revisions. See check in
Run Method Step

advantages to using 17-4
configuring 17-5
defined 17-1, 17-4
inserting into method 17-5

Run Procedure Step
configuring 21-20
defined 21-2
inserting into method 21-20
using 21-20

Run Program Step
configuring 21-11
defined 21-1
inserting into method 21-10
using 21-10

Runtime Data
configuring 22-41
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S
sample IDs

matching in data sets 24-12
sample tracking

definition 14-1
example using data sets 14-2
overview 14-1

Script Step
configuring 17-17
defined 17-2, 17-15
inserting into method 17-16

Scripted Let Step
configuring 17-20
defined 17-18
Extend defined 17-18, 28-2
extending variables 17-18
inserting into method 17-19
WeakExtend defined 17-18, 28-2

scripting
data sets 28-1, 28-2
in methods 28-1

Secure Stacking
configuring 7-25
stacking rules in 7-24
using 7-24

sensitivity
defined 8-6

Serial Dilution Step
collapsing diluent properties 18-12
configuring 18-6
defined 18-1
dilution ratio defined 18-13
expanding diluent properties 18-12
inserting into method 18-5

Set Global Step
configuring 21-16
defined 21-2
inserting into method 21-16
using 21-16

signing methods 12-26
SILAS messages

creating data sets from 22-42
SILAS Module Step

configuring 22-39
configuring runtime data 22-41
defined 22-2
inserting into method 22-39

Single Step
defined 25-30
example 25-30
opening 25-30
running 25-31

slope
calibration 9-35, 9-38

snap
choosing to 25-10, 25-14
how to 25-14

Snap Continuation
using 12-57

snapping a Continuation 12-57
source labware

configuring in Combine Step 15-35
configuring in HDR Combine Step 19-7, 

19-14
configuring in HDR Transfer Step 19-7, 

19-14
configuring in Transfer From File 

Step 18-51
configuring in Transfer Step 15-35, 15-45

Source/Waste Sensor
configuring Device Action step 22-29

Span-8 Aspirate Step
aspirating individual volumes 18-20
configuration 18-16
configuring 18-18
defined 18-1
inserting into method 18-17

Span-8 Dispense Step
configuring 18-25
defined 18-2, 18-23
dispensing individual volumes 18-27
included in configuration 18-23
inserting into method 18-24

Span-8 New Tips Step
configuring 18-32
defined 18-2, 18-31
inserting into method 18-31

Span-8 Pipetting log
contents 26-7
defined 12-58, 26-1
overview 26-4
sample IDs added to 26-4, 26-5
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Span-8 Pod
purging air from the syringes and 

tubing 12-54
Span-8 Step Palette

defined 18-1
displaying 18-3
steps displayed on 18-1

Span-8 Tip Discard Step
configuring 18-34
defined 18-2
inserting into method 18-33
when to use 18-33

Span-8 Transfer log
defined 12-58, 26-1
overview 26-5

Span-8 Wash Tips Step
Active Wash

configuring 18-39
defined 18-39

configuring a passive wash 18-36
configuring an active wash 18-39
defined 18-2
included in configuration 18-35
inserting into method 18-36
Passive Wash

configuring 18-37
defined 18-36
using to purge system 18-37

SPE (Solid Phase Extraction) ALP
defined 22-4

SPE Step
configuring 22-5
defined 22-1, 22-4
inserting into method 22-5

Specialty Step Palette
displaying 21-3
overview 21-1

Specialty Steps
defined 21-1

Speed Pump
configuring in Device Action Step 22-30

SQL Server report style
configuring 24-29

Stacker Carousel Step Palette
displaying 23-2
overview 23-1

Stacker Carousel, Biomek instrument
using the Present Step with 23-12
using the Stacker Setup Step with 23-3
using the Store Step with 23-14

Stacker Setup Step
configuring 23-3
defined 23-1

Start Step
configuring 12-4
defined 12-4
using 12-4

Step Palette Builder
accessing 29-19
using 29-18

Step Palettes
adding configured steps 29-22
changing properties of 29-23
creating 29-20
creating new 29-23
customizing 29-14, 29-20
deleting 29-24
modifying 29-18
rearranging steps on 29-22
removing steps from 29-22
toggling 29-11

steps
adding to Step Palettes 29-22
changing properties for identification on 

Step Palettes 29-16
copying 12-16
cutting 12-16
deleting 12-17
disabling 12-53
enabling 12-53
modifying caption in Method View 29-17
modifying techniques through 9-45
pasting 12-16
rearranging on Step Palettes 29-22
removing from Step Palettes 29-22

Stirring ALP
configuring in Device Action Step 22-31

Store Step
configuring 23-14
defined 23-1
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submethod
defined 17-4

syringes
cutoff velocity 9-32

T
teaching (framing)

reasons for 5-3
Technique Browser

accessing 9-3
Technique Editor

Aspirate tab 9-12
Calibration tab 9-34, 9-35, 9-37, 9-38
Dispense tab 9-14, 9-15
General tab 9-11
Liquid Level Sensing tab 9-19
Liquid Type tab 9-30, 9-31
Mix tab 9-17
setting values 9-9

Technique Properties
setting 9-7

Techniques
associating pipetting template with 10-5
auto-selection of 15-42, 15-51
calibrating 9-34
conditioning 9-36
context information defined 9-4
creating groups 9-39
creating new 9-5
creating within a method 9-46
customizing 15-43, 15-51
defined 9-1, 12-14
displaying available 9-4
how they work 9-1
icons defined 9-11
identifying 9-4
liquid level sensing

error handling settings 9-23
general settings 9-20, 9-26
repetition settings 9-21
sensitivity settings 9-22, 9-27

modification restrictions 9-45
modifying through a method step 9-46
operation icons 9-11
overriding liquid type values 9-30
properties 9-5

removing/deleting 9-43
saving 15-43, 15-51
saving custom 9-48
selecting a pipetting 12-14
selecting manually 9-45
selection in Combine Step 15-41
selection in Transfer From File Step 18-53
selection in Transfer Step 15-41
selection within a method 9-46
setting aspirate values 9-12
setting clot detection values 9-25
setting dispense values 9-14
setting liquid level sensing values 9-19, 

9-25, 9-29
setting mix after dispense values 9-16
setting mix before aspirate values 9-14
setting mix values 9-17
setting piercing values 9-29
setting properties 9-7
setting values for 9-9
setting values in Technique Editor 9-9
understanding 9-1
viewing description 9-10
viewing properties of 9-4
why they are valuable 9-2

Techniques, Modifying Saved 9-44
text file

reading from to create data sets 24-4
Text File report style

choosing 24-26
Then

If Step substep 17-13
Tip Discard Step (Span-8 Pod)

configuring 18-34
Tip Handling

configuring in Combine Step 15-30
configuring in Transfer From File 

Step 18-43
configuring in Transfer Step 15-30

Tip Loader ALP step
defined 22-2

Tip Loader Step
configuring 22-38
defined 22-37
inserting into method 22-37
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tip properties
configuring in Device Setup step 22-11

Tip Touch
defined 9-11
defined in Transfer Step 12-14

Tip Type Editor
accessing 7-4
adding new tips in 7-5
changing tip properties in 7-6
overview 7-1
removing tips in 7-8

tips
accessing properties 15-15
adding new in Tip Type Editor 7-5
capacity diagram 7-7
changing properties in Tip Type Editor 7-6
defining in Tip Type Editor 7-3
properties defined 7-6
properties diagram 7-7
properties displayed in Tip Type Editor 7-4
removing from type list in Tip Type 

Editor 7-8
type list displayed 7-4

Toggle
defined 15-11
using 15-12

toolbars 29-11
options 29-12
toggling 29-11

Trailing Air Gap
defined 9-11
defined in Transfer Step 12-14

Transfer Details
configuring in Combine Step 15-53
configuring in Transfer From File 

Step 18-62
configuring in Transfer Step 15-53

Transfer From File Step
configuring destination labware 18-55
configuring file properties 18-47
configuring source labware 18-51
configuring tip handling in 18-43
configuring transfer details 18-62
defined 18-2
inserting into method 18-42

Transfer Step
configuring destination labware 15-44
configuring source labware 15-35
configuring Tip Handling 15-30
configuring Transfer Details 15-53
defined 15-1
four functions in 15-29
inserting into method 15-30
overview 15-29
selecting a pipetting technique 12-14
Span-8 Pod

using defined patterns 18-69

U
Undo

using in method building 12-18
Unified Pipetting log

contents 26-9
defined 26-2
overview 26-5

Unified Transfer log
contents 26-11
defined 26-2
overview 26-5

Unload Tips Step
defined 16-21
inserting into method 16-22
when to use 16-21

Unload Tips Step (Multichannel Pod)
defined 16-2

Unload Tool Step
configuring 20-7
defined 20-1

V
Validate Before Run

defined 25-6
enabling 25-8

validated methods
opening 12-31, 12-33
printing run history 12-28, 12-29

validating methods 12-24
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variables
advantages to using 13-1
configuring 12-4, 13-3
context

defining 10-10
table of 10-12
understanding 10-8

creating in Loop step 16-24
creating in the Start Step 12-4
defined 13-1
defined in Loop Step 16-23
defined in Run Method 13-3
extended from Scripted Let step 17-20
inserting into pipetting templates 10-8
naming restrictions 12-6
using 13-1, 13-2
using an existing variable in Loop 

Step 16-27
using for aspirate 13-2
using in a method 13-4
using in Loop Step 16-25
using in Transfer From File Step 18-57
using in Transfer Step 15-50

Volume data set
understanding 14-3

volumes
specifying with data sets 14-8

W
Warnings

defined v
listed ix

Wash Plate Step
configuring 20-15
defined 20-2

Wash Step
configuring 16-18
defined 16-1, 16-17
inserting into method 16-17

Well Pattern Editor
accessing 11-2
copying a well pattern in 11-5
creating a new well pattern in 11-3
deleting a well pattern in 11-6
overview 11-1
renaming a well pattern in 11-7

well patterns
defining with data sets 14-5

well properties
configuring in Labware Type Editor 7-26

Worklist Step
advantages to using 17-7
configuring 17-7, 17-8
defined 17-1, 17-6
inserting into method 17-7
using text file in 17-6
using values 17-6
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